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Preface

Congratulations on purchasing the drawing/editing software (V-SFT-5) for the MONITOUCH V series.
For a clearer understanding, the MONITOUCH V series Reference Manual focuses on the outline of each function 
and the way of using the drawing/editing software (V-SFT-5) according to operating procedures.

Notes:

1. The copyright of the software is possessed by Hakko Electronics Co., Ltd.
2. Reproduction of the contents of the software and this manual, in whole or in part, without permission 

of Hakko Electronics Co., Ltd. is prohibited.
3. The specifications of the software and the information in this manual are subject to change without 

prior notice.
4. If the specifications of the software do not correspond with the contents of this manual, the software 

specifications have priority.
5. No liability is assumed by Hakko Electronics Co., Ltd. with respect to the influence brought by the 

result of using the software or this manual.
6. You may use this software on a single central processing unit.

About Trademarks:

• Windows, Word and Excel are registered trademarks of Microsoft Corporation in the United States 
and other countries.

• All other company names or product names are trademarks or registered trademarks of their 
respective holders.

• Programmable logic controllers (PLCs) are products of their respective manufacturers.



About Manuals

This manual describes the functions of the MONITOUCH V8 series in detail.
The following manuals are available for the MONITOUCH V8 series:

Manual Name Reference No. Contents

V8 Series Reference Manual (this 
manual)

1055NEx The functions of the MONITOUCH V8 series are 
explained in detail.

V8 Series Reference Additional 
Functions

1060NEx The functions that are added from the V-SFT 
version 5.1.0.0 to the MONITOUCH V8 series are 
explained in detail.

V Series Macro Reference 1056NEx An overview of macros of V-SFT version 5 as well 
as macro editor operations and macro command 
descriptions are explained in detail.

V8 Series Introductory Manual 1057NEx An overview of the MONITOUCH V8 series as well 
as basic operating procedures of the configuration 
software are explained in detail.

V8 Series Operation Manual 1058NEx The information related to the operations of the 
V-SFT version 5, such as software composition, 
editing procedure or limitations, is explained in 
detail.

V8 Series Hardware Specifications 2016NEx Hardware specifications and handling procedures 
of the MONITOUCH V8 series are explained.

V806 Series Hardware Specifications 2017NEx Hardware specifications and handling procedures 
of the MONITOUCH V806 series are explained.

V815 Hardware Specifications 2018NEx Hardware specifications and handling procedures 
of the MONITOUCH V815 are explained.

V808CH Hardware Specifications 2019NEx Hardware specifications and handling procedures 
of the MONITOUCH V808CH are explained.

V8 Series Connection Manual 2201NEx Connections with respective devices and wiring 
diagrams between the MONITOUCH V8 series are 
explained.

V Series DLL Function Specifications 1059NEx An overview and contents of DLL files used for 
Ethernet (HKEtn20.DLL) and CF card 
(VCFAcs.DLL) are explained in detail.



V8 Series Functions

The V8 series is equipped with the following functions.  Depending on the V8 series model, some functions may 
not be available.  For more information, refer to the related chapters.

Functions Described in the V8 Series Reference Manual (this manual)
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Chapter Contents V815iX V812iS
V810iS
V810iT
V808iS

V812S
V810S
V810T
V808S

V810iC
V808iC

V810C
V808C

V808iCH V808CH V806iT
V806iC
V806iM

V806T
V806C
V806M

2 Overlap

  Superimpose × × × × × ×

  Video overlap × × × × × × ×

3 Switch

  Coordinate output
  (for analog only)

  Transparency 

  Multi-output

  Delay/
  Message box

4 Lamp

  Transparency 

5 Data display

6 Message display

Comment display

7 Entry mode

Automatic writing when 
the entry target has 
been moved  

  Switch
  [Function: Cancel]

Switch
[Function: Max./Min. 
Value Entry]

  Password: variable

  Digital switch
  (add/subtract switch)

8 Graph

  Scale: variable

9 Trend

  XY parameters

  X scale

10 Sampling

Acknowledge display 
function

11 Graphic

12 Time display/calendar

13 Recipe mode



         : Available  : Optionally available  ×: Not available
*1 Not supported by V806iM and V806M
*2 Only UDP/IP supported

14 Multimedia - - - - - - - - -

  Animation × × × × × ×

  Video/RGB display × × × × × × ×

  JPEG display    *1    *1

  Sound replay function × × × × × × ×

15 Others - - - - - - - - -

  Data block area

  Memory card mode

    CF card

    SRAM

    CREC × ×

  Memo pad
  (for analog only)

16 Print

  Data sheet print Serial × ×

USB 

17 Barcode
One-dimensional

Two-dimensional

18 CF card Built-in

USB × ×

2-drive 
connection

× ×

19 Ethernet function ×

  Screen data transfer ×

  PLC connection     *2     *2 ×     *2

E-mail × × × ×

Web server × × × ×

20 Slider switch

A1 Buffering area

  Store target: SRAM

  Store target: CF card

A2 SRAM/clock setting

A3 Display language

  Multi-language selection

Displayed character 
selection

  Multi-language screen

- Windows fonts
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Functions Described in the V8 Series Reference Additional Functions
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Chapter Contents V815iX V812iS
V810iS
V810iT
V808iS

V812S
V810S
V810T
V808S

V810iC
V808iC

V810C
V808C

V808iCH V808CH V806iT
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V806iM

V806T
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2 Global overlap

3 Switch
Multi-function

Continuous buzzer

4 Word lamp

5 Data display
Offset value designation 
memory

Attribute change

6 Data display with entry 
function

Slider switch

Numerical data entry 
(extended)

7 Graph (real values)

Panel meter function 
extended

*1 *1    *1 *1 *3 *1 *3    *1 *3    *1 *3   *1 *2 

*3 *4
  *1 *2 

*3 *4

8 Trend graph (real values)

Trend sampling
Graph show/hide function

9 Alarm function
Parameter added

Acknowledge

10 RGB display
(touch switch emulation)

× × × × × × ×

11 Scroll

12 Expanded data sheet

13 Stroke fonts *1 *1

16-language selection

14 CF card
Screen added

Message storage

Addition of titles to CSV 
file (sampling data)

15 Item display function

16 FTP server × × × ×

17 E-mail certification × × × ×

Two Ethernet ports × × × × ×

18 Network camera *1 × *1 × *1 × *1 *2 ×

19 Remote desktop window 
display (analog only)

*1 × *1 × *1 × *1 *2 ×

20 MES interface ×

21 Operation log/Log viewer

22 Security



       : Available  : Optionally available  ×: Not available

*1 The 128-color mode is not supported.
*2 The V806M is not supported.
*3 [Indicator Setting (Extension)] for the panel meter is inactive.
*4 Not available on the portrait-orientated V806

23 Macro

24 Tag editing

25 Jump to the target screen  

Memory batch change

Selection order batch 
change

Image file 3D part 
conversion

Cross-reference

Text comparison

Selective transfer

Message/comment 
transfer

26 USB barcode reader × ×

USB keyboard × ×

USB mouse × ×

USB-FDD × × × ×

27 Ladder transfer 
USB

Ethernet × × × ×
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V8 Series Models

The following MONITOUCH V8 series models are available:

Please note that the V series model names are used as listed above in the manuals.

Generic Name Series Model V8 Classification

V series

V8 series

V815ix V8i or V8i series

V812iS V8i or V8i series

V812S V8

V810iS V8i or V8i series

V810S V8

V810iT V8i or V8i series

V810T V8

V810iC V8i or V8C series

V810C V8i or V8C series

V808iS V8i or V8i series

V808S V8

V808iC V8i or V8C series

V808C V8i or V8C series

V806iT

V8i or V806 seriesV806iC

V806iM

V806T

V8i or V806 seriesV806C

V806M

V808iCH

V808CH

V7 series

V715X

V712iS V7i or V7i series

V712S V7

V710iS V7i or V7i series

V710S V7

V710iT V7i or V7i series

V710T V7

V708iS V7i or V7i series

V708S V7

V708C V7

V706 series

V706T

V706C

V706M

V6 series

V606eC

V606eM

V608CH



Notes on Safe Usage of MONITOUCH

In this manual, you will find various notes categorized under the following levels with the signal words “DANGER,” 
and “CAUTION.”

Note that there is a possibility that the item listed with  may have serious ramifications.

DANGER Indicates an imminently hazardous situation which, if not avoided, will result in death or 
serious injury.

CAUTION Indicates a potentially hazardous situation which, if not avoided, may result in minor or 
moderate injury and could cause property damage.

• Never use the input function of MONITOUCH for operations that may threaten human life or damage the 
system, such as switches to be used in case of emergency.  Please design the system so that it can cope 
with the malfunction of a touch switch.  A malfunction of the touch switch will result in machine accident or 
damage.

• Turn off the power supply when you set up the unit, connect new cables or perform maintenance or  
inspections.  Failure to do so could cause electric shock or damage to the unit.

• Never touch any terminals while the power is on.  Otherwise, electric shock may occur.
• You must put a cover on the terminals on the unit when you turn the power on and operate the unit.  Without 

the terminal cover in place, electric shock may occur.
• The liquid crystal in the LCD panel is a hazardous substance.  If the LCD panel is damaged, do not ingest 

the leaked liquid crystal.  If the liquid crystal spills on skin or clothing, use soap and wash off thoroughly.
• For MONITOUCH using a lithium battery, never disassemble, recharge, deform by pressure, short-circuit, 

reverse the polarity (+/−) of the battery, or dispose of the battery in fire.  Failure to follow these conditions will 
lead to explosion or fire.

• For MONITOUCH using a lithium battery, never use a battery that is deformed, leaks, or shows any other 
signs of abnormality.  Failure to follow these conditions will lead to explosion or fire.

• If the screen becomes dark due to a failure or service life of the backlight, the POWER lamp starts flashing.  
The switches on the screen remain active even in this condition.  However, if the screen is too dark to view 
the switches while the POWER lamp is flashing, do not touch the screen.  Doing so could cause unexpected 
activation, resulting in machine damage or accident.

CAUTION

DANGER



• Check the appearance of MONITOUCH when it is unpacked.  Do not use the unit if any damage or 
deformation is found.  Failure to do so may lead to fire, damage, or malfunction.

• For use in a facility or for a system related to nuclear energy, aerospace, medical, traffic equipment, or 
mobile installations, please consult your local distributor.

• Operate (or store) MONITOUCH under the conditions indicated in this manual and related manuals.  Failure 
to do so could cause fire, malfunction, physical damage, or deterioration.

• Understand the following environmental limits for use and storage of MONITOUCH.  Otherwise, fire or 
damage to the unit may result.

- Avoid locations where there is a possibility that water, corrosive gas, flammable gas, solvents, grinding 
fluids or cutting oil can come into contact with the unit.

- Avoid high temperature, high humidity, and outside weather conditions, such as wind, rain or direct 
sunlight.

- Avoid locations where excessive dust, salt, and metallic particles are present.
- Avoid installing the unit in a location where vibration or physical shock may be transmitted.

• Equipment must be correctly mounted so that the main terminal of MONITOUCH cannot be touched 
inadvertently.  Otherwise, an accident or electric shock may occur.

• Tighten the fixtures of MONITOUCH with a torque in the specified range.  Excessive tightening may distort 
the panel surface.  Loose tightening may cause MONITOUCH to come off, malfunction, or be short-circuited.

• Check periodically that terminal screws on the power supply terminal block and fixtures are firmly tightened.  
Loosened screws may result in fire or malfunction.

• Tighten terminal screws on the power supply terminal block equally to a torque of 0.5 N•m.  Improper 
tightening of screws may result in fire, malfunction, or other trouble.

• MONITOUCH has a glass screen.  Do not drop or give physical shock to the unit.  Otherwise, the screen 
may be damaged.

• Connect the cables correctly to the terminals of MONITOUCH in accordance with the specified voltage and 
wattage.  Over-voltage, over-wattage, or incorrect cable connection could cause fire, malfunction or damage 
to the unit.

• Be sure to establish a ground of MONITOUCH.  The FG terminal must be used exclusively for the unit with 
the level of grounding resistance less than 100Ω.  Otherwise, electric shock or fire may occur.

• Prevent any conductive particles from entering MONITOUCH.  Failure to do so may lead to fire, damage or 
malfunction.

• After wiring is finished, remove the paper used as a dust cover before starting to operate MONITOUCH.  
Operation with the cover attached may result in accident, fire, malfunction, or other trouble.

• Do not attempt to repair MONITOUCH at your site.  Ask Hakko or the designated contractor for repair.
• Do not disassemble or modify MONITOUCH.  Otherwise, it may cause a malfunction.
• Hakko Electronics Co., Ltd. is not responsible for any damages resulting from repair, overhaul or 

modification of MONITOUCH that was performed by an unauthorized person.
• Do not use a sharp-pointed tool when pressing a touch switch.  Doing so may damage the screen.
• Only experts are authorized to set up the unit, connect the cables, or perform maintenance and inspections.
• For MONITOUCH using a lithium battery, handle the battery with care.  The combustible materials such as 

lithium or organic solvent contained in the battery may generate heat, explode, or catch fire, resulting in 
personal injury or fire.  Read related manuals carefully and handle the lithium battery correctly as instructed.

• When using a MONITOUCH that has an analog switch resolution with resistance film, do not press two or 
more points on the screen at the same time.  If two or more positions are pressed at the same time, the 
switch located between the pressed positions will activate.

• Take safety precautions during such operations as setting change during running, forced output, start, and 
stop.  Any misoperation may cause unexpected machine motions, resulting in machine accident or damage.

• In facilities where a failure of MONITOUCH could lead to accident threatening human life or other serious 
damage, be sure that the facilities are equipped with adequate safeguards.

• At the time of disposal, MONITOUCH must be treated as industrial waste.
• Before touching MONITOUCH, discharge static electricity from your body by touching grounded metal.  

Excessive static electricity may cause malfunction or other trouble.
• During the CF card power supply, the LED inside the CF card cover illuminates in red.  If you remove the CF 

card or turn the MONITOUCH off while the LED is illuminating, data on the CF card may become corrupt.  
Before removing the CF card or turning MONITOUCH off, ensure that the LED is not illuminating.

CAUTION



[General Notes]
• Never bundle control cables and input/output cables with high-voltage and large-current carrying cables such 

as power supply cables.  Keep these cables at least 200 mm away from high-voltage and large-current 
carrying cables.  Otherwise, malfunction may occur due to noise.

• When using MONITOUCH in an environment where a source of high-frequency noise is present, it is 
recommended that the FG shielded cable (communication cable) be grounded at its ends.  However, the cable 
may be grounded only at one end if necessary due to unstable communication conditions, or for any other 
reason.

• Plug connectors or sockets of MONITOUCH in the correct orientation.  Otherwise, malfunctions may occur.
• When an LAN cable is wrongly connected to the MJ1/MJ2 connector, the counterpart device may be damaged.  

Double-check the connector to avoid improper insertion.
• Do not use thinners for cleaning because they may discolor the MONITOUCH surface.  Use an alcohol-based 

cleaner which is commercially available.
• If a “data receive error” occurs when MONITOUCH and the counterpart (PLC, temperature controller, etc.) are 

started at the same time, read the manual for the counterpart unit and handle the error correctly.
• Avoid discharging static electricity on the mounting panel of MONITOUCH.  Static charges can damage the 

unit and cause malfunctions.  Otherwise, malfunction may occur due to noise.
• Avoid prolonged display of any fixed pattern.  Due to the characteristics of the liquid crystal display, an 

afterimage may occur.  If a prolonged display of a fixed pattern is expected, use the auto OFF function of the 
backlight.

[Notes on LCD]
  Note that the following conditions may occur under normal circumstances:

• The response time, brightness and colors of MONITOUCH may be affected by the ambient temperature.
• Tiny spots (dark or luminescent) may appear on the display due to liquid crystal characteristics.
• There are variations in brightness and colors on each unit.
• When LCDs incorporating CCFL (cold cathode fluorescent lamp) backlights are used, their optical properties 

(brightness, irregular colors, etc.) may change over time, especially at low temperatures.
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11 System Setting
Overview

The “system setting” includes the settings that are required 
for MONITOUCH to communicate with the PLC, screen 
data settings, and other settings as well as those for the 
MONITOUCH system.

* Before transferring screen data to MONITOUCH, be 
sure to check the system setting.

Edit Model Selection

Select the MONITOUCH model type you are going to edit.

Edit Model Model Size Color Option Unit Memory 
Expansion

Touch Switch*1

V815X V815iX 1024 * 768 64k colors w/o blinking
32k colors

None None Analog switch

V812S V812iS V812S 800 * 600 64k colors w/o blinking
32k colors
128 colors

Analog switch

V810S V810iS V810S Analog switch

V810T V810iT V810T 640 * 480 Analog switch
Matrix switch

V808S V808iS V808S 800 * 600 Analog switch

V810C V810iC V808C 640 * 480 Analog switch
Matrix switch

V808C V808iC V808C Analog switch
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*1 Touch switch
Analog or matrix can be distinguished from the MONITOUCH model name.  For more 
information, refer to the V8 Series Hardware Specifications.

*2 The screen data of the V8 series cannot be saved into an earlier version (for example, V7 or V6 
series).

*3 For more information on the models other than the V8 series, refer to the V-SFT Ver. 3 Reference 
Manual.

V808CH V808iCH 
V808CH

640 * 480 64k colors w/o blinking
32k colors
128 colors

None None Analog switch

V806T/C V806iT V806T 
V806iC V806C

320 * 240 64k colors w/o blinking
32k colors
128 colors (portrait 
orientation not 
allowed)

None
CF + Dsub

Analog switch

V806M V806iM V806M 16 gray scales

Edit Model Model Size Color Option Unit Memory 
Expansion

Touch Switch*1
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1Device Connection Setting

Depending on the device connected, the available connection modes vary.
For more information on the connectable devices, refer to the V8 Series Connection Manual.

* For more information on the network-compatible models (OPCN-1, T-Link, CC-Link, Ethernet, 
FL-Net, PROFIBUS-DP, SX Bus, DeviceNet (under development)), refer to the their individual 
manuals.

Read/Write Area

[Read/Write Area] Tab Window
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Read area

The read area is the area where the PLC gives commands for display or operation to MONITOUCH.
At least 3 words of consecutive memory addresses are secured.
MONITOUCH always reads data from these 3 words to display and operate according to the 
commands.

Memory addresses are allocated as shown below.

* Data in these memory addresses is saved at $s460 to 462 of the V8 series internal memory.  For 
more information on the internal memory ($s), refer to “Appendix 6  Internal Memory.”

Address Contents Operation

Read area = n Sub command/data

V8 series ← PLCn + 1 Screen status command

n + 2 Screen number command

Read area “n” (sub command/data)

(1) Free When data is saved in this area, the same data is written to [Write Area] 
n (refer to page 1-9) after the screen has been displayed.  Utilizing this 
operation, these bits can be used for watch dog monitoring *1 or display 
scanning *2.

(2) BZ0 A beep (peep) sounds at the leading edge [0 → 1].

(3) BZ1 An error buzzer (peep-peep) sounds at the leading edge [0 → 1].

(4) BZ2 A buzzer (ffeee) sounds continuously while the bit remains [1].
It is necessary to select [Unit Setting] → [General Settings] and check 
[Use Continuous Buzzer Sound].  (Refer to page 1-24.)

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

A-1 A-2 A-3 A-4 A-5
B-1 B-2 B-3 B-4 B-5
C-1 C-2 C-3 C-4 C-5
D-1 D-2 D-3 D-4 D-5

MONITORING ERROR

Power Supply Error
Turn the unit OFF at 
once.

Display the ERROR screen.  
(Command is sent.)

ERROR screen is displayed.

MONITORING ERROR

Power Supply Error
Turn the unit OFF at 
once.

Display the ERROR screen.  
(Command is sent.)

ERROR screen is displayed.

(2) BZ0 [0 → 1] (leading edge)
(1) Free

(3) BZ1 [0 → 1] (leading edge)

(4) BZ2 [1] (level)
(5) Calendar setting ([0 → 1] (leading edge)

(6) System reserved

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0
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1

*1 Watch dog
When the PLC is communicating with MONITOUCH, there is no means for the PLC to know 
whether or not MONITOUCH is doing operations correctly.
To solve this one-way communication, change data in bits 0 to 7 in [Read Area] “n” and check 
that the same data is saved in bits 0 to 7 in [Write Area] “n”.  This proves that the V8 series is 
correctly doing operations through communications with the PLC.
This verification is called “watch dog.”

*2 Display scanning
This operation can be utilized for display scanning.  Change data in bits 0 to 7 in [Read Area] “n” 
when giving a graphic change command and check that the same data is saved in bits 0 to 7 in 
[Write Area] “n”.  This can prove that the graphic change command is received and executed 
correctly.

*3 If this bit is used during constant sampling, data sampling timing may be shifted.  If this bit is set 
during constant sampling, we recommend resetting the sampling as well.

(5) Calendar setting *3 This bit is valid when the built-in clock is not used.  This bit should be 
used differently depending on whether the connecting PLC is equipped 
with the calendar function.
For more information on the built-in clock, refer to “Appendix 2  
SRAM/Clock Setting.”

When MONITOUCH is connected to a PLC with calendar function
When calendar data in the PLC is updated, it can forcibly be read 
by setting this bit (at the leading edge of [0 → 1]).
In addition to calendar data update using this bit, calendar data in 
the PLC is automatically read and updated at the following timing.
• When the power is turned on
• When the date is changed (AM00:00:00)

When MONITOUCH is connected to a PLC without calendar function
Allocate a tentative calendar data area by setting a memory 
address for [Calendar memory] in the [GB-80 Compatible] tab 
window ([Device Connection Setting] → [Read/Write Area]) and set 
the calendar data by setting this bit (ON).  For more information, 
refer to page 1-12.

(6) System reserved This bit is reserved by the system.  This bit must be “0”.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

A-1 A-2 A-3 A-4 A-5
B-1 B-2 B-3 B-4 B-5
C-1 C-2 C-3 C-4 C-5
D-1 D-2 D-3 D-4 D-5

Change data in [Read Area] “n”.
(Bits 0 to 7)

Data in [Write Area] “n” changes.
(Bits 0 to 7)

MONITORING

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

A-1 A-2 A-3 A-4 A-5
B-1 B-2 B-3 B-4 B-5
C-1 C-2 C-3 C-4 C-5
D-1 D-2 D-3 D-4 D-5

[A-1] to [A-5]
ON-display commands

+ Change data in [Read Area] “n”.
(Bits 0 to 7)

Data in [Read Area] “n”
(Bits 0 to 7)

= Data in [Write Area] “n”
(Bits 0 to 7)

[A-1] to [A-5] ON-display
Normal termination

MONITORING



1   System Setting

1-6

Read area “n + 1” (screen status command)

(1) Overlap 0
(2) Overlap 1
(3) Overlap 2

These bits are used for controlling show/hide operations of overlaps.
• Normal overlap or call-overlap

[0 → 1] (leading edge *1): Show
[1 → 0] (falling edge *1): Hide

• Multi-overlap
[0] (level *2): Hide
[1] (level *2): Show
It is necessary to specify library No. 0 to 9999 for [Overlap Library 
Number] for multi-overlap.

(4) Overlap 3 This bit is used to show/hide a global overlap display.
[0 → 1]: Show
[1 → 0]: Hide

It is necessary to specify library No. 0 to 9999 for [Overlap Library No.] for 
global overlap.

(5) System reserved This bit is reserved by the system.  This bit must be “0”.

(6) Global macro 
execution

The macro set for [Macro Block] is executed once at [0 → 1] (leading 
edge).
The macro block number should be specified for [Global Macro Memory] in 
the dialog that is displayed by selecting [System Setting] → [Macro 
Setting].
For more information, refer to the Macro Reference manual provided 
separately.

(7) Data sheet output The data sheet is printed out at [0 → 1] (leading edge).
This bit becomes valid when the data sheet function is set.  For more 
information, refer to “16.3  Data Sheet Print.”

(8) Screen hard copy The V8 series screen image is printed out at [0 → 1] (leading edge).  This 
bit becomes valid when a printer is connected.
It is also possible to make a screen hard copy using an internal switch 
[Function: Hard Copy].  For more information, refer to “16  Print.”

(9) Backlight This bit becomes valid when an option other than [Always ON] is selected 
in the [Backlight] tab window that is displayed by selecting [System Setting] 
→ [Unit Setting]. 

[0] (level): OFF when the conditions are satisfied
[1] (level): ON

For more information, refer to page 1-17.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0

(1) Overlap 0
(2) Overlap 1

(3) Overlap 2

(5) System reserved

(6) Global macro execution [0 → 1] (leading edge)

(7) Data sheet output [0 → 1] (leading edge)

(8) Screen hard copy [0 → 1] (leading edge)

(10) Analog RGB input (level)

(11) Screen internal switching (level)

(12) Screen forced switching [0 → 1] (leading edge)

(13) Data read refresh [0 →] (leading edge)

(9) Backlight (level)

(4) Overlap 3
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1

*1 It is possible to make this function work with the bit in the level.  For more information, refer to 
“General Setting” on page 1-24.

*2 As an exception, a multi-overlap may appear/disappear at the edge.  For more information, refer 
to “Notes when showing a multi-overlap display using an external command” on page 2-22.

*3 Example of usage
Step a:  Screen change according to read area “n + 2”
Step b:  Screen change with an internal switch
Step c:  Screen change to the same screen number as step 1 according to read area “n + 2”
In this case, however, the same value is stored in read area “n + 2” so the command is not valid.  
In such a case, it is possible to forcibly switch the screen to the screen number contained in read 
area “n + 2” at the leading edge [0 → 1] of bit 14.

(10) For analog RGB 
input type

These bits are used for controlling show/hide operations of the analog 
RGB input screen.

[0] (level): RGB input screen not displayed (RUN screen displayed)
[1] (level): RGB input screen displayed

For more information, refer to “14.2  Video/RGB Display.”

(11) Screen internal 
switching

This bit controls screen switching by internal switches.
[0]: Screen switching by internal switches is enabled.
[1]: Screen switching by internal switches is disabled.

* An “internal switch” means a switch you can create for internal 
processing within MONITOUCH by selecting [Screen] or [Return] for 
[Function:] of the switch.

(12) Screen forced 
switching

This bit is used for switching the screen using the read area “n + 2” when 
the required screen number has already been specified in “n + 2”.*3

(13) Data read refresh All the data display items on the screen are refreshed at [0 → 1] (leading 
edge).  This is applied to every data display item regardless of the setting 
for [Process Cycle].
For more information on [Process Cycle], refer to “Appendix 5  Process 
Cycle.”

D001
D002

D000

5

Screen No. 5

No. 2

Screen No. 2

No. 2

15    14   13    12   11    10    09   08   07    06    05   04    03   02   01   00

0    1   0    0   0    0   0    0   0    0   0    0   0    0   0    0
5

D000
D001
D002

Screen No. 5

No. 2

Screen forced switching (bit 14)

Read area “n + 2”
= external screen command

Data in the read area “n + 2” remains “5” even if the actual 
screen has been switched by an internal command.

To show screen No. 5 again using an external screen 
command, set [0→1] to bit 14 of read area “n + 1”.

a

b

c



1   System Setting

1-8

*1 Screen No. Error
When MONITOUCH has started communications with the PLC, the screen of the screen number 
specified in read area “n + 2” is displayed.  If the screen number specified in read area “n + 2” 
does not exist in the screen data, “Screen No. Error” is displayed on MONITOUCH.

Before starting communications with the PLC, check the data in [Read Area] “n + 2” and confirm 
that the screen number to be displayed at first is specified.

Read area “n + 2” (screen number command)

Screen number 
command *1

0 to 9999
These bits are used for switching the screen by an external command.
When a screen number is specified in these bits, the screen is displayed.
Even if the screen has been switched using an internal switch, it is possible 
to switch the screen using an external command from the PLC.  External 
commands have priority over internal switches.

Screen number

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM



1   System Setting

1-9

1Write area

This is the area where data is written from [Read Area], such as the displayed screen number, overlap 
display status, buzzer sounding status, etc.  3 words of consecutive memory addresses are secured.
MONITOUCH writes information to these 3 words during communications with the PLC.
When the V8 series has completed a display operation, sub command/data in [Read Area] “n” is 
written.

Memory addresses are allocated as shown below.

* Data in these memory addresses is saved at $s464 to 466 of the V8 series internal memory.  For 
more information on the internal memory ($s), refer to “Appendix 6  Internal Memory.”

Address Contents Operation

Write area = n Same as data in read area “n”

V8 series → PLCn + 1 Screen status

n + 2 Displayed screen number

Write Area “n” (output of read area “n”)

(1) Free

These bits reflect the data in read area “n” at the time MONITOUCH has 
been finished with processing.

(2) BZ0

(3) BZ1

(4) BZ2

(5) Calendar setting

(6) System reserved Always “0”

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEMMonitoring
A-1 A-2 A-3 A-4 A-5
B-1 B-2 B-3 B-4 B-5
C-1 C-2 C-3 C-4 C-5
D-1 D-2 D-3 D-4 D-5

Backlight OFF!
(The unit status is set to the write area.)

The backlight goes OFF when the screen is 
not touched for a certain time.

(2) BZ0
(1) Free

(3) BZ1

(4) BZ2
(5) Calendar setting

(6) System reserved

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0
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Write area “n + 1” (screen status)

(1) Overlap 0
(2) Overlap 1
(3) Overlap 2
(4) Overlap 3

Overlap status *1

[0]: Hide
[1]: Show

(5) System reserved Always “0”

(6) Serial extension 
I/O

Serial extension I/O (V-I/O) status
[0]: Normal
[1]: Error

(7) Global macro 
execution

This bit reflects the data in bit 8 of read area “n + 1”.

(8) Printer busy Printer status *2

[0]: Not busy
[1]: Busy

(9) Print data 
transferring

Print data transferring status when a print command (hard copy, sample 
print or data sheet) is executed *2

[0 → 1]: Print data transferring start
[1 → 0]: Print data transferring end

(10) Backlight Backlight ON/OFF status*3

[0]: OFF
[1]: ON

* Even if bit 11 (backlight) in read area “n + 1” is reset (0: OFF), this bit 
shows “1” if the backlight is on.

(11) For analog RGB 
input type

Analog RGB input screen status
[0]: RGB input screen not displayed (RUN screen displayed)
[1]: RGB input screen displayed

(12) Screen internal 
switching

This bit reflects the data in bit 13 of read area “n + 1”.

(13) Screen forced 
switching

This bit reflects the data in bit 14 of read area “n + 1”.

(14) Data read refresh This bit reflects the data in bit 15 of read area “n + 1”.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0

(1) Overlap 0
(2) Overlap 1

(3) Overlap 2

(5) System reserved

(8) Printer busy

(9) Print data transferring

(10) Backlight

(11) Analog RGB input

(12) Screen internal switching

(13) Screen forced switching

(14) Data read refresh

(6) Serial extension I/O

(7) Global macro execution

(4) Overlap 3
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1*1 Example:
a. Display overlap No. 0 from read area (n + 1) using an external command.
b. Display overlap No. 0 internally using the [Function: Overlap = ON] switch.
In either case (a or b), bit 0 of write area “n + 1” is set (ON).
In the case of b, the bit in read area “n + 1” remains “0”.

*2 Data of bits 9 and 10 is output to internal memory address $s16.  For more information on the 
internal memory ($s), refer to “Appendix 6  Internal Memory.”

*3 Data of bit 11 is output to internal memory address $s17.  For more information on the internal 
memory ($s), refer to “Appendix 6  Internal Memory.”

Calendar

For the calendar setting, refer to “12  Calendar.”

D001

15   14    13    12    11   10   09    08    07   06    05   04    03   02    01    00

0    0    0   0    0   0    0   0    0   0    0   0    0   0    0   1

External command for screen display from read area “n + 1”

When an overlap is displayed on the screen,
bit 0 in write area “n + 1” is set to “1”.

(Write area “n + 1”)

Internal command for screen display using a switch on the screen

b

a

Screen Change

Screen Change

Error

Error

A-Line Paint Process

A-Line Paint Process

Line A Line B Line C Line D

Num. 
Display Monitor Error Alarm

Line A Line B Line C Line D

Num. 
Display Monitor Error Alarm

Write area “n + 2” (displayed screen number)

Screen number 0 to 9999
Screen number currently displayed

Screen number

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
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[GD-80 Compatible] Tab Window

GD-80 compatible read/write area

When converting screen data files created on GD-80 into those of the V8 series, this option is 
automatically checked.
The contents of [Read Area] and [Write Area] with the GD-80/81S series are different from those with 
the V8 series.
When this option is checked, [Read Area] and [Write Area] will have the same contents as the 
GD-80/81S series.
For more information on [Read Area] and [Write Area] of the GD-80/81S series, refer to the GD-80 
User’s Manual.

Calendar memory

Use this memory area when the connecting PLC is not equipped with the calendar function and the V8 
series built-in clock * is not used.

* Built-in clock:  V8 series built-in clock

Follow the steps below.
[Step 1]

Specify the desired memory address for [Calendar memory].  Six words are occupied 
consecutively.

[Step 2]
Save calendar data in the calendar memory addresses specified in step 1 in BCD notation.
The allocation of calendar memory is shown below.

The day of the week is automatically recognized from the above data.  It is not necessary to 
input any data.

[Step 3]
Set bit 11 (calendar setting) of read area “n”.  At the leading edge of this bit (0 → 1), data in 
[Calendar memory] is set for calendar data.

*1 Calendar data is cleared when the power is turned off.  When the power is turned on, set 
calendar data according to the procedure mentioned above.

*2 When using the calendar memory, automatic reading of calendar data at the time of PLC 
connection as well as once-a-day automatic correction is not performed.  Consequently, some 
errors may be introduced.  Perform the procedure described above at regular intervals.

Memory Contents

n Year (BCD 0 to 99)

n + 1 Month (BCD 1 to 12)

n + 2 Day (BCD 1 to 31)

n + 3 Hour (BCD 0 to 23)

n + 4 Minute(s) (BCD 0 to 59)

n + 5 Second(s) (BCD 0 to 59)
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1Ethernet Communication

Local Port IP Address
Set the IP address, port number and others of MONITOUCH.  This is useful when specific IP 
addresses are assigned to respective MONITOUCHs where screen data is used.

* The IP address setting can be made on the network table or the Main Menu screen of 
MONITOUCH.  When using the same screen data on multiple MONITOUCHs, setting a network 
table will be useful.

* For more information, refer to the V8 Series Connection Manual.

 Set IP Check this box when setting the IP address of the V8 within the screen data.

 Select IP Address from 
Network Table

This is valid when the IP address of the V8 has been registered in the network 
table.  An IP address can be selected from network table No. 0 to 99.

IP Address * Set the IP address of the V8.

 Default Gateway * Set the default gateway.

 Subnet Mask * Set the subnet mask.
When this box is not checked, the subnet mask is automatically recognized 
based on the extreme left byte of the IP address.
Example: When IP address is “172.16.200.185”, “255.255.0.0” is set.

When IP address is “192.168.1.185”, “255.255.255.0” is set.

 Port No. * Set a port number (1024 - 65535).
(except for “8001”)

Send Timeout Specify the timeout time to be used when sending the EREAD/EWRITE macro 
command.

Retrials 0 - 255
Specify the maximum number of retrials to be attempted in the case a timeout 
occurs.

Memory Protect
Internal Memory
Memory Card Memory

Check this box when disabling data writing from a computer or another port.
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Network Table
Depending on the Ethernet function to be used, the network table is required or not required.
Refer to the chart below to know whether the network table is required or not for each function.

*1 For more information, refer to the V8 Series Connection Manual.
*2 The 128-color mode is not supported.

E-Mail
This is the function available with the V8i series.  This is required when [  Use E-Mail] is checked for 
buffering area setting.
For more information, refer to “19  Ethernet.”

Function

V series + Option

PLC Communication Macro
EREAD
EWRITE
SEND
MES

HKEtn20.dll
Screen 
Data 

Transfer

Web Server
E-Mail

FTP Server

Network 
Camera

Remote 
Desktop

TCP/IP UDP/IP

V815iX
V812iS
V810iS
V810iT
V810iC
V808iS
V808iC

V808iCH
V806iT
V806iC

Built-in LAN
 *2

V806iM

V812S
V810S
V810T
V810C
V808S
V808C
V806T
V806C
V806M

CU-03-3

CU-03-2

Network table *1 Not required Required Not 
required

Not 
required

Not 
required

Not 
required
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1Other Devices

Select [System Setting] → [Device Connection Setting] and make the settings for the following 
devices.

Printer
Make the setting when connecting a printer for hard copy, data sheet print or sample print.
For more information, refer to “16  Print.”

Card Recorder
Make the setting when using a card recorder CREC.
For more information, refer to “15.2  Memory Card Mode.”

V-I/O
Make the setting when using the serial extension I/O unit (V-I/O).

Touch Switch
Make the setting for touch switch emulation on the RGB display by signal input.
An optional unit GU-01, GU-10, or GU-11 is required for enabling RGB display by signal input.
For more information, refer to “14.2  Video/RGB Display.”

Simulator
Make the setting when the simulator communication program along with the screen data to the CF 
card through the CF card manager is to be saved.
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Unit Setting

Make the setting for the V8 series unit.  Select the functions you are going to use and make the setting 
correctly.  If you made a mistake in the setting, it is necessary to send the screen data again.

Select [System Setting] → [Unit Setting].

MR400 Format (Call)
This setting is effective when MR-400 is selected for the printer setting.  Register and set the print 
format.  For more information, refer to “Sato’s Barcode Printer MR-400” (page 16-16).
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1Backlight
Select the operation of the backlight attached to the V8 series unit.

Action Always ON
The backlight is always on.
Auto 1
Backlight OFF conditions:
The backlight is shut off when the time specified by [Backlight OFF Time] 
has elapsed from the instant when all the following conditions are met. *1

• Bit 11 of read area “n + 1”: OFF
• Screen display (lamp, data display, calendar, etc.) stands still.
• Touch switch: OFF

Backlight ON conditions:
The backlight is turned on when any of the following conditions is met. *2

• Bit 11 of read area “n + 1”: ON (always ON)
• Screen display has changed.
• Somewhere on the screen is touched.
• Normal/call-overlap: ON/OFF 
• Multi-/global overlap: ON/OFF, the overlap number changed 

Auto 2
Backlight OFF conditions:
The backlight is shut off when the time specified by [Backlight OFF Time] 
has elapsed from the instant when all the following conditions are met. *1

• Bit 11 of read area “n + 1”:  OFF
• Touch switch: OFF

Backlight ON conditions:
The backlight is turned on when any of the following conditions is met. *2

• Bit 11 of read area “n + 1”: ON (always ON)
• Somewhere on the screen is touched.
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*1 When the redisplay of the entire screen takes place, such as a screen change or turning on and 
off or switching an overlap display, the time measured for [Backlight OFF Time] is cleared.

*2 No switch data will be output if a switch is pressed once with the backlight off.  When a switch is 
pressed once with the backlight off, the backlight is turned on.  Switch data will be output from 
switch operation that is made after 500 ms has elapsed since the backlight was turned on.

*3 Invalid when bit 11 of read area “n + 1” is set (ON)
*4 Switches on the screen can be operated when the backlight is off.  This is compatible with the V4 

series.

Action Auto 3
Backlight OFF conditions:
The backlight is shut off when the time specified by [Backlight OFF Time] 
has elapsed from the instant when all the following conditions are met. *1

• Bit 11 of read area “n + 1”: OFF
• Touch switch: OFF

Backlight ON conditions:
The backlight is turned on when any of the following conditions is met. *2

• Bit 11 of read area “n + 1”: ON (always ON)
• Screen changed
• Somewhere on the screen is touched.
• Normal/call-overlap: ON/OFF 
• Multi-/global overlap: ON/OFF, the overlap number changed 

Manual
Backlight OFF conditions:
The backlight is turned off when either operation is performed.

• Press [SYSTEM] → [F5] on the MONITOUCH. *3

• Bit 11 of read area “n + 1” OFF (at the falling edge of [1→0])
Backlight ON conditions:
The backlight is turned on when any of the following conditions is met. *2

• Somewhere on the screen is touched.
• Press a function switch. *3

• Bit 11 of read area “n + 1” ON (at the leading edge of [0→1])
Manual 2*4

Backlight OFF conditions:
The backlight is turned off when either operation is performed.

• Press [SYSTEM] → [F5] on the MONITOUCH. *3

• Bit 11 of read area “n + 1” OFF (at the falling edge of [1→0])
Backlight ON conditions:
The backlight is turned on when any of the following conditions is met.

• Press [SYSTEM] → [F5] on MONITOUCH.
• Bit 11 of read area “n + 1” ON (at the leading edge of [0→1])

Backlight OFF Time 0 to 65535 (sec)
This is valid when [Auto 1], [Auto 2] or [Auto 3] is selected for [Action].
Set the length of time that elapses before the backlight is turned off when 
the OFF conditions have been met.

Control during 
Backlight Power ON

This is valid when [Manual] or [Manual 2] is selected for [Action].
Select the backlight ON/OFF status when the power is turned on and when 
the mode is changed from STOP → RUN.

Display This is valid for MONITOUCH with monochrome display.
This setting determines whether or not the display on MONITOUCH should 
be shown in reverse video.

V-SFT
Normal Reversed Image

Black White Black White

MONITOUCH Black White White Black
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1Buzzer

System/Mode Switch
This is the setting for the [SYSTEM] switch and [MODE] (F1) switch in the RUN mode.

*1 Refer to the next page for the procedure of switching the mode from RUN ↔ STOP.

Action Choose the desired duration of buzzer that is given when a switch is pressed.
Standard: 100 msec
Short: 10 msec
Continuous: Continuous 
OFF: No buzzer sounding

System Switch 
Prohibited

The use of [SYSTEM] switch is prohibited.  Even when the switch is pressed, 
no menu is displayed and the following operations are disabled.

• Switching the mode from RUN → STOP (Main Menu screen)*1

• Brightness adjustment/contrast adjustment
• Backlight control (when [Manual] is selected)

Mode Switch 
Prohibited

The use of [MODE] switch is prohibited.  Pressing the switch does not switch 
the mode from RUN to STOP (Main Menu screen). *1
Brightness adjustment, contrast adjustment and backlight control are 
enabled.

Mode Change 
Delay Time

0 to 30 (sec)
Set the mode change delay time for RUN → STOP (Main Menu screen). *1

* The same delay time is applied when canceling the system switch or 
mode switch prohibited state.



1   System Setting

1-20

Procedure of switching the mode from RUN ↔ STOP

The procedure varies depending on the setting for [System Switch Prohibited] and [Mode Switch 
Prohibited].

Blink/Flash
The blink/flash time for the blink color can be set.

System
Switch 
Prohibited

Mode
Switch 
Prohibited

Mode Change 
Delay Time

(sec)
RUN ↔ STOP Procedure

t

Press [SYSTEM] and hold down [F1] (= [MODE] 
switch) for “t” seconds while the menu is 
displayed.

-
Hold down [SYSTEM] and [F7] for “t” seconds.
For the V806 series: 
Hold down [SYSTEM] and [F5] for “t” seconds.

Press [SYSTEM] and hold down [F1] and [F7] for 
“t” seconds while the menu is displayed.
For the V806 series: 
Press [SYSTEM] and hold down [F1] and [F5] for 
“t” seconds while the menu is displayed.

OFF Time
(× 100 msec) 0: Blinking at about 500-msec intervals

1 to 100: Blinking at about ×100-msec intervalsON Time
(× 100 msec)
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1Overlap
This is valid when [Edit Model Selection] → [Touch Switch: Analog Switch] is selected. *1
Select the unit for overlap coordinates.  This is used when displaying an overlap at an external 
command or macro command.

*1 With the matrix switch, this is fixed to [Line/Column].

Handy-Sized Display Setting
Make the deadman switch or key lock switch setting when “V808CH” is selected in [Edit Model 
Selection].

Overlap Coordinates Line/Column: X coordinate in 8 dots, Y coordinate in 20 dots (= one-byte)
Dot: X coordinate in 4 dots, Y coordinate in 1 dot

 Use Deadman 
Switch*1

Select whether to use the deadman switch.
For the V808CH unit to be normally operative, uncheck the checkbox.
When changing the setting during RUN mode, execute the macro 
command “SET_DSW”.

 Use Key Lock 
Switch

Select whether to use the key lock switch.
For the V808CH unit to be normally operative, uncheck the checkbox.

*1 This setting is inactive with V808CH4.
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Video/RGB
Make the setting when using the video display function.
For more information, refer to “14.2  Video/RGB Display.”

Sound
Make the setting when selecting a WAV file by designating a memory address for sound replay 
function.
For more information, refer to “14.4  Sound.”

SRAM/Clock
Make the setting when using the SRAM or V8 series built-in clock.  For more information, refer to 
“Appendix 2  SRAM/Clock Setting.”

GD-80E/V609E Compatibility Setting
Make the setting in the case of model change from GD-80E/V609E to V808C (128 colors).

GD-80E/V609E 
Compatible

• Unchecked
On the V8 unit, screen data is displayed in the same position as specified 
on the V-SFT.

• Checked
On the V8 unit, screen data is displayed in the center with top and bottom 
margins of 40 dots, respectively.
(No part can be placed on these margins.)
Screen data of 640*400 dots is displayed on the V-SFT.

Margins of 40 dots are 
kept at the top and 
bottom, respectively.
(Displayed in black on 
the V8.)

Display on V808C
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1

* For pattern data, there are some colors that cannot be converted.
In such a case, the dialog shown below is displayed.

Color Batch 
Change

• Unchecked
Screen data is displayed in the same colors as those before conversion.

• Checked
Color batch conversion is performed except for black so that the screen is 
displayed in the same colors as those on GD-80E/V609E (2 colors).

* The color data cannot be restored to the original after conversion.

V808C data displayed on computerGD-80E/V609E data displayed on computer
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General Settings
These options are classified into two groups: GD-80 compatible settings, and other additional settings.
For the GD-80 compatible settings, these options are automatically selected when the GD-80 data is 
converted into that for the V8 series.

Use Continuous 
Buzzer Sound

Used to set whether or not to use a continuous buzzer.
• Unchecked

No continuous buzzer is issued.
• Checked

A continuous buzzer sounds while bit 10 of read area “n” is set (ON).

Display Overlap 
during bit ON

Used to set the action for [Normal/Call-Overlap] (bits 0, 1, 2 of read area 
“n + 1”).

• Unchecked
Recognized at the edge.  Even if the bit is set (ON) when the screen is 
opened, the overlap is not displayed.

• Checked
Recognized at the level.  The overlap is displayed while the bit is set 
(ON).

Clear the text when 
inputting the first 
character in the 
character input mode

Used to set the action to be made the first instant you press the character 
key in the character input mode.

• Unchecked
Existing text remains in the entry display part.
Checked
Existing text in the entry display part is automatically cleared.

Read Data from 
Barcode in Words

Used to set the unit of counting read data to be output to the I/F memory for 
barcode setting.

• Unchecked: in bytes
• Checked: in words (same as GD-80)

Mode Operation: 
Make messages the 
same as GD-80 if 
[Action Area] is 
[Switch/Lamp].

This is valid when [Action Area: Switch/Lamp] is selected for bit order 
alarming, page mode or direct mode.
Used to set the message display format on a switch or lamp part.

• Unchecked
If the message cannot be held in one line, it 
is wrapped and shown.

• Checked
If the message cannot be held in one line, 
the portion that cannot be held in the area 
is not shown.

ABCDEFGHIJKLMNOP
QRSTU

ABCDEFGHIJKLMNO
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1Num. Display: 
Displays the 
significant figures 
upon overflow

Used to set the display on MONITOUCH when an overflow occurs to a 
numerical display part.
Example:  When D100 = 1234:

• Unchecked
4-digit display: “1234”  2-digit display “--”

• Checked
4-digit display: “1234”  2-digit display “34”

Num. Display: 
Displays the special 
characters A to F in 
BCD

Used to set the display on MONITOUCH when BCD is selected for a 
numerical display part.

When operating the 
+/− block switch, skip 
keypad blocks that do 
not exist 

Used to set the action to be made if there is an unregistered block between 
the block numbers [Min. Block] and [Max. Block] for the target of switching 
the keypad block.

• Unchecked
Switching stopped when an unregistered block is encountered

• Checked
Switching while skipping the unregistered block

PLC
Display on MONITOUCH

Unchecked Checked

0 to 9 0 to 9 0 to 9

A 0 .

B 0 :

C 0 -

D 0 +

E,F 0 (Space)

No. 0 No. 4No. 1 No. 2 No. 3

Not registered

Switching not possibleSwitching possible

No. 0 No. 4No. 1 No. 3
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Regard the origin of 
graphic relay on an 
overlap as the origin 
of a screen

Used to set the reference position when the graphic relay function is set for 
an overlap.

• Unchecked
Graphics is placed with respect to the origin of the overlap display part.

• Checked
Graphics is placed with respect to the origin of the screen.

If a switch/lamp OFF 
color is the same as 
the base, do not 
make it solid filled

Used to set the OFF color display when the screen background color is the 
same as the OFF color of the switch or lamp.

• Unchecked
The switch or lamp part placed on top overwrites the existing switch or 
lamp part on either editor or MONITOUCH.

• Checked
The part on top overwrites on the editor.  On MONITOUCH, the OFF 
color becomes transparent.

Graphic library
Reference 
position

Overlap

Screen

Graphic library
Reference 
position Overlap

Screen

Lamp (on top)

Switch (on bottom)
On MONITOUCH

Lamp overwrite

Lamp (on top)

Switch (on bottom)
On MONITOUCH

No lamp seen when it is OFF
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1If a switch is overlaid 
on another, enable 
the upper switch

Used to set the action to be made when two switches overlap each other.
[Display on the editor]
The switches are displayed in the order of 
placement.  Because switch 0 was placed earlier, 
switch No. 1 placed afterward is on switch No. 0.

[Operation on MONITOUCH]
• Unchecked

The switch (No. 0) that is placed earlier becomes valid.

• Checked
The switch (No. 1) that is placed afterward becomes valid.

Make the action of bit 
items the same as 
GD-80.

Check this box when the Hitachi HIDIC-S10 is connected and screen data 
created on the GD-80 or V4 is converted into V8.
If this box is not checked, compatibility cannot be retained because bit 
weights are reversed from the GD-80 or V4 processing when they are 
converted into V8.

Make the offset 
processing for 
graphic call the same 
as GD-80

If two or three conditions shown below are present, the graphic display 
position at bit ON is different from that on the GD-80.  If you want to make it 
the same as the GD-80, check this box.

• Graphic relay used
• Graphic call used
• Graphic call with offset and parameter settings

Use Vertical Text If you want to place Japanese characters, check this box.

Use Internal Flash 
ROM as Back-up 
Area

Check this box when you want to use a part of the FROM area in 
MONITOUCH as a backup area for memory (PLC memory, internal memory 
or memory card).
This function cannot be used with the station number table *1.

Print Alarm Logging 
Data in the Displayed 
Format

Used to make print settings for alarm logging.
• Unchecked

Both bit ON data and bit OFF data are printed.
• Checked

Data is printed in the currently displayed format (if bit ON data is shown, 
only bit ON data is printed).

Convert DIO Input 
Memory to Bit 
Memory

The DIO output memory makes bit conversion while the DIO input memory 
does not make bit conversion.

When connecting to the following PLC models, bit conversion of the DIO 
input memory is required because of a special array of bits.  Check this box 
when the E-I/O or V-I/O is used on these PLCs.

• Fuji Electric MICREX-F (other than I/O memory for T-LINK)
• Hitachi HIDIC-S10α (other than I/O memory for JPCN-1)
• SIEMENS S5, S7 series (device memory with byte addresses)

No. 1

No. 0

No. 1

No. 0No. 0

No. 1

Press here.

No. 0

No. 1

No. 0

No. 1

Press here.
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Validate the 
Character Order 
Setting for Text in JIS 
Codes

Used to set the display of JIS codes for character display parts.
• Unchecked

It is displayed in the form of MSB → LSB regardless of the setting for 
[Text Process] ([Char. Display] → [Text Process]).

• Checked
The setting for [Text Process] ([Char. Display] →  [Text Process]) takes 
effect.

Relay: Priority 
Display on Screen 
Call

Used to set the action to be made with [Action Area: Switch] or [Sub-action: 
Screen Call] for bit order alarming.
Example:
Assume that three mode switches are placed on the screen and some error 
messages are shown on these three mode switches.  When an error bit of 
higher priority has been set, the action taken varies as shown below.

• Unchecked
There is no change in the messages that are shown.

• Checked
The message for the bit of higher priority is displayed.

Use 3-D Parts If you have converted screen data using 3D parts for 128-color monitor into 
the data for 64k-color or 32k-color monitor, this box is automatically 
checked.  Use the setting as is.

2-Point Pressing 
Special Operation

Used to set the operation by two-point switch pressing for the matrix type 
MONITOUCH.

• Unchecked
When a switch is pressed at the first point and an area other than 
switches is pressed at the second point, the output of the switch 
pressed first is turned OFF.

• Checked
When a switch is pressed at the first point and an area other than 
switches is pressed at the second point, the output of the switch 
pressed first remains ON.

Hide Check Screen Used to set the display on the monitor until the RUN screen appears when 
the STOP mode has been switched to the RUN mode on MONITOUCH.

• Unchecked:  “Data Loading...” is shown.
• Checked: Nothing is shown (black screen).

Convert NULL to 
Space with the 
LD/RD Macro

Used to set how to process NULL data when reading a CSV file that 
contains NULL data (attribute table type: CHAR).
<Applicable commands>
LD_RECIPE, LD_RECIPE2, LD_RECIPESEL, LD_RECIPESEL2, 
RD_RECIPE_FILE, RD_RECIPE_COLUMN, RD_RECIPE_LINE

• Unchecked
It is loaded as NULL (00H).

• Checked
It is converted into space (20H) and loaded.
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1Permit Double-Word 
Transfer by BMOV

Used to set the action to be taken when the transfer source (transfer target) 
device is a double-word device.
Example:  Fuji Electric MICREX-F series BD (data memory)

• Unchecked
Only the lower-order word is transferred.
$u100=BD100 C:4 (BMOV)

• Checked
Both the upper- and lower-order words are transferred.
$u100=BD100 C:4 (BMOV) (D)

Compatible when the 
video input signal is 
only in the odd or 
even field.

Used to set the video input signal.
• Unchecked

Both odd- and even-numbered fields
• Checked

Either odd- o even-numbered fields

Set the Height of the 
Windows Font to 
Gothic

Used to set the font size to be applied when the screen data created using 
the Windows fonts on the V-SFT version 2.1.3.0 or earlier is opened on the 
V-SFT version 2.1.4.0 and later.

• Unchecked
Created with version 2.1.3.0 or earlier → Opened with version 2.1.4.0 or 
later

• Checked
Compatibility with the screen data created with version 2.1.3.0 or earlier 
is retained.

Perform Drawing in 
the Background

Used to reduce flickering of data display parts placed on a switch or lamp 
part.

• Unchecked
Switch, lamp and data display parts flicker slightly.

• Checked
Flickering of switch, lamp and data display parts is reduced.

$u100 1111H ←
←

BD100 22221111H

$u101 3333H BD101 44443333H

$u102 5555H ←
←

BD102 66665555H

$u103 7777H BD103 88887777H

$u100 1111H ← BD100 22221111H

$u101 2222H

$u102 3333H ← BD101 44443333H

$u103 4444H

(Arial 36 pt)
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Decimal Point 
Compatible in 
Reading Recipe File

Used to set the action to be taken when values without decimal point are 
contained in the CSV file though “with decimal point” is set on the attribute 
table.

<Example>
Attribute table
Type: DEC, decimal point: 1, word count: 1

• Unchecked
Data is read assuming the decimal point as specified

• Checked
Data is read without assuming the decimal point

Fix the Width of the 
Windows Font

Used when numerical data display or character display parts are created 
using Windows fonts on Windows XP/Vista/7.

• Unchecked
When the screen data is opened on Windows 98/2000 and is 
transferred, text width may be changed on MONITOUCH.

• Checked
Regardless of the OS, text width is standardized on MONITOUCH.

Delete folders from 
the oldest if CF card 
is lacking in space for 
backup

Used to set the action to be taken when the CF card capacity is not 
sufficient for creating a backup file of sampling data.

• Unchecked
No backup file is created.

• Checked
• If folders dated the day before or earlier exist:

The folder of the oldest date is retrieved and is deleted entirely.
• If the folder dated the same day exists:

The oldest file in the buffer is retrieved and is deleted.

Do Not Delete the 
Alarm Now Occurring

This setting is valid when [Occurrence Time] or [Cancellation Time] is 
selected for [History Display] for alarm tracking.

• Unchecked
All the alarms being displayed can be deleted using the [DELETE] key.

• Checked
The alarms currently occurring cannot be deleted using the [DELETE] 
key.

Follow to the PLC1 
setting for the text 
process in a recipe 
file.

Used to determine how to recognize LSB and MSB when processing text 
strings in recipe files.

• Unchecked
Depends on the setting in the [Attribute Setting] dialog.

• Checked
Depends on the setting for [Text Process] in the [Communication 
Setting] tab window for PLC1.

CSV file 123.4 12.34 0.123 1234 12340

D100 D101 D102 D103 D104

Memory contents 1234 123 1 12340 57864

On MONITOUCH 123.4 12.3 0.1 1234.0 5786.4

Overflow

D100 D101 D102 D103 D104

Memory contents 1234 123 1 1234 12340

On MONITOUCH 123.4 12.3 0.1 123.4 1234.0
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1SW Word Operation 
(Transfer) Code 
Conversion

When a switch for [Function: Word Operation] is operated under the 
following conditions, the action to take place depends on this option setting.
Condition 1: [Device Connection Setting] → [Communication Setting] → 

[Code: BCD]
Condition 2: [Function] of the switch→ [Word Operation] → [Operation 

Mode:→ (Transfer)]
Condition 3: [Operation Memory: Constant (DEC/DEC-)]
Condition 4: [Operand Memory: PLC memory]

• Unchecked
The constant (DEC/DEC-) specified in the operation memory is stored 
as the DEC/DEC- data in the PLC.

• Checked
The constant (DEC/DEC-) specified in the operation memory is 
converted into BCD and stored in the PLC.

Avoid the use of 
upper three bits in the 
Read Area (n + 2)

This option determines how the high-order three bits in the read area “n + 2” 
(screen number designation) are treated following specification changes 
relevant to screen number extension.

• Unchecked
The high-order three bits are used for a screen number designation.

• Checked
The high-order three bits are system reserved (0).
Screen number designation range

• DEC: 0 - 4095
• BCD: 0 - 1999 (values after “2000” invalid)

File name 
designation in Recipe 
Macro (V7 
compatible)

This option determines the number of characters used to specify a recipe 
macro file name.

• Unchecked: 8 characters
• Checked: 10 characters (as with the case of V7) 

To be automatically checked at the time of conversion of V7→ V8

<Applicable commands>
SET_RECIPEFOLDER, RD_RECIPE_FILE, RD_RECIPE_LINE, 
RD_RECIPE_COLUMN, WR_RECIPE_FILE, WR_RECIPE_LINE, 
WR_RECIPE_COLUMN, GET_RECIPE_FILEINFO

Halt the RGB signal 
while backlight is 
OFF

This option determines the signal output setting for the RGB output (with 
option unit GU-02).

• Unchecked
The RGB signal is normally output regardless of the status of the V8 
backlight.

• Checked
The RGB signal is turned off when the V8 backlight is off.

Sampling CSV 
output: convert the 
value depending on 
the connected device

This option determines the CSV output setting for sampling data.
• Unchecked

PLC-specific numeral conversion*2 does not take place.
• Checked

PLC-specific numeral conversion*2 takes place.

Save the pitch setting 
of the texts of 
Switch/Lamp

This option is relevant to the [Pitch] setting in the [Text] tab window opened 
in the [Switch] or [Lamp] dialog.

• Unchecked
The value specified for [Pitch] is cleared at the end of the screen data 
editing.
[Pitch] is unchecked for the next editing.

• Checked
The value specified for [Pitch] is saved in the screen data.
[Pitch] is checked and provided with the set value for the next editing.
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Maintain the letter 
alignment of a 
switch/lamp

This option is relevant to the text alignment setting in the [Text] tab window 
opened in the [Switch] or [Lamp] dialog.

• Unchecked
The text alignment setting is cleared at the end of the screen data 
editing.
The alignment setting for every switch and lamp is cleared for the next 
editing.

• Checked
The text alignment setting is saved in the screen data.
The setting is retained for the next editing.

Hide ‘Battery not set’ 
message on the Main 
Menu

This option is relevant to the Main Menu screen display when the optional 
battery V7-BT is not installed.

• Unchecked
Regardless of whether or not SRAM is in use, the message “Battery not 
set” appears if the battery connector is disconnected.

• Checked
• SRAM/internal clock not used: 

The message “Battery not set” is not displayed.
• SRAM/internal clock used:

 The messages “Battery not set” and “Warning: 215” are displayed.

Allow to use 
Insert/DELETE keys 
when entering values

This option is relevant to using the [←/→] key for data insertion and using 
the [DELETE/BS] key for deletion.
For more information, refer to page 7-16.

Format the SRAM 
forcefully

This option determines the action to take in the event of error: 161 (0: ), 
indicating an SRAM formatting error, no SRAM data immediately after 
shipment, or loss of SRAM data due to battery disconnection.

• Unchecked (default)
Formatting the SRAM is executed on the Main Menu screen while the 
battery is connected with the V8 unit.

• Checked
A forced formatting is executed.
Whether an automatic formatting has been executed can be reviewed 
at $s1085.
(At the time of execution, “1” is placed at $s1085 during RUN mode.
The value at the address is cleared back to zero at the time of the 
reentry to the Main Menu screen.)

Retain compatibility 
with negative value 
handling of CVFD 
macro command

This option determines the action to take for the conversion of negative 
values.

• Unchecked (default)
An action according to the value at $s99 is taken.

• Checked
A truncation is performed, irrespective of the value at $s99.

* For more information on the macro command CVFD and address 
$s99, refer to the Macro Reference Manual.

Recipe file backup This option determines the action to take when an error occurs in writing to 
a CSV file in the recipe mode.

• Unchecked (default)
No backup file is created.

• Checked
• Normally ended: The CSV file and backup file “xxx.BAK” are 

created.
• Abnormally ended: A temporary file “xxx.000” to “xxx.999”* is 

created.

* If temporary files “xxx.000” through “xxx.999” already exist, the 
oldest file is retrieved and is deleted.
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1Update of recipe 
mode when SV/WR 
macro command is 
executed

This option determines whether or not to update the data in recipe mode 
when the RECIPE folder in the CF card is reread at the time of the following 
macro command execution.

• Unchecked (default)
The recipe mode item is not updated.

• Checked
The recipe mode item is updated.
The recipe mode item is reset to the default status.
If editing is disabled by the command memory, the current display 
status is kept.

<Applicable commands>
SV_RECIPE, SV_RECIPE2, SV_RECIPESEL, SV_RECIPESEL2, 
WR_RECIPE_FILE, WR_RECIPE_LINE, WR_RECIPE_COLUMN

Return switch 
prohibited when 
switching the screen 
by an external 
command

This option determines the action to take when the [Function: Return] switch 
is used.

• Unchecked (default)
It is possible to go back to the screen previously displayed when it is 
switched by an external command.

• Checked
It is not possible to go back to the screen previously displayed when it is 
switched by an external command.

Cancel the restriction 
on the number of 
registerable 
characters for Switch 
and Lamp (127 
characters)

This option determines the number of characters that can be displayed on 
the switch or lamp.

• Unchecked (default)
The number of registerable characters is limited according to the width 
of the item.

• Checked
A maximum of 127 characters can be registered regardless of the width 
of the item.

* If [  Size Automatic Adjustment] is checked in the [Switch] or [Lamp] 
dialog ([Text] tab window), the setting for [  Size Automatic Adjustment] 
overrides the setting made here.

Scale the upper/lower 
limit of the alarm for 
num. display

This option determines the range of values associated with alarm issue for 
numerical data display.

Example: Numerical data display to be colored blue for a value 101 or 
above
Numerical data display memory: D100
Alarm maximum value memory: $u1000, Alarm color: Blue 
Before range change: 0 - 1000
After range change: 0 - 100 (101 or above: Normal 

color → Blue) 

• Unchecked (default)
The maximum and minimum values for alarm are set in the range 
according to “After range change.” 

Alarm maximum value: $u1000 = 100
• Checked

The maximum and minimum values for alarm are set in the range 
according to “Before range change.” (With constant designated, the 
operation as the above “Unchecked” will take place.)

Alarm maximum value: $u1000 = 1000 
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*1 Station No. Table
Station numbers of target devices can be set as desired for PLC communication or temperature 
control network communication using the following devices.
• PLC: Mitsubishi QnA series (Ethernet), 1:n connection only
• PLC: Mitsubishi QnH (Q) series (Ethernet), 1:n connection only
• PLC: OMRON SYSMAC CS1/CJ1 (Ethernet Auto), 1:n connection only
• PLC: OMRON SYSMAC CS1/CJ1 DNA (Ethernet Auto), 1:n connection only
• Temperature controller: Fuji Electric M-MPC04P (loader)
• Temperature controller: Fuji Electric F-MPC04S (UM03)

*2 Applicable PLC models
• Hitachi: All models
• Yaskawa Electric: Memobus (transfer mode 1)
• Siemens: All models
• OMRON: All models (transfer mode 2)
• Fuji Electric: MICREX-F series and MICREX-F T-link
• General-purpose PROFIBUS-DP

Font Setting

Select the language to be displayed on the V8 series unit.
For more information, refer to “Appendix 3  Display Language.”
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1Global Function Switch Setting

There are function switches [F1] to [F7] ([F1] to [F5] for the V806 series) provided on the V8 series.
These switches can be used for all screens in the RUN mode.

* When the menu is displayed after the [SYS] key is pressed, these switches work as a mode 
switch, brightness adjustment switch, contrast adjustment switch, and backlight control switch.

* When the screen with local function switch setting is displayed, the setting for local function switch 
has priority.

* For more information on the setting items, refer to “3  Switch.”

 Use Function 
Switch

Check this box when using the global function switch.

Function Set the switch function.

Operation This option is active when [Output Memory] is checked.
Select the write operation to the output memory.

 Output Memory When the switch is pressed, output information is written into the specified 
memory.

 ON Macro Set the ON macro for the function switch.
For more information on macros, refer to the Macro Reference Manual.

 OFF Macro Set the OFF macro for the function switch.
For more information on macros, refer to the Macro Reference Manual.

 Interlock Set interlock for the function switch.
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CF Card Setting

Valid when using a CF card.
For more information, refer to “18  CF Card.”

Attribute Setting

Make the setting when reading or writing a CSV file from or into a CF card.
When using a macro, refer to the Macro Reference Manual; when using the recipe mode, refer to “13  
Recipe Mode”.

Buffering Area Setting

Make the setting when using the sampling mode.
For more information, refer to “Appendix 1  Buffering Area.”

Memory Card Setting

Make the setting when using the memory card mode.  (This is automatically set when using the data 
logging function.)
For more information on the memory card mode, refer to “15.2  Memory Card Mode.” 

MES Setting

Make the setting for the MES interface function.
For more information, refer to the V8 Series Reference Additional Functions.

Operation Log Setting

Make the setting for operation log.
For more information, refer to the V8 Series Reference Additional Functions.

Security Setting

Make the setting for the security function.
For more information, refer to the V8 Series Reference Additional Functions.

Remote Desktop Table Setting

Make the setting of the table for the remote desktop window display.
For more information, refer to the V8 Series Reference Additional Functions.
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1Macro Setting

Make the setting for initial macro, global macro or event timer macro.
For more information, refer to the Macro Reference Manual.

Time Display Format Setting

Use this setting when you want to define a calendar data format.
For more information, refer to “12  Calendar.”

Use Japanese Conversion Function

Make the settings when using the Japanese conversion function.
For more information, refer to “7  Entry Mode.”
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Please use this page for notes.
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2 Overlap
Overview

What Is “Overlap”?

It is possible to show a screen covering over a part of an ordinary screen.  This sectional window is 
called an “overlap” display.

With the V8 series, a maximum of three overlap displays can be shown at one time on the base 
screen.

When several overlap displays are shown at the same time, it is possible to move one that is partly 
behind another overlap display to the front with a touch.

000,000

00 sec.

Line A Paint Process Line A Paint Process

Count
Timer

Error contents Error contents

Screen 
Change

Screen 
Change

Line A

Error 
Detail

Error
Log

Line B Line C Line D

Num. 
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Detail

Do you want to save the setting?

YES NO

Global overlap allows for a maximum of four 
overlap displays on the base screen at one time.

For more information on global overlap, refer to 
page 2-43.

New function for version 5.4.17.0 (SYSTEM 
PROGRAM version 1.650)
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* However, when the value except “0” is entered in system memory address $s77, only the switches 
(including the system button) on the overlap display on the forefront are available.

For more information on the system memory ($s), refer to “Appendix 6  Internal Memory.”

Overlap and Screen

A maximum of four overlap displays can be shown on one screen.  This is because overlap areas are 
secured preliminarily as screen components.
Each overlap area is identified with an “overlap ID.”

* Overlap ID
An ID is given to each overlap area for the purpose of identification, which enables you to register 
a maximum of four overlap displays on the screen.

Only the switches on this overlap 
display are available.
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Video Overlap (For Channel Selection)

• Images taken by a video camera are 
displayed directly on one overlap area.

To show a video image, we recommend using a “video/RGB display” item instead of the video 
overlap function.
For more information, refer to “14.2  Video/RGB Display.”
However, when using the channel selection macro, use the video overlap function.  For more 
information, refer to page 2-47.

Overlap Display Formats

Five display formats can be set for overlap area.

Normal Overlap

When an overlap screen is to be displayed on a specific screen, set the “normal overlap” format.
Use one of three overlap areas (IDs) on the screen, as a normal overlap area.
A maximum of three “normal overlap” areas can be set on each screen.

1CH 2CH 3CH 4CH

Contrast

Gain

Bright

Save

Size

Menu

Help

Overlap Normal overlap (See page 2-6.)
Multi-overlap (See page 2-13.)
Call-overlap (See page 2-24.)
Global overlap (See page 2-43.)
Video overlap (See page 2-47.)

Place a “normal overlap” part on overlap ID 0.

Menu

Screen

Overlap ID 0 Overlap ID 1 Overlap ID 2
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Multi-overlap

Set the “multi-overlap” format when more than three overlap displays need to be shown on one screen.

Call-overlap

The “call-overlap” format is used for a commonly used sectional screen, such as a menu screen, which 
should allow access from any screen display.
If you register once, you can use the same overlap setting on different screens.  Using this format 
saves the memory space for screen data.
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The “Menu” window is
an overlap display commonly 
used for all these screens.
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Global Overlap
Set the “global overlap” format to keep the same overlap display shown even while the screen is 
switched to another.  The overlap display discussed above is designated as overlap ID3 and is 
registered in the overlap library.

Video Overlap (For Channel Selection)

Set the “video overlap” format to display images taken by a video camera.
Use one of three overlap areas (IDs) on the screen, as a video area.
Only one video area can be set on the screen.
The image displayed on the video overlap area can be displayed on four channels.

* Images of video will always be displayed in the forefront of the screen.  No overlap screen 
under the video display screen can be brought to the forefront, even by touching on the 
overlap display.
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Do you want to save the setting?
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Menu
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Screen 3

Switch to another screen

Details Details

When registering the “video overlap” format for overlap ID 0, a 
video overlap display is called up.Screen

Overlap ID 0
(Video overlap)

Overlap ID 1 Overlap ID 2
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Normal Overlap

Configuration

Register the “normal overlap” format on the screen.  A maximum of three “normal overlap” screens can 
be set on each screen.

0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP
Line A Error!

Detail

Do you want to save the setting?

YES NO

Screen

Normal overlap
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Setting Dialog
Main

Overlap ID
(0 to 2)

Set the overlap area (ID 0 - 2) where the normal overlap display is to be 
called.
A maximum of three overlaps can be set for each screen; if another normal 
overlap or multi- or call-overlap has been registered, the desired overlap ID 
may not be specified.
Normally, an overlap ID is automatically assigned.

 System Button When this box is checked, the overlap screen is equipped with a special 
button (= switch).
For more information, refer to page 2-43.

 Superimpose When this box is checked, the superimpose function can be used.
For more information on the superimpose function, refer to page 2-44.
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Style

Frame Type This is valid when a part compatible with the former MONITOUCH series is 
selected.
Select the desired frame type from five options shown below:
No Frame, Line, Paint, Tile, Shadow

Color (Frame, Area) For more information, refer to “Appendix 4  Styles and Coordinates” on 
page A4-9.

Change Part For more information, refer to the Operation Manual.
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Detail

*1 When this box is checked, it is not possible to use bits 0 to 2 of read area “n + 1” for showing or 
hiding the overlap display.

If you select [System Setting] → [Device Communication Setting] → [Read/Write Area] and 
check [  GD-80 Compatible Read/Write Area], the setting for [  Command Memory] becomes 
invalid.

 Command Memory *1 When this box is checked, specify one word of memory as desired.
This is used for showing or hiding the overlap display according to the 
data in the specified memory address.

When this box is not checked, bits 0 to 2 of read area “n + 1” are used.

 Item Select Memory This is required when using “entry mode” on the overlap screen.
For more information, refer to “Item Select Function” on page 7-36

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0: Hide
1: Show

Not used (Be sure to set “0”.)
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Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates” on page A4-10.

Editing Procedure

When you want to edit parts of a normal overlap area set on the screen, select the normal overlap area 
(with handles shown around) once.

If you place a switch or lamp part of text in this condition, it is placed on the normal overlap area.  
When you deselect the normal overlap area, you can place items on the screen.

For more information on the editing procedure, refer to the Operation Manual.
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Showing and Hiding a Normal Overlap Display
There are four methods below to show or hide a normal overlap display on or from the screen.

Internal command
• Switch

The switch function is available to show and hide normal overlap displays.
The following switches can be used.

For more information on the switch setting, etc., refer to “3  Switch.”

• Macro
A macro command is available to show and hide normal overlap displays.
Use the OVLP_SHOW command.
Additionally, the display location can also be specified.  (Use the OVLP_POS command.)
For more information, refer to the Macro Reference manual.

External command
• When using the read area

Commands from the read area are available to show and hide normal overlap displays.*1

Bit 0 of read area “n + 1” (screen status command) in the [Read/Write Area] dialog that is 
displayed by selecting [System Setting] → [Device Connection Setting] is for overlap No. 0, bit 1 
for overlap No. 1 and bit 2 for overlap No. 2. 

Method Details See:

Internal 
command Switch Function: Overlap Display Explanation 

below

Macro OVLP_SHOW
OVLP_POS

Macro 
Reference 
Manual

External 
command Read area “n + 1” Bits 0 to 2

(0: Hide, 1 Show) page 2-11

Command 
memory

Bit 0
(0: Hide, 1 Show) page 2-12

Operation Switch Function Attached Setting

Show Overlap Display

Overlap ID 0 to 2
Action = ON

Overlap ID 0 to 2
Action = ALT

Hide Overlap Display

Overlap ID 0 to 2
Action = OFF

Overlap ID 0 to 2
Action = ALT

Overlap ID 2

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0

Overlap ID 1
Overlap ID 0

0: Hide
1: Show

[Read Area] n + 1

MSB LSB
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• When using the command memory
Commands from the command memory are available to show and hide normal overlap displays.*1

For the normal overlap setting, bring up the [Normal Overlap] dialog →  [Detail] tab window, check 
the box for [  Command Memory] and specify the desired memory address. 

*1 Recognition of bit status
The way of recognizing bit status depends on the setting for [ Display Overlap during bit ON] in 
the [General Settings] tab window ([System Setting] → [Unit Setting] → [General Settings]). 
• Unchecked:

Bit status is recognized at the edges (0 → 1 or 1 → 0) of each bit.
• Checked:

Level recognition is used to recognize bit status.
Suppose that an overlap display was shown at an external command on the screen, the 
screen was switched to another, and then is displayed again.  In a case like this, the overlap 
display that corresponds to the bit being set (ON) appears on the screen.

* Notes on showing an overlap display using an external command
A switch for [Function: Overlap Display = OFF] is usable to hide the overlap display.  Using this 
type of switch hides the overlap display, whereas the bit is still set (ON).  To show the overlap 
display again, the bit requires to be reset (OFF) and set (ON) again.

Memory Related to Normal Overlap Display
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7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

D0002

Bit 0 of read area “n + 1”: 0 → 1 Bit 0 of read area “n + 1”: 1 → 0

Line B Monitor

Line A Error!

Detail

Line B Monitor

Memory See:

Read Area (n + 1) page 2-11

Command Memory page 2-12

Item Select Memory page 7-36 “Item Select Function”

0: Hide
1: Show

Not used (Be sure to set “0”.)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
[Command Memory] n

MSB LSB
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Multi-overlap

Configuration

To show a multi-overlap display, select [Multi] for one of the overlap ID 0 to 2.
Register overlap screens as overlap libraries and call the desired one on an overlap area (ID 0 to 2).  A 
maximum of three overlap screens can be displayed at one time; however, if you select the 
multi-overlap format, you can show as many screens as desired by switching the overlap library for 
three overlap screens.
A multi-overlap display can be shown or hidden by a switch or a command from the PLC.

0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

Line A Error!

Detail

Do you want to save the setting?

YES NO

Menu

Screen Overlap library
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Setting Dialog
[Multi-Overlap] dialog (on the screen)

• Main

Overlap ID
(0 to 2)

Set the overlap area (ID 0 - 2) where an overlap display registered as an 
overlap library is to be called for the “multi-overlap” format.

Designate
(Internal/External)

Internal:
An overlap display can be shown or hidden by pressing a switch placed 
on the screen.
For more information, refer to page 2-20.

External:
An overlap library number is specified from the memory, and is shown or 
hidden according to read area “n + 1”.
In this case, the display position can also be specified by an external 
command. 
For more information, refer to page 2-21.

Info Output Memory Specify the desired memory address.
The overlap library number currently shown on the screen is stored in the 
top memory address “n”.  When no overlap display is shown, “−1” is stored.
If [Internal] is selected for [Designate], one word of top memory address “n” 
is used.
If [External] is selected for [Designate], a maximum of four words from top 
memory address “n” is used. (n to n+3)
For more information, refer to page 2-22.

Overlap Library No. This is valid only when [External] is selected for [Designate].
A memory address of [Info Output Memory] “n + 1” is automatically 
allocated.
Specify the overlap library number to be displayed in advance.
For more information, refer to page 2-22.

Coordinate 
Designation

This is valid only when [External] is selected for [Designate].
Based on the address specified for [Info Output Memory], addresses 
“n + 2” or “n + 3” are automatically allocated.  For more information, refer to 
page 2-41.
Checked:

Coordinates of the display position are specified from the memory.
[Info Output Memory] “n + 2”: X coordinate
[Info Output Memory] “n + 3”: Y coordinate

Unchecked:
The overlap display is shown in the position as registered in the overlap 
library.
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• Detail

*1 When this box is checked, it is not possible to use bits 0 to 2 of read area “n + 1” for showing or 
hiding the overlap display.

If you select [System Setting] → [Device Communication Setting] → [Read/Write Area] and 
check [  GD-80 Compatible Read/Write Area], the setting for [  Command Memory] becomes 
invalid.

 Command Memory *1 When this box is checked, specify one word of memory as desired.
This is used for showing or hiding the overlap display according to the 
data in the specified memory address.

When this box is not checked, bits 0 to 2 of read area “n + 1” are used.

 Item Select Memory This is required when using “entry mode” on the overlap screen.
For more information, refer to “Item Select Function” on page 7-36

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0: Hide
1: Show

Not used (Be sure to set “0”.)
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[Overlap] dialog (on an overlap library)
• Main

 System Button When this box is checked, the overlap screen is equipped with a special 
button (= switch).
For more information, refer to page 2-43.

 Superimpose When this box is checked, the superimpose function can be used.
For more information on the superimpose function, refer to page 2-44.
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• Style

Frame Type This is valid when a part compatible with the former MONITOUCH series is 
selected.
Select the desired frame type from five options shown below:
No Frame, Line, Paint, Tile, Shadow

Color (Frame, Area) For more information, refer to “Appendix 4  Styles and Coordinates” on 
page A4-9.

Change Part For more information, refer to the Operation Manual.
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• Detail

 Read PLC Memory 
when OFF

This setting item becomes active when you select the multi-overlap or 
global overlap format.

* This setting is not valid for the call-overlap format.
Reading from the PLC memory is continued.

Checked (Continue):
Even when an overlap display is hidden, reading from the PLC memory 
for an item on the overlap display continues.
When the overlap display is shown again, it is processed at a high speed 
since information is constantly read.  Conversely, while the overlap 
display is not shown, screen display processing will be slowed down.

Unchecked (Discontinue):
When an overlap display that has been read is hidden, its information is 
completely erased.  As a result, it will be somewhat time-consuming to 
show the same overlap display afterward.  Without overlap display, 
however, screen display is smoothly performed.
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• Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates” on page A4-10.

Editing Procedure

When you want to edit parts for an overlap library, select the overlap area (with handles shown around) 
once.

If you place a switch or lamp part or text in this condition, it is placed on the overlap library.  When you 
deselect the overlap library, you can place items on the base screen.

For more information on the editing procedure, refer to the Operation Manual.

Macros That Can Be Registered for Overlap Library

An OPEN macro and a CLOSE macro can be registered for each overlap library.  Each macro is 
executed when the overlap library is brought up for the multi-overlap format on a screen or is cleared 
from the screen.
For more information on macros, refer to the Macro Reference Manual.
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Showing and Hiding a Multi-overlap Display
When an overlap display registered in the overlap library is used to show it in the multi-overlap format 
on the screen or hide the overlap display from the screen, either internal or external commands may 
be used.
Setting for either command (internal or external) is made in the [Multi-Overlap] dialog.

Internal command
• Switch

The switch function is available to show and hide multi-overlap displays.
The following switches can be used.

*1 When this box is not checked, it is displayed in the same position as it is placed for the overlap 
library.
When this box is checked, you can specify the display position as desired using a switch.

For more information on the switch setting, etc., refer to “3  Switch.”

• Macro
Using a macro, the multi-overlap display can be shown or hidden.
Use the SET_MOVLP, OVLP_SHOW command.
For more information, refer to the Macro Reference Manual.

Method Details See:

Internal 
Command

Switch function Multi-overlap display → Show
Overlap display (OFF)→ Hide

Explanation 
below

Macro
SET_MOVLP → Show
OVLP_SHOW → Hide

Macro 
Reference 
Manual

External 
command

Show 
command

Read area 
“n + 1”

Bits 0 to 1 of read area “n + 1”
(0: Hide, 1 Show)

Explanation 
below

Command 
memory

Command Memory  Bit 0
(0: Hide, 1 Show) page 2-21

Target library 
designation

Overlap Library No.
(= Info Output Memory “n + 1”) page 2-22

Coordinate designation
This is valid only when [  Coordinate 
Designation] is checked.
(= Info Output Memory “n + 2”, “n + 3”)

page 2-22

Operation Switch Function Attached Setting

Show Multi-Overlap Display Overlap ID 0 to 2
Overlap Library No.

 Display Position*1

Hide Overlap Display Overlap ID 0 to 2
Action = OFF
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External command (to show or hide)
• When using the read area

Commands from [Overlap Library No.] and [Read Area] are available to show and hide 
multi-overlap displays.
Follow the steps below.

1) Specify the overlap library number to be displayed for [Overlap Library No.].
2) Showing and hiding the multi-overlap display are under the control of bits 0 to 2 (overlap ID 0 

to 2) of read area “n + 1” in the [Read/Write Area] tab window that is displayed by selecting 
[System Setting] → [Device Connection Setting].

• When using the command memory
Commands from [Overlap Library No.] and [Command Memory] are available to show and hide 
multi-overlap displays.
Follow the steps below.

1) Specify the overlap library number to be displayed for [Overlap Library No.].

2) Bring up the [Multi-Overlap] dialog →  [Detail] tab window, check the box for [  Command 
Memory] and specify the desired memory address. 
The multi-overlap display is shown or hidden according to bit 0 being set (ON) or reset (OFF) 
at the address of [Command Memory].

Overlap ID 2

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0

Overlap ID 1
Overlap ID 0

  0: Hide
  1: Show

[Read Area] n + 1

MSB LSB

D0002
D0304 3 D0304 3

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

Specify the number for [Overlap Library No.]. Bit 0 of read area “n + 1”: 0 → 1

Overlap library No. 3

Line B Monitor Line B Monitor

Do you want to save the setting?

YES NO

Do you want to save the setting?

YES NO
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* Notes when showing a multi-overlap display using an external command
• Suppose that a multi-overlap display was shown at an external command on the screen, the 

screen was switched to another, and then is displayed again.  In a case like this, the overlap 
display that corresponds to the bit being set (ON) appears on the screen.

• A switch for [Function: Overlap Display = OFF] is usable to hide the overlap display.  Using this 
type of switch hides the overlap display, whereas the bit is still set (ON).  To show the overlap 
display again, the bit requires to be reset (OFF) and set (ON) again.

External command (when specifying the display position using an external 
command)
External commands are also available to specify the position of an overlap display, not only to show 
and hide the display.
For coordinate designation, follow the steps below.

1. Select [System Setting] → [Unit Setting] → [Overlap].  Then select [Overlap Coordinates].

* [Dot] is not available with matrix type switches.
It is fixed to [Line/Column].

2. Select [Multi-Overlap] dialog → [Main] and check the box for [  Coordinate Designation].   
Automatically [Info Output Memory] “n + 2” and “n + 3” are allocated for memory addresses for [X 
Coordinate] and for [Y Coordinate], respectively.
Specify the coordinate value in increments selected in step 1.

* When no coordinate is specified, the overlap display is shown in the position as registered in the 
overlap library.

Line/Column The position can be moved in 8 dots (X) and in 20 dots (Y).

Dot* The position can be moved in 4 dots (X) and in 1 dot (Y).

Memory Contents Operation

Info Output Memory “n” The overlap library number of the 
multi-overlap display currently shown 
on the screen is stored.
When no overlap display is shown, 
“−1” is stored.

V → PLC

Overlap Library No.
(Info Output Memory “n + 1”)

Specify the overlap library number to 
be displayed. V ← PLC

Coordinate Designation: X Coordinate
(Info Output Memory “n + 2”)

The X coordinate for multi-overlap 
display is specified. V ← PLC

Coordinate Designation: Y Coordinate
(Info Output Memory “n + 3”)

The Y coordinate for multi-overlap 
display is specified. V ← PLC

0: Hide
1: Show

Not used (Be sure to set “0”.)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
[Command Memory] n

MSB LSB
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Memory Related to Multi-overlap Display

Memory See:

Info Output Memory page 2-16

Overlap Library No. page 2-21

Read Area (n + 1) page 2-21

Command Memory page 2-21

Coordinate Designation: X/Y Coordinate page 2-22

Item Select Memory page 7-36 “Item Select Function”
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Call-overlap

Configuration

To show a call-overlap display, select [Call] for one of the overlap ID 0 to 2.
Register overlap screens as overlap libraries and call the desired one on an overlap area (ID 0 to 2).
A call-overlap display can be shown or hidden by a switch or a command from the PLC.

0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

Line A Error!

Detail

Do you want to save the setting?

YES NO

Menu

Screen Overlap library

Line A Error!

Detail

Menu

Overlap ID 0

Overlap ID 1

Overlap ID 2
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Setting Dialog
[Call-Overlap] dialog (on the screen)

• Main

*1 Start X/Y
The call-overlap icon position corresponds to the upper left corner of the overlap display that will 
be shown.

Overlap ID
(0 to 2)

Set the overlap area (ID 0 - 2) where an overlap display registered as an 
overlap library is to be called for the “call-overlap” format.

Overlap Library No. Specify the overlap library number to be called on the overlap area (ID).
Click [Open] to browse in the overlap library list.

Start X *1

Start Y
Specify the overlap display position.

[Call-Overlap] icon

Menu
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• Detail

*1 When this box is checked, it is not possible to use bits 0 to 2 of read area “n + 1” for showing or 
hiding the overlap display.

The item [  Command Memory] becomes inactive if [  GD-80 Compatible Read/Write Area] is 
checked ([System Setting] → [Device Connection Setting] → [Read/Write Area]).

 Command Memory When this box is checked, specify one word of memory as desired.
This is used for showing or hiding the overlap display according to the 
data in the specified memory address.

When this box is not checked, bits 0 to 2 of read area “n + 1” are used.

 Item Select Memory This is required when using “entry mode” on the overlap screen.
For more information, refer to “Item Select Function” on page 7-36

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0: Hide
1: Show

Not used (Be sure to set “0”.)
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[Overlap] dialog (on an overlap library)
• Main

 System Button When this box is checked, the overlap screen is equipped with a special 
button (= switch).
For more information, refer to page 2-43.

 Superimpose When this box is checked, the superimpose function can be used.
For more information on the superimpose function, refer to page 2-44.
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• Style

Frame Type This is valid when a part compatible with the former MONITOUCH series is 
selected.
Select the desired frame type from five options shown below:
No Frame, Line, Paint, Tile, Shadow

Color (Frame, Area) For more information, refer to “Appendix 4  Styles and Coordinates” on 
page A4-9.

Change Part For more information, refer to the Operation Manual.
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• Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates” on page A4-10.

Editing Procedure

When you want to edit parts for an overlap library, select the overlap area (with handles shown around) 
once.

If you place a switch or lamp part or text in this condition, it is placed on the overlap library.  When you 
deselect the overlap library, you can place items on the base screen.

For more information on the editing procedure, refer to the Operation Manual.

OPEN/CLOSE Macros for Overlap Library

* For the call-overlap format, the OPEN/CLOSE macros are not valid.
These macros are valid for the multi-overlap format.
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Showing and Hiding a Call-overlap Display
There are the following four methods to show or hide a call-overlap display on or from the screen.

Internal command
• Switch

The switch function is available to show and hide call-overlap displays.
The following switches can be used.

For more information on the switch setting, etc., refer to “3  Switch.”

• Macro
A macro command is available to show and hide call-overlap displays.
Use the OVLP_SHOW command.
Additionally, the display location can also be specified.  (Use the OVLP_POS command.)
For more information, refer to the Macro Reference Manual.

External command
• When using the read area

Commands from the read area are available to show and hide call-overlap displays.*1  

Bit 0 of read area “n + 1” (screen status command) in the [Read/Write Area] dialog that is 
displayed by selecting [System Setting] → [Device Connection Setting] is for overlap No. 0, bit 1 
for overlap No. 1 and bit 2 for overlap No. 2. 

Method Details See:

Internal 
Command Switch Function: Overlap Display Explanation 

below

Macro OVLP_SHOW
OVLP_POS

Macro 
Reference 
Manual

External 
command Read area “n + 1” Bits 0 to 2

(0: Hide, 1 Show)
Explanation 
below

Command 
Memory

Bit 0
(0: Hide, 1 Show) page 2-31

Operation Switch Function Attached Setting

Show Overlap Display

Overlap ID 0 to 2
Action = ON

Overlap ID 0 to 2
Action = ALT

Hide Overlap Display

Overlap ID 0 to 2
Action = OFF

Overlap ID 0 to 2
Action = ALT

Overlap ID 2

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0

Overlap ID 1
Overlap ID 0

  0: Hide
  1: Show

[Read Area] n + 1

MSB LSB
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• When using the command memory
Commands from the command memory are available to show and hide call-overlap displays.  *1

Bring up the [Call-Overlap] dialog → [Detail] tab window, check the box for [  Command Memory] 
and specify the desired memory address.

*1 Recognition of bit status
The way of recognizing bit status depends on the setting for [ Display Overlap during bit ON] in 
the [General Settings] tab window ([System Setting] →  [Unit Setting] →  [General Settings]). 
• Unchecked:

Bit status is recognized at the edges (0  1 or 1  0) of each bit.
• Checked:

Level recognition is used to recognize bit status.
Suppose that an overlap display was shown at an external command on the screen, the 
screen was switched to another, and then is displayed again.  In a case like this, the overlap 
display that corresponds to the bit being set (ON) appears on the screen.

* Notes on showing an overlap display using an external command
A switch for [Function: Overlap Display = OFF] is usable to hide the overlap display.  Using this 
type of switch hides the overlap display, whereas the bit is still set (ON).  To show the overlap 
display again, the bit requires to be reset (OFF) and set (ON) again.

Memory Related to Call-overlap Display

D0002

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

D0002

Bit 0 of read area “n + 1”: 0 → 1 Bit 0 of read area “n + 1”: 1 → 0

Line B Monitor

Line A Error!

Detail

Line B Monitor

Memory See:

Read Area (n + 1) page 2-30

Command Memory page 2-31

Item Select Memory page 7-36 “Item Select Function”

0: Hide
1: Show

Not used (Be sure to set “0”.)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
[Command Memory] n

MSB LSB
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Global Overlap

Configuration
For showing global overlap displays on the screen, the global overlap format needs to be set ([System 
Setting] → [Global Overlap Setting]).  When an overlap display has been registered in the overlap 
library, it can be called as overlap ID 3 to the screen.
Once the overlap display is called onto the screen, it remains there even the screen is switched to 
another, until the command to hide is issued.

0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

Line-A Error!

Details

Do you want to save the setting?

YES NO

Menu

Screen Overlap library

Line-A Error!

Line-A Error!

Overlap ID 3

Overlap ID 3

Switch to another 
screen

[Global Overlap Setting] dialog (ID 3)

Details

Details
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Setting Dialog
[Global Overlap Setting] dialog

• Main

Overlap ID 3 ID 3 is allocated to a global overlap display.

Designate
(Internal, External)

Internal:
An overlap display can be shown or hidden by pressing a switch placed 
on the screen or by a macro command.

External:
An overlap display can be shown or hidden according to an overlap 
library number specified in memory.  The display position can also be 
specified by an external command.

Info Output Memory Specify the desired memory address.
The overlap library number currently shown on the screen is stored in 
memory at the top memory address “n”.  When no overlap display is 
shown, “−1” is stored.
If [Internal] is selected for [Designate], one word of top memory address “n” 
is used.
If [External] is selected for [Designate], a maximum of four words from top 
memory address “n” is used. (n to n + 3)
For more information, refer to page 2-41.

Overlap Library No. This is valid only when [External] is selected for [Designate].
Based on the address specified for [Info Output Memory] , address “n + 1” 
is automatically allocated.
Specify the overlap library number to be displayed using this item.
For more information, refer to page 2-41.

Coordinate 
Designation

This is valid only when [External] is selected for [Designate].
Based on the address specified for [Info Output Memory], addresses 
“n + 2” or “n + 3” are automatically allocated.  For more information, refer to 
page 2-41.
Checked:

Coordinates of the display position are specified from the memory.
[Info Output Memory] “n + 2”: X coordinate
[Info Output Memory] “n + 3”: Y coordinate

Unchecked:
The overlap display is shown in the position as registered in the overlap 
library.
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• Detail

*1 When this box is checked, bit 3 of read area “n + 1” is invalid to show or hide overlap displays.
The item [  Command Memory] becomes inactive if [  GD-80 Compatible Read/Write Area] is 
checked ([System Setting] → [Device Connection Setting] → [Read/Write Area]).

 Command Memory 
*1

Checked:
Specify one word of memory as desired.
This is used for showing or hiding the overlap display according to the 
data at the specified memory address.

Unchecked:
Bit 3 of read area “n + 1” is used at all times.

Item Select Memory This is required for using “entry mode” on a overlap display.
For more information, refer to “Item Select Function” page 7-36.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

  0: Hide
  1: Show

Not used (Be sure to set “0”.)
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[Overlap] dialog (for the overlap library)
• Main

System Button When this box is checked, the overlap display is equipped with a special 
button (= switch).
For more information, refer to page 2-43.

Superimpose When this box is checked, the superimpose function can be used.
For more information on the superimpose function, refer to page 2-44.
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• Style

Frame Type This setting item is active when a part compatible with the former 
MONITOUCH series is selected.
Select the desired frame type from five options shown below:
No Frame, Line, Paint, Tile, Shadow

Color (Frame, Area) For more information, refer to “Appendix 4  Styles and Coordinates” on 
page A4-9.

Change Part For more information, refer to the Operation Manual.
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• Detail

 Read PLC Memory 
when OFF

This setting item becomes active when the multi-overlap or global overlap 
format is selected.

* This setting is not valid for the call-overlap format.
Reading the PLC memory continues.

Checked (Continue):
Even when an overlap display is hidden, reading from the PLC memory 
for an item on the overlap display continues.
When the overlap display is shown again, it is processed at a high speed 
since information is constantly read.  Conversely, while the overlap 
display is not shown, screen display processing will slow down.

Unchecked (Discontinue):
When an overlap display that has been read is hidden, its information is 
completely erased.  As a result, it will be somewhat time-consuming to 
show the same overlap display afterward.  Without overlap display, 
however, screen display is smoothly performed



2    Overlap

2-38

• Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates” on page A4-10 .

Editing Procedure
When an overlap display registered in the overlap library is to be edited, select the overlap display 
(with handles shown around) once.

On the overlap display enclosed with handles, parts (switches, lamps, or text) can be placed on the 
display.  When the overlap display is deselected then, placing those parts is allowed on the base 
screen.

For more information on the editing procedure, refer to the Operation Manual.
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Macros Available in Overlap Library
An OPEN macro and a CLOSE macro can be registered in the overlap library.  When an overlap 
display in the global overlap format is shown on or hidden from the screen, these macros registered 
with the overlap display are individually executed.
For more information on macros, refer to the Macro Reference Manual.

Showing and Hiding a Global Overlap Display
When an overlap display registered in the overlap library is used to show or hide it on or from the 
screen as a global overlap display, any of the following four methods may be used.

Internal command
• Switch

The switch function is available to show and hide the global overlap display.
The following switches can be used.

*1 When this box is not checked, the overlap display is shown in the position as registered in 
the overlap library.
When this box is checked, you can specify the display position as desired using a switch.

For more information on the switch setting, etc., refer to “3  Switch”.

• Macro
Macro commands are available to show and hide the global overlap display.
Use the macro commands “SET_MOVLP” and “OVLP_SHOW”.
For more information, refer to the Macro Reference Manual.

Method Details Refer to:

Internal 
Command

Switch function Multi-Overlap Display → Show
Overlap Display (OFF)→ Hide

Explanation 
below

Macro SET_MOVLP → Show
OVLP_SHOW → Hide

Macro 
Reference 
Manual

External 
Command

Command 
to show

Read area 
“n + 1”

Bit 3 of read area “n + 1”
(0: Hide, 1 Show) page 2-40

Command 
memory

Command memory  Bit 0
(0: Hide, 1 Show) page 2-40

Target library 
designation

[Overlap Library No.]
(= Info Output Memory “n + 1”) page 2-41

Coordinate designation
This is valid only when [  Coordinate 
Designation] is checked.
(= Info Output Memory “n + 2”, “n + 3”)

page 2-41

Action Switch Function Attached Setting

Show Multi-Overlap Display Overlap ID 3
Overlap library number

 Display Position*1

Hide Overlap Display Overlap ID 3
Action = OFF
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 External command (to show or hide)
• When using the read area

Commands from [Overlap Library No.] and [Read Area] are available to show and hide the global 
overlap display.
Follow the steps below.

1) Specify the overlap library number for [Overlap Library No.].
2) Show or hide the overlap using bit 3 (for overlap ID 3) of the [Read Area] “n + 1” in the 

[Read/Write Area] tab window ([System Setting] → [Device Connection Setting]).

• When using the command memory
Commands from [Overlap Library No.] and [Command Memory] are available to show and hide the 
global overlap display.
Follow the steps below.

1) Specify the overlap library number to be displayed for [Overlap Library No.].

2) Open the [Global Overlap Setting] dialog → [Detail] tab window, and check [  Command 
Memory].  Specify an address of the command memory arbitrarily.

3) Show or hide the global overlap display using bit 0 (ON or OFF) in [Command Memory].

Overlap ID 3

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

    0: Hide
    1: Show

[Read Area] n + 1

MSB LSB

D0002
D0304 3 D0304 3

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

Specify the number for [Overlap Library No.]. Bit 3 of read area “n + 1”: 0 → 1

Overlap library No. 3

Line B Monitor Line B Monitor

Do you want to save the setting?

YES NO

Do you want to save the setting?

YES NO
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* Notes on showing a global overlap display using an external command
A switch for [Function: Overlap Display = OFF] is usable to hide the global overlap display.  Using 
this type of switch hides the overlap display, whereas the bit is still set (ON).  To show the overlap 
display again, the bit requires to be reset (OFF) and set (ON) again.

External command (when specifying the display position using an external 
command)
External commands are also available to specify the position of an overlap display, not only to show 
and hide the display.
For coordinate designation, follow the steps below.

1. Click [System Setting] → [Unit Setting] → [Overlap].  Then select [Overlap Coordinates].

* [Dot] is not available with matrix type switches.
Positioning is always on the basis of [Line/Column].

2. Open the [Global Overlap Setting] dialog → [Main] tab window.  Check [  Coordinate 
Designation].  Based on [Info Output Memory], “n + 2” and “n + 3” are automatically allocated to 
memory addresses for [X Coordinate] and for [Y Coordinate], respectively.
Specify coordinates in units as selected in step 1.

* When no coordinate is specified, the overlap display is shown in the position as registered in the 
overlap library.

Line/Column Positions are movable in increments of 8 dots on the X axis and 
20 dots on the Y axis.

Dot* Positions are movable in increments of 4 dots on the X axis and 
1 dot on the Y axis.

Memory Contents Action

Info Output Memory “n” The overlap library number of the global 
overlap display currently shown on the 
screen is stored.
When no overlap display is shown, “-1” is 
stored.

V → PLC 

Overlap Library No.
(Info Output Memory “n + 1”)

Specify the overlap library number to be 
displayed. V ← PLC

Coordinate Designation: X Coordinate
(Info Output Memory “n + 2”)

Specify the X coordinate of the global 
overlap display. V ← PLC

Coordinate Designation: Y Coordinate
(Info Output Memory “n + 3”)

Specify the Y coordinate of the global 
overlap display. V ← PLC

  0: Hide
  1: Show

Not used (Be sure to set “0”.)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
[Command Memory] n

MSB LSB
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Memory Related to Global Overlap Display

Limitations

• The global overlap display is not shown while the login screen registered in the [Security Setting] 
dialog is displayed.
After the screen is switched to another, the global overlap display will be shown.

• The global overlap display will be redisplayed after any of the following actions:
• The macro command “CHG_LANG” has been executed to change the language.
• The item placed on the global overlap display has been shown/hidden.
• The offset memory value of the item placed on the global overlap display has been changed.
• While a global overlap display is shown, showing the overlap display of the same overlap 

library number takes place.
• The data block area cannot be used on the global overlap display.  If used in this way, the contents 

in the data block area will not be displayed on MONITOUCH.
“Warning” is displayed on the [Error Check] window in the following cases:

• Macro command “SET_MOVLP” used with [Designate: Internal], or [Designate: External] 
Do not specify the overlap library number with which a data block area is registered for a 
global overlap display.

• [Designate: Internal] and a switch provided with [Function: Multi-Overlap Display] 
Change the overlap library number, or delete the data block area from the specified overlap 
library.

• When the global overlap display is used, “3” cannot be specified for [Order INC] in the [Detail] tab 
window in the [Data Block Area] dialog.  Specify a value from 0 to 2 for [Order INC].

• The global overlap display cannot be set for component parts.  It cannot be called up from 
component parts.

Memory Refer to:

Info. Output Memory page 2-41

Overlap Library No. page 2-41

Read Area (n + 1) page 2-40

Command Memory page 2-40

Coordinate Designation: X/Y Coordinate page 2-41

Item Select Memory page 7-36 “Item Select Function”
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Feature of Overlap Display − System Button −

The system button, a function common to every overlap display format, is explained in this section.

Overview

The system button is a switch part that can be set on an overlap display and can work in two ways.

Moving the overlap display
When you press the top left corner (2 × 2 switch grids) of the overlap display once, the overlap frame 
flashes.
If you press another position on the screen while the overlap frame is flashing, the overlap display 
moves to the position, aligning the top left corner of the overlap display with the position you have 
pressed.  (The frame stops flashing when it has been moved.)

If a part of the overlap should extend off the screen, it is automatically adjusted to a position closest to 
the pressed position but within the screen space.
To stop the overlap frame flashing (to cancel the movable state), press the top left corner of the overlap 
display again.

Hiding the overlap display
When you press the top left corner (2 × 2 switch grids) of the overlap display twice consecutively 
(within one second), the overlap display is cleared from the screen.

Setting the system button
The system button can be set on the [Main] tab window in the dialog for each overlap setting.

Press somewhere outside the overlap display 
on the screen while the frame is flashing:

The overlap display moves to the position with its 
top left corner aligned (flashing is canceled).

Overlap

Overlap display

Press on switch grids (2 × 2) 
consecutively twice: The overlap display disappears from the screen.

Blip!
Blip!
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Feature of Overlap Display −  Superimpose −

Overview

When a video display item is placed on the screen, it is displayed on top so that no switches on the 
underlying screen can be used.
To enable switch operation while keeping the video display on the screen, an overlap display with the 
superimpose function can be called up on the video display item.

The superimpose function can be set for any overlap format (normal overlap, multi-overlap 
call-overlap, or global overlap).
The level of transparency for the overlap can be determined by [Transparent Color] and [Blend] on the 
[Superimpose Setting] dialog.

* The transparent color and blend value for transparency can be set on the [Screen Setting] 
dialog that is selected from the [Screen Setting] menu. 
This setting is valid for all the screens.
It is not possible to change the setting for each overlap display.

* The transparent color and the blend value for superimposing a global overlap display 
depend on the settings made for the screen, on which the overlap display appears first.

Setting Procedure

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Video Monitoringngn Display Adjustment

ContrastBrightness

▲

▲

Color

Overlap
(with superimpose function)

Video display

Step 1 Check the box for [  Superimpose] on the [Main] tab window in the dialog for each 
overlap setting.
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Step 2 For [Normal Overlap] if you check this box, [Setting] on the right becomes active.  Click 
[Setting].

* For [Multi-Overlap], [Call-Overlap] or [Global Overlap Setting], move to step 6.

Step 3 The following message is displayed.  Click [Yes].

Step 4 The [Superimpose Setting] dialog *1 is displayed.

[Transparent Color]
When you use the superimpose function, one color is always transparent when the 
overlap display is shown on the video display.  This is due to the system structure.
You need to specify that color in advance.
To avoid showing the video image as transparent, set one color that you do not use on 
the overlap display.

[Blend] (0 (light) to 255 (dark))
Set the blend ratio of the overlap display to the video display.
When the blend value is closer to [0], the overlap display is shown faintly.  The overlap 
display becomes more visible as you increase the blend value closer to [255].

Step 5 Click [OK].  The superimpose setting for the screen equipped with a normal overlap 
display has been completed.

Overlap display
(Superimpose)

Video image
If you use the color (e.g. black) that is set as [Transparent 
Color] on the overlap display (e.g. switch OFF color), the 
background (e.g. video display) is displayed as is.

Color Adjustment
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Showing Procedure
The same as usual overlap display:
The calling method is the same in either case of [  Superimpose] and [  Superimpose].  However, 
the calling method varies depending on the format of overlap display (normal overlap, call-overlap, 
multi-overlap, global overlap).  Refer to the calling method for each format.

Calling from a video item:
Depending on the setting of the video display item, you can call an overlap display with the 
superimpose function by clicking on the video display.

* Note that the method above is available only with the call-overlap format.

Make the settings on the [Action] tab window for the video display item as shown below.

* Only one overlap display with [  Superimpose] can be set for a screen.
If you display multiple overlap displays with [  Superimpose] simultaneously, the 
superimpose function becomes valid only with the one that is shown first.

Step 6 For [Multi-Overlap], [Call-Overlap] or [Global Overlap Setting], select [Screen Setting] →  
[Screen Setting] → [Others] tab window for the screen equipped with the overlap 
display, and make the same setting as step 4 in the [Superimpose Setting] field.

* Superimposing a global overlap depends on the [Superimpose Setting] made 
for the screen, on which the global overlap appears first.

 Display Operation 
Screen When 
Clicking 
(Superimpose)

By checking this box, the specified overlap display is shown when you click 
on the video image.

[Overlap ID]
Specify the overlap ID to be displayed.
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Video Overlap (For Channel Selection)

This is the function to allow compatibility with the V6 series.  To change the channel or the size during 
video display on the V8i, use this video overlap display function.

Setting Procedure

• [System Setting] → [Unit Setting] → [Video/RGB] → [Video/RGB Settings] dialog
• [Parts] menu → [Multimedia] → [Video/RGB Overlap]

For more information on the setting items, refer to page 2-48.

Video setting
* To set up this dialog, you can also start from the [Video Overlap] dialog → [Main] tab window and 

then select [Video/RGB Settings].

Set the items on the dialog shown below.

Video Input
(NTSC, NTSC Square 
Pixel, PAL)

Select the video input signal type.

Maximum Number of 
Snap Files in Auto
(0 to 255)

Snapshot images are saved on a CF card when [Auto] is selected.  Specify 
the maximum number of files to be saved automatically.

When the Snap File 
Limitation is Exceeded
(Stop, Overwrite)

Set the processing rule when [Maximum Number of Snap Files in Auto] 
mentioned above has been exceeded.

[STOP]:
When the limitation has been exceeded, snap shooting stops.

[Overwrite]:
When the limitation has been exceeded, the images are saved while 
overwriting files from the first file.

Snap File 
Compression Rate
(Low, Middle, High)

Set the file compression rate for snap files.
High: The file size is small but image quality is lowered.
Middle: The file size and image quality are at an intermediate level (twice 

the “High” level).
Low: The image quality is good but file size is bigger (twice the “Middle” 

level).
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Setting Dialog (V8i)

Most of the setting items on the dialog are the same as those on the [Video] dialog for a video display 
item.
For more information, refer to “14.2  Video/RGB Display.”
The setting items different from those for a video display item are explained.

Menu Setting Item Contents

[Main] → 
[Display]

No. of Channels This is fixed to “1”.
However, it is possible to change the channel using 
“SEL_CH” of the [Video] macro command.

[Detail] Overlap ID This option determines the overlap area (ID 0 - 2) where 
the video display is to be called.

[Coordinates] Start X
Start Y

This option determines the video display position.
The video screen is displayed while aligning its upper left 
corner with this coordinate position.
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Video Display Setting (Macro Command)

The size and color of the vide display can be set using the macro commands for video display.
When no macro is used, the video screen is displayed under default conditions.
When a macro command is executed, it has priority.

Video display default setting
The default settings are shown below.

The video display status is output to the internal system memory ($s).
It is output as shown below.

Changing the default settings
Use macro commands.  The size, channel number, brightness, contrast and color shade of video 
display can be set.
Select the [Video] macro command.  The following dialog is displayed.

Setting Item Options Default Value

Size 160 × 120, 320 × 240
640 × 480, 640 × 240

320 × 240

Display Channel CH1, CH2, CH3, CH4 1 (CH)

Brightness 0 (dark) to 255 (bright) 183

Contrast 0 (weak) to 255 (strong) 48

Color shade 0 (light) to 255 (deep) 1

Address Contents

$s170 Channel No.

$s171 Dither (fixed to 1 (yes))

$s172 Brightness

$s173 Contrast

$s174 Color shade
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• Command selection:

• Example
Channel No. = 2 (CH2)
Size = 640 × 480 dots
To change to the above state, you should use the following macro commands:
Video SEL_CH  2 →   CH2 selection
Video SIZE  640 × 480 →   Size selection
Video_INF SAVE →   Saving the state in the memory

• Designating the memory address
The following data should be set.

Video MEMORY  F1 (= n)
F1 memory

Command Name Contents

SIZE (160 × 120, 340 × 240, 640 × 480, 640 × 240)
Determine the video window size.

SEL_CH (1 to 4)
Specify the channel number of the input port.

BRIGHT (0 to 255)
Determine the brightness of video image.

CONTRAST (0 to 255)
Determine the contrast of video image.

COLOR (0 to 255)
Determine the color shade of video image.

VIDEO_INF (SAVE, DEFAULT)
It is possible to save the current video display state or to reset to the 
default settings.
When [SAVE] is selected, the current video display state is saved so 
that even if a power failure occurs, the video image can be displayed in 
the same state as before.
When [DEFAULT] is selected, the display state is reset to the default.
The V8 series may stop for a second when this command is executed.

n Command No.
n + 1 Setting Value

Command Name Command No. Setting Value
SIZE 0 0: 160 × 120, 1: 320 × 240, 2: 640 × 480, 3: 640 × 240
SEL_CH 1 1 to 4
BRIGHT 3 0 to 255
CONTRAST 4 0 to 255
COLOR 5 0 to 255
VIDEO_INF 6 0: SAVE, 1: DEFAULT
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• Example
Channel No. = 2 (CH2)
Size = 640 × 480 dots
To change to the above state, you should set [$u00100] for “F1” for the [Video MEMORY] 
macro command and set as shown below.

Channel No. 2 selection
$u00100=1(W) →   Command (SEL_CH) selection
$u00101=2 (W) →   2CH selection
Video MEMORY  $u00100 →   Command execution
Window size change
$u00100=0(W) →   Command (SIZE) selection
$u00101=2 (W) →   640× 480 dots selection
Video MEMORY  $u00100 →   Command execution
Saving in memory
$u00100=6(W) →   Command (Video_INF) selection
$u00101=0(W) →   SAVE selection
Video MEMORY  $u00100 →   Command execution

Showing and Hiding a Video Overlap Display
The following three methods will show or hide a video overlap display on or from the screen.

Internal command
• Switch

The switch function is available to show and hide video overlap displays.
The following switches can be used.

For more information on the switch setting, etc., refer to “3  Switch.”

• Macro
A macro command is available to show and hide video overlap displays.
Use the OVLP_SHOW command.
Additionally, the display location can also be specified.  (Use the OVLP_POS command.)
For more information, refer to the Macro Reference Manual.

Method Details Refer to:

Internal 
Command

Switch   Function: Overlap Display Explanation below

Macro OVLP_SHOW
OVLP_POS

Macro Reference 
Manual

External 
Command Read area “n + 1” Bits 0 to 2

(0: Hide, 1 Show) page 2-52

Operation Switch Function Attached Setting

Show Overlap Display

Overlap ID 0 to 2
Action = ON

Overlap ID 0 to 2
Action = ALT

Hide Overlap Display

Overlap ID 0 to 2
Action = OFF

Overlap ID 0 to 2
Action = ALT
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External command
Commands from the read area are available to show and hide video overlap displays. *1

Bit 0 of read area “n + 1” (screen status command) in the [Read/Write Area] dialog that is displayed by 
selecting [System Setting] → [Device Communication Setting] is for overlap No. 0, bit 1 for overlap No. 
1 and bit 2 for overlap No. 2. 

*1 Recognition of bit status
The way of recognizing bit status depends on the setting for [ Display Overlap during bit ON] in 
the [General Settings] tab window ([System Setting] → [Unit Setting] → [General Settings]).
• Unchecked:

Bit status is recognized at the edges (0 → 1 or 1 → 0) of each bit.
• Checked:

Level recognition is used to recognize bit status.
Suppose that an overlap display was shown at an external command on the screen, the 
screen was switched to another, and then is displayed again.  In a case like this, the overlap 
display that corresponds to the bit being set (ON) appears on the screen.

* Notes on showing an overlap display using an external command
A switch for [Function: Overlap Display = OFF] is usable to hide the overlap display.  Using this 
type of switch hides the overlap display, whereas the bit is still set (ON).  To show the overlap 
display again, the bit requires to be reset (OFF) and set (ON) again.

Memory Related to Video Overlap Display

Read Area (n + 1) page 2-52

Overlap ID 2

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0

Overlap ID 1
Overlap ID 0

0: Hide
1: Show

[Read Area] n + 1

MSB LSB
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Size Limits of Overlap Displays

There is a limit to the size of the overlap display that can be shown on one screen.
Sum up the sizes of overlap displays: normal overlap, call-overlap, multi-overlap (the maximum one if 
several exist) and global overlap placed on one screen.  Do not allow the total to exceed the limit 
specified below.

(Unit: dots)

* Overlap size of a screen with video overlap setting

• Normal, call-, multi-overlap, and global overlap size calculation method (unit: dots)
Overlap size = Overlap display width × Overlap display height

Example: For V810T
If you have four overlap displays shown below, the total size falls within the range, and as a 
result, there is no problem.

Model Maximum 
Screen Size

Maximum Overlap Size* Maximum Overlap Size 
(for Video)*

V815iX (1024 × 768) 786,432 3,145,728 1,572,864
(The total of widths of four 
overlap displays must not 

exceed 2,048 dots.)

V8xxxS (800 × 600) 480,000 1,920,000 960,000
(The total of widths of four 
overlap displays must not 

exceed 2,048 dots.)

V810xT (640 × 480) 307,200 1,228,800 614,400
(The total of widths of four 
overlap displays must not 

exceed 2,048 dots.)

V810xC (640 × 480) 307,200 921,600 -

V808xC (640 × 480)

V808CH (640 × 480)

V806xx (320 × 240) 76,800 230,400 -

640

480

448

400

640 x 480 = 307,200 (  1  )

448 x 400 = 179,200 (  2  )

448

400

448 x 400 = 179,200 (  3  )

300

200

300 x 200 = 60,000 (  4  )
=<

  1  ( = 307,200)    307,200
  1  +  2  +  3  +  4  ( = 725,600)    1,228,800

=<

Overlap ID 0

Overlap ID 1

Overlap ID 2

(Base screen) Global overlap ID 3

The total size falls within the range, 
and thus, there is no problem.
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Please use this page for notes.
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3 Switch
3.1 Overview

Basic Function of Switches

A switch part has the function of sending ON/OFF information to the specified bit in the PLC memory.

When a switch is pressed, the following processes can be executed:
• Changing the screen display

• Showing an overlap display

• Performing operations, and writing the results into the PLC memory

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

M0 to 15

M16 to 31

M32 to 47

.....
.....Overlap

Turns it ON.

ON information

PLC memory

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Screen 1

Z Z Z

Labeller

Z

OK
Hard
Copy

Change
Screen

Animation

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Overlap

Overlap
Display

Overlap

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Word
Operation

65+36=

PLC

D100
D200

D300

.....
.....

65+36=101

PLC memory
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• Printing the image displayed

• Turning a memory bit ON and showing an overlap display at the same time

• On pressing a switch, ON/OFF information or a value can be sent to multiple bits or words - e.g. in 
the PLC memory or internal memory - at the same time.   (Multi-output function)

• Switches now feature a delay function.
You can set “ON delay” functions, where memory output cannot occur unless the switch is pressed 
continuously for a fixed time, and “OFF delay” functions, where the memory cannot go OFF until a 
fixed time has elapsed after you have released your finger from the switch.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Change
Screen

Z Z Z

Labeller

Z

Hard
Copy

OK
Change
Screen

Z Z Z

Labeller

Z

Hard
Copy

OK

Animation
Animation

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Overlap

PLC

M0 to 15

M16 to 31

M32 to 47

.....
.....

Overlap

Overlap
Display

Turns it ON.

ON information

PLC memory

Pressing the [High speed] switch can serve not just to turn 
M30 ON, but to turn M10 and M20 OFF at the same time.
This makes it simple to create radio buttons.

M10=ON M20=OFF M30=OFF

M10=OFF M20=OFF M30=ON

Low 
speed

Medium 
speed

High 
speed

Low 
speed

Medium 
speed

High 
speed

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

M0  15

M16  31

M32  47

.....
.....M10

Turns it ON.

ON information

PLC Memory

For example, on pressing a switch for which [Output 
Memory: M10] and [ON delay: 3 sec] have been set, 
M10 will be turned ON after the switch has been pressed 
continuously for 3 seconds.

Pressed for 3 seconds
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• You can set a confirmation pop-up window to be displayed automatically when a switch is pressed 
and ask whether the operation is [OK] or should be canceled ([Cancel]).
You can make the settings for confirmation and operation execution entirely on the MONITOUCH, 
without the need for troublesome programming.

A macro can be executed when a switch is pressed or released.

Lamps in Switches

• Switches can be equipped with lamps, which light up (in ON color) when the switch is pressed and 
go off (in OFF color) when it is released.

• Lamp activation can be commanded from the PLC memory.

• When lamp activation is commanded externally, it is also possible for one lamp to use 
128 patterns.

Example: 3 patterns

PLC

M0 - 15

M16 - 31

M32 - 47

.....
.....

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

M10

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

M10

OK Cancel

Will start operation?

Turns it ON.PLC Memory

ON information

Switch Switch Switch

M0 to 15

M16 to 31

M32 to 47

.....
..... Switch

Switch

PLC

PLC memory

STOP READY RUN
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3.2 Notes on Switches
Switch for Use in Emergency

Placement

Minimum Switch Unit and Maximum Number of Switches

• Matrix switches: 18 dots × 14 dots
• Analog switches: 2 dots × 2 dots

(For safety reasons, however, using switches greater than 18 dots × 14 dots is recommended.)
• For the minimum switch unit and the maximum number of switches, refer to the chart below.

When Placing Switches while Overlaying One on Another:

However, if it is unavoidably necessary to do so, either switch must be valid depending on the order of 
placement.
For this setting, select [System Setting] → [Unit Setting] → [General Settings].
For more information, refer to “1  System Setting” on page 1-24.
The order of placement can be seen on the [Item List] view.
(For more information on the [Item List] view, refer to the Operation Manual.)

Do not use switches where they could cause injury to people or damage machinery.  Moreover, do 
not use switches as emergency switches.

V815 / V812 / V810 / V808 V806

Maximum number per screen 1024 192

Minimum unit 14 dots

18
 d

ot
s

As a rule, when placing switches, do not overlay one switch on another.
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Switch Area

The action area that is sensitive to a press on the screen is basically identical to the switch part area; 
however, depending on the part type or the method of placement, enlargement or reduction, it may not 
be so.

Check the action area as described below.

• Setting position
Select [View] → [Display Environment] → [Display] tab window [  Display Area]

When [Display Area] is checked ( ), a dotted box is shown around each switch part as shown 
below.  This dotted box shows the switch action area.
Pressing in a switch action area activates the switch.  The outline of each switch part is called the 
“part area” of the switch.
Pressing on this area out of the action area does not activate the switch.

Part area

Action areas

Part area
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Differences between Switch Types

There are two switch types for MONITOUCH.
For more information, refer to “Touch Switch Specifications” (page 3-8).

Analog touch switch
Analog touch switches can be placed, enlarged or reduced as desired.
To place, enlarge or reduce switches ignoring the switch grids, uncheck [  Place switches on switch 
grids].

Matrix touch switch
Matrix touch switches must be placed, enlarged or reduced along the switch grids.  Otherwise, they do 
not work.

Switch Grids
Setting position
Select [View] → [Grid] → [Grid Setting].
When you check [  Grid Display] and set [Grid Type: Switch], the switch grids shown in the diagram 
below are displayed on the screen.

Place switches on 
switch grids.

As default, [  Place switches on switch grids] is checked ( ) in the [Grid] tab 
window.
Switches can be enlarged/reduced along the switch grids.

Switch grids
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* When you uncheck [  Place switches on switch grids] for the matrix type V8 series, a 
switch area (action area) may be misaligned from the switch grids as shown below.  Take 
caution when moving, enlarging, and reducing a switch area.

When Placing Switches on an Overlap Display:

If the following two conditions exist at the same time, “Error: Action area setting” will be given.
Remove either condition.

• X size of the switch is minimal.
• Shift the overlap position by 

1-byte from the switch grids.

Minimal X size

Shift the overlap 
position by 1-byte.
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Touch Switch Specifications

Two types of touch switches are available with the V8 series: analog types and matrix types.
The switch output action varies depending on the touch switch type.

Analog Switch

• When two or more points on the screen are pressed at the 
same time, the center of the pressed points is output.
If the center of the pressed points happens to be a switch, 
this switch may activate.
Do not press two or more points on the screen at the same 
time.

• For two-point pressing, use a switch on the screen and a function switch.

Matrix Switch

1-output or 2-output of the switch can be set for each screen.
Select [Screen Setting] → [Screen Setting] dialog.  Set [1-Output] or [2-Output] for [Switch Output].

2-point Pressing

Two switches on the screen A switch on the screen and a 
function switch

Analog switch Disabled Enabled

Matrix switch Enabled by setting Enabled

1-Output The pressed switch is turned ON/OFF.
If two switches are accidentally pressed at the same time, both switches do 
not work.

2-Output The pressed switch is turned ON/OFF.
If two switches are pressed at the same time, both switches work as 
intended.  If three or more switches are accidentally pressed at the same 
time, none of the switches work.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

switch

Pressing two positions at the same time 
activates the switch in the center.
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2-point pressing special operation
With the matrix type V8 series, it is possible to select the action taken as a consequence of two-point 
pressing.

• Setting position
[System Setting] → [Unit Setting] → [General Settings] tab window: [  2-Point Pressing Special 
Operation]

• Operation
 Unchecked

1) Press switch 1 on the screen.  A switch activation status is stored in output memory.  (lamp 
ON)

2) Press an area outside the switch on the screen.  Switch 1 output is turned OFF.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM
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 Checked
1) Press switch 1 on the screen.  A switch activation status is stored in output memory.  (lamp 

ON)

2) Press an area outside the switch on the screen.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Switch 1 output is maintained.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM
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3.3 Setting Dialog
Main

 Output Memory Check ( ) this item when you want to set the specified bit in memory by 
pressing the switch.
When the internal memory or a memory card is chosen, the processing 
speed will be faster.

• When the PLC memory is chosen:
Depending on whether the specified output memory address is 
bit-writable or not, the selection for [Output Action] should vary.
Refer to the Hardware Specifications whether the memory is 
bit-writable or not.

Output Action *1
(Momentary, 
Momentary W, Set, 
Reset, Alternate)

This item becomes valid when [  Output Memory] is checked.
Select the write operation to the output memory.

 Multi-output This item becomes valid when [  Output Memory] is checked.
Check this box when you want to perform an output operation set for 
[Output Memory] to multiple memory addresses at one time.
For more information, refer to page 3-15.

Switch Action Output Processing

Set The specified bit is set to “ON”.
(Remains ON if the switch is released)

Reset The specified bit is reset to “OFF”.
(Remains OFF if the switch is released)

Momentary
Momentary W

The specified bit is set to “ON”, and when the switch is 
released, it is reset to “OFF”.
(Remains ON while the switch is held down)

Alternate Each time the switch is pressed, the specified bit is alternately 
set (ON) and reset (OFF).



3   Switch

3-12

*1 For the [Momentary] and [Momentary W] operations, refer to page 3-13.

 Lamp Memory The display in the switch area can be changed.

• In the case of [  Lamp Memory]
When the switch is pressed, the lamp lights up automatically.  When it 
is released, it goes off.
The lamp turns the ON color when it is pressed; and turns the OFF 
color when it is released.

• In the case of [  Lamp Memory]
The settings for [Lamp Memory] become active.  Specify a memory 
address for the lamp display.

* When the PLC memory is used for [Lamp Memory], set up 
consecutive addresses for high-speed processing.

For more information, refer to “4  Lamp”.

 Connect Output 
Memory and Lamp 
Memory

This item becomes valid when [  Output Memory] is checked.
When this box is checked ( ), the same memory address as [Output 
Memory] is set for [Lamp Memory].
When [Alternate] is set for [Output Action], the display reflects the status of 
the memory bit.

Function Select the function to be provided to the switch, that is, how the switch 
should work when it is pressed.
The switch function is classified into groups depending on the function.

For more information on each function, refer to page 3-27.

Memory 
Designation

Action

Bit Bit setting/resetting (ON/OFF) switches the lamp display.
The required number of bits varies with the number of 
patterns. (127 bits maximum)
When multiple bits are set (ON), the most significant bit has 
priority. *1
The number of patterns can be set in the [Style] tab window.

Word
(BCD/DEC)

The lamp display is changed according to the value specified 
for the lamp memory.
The range of setting values varies with the number of 
patterns.
Range: 0 - 127
If a value outside the specified range is set, the lamp display 
is not changed.
The number of patterns can be set in the [Style] tab window.

Standard To be used by itself

Entry To be linked with a part in entry mode

Sample To be linked with a part in sampling mode

Memory Card To be linked with a part in memory card mode

Memo Pad To be linked with a part in memo pad mode

Table Data To be linked to entry mode when using a table data display 
as an entry target in entry mode

Digital Switch To be used for creating a digital switch part

Video To be linked with the video function

JPEG To be used for calling or deleting a JPEG file

Recipe To be linked with the recipe function

Security To be linked with the security function

Network camera 
display

To be linked with the network camera function

Remote desktop To be liked with the remote desktop window display function
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[Momentary] and [Momentary W]

Whether [Momentary] or [Momentary W] is selected, the switch works in the same way in terms of the 
output action that is performed when the switch is pressed.  However, the processing method varies 
depending on the memory type as described below.
Refer to the Hardware Specifications whether the memory is bit-writable or not.

• For bit-writable memory:
The operation result will be directly written on the bits of [Output Memory] as shown below, 
regardless of whether [Momentary] or [Momentary W] is chosen.
Example: When [M10] is specified for [Output Memory]:

• For non-bit-writable memory:
Switch activation is processed in the unit of bits within the V8 series; therefore, if the 
non-bit-writable memory is specified for [Output Memory], different processing methods are 
employed depending on the [Momentary]/[Momentary W] selection.
Processing when [Momentary] is chosen:
(1) One word of [Output Memory] is read.
(2) The result of [Output Action] is written into one word of [Output Memory].

(Other bits are kept intact.)
Example: When [D100 - 10] is specified for [Output Memory]:

Processing when [Momentary W] is chosen:
The result is directly written into one word of [Output Memory].
(Other bits are cleared.)
Therefore, a one-word area must be secured for [Output Memory].
Example: When [D100 - 10] is specified for [Output Memory]:

For bit-writable memory, you can choose either [Momentary] or [Momentary W].  For 
non-bit-writable memory, it is recommended to choose [Momentary W] for high-speed 
processing.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM
Write the ON state of M10.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

0 0 0 0 0 0 0 0 0 0 0 0 0 1 1 1

0 0 0 0 0 1 0 0 0 0 0 0 0 1 1 1

(1) Data in D100 is read.

(2) The bit of D100 - 10 is set (ON) 
and is written in D100.

0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

The bit of D100 - 10 is 
set (ON) and the one 
word is written entirely.
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For matrix touch switches:
Select [Screen Setting] → [Screen Setting] → [Switch Output], and select [2-Output].
When the output memory is set within the same word for switches of [Momentary W], the two-point 
output may not be available.  Use [Momentary] in such a case.  (Refer to “Touch Switch 
Specifications”: page 3-8.)

Others
The GD-80 series handles switch output in the unit of words as [Momentary W].
Therefore, if data of the GD-80 series is imported, it is recommended to choose [Momentary W].
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Multi-output

* The [Multi-output] tab window appears when [  Multi-output] is checked in the [Main] tab 
window.

*1 For more information on [Action], refer to “List of Functions” (page 3-27).
(For information on [Word Operation], refer to “Word Operation” (page 3-25).)

*2 When [Action: Word Operation] is selected, the setting items for word operation appear.
For more information on these setting items, refer to “Word Operation” (page 3-25).

Output memory
(1 - 16)

Specify the number of bits to which output operation is to be performed 
when the switch is pressed.
Up to 16 memory addresses can be specified.

Memory
(No. 0 - 15)

Specify as many memory addresses as specified for [Output memory] 
above.
When the internal memory or a memory card is chosen, the processing 
speed will be faster.

• When the PLC memory is chosen:
Depending on whether the specified output memory address is 
bit-writable or not, the selection for [Output Action] should vary.
Refer to the Hardware Specifications whether the memory is 
bit-writable or not.

Action *1 Select the write operation to the output memory.

Up/Down The sequence of output memory addresses can be altered.
Select the output memory address and click [Up] to move it up or click 
[Down] to move it down.  The output operation is performed in this 
sequence.

Switch Action Output Processing

Momentary
Momentary W

When the switch is held down, the specified bit is set (ON), 
and when it is released, it is reset (OFF).
(Remains ON while the switch is held down)

Set When the switch is pressed, the specified bit is set (ON).
(Remains ON if the switch is released)

Reset When the switch is pressed, the specified bit is reset (OFF).
(Remains OFF if the switch is released)

Alternate Each time the switch is pressed, the specified bit is 
alternately set (ON) and reset (OFF).

Word Operation *2 Each time the switch is pressed, one word operation is 
performed.
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Multi-output Operation

With [  Multi-output] checked, an output operation will be performed to the specified memory 
addresses from No. 0 when the switch is pressed.  The operation performed when the switch is 
released is also processed in the sequence from No. 0.

M100 = ON

D100-10 = OFF

$u200-00 = ON

M300 = ON

Example:  With the settings shown below:

When the switch is pressed, an output 
operation is performed as shown below:
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Text

(Character input box)

(Text alignment & copy)

[ON], [OFF] to [P128] When [XOR] is selected for [Draw Mode] on the [Style] tab window:
Only [OFF] can be selected.  Specify the text to be displayed.

Pattern No. When [REP] is selected for [Draw Mode] on the [Style] tab window:
Text in each pattern can be specified for display.  Click each tab and 
specify the text to be displayed.

(Character input box) A maximum of four lines of text can be placed on a switch part.
Clicking the mouse button on the box brings up a text entry cursor.
Text can be justified within the switch part.

Color

For more information, refer to “Appendix 4  Styles and Coordinates” on 
page A4-4.

Property

Enlarge

Point

Rotation + Direction

 Windows Font For more information, refer to the Operation Manual.

 Use the Same 
Property for All 
Patterns

When this box is checked ( ), the text properties for each line are applied 
to all the patterns.

 Size Automatic 
Adjustment

When this box is checked ( ), the text is automatically adjusted to the 
largest size of all the patterns.

 4-Line Display

For more information, refer to “Appendix 4  Styles and Coordinates” on 
page A4-4.

(Text alignment & 
copy)

 Retain the 
coordinates when 
changing character 
string

 Pitch

Display Language For more information, refer to “Appendix 3  Display Language.”
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Interlock

 Use Interlock If you want to attach the interlock function to the switch, check this box 
( ).  The setting items vary depending on the interlock condition.

When switch is OFF *1
(Valid, Invalid)

This is valid when [Momentary/Momentary W] is selected for [Output 
Action].
When you remove your finger from the switch (= when the switch is turned 
OFF), set whether or not the system should determine the condition set 
below.

Valid:
The system determines the condition even when the switch is OFF.
If the condition fails, the switch will not be turned OFF even when you 
remove your finger.

Invalid:
The system does not determine the condition when the switch is OFF.

(Condition) Set the interlock condition.

 Use Error Buzzer Set whether or not an error buzzer sounds when the switch is pressed 
while the condition is not satisfied.

[  Use Error Buzzer]: The buzzer will not sound.

[  Use Error Buzzer]: The buzzer will sound.

Bit ON/OFF Status Memory
    Set the memory address for interlock.

Operation Permitted State: Bit ON
    When [Memory] is OFF, switch operation is prohibited.
    When [Memory] is ON, switch operation is allowed.

Operation Permitted State: Bit OFF
    When [Memory] is OFF, switch operation is allowed.
    When [Memory] is ON, switch operation is prohibited.

Comparison by 
Operation

Data Length
    Set data length of the value used for the condition.
    [Word] / [Double word]

Display Type
    Set the display type for [Condition 1/2] of the condition.
    [DEC +-] / [DEC] / [BCD]

[Condition 1/2]
    Set an equal sign, value, and memory address as the 
condition for comparison.
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*1 Example: Operations with [When switch is OFF] valid or invalid

ON

OFF

ON

ON

OFFON

OFFON

OFF

M1

M1

M1

M1

When the switch is ON: When the switch is OFF:

[When Switch is OFF] [Valid]

[When Switch is OFF] [Invalid]

Control 
panel

[Switch] dialog
Output Memory:  M0
Output Action:  Momentary
Interlock
Memory:  M1
Condition:  ON

Condition satisfied

Condition satisfied

Condition satisfied

Condition satisfied

Condition not 
satisfied

Condition satisfied

Ineffective

Ineffective

Lamp OFF graphicLamp ON graphic

Lamp OFF graphicLamp ON graphic

Lamp OFF graphicLamp ON graphic

Lamp ON graphicLamp ON graphic

Output Memory
M0 remains ON.

Output Memory
M0 is OFF.

Output Memory
M0 is OFF.

Output Memory
M0 is OFF.

Control 
panel

Press

Release

V8 seriesV8 series
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Macro

Style

The setting items are the same as those in the [Lamp] dialog.
For more information, refer to “4  Lamp” on page 4-6.

Macro Edit Set the macros to be executed when the switch is pressed (ON macro) and 
when it is released (OFF macro).  For more information on macros, refer to 
the Macro Reference Manual.
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Delay

ON action
(Normal, ON delay, 
Double-touch)

The ON delay setting can be made.

Normal No delay motion is set.

ON delay
(10 to 300 × 100 ms)

The switch is activated for the function as specified 
for [  Output Memory], [Function] and [Macro] when 
the switch is held down for the time specified.

 First-touch buzzer
When this box is checked, a buzzer sounds each 
time the switch is pressed.
When this box is unchecked, a buzzer sounds not 
when the switch is pressed but when the switch is 
activated after the ON delay time.

Double-touch
(10 to 300 × 100 ms)

The switch is activated for the function as specified 
for [  Output Memory], [Function] and [Macro] when 
the switch is pressed within the time specified.

When the switch is pressed once, the frame of the 
switch starts blinking.  The switch is activated when it 
is pressed again while blinking.
If you press another switch or move to another screen 
while it is blinking, the switch operation is canceled.

* If you display an overlap display while it is 
blinking, the switch operation continues.
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*1 If [ON function repeat] is checked and the ON macro repeat function is also set (at $s64 to 66), 
the repeat motion of the ON macro will be executed first on pressing the switch.

*2 When the screen has a switch currently in OFF delay motion, it cannot be switched to another 
screen (no switch operation acceptable) before the OFF delay motion is completed.
Likewise, when an overlap display has a switch currently in OFF delay motion, it cannot be 
switched or cleared before it is completed.

ON repeat *1  ON function repeat:
When this box is checked, the repeat function is added to the switch 
function.

 ON macro repeat:
When this box is checked, the repeat function is added to the switch ON 
macro.

Repeat timer (15 to 150 × 10 ms):
When [  ON function repeat] or [  ON macro repeat] is checked, this 
item automatically becomes active.  Specify an interval between 
repetitions of the function or macro.

Repeat buzzer:
When [  ON function repeat] or [  ON macro repeat] is checked, this 
item automatically becomes active.  Check this box when you want to 
sound a buzzer when repeating the function or macro.

Call pop-up window With this box checked, a pop-up window will be displayed automatically 
when the switch is pressed.
For more information, refer to the next section.

OFF delay *2 The OFF delay setting can be made.
When the box is checked, switch OFF operation (output memory, OFF 
macro, etc.) will be processed at the conclusion of the specified time after 
the switch has been released.

* The OFF delay setting can be made to a maximum of eight switches 
on a single screen.
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Confirmation Pop-up Window

You can set a confirmation pop-up window to be displayed automatically when a switch is pressed.

When [OK] is pressed, the switch is activated for the function as specified for [  Output Memory], 
[Function] and [Macro].
When both [OK] and [Cancel] are used, pressing [ON] executes the switch function; pressing [Cancel] 
closes the confirmation pop-up window without executing the function.

Setting items

Note
• While a confirmation pop-up window is displayed, no switch operation other than those on the 

window is acceptable (except for the function switch).
• If you switch the screen while a confirmation pop-up window is displayed, it means the same as 

pressing [CANCEL].

Pop-up window type Type 0:
With [OK] and [Cancel]

Type 1:
With [OK] only

Message No.
(0 - 32767)

The message “Do you want to start?” is shown above as a sample of 
messages that can be registered freely by the user.
(Registration is possible by selecting [Registration Item] → 
[Message].)
Specify the line number (absolute address) of the registered 
message here.

<Displayable message>
Only one message number can be specified.
(Maximum 32 one-byte characters × 3 lines)

PLC

M0 - 15

M16 - 31

M32 - 47

.....
.....

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

M10

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

M10

OK Cancel

Will start operation?

Turns it ON.PLC Memory

ON information

CancelOK

Will start operation?

Registered message

OK

Will start operation?

Registered message
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Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates” on page A4-12.

Display Setting

For information on setting the tab window, refer to the V8 Series Reference Additional Functions.

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

Buzzer Sound Unchecked:
The setting in the [Buzzer] tab window takes effect ([System Setting] → 
[Unit Setting] → [Buzzer]).

Checked:
A buzzer sound is set for each switch.
Standard/Short/Continuous/Error/OFF

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Word Operation

* The [Word Operation] tab window appears when [Function: Word Operation] is checked in 
the [Main] tab window.

Main

Word Operation

Screen Screen switching takes place after the execution of word operation.

Operation Type
(BCD, DEC)

This option becomes valid when addition, subtraction, multiplication or 
division is chosen for [Operation Mode].  Choose BCD (binary coded 
decimal) or DEC (decimal) for the format for writing into the specified 
memory.

Operation Memory Specify the operation memory address.  (A in the figure above)

Operand Memory Specify the operand memory address.  (B in the figure above)

Output Memory This item becomes active in instances other than [Operation Mode: 
Transfer].
Specify the memory address where the operation result is output.  (C in 
the figure above)

Operation 
Mode

→ 
(Transfer)

Operation memory [A] is transferred to operand memory [B].

+ (Add) Operation memory [A] and operand memory [B] are arithmetically 
computed, and its result is written in output memory [C].
In the case of divisions, the quotient is written in output memory [C] and 
the remainder is written in [C + 1].

- (Subtract)

× (Multiply)

× (Divide)

∩ (OR)
Operation memory [A] and operand memory [B] are logically computed, 
and its result is written in output memory [C].∪ (AND)

@ (XOR)

Comparison 
Condition

None Set the condition for executing word operation.
Operation is executed when the switch is pressed.

=, ≠
<, >
≤, ≥

Set the condition for executing word operation.
When the condition is metWord operation is executed.
When the condition is not metWord operation is not executed.

Comparison Memory Specify the memory address that stores a comparator.

Constant Specify a constant.

A B

C
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Example of Use

Comparison Condition:<
Comparison Memory: D100
Constant : 500
(Expression of Conditions)= [Comparison Memory] [Comparison] [Constant]
                =      D100                <        500
When data in D100 is less than “500”, operation is executed.

Notes
• If the value in output memory [C] is changed by an external command, the latter value has priority.
• MONITOUCH processes operations in the following order:

1. Data is read out from [Operation Memory] and [Operand Memory].
2. Arithmetic operation is processed.
3. The result is written into [Output Memory].
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3.4 Basic Function of Switches
List of Functions

The contents of each function are shown below.
When nothing is entered under the “Linked Part” column, the switch activates alone.  When 
something is entered, the switch will not work unless a link is established with a corresponding 
part.  For more information, refer to the relevant pages.

Standard

Name
Auxiliary Setting Item

Linked Part See:
Contents

No Function −
− −

Activation of the specified bit in memory

Screen Screen No.
− page 3-34

Screen shift to the specified screen

Overlap 
Display

Overlap ID
Action setting (ON, OFF, ALT, ICON) − page 3-36
Control of normal/multi-overlap display

Multi-Overlap 
Display

Overlap ID, overlap library number, display 
position − page 3-37
Multi-overlap control

Hard Copy −
− page 3-35Print-out of the currently displayed screen 

image

Word 
Operation *1

[Word Operation] tab window
− page 3-25

Operation of memory data

+ Block − Message mode
Graphic mode
Data block area
Alarm logging
Data sampling
Trend sampling
Alarm tracking
Memory card mode
Memo pad
JPEG display

page 6-1
page 11-2
page 15-1

page 10-50
page 9-30
page 9-14

page 10-21
page 15-6

page 15-26
page 14-65

Display of block numbered one greater (+1)

− Block −

Display of block numbered one less (−1)

Roll Up − Bit order alarming
Relay-sub
Message mode
Alarm logging
Data sampling
Trend sampling
Time order 
alarming
Alarm tracking
Memory card mode

page 10-1
page 10-15

page 6-1
page 10-50
page 9-30
page 9-14

page 10-69
page 10-21
page 15-6

Scrolling upward

Roll Down −

Scrolling downward

Block Call Block number Message mode
Data block area
Graphic mode
Memo pad

page 6-1
page 15-1
page 11-2

page 15-26
Change of the block displayed
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*1 The function to switch the screen can also be set.  See page 3-25.

Entry

Mode Display order Bit order alarming
Message mode
Time order 
alarming

page 10-1
page 6-1

page 10-69
Display of corresponding messages

Item Select −
Entry mode page 7-1Entry selection switch if data is placed in the 

same switch

Return −
page 3-34

Return to the previous screen

Reset − Alarm logging
Data sampling
Trend sampling
Alarm tracking

page 10-50
page 9-30
page 9-14

page 10-21
Clear in sampling buffer

Occupy −
− page 3-35Communication of 1:1 (only available with 

multi-link)

CF Card 
Format (Buffer)

−
− page 18-1

Sampling file format in the CF card

CF Card 
Removal

−
− page 3-39

Switch that stops access to the CF card

Name
Auxiliary Setting Item

Linked Part See:
Contents

Character 
Input

−

Entry mode
(DELETE key 
available for alarm 
tracking)

page 7-1

Entry of text placed on switches

Write *1 −

Write of entry data into memory

Clear −

Clear of entry

Toggle Sign −

Inverse of entered sign (for numeric input)

Space −

Entry of one-byte space (for character input)

Backspace −

Backspace (for character input)

DELETE −

Deletion of one character the cursor is sitting 
over (for character input)

+1 −

Increase by one the number the cursor is 
sitting over (for numeric input)

Name
Auxiliary Setting Item

Linked Part See:
Contents



3   Switch

3-29

3

−1 −

Entry mode page 7-1

Decrease by one (−1) the number the cursor 
is sitting over (for numeric input)

Add Value to be added

Addition of the specified value to the 
numerical display data the cursor is sitting 
over

Subtraction Value to be subtracted

Subtraction of the specified value from the 
numerical display data the cursor is sitting 
over

Cancel −

Reset to the default state during input 
operation

LFT −

Move of cursor to the right (for character 
input)

RGT −

Move of cursor to the left (for character input)

UP −

Move of cursor to the previous option (−1)

DW −

Move of cursor to the previous option (+1)

<< −

Move to the following screen page (+1)

>> −

Move to the previous screen page (−1)

Conversion of 
Kanji

−

Selection of Kanji mode

Graphic 
Library

Graphic library (GNo., No.)

Change of characters by reading a graphic 
library

80 Compatible 
HEX Key

To be used for data converted from the GD80 series
Refer to the File Conversion Manual.80 Compatible 

HEX Key 
Change

Max. Value 
Entry

−

Entry mode page 7-1

Display of the maximum value in the entry 
display position

Min. Value 
Entry

−

Display of the minimum value in the entry 
display position

Name
Auxiliary Setting Item

Linked Part See:
Contents
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*1 The function to switch the screen can also be set.  See page 3-25.

Sample

Multi-char. 
Input

−

Entry mode page 7-1

Switching text on the switch

Switching Entry Mode Change

Switching entry mode (when the Japanese 
conversion function is used)

Switching (1-byte/2-byte Char. Change)

Switching between one-byte and two-byte 
characters (when the Japanese conversion 
function is used)

Switching Caps Lock

Switching between uppercase and lowercase 
characters (when the Japanese conversion 
function is used)

Direct Input −

Direct input (when the Japanese conversion 
function is used)

Word Edit −

Registered word edit (when the Japanese 
conversion function is used)

Word 
Registration

−

New word registration (when the Japanese 
conversion function is used)

Char. 
Switching (+)

−

Switching character entry switch + 1

Char. 
Switching (−)

−

Switching character entry switch − 1

Name
Auxiliary Setting Item

Linked Part See:
Contents

Graph Return − Alarm logging
Data sampling
Trend sampling
Alarm tracking

page 10-50
page 9-30
page 9-14

page 10-21
Return to the latest sampling data

Display 
Change-over

− Alarm logging
Alarm tracking

page 10-50
page 10-21Display change by bit ON/OFF

Print − Alarm logging
Data sampling

page 10-21
page 9-30Print of sampling buffer data

Change 
Display Order

− Alarm logging
Time order 
alarming
Alarm tracking

page 10-50
page 10-69
page 10-21

Display order change of occurrences to begin 
with the oldest or to begin with the newest

Name
Auxiliary Setting Item

Linked Part See:
Contents
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Memory Card

Memo Pad

Name
Auxiliary Setting Item

Linked Part See:
Contents

File Select −

Memory card mode page 15-6

File selection available from the list

Record Select −

Record selection available from the list

Card Number 
Edit

Overlap Library No.

Edit mode available with the specified 
multi-overlap display shown

Card Name 
Edit

Overlap Library No.

Edit mode available with the specified 
multi-overlap display shown

File Name Edit Overlap Library No.

File edit mode available with the switch lit

Record Name 
Edit

Overlap Library No.

Record edit mode available with the switch lit

Card Format −

Formatting of memory cards

Transfer Card 
-> PLC

−

Transfer of the selected record to PLC

Transfer PLC 
-> Card

−

Transfer of the selected record from PLC

Name
Auxiliary Setting Item

Linked Part See:
Contents

Pen Color Pen color

Memo pad page 15-26

Pen color selection

Pen Size Pen thickness (1 dot, 2 × 2 dots)

Pen thickness selection

Line −

Straight line

Delete Area −

Deletion of the memo pad in the selected area

Delete All −

Deletion of all memo pads on the screen
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Table Data Display

Digital Switch

Video

JPEG

Name
Auxiliary Setting Item

Linked Part See:
Contents

Cursor 
Movement to 
Right

−

Entry mode
(Table data 
display)

page 7-1

Cursor movement to the right within the table

Cursor 
Movement to 
Left

−

Cursor movement to the left within the table

Table Move + −

Table movement in the positive direction

Table Move − −

Table movement in the negative (−) direction

Name
Auxiliary Setting Item

Linked Part See:
Contents

Digital Switch + Target digits (1 to 17)

Numerical data 
display
(Digital switch)

page 3-38

Increment of the selected digit by one (+1)

Digital Switch − Target digits (1 to 17)

Decrement of the selected digit by one (−1)

Digital Switch 
Sign Inversion

−

Inverse of the sign for numerical data display

Name
Auxiliary Setting Item

Linked Part See:
Contents

Pause Channel (Auto, CH1, CH2, CH3, CH4)

Video item page 14-23
Pausing of the video display that is linked

Restart Channel (Auto, CH1, CH2, CH3, CH4)

Pausing cancel of the video display that is 
linked

Name
Auxiliary Setting Item

Linked Part See:
Contents

File Delete −
Video item
Recipe mode

page 14-23
page 13-1Deletion of JPEG file currently displayed or 

recipe file currently selected

File Call JP / VD (0 to 32767)

Video item
JPEG Display

page 14-23
page 14-65

Call of the JPEG file with the specified 
number

JPEG Search Increment/Decrement (-32767 to 32767)

Setting of an increment for JPEG file selection



3   Switch

3-33

3

Recipe

Security
Refer to the V8 Series Reference Additional Functions.

Network Camera Display
Refer to the V8 Series Reference Additional Functions.

Remote Desktop Window Display
Refer to the V8 Series Reference Additional Functions.

Name
Auxiliary Setting Item

Linked Part See:
Contents

Folder Select Folder name
Memory designation

Recipe mode page 13-1

File Select File name
Memory designation

A specified file name or a string in the 
memory address specified for [Command 
Memory] is displayed on the switch 
automatically.

Edit −

Press on the data or name to be edited.

Recipe Display Display order 0 - 23

CF card folders, CSV file names, and record 
names are displayed on switches.
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Switch Function Examples

To Switch the Screen (= Screen, Return)
Setting Item

*1 It is possible to disable the returning of the screen that is displayed by an external command.
Click [System Setting] → [Unit Setting] → [General Settings].  In the tab window, check 
[ Return switch prohibited when switching the screen by an external command].  For more 
information, refer to page 1-33. 

Example of use
• [Function: Screen, screen No. 1]

• [Function: Return]

Notes
• When the screen display reverts, the initial screen state is displayed, that is, the state when no 

scrolling nor block change has been specified.
• When the screen display is changed, all the switches and switch outputs should be turned OFF.  

This is to prevent accidental activation of any switch that may be caused by inadvertent contact 
with the screen.

• It is possible to change the screen display without using the switch function but using an external 
command from the PLC.
For information on the screen shift command from the PLC, refer to “1  System Setting.”

Switch Function Auxiliary Setting 
Item

Details

Screen Screen No. The screen of the specified screen number is displayed.

Return − The screen that was displayed immediately previously 
is displayed again. 
You can go up to 8 screens back. *1

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Press the switch.Screen No. 0
Screen No. 1

Screen 1

Screen 1

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Press the switch. Press the switch.

Press the switch. Press the switch.

Screen No. 0

Screen 1

Screen 1 Screen 8

Retum
Retum

RetumRetum Screen 8

Screen No. 1 Screen No. 8
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To Print out the Screen Display (= Hard Copy):
Setting item

Example of use
[Function: Hard Copy]

Notes
When the screen is printed with the [Function: Hard Copy] switch, that switch is also printed out.
If you do not want to print out the switch, use a way to print using an external command.
For more information on printing using an external command, refer to “1  System Setting.”

Occupy
Setting Item

*1 When “multi-link” is set for connection with the PLC, [Occupy] can be selected for [Function] of 
the switch.

Example of use

Notes
Pressing the [Occupy] switch lights up the lamp in the switch.
(This lamp lights up even when [Lamp Memory] is set.)
Pressing the [Occupy] switch again resets the condition, and the lamp in the switch goes off.  
Communications are started between one PLC and multiple MONITOUCHs again.

Switch Function Auxiliary Setting Item Details

Hard copy − The image of the screen currently being displayed is 
printed.
Even during printing, operations on the screen are 
performed normally.

Switch Function Auxiliary Setting Item Details

Occupy *1 − When multiple MONITOUCHs are communicating 
with one PLC (n:1), pressing the [Occupy] switch 
limits the communication between one MONITOUCH 
and the PLC (1:1).  Other MONITOUCHs are stopped.

Animation

Change
Screen

Z Z Z

Labeller

Z

Unloader

Hard
copy

OK

Animation

Change
Screen

Z Z Z

Labeller

Z

Unloader

Hard
copy

OK

Hard
copy

Press the switch.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEMOccupied by another station
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Showing Normal/Call-Overlap Display (= Overlap Display)
Setting item

*1 When pressing a switch twice, be sure to do so within 1 second.  Tap it twice rhythmically.

Example of use
[Function: Overlap Display = ALT]

To transmit the information that the switch was pressed to the PLC while the overlap display is shown, 
set [Output Memory] to the [Function: Overlap Display = ON] switch.
Select from [Momentary W], [Set] and [Alternate] for [Output Action].

Switch 
Function

Auxiliary Setting 
Item

Details

Overlap 
display

Overlap ID A maximum of three overlap displays can be shown on one 
screen.
Set [Overlap ID] for each [Overlap Display] switch so that you 
can determine which switch acts for which overlap display.

Action ON The overlap display of the specified ID is shown.

OFF The overlap display of the specified ID is cleared.

ALT When the switch is pressed once, the overlap display of the 
specified ID is shown, and when pressed again, it is cleared.

ICON Switch move mode
• Pressing the switch once makes the frame flash.  When the 

switch is flashing, the switch move mode is in effect.
• Pressing a position on the screen while the switch is 

flashing moves the switch to the pressed position.  If part of 
the switch extends off the screen, the V8 series 
automatically adjusts the position.

• When the switch is pressed again, the switch move mode 
is canceled.

Overlap display
• Pressing the switch twice erases the switch, and the 

overlap display of the specified ID is shown.
• When the overlap display of the specified ID has been 

cleared, the switch is displayed again.
• If the overlap display is equipped with the system button 

([  Use System Button]), pressing the top left corner of 
the overlap display twice (*1) clears the overlap display 
from the screen.

• If [  Use System Button] is not checked, create a 
[Function: Overlap Display = OFF, overlap OD] switch.  
This switch is used to clear the specified overlap display.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Z Z ZZ

OK

Z Z ZZ

OK

(1)

(2)

Animation

Unloader

Labeller

Change
Screen

Press the
switch.

Change
Screen

Change
Screen

Press the
switch again.

Animation

Change Screen

Change
Screen

RUN
Screen

Manual
Op.

Data
Disp.

Graph
Disp.

Animation
Disp.

Instruc-
tions
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Notes
• There are four types of overlap display formats: normal overlap, call-overlap, multi-overlap and 

global overlap.
The [Function: Overlap Display] switch is used for showing a normal overlap display or call-overlap 
display.  To show a multi-overlap display, refer to the next section.

• It is also possible to bring up an overlap display without using the switch function but using an 
external command from the PLC.
To show an overlap display using an external command, refer to “1  System Setting.”

Showing Multi-overlap Display (= Multi-overlap Display)
Setting item

*1 For the display position, specify the position of the top left corner of the overlap display.
There are two ways to specify the display position.

1) Specifying coordinates
Specify the coordinates of the top left corner of the overlap display to be shown.

2) Specifying with mouse
When you click [Specify with Mouse], the mouse cursor is displayed.

When you click on the desired location on the screen, the MLIB mark is displayed on the 
screen.  This mark represents the top left corner of the overlap display.

Notes
• There are four types of overlap display formats: normal overlap, call-overlap, multi-overlap and 

global overlap.
A [Function: Multi-Overlap Display] switch is used to show multi-overlap or global overlap display.  
For showing a normal overlap display or a call-overlap display, refer to page 3-36.

• It is also possible to bring up an overlap display without using the switch function but using an 
external command from the PLC.
To show an overlap display using an external command, refer to “1  System Setting.”

Switch Function Auxiliary Setting Item Details

Multi-overlap 
Display

Overlap ID A maximum of three overlap displays can be shown 
on one screen.  Set [Overlap ID] for each [Overlap 
Display] switch so that you can determine which 
switch acts for which overlap display.

Overlap Library No. For the multi-overlap format, overlap displays should 
be created and registered not on the screen, but as 
overlap libraries.
The switch is used to specify the overlap library 
number to be called.

 Display Position *1 When this box is checked ( ), the overlap display 
position can be set.
When this box is not checked ( ), it is displayed in 
the same position as it is created for the overlap 
library.

LIB
M
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Digital Switch
Setting item

Example of use

• Switch
Switch Function: Digital Switch
ID: The same ID as the numerical data display part

• Num. Display
Display Function: Digital Switch
ID: The same ID as the switch part

 Moves to Higher/Lower Digits: When this box is checked ( ), a carry is performed.
When this box is not checked ( ), only the selected digit 
changes.

<Without a carry>
• Without sign or with “+” sign

Pressing the [+] key on the first digit changes “129” → “120”.
Pressing the [−] key on the first digit changes “120” → “129”.

• With “−” sign
Pressing the [+] key on the first digit changes as shown below.
“−008” → “−009” → “000” → “001” → “002”
Change the sign using a switch ([Function: Digital Switch Sign Inversion]).

Switch Function Auxiliary Setting 
Item

Details

Digital Switch Digital Switch + Target Digit The selected digit is incremented by one (+1).

Digital Switch − Target Digit The selected digit is decremented by one (−1).

Digital Switch 
Sign Inversion − The sign is inverted.

3
+

-
2
+

-
1
+

-

+

-
4

Switch [Function: Digital Switch +]

Num. Display [Display Function: Digital Switch]

Switch [Function: Digital Switch −]

0
+

-
2
+

-
1
+

-

Only the third digit changes in order 
of 0, 1, 2, 3, ... 9, 0, 1.

Only the first digit changes in order 
of 0, 9, 8, 7, ... 2, 1, 0.
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<With a carry>

• Without sign or with “+” sign
Pressing the [+] key on the first digit changes 
“129” → “130”.
Pressing the [−] key on the first digit changes 
“120” → “119”.

• With “−” sign
Pressing the [+] key on the first digit changes 
“−129” → “−128”.
Pressing the [−] key on the first digit changes 
“−129” → “−130”.

Notes
• When [Alarm] is selected for [Operation/Alarm], the maximum and minimum values can be set.
• [Word Operation] and [Scaling] can be used.
• If multiple numerical data display parts (function: digital switch) of the same ID exist, the part that is 

placed first becomes valid.

Prohibition of Access to CF Card (= CF Card Removal)
Setting items

Switch status
The switch lamp will be brought to the following status conditions.  The information on switch status is 
stored in the system memory at $s500.

Notes
• When intending to cancel the switch ON status (access stopped) and start accessing the CF card, 

press the switch again.
• When the screen is changed while the switch is ON, restoration to the normal accessing status 

takes place automatically.
• Lamp memory specified for the switch becomes invalid.

Switch Function Auxiliary Setting Item Details

CF card removal

-

Accessing the CF card is stopped.
With [  CSV Output] checked in the buffering area 
setting, the sampling data is output in the CSV 
format.

Lamp CF Card Removal Status of Access to CF Card

OFF Prohibited Normally accessing

ON/OFF blinking Prohibited Data writing by switch ON

ON Permitted Access stopped

0
+

-
2
+

-
1
+

-

Carry DOWN

Carry UP
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3.5 Switch Coordinate Information
The current touch switch information is output to system memory addresses $s900 to 902.
This information is useful when linking an image processing device.

• $s900
Touch switch status

• $s901
X coordinate (absolute)

• $s902
Y coordinate (absolute)

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEMX: 320 Y: 300

0: Switch OFF
1: Switch ON

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Not used
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3.6 Flowchart
When the Switch Is ON (Pressed):

*1 [Output Action] or [Macro] should be selected for execution.
*2 Macro B is started after macro A is finished with “SWRET.”

For more information on macro commands, refer to the Macro Reference Manual.
*3 The switch function is executed after the ON macro is executed.  However, the “SET_SCRN,” 

“SET_MOVLP,” “OVLP_SHOW” and “OVLP_POS” commands are executed after the switch 
function has been executed.

*4 The motion “C” is repeated until the switch is turned OFF (released).

A

B

C

ON delay

ON delay

Delay finished

Interlock

Interlock 
condition

Buzzer

Error buzzer ON

Delay cancel

Delay finished

Yes

Not satisfied

No

Satisfied

No buzzer

Buzzer

Switch ON

Interlock

Interlock 
condition

Normal switch

Lamp

Lamp ON graphic

Buzzer ON

Output operation

ON macro

Function execution

Continue ON 
macro?

ON macro

ON repeat

ON repeat

Ending

No

Not 

Satisfied

Yes

No ON delay

Internal

External

No

No

Yes

Yes

Buzzer

Error buzzer ON

No buzzer

Buzzer
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ON Delay

ON delay Double-touch

Confirmation pop-up window ON delay + confirmation pop-up window

ON delay

First-touch buzzer

Buzzer ON

ON delay timer up

Delay finished Delay cancel Delay finished Delay cancel

Second touch

Switch frame blink

ON delay

ON delay

Buzzer ON

Confirmation pop-up 
window displayed

Confirmation pop-up 
window clear

ON processing finished CANCEL processing 
finished

Confirmation pop-up 
window clear

Buzzer ON

ON delay

First-touch buzzer

Buzzer ON

ON delay timer up

Delay finished Delay cancel

Buzzer ON

Confirmation pop-up 
window displayed

Confirmation pop-up 
window clear

ON processing finished CANCEL processing 
finished

Confirmation pop-up 
window clear

Buzzer ON

No

Switch OFF

Yes

Yes

[OK] pressed

[CANCEL] pressed

timer up

Yes

Yes

No

Yes

Switch OFF

[OK] pressed

[CANCEL] pressed
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Output Operation

ON Repeat

Output operation

Multi-output

Output operation 
execution

Output operation 
finished

Output memory No. 0

Output memory

Output operation 
execution

Output memory No. + 1

Yes

No

Yes

No

ON repeat

Repeat buzzer

Buzzer ON

ON repeat 
macro

ON macro

ON function 
repeat

Function execution

Repeat finished

No

No

No

Yes

Yes

Yes
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When the Switch Is OFF (Released):

Set, Reset, Alternate

Momentary, Momentary W

* For more information on the output operation, refer to “[Momentary] and [Momentary W]” (page 
3-13).

Release the switch.

OFF delay

OFF delay 
timer up

Delay finished Delay cancel

Switch OFF

Lamp

Lamp OFF graphic

OFF macro

Ending

No

Switch ON

Yes

Yes

Internal

External

Release the switch.

OFF delay

OFF delay 
timer up

Delay finished

Switch OFF

Delay cancel

No

Switch ON

Yes

Yes

Interlock

When the 
switch is OFF

Interlock 
condition

Lamp

Lamp OFF graphic

Output operation

OFF macro

Ending

Lamp

Lamp OFF graphic

No

Ineffective

Yes

Effective

Satisfied

Internal

Not satisfied

External External

Internal
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4 Lamp
Overview

• The displayed patterns of a lamp are switched in response to data changes in lamp memory.
There are lamps called “bit lamps” that are switched according to bit setting (ON) and resetting 
(OFF) and “word lamps” that are switched according to the values placed at memory addresses.

Bit lamp
Lamp memory: M19

Word lamp
Lamp memory: D100

• Colors can be set on a pattern-by-pattern basis.  For a [Draw Mode: REP] lamp, the text on the 
lamp can also be set for each pattern.

• A maximum of 128 patters are usable for one lamp:

PLC

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

M 0~15

M16~31

M32~47

.....
.....

LAMP

ON information

PLC memory

PLC

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

D099

D100

D101

.....
.....

LAMP

3 (DEC)

Pattern No. 3 display

PLC memory

ONOFF

(OFF) (ON) (P3) (P4) (P5) (P6)

(P128) (P127) (P8) (P7)

(   ): Bit lamp patterns

Pattern 0 Pattern 1 Pattern 2 Pattern 3 Pattern 4 Pattern 5

Pattern 6Pattern 7Pattern 126Pattern 127

Operation 
stop

Operation 
start Tank alarm Temperature 

increase
Temperature 

decrease
Water 

pressure drop

Voltage 
drop

Electric leak 
warning!

In 
preparation

Production 
discontinued!
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Setting Dialog

Main

Lamp Memory Specify a memory address for the lamp display.

Function
(No Function, Mode)

No Function:
The lamp part works independently irrespective of other parts.

Mode:
Messages can be displayed on the lamp part in a link with bit order 
alarming, time order alarming or message mode.
Specify the order in displaying messages [Display Order] on the lamp 
part as an auxiliary setting item.
For more information on bit order alarming and time order alarming, refer 
to “10  Alarming”; for more information on the message mode, refer to “6  
Message.”

Memory 
Designation

Action

Bit The lamp display is changed by bit setting (ON) and 
resetting (OFF).
The required number of bits depends on the number 
of display patterns. (127 bits maximum)
When multiple bits are set (ON), the most significant 
bit has priority.
The number of patterns can be set in the [Style] tab 
window.

Word
(BCD/DEC)

The lamp display is changed according to the value 
specified in the lamp memory.
The range of settings depends on the number of 
display patterns.
Range: 0 - 127
If a value outside the specified range is set, the lamp 
display is not changed.
The number of patterns can be set in the [Style] tab 
window.
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Example of display
When a 128-pattern lamp shown below is placed:

• Bit lamp
Lamp memory: M0 (allocated consecutively from M0 for the number of patterns)
Number of patterns: 128

* When multiple bits are set to ON, a pattern is displayed according to the most 
significant bit.

(OFF) (ON) (P3) (P4) (P5) (P6)

(P128) (P127) (P8) (P7)

(   ): Bit lamp patterns

Pattern 0 Pattern 1 Pattern 2 Pattern 3 Pattern 4 Pattern 5

Pattern 6Pattern 7Pattern 126Pattern 127

Operation 
stop

Operation 
start Tank alarm Temperature 

increase
Temperature 

decrease
Water 

pressure drop

Voltage 
drop

Electric leak 
warning!

In 
preparation

Production 
discontinued!

M000-015
M016-031

M112-127

M000-015
M016-031

M112-127

Operation 
stop

Water 
pressure drop

M4 (bit 4) is set to ON.

Set M4 (bit 4) in the PLC memory to ON.
Pattern 5 (P6) is displayed.

When M0 to M127 (all bits) are set to OFF 
in the PLC memory, pattern 0 (OFF) is 
displayed.

<Status Monitor > <Status Monitor >

M000-015
M016-031

M112-127

Production 
discontinued!

Pattern 127 (P128) is displayed.

<Status Monitor >
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• Word lamp
Lamp memory: D100
Number of patterns: 128

* If a value outside the specified range is set for the lamp memory, the lamp display is 
not changed.

Notes
• When the PLC memory is used for [Lamp Memory], set consecutive addresses for speeding the 

processing.
• If you place multiple lamps having a difference number of patterns on the screen allocating 

memory in consecutive addresses, carefully make the setting for [Lamp Memory].  The required 
number of bits varies depending on the number of patterns.

D100 3
D101

D100 0
D101

Operation 
stop

Temperature 
increase

Set “3” for D100.

Set “3” for D100 in the PLC memory.
Pattern 3 is displayed.

When “0” is set for D100 in the PLC 
memory, pattern 0 is displayed.

<Status Monitor > <Status Monitor >
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Text

(Character input box)

(Text alignment & copy)

[ON] [OFF] to [P128] When [XOR] is selected for [Draw Mode] on the [Style] tab window:
Only [OFF] can be selected.  Specify the text to be displayed.

Pattern No. When [REP] is selected for [Draw Mode] on the [Style] tab window:
Text to be displayed on each pattern can be specified.  Click each tab 
and specify the text to be displayed on the pattern of the lamp.

(Character input box) A maximum of four lines of text can be placed in one lamp.
Clicking the mouse button on the box brings up a text entry cursor.
Text can be justified within the lamp part.

Color

For more information, refer to “Appendix 4  Styles and Coordinates” on 
page A4-4.

Property

Enlarge

Point

Rotation + Direction

Windows Fonts For more information, refer to the Operation Manual.

 Use the Same 
Property for All 
Patterns

When this box is checked ( ), the text properties are applied to all the 
patterns line by line.

 Size Automatic 
Adjustment

When this box is checked ( ), the text is automatically adjusted to the 
largest size of all the patterns.

 4-Line Display

For more information, refer to “Appendix 4  Styles and Coordinates” on 
page A4-4.

(Text alignment)

 Retain the 
coordinates when 
changing character 
string

 Pitch

Display Language For more information, refer to “Appendix 3  Display Language.”
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Style

[ON] [OFF] to [P128] Select a pattern and specify a color for it.

Pattern No.

Color/Frame *1 Colors are shown for selection.  Depending on the setting for [Draw 
Mode], the setting items vary.  For more information, refer to page 4-9.

Frame Type
(No Frame, Type 1, Type 
2, Type 3)

This is valid when the selected part file is No. 0000 to 0003 of #32 [2D 2 
Pattern] in the file “Parts_Lp_E.V7”.
It is possible to select part 0 to 3 without opening the part list by pressing 
the [Change Part] switch.

Customize For more information, refer to the Operation Manual.

 Flash

Draw Mode
(XOR, REP)

XOR :
When the lamp memory is ON, the frame and text are displayed in the 
XORed color.

REP :
The color selected for [Color] above is shown as is.

For more information, refer to page 4-9.

 Transparent This setting item becomes active when [REP] is chosen for [Draw Mode].
When this box is checked ( ), the previous image is completely 
cleared.
For more information, refer to page 4-7.

Change Part For more information, refer to the Operation Manual.

No. of Patterns
(2 to 128)

This is valid when the selected part file is other than No. 0000 to 0003 of 
#32 [2D 2 Pattern] in the file “Parts_Lp_E.V7”.
Change the number of patterns.
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About transparency
The transparency function is useful to create a part that is displayed only when it is ON or a part 
consisting of only characters.

• When a part as shown below is placed on the screen:

• Unchecked
The previously displayed image remains.

• Checked
The previously displayed image does not remain.  Parts can be displayed appropriately even with 
graphics placed on the background.

Notes

• The [Transparent] setting is not valid for No. 0000 to 0003 in the part files “Parts_Lp_E.V7”.

• For displaying a switch or lamp part for which [Transparent] is checked ( ), or a pattern for which 
[Transparent Color] is checked ( ) in a graphic or graphic relay mode, limitations are imposed on 
the number and size of these parts and patterns displayable on one screen.  For more information, 
refer to page 11-19.

OFF ON
Part to be displayed only 

when it is ON
Not displayed

Only characters displayed

Custom parts
(Black: transparent color)

OFF OFF

[OFF] [ON] [OFF]

[OFF] [ON] [OFF]
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Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates” on page A4-12.

Display Setting

For information on setting the [Display Setting] tab window, refer to the V8 Series Reference Additional 
Functions.

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Draw Mode

XOR
Part file:  Parts_Lp_E.V7 (No. 0000 to 0003)

Text
When setting text on a lamp part, the same text is used for both OFF and ON statuses.
Set “OFF” in the character input box in the [Text] tab window.

Color
• OFF frame color / ON color / OFF color

Select the desired colors in the [Style] tab window.  The part is displayed in the selected colors.
• OFF text color

Select the desired color in the [Text] tab window.  The text is displayed in the selected color.
• ON frame color

It is not possible to select the frame color to be used when the lamp is ON.  It is automatically 
determined by XOR operation.

• ON text color
It is not possible to select the text color to be used when the lamp is ON.  It is automatically 
determined by XOR operation.
The text displayed when the lamp is ON is the same as that displayed when the lamp is OFF.

• This is the case where text is placed overlapping on a lamp part as shown below.

(Parts_Lp_E.V7)

XOR = ON frame color

Frame color

OFF color

ON color
XOR

XOR = ON text color

Text color

OFF color

ON color
XOR
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Example of display

Bla Blu R Mag Gre C Y W

Bla Blu R Mag Gre C Y WBla

Blu Bla Mag R C Gre W YBlu

R Mag Bla Blu Y W Gre CR

Mag R Blu Bla W Y C GreMag

Gre C Y W Bla Blu R MagGre

C Gre W Y Blu Bla Mag RC

Y W Gre C R Mag Bla BluY

W Y C Gre Mag R Blu BlaW

A

C

BD

C

Bla Blu R Mag Gre C Y W

Bla Blu R Mag Gre C Y WBla

Blu Bla Mag R C Gre W YBlu

R Mag Bla Blu Y W Gre CR

Mag R Blu Bla W Y C GreMag

Gre C Y W Bla Blu R MagGre

C Gre W Y Blu Bla Mag RC

Y W Gre C R Mag Bla BluY

W Y C Gre Mag R Blu BlaW

A

C

B D

C

♦ [OFF color: Yellow]
[OFF color: Red]
[Frame color: White]   The frame color displayed when the lamp is ON:
OFF color (yellow)   A
(Setting)

OFF color (red)   B
(Setting)

Frame color (white)   D
(Setting)

XOR Magenta = ON frame colorGreen C XOR

OFF color (yellow)   A
(Setting)

OFF color (red)   B
(Setting)

OFF color (blue)   D
(Setting)

XOR

Light blue = ON text color

Green  C
XOR

♦ [OFF color: Yellow]
[OFF color: Red]
[Text color: Blue]   The text color displayed when the lamp is ON:
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Part file: Parts_Lp_E.V7 (No. 0004 and later), or other
Text

When setting text on a lamp part, the same text is used for both OFF and ON statuses.
Set text in the character input box [OFF] in the [Text] tab window.

Color
• OFF color

Select the desired colors in the [Style] tab window.  The part is displayed in the selected color.
• ON color

The color specified in the [Style] tab window and the OFF color (explained above) are XORed. 
• P3 to P16 color

As with the ON color, the color specified in the tab window and the OFF color are XORed.
• This is the case where text is placed overlapping on a lamp part as shown below.
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REP
Part file: Parts_Lp_E.V7 (No. 0000 to 0003)

Text
When placing text on a lamp part in “REP” draw mode, the following two modes are available.
• When displaying different text when the lamp is ON and OFF:

OFF text
Set text in the character input box [OFF] in the [Text] tab window.

ON text
Set text in the character input box [ON] in the [Text] tab window.

• When displaying the same text when the lamp is ON and OFF:
OFF text

Set text in the character input box [OFF] in the [Text] tab window.
ON text

Set nothing in the character input box [ON] in the [Text] tab window.
The text set in the character input box [OFF] is displayed when the lamp is ON.

(Parts_Lp_E.V7)

RunStop

When the lamp is OFF
[Char. Prop.: Normal]

When the lamp is ON
[Char. Prop.: Bold]

The text property can be set as shown.

Error Error
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Color
• ON frame color, OFF frame color, ON color, OFF color

Select the desired colors in the [Style] tab window.  The part is displayed in the selected colors.
The same frame color is used when the lamp is ON and OFF.

• OFF text color
Set the color for [OFF] in the [Text] tab window.

• ON text color
Set the color for [ON] in the [Text] tab window.  The text is displayed in the selected color.

Part file: Parts_Lp_E.V7 (No. 0004 and later), or other
Almost the same as part No. 0 to 3 (Refer to page 4-12.)
<Different points>

• ON frame color, ON color
Select the desired colors in the [Style] tab window.  The part is displayed in the selected colors.
A color different from the OFF frame color can be set.

• For P3 to P16, the selected colors are shown.

Notes

• When the OFF text color and the ON color are the same, the text cannot be shown when the lamp is 
turned ON.

• When text is entered as graphics, it is not displayed when the lamp is turned ON.
Once the lamp is turned ON, the text is not displayed even when the lamp is turned OFF unless 
the screen is changed.

RUN

RUN

RUN

The text is not displayed when the lamp is once turned ON.
The text is displayed by opening the screen again.

Place text graphics.

Initial OFF state ON state OFF state
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Other Notes
The number of lamps
A maximum of 1024 lamp parts can be created on one screen.
For more information, refer to the Operation Manual.

Placing multiple lamp parts
When placing two or more lamp parts on one screen, do not allow them to overlap each other.
If it is unavoidably necessary to do so, note the following points when creating the screen.

REP

REP

XOR

XOR

XOR

XOR

M0=0

M1=0

M0=1

M1=0

XOR

XOR

M0=1

M1=1

XOR

XOR

M0=0

M1=1

REP

REP

M0=0

M1=0

M0=1

M1=0

REP

REP

M0=1

M1=1

REP

REP

M0=0

M1=1

REP

REP
M0=0

M1=1

M0

M1

M0

M1

M0

M1

M0

M1

M0

M1

* When XOR is selected, the 
overlapping section is shown 
in the XORed color.

* When REP is selected, the part 
that changes last (0->1 or 1->0) 
is displayed on top.

* When M0 = 0 in the above, the 
lamps are shown as below.
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5 Data Display
5.1 Num. Display

Overview

• Numerical data read from PLC is displayed in real time on the MONITOUCH screen in any of the 
following formats: DEC (w/o sign); DEC (w/ −sign); DEC (w/ +/−sign); HEX (hexadecimal); OCT 
(octal); BIN (binary) and [Real Number (decimal floating-point)].

• It is possible to show data in a different color when it exceeds or falls short of the specified range.  
This setting can easily attract the operators’ attention to the situation.

• It is possible to calculate data read from the PLC within MONITOUCH and to display its result on 
the MONITOUCH screen.

• In addition to using of “numerical data display” ([Num. Display]) independently, it can also be linked 
with another part.
For example, in order to indicate data as a percent in the statistic graph as shown below, it is 
necessary to link [Num. Display] with [Statistic Graph].  Then % data automatically reflects 
changes along with the data in the statistic graph.

PLC

.................

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

12345
12345

PLC memory

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

100

80

100

150

Target

Count Count

Target

When the count exceeds 
the target, the count 
number color is changed.

PLC

.................

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

-211
789

PLC memory

MONITOUCH executes the following calculation 
on the read data “789” and displays the result.

[-1000] + [789] × [1] = -211

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

%

A      350    42.94%

B      209    25.64%

C      156    19.14%

D      100    12.26%

Linked

Numerical data displayStatistic graph

Production Ratio

Result

Product

Product

Product

Product
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• Offset value designation memory
One single numerical display part is usable to show different data by switching the memory 
address assigned to the part.  This feature should be helpful to reduce the number of screens or 
parts used and facilitate screen maintenance.

D100 3

1000

980

12
D103 (D100 + 3)
D113 (D110 + 3)
D123 (D120 + 3)

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

1000

999

5

1

D102 (D100+ 2)
D112 (D110 + 2)
D122 (D120 + 2)

1000

998

10

D100 2

D100

D102

0

1000

998

D103

D112
D113

D122
D123

1000

10

980

12

D101 1000

999D111

5D121

D101 (D100+ 1)
D111 (D110 + 1)
D121 (D120 + 1)

Example: Display of the scheduled production volume, non-defective count, and defective count 
for a machine selected from Nos. 1 to 3

“2” written to the 
offset value 
designation 
memory D100

Numerical data display
Machine number: D100 (memory)
Scheduled production volume: D100 (base memory), D100 (offset value designation 

memory)
Non-defective count: D110 (base memory), D100 (offset value designation 

memory)
Defective count: D120 (base memory), D100 (offset value designation 

memory)

When D100 = 1, machine No. 1 data at 
D101, D111, and D121 are displayed.

“3” written to the 
offset value 
designation 
memory D100

Scheduled
production volume

Non-defective count

Defective count

<One-day production result>

<One-day production result> <One-day production result>

When D100 = 2, machine No. 2 data at 
D102, D112, and D122 are displayed.

When D100 = 3, machine No. 3 data 
at D103, D113, and D123 are 
displayed.

Machine number
(Offset value 
designation memory)

Scheduled 
production volume

Non-defective count

Defective count

Scheduled
production volume

Non-defective count

Defective count

Scheduled
production volume

Non-defective count

Defective count
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• Attribute specification memory
The attributes (the number of digits, decimal point, display type, or text color) of numerical display 
parts are easily changeable while MONITOUCH is in RUN mode.

31.5315

D100 315

0
D201
D202

0
D200

D100 315

D201
D202

D200

7

13B

D203 D2030 0

1
2
6

Example: Numerical data display D100 (no transparency)
Decimal point: 0  1, Text color: black   red, Background color: white  yellow

<Room Temperature Check>

D200 = 1
D201 = 2
D202 = 6

The display now 
includes one 
decimal place 
and shows 
red-colored text 
on yellow-colored 
background.

Attribute specification memory

Decimal point: D200

Text color: D201

Background color: D202

Display type: D203

D100

(White)
(Black)

(Yellow)
(Red)

<Room Temperature Check>

(1 decimal place)(No decimal point)

<Room Temperature Check>

D203 = 3

The display type 
is switched from 
DEC to HEX.
The setting for 
one decimal 
place (D200 = 1) 
is invalid.

(DEC w/o sign) (DEC w/o sign)
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Setting Dialog

Main

Memory 
Base Memory

Specify the address to be used for numerical data display.
* This is valid when [No Function], [Entry Target] or [Digital Switch] is set for 

[Function].

 Offset Value 
Designation 
Memory*4 *5

Set the memory address and the code used for storing an offset value with 
respect to the value in the base memory.  Constant setting is also allowed.

* This is active when [No Function], [Entry Target] or [Digital Switch] is set 
for [Function].  This setting is also valid for [Alarm: Max/Min].

Data Length *1 Choose data length to be occupied for this part.
1 word, 2 words

Digits *2 Specify the number of digits for numerical data display.

Decimal Point Specify the decimal place.  The number of decimal places must be smaller 
than the number of digits.  When no decimal point is required, set “0”.

Display Type *1 Select the format of numbers to be displayed on the screen.
DEC (w/o sign), DEC (w/ -sign), DEC (w/ +/- sign), HEX, OCT, BIN (binary)

Input Type Choose the code to be used when reading data from the PLC memory 
address.
BCD, DEC, Actual Number *3

Code Setting Range

DEC 0 to 65535

BCD 0 to 9999

Constant (DEC) 0 to 65535

Display Type Digits Decimal Point

DEC 1 to 10 0 to 9

HEX 1 to 8 −

OCT 1 to 11 −

BIN 1 to 32 −
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*1 Relation between data length and display type

*2 When a value exceeding the set number of digits is keyed in:

 Zero Suppress Check this box when using zero suppression.

When this box is checked, choose either [Flush Left] or [Flush Right].

 Size Automatic 
Adjustment

Check this box when automatically adjusting the item size based on the 
[Digits] and [Decimal Point] settings.

Function Select a function when using the display part linking to it.

Code 1-word Range 2-word Range

DEC (w/o sign) 0 to 65535 0 to 4294967295

DEC (w/ −sign) −32768 to 32767 −2147483648 to 2147483647

DEC (w/ ±sign) −32768 to +32767 −2147483648 to +2147483647

HEX 0 to FFFF 0 to FFFFFFFF

OCT 0 to 177777 0 to 37777777777

BIN (binary) 0 to 1111111111111111 0 to 11111111111111111111111111111111

Code DEC HEX/OCT/BIN

Display Overflow display Numbers from the right

Example: Data length:  1 word
Digits:  3
Entered value: 1010

− − − 010

[  Zero Suppress] (flush right) →       123
[  Zero Suppress] → 000123

Space

Flush-left → 123
Flush-right →     123

Function Attached Data Linked Item Refer to:

No Function − − −

Entry Display Part
Max. Value Display Part
Min. Value Display Part

− Entry mode page 7-23
page 7-25

Entry Target Order INC − page 7-19

Stat. Graph % Display Statistic Graph 
No.

Statistic graph page 8-34

Sampling Count Display
Sampling Time Display

− Trend graph, 
Data sampling, 
Alarm logging

page 9-25
page 9-42
page 10-60

Memory Card No. Display
Memory Card File No. Display
Memory Card Record No. 
Display

− Memory card 
mode

page 15-16

Sampling Buffer Average 
Display
Sampling Buffer Max. Display
Sampling Buffer Min. Display
Sampling Buffer Total Display

Sampling 
Buffer Word 
No.
Sampling 
Buffer No.

− page 9-25
page 9-42

Digital Switch Moves to 
Higher/Lower 
Digits

Switch page 3-38
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*3 Actual Number (data with decimal floating-point)
For more information, refer to page 5-15.

*4 The offset value designation memory is read in every cycle, regardless of the item processing 
cycle.  When to update the screen depends on the setting made at [  Redraw the screen] 
([Screen Setting] → [Screen Setting] → [Show/Hide Item]).
• Checked:

The screen is updated when the value in the offset value designation memory changes.
• Unchecked:

The screen is updated at the times below:
Screen change, screen redisplay, multi-overlap display change (with a display part placed on a 
multi-overlap display), or data block change (with a display part placed in a data block)

*5 Notes on the use of the offset value designation memory
• An offset value designation memory location is counted as one of the number of the set 

memory locations.
For more information on the number of permissible memory locations, refer to the V8 Series 
Operation Manual.

• When the screen is updated, the offset value designation memory is read for the items placed 
on the screen.  For a screen including multiple offset value designation memory locations, the 
updated screen is displayed upon completion of reading all these memory locations.  If 
updating is time-consuming, the use of the internal memory is recommended.

• When setting offset values on a screen, the setting needs to be finished before switching the 
screen to another.
In a case where an offset value is designated in an OPEN macro, the offset value is not valid 
when the screen is open, but becomes valid when the screen is updated.

• If a value placed in offset value designation memory is outside the permissible range, an error 
arises.  Observe the specified range for setting.
PLC memory: Communication error Format
Internal memory: Error 46 
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Style

*1 Transparent setting
There are some points to be noted when using the transparent setting for numerical data display.
For more information, refer to page 5-44.

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”

Property

Transparent *1

Enlarge

Point

Rotation + Direction

Spacing

 Windows Font
For more information, refer to the Operation Manual.

Font

Character Size For more information, refer to “Appendix 4  Styles and Coordinates.”

Display Language For more information, refer to “Appendix 3  Display Language.”

Change Part For more information, refer to the Operation Manual.

Customize For more information, refer to the Operation Manual.
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Operation/Alarm

 Alarm *1

Min. Specify a range using a constant or a memory address.

Color Select colors for text and background.

Max. Specify a range using a constant or a memory address.

Color Select colors for text and background.

 Word Operation *2 Operation can be performed on the value in the memory address specified 
for [Memory] on the [Main] tab window.

 Scaling *3 Data (Range before Scaling) that the PLC has read is automatically 
converted into the range (Range after Scaling) that is set.
It is possible to eliminate correction program for the data that the PLC has 
read when displaying temperature, rotation speed, etc.

Range before 
Scaling

Specify the data to be read from the PLC.

Range after 
Scaling

Specify the range of data to be shown on MONITOUCH.

Offset value 
(constant)

Multiplier of 
divisor 
(constant)

× or / (÷)

4000

100

00

PLC� MONITOUCH

(Range before Scaling) (Range after Scaling)
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*1 When [Entry Target] is selected for [Display Function]
When the box for [Alarm] is checked, the maximum and minimum values specify the range of 
numerical data that can be input.
For more information on numerical data entry, refer to “7  Entry Mode.”

*2 Word Operation
Example:  Data read from PLC is “789”.
• [BCD] is chosen for [Input Type], but negative numbers should be indicated.

(Negative number in the BCD format does not exist.)
Choose either [DEC (w/ −sign)] or [DEC (w/ +/−sign)] for [Display Type].

Offset value + (data) [×] multiplier = data displayed
[0] + (789) [×] [−1] = −789

Or, [−1000] + (789) [×] [1] = −211

• Example of multiplication
Offset value + (data) [×] multiplier = data displayed

[1000] + (789) [×] [1] = 1789
[0] + (789) [×] [100] = 78900

• Example of division with decimal point
When “2” is entered for [Decimal Point] in the [Type] tab window, “7.89” is read into 
MONITOUCH.

Offset value + (data) [÷] divisor = data displayed
[0] +  (7.89) [÷] [100] = 0.0789

Data is rounded down to the decimal place, and “0.07” is indicated.

• Example of division without decimal point
Offset value + (data) [÷] divisor = data displayed

[0] + (789) [÷] [−100] = −7.89
Data is rounded down to the decimal place, and “−7” is indicated.

Offset value + (data) [÷] divisor = data displayed
[200] + (789) [÷] [100] = 207.89

Data is rounded down to the decimal place, and “207” is indicated.

Example:  When [Word Operation] is selected for [Entry Target] (entry mode):
• The value you enter is displayed (= result of operation).

Data stored in the memory address is the source data of operation.

Offset value + (data) [×] multiplier
[0] +     (A) [×] [100]

Input “100” → 100 = (A) ×100 → (A) = 1
Input “550” → 550 = (A) ×100 → (A) = 5 (Remainder “5” is ignored and “500” is displayed.)
Input “1340”    →  1340 = (A) ×100 → (A) = 13 (Remainder “40” is ignored and “1300” is 
displayed.)
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Offset value + (data) [÷] divisor
[0] +     (A) [÷] [100]

Input “100” → 100 = (A) ÷100 → (A)  = 10000
Input “550” → 550 = (A) ÷100 → (A)  = 55000
Input “1340”    →   1340 = (A) ÷100 → (A)  = 2928 (A word exceeds 5 digits.)

*3 Scaling
• If data in the PLC memory × the maximum value of [Range after Scaling] is greater than 

double-word, it cannot be displayed correctly.

• Example:  Numerical data display
When data in the PLC memory address D100 is “2000” with [Range before Scaling: 0 to 4,000] 
and [Range after Scaling: 0 to 100], “50” is displayed on MONITOUCH.

• Example:  When [Scaling] is selected for [Entry Target] (entry mode):
When “25” is entered through the keypad with [Range before Scaling: 0 to 4,000] and [Range 
after Scaling: 0 to 100], “1,000” is written to the PLC memory address D100.

• Notes on the use of entry targets (entry mode)
When entry targets are used, some error may arise.
If [Range before Scaling] is greater than [Range after Scaling], the entered value is displayed 
correctly.

When comparing [Range before Scaling] with [Range after Scaling], remove the decimal point 
from the display range.

Example: [Range before Scaling: 0 to 10000] and [Range after Scaling: 0.00 to 500.00]
The range after scaling is converted into 0 to 50000, that is, [Range before Scaling] < [Range 
after Scaling]; therefore, the entered value is not displayed correctly.

4000

100

00

PLC�

25

1000

MONITOUCH

(Range before Scaling) (Range after Scaling)

(Data entered on the keypad)

(Data stored)

100

0

1000010000

250

10000

100

00 0

PLC

100
2525

2500
200

2
0 0

PLCDisplayed on 
MONITOUCH

(Range before Scaling) (Range after Scaling)

Entered value = value displayed on MONITOUCH

Entry on 
MONITOUCH

Displayed on 
MONITOUCH

(Range before Scaling) (Range after Scaling)

Entered value ≠ value displayed on MONITOUCH

Entry on 
MONITOUCH

If [Range before Scaling] > [Range after Scaling], the entered 
value is displayed correctly.

If [Range before Scaling] < [Range after Scaling], the entered 
value is not displayed correctly.
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Detail

Process Cycle For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

 Attribute 
Specification 
Memory*1

Check this box for changing attributes according to the values at the attribute 
specification memory address.

DEC/BCD Select either code to be used for reading the attribute specification memory.
This selection commonly applies to all attributes.

Digits Set a memory address used to specify the number of digits of the numerical 
data display.
When the numerical data display includes decimal places, the number of 
digits specified at this address must include the number of decimal places.

* If the number of digits of a value being read exceeds the limit 
specified, a hyphen is displayed, indicating an overflow.

Decimal Point Set a memory address used to specify the number of decimal places of the 
numerical data display.

* The number of decimal places must be smaller than the number of 
digits.  If the number of decimal places is the same as or more than 
the number of digits, an overflow arises.
For HEX, OCT or BIN as [Display Type], decimal point setting does 
not take effect.
Even if a value is set for [Decimal Point] in such a case, it is 
assumed to be zero.

Display Type Digits

DEC 1 to 10

HEX 1 to 8

OCT 1 to 11

BCD 1 to 8

BIN 1 to 32

FLOAT 1 to 32

Display Type Decimal Point

DEC 0 to 9

BCD 0 to 7

FLOAT 0 to 31

HEX/OCT/BIN* -
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Display Type Set a memory address used to specify the display type of the numerical data 
display.
Place a value at the memory address according to the following:

0: DEC (w/o sign)
1: DEC (w/ -sign)
2: DEC (w/ +-sign)
3: HEX
4: OCT
5: BIN
6: FLOAT*
7: BCD (w/o sign)
8: BCD (w/ -sign)
9: BCD (w/ +-sign)

* This setting takes effect when [Data Length: 2-Word] is selected in 
the [Main] tab window.  The [Display Type] setting is invalid when 
[Input Type: Actual Number] is selected in the [Main] tab window.

Text Color Set a memory address used to specify the text color.

Bits 0 to 6: Color
Bit 7: Blinking (0: No, 1: Yes) 

A color from 128 colors (with blinking) can be selected on [Palette 1] in the 
[Custom Color] dialog.
Colors correspond to the following color codes:

31.5 Foreground color

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

0 - 127 colors

Foreground color

Blinking
     0: No
     1: Yes

n

[Palette 1]

00
16
32
48
64
80
96
112

15
31
47
63
79
95
111
127

0 1 2 3 4 5 6 7 8 9 A B C D E F
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5
*1 Notes on the use of attribute specification memory

• The update timing depends on the [Process Cycle] in the [Detail] tab window for each data 
display.

• For a display part provided with a frame, the frame size is not changed according to the setting 
of [Digits], [Decimal Point], or [Display Type].  For this reason, you need to set the maximum 
number of digits in the screen data.    

• When [Property: Not Transparent] is selected in the [Style] tab window, the background 
drawing area will be influenced by the setting of [Digits], [Decimal Point], or [Display Type].  
Therefore, if the set number of digits is decreased, the background color will be left.
For this reason, you need to set the maximum number of digits in the screen data.  Or, you 
may update the display with the macro command “SYS (RESET_SCRN)” or by screen 
change.

• If a value displayed has become higher than the maximum or lower than the minimum 
specified for alarm, the value is shown in the color preset for alarm.

• When [   Attribute Specification Memory] is checked, the macro command “CHG_DATA” is 
not executable for the numerical data display.

• With [Function: Entry Target] specified, the display is switched when the cursor is moved from 
the display field.

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates” on page A4-10.

Background Color Set a memory address used to specify the text background color.

Bits 0 to 6: Color 
Bit 7: Blinking (0: No, 1: Yes) 

A color from 128 colors (with blinking) can be selected on [Palette 1] in the 
[Custom Color] dialog.  For color codes, refer to the section of “Text Color.”

* However, the [Background Color] setting does not take effect when 
[Transparent] is selected for [Property] in the [Style] tab window.

31.5 Background color

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

0 - 127 colors

Background color

Blinking
     0: No
     1: Yes

n
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Comment

Display Setting

For information on setting the [Display Setting] tab window, refer to the V8 Series Reference Additional 
Functions.

Comment This setting is used for the operation log function.  For more information, refer 
to the V8 Series Reference Additional Functions.

Display Language For more information, refer to “Appendix 3  Display Language”.



5.1 Num. Display

5-15

5

Actual Number (Data with Decimal Floating Point)

MONITOUCH can handle real numbers specified by the IEEE754 standards (32-bit single precision 
real number format).

Overview
About IEEE754 standards (32-bit single prevision real number format)
32 bits are defined in the following format.

The format expresses decimal floating-point data as shown below 

• Normalized numbers

• Denormalized numbers (e = 0)

Symbol Name Contents

s Sign 0: Positive
1: Negative

e Exponent 0 to 255
* However, if “255” is specified, it cannot be regarded 

as a decimal floating-point number.
If “0” is specified, it is regarded as a denormalized 
number.

f Significand This is a binary fraction less than 1.
The final significand can be calculated using the following 
formula:
[1.f ] = [1 + f × 2−23]

Symbol Name Contents

s Sign 0: Positive
1: Negative

e Exponent Since e = 0, the exponent will be “−126”.

f Significand f ≠ 0
This is a binary fraction less than 1.
The final significand can be calculated using the following 
formula:
[0.f ] = [f × 2−23]

022233031

s e f

s
(-1) 2 (1.f)

(e-127)



5.1 Num. Display

5-16

Applicable range
−3.402823 × 1038 ≤ n ≤ −1.401298 × 10−45 
1.401298 × 10−45  ≤ n ≤ 3.402823 × 1038 
(Significant digits: approx. 7 (in decimal))

When the value falls in the following conditions, it cannot be handled as a decimal floating-point 
number.

e = 255, f ≠ 0 (non-numeric)
e = 255, f = 0, s = 0 (+∞)
e = 255, f = 0, s = 1 (−∞)
e = 0 (0)

MONITOUCH display range
−9.999999 × 1031  ≤ n ≤ −1.000000 × 10−31 
1.000000 × 10−31  ≤ n ≤ 9.999999 × 1031

A: Overflow display (- - - -)
B: 0
C: −0

0 1-1

38-3.402823   10 3.402823   10 38-1.401298   10-45 1.401298   10 -45

0 1-1

38-3.402823   10 3.402823   10 38-1.401298   10-45 -1.401298   10-45

31-9.999999   10 9.999999   10 31-1.000000   10-31 1.000000   10 -31

A C B A
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Decimal Floating-point Data Example
Example 1
When the following 32-bit data is displayed as decimal floating-point data, it is calculated as shown 
below.

As a result, “−3.125” is shown on MONITOUCH.

Example 2
When the following 32-bit data is displayed as decimal floating-point data, it is calculated as shown 
below.

As a result, “2.5” is shown on MONITOUCH.

1 1 0 0 0 0 0 0 0 1 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

022233031

s
(-1) 2 (1.f)

(e-127)

s e f

2
(128-127)

2
1

2
1

(-1) -1

[1 + f    2   ]-23

[1 + (2  + 2  )   2   ]22 19 -23 [1 + (2     + 2     )]22-23 19-23

[1 + 2  + 2  ]-1 -4 [1 + 0.5 + 0.0625]
1.5625

-1 2 1.5625 -3.125

10000000(BIN) = 128(DEC)Negative

[1 + (2   )   2   ]

0 1 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

022233031

s
(-1) 2 (1.f)

(e-127)

s e f

2
(128-127)

2
1

2
0

(-1) 1

[1 + f    2   ]-23

21 -23 [1 + 2  ]-2

[1 + 0.25] 1.25

1 2 1.25 2.5

10000000(BIN) = 128(DEC)Positive
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5.2 Char. Display
Overview

• Data read from the PLC is displayed in the form of characters on the MONITOUCH screen in real 
time.  ANK codes are put into one-byte characters, and Shift JIS codes are put into two-byte 
characters.

• In addition to using of “character display” ([Char. Display]) independently, it can also be linked with 
another part.
For example, when a character key set up in [Entry] mode is pressed, the character is entered in 
the [Char. Display] part specified as “entry target.” This is possible by linking [Char. Display] with 
[Entry] mode.

• Offset value designation memory
One single character display part is usable to show different data by switching the memory 
address assigned to the part.  This feature should be helpful to reduce the number of screens or 
parts used and facilitate screen maintenance.
For more information, refer to page 5-2.

• Attribute specification memory
The attributes (the number of bytes or text color) of character display parts are easily changeable 
while MONITOUCH is in RUN mode.  For more information, refer to page 5-3.

PLC

.................

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEMPLC memory

ABCDE
ABCDE

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

abcdefgh

ABCDEFGH

opqrstuv

OPQRSTUV

E J N S X & d

D I M R W % c

C H L Q V # c

B G K P U Z b

i n

r

ENTER CLEAR

h m

s

+BK -BK

g l q v z DEL BS

f k p u y UP DW

A F K O T Y a e j o t x <-- -->

w *

D

A
B
C

Linked

Character display

Keypad

Text Entry Screen

Product
Product
Product
Product
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Setting Dialog

Main

Memory *1
Base Memory

Specify the address to be used for character display.
* This is valid when [No Function], [Entry Target] or [Password Input] is set 

for [Function].

 Offset Value 
Designation 
Memory*2 *3

Set the memory address and the code used for storing an offset value with 
respect to the value in the base memory.  Constant setting is also allowed.

* This is active when [No Function], [Entry Target] or [Password Input] is set 
for [Function].

No. of Bytes Specify the number of bytes to be used by this part.

Character Position Choose either flush-left or flush-right for character display.

Text Process
(LSB → MSB / 
MSB → LSB)

Set the recognition of MSB and LSB in one word.

[LSB → MSB]

[MSB → LSB]

 Size Automatic 
Adjustment

Check this box when automatically adjusting the item size based on the [No. 
of Bytes] setting.

Code Setting Range

DEC 0 to 65535

BCD 0 to 9999

Constant (DEC) 0 to 65535

Flush Left →   ABC
Flush Right →      ABC

MSB     LSB
2nd byte      1st byte

15                                  0

LSB    MSB
1st byte      2nd byte

15                                  0
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*1 Code used for storing text of character display parts
• 1-byte characters: ANK code
• 2-byte characters: Shift-JIS code

Pay attention to the order of storing data in the higher and lower digits in each address.

Example: Character display [Memory: D500] [No. of Bytes: 6]
When inputting D500: H3231, D501: H3433 and D502: H4241, the characters “1234AB” is 
displayed on MONITOUCH.

When inputting D500: H3231, D501: H0033 and D502: H4241, the characters “1234” is 
displayed on MONITOUCH.  The characters after the null (00) code are not displayed when 
inputting null (00) code.
When you want to insert a space, input the space code (20H).

Function Select a function when using the display part linking to it.

Function Attached 
Data

Linked Item Refer to:

No Function − −

Entry Display Part − Entry mode

Entry Target Order INC −

Sampling Status Display − Alarm logging

Memory Card Name Display 
Memory Card File Name 
Display
Memory Card Record Name 
Display

− Memory card mode

Password Input Password 0 
(to 3)

Entry mode

Recipe Folder Name Display
Recipe File Name Display

− Recipe mode

PLC

D500
D501
D502

H3231
H3433
H4241

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

1234AB

PLC

D500
D501
D502

H3231
H0033
H4241

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

123
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*2 The offset value designation memory is read in every cycle, regardless of the item processing 
cycle.  
When to update the screen depends on the setting made at [  Redraw the screen] ([Screen 
Setting] → [Screen Setting] → [Show/Hide Item]).
• Checked:

The screen is updated when the value in the offset value designation memory changes.
• Unchecked:

The screen is updated at the times below:
screen change, screen redisplay,
multi-overlap display change (with a display part placed on a multi-overlap display),
data block change (with a display part placed in a data block)

*3 Notes on the use of the offset value designation memory
• An offset value designation memory location is counted as one of the number of the set 

memory locations.
For more information on the number of permissible memory locations, refer to the Operation 
Manual.

• When the screen is updated, the offset value designation memory is read for the items placed 
on the screen.  For a screen including multiple offset value designation memory locations, the 
updated screen is displayed upon completion of reading all these memory locations.  If 
updating is time-consuming, the use of the internal memory is recommended.

• When setting offset values on a screen, the setting needs to be finished before switching the 
screen to another.
In a case where an offset value is designated in an OPEN macro, the offset value is not valid 
when the screen is open, but becomes valid when the screen is updated.

• If a value placed in offset value designation memory is outside the permissible range, an error 
arises.  Observe the specified range for setting.
PLC memory: Communication error Format
Internal memory: Error 46 
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Style

*1 Transparent setting
There are some points to be noted when using the transparent setting for character display.
For more information, refer to page 5-44.

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”

Property

Transparent *1

Enlarge

Point

Rotation + Direction

Spacing

 Windows Font For more information, refer to the Operation Manual.

Font
For more information, refer to “Appendix 3  Display Language.”

Display Language

Change Part For more information, refer to the Operation Manual.

Customize For more information, refer to the Operation Manual.
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5

Detail

Process Cycle For more information, refer to “Appendix 5  Process Cycle.”

 JIS/ASCII
(1-Byte, 2-Byte)

This is the setting to be used for the GD-80 compatible data.
For more information, refer to the File Conversion manual provided 
separately.

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

 Attribute 
Specification 
Memory*1

Check this box for changing attributes according to the values at the attribute 
specification memory address.

DEC/BCD Select either code to be used for reading the attribute specification memory.
This selection commonly applies to all attributes.

No. of Bytes Set a memory address used to specify the number of bytes of the character 
display.
No. of Bytes: 1 to 127

* Regardless of the setting for [No. of Bytes], 127 bytes (64 words) will 
always be read.
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Text Color Set a memory address used to specify the text color.

Bits 0 to 6: Color 
Bit 7: Blinking (0: No, 1: Yes) 

A color from 128 colors (with blinking) can be selected on [Palette 1] in the 
[Custom Color] dialog.
Colors correspond to the following color codes:

Background Color Set a memory address used to specify the text background color.

Bits 0 to 6: Color 
Bit 7: Blinking (0: No, 1: Yes)

A color from 128 colors (with blinking) can be selected on [Palette 1] in the 
[Custom Color] dialog.  For color codes, refer to the section of “Text Color.”

* However, the [Background Color] setting does not take effect when 
[Transparent] is selected for [Property] in the [Style] tab window.

31.5 Foreground color

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

0 - 127 colors

Foreground color

Blinking
     0: No
     1: Yes

n

[Palette 1]

00
16
32
48
64
80
96
112

15
31
47
63
79
95
111
127

0 1 2 3 4 5 6 7 8 9 A B C D E F

31.5 Background color

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

0 - 127 colors

Background color

Blinking
     0: No
     1: Yes

n
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*1 Notes on the use of attribute specification memory
• The update timing depends on the [Process Cycle] in the [Detail] tab window for each 

character display.
• For a display part provided with a frame, the frame size is not changed according to the setting 

of [No. of Bytes].  For this reason, you need to set the maximum number of bytes in the screen 
data.

• When [Property: Not Transparent] is selected in the [Style] tab window, the background 
drawing area will be influenced by the setting of [No. of Bytes].  If the set number of bytes is 
decreased, therefore, the background color will be left.
For this reason, the maximum number of bytes in the screen data needs to be set.  
Alternatively, you may update the display with the macro command “SYS (RESET_SCRN)” or 
by screen change.

• When [ Attribute Specification Memory] is checked, the macro command “CHG_DATA” is 
not executable for the character display.

• With [Function: Entry Target] specified, the display is switched when the cursor is moved from 
the display field.

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates” on page A4-10.
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Comment

Display Setting

For information on setting the [Display Setting] tab window, refer to the V8 Series Reference Additional 
Functions.

Comment This setting is used for the operation log function.  For more information, refer 
to the V8 Series Reference Additional Functions.

Display Language For more information, refer to “Appendix 3  Display Language”.
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5.3 Message Display
Overview

• Required messages should be registered within MONITOUCH preliminarily.  When a message 
number is specified in the PLC memory, the corresponding message is displayed on the 
MONITOUCH screen in real time.

• One-line message can be displayed in any position desired.

PLC

.................

AAAAAA
BBBBBB
CCCCCC
DDDDDD
EEEEEE
FFFFFF
GGGGGG
HHHHHH
IIIIII
JJJJJJ
KKKKKK

QQQQQQ

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8
No. 9
No. 10

No. 20
10

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

KKKKKK

PLC memory

Message editing

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

AAAAAA

JJJJJJ

DDDDDD
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Setting Dialog

Main

Memory One word is occupied.
The message that corresponds to data contained in the specified memory 
address is displayed on the screen.

* Specify a message number using its absolute address (range: 0 to 
32767).
For more information on the absolute address, refer to the Operation 
Manual.

Message Edit When you click [Open], the [Message Edit] window is opened.

For more information on the message editing procedure, refer to the 
Operation Manual.
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Style

*1 Transparent setting
There are some points to be noted when using the transparent setting for message display.
For more information, refer to page 5-44.

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”

Property

Transparent *1

Enlarge

Point

Rotation + Direction

 Windows Font

For more information, refer to the Operation Manual.Change Part

Customize



5.3 Message Display

5-30

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates” on page A4-10.

Display Setting

For information on setting the [Display Setting] tab window, refer to the V8 Series Reference Additional 
Functions.

Process Cycle For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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5.4 Table Data Display
Overview

• Multiple data can be displayed in tabular form with ease.
You can choose any from [Num. Display], [Char. Disp.], [Message Display] and [Text] for data 
display part.

• Property modification for multiple data display parts is possible at one time.
• Average, maximum, minimum, and total values can be displayed.
• Table data display part can be set as an entry target for entry mode.

[Table Data Display] Setting Dialog

This section explains about the setting dialog that appears when the table data is selected entirely.

Main

No. 1 No. 2 No. 3 No. 4 No. 5 Average

1 100 150 120 130 200 140

2 120 100 180 190 200 158

3 130 120 160 100 150 132

4 50 60 40 150 20 64

No. of Lines (1 - 20) Specify the number of lines.

No. of Columns (1 - 25) Specify the number of columns.
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Style

Detail

 Ruled Line
(color)

Determine whether or not ruled lines should be displayed.
When the box is checked, you can select a color for ruled lines.

Background (color) Select a color for the background of table data.

Change Part For more information, refer to the Operation Manual.

Process Cycle For more information, refer to “Appendix 5  Process Cycle.”

Order INC
This is valid when you use table data as entry targets.
For more information, refer to “7  Entry Mode.” Item Select Memory

Cursor Direction

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates” on page A4-10.

[Num. Display] Setting Dialog

The setting dialog can be displayed for each data cell.
(For more information on the editing procedure, refer to the Operation Manual.)
This section explains the case where [Num. Display] is selected on the [Type] tab window.

Type

Num. Display
Char. Display
Message Display
Text

Choose [Num. Display].
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Main

Memory Specify the address to be used for numerical data display.
* This is valid when [No Function] or [Entry Target] is set for [Function].

Data Length *1 Choose data length to be occupied for this part.
1 word, 2 words

 Inc. Direction *2 This is valid when multiple data in the table data are selected.
For more information, refer to page 5-35.

Digits *3 Specify the number of digits for numerical data display.

Decimal Point Specify the decimal place.  The number of decimal places must be smaller 
than the number of digits.  When no decimal point is required, set “0”.

Display Type *1 Select the format of numbers to be displayed on the screen.
DEC (w/o sign), DEC (w/ -sign), DEC (w/ +/- sign), HEX, OCT, BIN (binary)

Input Type Choose the code to be used when reading data from the PLC memory 
address.
BCD/DEC

 Zero Suppress Check this box when using zero suppression.

When this box is checked, choose [Flush Left], [Center] or [Flush Right].

Display Type Digits Decimal Point

DEC 1 to 10 0 to 9

HEX 1 to 8 −

OCT 1 to 11 −

BIN 1 to 32 −

[  Zero Suppress] (flush right) →       123
[  Zero Suppress] → 000123

Space

Flush-left →   123
Center →      123
Flush-right →        123
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*1 Relation between data length and display type

*2 Inc. Direction

*3 Digits
For more information, refer to page 5-5.

*4 Start X/Y, End X/Y

Function Select a function when using the display part linking to it.

Code 1-word Range 2-word Range

DEC (w/o sign) 0 to 65535 0 to 4294967295

DEC (w/ −sign) −32768 to 32767 −2147483648 to 2147483647

DEC (w/ ±sign) −32768 to +32767 −2147483648 to +2147483647

HEX 0 to FFFF 0 to FFFFFFFF

OCT 0 to 177777 0 to 37777777777

BIN (binary) 0 to 1111111111111111 0 to 11111111111111111111111111111111

Function Attached Data

No Function −

Entry Target −

Mean Value Display
MAX Display
MIN Display
Total Value Display

Start X/Y
End X/Y *4

12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345

12345
12345
12345
12345
12345

12345 12345 12345
12345 D200 D203
12345 D201 D204
12345 D202 D205
12345 12345 12345

12345
12345
12345
12345
12345

The memory addresses that 
correspond to the selected data 
display cells are changed.

Example:
Memory: D200

 Inc. Direction: checked (↓)

Selected

12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345

X:1,Y:1 X:2,Y:1 X:3,Y:1
X:1,Y:2 X:2,Y:2 X:3,Y:2
X:1,Y:3 X:2,Y:3 X:3,Y:3
X:1,Y:4 X:2,Y:4 X:3,Y:4
X:1,Y:5 X:2,Y:5 X:3,Y:5

Mean value display for the selected data
    Display Function: Mean Display
    Start X: 2, Y: 1
    End X: 2, Y: 4

Selected
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Style

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”

Property

Enlarge

Point

Character Size

 Windows Font
For more information, refer to the Operation Manual.

Font

Display Language For more information, refer to “Appendix 3  Display Language.”
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Operation/Alarm

 Alarm *1

Min. Specify a range using a constant or a memory address.

Color Select colors for text and background.

Max. Specify a range using a constant or a memory address.

Color Select colors for text and background.

 Word Operation *2 Operation can be performed on the value in the memory address specified 
for [Memory] on the [Main] tab window.

 Scaling *3 Data (Range before Scaling) that the PLC has read is automatically 
converted into the range (Range after Scaling) that is set.
It is possible to eliminate correction program for the data that the PLC has 
read when displaying temperature, rotation speed, etc.

Range before 
Scaling

Specify the data to be read from the PLC.

Range after 
Scaling

Specify the range of data to be shown on MONITOUCH.

Offset value 
(constant)

Multiplier of 
divisor 
(constant)

× or / (÷)

4000

100

00

PLC� MONITOUCH

(Range before Scaling) (Range after Scaling)
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*1 When [Entry Target] is selected for [Display Function]
When the box for [Alarm] is checked, the maximum and minimum values specify the range of 
numerical data that can be input.
For more information on numerical data entry, refer to “7  Entry Mode.”

*2 Word Operation
For more information, refer to page 5-9.

*3 Scaling
For more information, refer to page 5-10.
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[Char. Display] Setting Dialog

The setting dialog can be displayed for each data cell.
(For more information on the editing procedure, refer to the Operation Manual.)
This section explains the case where [Char. Display] is selected on the [Type] tab window.

Type

Main

Num. Display
Char. Display
Message Display
Text

Choose [Char. Display].

Memory Specify the address to be used for character display.

No. of Bytes Specify the number of characters to be displayed.
One character of the alphabet occupies one byte.

 Inc. Direction This is valid when multiple data in the table data are selected.
For more information, refer to page 5-35.

Character Position The character position in the cell can be selected.

Flush-left →   123
Center →      123
Flush-right →        123
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Style

Text Process
(LSB → MSB / 
MSB → LSB)

Set the recognition of MSB and LSB in one word.

[LSB → MSB]

[MSB → LSB]

Function No Function:  Data in [Memory] is displayed as is.
Entry Target:  Data can be written in the entry mode.

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”
Property

Enlarge

Point

 Windows Font
For more information, refer to the Operation Manual.

Font

Display Language For more information, refer to “Appendix 3  Display Language.”

MSB     LSB
2nd byte     1st byte

15                                     

LSB    MSB
1st byte     2nd byte

15                                     
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[Message Display] Setting Dialog

The setting dialog can be displayed for each data cell.
(For more information on the editing procedure, refer to the Operation Manual.)
This section explains the case where [Message Display] is selected on the [Type] tab window.

Type

Num. Display
Char. Display
Message Display
Text

Choose [Message Display].
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Main

Style

Memory Specify the memory address to be used for specifying the message line 
number.

 Inc. Direction This is valid when multiple data in the table data are selected.
For more information, refer to page 5-35.

Message Edit When you click [Open], the [Message Edit] window is opened.
For more information on the message editing procedure, refer to the 
Operation Manual.

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”
Property

Enlarge

Point

 Windows Font For more information, refer to the Operation Manual.
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[Text] Setting Dialog

The setting dialog can be displayed for each data cell.
(For more information on the editing procedure, refer to the Operation Manual.)
This section explains the case where [Text] is selected on the [Type] tab window.

Type

Style

Num. Display
Char. Display
Message Display
Text

Choose [Text].

TEXT Enter the text to be displayed.

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”
Property

Enlarge

Point

Character Position For more information, refer to “Appendix 4  Styles and Coordinates.”

 Windows Font
For more information, refer to the Operation Manual.

Font

Display Language For more information, refer to “Appendix 3  Display Language.”
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5.5 Notes
About Transparency

There is a limitation on the use of the [Transparent] setting.

If this limitation has been exceeded, the transparent setting does not work correctly.
If the displayed image is different from what you intend, reduce the number of display parts with which 
[Transparent] is selected.

* In addition to data display parts, there are other items that have a limitation on the 
[Transparent] setting.

• Pattern (Draw, Graphic Display, Graphic Relay)
• Switch, Lamp
For more information, refer to the appropriate section for each item.

Other Notes

• When [Shadow] is chosen for [Property], [Transparent] cannot be selected; however, it can be 
rendered in the same way as [Transparent].

• Even for transparent enabled parts, it is recommended to keep [Not Transparent] selected.
If you select [Transparent] , flickering may occur when the displayed numerical data or character 
data changes.  Also the display speed will decrease.

Model Max. Number 
of Parts

  Height × Width Size

V815iX Without video 256 1,228,800 dots in total
(= 2,457,600 bytes ... 64k/32k colors)
(= 1,228,800 bytes ... 128 colors)

With video 393,216 dots in total
(= 786,432 bytes ...... 64k/32k colors)

V812xS
V810xS/V810xT
V808xS

Without video 256 1,228,800 dots in total
(= 2,457,600 bytes ... 64k/32k colors)
(= 1,228,800 bytes ... 128 colors)

With video

V810xC
V808xC
V808xCH

 256 131,072 dots in total
(= 262,144 bytes ...... 64k/32k colors)

262,144 dots in total
(= 262,144 bytes ...... 128 colors)

V806xx 64 131,072 dots in total
(= 262,144 bytes ....64k/32k colors)
(= 131,072 bytes ....128 colors/monochrome)
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When Placing Switch or Lamp Parts While Overlaying 
One on Another:

In the Case of Num. Display, Char. Display or Message Display

Note the following points when placing parts:

• When placing a data display part on a switch or lamp part:
It is recommended to create the screen under the following 
conditions.

[Condition 1]  Switch/Lamp  Draw Mode: REP
[Condition 2]  Data Display

Part type:
The parts that do not have any graphics on the background and simply consist of foreground 
and background colors
(Example:  Parts_NumDsp_E.V7 (No.0000 to 0009), etc.)

If the above conditions are not met, the parts may not be displayed correctly.

• When placing data display parts on a switch or lamp part:
When the above conditions are met, the parts can be displayed correctly with multiple data display 
parts.

• When placing a data display part on switch or lamp parts:
Due to the part property, the parts cannot be displayed correctly.

In the Case of Table Data (with Switches)

With table data, when [Text] is selected for the cell in the first column and the first row of the table, the 
whole first row has the switch function.
Consequently, if you place a switch part on the first row, it cannot be recognized correctly because it is 
the same as a switch part overlays another switch part.  (The switch function on the table data has 
priority.)

1234 1234

Lamp OFF Lamp ON

1234 1234 1234 1234

Lamp OFF Lamp ON

1234 1234

1234 1234

The data display part is hidden 
under the lamp.

The XOR color is displayed.

Lamp OFF Lamp ON

Lamp OFF Lamp ON

Draw Mode: REP

Draw Mode: XOR

No. 1 1004 50
No. 2 1006 65
No. 3 999 45
No. 4 1005 55
No. 5 1008 41

888.9
100.7
434.0
123.2
770.8

Since [Text] is set for the cell in the first column and 
the first row, the hidden switch parts on the first row 
are not valid.

Example:
If you select [Text] the first column and place 
hidden switch parts on other columns:



5.5 Notes

5-46

Please use this page for notes.
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6 Message
6.1 Message Mode

Overview

This is the function that displays messages on the screen by specifying the line number of a message 
previously registered in the message registration area (= message editing) or by grouping these 
messages into blocks and specifying the block number(s).
The message mode has four kinds of display configuration as shown below.

[Type: Direct]
[Operation Select: Block]

[Type: Page]
[Operation Select: Block]

[Type: Direct]
[Operation Select: Message]

[Type: Page]
[Operation Select: Message]

Message mode
How do you display message(s)?

Display line by line.
How do you configure the display?

Display in blocks.
What block type?

Direct blockPage blockDisplay the registered 
message separately.

Display the registered 
message continuously.

Refer to (A) on page 6-2. Refer to (B) on page 6-2. Refer to (C) on page 6-3. Refer to (D) on page 6-3.
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How to Specify the Message Number

If you select [Operation Select: Message] in the message mode, you must specify the number of the 
message that you will display.

A [Type: Page]
Specify the line number of the top message that you will display.  Several lines of the message of 
which number you specified are continuously displayed within the area at the top of the screen.
For more information, refer to page 6-6.

B [Type: Direct]
One memory address is automatically assigned to every line in the message display area.  
Specify the message number that you will display based on the assigned memory address.
A message specified by the memory address is displayed on the screen.
For more information, refer to page 6-6.

= No. 3
= No. 4
= No. 5
= No. 6

D100 3

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8

Four lines from message No. 3 (to message 
No. 6) are displayed on the screen.

Control panel emergency stop
Operation box emergency stop
Direction change count
Count stop
Pusher error
Intermediate stopper error
Saddle raise stopped
Saddle final raise stopped
Carry roller start

Message editing

4 lines

Y size
4 lines

Set “3” for D100.

Count stop
Pusher error
Intermediate stopper error
Saddle raise stopped

D100

D101

D102

D100

D101

D102

= No. 2

= No. 8

= No. 4

D101 8
2

4

D100

D102

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8

Memory addresses, each of which specifies a message 
number, are assigned consecutively for 3 lines.

Control panel emergency stop
Operation box emergency stop
Direction change count
Count stop
Pusher error
Intermediate stopper error
Saddle raise stopped
Saddle final raise stopped
Carry roller start

Message editing

Size
3 lines

Memory for the 1st line
Memory for the 2nd line
Memory for the 3rd line

Direction change count

Direction change count

Carry roller start

Pusher error
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How to Specify the Block Number

If you select [Operation Select: Block] in the message mode, specify the registered [Page Block] or 
[Direct Block] number of the message that you will display.

C [Type: Page]
Register the message that was previously registered in the message editing area as [Page 
Block].
The corresponding “page block” is displayed on the screen.
To display a page block on the screen, there are two ways: with an internal command 
(changeover with a switch) or with an external command (changeover with respect to data in a 
memory address).  For more information, refer to page 6-6.

D [Type: Direct]
Register the message that was previously registered in the message editing area as [Direct 
Block].
The corresponding “direct blocks” are displayed on the screen.
To display a direct block on the screen, there are two ways: with an internal command 
(changeover with a switch) or with an external command (changeover with respect to data in a 
memory address).  For more information, refer to page 6-6.

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8
No. 9
No.10
No.11

D100 0

Control panel side emergency stop

The EMERGENCY STOP button on the 
control panel is pressed.
Reset the button.

Operation box side emergency stop

The EMERGENCY STOP button on the 
operation box is pressed.
Reset the button.

   Control panel side emergency stop

The EMERGENCY STOP button on 
the control panel is pressed.
Reset the button.

The EMERGENCY STOP button on 
the operation box is pressed.
Reset the button.

Message group No. 3
Page block No. 0

Set “0” for D100. Page block No. 0

 Control panel side emergency stop

The EMERGENCY STOP button on 
the control panel is pressed.
Reset the button.

D100 0

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8
No. 9

No.21
No.22

No. 1
No. 9
No. 6
No.22
No. 5

MONITOUCH
General Specifications

Item
Contents

Hardware Specifications
Input voltage    85 to 235 AC

Display color    16 colors
Display area    640 x 480 dots

FUNC switch    8 points
Switch    H24 x W40

Printer port    1 port
Baud rate   RS232C/RS422

General Specifications
Switch    H24 x W40

Display color    16 colors
Baud rate   RS232C/RS422
Input voltage    85 to 235 AC

Message group No. 2

Direct block No. 0
Direct block No. 1

Direct block No. 2

Set “0” for D100. Direct block No. 0

General Specifications
Switch    H24 x W40

Display color    16 colors
Baud rate   RS232C/RS422
Input voltage    85 to 235 AC
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Configuration

The message mode components are shown below.

Message icon
= [Message] dialog

− Block
Roll Down
Block Call
Roll Up
+ Block
    switch, etc.

Display area
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Setting Dialog

Message
Main

Type *1
(Page, Direct) Choose the display format and the operation type.

Depending on the combination of selections for [Type] and [Operation 
Select], the display format varies.Operation Select *1

(Message, Block)

Internal Command
External Command

This option becomes active when [Operation Select: Block] is selected.
Select how to call up blocks.

Internal Command:
The page block or direct block display can be changed with the [Function: 
+ Block/− Block/Block Call] switch placed on the screen.

External Command:
Directly specify the page block or direct block number using [Memory], 
and display the corresponding block. 

Memory *2 When [Operation Select: Message] is selected or when [Operation Select: 
Block] and [External Command] are selected, a memory address must be 
specified.
This is the command memory for displaying messages by specifying a 
message number or block number.

Message G No. *3 This option becomes active when [Operation Select: Message] is selected.

Checked ( ):
Set a group number (0 - 127) for [Group No.].
The message displayed on the screen is limited to a message within the 
specified group number.  Specify a message number (0 - 255) within the 
group in the command memory specified for [Memory].

Unchecked ( ):
Specify the message number to be displayed as an absolute address.
Messages from more than one group can be specified.
Specify a message number (0 - 32767) among the whole of messages for 
[Memory].
For more information on message registration, refer to page 6-12.
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*1 Depending on the combination of selections for [Type] and [Operation Select], the display motion 
varies as described below.

Initial Block This option becomes active when [Operation Select: Block] and [Internal 
Command] are selected.
This is the block to be displayed at first when page or direct blocks are 
called up on the screen.
For more information on the page block and the direct block, refer to page 
6-14 and page 6-13.

Max. Block This option becomes active when [Operation Select: Block] and [Internal 
Command] are selected.
This is the greatest number of page or direct blocks to be used in the 
message mode.
For more information on the page block and the direct block, refer to page 
6-14 and page 6-13.

Min. Block This option becomes active when [Operation Select: Block] and [Internal 
Command] are selected.
This is the smallest number of page or direct blocks to be used in the 
message mode.
For more information on the page block and the direct block, refer to page 
6-13 and page 6-14.

Action Area Choose from [Display Area], [Switch] or [Lamp] for specifying the place 
where the message should be displayed on the screen.

Display Area:
Shows messages on display area parts placed on the screen.

Switch:
Shows messages on switch parts placed on the screen.
Place the [Function: Mode] switches.  Each switch has [Display Order] as 
an auxiliary item where you can specify which message to display on 
which switch.  When you do not set [Display Order], the messages are 
displayed in the same order that the switches were placed.

Lamp:
Shows messages on lamp parts placed on the screen.
Place the [Function: Mode] lamps.  As with switches, each lamp is set 
with the auxiliary item [Display Order].

Operation
 Select

Type
Message Block

Page

Use [Memory] (discussed later) to 
specify the line number of the top 
message that you will display.
Several lines of the message, of which 
number you specified, are continuously 
displayed within the area at the top of 
the screen.

Page blocks are displayed on the 
screen.  Either an internal or external 
command can be used.
(Refer to page 6-5.)

Direct

One memory address is automatically 
assigned to every line in the message 
display area.  Specify the message 
number that you will display based on 
the assigned memory address.
A message specified by the memory 
address is displayed on the screen.

Direct blocks are displayed on the 
screen.  Either an internal or external 
command can be used.
(Refer to page 6-5.)



6.1 Message Mode

6-7

6

*2 The contents in memory are shown below.

Depending on the combination of selections for [Type] and [Operation Select], the number of 
words to be used from the address specified for [Memory] varies as described below.

*3 For more information on the “absolute address” for message editing, refer to the Operation Manual.

Style

*1 When [Switch] or [Lamp] is chosen for [Action Area] on the [Main] tab window, [Enlarge X] and 
[Enlarge Y] are fixed to “1”.

Detail

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”
Property

Enlarge *1

Point

 Windows Font For more information, refer to the Operation Manual.

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

Memory n

Message No. 0 to 32767
or Block No. 0 to 1023

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

MSB LSB

Operation
 Select

Type
Message Block (external command)

Page 1 word 1 word

Direct

The words are based on the display 
area’s Y size divided by the character 
enlargement factor value.
Memory space is sequentially allocated 
from the top memory address specified 
for [Memory].

1 word



6.1 Message Mode

6-8

Display Area

These settings are valid when you select [Operation Select: Block] in the [Message] dialog.

Style

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Color Select the color in the display area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified in the [Message] dialog.
For more information on the ID, refer to the Operation Manual.
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Checking the display area size
You can check on the screen that error messages can be displayed on the display areas intended.

When you have registered messages, select [View] → [Display Environment] → [Display] tab, check 
( ) the box for [  Display Message].

The registered messages are displayed on the screen.

For more information on size adjustment, etc., refer to the Operation Manual.
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Switch / Lamp (for Display Area)

These settings are valid when you select [Operation Select: Switch or Lamp] in the [Message] dialog.
Messages are displayed on switches or lamps.
This section describes the switch and lamp settings that are essential.

Main

Detail

Function Select [Mode].

Display Order (0 - 23):
Specify the order of displaying the message when multiple [Mode] switches 
or lamps are placed.
If you set the same number for [Display Order] for all switch or lamp parts, 
the messages are displayed in the same order that the switches or lamps 
were placed.

* One switch or lamp shows one line of message.

ID Set the same ID as specified in the [Message] dialog.
For more information on the ID, refer to the Operation Manual.
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Switch / Lamp (for Message Scroll)

To scroll up and down in the message mode, the following switches can be used.
This section describes key setting items for switches that are used together with the message mode.

Main
These switches are valid when you select [Operation Select: Block] and [Internal Command] in 
the [Message] dialog.
Use this setting when the messages of a page block or direct blocks displayed on the screen 
extend off the area.

Detail

Function Contents

+ Block Moves to the next message block.

− Block Moves back to the previous message block.

Block Call Jumps to the specified block number.

Roll Up Scrolls up the messages.

Roll Down Scrolls down the messages.

ID Set the same ID as specified in the [Message] dialog.
For more information on the ID, refer to the Operation Manual.
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Registering Messages

There are two ways of registering messages.

• [Message] dialog → [Main] tab window → [Open]

* When [Operation Select: Block] is selected, the window for message registration will not be 
displayed in this way.

* When you specify a message group number, the cursor appears at the top of the group.

• [Registration Item] → [Message] → (group number designation)

In the [Message Edit] window, line numbers denote absolute addresses as default.
If [  Message G No.] is checked, select [Display] → [Display Absolute Address as Line Number] 
and remove the check from this menu item before commencing editing.

For more information on the editing procedure in the [Message Edit] window, refer to the Operation 
Manual.
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Registering Page Blocks

There are two ways of registering page blocks.

• [Message] dialog → [Main] tab window → [Open]
The specified block number is displayed.

* When [Type: Page], [Operation Select: Block] and [Internal Command] are selected, the window 
for page block registration can be displayed in this way.

• [Registration Item] → [Page Block] → (block number designation)

For more information on the editing procedure in the [Page Block Edit] window, refer to the Operation 
Manual.
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Registering Direct Blocks

There are two ways of registering direct blocks.

• [Message] dialog → [Main] tab window → [Open]
The specified block number is displayed.

* When [Type: Direct], [Operation Select: Block] and [Internal Command] are selected, the window 
for direct block registration can be displayed in this way.

• [Registration Item] → [Direct Block] → (block number designation)

For more information on the editing procedure in the [Direct Block Edit] window, refer to the Operation 
Manual.
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6.2 Comment Display
Overview

Register comments in advance, and show the comment by setting the comment number (word 
designation) to the memory address or by setting (ON) the bit (bit designation).
A maximum of 32,767 comments can be registered.  The character property, such as color or size, can 
be set for each comment.
One comment can include multiple lines.

Word Designation

No.1

No.2

No.3

No.4

=No.3

D100 3D100 0

Error 1

Error 2

Error 3

Remedy:
Perform XX.
Error 4

Comment editing

When D100 = 0 Set “3” for D100.

No comment is displayed. Comment No. 3 is displayed.

Error 3
Remedy:
Perform XX.
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Bit Designation

When multiple bits are set (ON), the least significant bit has priority.

=No.2

D100D100

No.1

No.2

No.3

No.4

D100-00=

D100-01=

D100-02=

D100-03=

Error 2

When D100 = 0 Set bit 1 of D100.

No comment is displayed. Comment No. 2 is displayed.

Error 1

Error 2

Error 3

Remedy:
Perform XX.
Error 4

Comment editing

=No.1

D100

No.1

No.2

No.3

No.4

D100-00=

D100-01=

D100-02=

D100-03=

Comment editing

When bit 3 of D100 is set (ON):

Comment No. 1 is displayed since 
the least significant bit has priority.

Error 1

Error 1

Error 2

Error 3

Remedy:
Perform XX.
Error 4
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Configuration

The comment display components are shown below.

Setting Dialog

Comment Display
Main

Word Designation
Bit Designation

Choose the memory designating method.

Word Designation:
Select this option to call up the comment by specifying the comment 
number.

Bit Designation:
Select this option to call up the comment by bit activation.

Command Memory Specify the command memory to be used for displaying messages on the 
screen.
The setting should vary depending on whether you select [Word 
Designation] or [Bit Designation].

Word designation:
Set the memory address (1 word) for specifying the comment number.
When “0” is specified, no comment is displayed.
When “1 - 32767” is specified, the corresponding comment is displayed.
However, if the BCD code is used on the PLC, the available range is 
limited to “1 - 9999”.

Bit designation:
Set the memory address (1 bit) to call up the comment set for [Start No.].
When multiple bits are set (ON), the least significant bit has priority.

Comment display icon
= [Comment Display] dialog

Display area
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Detail

Start No.
(1 to 32767)

This is valid when you select [Bit Designation].
Specify the comment number to be called up by activation of the bit set for 
[Memory].

[Open] When you click [Open], the [Comment] editing window is opened.
For more information, refer to page 6-20.

No. of Bits
(1 to 512)

This is valid when you select [Bit Designation].
Specify the number of bits to be used for comment display (= total number 
of comments to be displayed).  From the bit set for [Memory], as many bits 
as set for [No. of Bits] are consecutively allocated to the comment specified 
for [Start No.] and later.

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Display Area
Style

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Checking the display area size
You can check on the screen that error messages can be displayed on the display areas as you 
intended.
The procedure is the same as described for the message mode.  Refer to page 6-9.

Color Select the color in the display area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified in the [Comment Display] dialog.
For more information on the ID, refer to the Operation Manual.
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Registering Comments

There are two ways of registering comments.
• [Comment Display] dialog → [Main] tab window → [Open]

* When [Word Designation] is selected, the window for comment registration will not be displayed 
in this way.

* The cursor appears at the line number specified for [Start No.].

• [Registration Item] → [Comment] → (group number designation)

For more information on the editing procedure in the [Comment Edit] window, refer to the Operation 
Manual.
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7 Entry Mode
Overview

• When writing numerical data or characters (ANK, Shift JIS code, etc.) to the specified memory 
addresses, you must set the entry mode.

• Entry mode allows you to enter numerical data and characters on the same screen.
Depending on whether the target data display is a numerical data display part or a character 
display part, the system automatically recognizes data entry as numeric values or text data.

• The keypad can be hidden in normal times and be popped up only when it is necessary.  (Refer to 
page 7-27.)

9999

0
1250

300

7.23

11.02

TEST 0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250

Entry Screen

Value 1

Value 2

Value 3

Value 4

Text 1

Max.
Min.
Key-in

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP

Numerical Data Entry Numerical Data Entry
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• Alternatively, target data display parts can be switched over with the keypad displayed.  (Refer to 
page 7-41.)

• You can create a password entry screen easily using a character display part.  (Refer to page 
7-29.)

• You can move the cursor only to the data display parts that require data entry.  (Refer to page 
7-36.)

• An entry screen that looks like a digital switch can be created.  (Refer to page 7-40.)

9999

01250

300

7.23

11.02

TEST

0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250

DWUP

1000

0

0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

0

DWUP

0

0

0

5000

5010

1250

300

7.23

11.02

TEST

0

0

0

5000

5010

100

200

Entry Screen

Value 1
Value 2
Value 3
Value 4
Text 1

Max.
Min.
Key-in

Entry Screen

Line A
Line B
Line C
Line D
Line E

Max.
Min.
Key-in

Setting value
Target value

Value 1
Value 2
Value 3
Value 4
Text 1

Line A
Line B
Line C
Line D
Line E

Change Data

Data block No. 0 Data block No. 1 Data block No. 9

987

654

CLR321

ENT+/-.0

987

654

CLR321

ENT+/-.0

ABCD Example: Char. Display
Memory: D300
Function: Password Input (Fixed)
No. 0: 1999
No. 1: 1231
No. 2: (None)
No. 3: (None)

Key-in “1999”.

Key-in “1231”.

D300 = 0

D300 = 1

Key-in “2000”. D300 = −1
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Configuration

The entry mode components are shown below.

Maximum/minimum value display part

Keypad

Entry icon
= [Entry] dialog

Entry display part

Entry target

Value 1

Value 2

Value 3

Value 4

Max.

Min.

Key-in
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[Entry] Dialog

Main

Type
(Data Display, Data 
Block)

Select the format to be used in the entry mode.

Data Display:
Enter data on the data display part (Function: Entry Target) placed on the 
base screen or an overlap window though the keypad.

Data Block:
Enter data on the data display part (Function: Entry Target) placed on a 
data block (refer to page 7-41) though the keypad.

Input Item Select
(Internal, External)

Choose the method for selecting a data field for entry target.

Internal:
The [Function: UP/DW] switches are used for controlling the cursor and 
selecting an entry target.

External:
Specify the order number ([Order INC]) for [Command Memory] for entry 
target selection.

Command Memory This is used for controlling entry mode.
The memory contents depend on the selection of [Internal] or [External] for 
[Input Item Select].
For more information, refer to page 7-6.

 Use Writing 
Enabled Bit

When this box is checked, writing is disabled unless the bit specified for 
[Command Memory] is set.
For more information, refer to page 7-6.

Info Output Memory The status of entry mode is written into the specified memory address.
The memory contents depend on whether the [  Line/Column Output] 
box in the [Detail] tab window is checked or not.
For more information, refer to page 7-8.

 Reverse When this box is checked, the data field currently selected by the cursor as 
an entry target is reversed (highlighted).
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7

 Default 0 This is valid when a data display part (Function: Entry Display Part) is 
placed.
When this box is checked, data on the entry display part is reset to “0” if it 
is a numeric value or is reset to a space if it is text each time the [Write] key 
is pressed.

 Auto Writing by 
Entry Target 
Selection Switch

When the cursor moves to another data display part (Function: Entry 
Target), the entered value is written into memory.

Target Memory
(Direct, Output 
Memory)

Select the target memory where data should be written when the [Write] 
key is pressed.

Direct:
Data is written to the memory address specified for [Memory] for the data 
display part (Function: Entry Target).

Output Memory:
Numerical data entry: → [Info Output Memory] n + 2, n + 3
Character data entry: → [Info Output Memory] n + 2 and allocating as 

many words as “the number of bytes ÷ 2”
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Command memory (Input Item Select: Internal)

1. Entry area designation This is valid when input area selection is enabled [1].
Specify the area the cursor can move.  The contents are shown below:

2. Entry area selection Select the area where the cursor can move between the data fields to select an entry 
target.

0: Disabled
The cursor moves in the areas in the following order:
1) Base screen
2) Overlap ID 0
3) Overlap ID 1
4) Overlap ID 2
5) Overlap ID 3

1: Enabled
The cursor moves in the specified area only.
For the procedure of area designation, refer to “1.  Entry area designation.”

3. Cursor movement This bit determines whether or not to move the cursor automatically to the next 
display part for entry when the [Write] key is pressed.

0: Manual
The cursor remains in the same position when the [Write] key is pressed.  It is 
necessary to move the cursor manually.

1: Auto
The cursor moves to the next display part for entry when the [Write] key is 
pressed.

4. Write enabled/disabled This is valid when [  Use Writing Enabled Bit] is checked on the [Entry] dialog.
This bit determines whether the data entry keys are disabled or enabled.
When [  Use Writing Enabled Bit] is not checked, the entry keys are always 
enabled.

0: Write disabled
The entry keys are all disabled.  If an entry key is pressed, an error beep sounds 
and no entry is possible.
However, only the scroll switches that control the cursor can be accepted.

1: Write enabled
The entry keys are acceptable.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0

1. Entry area designation2. Entry area selection
0: Disabled
1: Enabled

3. Cursor movement
0: Manual
1: Auto

4. Write enabled/disabled *1
0: Write disabled
1: Write enabled *1  This is valid when [  Use Writing Enabled Bit] is checked.

LSBMSB

Bit No. Type

02 01 00 Data Display Data Block

0 0 0 Base Data block area No. 0

0 0 1 Overlap ID 0 Data block area No. 1

0 1 0 Overlap ID 1 Data block area No. 2

0 1 1 Overlap ID 2 Data block area No. 3

1 0 0 Global overlap ID 3 -
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Command memory (Input Item Select: External)

1. Order INC designation Specify the order number (Order INC) of the data display or table data display part to 
be used as an entry target.
(Bit 0 to bit 7 are used when [DEC] is selected; bit 0 to bit 9 are used when [BCD] is 
selected.)

2. Entry area designation Specify the area the cursor can move.  The contents are shown below:

3. Entry target data 
selection

Select the data display part type to be used as an entry target.

0: Data display part
1: Table data display part

For table data display parts, [Command Memory] (n + 1) is also used.

4: Write enabled/disabled This is valid when [  Use Writing Enabled Bit] is checked on the [Entry] dialog.
This bit determines whether the entry keys are disabled or enabled.
When [  Use Writing Enabled Bit] is not checked, the entry keys are always 
enabled.

0: Write disabled
The entry keys are all disabled.  If an entry key is pressed, an error beep sounds 
and no entry is possible.
However, only the scroll switches that control the cursor can be accepted.

1: Write enabled
The entry keys are acceptable.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0

1. Order INC designation (0 to 255)

2. Entry area designation

3. Entry target data selection
0: Data display part
1: Table data display part

4. Write enabled/disabled *1
0: Write disabled
1: Write enabled *1  This is valid when [  Use Writing Enabled Bit] is checked.

LSBMSB

Bit No. Type

13 11 10 Data Display Data Block

0 0 0 Base Data block area No. 0

0 0 1 Overlap ID 0 Data block area No. 1

0 1 0 Overlap ID 1 Data block area No. 2

0 1 1 Overlap ID 2 Data block area No. 3

1 0 0 Global overlap ID 3 -

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0

Line selection (1 to 20)Column selection (1 to 25)

[Command Memory] n + 1

LSBMSB
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Info output memory ([  Line/Column Output] is not checked)

1. Order INC The order INC of the currently selected entry target is stored.
(Bit 0 to bit 7 are used when [DEC] is selected; bit 0 to bit 9 are used when [BCD] is 
selected.)

2. Entry area The currently selected entry area number is written.  The contents are shown below:

3. Entry motion This bit is valid when multiple entry mode parts are placed on the screen.
An entry mode part can be placed on the base screen or an overlap window, 
respectively.
If multiple entry mode parts are displayed at the same time, the one shown at the 
forefront becomes active.  This bit is set to “1” when the entry mode part is at the 
forefront.
(If there is only one entry mode part displayed, the bit is always “1”.)

4: Write status This bit shows whether the [Write] key has been pressed or not.

0: Not written
Indicates that the [Write] key has not been pressed.

1: Write completed
Indicates that the [Write] key has been pressed and that data is written to memory.
Unless the cursor moves to another entry target, this bit remains “1”.  It is 
recommended to clear this bit to “0” when confirmation has been finished.

5. Block number These bits are valid when you select [Type: Data Block] on the [Main] tab window of 
the [Entry] dialog.
The currently displayed data block number is stored.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0

1. Order INC (0 to 255)

3. Entry motion
0: Disabled
1: Enabled

4. Write status
0: Not written
1: Write completed

2. Entry area

[Info Output Memory] n

n+1
15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0

5. Block No. (0 to 1023)

n+2
15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

n+m
15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

6. Entered data

LSBMSB

Bit No. Type

13 11 10 Data Display Data Block

0 0 0 Base Data block area No. 0

0 0 1 Overlap ID 0 Data block area No. 1

0 1 0 Overlap ID 1 Data block area No. 2

0 1 1 Overlap ID 2 Data block area No. 3

1 0 0 Global overlap ID 3 -
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Info output memory ([  Line/Column Output] is checked)

6. Entered data These bits are valid when you select [Target Memory: Output Memory] on the [Main] 
tab window of the [Entry] dialog.
The entered value is stored.

Numeric value:  2 words maximum
Text:  “The number of bytes ÷ 2” words (if the number of bytes is odd, 1 is added.) 

1. to 6. Refer to page 7-8.

7. Line number
8. Column number

The line and column numbers of the selected table data cell are stored.

9. Entry target data 
selection

The kind of the entry target data currently selected is stored.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

1. Order INC (0 to 255)

3. Entry motion
0: Disabled
1: Enabled

4. Write status
0: Not written
1: Write completed

2. Entry area

[Info Output Memory] n

n+1

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0

5. Block No. (0 to 1023)

n+2

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00n+3

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

6. Entered data

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0

7. Line number (1 to 20)8. Column number (1 to 25)

n+m

9. Entry target data selection
0: Data display part
1: Table data display part

LSBMSB
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Auto writing by entry target selection switch
When the box for [  Auto Writing by Entry Target Selection Switch] is checked on the [Main] tab 
window of the [Entry] dialog, entered data is written into memory not when [Write] key is pressed but 
when the cursor is moved to the next data display part using a cursor movement switch.

• Cursor movement switches

• Note
When an entry mode part is placed on an overlap window, it is not possible to hide the overlap 
window after entered data has been written automatically into memory by moving the cursor, 
differently from the [Write] key.

Function

Entry DW

UP

>>

<<

Table Data Cursor Movement to Right

Cursor Movement to Left

Table Move +

Table Move −

5 0 0
1 5 0 0
2 2 2 2

7 9 UP8

4 6 DW5

1 3 +-2

0 CLR CR.

D100

D101

D102

9 9
1 5 0 0
2 2 2 2

7 9 UP8

4 6 DW5

1 3 +-2

0 CLR CR.

D100

D101

D102

99 99

D100   99
1500
2222

D100   500
1500
2222
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Detail

 Graphic Text on the entry key can be switched over as required.

Unchecked:
The text set on the switch part is regarded as to be entered text.

Checked:
The text placed on the graphic library is regarded as entry text.
To switch over multiple graphic libraries, use the [Function: Graphic 
Library] switch.
For more information, refer to page 7-30.

 Line/Column 
Output

This is valid when you use [Table Data Display] for entry target.
When this box is checked, the line and column numbers are stored in [Info 
Output Memory] (n + 1).

Process Cycle For more information, refer to “Appendix 5  Process Cycle.”

 Display All Formats When this box is checked, the number of options for [Type] on the [Main] 
tab window increases.

Memory Card:
Used for a keypad that allows name editing in the memory card mode.  
For more information, refer to “15.2  Memory Card Mode.”

Recipe Item:
Used for a keypad that allows name editing in the recipe mode.  For more 
information, refer to “13  Recipe Mode.”

Direct:
Used for controlling the whole processing up to data write operation using 
external commands.
For more information, refer to page 7-42.

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

 GD80 Compatible This is valid when [  Display All Formats] is checked.
This is used for keeping compatibility with GD-80.
(For more information, refer to the File Conversion Manual provided 
separately.)
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Keypad

Type
Numeric data entry keys

Character entry keys

• When using graphic libraries:
If there are too many characters to be displayed, it is possible to switch over the character set 
displayed on the entry keys.

Notes on Placement

Set the same ID as set the [Entry] dialog for the switch for a keypad or other entry keys.
The ID of the entry mode can be known from the number shown at the bottom left of the [Entry] icon or 
on the [Detail] tab window of the [Entry] dialog.

* To check the ID of each key, select [View] → [Display Environment] and check the box for [  
Display ID Number]. 
For more information on the ID, refer to the Operation Manual.

or
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List of Functions

The following switches can be used in the entry mode.
* These switches do not work independently.  Be sure to link them with entry mode (set the 

same ID as entry mode).

Function Action Remarks See:

Character Input Numeric or character codes are entered. −

Write Entered data is written to the specified memory address.
Screen change is possible after the execution of data 
writing.

−

Clear Entered data is cleared. −

Toggle Sign Entered sign is inverted. Target: Num. Display −

Space One-byte space is entered. Target: Char. Display −

Backspace The character before the cursor is deleted. *1 page 7-16

DELETE The character of the current cursor position is deleted. *1 *2 page 7-16

+1 The number at the current cursor position is increased by 
one.

Target: Num. Display −

−1 The number at the current cursor position is decreased by 
one (−1).

Target: Num. Display −

Add A specified constant is added.
(Data is written when the [Write] key is pressed.)

Target: Num. Display

page 7-40
Subtraction A specified constant is subtracted.

(Data is written when the [Write] key is pressed.)
Target: Num. Display

Cancel Data entry is reset to the default during entry operation. page 7-14

LFT The cursor is moved to the left. *2 page 7-16

RGT The cursor is moved to the right. *2 page 7-16

UP The entry target is moved to the data display part of which 
order INC is decreased by one (−1).

−

DW The entry target is moved to the data display part of which 
order INC is increased by one (+1).

−

>> The area currently selected for entry target is moved to an 
area of which number is increased by one (+1).

−

<< The area currently selected for entry target is moved to an 
area of which number is decreased by one (−1).

−

Conversion of 
Kanji

Kanji mode is selected.
*JIS level-1 Kanji set only

Target: Char. Display −

Graphic Library The specified graphic is displayed. page 7-31

+ Block The block/graphic number is increased by one (+1). Target: Data Block
page 7-41

− Block The block/graphic number is decreased by one (−1). Target: Data Block

Cursor Movement 
to Right

The cursor is moved to the right in a table data display 
part.

Target: Table Data 
Display

page 7-21
Cursor Movement 
to Left

The cursor is moved to the left in a table data display part. Target: Table Data 
Display

Table Move + When there are multiple table data display parts, the 
cursor is moved to the table of which number is increased 
by one (+1).

Target: Table Data 
Display

page 7-22
Table Move − When there are multiple table data display parts, the 

cursor is moved to the table of which number is decreased 
by one (−1).

Target: Table Data 
Display

80 Compatible 
HEX Key

HEX keys compatible with the GD-80 series For compatibility with 
GD-80

−

80 Compatible 
HEX Key Change

HEX keys compatible with the GD-80 series For compatibility with 
GD-80

−
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*1 Decimal point and signs are not erasable from numerical data displays.
*2 For numerical displays, the option [  Allow to use Insert/DELETE keys when entering values] requires to be 

checked in the [General Settings] tab window opened in the [Unit Setting] dialog ([System Setting] → [Unit 
Setting]).
The above setting is reflected throughout the entry mode for all screens.

[Function: Cancel] switch
When the [Cancel] key is pressed during data entry, the entry motion is canceled and the field is reset 
to the previous data.

Max. Value Entry When this switch is pressed for an entry target with the 
alarm setting, the maximum setting value is displayed.

Target: Num. Display

page 7-15
Min. Value Entry When this switch is pressed for the entry target with the 

alarm setting, the minimum setting value is displayed.
Target: Num. Display

Multi-char. Input Characters in each pattern are changed over by the 
switch for [Char. Switching (+), Char. Switching (−)].

Switching (Entry 
Mode Change)

Switching 
(1-byte/2-byte 
Char. Change)

Switching (Caps 
Lock)

Direct Input

Word Edit Target: Char. Display

Word Registration Target: Char. Display

Char. Switching 
(+)

The pattern and text of the [Multi-char. Input] switch are 
switched from OFF → P15.

Char. Switching 
(−)

The pattern and text of the [Multi-char. Input] switch are 
switched from P15 → OFF.

Function Action Remarks See:

5 0 0
1 5 0 0
2 2 2 2

7 9 UP8

4 6 DW5

1 3 +-2

0 CLR CR.

D100

D101

D102

5 0 0
1 5 0 0
2 2 2 2

7 9 UP8

4 6 DW5

1 3 +-2

0 CLR CR.

D100

D101

D102

Cancel

99 500

Cancel

D100   500
1500
2222

D100   500
1500
2222
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[Function: Max./Min. Value Entry] switch
When the maximum and minimum values (alarm setting) are set for an entry target, pressing the [Max. 
Value Entry] switch and [Min. Value Entry] switch brings up the maximum and minimum values, 
respectively.  When the [Write] key is pressed, entered data is written into memory.

* For more information on the entry target, refer to page 7-19.

[Function: Char. Switching (+) / Char. Switching (−)] switch
Pressing the [Char. Switching (+), Char. Switching (−)] switch changes over the text on the [Multi-char. 
Input] switch.  With the [Multi-char. Input] switch, not only the text but also the pattern will be changed 
over.  The maximum numbered pattern of the [Multi-char. Input] switch is used to show that the switch 
is highlighted when it is pressed.

• The [Char. Switching (+) / Char. Switching (−)] switch is disabled when the Japanese conversion 
function is set.

• Text switching using graphic library is not possible even if [  Graphic] in the [Detail] tab window in 
the entry mode.

5 0 0
1 5 0 0
2 2 2 2

7 9 UP8

4 6 DW5

1 3 +-2

0 CLR CR.

D100

D101

D102

9 9 9 9
1 5 0 0
2 2 2 2

7 9 UP8

4 6 DW5

1 3 +-2

0 CLR CR.

D100

D101

D102

9999

9999

7 9 UP8

4 6 DW5

1 3 +-2

0 CLR CR.

0

D100   9999
1500
2222

D100   500
1500
2222

Max.

Min.

Cancel

Max.

Min.
Cancel

Max.

Min.

Cancel

Alarm
   Max. 9999
   Min. 0000

OFF OFF

Char. Switching (+) Char. Switching (−)Char. Switching (+)

Example:  [Multi-char. Input] switch with 3 notches = “2” patterns can be registered

“P3” is used as a highlighted 
image, and cannot be switched 
using the [Char. Switching] switch.

Peep, peep

(There is no pattern available any more.)
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[Function: LFT/RGT/DELETE/Backspace] 
On the numerical data entry screen, the [LFT] and [RGT] keys are usable to move the cursor for 
numeral insertion, and the [DELETE] and [Backspace] keys are usable for numeral deletion.

* The option [  Allow to use Insert/DELETE keys when entering values] requires being checked in 
the [General Settings] tab window opened in the [Unit Setting] dialog ([System Setting] → [Unit 
Setting] ).  Otherwise, the [LFT], [RGT], and [DELETE] keys are disabled.

<Display during data entry>
Numerals being typed are displayed in a flush-right format with zero suppress, regardless of which 
settings (flush right and zero suppress) are currently made for the numerical data display.  After the 
numerals being typed are entered, they are displayed in the set format.

• Insertion of numerals
• The whole number part

A numeral insertion is made to the right of the cursor.
When numerals exist at all places, entering a new numeral deletes the leftmost numeral.
Additionally, entering a numeral at the leftmost place of the whole number part overwrites the 
current numeral.

13

97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

13

00013

123

123

00123

13

Flush right, with zero suppress

Flush left, with zero suppress

Without zero suppress Flush right,
with zero suppress

Before entry Being typed Entered

1245 2345
97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

2234 1234
97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

Example: Insertion of “3” between “2” and “4” to show “2345”

Cursor 
movement to “2”

Press the “3” key.
“3” is placed at the right 
of the cursor to switch 
the display to “2345”.

Cursor movement 
to the leftmost 
numeral “2” 

Press the “1” key.
“2” is overwritten with 
“1” to switch the 
display to “1234”.

Example: Overwriting the leftmost numeral “2” to show “1234”
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• The fractional part
A numeral insertion is made to the left of the cursor.  When numerals exist at all places, 
entering a new numeral deletes the rightmost numeral of the fractional part.  Additionally, 
entering a numeral at the rightmost place of the fractional part overwrites the current numeral.

• Deletion of numerals
The [DELETE] key deletes the numeral at the cursor.

1.560 1.526
97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

Example: Insertion of “2” between “5” and “6” to show “1.526”

Cursor movement to “6”

Press the “2” key.
The rightmost numeral 
“0” of the fractional 
part is deleted and “2” 
is placed at the left of 
the cursor.
The display shows 
“1.526”.

1.567 1.560
97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

Example: Overwriting the rightmost numeral “7” to show “1.560”

Cursor movement to the 
rightmost numeral “7” 

Press the “0” key.
“7” is overwritten with 
“0” to switch the 
display to “1.560”.

1.234 0.234
97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

Example: Deletion of “1” from the whole number part of “1.234”

Press the [DELETE] 
key.
“1” is deleted and 
replaced with “0”.
The display shows 
“0.234”.

• The whole number part

Cursor 
movement to “1”

1.234 1.340
97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

Example: Deletion of the tenth place of “1.234”
• The fractional part

Cursor 
movement to “2”

Press the [DELETE] 
key.
“2” is deleted and “0” is 
put at the rightmost 
place of the fractional 
part.
The display shows 
“1.340”.
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The backspace key deletes the numeral to the left of the cursor.

1526 126
97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

Example: Deletion of “5” from “1526”

Cursor 
movement to “2”

Press the 
[BackSpace] key.
“5” is deleted.
The display shows 
“126”.

• The whole number part

1.526 1.560
97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

97 8

64 5

3

+/-

1 2

ENTER0 .

CLEAR

DELETE

BackSpace+
-

Example: Deletion of “2” from “1.526”

Cursor 
movement to “6”

Press the 
[BackSpace] key.
“2” is deleted and “0” 
is put at the rightmost 
place of the fractional 
part.
The display shows 
“1.560”.

• The fractional part
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7

Entry Target

This section describes the settings essential for entry mode.

Num./Char. Display
Main

Operation/Alarm

Memory Specify the memory address to which data is written by pressing the [Write] 
key.

Function Select [Entry Target].

Order INC (0 to 255) Set the number of order of moving the cursor using scroll switches, etc.

 With Entry Key Check this box when registering numeral or character entry keys.

 Alarm Set the data range that can be written by pressing the [Write] key.
When the maximum and minimum values are set, only the values within 
this range are acceptable.

* However, if the value is changed by an external command, this 
alarm setting is ignored.
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Table Data Display
Detail

Main (cell → [Detail Setting] → [Type: Num. Display]/[Type: Char. Display])

Order INC (0 to 255) When multiple table data display parts (Function: Entry Target) are present, 
determine the order of decreasing precedence.

Cursor Direction (RGT, 
DW)

This is valid when [Internal] is selected for [Input Item Select] for entry 
mode and bit 14 (cursor movement) of [Command Memory] is set.
This option determines the direction in which the cursor moves when the 
[Write] key is pressed.

Memory Specify the memory address to which data is written by pressing the [Write] 
key.

Function Select [Entry Target].
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7

Operation/Alarm

Notes on table data display part
• If multiple entry targets are present in a table data display part, move the cursor using the [DW] 

[UP] switches or [Cursor Movement to Right] [Cursor Movement to Left] switches. 

 Alarm Set the data range that can be written by pressing the [Write] key.
When the maximum and minimum values are set, only the values within 
this range are acceptable.

* However, if the value is changed by an external command, this 
alarm setting is ignored.
If data exceeding the specified range is transferred using an 
external command, it is shown in the color specified for [Color].

7 8 9 -
4 5 6 +
1 2 3 CLR

0 ENT

No.

1

2

3

4

5

162

644

151

758

60

150

600

100

600

20

170

170

800

140

900

50

Entry Screen

Current 
value

Target 
value

Limit 
value UP

DW

Key-in LFT RGT
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• When multiple table data display parts with entry target are present, move the cursor between the 
table data display parts using the [Table Move +] [Table Move −] switches.

• Special function for table data display part
When graphics text is set in the cell in the first line under the first column in a table data display 
part, the first line is automatically equipped with a switch function.
When you press the first line, the cursor moves to the first entry target cell in the table data 
display part.
(This works in the same way as the [Table Move +] or [Table Move −] switch.)

The special function described above is valid under the following conditions:
• The IDs for entry mode and table data display part are not identical.
• [Data Display] is selected for [Type] for entry mode.

7 8 9 -
4 5 6 +
1 2 3 CLR

0 ENT

<- ->
UP

DW

No.

1

2

3

4

5

162

644

151

758

60

170

800

140

900

50

150

600

100

600

20
10

No.

1

2

3

A

10

52

45

B

425

754

433

C

700

100

300

D

1615

1554

1225

Entry Screen

Table Move + Table Move −

When this switch is pressed, the 
cursor moves to the top cell in the 
other table data display part.

Key-in

Current 
value

Target 
value

Limit 
value

7 8 9 -
4 5 6 +
1 2 3 CLR

0 ENT

<- ->
UP

DW

No.

1

2

3

4

5

162

644

151

758

60

170

800

140

900

50

150

600

100

600

20
10

No.

1

2

3

A

10

52

45

B

425

754

433

C

700

100

300

D

1615

1554

1225

Entry Screen

Table Move + Table Move −

Works in the same way 
as these switches

When you press the first line, the cursor moves to the 
top cell in the table data display part.

Key-in

Current 
value

Target 
value

Limit 
value
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7

Entry Display

What Is “Entry Display”?

An “Entry Display” part is an area where data entered using entry keys is temporarily displayed.

When there is no entry display part, entered data is temporarily displayed on the entry target.
This section describes the settings essential for entry mode.

Main

Digits For entry display parts on MONITOUCH, the system automatically refers to 
the properties set for the entry target.  Make these settings for the purpose 
of layout on the editor.
Lay out the part referring to the greatest value or the longest display 
among the entry targets.

Decimal Point

Display Type

 Zero Suppress

Function Select [Entry Display Part].

9999

0
1250

300

7.23

11.02

TEST 0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250

Entry Screen

Value 1

Value 2

Value 3

Value 4

Text 1

Max.
Min.
Key-in
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Detail

ID Set the same ID as specified in the [Entry] dialog.
For more information on the ID, refer to the Operation Manual.
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Max./Min. Value Display (for Numerical Data Only)

What Is “Max./Min. Value Display”?

“Max./Min. Value Display” parts define a data range that can be entered using entry keys.  This is valid 
when the box for [  Alarm] is checked for the numerical data display part or table data display part 
(numerical) set as an entry target.

This section describes the settings essential for entry mode.

Main

Detail

Digits For maximum/minimum value display parts on MONITOUCH, the system 
automatically refers to the alarm setting made for the entry target.  Make 
these settings for the purpose of layout on the editor.
Lay out the part referring to the greatest value or the longest display 
among the alarm settings for entry targets.

Decimal Point

Display Type

 Zero Suppress

Function Select [Max. Value Display Part] or [Min. Value Display Part].

ID Set the same ID as specified in the [Entry] dialog.
For more information on the ID, refer to the Operation Manual.

9999

0
1250

300

7.23 4 5 6 DW

7 8 9 UP

1250

Entry Screen

Value 1

Value 2

Value 3

Max.
Min.
Key-in
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Placing Entry Targets and Keypad on Base Screen 
([Type: Data Display])

Overview

This is a simple and basic example of using entry mode where all the entry mode settings are made on 
one screen.

Setting Procedure

Note the following points when making settings.

• Set the same ID for the keypad, entry display, maximum value display and minimum value display 
as specified in the [Entry] dialog.

• Set [Function: Entry Target] for the target data display parts.

1234

1234
1234

1234

12.34

12.34

ABCD 0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

1234

Entry Screen

Value 1

Value 2

Value 3

Value 4

Text 1

Max.

Min.

Key-in

Set the same ID.
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Showing Keypad Only When Necessary

Overview

Any entry target placed on the base screen can be equipped with a keypad.  The keypad is 
automatically placed on the specified overlap display.  When the [ENT] key has been pressed for an 
entry target, the numerical data keyed in is entered for the target and the overlap disappears.

* The use of system memory $s76 enables the keypad to remain on the screen even at the 
press of the [ENT] key.
An overlap display remains while the value at $s76 is not zero.  Therefore, execute the 
macro command (MOVE) to place a value other than “0” at $s76.

Setting Procedure

1. Place either a numerical data or character display part on the screen, and proceed to the dialog 
setting.

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP

Numerical Data Entry Numerical Data Entry
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2. The data display part on the screen is equipped with the icon for overlap (multi-overlap).
At the same time, the keypad, the [Entry] dialog, and the entry display are registered in the 
specified overlap library.  If the functions of [Max. Value Entry] and [Min. Value Entry] are needed, 
add these functions in the overlap library by manual operation.

3. When there are two or more entry targets, follow the same steps for keypad placement.

Function Entry Target

With Entry Key Checked

Overlap ID Specify the overlap ID to be used for showing the keypad. *1

Overlap Library No. Specify the overlap library number of the keypad.
Press the [Register] button, select the desired keypad, and 
register it in the overlap library.*2
If registration in the overlap library is already complete, simply 
specify the overlap library number.

 Display Position • Unchecked:
The keypad is displayed in the position as registered in the 
overlap library.

• Checked:
The keypad can be placed in your desired position. (default 
0,0)
[X Coordinate] and [Y Coordinate]: Specify coordinates of 
the display position.
[Specify with Mouse]: Specify the display position by clicking.

*1 With [  With Entry Key] checked, if any overlap display other than the multi-overlap 
display has been registered, the following message is displayed.
Change the ID to another.

If another multi-overlap display is already registered with the same overlap ID, no error 
occurs.
However, when the keypad is displayed on the MONITOUCH, the multi-overlap display 
that is previously displayed will be hidden.

*2 Unless the [Register] button is pressed, the keypad will not be registered in the overlap 
library.

Numerical/character keys

Entry displayEntry icon
= [Entry] dialog

<Data display> <Overlap library>



7    Entry Mode

7-29

7

Password Function (For Char. Display Only)

Overview

Using entry mode, a password entry screen can be created with ease.

Setting Procedure

The following settings are required.

[Entry] dialog
Set [Type: Data Display].

Char. Display

Keypad
Set the options in the same way as [Type: Data Display].

Memory
(Main)

“Accept” or “reject” of the password is stored.

Password matches:
When the password is accepted, 0 (to 3) is stored.

Password does not match:
[−1] (FFFF H) is stored.

Function
(Main)

Select [Password Input].
The following options are included.

Fixed:
Select this option when there are four or less passwords.
Specify each password for No. 0 to 3 as necessary.  (Max: 32 one-byte 
alphanumeric characters)

Variable:
Select this option when there are more than four passwords.
Check the box for the password number, and specify the desired memory 
address.
Set a correct password in the specified memory address.  This password 
is used for judging “accept” or “reject” of the input password.

987

654

CLR321

ENT+/-.0

Example: Char. Display
Memory: D300
Function: Password Input (Fixed)
No. 0: 1999
No. 1: 1231
No. 2: (None)
No. 3: (None)

Key-in “1999”.

Key-in “1231”.

D300 = 0

D300 = 1

Key-in “2000”. D300 = −1
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Switching over Characters Displayed on Entry Keys

Overview

If the space on the screen is not sufficient, you can switch over characters displayed on the entry keys.
Register the characters to be switched as graphic libraries.

Setting Procedure

The following settings are required.

[Entry] dialog

Entry keys

 Graphic Check the box.
Specify the graphic number range to be switched over.
It is necessary to register as many graphic libraries as specified.

Function
(Main)

Select [Character Input] (Entry).

Draw Mode
(Style)

Be sure to select [XOR].
* Do not select a switch for which [XOR] cannot be selected.

Use the [Change Part] button and select a 2D part for which [XOR] 
can be set.

ID
(Detail)

Set the same ID as specified in the [Entry] dialog.
For more information on the ID, refer to the Operation Manual.

DEL

CLR

ENT

SP

BSA B C D E F G

H I J K L M N

O P Q R S T U

A - U a - u

DEL

CLR

ENT

SP

BSa b c d e f g

h i j k l m n

o p q r s t u

A - U a - u

A B C D E F G

H I J K L M N

O P Q R S T U

a b c d e f g

h i j k l m n

o p q r s t u

0 1 2 3 4 5 6

7 8 9 - _ , .

@ = [ ] { } :

Graphic library
Group No. 0 & No. 0

Group No. 0 & No. 1

Group No. 0 & No. 5
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7

Character change key

Graphic library
Register graphic libraries to be displayed on the entry keys.
Using the example where entry keys are placed as shown below, the procedure is explained.

Function
(Main)

Choose from the following functions.
[+ Block] (standard)
[− Block] (standard)
[Graphic Library] (Entry)
    GNo./No.

ID
(Detail)

Set the same ID as specified in the [Entry] dialog.
For more information on the ID, refer to the Operation Manual.

Step 1 Click [Registration Item] → [Graphic Library].
Specify the graphic library number to be registered and click [OK].

Step 2 The [Graphic Library Edit] window is displayed.
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Step 3 Select [View] → [Display Environment].  The [Display Environment] dialog is displayed.

Step 4 Open the [Others] tab window, and check the box for [  Base Screen Dsp.].

Specify the screen number where the keypad is placed, and click [OK].
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7

Step 5 The screen layout is shown on the [Graphic Library Edit] window.  On this window, place 
text graphics for characters to be displayed on the keypad.

* When you have finished the first graphic library, move to the next graphic library and 
place the next text graphics in the same manner.  For more information on the 
graphic library editing procedure, refer to the Operation Manual.

Step 6 When you have finished editing, close the [Graphic Library Edit] window.
Return to the [Screen Edit] window.
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Step 7 Check the registered graphic libraries on the screen.
Select [View] → [Display Environment].  The [Display Environment] dialog is displayed.

Step 8 Open the [Others] tab window and check the box for [  Graphic Library Dsp.].
The [Key Dsp. No.] button becomes active.  Click this button.

The [Key Dsp. No. Setting] dialog is displayed.  Specify the required graphic library 
number and click [OK].
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7

Step 9 The [Display Environment] dialog is displayed again.  Click [OK].
The registered graphic library is displayed on the keypad.

Step 10 The text on the graphic library can be centered on each key on the keypad.
Select the keypad, and select [Edit] → [Arrangement (Equal)] → [Switch/lamp 
Centering].  The text is center-aligned.

Switches selected
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Item Select Function

Overview

• It is possible to limit cursor movement to certain entry targets when selecting a data field for entry.  
This is called the “item select function.”

• The item select function becomes available when [Data Display] or [Block] is chosen for [Type], 
and [Internal] is chosen for [Input Item Select] in the [Entry] dialog.

• When using the item select function, either use the [Function: Item Select] switch that is operated 
with the V8 series’ internal switch (see next section) or use an external command with [Item Select 
Memory] (see page 7-37).

Item Select Function with a Switch
[Function: Item Select] switch
When using the [Function: Item Select] switch, overlay it on the entry target.
Pressing the switch moves the cursor to the part.

* The [Function: Item Select] switches must be placed on the same editing layer (base screen 
or overlap ID 0 to 3) that is specified on the [Entry] dialog.  Otherwise, the switches do not 
work.

9999

0
1250

300

7.23

11.02

TEST 0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250

Data entry into “Value 2” and “Text 1” can be disabled if necessary.

Entry Screen

Value 1

Value 2

Value 3

Value 4

Text 1

Max.
Min.
Key-in

50.00

0
1250

300

7.23

11.02

TEST 0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

11.02

When the switch is pressed, the cursor moves.

Entry Screen

Value 1

Value 2

Value 3

Value 4

Text 1

Max.
Min.
Key-in

Switch
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[Function: Overlap Display = ON (or Multi-Overlap Display)] switch
When the [Function: Overlap Display = ON (or Multi-Overlap Display)] switch is overlaid on an entry 
target, pressing the switch brings up the overlap window with the cursor on it.  (Refer to page 7-27.)
Each time a switch is pressed, the cursor moves; when an overlap display part is shown, the switch 
works in the same way as the [Function: Item Select] switch.

Item Select Function using Item Select Memory

It is possible to control cursor movement by setting [Item Select Memory] on the same position where 
an entry target is placed.

Setting position

Check the box for [  Item Select Memory] and specify the top memory address of [Item Select 
Memory].

*1 For [  Data Block Area] in the [Data Block Area] dialog, specify the top memory address and 
[Word Count].

Entry Target
Setting position

Type Placing position

Num. Display
Char. Display

Base screen [Screen Setting] → [Screen Setting] → [Entry] tab window 
→ [  Item Select Memory]

Normal overlap [Normal Overlap] dialog → [Detail] tab window → [  Item 
Select Memory]

Multi-Overlap [Multi-Overlap] dialog → [Detail] tab window → [  Item 
Select Memory]

Call-Overlap [Call-Overlap] dialog → [Detail] tab window → [  Item 
Select Memory]

Global overlap [Global Overlap Setting] dialog → [Detail] tab window → [  
Item Select Memory]

Data Block Area [Data Block Area] dialog → [Detail] tab window → [  Item 
Select Memory] *1

Table Data 
Display

− [Table Data Display] dialog → [Detail] tab window → [  
Item Select Memory]

1250

300

7.23

11.02

TEST
0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

10.00

0

7.23

When the switch is pressed, an overlap window is brought up 
and the cursor appears in the pressed position.
While the overlap display part is shown, the cursor moves to 
the switch that is pressed.

Entry Screen

Value 1

Value 2

Value 3

Value 4

Text 1

Max.
Min.
Key-in

Switch
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Contents of item select memory (Entry Target = Num. Display/Char. Display)
The memory addresses specified for [Item Select Memory] are linked with the selection order of entry 
targets as shown below:

0

1

2

3

4

1 1 1 1

2 2 2 2

3 3 3 3

4 4 4 4

5 5 5 5

1 1 1 1

3 3 3 3

5 5 5 5

1 1 1 1

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
Item select  
memory n

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00n + m

m × 16

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16
n + 1

Bit No.
Selection order of 
entry targets

Bit No.
Selection order of 
entry targets

m × 16 + 15

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 1 0 1 0 1

MSB LSB
Example: For the screen shown below:

Item select memory n

Ignored
Corresponding to 
selection order

Line A

Line B

Line C

Line D

Line E

Order INC

The cursor moves to the data fields in the following order:
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Contents of item select memory (Entry Target = Table Data Display)
Assignment depends on the number of columns of the table data display part.

* In this case, the selection order of data display parts is ignored.
Line and column numbers are fixed whether the [Display Function: Entry Target] parts are 
present or not.  The line and column numbers are also assigned to those consisting of text 
graphics only.

• Table with 1 to 16 columns
For a table with 1 to 16 columns, one word is used for each line.
The total number of words used is as many as the number of lines.

• Table with 17 to 20 columns
For a table with 17 or more columns, 2 words are used for each line.
The total number of words used is twice as many as the number of lines (× 2).

16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
Item select memory n

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00n + m

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16
n + 1

Bit No.
Line 1

Bit No.
Line 2

Bit No.
Line “m”

Column numbers

20 19 18 17
15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

MSB LSB

Bit No.
Line 1

Bit No.
Line 2

Bit No.
Line “m”

16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1
15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Item Select Memory

n + 1

LSB LSB

n

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00 15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
n + 3 n + 2

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00 15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
n + q n + p

Column number
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Using the Keypad-like Digital Switch

Overview

Using entry mode, a digital switch screen can be created with ease.

* A digital switch part that does not use entry mode (does not use the [Write] key) is also 
available.
For more information, refer to “3  Switch” on page 3-38.

Setting Procedure

The following settings are required.

[Entry] dialog
Set [Type: Data Display].

Entry target (Num. Display) 
Place a display part on the screen and specify the memory address to which data should be written.
For more information on other setting items, refer to page 7-19.

* Real numbers are not supported.

Keypad

* When no alarm setting is made for the entry target:
When the result of calculation exceeds the data length set for the entry target, an error buzzer 
sounds and the switch becomes invalid.

* When the alarm setting is made for the entry target:
When the result of calculation is greater than the maximum value or smaller than the minimum 
value, an error buzzer sounds and the switch becomes invalid.

Function
(Main)

Select [Add] or [Subtraction] (Entry).

Set the detail for [Value] as an auxiliary setting item.
Range: 0 to 4294967295 DEC (FFFFFFFF HEX) (37777777777 OCT)

ID
(Detail)

Set the same ID as specified in the [Entry] dialog.
For more information on the ID, refer to the Operation Manual.

2 2 2 2
+10

Enter

+1+1000

-1000

+100

-10 -1-100

2 2 3 2
+10

Enter

+1+1000

-1000

+100

-10 -1-100

2 2 3 2
+10

Enter

+1+1000

-1000

+100

-10 -1-100

D100 2232D100 2222

[Num. Data Display]
D100
Entry Target

[Switch]
Addition: xx (U)

[Switch]
Subtraction: xx (U)
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[Type: Data Block]

Overview

If the space on the screen is not sufficient, you can switch over the entry targets displayed on the 
screen.
Register the data for these entry targets to be switched as data blocks.

Setting Procedure

The following settings are required.

[Entry] dialog

Keypad
Place the part in the same way as [Type: Data Display].

Data block area
Place the data block area on the screen.  For more information, refer to “15.1  Data Block Area.”

Data block
Register data for entry targets for [Data Block].
For more information on the registration and editing procedure, refer to Operation Manual.

Type
(Main) Select [Data Block].

9999

01250

300

7.23

11.02

TEST

0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250

DWUP

1000

0

0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

0

DWUP

0

0

0

5000

5010

1250

300

7.23

11.02

TEST

0

0

0

5000

5010

100

200

Entry Screen

Value 1
Value 2
Value 3
Value 4
Text 1

Max.
Min.
Key-in

Entry Screen

Line A
Line B
Line C
Line D
Line E

Max.
Min.
Key-in

Setting value
Target value

Value 1
Value 2
Value 3
Value 4
Text 1

Line A
Line B
Line C
Line D
Line E

Change Data

Data block No. 0 Data block No. 1 Data block No. 9
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[Type: Direct]

Overview

The data format, the number of digits, the decimal point position, etc. are externally controlled.

[Entry] Dialog
Main

Type Select [Direct].
* [Direct] can only be selected when [  Display All Formats] is checked 

in the [Detail] tab window.

Command Memory This is used for controlling entry mode.
For more information, refer to page 7-43.

Info Output Memory The status of entry mode is written into the specified memory address.
For more information, refer to page 7-44.

 Default 0 This is valid when a data display part (Function: Entry Display Part) is 
placed.
When this box is checked, data on the entry display part is reset to “0” if it 
is a numeric value or is reset to a space if it is text each time the [Write] key 
is pressed.
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Command memory

1. Display type Specify data format to be used for entry.

2. Write format Specify data format to be used for writing data to [Info Output Memory] n + 2 and later.
Note that when BCD is chosen, “0” is entered for negative values.

3. Clear This bit is used for clearing the data from the data display part (Function: Entry 
Display Part).

0:
The data indicated on the entry display part remains.

1:
Entering “0” clears the current numerical data.
Entering a space (ANK 20H) clears the current characters.  Entry is prohibited.

4: Digits Specify the number of digits for entry.  “0 to 80” can be specified.
The number of required bits depends on the code (DEC or BCD).

DEC: Bits 0 to 6
BCD: Bits 0 to 7

5. Decimal point Specify the decimal point position.
Up to 10 digits can be displayed in DEC.  Therefore “0” to “9” can be specified.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0

1. Display type2. Write format
0: DEC
1: BCD

3. Clear

BCD: 1 to 8
DEC: 1 to 10
HEX: 1 to 8
OCT: 1 to 11
BIN: 1 to 32
TEXT: 1 to 80

Command memory n

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0

4: Digits5. Decimal point
DEC: 0 to 7
BCD: 0 to 9

n+1

LSBMSB

Bit No.
Display type

02 01 00

0 0 0 DEC (w/o sign)

0 0 1 DEC (w/ −sign)

0 1 0 DEC (w/ +− sign)

0 1 1 HEX

1 0 0 OCT

1 0 1 BIN

1 1 0 Text
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Info output memory

1. Display type
Data specified in [Command Memory] “n” (page 7-43) is written.

2. Write format

3. Entry motion This bit is valid when multiple entry mode parts are placed on the screen.
An entry mode part can be placed on the base screen or an overlap window, 
respectively.
If multiple entry mode parts are displayed at the same time, the one shown at the 
forefront becomes active.  This bit is set to “1” when the entry mode part is at the 
forefront.
(If there is only one entry mode part displayed, the bit is always “1”.)

4: Write status This bit shows whether the [Write] key has been pressed or not.

0: Not written
Indicates that the [Write] key has not been pressed.

1: Write completed
Indicates that the [Write] key has been pressed and that data is written to memory.

5: Digits
Data specified in [Command Memory] “n” (page 7-43) is written.

6. Decimal point

7. Entered data Write entry data when the [Write] key is pressed.

Info output memory n

n+1

n+2
15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

n+m
15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

7. Entered data

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0

1. Display type2. Write format
0: DEC
1: BCD

BCD: 1 to 8
DEC: 1 to 10
HEX: 1 to 8
OCT: 1 to 11
BIN: 1 to 32
TEXT: 1 to 80

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0

5: Digits6. Decimal point
DEC: 0 to 7
BCD: 0 to 9

3. Entry motion
0: Disabled
1: Enabled

4. Write status
0: Not written
1: Write completed

LSBMSB
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7

Detail

Keypad

Make settings in the same way as explained for [Type: Data Display].  (Refer to page 7-12.)

Entry Display Part

Make settings in the same way as explained for [Type: Data Display].  (Refer to page 7-23.)

Operating Procedure

Data is read using the following steps.

A: Command Memory
B: Info Output Memory

* Once bit 15 of [Info Output Memory] “n” is set (ON), it is not reset automatically.

 Graphic
Set these options as explained for [Type: Data Display].
For more information, refer to page 7-11. Line/Column 

Output

Process Cycle For more information, refer to “Appendix 5  Process Cycle.”

 Display All Formats Set these options as explained for [Type: Data Display].
For more information, refer to page 7-11.ID

Step 1 Specify the display format, the number of digits, the decimal point position, etc. in 
[Command Memory] “n” and “n + 1”.

A

Step 2 The entry display part indicates data according to the specified display format, the 
number of digits, and the decimal point position, etc.

Step 3 Check that bit 14 (entry motion) of [Info Output Memory] “n” is set (ON). B

Step 4 Enter the desired data through the keypad and press the [Write] key.

Step 5 Check that bit 15 (write completed) of [Info Output Memory] “n” is set (ON).
In the same manner, check that the data is written to [Info Output Memory] “n”, “n 
+ 2” and “n + 3”.

B

Step 6 Read the data in [Info Output Memory] “n”, “n + 2” and “n + 3”. B

Step 7 Reset bit 15 (write completed) of [Info Output Memory] “n”. * B

Step 8 Set bit 15 (clear) of [Command Memory] “n”.
Check that the entry display part indicates “0”.

A

Step 9 Reset bit 15 (clear) of [Command Memory] “n”.
Check that the data is shown on the entry display part again.

A
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Please use this page for notes.
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8

8 Graph Display
8.1 Bar Graph

Overview

• Data in the memory address can be expressed in a bar graph.

• It is possible to extend the bar from the desired standard point.

• When data in the memory exceeds or falls short of the range specified, the graph color can be 
changed.  This makes the operator recognize the situation easily and correctly.

• As shown below, it is possible to indicate a bar graph in several colors.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

.................

7000

0 100%50

PLC

V8 series

PLC memory

0 10050

Standard point
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Setting Dialog

Main

*1 When [DEC-/BCD] is selected, the setting at [Code: DEC/BCD] in the [Communication Setting] 
tab window takes effect ([System Setting] → [Device Connection Setting]).

Memory Data in this memory address is shown in the graph in real time.
The data in this address is called the “current value.”

Data Length
(1-Word, 2-Word) Select data length of the memory address.

Input Type
(DEC-/BCD*1/
FLOAT)

Select the code of memory values.
The selection here also applies to [Scale], [Target Value], [Standard Value] 
and [Alarm].

Type
(Standard, 
Deviation)

Choose either [Standard] or [Deviation].

Standard: 
The bar extends from the minimum value toward the maximum value to the 
current value.

Deviation: 
Determine the “standard point” in the graph.  The bar extends from the 
standard point to the current value.

Direction
(RGT, LFT, UP, DW)

Choose from [RGT], [LFT], [UP] or [DW] to select the direction for drawing the 
graph.  

Scale Specify the minimum and maximum values for the range of the graph.
When the scale value should be variable, choose a memory address; when it 
is fixed, choose [Constant].

Target Value
Standard Value

When [Standard] is chosen for [Type], the option name reads [Target Value].
When [Deviation] is chosen, it reads [Standard Value].
When the target or standard value should be variable, choose a memory 
address; when it is fixed, choose [Constant].

* When the box for [Alarm] is checked ( ) in the [Alarm] tab window, 
it is not necessary to set [Target Value] or [Standard Value].

0 50

50 0

0

50 0

50

0 50

50 0

0

50 0

50

Standard Deviation



8.1   Bar Graph

8-3

8

Alarm

*1 Choose either [Top] (left) or [Bottom] (right) for 
placing marks.

 Alarm When the box for [  Alarm] is checked, the bar will be shown in a different 
color when data in the specified memory address exceeds or falls short of the 
range specified.

Upper Limit
Range
Lower Limit 

This option is valid when [Standard] is selected for [Type] in the [Main] tab 
window.
Set the upper limit, the lower limit and colors.

When the upper or lower limit should be variable, choose a memory address; 
when it is fixed, choose [Constant].

 Upper Limit 2
 Lower Limit 2

This option is valid when [Standard] is selected for [Type] in the [Main] tab 
window.
Use this option when using more than three colors for alarm setting.
Make the settings in the same way as [Upper Limit] or [Lower Limit].

Range Value
Range
Standard Value

This option is valid when [Deviation] is selected for [Type] in the [Main] tab 
window.
Specify the value to be used as the reference for [Standard Value].
[Range Value] specifies a data range from the standard value in both 
directions (right and left or up and down).
Set the values and colors.
When the range or standard value should be variable, choose a memory 
address; when it is fixed, choose [Constant].

 Mark Display
Position *1 *2

Color

Check this box ( ) when you want to indicate the upper and lower limits 
using  marks.

Specify the position and the color of the marks.

 Separate Color 
Display

The bar is shown in separate colors: “lower limit color,” “range color,” and 
“upper limit color” when this option is checked ( ).
(Refer to “Examples with Alarm Setting” on page 8-6.)

• Standard • Deviation

Min. Max.Upper limitLower limit

Max.: 100
Min.: 0
Upper limit: 75
Lower limit: 25
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*2 When placing scales around the graph, do not place 
scales in the positions shown at right.  There are some 
cases where the mark color is different from the setting 
or is not displayed.  The mark is drawn using the 
XORed color.

Style

*1 Depending on the selection for [Type] on the [Main] tab window, each option denotes as shown 
below.

Execute *1 Set the color for the current value.
When the box for [  Alarm] is checked in the [Alarm] tab window, the setting 
for [Execute] is not valid.

Target Value *1 Set the color for the target value.
When the box for [  Alarm] is checked in the [Alarm] tab window, the setting 
for [Target Value] is not valid.

Area *1 Specify the colors inside the graph. 

 Display Frame
Frame *1

Check this box ( ) when drawing an outline around the bar graph.
Set the frame color.

Change Part For more information, refer to the Operation Manual.

Customize For more information, refer to the Operation Manual.

A

A

A A

A = 2 dots

Horizontal bar

Vertical bar

• Standard

Current 
value

Target value
Execute color

Area color

Frame color

Target value color

• Deviation

Current 
value

Standard value
Execute color

Area color

Frame color
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Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Display Setting

For information on setting the [Display Setting] tab window, refer to the V8 Series Reference Additional 
Functions.

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Examples with Alarm Setting

[Type: Standard], [  Alarm]

[Type: Deviation], [  Alarm]

50 150 250 350 450

50 150 250 350 450

50 150 250 350 450

50 150 250 350 45050 150 250 350 450

50 150 250 350 450

50 150 250 350 450

Lower limit 
color

Range 
color

Upper limit 
color

Area 
color

[Direction: RGT]

Current value Lower limit 
value

Upper limit value Current 
value

Lower limit 
value

Upper limit value Current value
Lower limit 

value
Upper limit value

Current 
value

Lower limit value Upper limit valueCurrent 
value

Lower limit value Upper limit value

Current 
value

Lower limit 
value

Upper limit 
value

Current valueLower limit 
value

Upper limit 
value

• Single color use • Separate color use • With marks

50 150 250 350 450

50 150 250 350 450

50 150 250 350 450

50 150 250 350 450

50 150 250 350 450

50 150 250 350 450

50 150 250 350 450

A AA A

A AA A

A AA A

A A

Lower limit 
color

Range 
color

Upper limit 
color

Area 
color

[Direction: RGT]

Current 
value

Standard value

A: Range value

Current value Standard value
Lower limit value Upper limit value

Current value Standard valueCurrent value Standard value

Current valueStandard value Current valueStandard Value

• Single color use • Separate color use • With marks
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8.2 Pie Graph
Overview

• Data in the specified memory address can be expressed in a pie graph, extending the graph 
clockwise from the start point.

• It is possible to extend the graph from the desired standard point.

• When data in the memory exceeds or falls short of the range specified, the graph color can be 
changed.  This makes the operator recognize the situation easily and correctly.

• As shown below, it is possible to indicate a pie graph in several colors.

Standard point
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Setting Dialog

Main

*1 When [DEC-/BCD] is selected, the setting at [Code: DEC/BCD] in the [Communication Setting] 
tab window takes effect ([System Setting] → [Device Connection Setting]).

Memory Data in this memory address is shown in the graph in real time.
The data in this address is called the “current value.”

Data Length
(1-Word, 2-Word) Select data length of the memory address.

Input Type
(DEC-/BCD*1/
FLOAT)

Select the code of memory values.
The selection here also applies to [Scale], [Target Value], [Standard Value] 
and [Alarm].

Type
(Standard, 
Deviation)

Choose either [Standard] or [Deviation].

Standard: 
The sector extends from the minimum value toward the maximum value to 
the current value.

Deviation:
Determine the “standard point” in the pie graph.  The bar extends from the 
standard point to the current value.

Scale Specify the minimum and maximum values for the range of the graph.
When the scale value should be variable, choose a memory address; when it 
is fixed, choose [Constant].

Target Value, 
Standard Value

When [Standard] is chosen for [Type], the option name reads [Target Value].
When [Deviation] is chosen, it reads [Standard Value].
When the target or standard value should be variable, choose a memory 
address; when it is fixed, choose [Constant].

* When the box for [Alarm] is checked in the [Alarm] tab window, it is 
not necessary to set [Target Value] or [Standard Value].

Standard value

• Standard • Deviation
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Alarm

*1 When showing scales, do not place scales in the following position.  There are some cases 
where the mark color is different from the setting or is not displayed.
The mark is drawn using the XORed color.

 Alarm When the box for [  Alarm] is checked, the bar will be shown in a different 
color when data in the specified memory address exceeds or falls short of the 
range specified.

Upper Limit
Range
Lower Limit 

This option is valid when [Standard] is selected for [Type] in the [Main] tab 
window.
Set the upper limit, the lower limit and colors.

When the upper or lower limit should be variable, choose a memory address; 
when it is fixed, choose [Constant].

Range Value
Range
Standard Value

This option is valid when [Deviation] is selected for [Type] in the [Main] tab 
window.
[Standard Value] specifies the standard value.
[Range Value] specifies a data range from the standard value in both 
directions.
Set the values and colors.
When the range or standard value should be variable, choose a memory 
address; when it is fixed, choose [Constant].

 Mark Display

Color *1

Check this box ( ) when you want to indicate the upper and lower limits 
using  marks.

Choose the desired color for the mark.

 Separate Color 
Display

The bar is shown in separate colors: “lower limit color,” “range color,” and 
“upper limit color” when this option is checked ( ).
(Refer to “Examples with Alarm Setting” on page 8-12.)

• Standard • Deviation

Maximum value, minimum value

Upper Limit Lower Limit

Max.: 100
Min.: 0
Upper limit: 60
Lower limit: 30

A
Pie graph

A = Angle: 1/3, Radius r +2 dots
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Style

*1 Depending on the selection for [Type] on the [Main] tab 
window, each option denotes as shown at right.

*2 The pie graphs with and without internal circle are shown 
at right.

Execute *1 Set the color for the current value.
When the box for [  Alarm] is checked in the [Alarm] tab window, the setting 
for [Execute] is not valid.

Target Value *1 Set the color for the target value.
When the box for [  Alarm] is checked in the [Alarm] tab window, the setting 
for [Target Value] is not valid.

Area *1 Specify the colors inside the graph. 

 Display Frame 
Frame *1

Check this box ( ) when drawing an outline around the pie graph.
Set the frame color.

 Internal Circle 

Radius *2

Check this box ( ) when drawing an internal circle in the center of the pie 
graph.

Set the radius of the internal circle.

Change Part For more information, refer to the Operation Manual.

Customize For more information, refer to the Operation Manual.

Area color

Target value color

Target value

Current value

Execute 
color

Frame 
color

Without internal 
circle

Radius

With internal 
circle
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Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Display Setting

For information on setting the [Display Setting] tab window, refer to the V8 Series Reference Additional 
Functions.

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Examples with Alarm Setting

[Type: Standard], [  Alarm]

[Type: Deviation], [  Alarm]

Lower limit 
color

Range 
color

Upper limit 
color

Area 
color

Lower limit 
value

• Single color use

• Separate color use

• With marks

Upper limit 
value

Current 
value

Upper limit 
value Current 

value

Lower limit 
value

Current 
value

Upper limit 
value

Lower 
limit Upper limit 

value
Lower limit 

value

Current 
value

Upper limit 
value

Lower limit 
value

Current 
value

Upper limit 
value Current 

value

Lower limit 
value

Current 
value

Upper limit 
value

Lower limit 
value

A A

A A

A A

A A

A A

A A

A A

Lower limit 
color

Range 
color

Upper limit 
color

Area 
color

A: Range value

• Single color use

• Separate color use

• With marks

Lower 
limit 

value

Upper 
limit 

value

Current 
value

Upper 
limit 

value

Lower 
limit 

value

Upper 
limit 

value

Lower 
limit 

value

Current 
value

Upper 
limit 

value

Lower 
limit 

value

Current 
value

Lower 
limit 

value

Upper 
limit 

value

Current 
value

Upper 
limit 

value

Lower 
limit 

value
Upper 
limit 

value

Lower 
limit 

value

Current 
value

Standard 
value

Standard 
value

Standard 
value

Standard 
value

Standard 
value

Standard 
value

Standard 
value

Current 
value

Current 
value
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8.3 Closed Area Graph
Overview

• Changes in a closed area, such as a tank, can be expressed in a closed area graph.

• When data in the memory exceeds or falls short of the range specified, the graph color can be 
changed.

Setting Dialog

Main

*1 When [DEC-/BCD] is selected, the setting at [Code: DEC/BCD] in the [Communication Setting] 
tab window takes effect ([System Setting] → [Device Connection Setting]).

Memory Data in this memory address is shown in the graph in real time.
The data in this address is called the “current value.”

Data Length
(1-Word, 2-Word) Select data length of the memory address.

Input Type
(DEC-/BCD*1/
FLOAT)

Select the code of memory values.
The selection here also applies to [Scale] and [Alarm].

Direction
(RGT, LFT, UP, DW)

Choose from [RGT], [LFT], [UP] or [DW] to select the direction for drawing the 
graph. 

Scale Specify the minimum and maximum values for the range of the graph.
When the scale value should be variable, choose a memory address; when it 
is fixed, choose [Constant].

1234
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Alarm

*1 For a closed area graph containing a part as shown below, the [Separate Color Display] option is 
not available.

Style

*1 The above options denote as shown below.

 Alarm When the box for [  Alarm] is checked, the bar will be shown in a different 
color when data in the specified memory address exceeds or falls short of the 
range specified.

Upper Limit
Range
Lower Limit 

Set the upper limit, the lower limit and colors.
When the upper or lower limit should be variable, choose a memory address; 
when it is fixed, choose [Constant].

 Separate Color 
Display *1

The bar is shown in separate colors: “lower limit color,” “range color,” and 
“upper limit color” when this option is checked ( ).  
(Refer to “Closed Area Graph Examples” on page 8-16.)

Execute *1 Set the color for the current value.
When the box for [  Alarm] is checked in the [Alarm] tab window, the setting 
for [Execute] is not valid.

Area *1 Specify the colors inside the graph. 

Change Part For more information, refer to the Operation Manual.

Customize For more information, refer to the Operation Manual.

Area color

Current value

Execute color
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Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Display Setting

For information on setting the [Display Setting] tab window, refer to the V8 Series Reference Additional 
Functions.

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Closed Area Graph Examples

Notes

• When a tile pattern (other than tile pattern “0”) is used for screen background or overlap display 
area, the closed area graph may not be drawn correctly.
Likewise, when the closed area graph is placed on a graphic using a tile pattern, it may not be 
drawn correctly either.

• When the line color used for the closed area graph is the same as the screen background color, it 
cannot be drawn.

* If you use a 3D part, this problem will not arise.  Therefore, if you want to place a closed 
area graph on a tile pattern, use a 3D part.

Lower 
limit color

Current 
value

Lower limit 
value

Upper limit 
value

Range 
color

Upper 
limit color

Area 
color

[Direction: UP]

Single color use

Separate color use

Upper limit 
value

Current 
value
Lower limit 
value

Upper limit value

Current value

Lower limit value

Current 
value

Lower limit 
value

Upper limit 
value

Upper limit 
value

Current 
value
Lower limit 
value

Upper limit value

Current value

Lower limit value

Tile “3” is used for screen background.

Example:
On the editor On MONITOUCH
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8.4 Panel Meter
Overview

• Data in the specified memory address can be expressed in the form of an 
analog meter.

• The indicator can be moved to the right or left.
• Alarm 1

When data in memory exceeds or falls short of the range specified, the 
indicator color is changeable to indicate the status.

• Alarm 2
When divisions are made in the alarm range, these divisions can be differently colored.  Division 
into a maximum of 16 sections is allowed.
Note that the color of the indicator does not change according to the alarm condition.

   Example: [No. of Divisions] = “3”

• Extended indicator/scale settings
The design of a scale or an indicator can be modified with a user-created bitmap.

• Numerical data display
A panel meter can be provided with a numerical data display that shows the current data. 

   Example: “8” placed in memory at D100

50

100

150

200
250

300

350

400

450 50

100

150

200
250

300

350

400

450 50

100

150

200
250

300

350

400

450

Alarm: Lower limit Range Upper limit

Color

(Lower limit)

Color

(Range)

Color Color

(Upper limit)

ColorColor

0

5

10

15
20

25

30

35

40

(Blue) Upper Limit [10] Lower Limit [0]

(Yellow) Upper Limit [25] Lower Limit [15]
(Red) Upper Limit [40] Lower Limit [30]

Up to 16 alarm divisions

0

5

10

15
20

25

30

35

0

5

10

15
20

25

30

35 -2

-1
0

1

2

4040

0

5

10

15
20

25

30

35

40

8

D100 
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Applicable Models

* Not available on the portrait-orientated V806.

Setting Dialog

Main

*1 When [DEC-/BCD] is selected, the setting at [Code: DEC/BCD] in the [Communication Setting] 
tab window takes effect ([System Setting] → [Device Connection Setting]).

Contents

Model

ColorV815iX/V812(i)S
V810(i)S/

V810(i)TV808(i)S

V810(i)C/V808(i)C
V808(i)CH

V806(i)T
V806(i)C * V806(i)M

Alarm 1 All

Alarm 2

64k 
colors
32k 
colors

Indicator extended 
setting

Scale Show

Extension

Numerical data 
display

Memory Data in this memory address is shown in the meter in real time.
The data in this address is called the “current value.”

Data Length
(1-Word, 2-Word) Choose data length to be occupied for this part.

Input Type
(DEC-/BCD*1/FLOAT)

Select the code of memory values.
The selection here also applies to [Scale], [Target Value], and [Alarm].

Progress Direction
(Clockwise, 
Counterclockwise)

Select the indicator’s moving direction.

Scale Specify the minimum and maximum values for the range of the meter.
When the scale value should be variable, choose a memory address; when 
it is fixed, choose [Constant].

Target Value Specify the value to be used as the target.
When the target value should be variable, choose a memory address; 
when it is fixed, choose [Constant].

* When the box for [Alarm] is checked in the [Alarm] tab window, it 
is not necessary to set [Target Value].
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Alarm

 Alarm 1 When the current value falls outside the specified range, the status can be 
indicated with color changes of the indicator and the area.

 Alarm 2 Set the number of divisions and their respective alarm colors.

* Painting is performed in ascending order, from data 0 property to 
data 15 property.
When a painted range overlaps with another, the color of the greater 
number comes to the fore.

Upper Limit
Range
Lower Limit 

Set the upper limit, the lower limit and colors.
When the upper or lower limit should be variable, 
choose a memory address; when it is fixed, choose 
[Constant].

Color Set the color inside the area.

Range Set the color for values outside the ranges specified in 
[Data Property] dialogs.

No. of 
Divisions
(1 to 16)

Set the number of divisions for alarm.

Edit Proceed to setting each [Data Property] dialog for a 
color and upper and lower limit values.

Indicator’s moving 
direction: right

Indicator’s moving 
direction: left

Data 1 
property

Data 0 
property

Data 1 
property

Data 0 
property

Data 3 property

Data 2 property

  Example: [No. of Divisions] = “4”

(The indicator’s moving direction can be selected in the [Main] tab window.)  
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Num. Display

A panel meter can be equipped with a numerical data display to show the current data.

Main

Style

Digits Specify the number of digits for numerical data display.

Decimal Point Specify the decimal place.  When no decimal point is required, set “0”.

Display Type Select the format of numbers to be displayed on the screen.

 Zero Suppress Check this box when using zero suppress.

 Size Automatic 
Adjustment

Check this box when automatically adjusting the item size based on the 
[Digits] and [Decimal Point] settings.

Color

For more information, refer to “Appendix 4  Styles and Coordinates”.

Property

Enlarge

Point

Rotation + Direction

 Spacing

Character Size



8.4   Panel Meter

8-21

8

Coordinates

 Windows Font
For more information, refer to the Operation Manual.

Font

Display Language For more information, refer to “Appendix 3  Display Language”.

 Customize Check this box when using a user-created bitmap file for the design of the 
numerical data display.
Black (code 0000) on the image automatically becomes transparent on 
MONITOUCH.  To display black, specify a color approximate to black.

Panel Meter Center 
Point

The coordinates of the panel meter center point are displayed.

Base Point X/Base 
Point Y

Specify the X and Y coordinates of the base point on the numerical data 
display in dots.

Default Resets the X and Y coordinates of the base point on the numerical data 
display to those specified for [Panel Meter Center Point].

Select Choose a bitmap file in the desired folder.  The 
selected bitmap file is stored in “.\V-SFT-5\Parts\User”.

Width/Height Change the width and height of the imported bitmap 
image.

 Aspect 
Ratio Fixed

Check this box when using the fixed width-to-height 
ratio for changing the size of the bitmap image.

Red ×:
Base point X, Y
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Style

Indicator *1 Choose the desired color for the indicator that shows the current value.  
When the box for [  Alarm] is checked in the [Alarm] tab window, the setting 
for [Indicator] is not valid.
For setting the color of the indicator, go to [Alarm 1].

Target Value *1 Set the color for the target value.  
When the box for [  Alarm] is checked in the [Alarm] tab window, the setting 
for [Target Value] is not valid.
Then go to the [Alarm] tab window for setting the color of the target value.

Area *1 Specify the colors inside the meter. 

 Display Frame 
Frame *1

Check this box ( ) when drawing an outline around the panel meter.
Set the frame color.

 Complete 
Round Circle

Check this box to make a complete round graph area.

Graph shape
Indicator

Unchecked (sector) Checked (complete round circle)

Graph area

Start 
Angle

Set the start angle. Example: [Start Angle: 180], [End: 0]

End This setting is active 
only when [  
Complete Round 
Circle] is not checked.
Set the end angle. * Panel meter area: 

Area circularly enclosed from 
the start angle to the end angle 
in the clockwise direction

Start angle
End angle



8.4   Panel Meter

8-23

8

*1 The above options denote as shown below.

*2 The inner circle must be set.  The minimum radius of the inner circle is 10 dots.  The minimum 
difference in radius between the outer and inner circles is 3 dots.

*3 Available with 64k-color or 32k-color MONITOUCH (V815iX, V812(i)S, V810(i)S, V810(i)T or 
V808(i)S).

Outer radius *2 Set the radius of the outer circle of the panel meter.

Inner radius *2 Set the radius of the inner circle of the panel meter.

Change Part For more information, refer to the Operation Manual.

Customize For more information, refer to the Operation Manual.

 Indicator Setting 
(Extension) *3

Check this box when changing the indicator part.  A user-created bitmap file 
can be used.

Outer circle

Outer radius
Center

Inner circle

Inner radius
Center

Start Point Select the shapes of the 
top and the end of the 
indicator.

End Point

Length Specify the length of the 
indicator in dots.
(Maximum: Radius of the 
panel meter; Minimum: 1) 

 Customize Check this box when using a user-created bitmap file for 
the design of the indicator.
For more information, refer to “Customizing the Indicator 
and Scale” (page 8-27).

Start 
point

End 
point

Length

Area colorTarget value color

Target value Current value

Indicator color

Frame color
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Scale

Direction
Inside/Outside

Select the position of the scale; inside or outside of the outer circle.

Color Set the scale color.

Radius Set the scale radius.

Major scale Set the number of divisions and length of the major scale.

Inside Outside

Scale

Scale radius

No. of Divisions 1 to 255 Example: [No. of Divisions] = “8”
 

Length 1 to 16
(When [  Minor 
scale] is checked, 
the length can be 
set in increments 
of “2”.)

Major scale



8.4   Panel Meter

8-25

8

Detail

 Minor scale Check this box and set the number of divisions when drawing a minor scale 
between major scales.  (The length is the half of the one set for [Length] at 
[Major scale].)

 Line Check this box to add the outer line to the scale.

 Customize Check this box when using a user-created bitmap file for the scale design.
For more information, refer to “Customizing the Indicator and Scale” (page 8-
27).

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

No. of 
Divisions

1 to 16 Example: 
Major scale [No. of Divisions] = “8”
Minor scale [No. of Divisions] = “5”
 

Minor scale

Number of 
divisions for 
minor scale

Outer 
line

Example: Major scale [No. of Divisions] = “8”, Minor scale [No. of 
Divisions] = “5”

Checked Unchecked
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Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Display Setting

For information on setting the [Display Setting] tab window, refer to the V8 Series Reference Additional 
Functions.
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Customizing the Indicator and Scale

A desired bitmap file can be used for the part design (background, indicator and scale).

[Style], [Scale]

Customize 
(background) 
Select (indicator, 
scale)

Choose a bitmap file in the desired folder.
The selected bitmap file is stored in “.\V-SFT-5\Parts\User”.

Width / Height Change the width and height of the imported bitmap image.

 Aspect Ratio 
Fixed

Check this box when changing the size of the bitmap image while fixing the 
ratio between the width and height.

Panel Meter Center 
Point

The coordinate values of the panel meter (circle) center point are displayed.

Base Point X 
Base Point Y

Specify the X or Y coordinate value of the base point in dots.
The indicator turns around the point specified for [Panel Meter Center Point].

Default Resets the X and Y coordinate values of the base point to those specified for 
[Panel Meter Center Point].

ScaleBackground / Indicator

Red mark “×”: base point

Background

Indicator

N

S

EW

(0, 0)

Panel meter center point

Indicator

Base point
Specify the X and 
Y coordinate 
values of the base 
point to adjust the 
position of the 
indicator or scale.

Scale
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Procedure
This section explains the procedure for importing a bitmap image into the panel meter.

Scale

Black (code 0000) in the bitmap 
image automatically becomes 
transparent on MONITOUCH.

Indicator

scale_A.bmpback_A.bmp pin_A.bmp

Background of the 
panel meter

Step 1 Place a panel meter on the screen.
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Step 2 Import a background image of the panel meter.
Select [Customize] in the [Style] tab window in the [Panel Meter] dialog and check [  Use 
Custom Bitmap].  Press the [Open] button and select a bitmap file.  (Example: 
back_A.bmp)

Step 3 Enlarge or reduce the size of the graph area by specifying desired values for [Outer radius] 
and [Inner radius] in the [Style] tab window. 

Step 4 Import a bitmap image of the indicator.
Select [  Indicator Setting (Extension)] → [  Customize] on the [Style] tab window in the 
[Panel Meter] dialog and check [  Use Custom Bitmap].  Press the [Open] button and 
select a bitmap file.  (Example: pin_A.bmp)

* The bitmap image of the indicator is imported while it is pointing upward with 
reference to the panel meter center point.
The indicator cannot be rotated on the editor.

Background of the panel meter

Graph area

Indicator

Base point X and Y (= panel meter center point)
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Step 5 Move the indicator part downward by specifying values for [Base Point X] and [Base Point 
Y] in the [Style] tab window.  
It can be enlarged or reduced by specifying values for [Width] and [Height].

* The indicator rotates around the panel meter center point.
Step 6 Import a bitmap image of the scale.

Select [  Show a scale] → [  Customize] in the [Scale] tab window in the [Panel Meter] 
dialog and check [  Use Custom Bitmap].  Press the [Open] button and select a bitmap 
file.  (Example: scale_A.bmp)

Step 7 Specify values for [Width] and [Height] in the [Scale] tab window to reduce the size of the 
scale. 
The scale can be moved by specifying values for [Base Point X] and [Base Point Y].

The necessary settings have been completed.

Indicator base point X, Y

Panel meter center point

Scale
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Limitations

• The maximum sizes of the panel meter are shown below:

• Draw a panel meter in order from the smaller number shown below.
When any setting is made for [Alarm 2], [Indicator Setting (Extension)] or [Num. Display] and a 
value on the panel meter or [Alarm 2] is changed, the panel meter is updated entirely.

• The numerical data display is displayed even when a value falls outside the range specified for 
[Scale] (in the [Main] tab window).  However, when the number of digits exceeds the specified 
value, “---” is displayed.

MONITOUCH Model Max. Size of Panel Meter (unit: dots)

V815iX Height 768, width 512

V812(i)S / V810(i)S / V808(i)S Height 600, width 400

V810(i)T Height 480, width 320

V810(i)C / V808(i)C / V808(i)CH
V806(i)T / V806(i)C

Height × width = max. 65936

0

5

10

15
20

25

30

35

40

8

1. Part area *

3. Scale

2. Alarm

4. Indicator

5. Numerical data display

* When a draw item edited in the [Modify Part] window is placed with the 3D 
panel meter part, the item is placed over the panel meter.

Panel meter structure
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8.5 Statistic Bar Graph
Overview

• Percentages of data contained in multiple memory addresses can be expressed in a statistic 
graph.

• One statistic bar graph can be divided into a maximum of eight sections.
• It is also possible to indicate percentages in numerals for the statistic bar graph.  In this case, 

statistic bar graph must be linked with numerical data display parts.

Setting Dialog

Main

*1 The type of data specified in memory is determined by the setting for [Code] in the 
[Communication Setting] tab window for the device connected.

Memory Specify the top memory address to be used for the statistic bar graph.
Memory in consecutive addresses is automatically allocated to the statistic graph.
The required number of words (memory) can be calculated using the following 
equation:
Required memory = [Data Length] × [No. of Divisions]

Data Length
(1-Word, 2-Word) Select data length of the memory address.

No. of Divisions
(2 to 8) Specify the number of divisions for statistic bar graph.

Graph Direction
(RGT, UP)

Choose the graph extending direction from [RGT (horizontal bar)] or [UP (vertical 
bar)].  

Data Property 
Color

Set a color for each division.

15%
25%
20%
10%
30%

%

Statistic Bar Graph Num. Display
Linked
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Style

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Display Setting

For information on setting the [Display Setting] tab window, refer to the V8 Series Reference Additional 
Functions.

Frame Choose the desired color for the outline of statistic bar graph.

Change Part For more information, refer to the Operation Manual.

Customize For more information, refer to the Operation Manual.

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Num. Display (% Display)

“% display” of data in the graph is available using numerical data display parts.

In this section, the items to be noted when linking a statistic graph and numerical data display parts.
For the other setting items for numerical data display parts, refer to “5  Data Display.”

Main

Detail

Function Select [Statistic Graph % Display].

Statistic Graph No. Specify the data property number set for the statistic bar graph part.
If the number of divisions is 4, four numerical data display parts (0 to 3) are 
required.

ID Set the same ID as specified in the [Detail] dialog for the statistic bar graph 
part.
For more information on the ID, refer to the Operation Manual.

15 %
25 %
20 %
10 %
30 %

Statistic Graph Num. Display

Linked

%
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8.6 Statistic Pie Graph
Overview

• Percentages of data contained in multiple memory addresses can be expressed in a statistic 
graph.

• One statistic pie graph can be divided into a maximum of eight sections.
• It is also possible to indicate percentages in numerals for the statistic pie graph. 

In this case, the statistic pie graph must be linked with numerical data display parts.

Setting Dialog

Main

*1 The type of data specified in memory is determined by the setting for [Code] in the 
[Communication Setting] tab window for the device connected.

Memory Specify the top memory address to be used for the statistic pie graph.
Memory in consecutive addresses is automatically allocated to the statistic 
graph.
The required number of words (memory) can be calculated using the 
following equation:
Required memory = [Data Length] × [No. of Divisions]

Data Length
(1-Word, 2-Word) Select data length of the memory address.

No. of Divisions
(2 to 8) Specify the number of divisions for statistic pie graph.

Data Property Color Set a color for each division.

25%
12%
50%
13%

%

Statistic Pie Graph Num. Display
Linked
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Style

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Display Setting

For information on setting the [Display Setting] tab window, refer to the V8 Series Reference Additional 
Functions.

Num. Display (% Display)

The “% display” is available in the same way as statistic bar graph.
For more information, refer to “Num. Display (% Display)” on page 8-34.

Frame Choose the desired color for the outline of statistic pie graph.

Change Part For more information, refer to the Operation Manual.

Customize For more information, refer to the Operation Manual.

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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9 Trend Graph
9.1 Trend Graph (Real Time)

Overview

• Data in consecutive memory addresses can be expressed in a line graph or rectangular waves.
• Subsidiary lines can be drawn for easier recognition of data change.

• A maximum of 16 trends (lines) can be displayed.
• Negative values can be used.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

D200 = 60
D201 = 80
D202 = 90
D203 = 70
D204 = 60
D205 = 83
D206 = 90

D100 = 30
D101 = 40
D102 = 80
D103 = 20
D104 = 60
D105 = 10
D106 = 100

D300 = 40
D301 = 20
D302 = 60
D303 = 30
D304 = 10
D305 = 20
D306 = 50

0

20

40

60

80

100
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Setting Dialog

Main

Control Memory 

1. X Axis Data Points *2 (0 to 1024)
Specify the number of plot points to be displayed.
When the number of points is specified in [Control Memory], the trend 
graph is drawn by reading data for the lines (Nos. 0 to 15) as specified 
in respective tab windows.  Each time the number of points increases, 
the same operation is repeated.  (If it decreases, a different operation 
is made.)

2. Redraw *3

Trend lines are redrawn at the edge (0 → 1) by the specified number of 
points.
Drawing is performed over the previous one without clearing the trend 
graph area.

3. Redraw after clear *3

Trend lines are redrawn at the edge (0 → 1) by the specified number of 
points.
Drawing is performed after clearing the trend graph area.

X Axis Data Points *2
(3 to 1024)

Specify the desired number of plot points along the horizontal axis.

Graph Setting
(No. 0 to No. 15)

When a number box is checked, the corresponding trend line will be 
displayed.  Press the [Edit] button or double-click on the number when 
setting details of the trend line.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0

1. X-axis data points2. Redraw (0 → 1)

3. Redraw after clear (0 → 1)
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Edit Make settings for the trend line of the number checked in the [Graph 
Setting] field.

Memory Data in this memory address is read for drawing 
the trend line.  The required number of memory 
addresses varies depending on the setting for [X 
Axis Data Points] described above and [Data 
Length] described below.
For more information, refer to page 9-9.

Data Length
(1-Word, 2-Word)

Choose data length for one plot point.

Input Type
(DEC-/BCD*1/
FLOAT*6)

Select the code of memory values.
The selection here also applies to [Graph Min. 
Value], [Graph Max. Value], [Min. X Scale], and 
[Max. X Scale].

Graph Min. Value *4
Graph Max. Value

Specify the graph display area.
(PLC Memory *5, Internal Memory *5, Constant)

Min. X Scale *4
Max. X Scale

This is valid when you check [  X Scale] in the 
[Main] tab window.  For more information, refer to 
page 9-11.

Line Graph
(Line type & color)

Check this box when showing lines in the graph.  
Set the line type (from 6 types) and color.

Marker
(Point type & color)

Check this box when showing points in the 
graph.  Set the point type (from 6 types) and 
color.

Batch Setting It is possible to apply the same settings (from [Data Length] to [Max. X 
Scale] within the [Edit] button) to all the lines of which numbers are 
checked in the [Graph Setting] field.

Direction Choose from [RGT], [LFT], [UP], or [DW] to select the direction for drawing 
the trend graph.  

 XY Parameters Check this box when using XY parameters.
For more information, refer to page 9-9.

 X Scale This is valid when [  XY Parameters] is checked.  For more information, 
refer to page 9-11.

Y

Y

Y

Y

X X

X X

Graph origin

RGT direction LFT direction

UP direction DW direction
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*1 When [DEC-/BCD] is selected, the setting at [Code: DEC/BCD] in the [Communication Setting] 
tab window takes effect ([System Setting] → [Device Connection Setting]).

*2 X Axis Data Points

320 × 240 dots: 3 to 320
640 × 480 dots: 3 to 640
800 × 600 dots: 3 to 800
1024 × 768 dots: 3 to 1024

* Do not specify a value larger than the X size (dots) of the selected trend graph part.  Trend 
lines will not be drawn correctly.

*3 “Redraw” and “redraw after clear”
When redrawing, choose either “2. Redraw” or “3. Redraw after clear.”  Note the difference of 
these options.
If the interval between redrawing is too short, the trend graph may not be redrawn even at the 
leading edge.
Data once displayed in the trend graph cannot be changed unless the redrawing command is 
given.

*4 Graph Max. Value, Graph Min. Value, Max. X Scale, Min. X Scale
Do not specify the same value for both [Graph Max. Value] and [Graph Min. Value].  Doing so will 
result in an error.  Be sure to set correctly.

*5 When specifying a memory address (other than [Constant]) for [Graph Max. Value] or [Graph 
Min. Value], the values will be read and displayed at the timing when the graph is displayed or 
when the “redraw” or “redraw after clear” command is executed.

*6 If any value (non-numeric inclusive) specified is outside the range usable on MONITOUCH, the 
value cannot be displayed.  For more information on the allowable range, refer to page 5-15“  
Actual Number (Data with Decimal Floating Point)”.

Maximum plot points = X Axis Data Points

Plot point pitch

The number of plot points: 6
Direction: →

Plot point
Graph origin
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Reference Line

*1 When [DEC-/BCD] is selected, the setting at [Code: DEC/BCD] in the [Communication Setting] 
tab window takes effect ([System Setting] → [Device Connection Setting]).

*2 If any value (non-numeric inclusive) specified is outside the range usable on MONITOUCH, the 
value cannot be displayed.  For more information on the allowable range, refer to page 5-15“  
Actual Number (Data with Decimal Floating Point)”.

Reference Line 1
Reference Line 2
Reference Line 3
Reference Line 4

It is possible to draw a maximum of four horizontal lines for reference on 
the trend graph.
The line type is fixed to a dotted line.
You can specify the line color and the value at which the reference line 
should be displayed.

When specifying a memory address (other than [Constant]) for the value at 
which the reference line should be displayed, the value will be recognized 
at the timing when the graph is displayed or when the “redraw” or “redraw 
after clear” command is executed.

Data Length
(1-Word, 2-Word)

This is valid when a memory address (other than [Constant]) is specified 
for reference lines or scale range.  Choose data length of the specified 
memory address to be used.

Input Type
(DEC-/BCD*1/
FLOAT*2)

Select the code of scale values.

Scale
(Max., Min.)

A scale range can be specified for calculating the position where a 
reference line should be drawn.  Negative values can also be specified.

0 X

Y

Direction: →

(Reference Line 4)

(Reference Line 3)

(Reference Line 2)

(Reference Line 1)
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Reference lines
• When drawing a reference line in the center of a trend graph, make settings as shown below.

[  Reference Line 1]
[Value: 1]
[Scale  Min. 0]
[Scale  Max. 2]

A line is shown in the center.

• Even when [Graph Min. Value] and [Graph Max. Value] for the trend graph is “0” and “1000”, [Scale 
Max.] and [Scale Min.] are used for drawing a reference line.
Thus specifying “0”, “1” and “2” as in the example is appropriate for drawing a reference line.

• When four or more reference lines are required or a grid pattern should be 
displayed:
1) Draw the desired lines or grids on the [Graphic Library Edit] window.
2) Go back to the [Screen Edit] window.
3) Click the trend graph, and click the [Modify Part] icon while handles are 

shown around the graph.
4) The [Modify Part] window is displayed.  Click the [Graphic Call] icon, and place the graphic 

library you created.
5) Close the [Modify Part] window, and go back to the [Screen Edit] window.

2

0

1

Reference line displayed

Max.

Min.
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Style

Color Choose the desired color for the graph area.

 Rectangular Wave When this option is checked, the rectangular wave graph is displayed.

Select a solid line or dotted line for the line type.

Change Part For more information, refer to the Operation Manual.

[ Rectangular Wave] unchecked [  Rectangular Wave] checked
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Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Process Cycle For more information, refer to “Appendix 5  Process Cycle.”

 Link ID When you want to display multiple trend graphs asynchronously or 16 or 
more trend lines in one graph area, check this box.
For more information, refer to page 9-12.

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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 XY Parameters

Choose whether you want to place plot points along the X-axis of trend graph at equal pitches or at 
variable pitches.

[  Use XY Parameters] Unchecked (Default Setting)

An equal pitch is automatically set between the plot points.  MONITOUCH calculates a pitch between 
plot points as shown below.

• Plot point pitch (dots) 
= X size of the trend graph (dots) ÷ ([X Axis Data Points] − 1)
(MONITOUCH adjusts the data so that no remainder will be left.)

Memory allocation
Memory allocation varies depending on the setting for [X Axis Data Points] and [Data Length] for each 
of [  No. 0] to [  No. 15] in the [Graph Setting] field of the [Main] tab window.

For example, in the case of [X Axis Data Points: 11], [Memory: D100] and [Data Length: 1-Word], 
memory addresses D100 to D110 are used.

A

B

C

D

E

F

X0

Y

X size

Plot point pitch

Y
 s

iz
e

Memory setting: n

Word
n + 0 Point 0 data
n + 1 Point 1 data
n + 2 Point 2 data
n + 3 Point 3 data
n + 4 Point 4 data
n + 5 Point 5 data

:
:
:

n + m Point “m” data

Double-word
n + 0 Point 0 data
n + 1
n + 2 Point 1 data
n + 3
n + 4 Point 2 data
n + 5

:
:
:
:
:

n + m Point “m” data
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[  Use XY Parameters] Checked

The pitch between plot points can be set freely.
Pitch data (distance from the graph origin to each plot point) can be specified in units of dots.

Memory allocation
Memory allocation varies depending on the setting for [X Axis Data Points] and [Data Length] for each 
of [  No. 0] to [  No. 15] in the [Graph Setting] field of the [Main] tab window.
Memory for each pitch data is allocated following memory for each plot point.

For example, in the case of [X Axis Data Points: 11], [Memory: D100] and [Data Length: 1-Word], 
memory addresses D100 to D121 are used.

0

1

2

3

4 5

Graph origin

Pitch data

Memory setting: n

Data length: Word
n + 0 Point 0 Trend data
n + 1 Point 0 Pitch data
n + 2 Point 1 Trend data
n + 3 Point 1 Pitch data
n + 4 Point 2 Trend data
n + 5 Point 2 Pitch data

:
:

n + m Point “m” Trend data

Point “m” Pitch data

Data length: Double-word
n + 0 Point 0 Trend data
n + 1
n + 2 Point 0 Pitch data
n + 3
n + 4 Point 1 Trend data
n + 5
n + 6 Point 1 Pitch data
n + 7

:
:
:
:

n + m Point “m” Trend data

Point “m” Pitch data
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[  X Scale] checked
When this box is checked, pitch data from the graph origin can be specified not with dots but using the 
specified scale range.
A scale range can be specified for [Min. X Scale] and [Max. X Scale] of each of [  No. 0] to [  No. 
15] selected in the [Graph Setting] field.

Example:
[  X Scale] unchecked

Example:
[  X Scale] checked
[Min. X Scale]: 0
[Max. X Scale]:  10

Graph origin 0 30 dots

X size: 300 dots

60 dots
120 dots

210 dots
300 dots

Graph origin 0 1

X size: 300 dots

2
4

7
Scale  Max. 10Scale  Min. 0
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Asynchronous Display of Multiple Trend Graphs

Overview

All the trend lines on a trend graph are displayed at the same plot points at the same timing because a 
trend graph has only one control memory.
If you want to display multiple trend lines at an asynchronous timing, you have to select from the item 
list view [Trend Graph] → [Detail] → [  Link ID] (page 9-8).
When this box is checked, you can link two or more overlapping trend graphs while assigning priorities 
to respective control memory.
For example, when drawing two trend graphs as follows:

Control memory: D120
Process cycle: High Speed
ID : 0

(= Parent trend graph)

Control memory: D140
Process cycle: High Speed
Link ID: 0
ID : 1

(= Child trend graph)

3. D140 = K5 (X Axis Data Points)
D120 = H8007
(Redraw after clear & X Axis Data Points)

2. D140 = K9
(X Axis Data Points)

1. D120 = H0009
(X Axis Data Points)

The parent trend graph is drawn up to 9 
plot points.

The child trend graph is drawn up to 9 plot 
points.

Change the number of plot points to 5 
points in the child trend graph, and send 
the change & redraw after clear 
commands from the parent trend graph at 
the same time.
The 5 points of the child trend graph are 
drawn.
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Notes on Setting

• When linking two or more trend graphs, you have to regard one trend graph as a “parent,” and the 
other trend graph as a “child.” 
When setting the child trend graph, check [  Link ID] and specify the same ID as the parent trend 
graph.
Both the redraw & redraw after clear commands at the child trend graph are ignored and only the 
commands from the control memory of the parent trend graph become acceptable.

• [Process Cycle: High Speed] should be specified for all the trend graphs that are linked.
• The area property setting of the parent trend graph becomes valid.  The area property setting of 

the child trend graph is not valid.
In addition, the reference lines set for the child trend graph area ignored.

• Place the child trend graph over the parent trend graph using the [Bring to Top] or [Send to Bottom] 
icon.  If the parent trend graph is placed over the child trend graph, these two graphs will not be 
linked correctly.

Area Property: Blue
(= Parent trend graph)

When the graphs are overlaid, the 
graph area is displayed in blue.

Area Property: Light blue
(= Child trend graph)
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9.2 Trend Sampling (Historical)
Overview

• Data stored in the specified buffering area can be expressed in a trend graph (line graph) or 
rectangular waves.

• A maximum of 16 trend lines can be displayed in one graph area.
• When data is updated, so is the graph in real time.
• Sampling data is saved in the specified buffering area of the V8 series even after the screen 

display has been changed.

• Data is stored at the following two timings:
[Bit Synchronization] method:
Data is stored at the edge of OFF → ON of a designated bit.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

D200

D20116:15:43
16:15:51
16:15:52
16:21:12
16:21:54
16:21:55
17:05:02
17:06:31
18:08:01
18:08:01
19:21:30
19:22:45

(D201)
80
40

290
120
190

75
200
120
280
120
115
120

(D200)
300
250
360
340
360
310
310
320
380
320
360
350

00

400

Graph 
Return

Page 
Up

Page 
Down

Roll 
Up

Roll 
Down

Reset

Menu

Trend Sampling

Buffering Area

Data changes in the PLC 
memory are monitored 
and stored.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

16:15:43
16:15:51
16:15:52
16:21:12
16:21:54

(D201)
80
40

290
120
190

(D200)
300
250
360
340
360

00

400

OFF (0)

ON (1)

1 2 3 4 5
1
2
3
4
5

Trigger bit

(Sampling times)

Buffering area
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[Constant Sampling] method:
Data is stored at regular intervals determined by a counter inside MONITOUCH.

• Sampling data is retained unless the user clears the buffering area.  However, if [DRAM] is 
selected under [Primary storage target] and [None] is selected under [Secondary storage target], it 
is cleared in the following cases: when the power is turned off, when the Main Menu screen is 
displayed or when the RESTART macro command is executed.

• It is possible to arbitrarily show or hide trend sampling graph lines registered with a screen.  
Showing or hiding graph lines can be easily changed as necessary, depending on the operating 
conditions.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

00

400

16:15:40
16:15:45
16:15:50
16:15:55
16:16:00
16:16:05
16:16:10
16:16:15
16:16:20
16:16:25
16:16:30
16:16:35

(D201)
80
40

290
120
190

75
200
120
280
120
115
120

(D200)
300
250
360
340
360
310
310
320
380
320
360
350

Data is read at regular intervals 
(for example, 5-second intervals).

Buffering area

80.9

9.05

46.2

28.0

80.9

9.05

46.2

28.0

ON

ON

ON

ON

ON

ON

OFF

OFF

Temperature A

Temperature B

Temperature C

Temperature D

Trend sampling screen Trend sampling screen

Temperature A

Temperature B

Temperature C

Temperature D
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Configuration

The trend sampling mode components are shown below.

Setting Dialog

Trend Sampling
Main

Buffering Area No. Specify the desired buffering area number to be used for trend sampling.
The buffering area setting determines the trend controlling bit, source data 
address, etc.

Refer to Buffering Status:
When you click here, the [Buffering Area Setting] dialog for the specified 
buffer number is displayed.  It is also possible to make settings for a 
buffering area directly.  For more information, refer to page 9-27.

X Axis Data Points *1
(3 to 1024)

Specify the desired number of plot points along the horizontal axis.

Switch parts

Trend sampling

Data display parts

Count display
Time display
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Graph Setting
(No. 0 to No. 15)

When a number box is checked, the corresponding trend line will be 
displayed.  Press the [Edit] button or double-click on the number when 
setting details of the trend line.

Edit Make settings for the trend line of the number checked in the [Graph 
Setting] field.

Sampling Buffer Word 
No. *2

Specify the ordinal number of the word to be 
referred to for displaying sampling data among 
the words specified for [Word Count] in the 
[Buffering Area Setting] dialog.

Data Length
(1-Word, 2-Word)

Choose data length for one plot point.

Input Type
(DEC-/BCD*3/
FLOAT*4)

Select the code of memory values.
The selection here also applies to [Graph Min. 
Value] and [Graph Max. Value].

Graph Min. Value *5
Graph Max. Value

Specify the graph display area.
(PLC Memory *6, Internal Memory *6, Constant)

Line Graph
(Line type & color)

Check this box when showing lines in the graph.  
Set the line type (from 6 types) and color.

Marker
(Point type & color)

Check this box when showing points in the 
graph.  Set the point type (from 6 types) and 
color.

Batch Setting It is possible to apply the same settings (from [Data Length] to [Graph Max. 
Value] within the [Edit] button) to all the lines of which numbers are 
checked in the [Graph Setting] field.

Direction Choose from [RGT], [LFT], [UP], or [DW] to select the direction for drawing 
the trend graph. 

Y

Y

Y

Y

X X

X X

Graph origin

RGT direction LFT direction

UP direction DW direction
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*1 X Axis Data Points

320 × 240 dots: 3 to 320
640 × 480 dots: 3 to 640
800 × 600 dots: 3 to 800
1024 × 768 dots: 3 to 1024

* Do not specify a value larger than the X size (dots) of the selected trend sampling part.  
Trend lines will not be drawn correctly.

*2 Example: “8” is specified for [Word Count] in the [Buffering Area Setting] dialog.
When you want to sample data of the 3rd word in the buffering area, specify “2” for [Sampling 
Buffer Word No.].

In this example, the same address should be specified for either data length even if the setting 
for [Data Length] in the [Trend Sampling] dialog is not the same.

*3 When [DEC-/BCD] is selected, the setting at [Code: DEC/BCD] in the [Communication Setting] 
tab window takes effect ([System Setting] → [Device Connection Setting]).

*4 If any value (non-numeric inclusive) specified is outside the range usable on MONITOUCH, the 
value cannot be displayed.  For more information on the allowable range, refer to page 5-15“  
Actual Number (Data with Decimal Floating Point)”.

*5 Graph Max. Value, Graph Min. Value
Do not specify the same value for both [Graph Max. Value] and [Graph Min. Value].  Doing so will 
result in an error.  Be sure to set correctly.

*6 When specifying [Graph Max. Value]/[Graph Min. Value] as memory (except [Constant]), the 
graph max./min. values is reflected at the same time when the graph is displayed or the macro 
command “TREND_REFRESH” is executed.
(For more information on the TREND_REFRESH macro command, refer to the Macro Reference 
Manual.)

[Data Length: 1-Word] [Data Length: 2-Word]

Sampling Buffer Word No. Sampling Buffer Word No.

1 word 0 1st word 0

2nd word 1 2nd word

3rd word 2 3rd word 2

4th word 3 4th word

5th word 4 5th word 4

6th word 5 6th word

7th word 6 7th word 6

8th word 7 8th word

Maximum plot points = X Axis Data Points

Plot point pitch

The number of plot points: 6
Direction: →

Plot point
Graph origin
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Reference Line

*1 When a memory address is specified for [Reference Line], when to update the reference line 
depends on [Process Cycle: High Speed].  If [ Use Control Memory] is checked in the [Detail] 
tab window, update depends on the specified processing cycle.

*2 When [DEC-/BCD] is selected, the setting at [Code: DEC/BCD] in the [Communication Setting] 
tab window takes effect ([System Setting] → [Device Connection Setting]).

*3 If any value (non-numeric inclusive) specified is outside the range usable on MONITOUCH, the 
value cannot be displayed.  For more information on the allowable range, refer to “Actual 
Number (Data with Decimal Floating Point)” on page 5-15.

*4 When memory address are specified for [Scale Min.] and [Scale Max.] and the values at the 
addresses are changed in RUN mode, the changes will be reflected to the trend sampling graph 
at the time of graph display or the execution of the macro command “TREND_REFRESH”.  For 
more information on the macro command “TREND_REFRESH”, refer to the Macro Reference 
Manual.

Reference Line 1
Reference Line 2
Reference Line 3
Reference Line 4 *1

It is possible to draw a maximum of four reference lines on the trend 
sampling area.
The line type is fixed to a dotted line.
You can specify the line color and the value at which the reference line 
should be displayed.

Data Length
(1-Word, 2-Word)

This is valid when a memory address (other than [Constant]) is specified 
for reference lines or scale range.  Choose data length of the specified 
memory address to be used.

Input Type
(DEC-/BCD*2/
FLOAT*3)

Select the code of scale values.

Scale*4

(Max., Min.)
A scale range can be specified for calculating the position where a 
reference line should be drawn.  Negative values can also be specified.

0 X

Y

Direction: →

(Reference Line 4)

(Reference Line 3)

(Reference Line 2)

(Reference Line 1)
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• Reference lines
When drawing a reference line in the center of a trend graph, make settings as shown below.

[  Reference Line 1]
[Value: 1]
[Scale  Min. 0]
[Scale  Max. 2]

A line is shown in the center.

* Differently from trend graphs, trend 
sampling cannot be equipped with more 
than four reference lines or vertical 
reference lines.

Style

Color Choose the desired color for the graph area.

 Rectangular Wave When this option is checked, the rectangular wave graph is displayed.

Select a solid line or dotted line for the line type.

 Pen Recorder 
Display

When this option is checked, the pen recorder type graph is displayed.

Change Part For more information, refer to the Operation Manual.

2

0

1

Reference line displayed

Max.

Min.

[ Rectangular Wave] unchecked [  Rectangular Wave] checked

[Direction] RGT
[  Pen Recorder Display] unchecked

[Direction] RGT
[  Pen Recorder Display] checked

• Sampling times < [X Axis Data Points]
The newest data move from left to right.

• Sampling times > [X Axis Data Points]
Newest data at the right

Newest data always at the right

Newest data

Newest data
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Detail

*1 Notes on the use of control memory
• Control memory setting is counted as one of the number of memory locations that is permitted 

for one screen.  For more information on the number of permissible memory locations, refer to 
the Operation Manual.

• Even if all the graph lines are hidden, the switches for [Roll Up], [Roll Down], [+ Block], 
[- Block] and [Graph Return] work.

• Even if all the graph lines are hidden, the position data of the cursor moved with the [Roll Up], 
[Roll Down], [+Block], and [-Block] switches is retained (but the cursor is hidden).

• When graph lines are shown or hidden, flickering associated with graph redrawing will occur 
momentarily.

*2 Read area → V8 Series Reference Manual.
TREND_REFRESH  Macro Reference Manual

Use Control 
Memory  *1
(Word designation)

This memory address is associated with showing or hiding graph line Nos. 
0 - 15.
Each graph line is shown and hidden when the corresponding bit is set 
(ON) and reset (OFF).

Process Cycle
(High Speed, Low 
Speed, Refresh)

Set a cycle to read the control memory. When [Refresh] is selected, the 
graph is redrawn at the leading edge (0 → 1) of bit 15 *2 at “n + 1” in the 
read area or in accordance with the macro command 
TREND_REFRESH *2.

ID Specify the ID.
For more information on the ID, refer to the Operation Manual.

15 . . . . . . . . . . . . . . . . . . 04 03 02 01 00

Graph line No. 0

LSBMSB

Graph line No. 15

Graph line No. 1

Graph line No. 2

Graph line No. 3

1: Show
0: Hide
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Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Trend sampling area and plot points
The V8 series calculates the size of the plot point pitches for drawing a trend line as follows:

Plot point pitch (dots) = X size (dots) ÷ ([X Axis Data Points] − 1)
(The minimum unit of plot point pitch is “1 dot.”)

<Example 1>  Suppose a trend sampling part as shown below:
X size: 270 (dots)
[X Axis Data Points]: 10...

    270 (dots) ÷ (10 − 1) = 30
The plot point pitch is “30”.

* When you adjust the size of a trend sampling part after setting [X Axis Data Points], it is 
automatically enlarged or reduced so that there will be no remainder left.
If the value for [X Axis Data Points] is changed after the trend sampling part is placed and adjusted 
in size, a remainder may be created.  The remainder dots will be shown as a blank area.

<Example 2>  Suppose a trend sampling part as shown below:
X size: 278 (dots)
[X Axis Data Points]: 50...

    278 (dots) ÷ (50 −1) = 5 ... Remainder 33
The plot point pitch is 5 dots and the remainder (33 dots) creates a blank area.

A

B

C

D

E

F

X0

Y

X size

Plot point pitch

Y 
si

ze
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To eliminate a blank area, adjust the trend sampling part size after setting the number of plot 
points (X Axis Data Points).

Switch Parts for Trend Sampling
Applicable switch parts list

Notes on setting
Specify the same ID for switch parts as the one specified in the [Trend Sampling] dialog. 
The ID specified in the [Trend Sampling] dialog can be known from the [Trend Sampling] icon or on the 
[Detail] tab window of the [Trend Sampling] dialog.

To check the ID of each switch part, select [View] → [Display Environment] and check the box for 
[ Display ID Number].  For more information on the ID, refer to the Operation Manual.

Function Contents

Roll Up Scrolls up by one data point toward the most recent entry.  If all data 
cannot be held in the graph, one data point at a time scrolls into view.

Roll Down Scrolls down by one data point toward the oldest entry.  If all data cannot 
be held in the graph, one data point at a time scrolls into view.

+ Block Scrolls up by one page toward the most recent entry.

− Block Scrolls down by one page toward the oldest entry.

Graph Return Returns trend sampling to the most recent one when it is pressed while 
flashing.
Flashing of the [Graph Return] switch is canceled as well as its selection.

Reset When the switch is pressed once, it is turned on.  Pressing it again within 2 
seconds clears the buffering area.  Sampling restarts immediately after 
clearing.
If not pressed again within 2 seconds, the switch is turned off and resetting 
is nullified.

0

Y

XX size

Y
 s

iz
e

Plot point pitch

Blank area

or
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Sampling data display and switch operation
The first page of trend sampling graph is shown from the newest data when the screen equipped with 
trend sampling is displayed.
To allow operators to view data in the buffering area that is not shown on the trend sampling graph, use 
the [Roll Up], [Roll Down], [+ Block], [− Block], and [Graph Return] switch parts.
These switch parts work as described below:

1. Press the [Roll Up], [Roll Down], [+ Block], or [− Block] switch.

2. A dotted vertical line is drawn at the center of the graph.  (This dotted line is called a “cursor.”)
The [Graph Return] switch flashes alternately in ON and OFF colors.

3. When the sampling count display or sampling time display is set for data display parts for trend 
sampling, the count number or the sampling time of the selected data point is indicated. 
(If no data point is selected, the number of sampling times or the last sampling time is indicated.)

4. Pressing the [Graph Return] switch while it is flashing returns the trend sampling data display to 
the most recent data.

* The data specified by the cursor can be displayed in numerals.  Use a macro command in 
this case.  (Macro command “SAMPLE”)
For more information, refer to the Macro Reference Manual.

06-04   11 : 50 : 13Cursor

Graph 
Return Reset

Menu
Trend Sampling

Count: 5
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Data Display Parts for Trend Sampling
Applicable data display parts list

*1 Sampling Count Display

*2 Sampling Time Display

Function Contents

Sampling Count Display *1 The number of sampling times or the ordinal number of the 
selected data point among those sampled can be indicated.

Sampling Time Display *2 This part indicates the last sampling time or that of the selected 
data point. 
Depending on the setting for [Digits] as well as the check box for 
[  Put msec information on logging time] in the [Others] tab 
window for buffering area setting, the sampling time is indicated 
in the following format:

- [  Put msec information on logging time] unchecked:
Less than 8 digits No display
From 8 digits up to 13 digits “hh : mm : ss”
From 14 digits up to 18 digits “MM - DD   hh : mm : ss”
19 digits or greater “YYYY - MM - DD   hh : mm : ss”

- [  Put msec information on logging time] checked:
Less than 8 digits No display
From 8 digits up to 11 digits “hh : mm : ss”
From 12 digits up to 17 digits “hh : mm : ss.xxx” (xxx: msec)
From 18 digits up to 22 digits “MM - DD   hh : mm : ss.xxx” 

(xxx: msec)
23 digits or greater “YYYY - MM - DD   hh : mm : ssss.xxx” 

(xxx: msec)

Sampling Buffer Average Display The average, minimum, maximum, or total value of sampling 
data in the buffering area can be displayed.
Calculation is performed in the V8 series and the result is stored 
in units of doublewords.  Results are stored in the V8 series only, 
and can be displayed on the screen.  For more information, refer 
to page 9-26.

Sampling Buffer Max. Display

Sampling Buffer Min. Display

Sampling Buffer Total Display

99 5

Normal
This number indicates the number of 
data points that have been read for 
trend sampling.

When selected:
This number indicates the ordinal 
number of selected data point 
among sampling data.

06-04   11 : 50 : 13   06-04   11 : 33 : 15

Normal

This is the 
sampling 
time of the 
data point 
that has 
been read 
most 
recently.

When selected:
This is the sampling time 
of the selected data point.

Direction: → Direction: →
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Sampling Buffer Average, Min., Max., and Total Displays

• When the data of [Sampling Buffer Average Display], [Sampling Buffer Max. Display], [Sampling 
Buffer Min. Display], or [Sampling Buffer Total Display] should be displayed, check [  Use a 
Calculation Operation] in the [Buffering Area Setting] dialog for the buffer number specified for 
calculation.  Otherwise, calculation and data display will not be carried out correctly.

• Calculations are performed based on the data obtained from the start of sampling to the present.
When [Overwrite] is chosen for [Full Processing] in the [Buffering Area Setting] dialog, the actually 
calculated result may not be consistent with the result displayed.

• If the result (2 words) overflows after calculation of [Sampling Buffer Average Display] or [Sampling 
Buffer Total Display], correct data may not be obtained.
(Overflow: the state in which data exceeds two words)

• When selecting [Memory Card] for [Secondary storage target] in the [Buffering Area Setting] dialog 
and storing sampling data on a memory card using a card recorder CREC, it will take a longer time 
to change from the STOP → RUN mode if you put a check mark to [  Use a Calculation 
Operation] in the [Buffering Area Setting] dialog.
This situation arises because read operations from the card recorder are performed for calculation.  
During read operation, the message “Sample-Operation Working” is displayed on the screen, and 
bit 15 (sampling calculation) of [I/F Memory] “n” in the [Memory Card Setting] dialog is set (ON).

It will not take much time in read operations when storing sampling data on a CF card without 
using a card recorder.

Notes on setting
Refer to “Notes on setting” for switch parts already described.

782
864
559

5049

The calculated result of data 
for a trend line in a buffering 
area is displayed.

Average
Maximum
Minimum
Total

782

864

559

5049

Data Loading...

It will take a longer time to 
show these results.

At start-up

Average

Maximum

Minimum

Total
Sample data operation
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Buffering Area Setting

When you click [Refer to Buffering Status] on the [Main] tab window of the [Trend Sampling] dialog, the 
setting items for the buffering area number are displayed.

Sampling Method *1 Choose from [Bit Synchronization], [Constant Sampling] and [Device 
Memory Map: PLC n].

Sampling Cycle
(0 to 65535 sec)

Specify the data read cycle.
When “0” is specified, monitoring is executed at every cycle.

Memory Continuous:
The sampling data memory is allocated consecutively in the read area or 
from the specified top address.

Individually:
The memory address for sampling data can be specified.

Select [Continuous] and check this box when specifying a top memory 
address for consecutive allocation.  From the specified top memory 
address, as many words as specified for [Word Count] are allocated for 
data for trend lines.

Example:  [Continuous], [Memory: D100], [Word Count: 4]

Word Count
(1 - 128)

Set the number of words to be read for one sampling.

0

20

40

60

80

100
Sampling Buffer Word No. 
0 = D100

Sampling Buffer Word No. 
1 = D101

Sampling Buffer Word No. 
2 = D102

Sampling Buffer Word No. 
3 = D103
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*1 Sampling methods

[Bit Synchronization] method:
Data is stored at the edge of OFF → ON of a designated bit.

Store Target For more information, refer to “Storage Target (Setting Dialog)” (page A1-
13) in “Appendix 1  Buffering Area.”

Discrete memory/CSV 
format

For more information, refer to “Discrete Memory/CSV Format (Tab 
Window)” (page A1-19) in “Appendix 1  Buffering Area.”

Others For more information, refer to “Others” (page A1-27) in “Appendix 1  
Buffering Area.”

[  Use a Calculation Operation]
Check this option when displaying the average, maximum, minimum or 
total value of data stored in the buffering area on the screen.
For more information, refer to page 9-26.

 Start Bit You can control sampling start, stop, and restart.

When this box is checked, the corresponding bit in the sampling control 
memory area is automatically indicated.

Sampling control memory [U] (bits 03, 07, 11, 15)
ON: Start sampling
OFF: Sampling stop

* For more information on the sampling control memory, refer to page 
A1-9 in “Appendix 1  Buffering Area.”

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

U S R T U S R T U S R T U S R T

Buffer No. 3
Buffer No. 7
Buffer No. 11

n
n+1
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Buffer No. 6
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Buffer No. 1
Buffer No. 5
Buffer No. 9
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Buffer No. 8
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[Constant Sampling] method:
Data is stored at regular intervals determined by a counter inside MONITOUCH.

*2 For the procedure of calculating the size of trend sampling data, refer to “Appendix 1  Buffering 
Area”.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

00

400

16:15:40
16:15:45
16:15:50
16:15:55
16:16:00
16:16:05
16:16:10
16:16:15
16:16:20
16:16:25
16:16:30
16:16:35

(D201)
80
40

290
120
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75
200
120
280
120
115
120

(D200)
300
250
360
340
360
310
310
320
380
320
360
350

Data is read at regular intervals 
(for example, 5-second intervals).

Buffering area
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9.3 Data Sampling (Historical)
Overview

• Data stored in the specified buffering area can be expressed in a numerical data or text form.
• A maximum of 16 pieces of data can be displayed in one display area.
• When data is updated, so is the display in real time.
• Sampling data is saved in the specified buffering area of the V8 series even after the screen 

display has been changed.

• Data is stored at the following two timings:
[Bit Synchronization] method:
Data is stored at the edge of OFF → ON of a designated bit.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

D200

D20116:15:43
16:15:51
16:15:52
16:21:12
16:21:54
16:21:55
17:05:02
17:06:31
18:08:01
18:08:01
19:21:30
19:22:45

(D201)
80
40

290
120
190

75
200
120
280
120
115
120

(D200)
300
250
360
340
360
310
310
320
380
320
360
350

80
40

290
120
190

75
200
120
280
120
115

300
250
360
340
360
310
310
320
380
320
360

Graph 
Return

Page 
Up

Page 
Down

Roll Up Roll 
Down Print Reset

Menu

Data Sampling

Buffering area

Data changes in the PLC 
memory are monitored 
and stored.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

16:15:43
16:15:51
16:15:52
16:21:12
16:21:54

(D201)
80
40

290
120
190

(D200)
300
250
360
340
360

OFF (0)

ON (1)

1 2 3 4 5
1
2
3
4
5

80
40

290
120
190

75
200
120
280
120
115

300
250
360
340
360
310
310
320
380
320
360

Trigger bit

(Sampling times)

Buffering area
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[Constant Sampling] method:
Data is stored at regular intervals determined by a counter inside MONITOUCH.

• Sampling data is retained unless the user clears the buffering area.
• However, if [DRAM] is selected under [Primary storage target] and [None] is selected under 

[Secondary storage target], it is cleared in the following cases: when the power is turned off, when 
the Main Menu screen is displayed or when the macro command “RESTART” is executed.

Configuration

The data sampling mode components are shown below.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

16:15:40
16:15:45
16:15:50
16:15:55
16:16:00
16:16:05
16:16:10
16:16:15
16:16:20
16:16:25
16:16:30
16:16:35

(D201)
80
40

290
120
190

75
200
120
280
120
115
120

(D200)
300
250
360
340
360
310
310
320
380
320
360
350

80
40

290
120
190

75
200
120
280
120
115

300
250
360
340
360
310
310
320
380
320
360

Data is read at regular intervals 
(for example, 5-second intervals).

Buffering area

Switch parts

Data sampling area

Data display parts

Count display Time display

[Data Sampling] icon = 
[Data Sampling] dialog
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Setting Dialog

Data Sampling
Main

Buffering Area No. Specify the desired buffering area number to be used for data sampling.
The buffering area setting determines the data display controlling bit, 
source data address, etc.

Refer to Buffering Status:
When you click here, the [Buffering Area Setting] dialog for the specified 
buffer number is displayed.  It is also possible to make settings for a 
buffering area directly.  For more information, refer to page 9-45.
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Detail

*1 Sample print
For more information, refer to page 9-48.

 Print Command 
Memory

Check this box when specifying a memory address for “sample print” *1.
Specify one word for the command memory.

* Be sure to reset all the bits to “0” except bit 15.

Print Message
(GNo., No.)

When obtaining a “sample print” *1, register the layout and title for printing 
in a message library.
Specify the top line number of the registered message here.

Open:
When you click here, the [Message Edit] window for the specified group 
number is displayed.  It is also possible to edit the message for printing 
directly.  For more information, refer to page 9-49.

Preview:
Click here to check the title image for printing.
For more information on printing, refer to page 9-48.

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Printout command (0 → 1)
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Data Sampling Display Area
Main

Style

 No. 0 to (No. 15) When a number box is checked, the corresponding data will be displayed.  
Press the [Edit] button or double-click on the number when setting details 
of the data.

For the other setting items, refer to page 9-36.

Color Specify the color in the data sampling area.

 Windows Font For more information, refer to the Operation Manual.

Display Language For more information, refer to “Appendix 3  Display Language.”

Change Part For more information, refer to the Operation Manual.
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Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

ID Set the ID in the same way as described for the [Data Sampling] dialog.
For more information on the ID, refer to the Operation Manual.
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Data No. 0 (to No. 15)
Type

Main (for Num. Display)

Num. Display
Char. Display

Choose the desired type.

Sampling Buffer Word 
No. *1

Specify the ordinal number of the word to be referred to for displaying 
sampling data among the words specified for [Word Count] in the 
[Buffering Area Setting] dialog.

Data Length *2
(1-Word, 2-Word)

Set the data length.
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*1 Example: “8” is specified for [Word Count] in the [Buffering Area Setting] dialog.
When you want to sample data of the 3rd word in the buffering area, specify “2” for [Sampling 
Buffer Word No.].

In this example, the same address should be specified for either data length even if the setting 
for [Data Length] in the [Data Sampling] dialog is not the same.

Digits *3 Specify the number of digits for numerical data display.

Decimal Point Specify the decimal place.  When no decimal point is required, set “0”.

 Zero Suppress Check this box when using zero suppression.

When this box is checked, choose either [Flush Left] or [Flush Right].

Display Type *2 Select the format of numbers to be displayed on the screen.
DEC (w/o sign), DEC (w/ −sign), DEC (w/ +/− sign), HEX, OCT, BIN 
(binary)

Input Type Choose the code to be used when reading data from the PLC memory 
address.
The selection here also applies to [Alarm], [Word Operation], and [Scaling].
BCD, DEC, Actual Number*4

Display Function No Function:
Data stored in the buffering area is displayed.

Sampling Count Display:
This is the display type compatible with earlier MONITOUCH models.
For more information, refer to the File Conversion manual provided 
separately.

[Data Length: 1-Word] [Data Length: 2-Word]

Address Address

1st word 0 1st word 0

2nd word 1 2nd word

3rd word 2 3rd word 2

4th word 3 4th word

5th word 4 5th word 4

6th word 5 6th word

7th word 6 7th word 6

8th word 7 8th word

Display Type Digits Decimal Point

DEC 1 to 10 0 to 9

HEX 1 to 8 −

OCT 1 to 11 −

BIN 1 to 32 −

[  Zero Suppress] (flush right) →       123
[  Zero Suppress] → 000123

Space

Flush-left →  123
Flush-right →      123
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*2 Relation between data length and display type

*3 When a value exceeding the set number of digits is keyed in:

*4 If any value (non-numeric inclusive) specified is outside the range usable on MONITOUCH, the 
value cannot be displayed.  For more information on the allowable range, refer to page 5-15“  
Actual Number (Data with Decimal Floating Point)”.

Main (for Char. Display)

Code 1-word Range 2-word Range

DEC (w/o sign) 0 to 65535 0 to 4294967295

DEC (w/ −sign) −32768 to 32767 −2147483648 to 2147483647

DEC (w/ ±sign) −32768 to +32767 −2147483648 to +2147483647

HEX 0 to FFFF 0 to FFFFFFFF

OCT 0 to 177777 0 to 37777777777

BIN 0 to 1111111111111111 0 to 11111111111111111111111111111111

Model DEC HEX/OCT/BIN

Display Overflow display Numbers from the right

Example: Data length:  1 word
Digits:  3
Entered value: 1010

− − − 010

Sampling Buffer Word 
No.

Specify the ordinal number of the word to be referred to for displaying 
sampling data among the words specified for [Word Count] in the 
[Buffering Area Setting] dialog.

No. of Bytes Specify the number of bytes.

Flush Left
Flush Right

Choose either flush-left or flush-right for character display.

Text Process
(LSB → MSB / 
MSB → LSB)

Set the recognition of MSB and LSB in one word.
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Operation/Alarm (for Num. Display)

For more information on the setting items, refer to “5  Data Display.”

Style

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”
Property

Transparent

Character Size
(For numerical data only)
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Switch Parts for Data Sampling
Applicable switch parts list

Notes on setting
Specify the same ID for switch parts as the one specified in the [Data Sampling] dialog. 
The ID specified in the [Data Sampling] dialog can be known from the [Data Sampling] icon or on the 
[Detail] tab window of the [Data Sampling] dialog.

To check the ID of each switch part, select [View] → [Display Environment] and check the box for [  
Display ID Number].  

For more information on the ID, refer to the Operation Manual.

Sampling data display and switch operation
The first page of data sampling is shown from the newest data when the screen equipped with data 
sampling is displayed.
To allow operators to view data in the buffering area that is not shown on the data sampling area, use 
the [Roll Up], [Roll Down], [+ Block], [− Block], and [Graph Return] switch parts.
These switch parts work as described below:

1. Press the [Roll Up], [Roll Down], [+ Block], or [− Block] switch.

Function Contents

Roll Up Scrolls up by one data element toward the most recent entry.  If all data 
elements cannot be held in the area, one data element at a time scrolls into 
view.

Roll Down Scrolls down by one data element toward the oldest entry.  If all data 
elements cannot be held in the area, one data element at a time scrolls into 
view.

+ Block Scrolls up by one page toward the most recent entry.

− Block Scrolls down by one page toward the oldest entry.

Graph Return Returns to the most recent data display when it is pressed while flashing.
Flashing of the [Graph Return] switch is canceled as well as its selection.

Reset When the switch is pressed once, it is turned on.  Pressing it again within 2 
seconds clears the buffering area.  Sampling restarts immediately after 
clearing.
If not pressed again within 2 seconds, the switch is turned off and resetting 
is nullified.

Print All data elements stored in the specified buffer are printed.

or
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2. A line in the center of the area is selected with the cursor.
The [Graph Return] switch flashes alternately in ON and OFF colors.

3. When the sampling count display or sampling time display, described later in “Data Display Parts 
for Trend Sampling”, is set, the count number or the sampling time of the selected data point is 
indicated. 
(If no data element is selected, the number of sampling times or the last sampling time is 
indicated.)

4. Pressing the [Graph Return] switch while it is flashing returns the data sampling display to the 
most recent data.

* The data specified by the cursor can be displayed in numerals.  Use a macro command in 
this case.  (Macro command “SAMPLE”)
For more information, refer to the Macro Reference Manual.

06-04   11 : 50 : 13

102    150    191    250    303    408    515    787 
111    156    196    255    310    410    526    712
108    159    199    254    311    412    533    742
106    145    198    253    312    411    555    798
113    148    188    252    313    407    548    742
111    140    180    251    314    406    521    739
115    153    193    248    315    411    569    746
113    142    183    253    313    403    577    786
118    158    198    248    313    418    598    741

Cursor

Graph 
Return Reset

Menu
Data Sampling

Count: 5
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Data Display Parts for Data Sampling
Applicable data display parts list

*1 Sampling Count Display

Function Contents

Sampling Count Display *1 The number of sampling times or the ordinal number of the 
selected data element among those sampled can be indicated.

Sampling Time Display *2 This part indicates the last sampling time or that of the selected 
data point. 
Depending on the setting for [Digits] as well as the check box for 
[  Put msec information on logging time] in the [Others] tab 
window for buffering area setting, the sampling time is indicated 
in the following format:

- [  Put msec information on logging time] unchecked:
Less than 8 digits No display
From 8 digits up to 13 digits “hh : mm : ss”
From 14 digits up to 18 digits “MM - DD   hh : mm : ss”
19 digits or greater “YYYY - MM - DD   hh : mm : ss”

- [  Put msec information on logging time] checked:
Less than 8 digits No display
From 8 digits up to 11 digits “hh : mm : ss”
From 12 digits up to 17 digits “hh : mm : ss.xxx” (xxx: msec)
From 18 digits up to 22 digits “MM - DD   hh : mm : ss.xxx” 

(xxx: msec)
23 digits or greater “YYYY - MM - DD   hh : mm : 

ssss.xxx” (xxx: msec)

Sampling Buffer Average Display The average, minimum, maximum, or total value of sampling 
data in the buffering area can be displayed.
Calculation is performed in the V8 series and the result is stored 
in units of doublewords.  Results are stored in the V8 series 
only, and can be displayed on the screen.  For more information, 
refer to page 9-43.

Sampling Buffer Max. Display

Sampling Buffer Min. Display

Sampling Buffer Total Display

5 2

102    150    191    250    303    408    515
111    156    196    255    310    410    526
108    159    199    254    311    412    533
106    145    198    253    312    411    555
113    148    188    252    313    407    548

102    150    191    250    303    408    515
111    156    196    255    310    410    526
108    159    199    254    311    412    533
106    145    198    253    312    411    555
113    148    188    252    313    407    548

Normal
This number indicates the number of 
data elements that have been read 
for data sampling.

When selected:
This number indicates the ordinal 
number of selected data element 
among sampling data.
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*2 Sampling Time Display

Sampling Buffer Average, Min., Max., and Total Displays

• When the data of [Sampling Buffer Average Display], [Sampling Buffer Max. Display], [Sampling 
Buffer Min. Display], or [Sampling Buffer Total Display] should be displayed, check [  Use a 
Calculation Operation] in the [Buffering Area Setting] dialog for the buffer number specified for 
calculation.  Otherwise, calculation and data display will not be carried out correctly.

• Calculations are performed based on the data obtained from the start of sampling to the present.
When [Overwrite] is chosen for [Full Processing] in the [Buffering Area Setting] dialog, the actually 
calculated result may not be consistent with the result displayed.

• If the result (2 words) overflows after calculation of [Sampling Buffer Average Display] or [Sampling 
Buffer Total Display], correct data may not be obtained.
(Overflow: the state in which data exceeds two words)

• When selecting [Memory Card] for [Secondary storage target] in the [Buffering Area Setting] dialog 
and storing sampling data on a memory card using a card recorder CREC, it will take a longer time 
to change from the STOP → RUN mode if you put a check mark to [  Use a Calculation 
Operation] in the [Buffering Area Setting] dialog.

• This situation arises because read operations from the card recorder are performed for calculation.  
During read operation, the message “Sample-Operation Working” is displayed on the screen, and 
bit 15 (sampling calculation) of [I/F Memory] “n” in the [Memory Card Setting] dialog is set (ON).

06-04   11 : 50 : 13 06-04   11 : 33 : 15

102    150    191    250    303    408    515
111    156    196    255    310    410    526
108    159    199    254    311    412    533
106    145    198    253    312    411    555
113    148    188    252    313    407    548

102    150    191    250    303    408    515
111    156    196    255    310    410    526
108    159    199    254    311    412    533
106    145    198    253    312    411    555
113    148    188    252    313    407    548

Normal

This is the sampling time of the data 
element that has been read most recently.

When selected:

This is the sampling time of 
the selected data element.

102    150    191    250    303    408    515
111    156    196    255    310    410    526
108    159    199    254    311    412    533
106    145    198    253    312    411    555
113    148    188    252    313    407    548

106
113
102
540

The calculated result of data for a trend 
line in a buffering area is displayed.

Average
Maximum
Minimum
Total
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It will not take much time in read operations when storing sampling data on a CF card without 
using a card reader.

Notes on setting
Refer to “Notes on setting” for switch parts already described.

782

864

559

5049

Data Loadding...

It will take a longer 
time to show these 
results.

At start-up

Average
Maximum
Minimum
Total

Sample data operation
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Buffering Area Setting

When you click [Refer to Buffering Status] on the [Main] tab window of the [Data Sampling] dialog, the 
setting items for the buffering area number are displayed.

Sampling Method *1 Choose from [Bit Synchronization], [Constant Sampling] and [Device 
Memory Map: PLC n].

Sampling Cycle
(0 to 65535 sec)

Specify the data read cycle.
When “0” is specified, monitoring is executed at every cycle.

Memory Continuous:
The sampling data memory is allocated consecutively in the read area or 
from the specified top address.

Individually:
The memory address for sampling data can be specified.

Select [Continuous] and check this box when specifying a top memory 
address for consecutive allocation.  From the specified top memory 
address, as many words as specified for [Word Count] are allocated for 
data for trend lines.

Example:  [Continuous], [Memory: D100], [Word Count: 4]

80
40

290
120
190

75
200
120
280
120

300
250
360
340
360
310
310
320
380
320

480
540
590
420
390
675
500
420
480
520

1300
1250
1360
1340
1360
1310
1310
1320
1380
1320

Sampling Buffer Word No. 3 = D103

Sampling Buffer Word No. 2 = D102

Sampling Buffer Word No. 1 = D101

Sampling Buffer Word No. 0 = D100
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*1 Sampling methods

[Bit Synchronization] method:
Data is stored at the edge of OFF → ON of a designated bit.

Word Count
(1 - 128)

Set the number of words to be read for one sampling.

Store Target For more information, refer to “Storage Target (Setting Dialog)” (page A1-
13) in “Appendix 1  Buffering Area.”

Discrete memory/CSV 
format

For more information, refer to “Discrete Memory/CSV Format (Tab 
Window)” (page A1-19) in “Appendix 1  Buffering Area.”

Others For more information, refer to “Others” (page A1-27) in “Appendix 1  
Buffering Area.”

[  Use a Calculation Operation]
Check this option when displaying the average, maximum, minimum or 
total value of data stored in the buffering area on the screen.
For more information, refer to page 9-26.

 Start Bit You can control sampling start, stop, and restart.

When this box is checked, the corresponding bit in the sampling control 
memory area is automatically indicated.

Sampling control memory [U] (bits 03, 07, 11, 15)
ON: Start sampling
OFF: Sampling stop

* For more information on the sampling control memory, refer to page 
A1-9 in “Appendix 1  Buffering Area.”

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

U S R T U S R T U S R T U S R T

Buffer No. 3
Buffer No. 7
Buffer No. 11

n
n+1
n+2

Buffer No. 2
Buffer No. 6

Buffer No. 10

Buffer No. 1
Buffer No. 5
Buffer No. 9

Buffer No. 0
Buffer No. 4
Buffer No. 8

Sampling control memory

LSBMSB

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

16:15:43
16:15:51
16:15:52
16:21:12
16:21:54

(D201)
80
40

290
120
190

(D200)
300
250
360
340
360

OFF (0)

ON (1)

1 2 3 4 5
1
2
3
4
5

80
40

290
120
190

75
200
120
280
120
115

300
250
360
340
360
310
310
320
380
320
360

Trigger bit

(Sampling times)

Buffering area
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[Constant Sampling] method:
Data is stored at regular intervals determined by a counter inside MONITOUCH.

*2 For the procedure of calculating the size of trend sampling data, refer to “Appendix 1  Buffering 
Area”.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

16:15:40
16:15:45
16:15:50
16:15:55
16:16:00
16:16:05
16:16:10
16:16:15
16:16:20
16:16:25
16:16:30
16:16:35

(D201)
80
40

290
120
190

75
200
120
280
120
115
120

(D200)
300
250
360
340
360
310
310
320
380
320
360
350

80
40

290
120
190

75
200
120
280
120
115

300
250
360
340
360
310
310
320
380
320
360

Data is read at regular intervals 
(for example, 5-second intervals).

Buffering area
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Sample Print

Overview

The function that prints sampling data stored in the buffering area is called the “sample print” function.

* For more information on printing, such as compatible printers or print setting procedure, refer to 
“16  Print.”

Methods

There are two methods for printing sampling data.

• Switch
When the [Function: Sample: Print] switch is pressed, a sample print is carried out.

• Print command memory
The setting shown below is required on the [Data Sampling] dialog.

 Print Command 
Memory
(Detail)

When this box is checked, one word is allocated for the command 
memory.
Only bit 15 is used.

* Be sure to reset all the bits to “0” except bit 15.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

07-20   16:15:43
07-20   16:15:51
07-20   16:15:52
07-20   16:21:12
07-20   16:21:54
07-20   16:21:55
07-20   17:05:02
07-20   17:06:31
07-20   18:08:01
07-20   18:08:01
07-20   19:21:30
07-20   19:22:45

80
40

290
120
190

75
200
120
280
120
115
120

300
250
360
340
360
310
310
320
380
320
360
350

07-20   16:15:43
07-20   16:15:51
07-20   16:15:52
07-20   16:21:12
07-20   16:21:54
07-20   16:21:55
07-20   17:05:02
07-20   17:06:31
07-20   18:08:01
07-20   18:08:01
07-20   19:21:30
07-20   19:22:45

No. 2
80
40

290
120
190

75
200
120
280
120
115
120

No. 1
300
250
360
340
360
310
310
320
380
320
360
350

1
2
3
4
5
6
7
8
9
10
11
12

Buffering area

Print

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Print command 
memory “n”

Printout command (0 → 1)
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Registering Print Message
Setting position
[Data Sampling] dialog → [Detail] → [Print Message]

Register a print message in the position shown above.
For more information on the message editing procedure, refer to the Operation Manual.

Data to be registered
• The top line in the specified print message denotes a header.

If you want to use two or more lines for a header, insert one-byte “¥” at the end of the line.  The 
next line is recognized as a part of the header.  Of course, “¥” is not printed.

• On the line following the header, specify the positions to indicate count, time, and sampling data.
Use one-byte characters “C,” “T,” and “0” to “15”.

Alignment of C, T and 0 to 15 depends on the formats set for [Sampling Count Display], 
[Sampling Time Display] and [Data Sampling]. 
If [  Zero Suppress] and [Flush Right] are selected for these parts, the values are printed with 
the lowest digit in alignment.
If [  Zero Suppress] and [Flush Left] are selected for these parts, the values are printed with the 
highest digit in alignment; if [  Zero Suppress] is not checked, the values are printed without 
zero suppression.

• The header is printed on top of each page.

* Even when [C] and [T] are registered in the print message, the count and the time are not 
printed if [Sampling Count Display] and [Sampling Time Display] are not placed on a 
screen.

C: Sampling count print position

T: Sampling time print position 

0 to 15: Data No. 0 to 15 print positions

C

0

T

0

0

12345

1

12345

[Zero Suppress] checked
[Flush Left]
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Registration example
[Print Message] Message GNo. 2 :  No. 0
[  Zero Suppress] unchecked
[Flush Left]

C T 0 1  2   3

1
2
3
4

50

06-04 13:14:20
06-04 13:34:20
06-04 13:54:20
06-04 13:74:20

06-04 15:14:20

1234
2457
1240
4563

9997

4562
2346
6548
7683

8764

 1111
 3464
 5648
 6713

 8127

  224
  456
  984
  777

  265

No. 1          No. 2         No. 3          No. 4

No. 1          No. 2         No. 3          No. 4

It is printed as shown below.

Message GNo. 2 editing

Title

Print position

Sampling
Count Time

--- Line 1 --- --- Line 2 ---\

Sampling
Count Time

--- Line 1 --- --- Line 2 ---
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10 Alarming
10.1 Bit Order Alarming (Real Time)

Overview

• This is the function for displaying or erasing messages on the screen by setting or resetting bits.  
When multiple bits are set, the messages are displayed in order of precedence (see page 10-4).

• If multiple bits are set and the applicable messages are not held in the display area on the screen, 
the messages can scroll up and down using the [Roll Up] and [Roll Down] switches.

• When a bit is reset, the corresponding message disappears from the screen, and other messages 
are moved up.

• A detailed display (= alarm sub-display) for a message of “bit order alarming” can be displayed at 
the same time.  The alarm sub-display can be either in text or graphics (pictures).  For each bit of 
bit order alarming data, a maximum of four alarm sub-displays can be connected.  (Refer to “10.2  
Alarm Sub Display.”)

D100D100

B B B B B B
C C C C C C

A A A A A A

D D D D D D

B B B B B B
C C C C C C

A A A A A A

D D D D D D

B B B B B B

PLC PLC Bits 0, 2 and 3 of D100 are ON.Bit 1 of D100 is ON.

Press the [Roll Up] switch. Hidden messages come into view.

B B B B B B
C C C C C C

A A A A A A B B B B B B
C C C C C C

When the bit is OFF, the message (“AAAAAA” in the example) disappears, and the 
consecutive lines are moved up.

A B C

Bit order alarming

Detailed information for the 
above message (textual)

Detailed information for the 
above message (pictorial)

Tank A Error !
Tank B Error !
Tank C Error !

An error is detected in 
tank C.
Stop the machine and 
check around the tank.
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• Also, it is possible to use a screen for alarm sub-display.
(Refer to “Calling Screens from Messages (Screen Call)” on page 10-13.)

• When display errors which are currently occurring not in order of precedence, but in order of 
occurrence, use “time order alarming.”  For more information, refer to “10.5  Time Order Alarming 
(Real Time).”

Configuration

The bit order alarming components are shown below.

0000
0000
0000
0000
0000
0000

Messages are displayed when corresponding 
bits in the PLC memory are ON.

Bring up a screen related to the 
message (example: Line B data).

Among the displayed messages, 
press on the desired message.

Line A data

Line B data

Line D data

Line G data

Line B data

No. 1 Servo
No. 2 Servo
No. 3 Servo
No. 1 Motor
No. 2 Motor
No. 3 Motor

[Bit Order Alarming] 
icon = [Bit Order 
Alarming] dialog

[Roll Up], [Roll Down] switch parts

Display area
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Setting Dialog

Bit Order Alarming
Main

Memory Specify the command memory address used to display a registered 
message on the screen.
Memory addresses are automatically allocated to the messages bit by bit 
as many as [Executing Relays] (see below) from the specified top memory 
address.

Example:  Memory: M10, Executing Relays: 5

Start Message
(GNo., No.) *1

Specify the group number and message (line) number of the top message 
among the messages registered on the [Message Edit] window which you 
want to display for bit order alarming.

Open:
When you click here, the [Message Edit] window for the specified group 
number is displayed.  It is also possible to edit the message for bit order 
alarming directly.  For more information, refer to page 10-8.

Executing Relays
(1 to 4096)

Specify the number of alarms (total number of bits for assigning messages) 
to be used for bit order alarming. 

No. of Lines per Relay
(1 to 24)

This option is active when [Display Area] is chosen for [Action Area].
Specify the number of lines to be linked with one alarm (= one bit) on the 
display area part.

M10
M11
M12
M13
M14

Tank A Error !
Tank B Error !
Tank C Error !
Tank D Error !
Tank E Error !

Five messages are assigned to 
memory addresses from M10.
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*1 Precedence in displaying messages *2

Precedence is assigned to the messages displayed by bit order alarming.  Based on the memory 
bits assigned, the smaller the bit number is, the higher precedence is given; the larger the bit 
number, the lower its precedence.  When messages are displayed on the screen, those of higher 
precedence are displayed first.

*2 Precedence
There is another way to display messages in the order of occurrence instead of precedence.  
This is called “time order alarming.” 
For more information, refer to “10.5  Time Order Alarming (Real Time).”

*3 Action Area
When selecting each option, the screen image changes as shown below.

Action Area *3
(Display Area, Switch, 
Lamp)

Choose from [Display Area], [Switch] or [Lamp] for specifying the place 
where the message should be displayed on the screen when the 
corresponding bit is set or reset.

Display Area:
Shows messages on display area parts placed on the screen.

Switch:
Shows messages on switch parts placed on the screen.
Place the [Function: Mode] switch part.  Each switch part has an auxiliary 
item [Display Order] and when using this item you can specify which 
alarm message should be displayed on which switch.  When you set the 
same number for [Display Order] of all the switch parts, the messages 
are displayed in the order in which the switch parts were placed.

Lamp:
Shows messages on lamp parts placed on the screen.
Place the [Function: Mode] lamp part.  As with switch parts, each lamp 
part has an auxiliary item [Display Order].

M10
M11
M12
M22
M23
M24

Tank A Error !
Tank B Error !
Tank C Error !
Line A Stop
Line B Stop
Line C Stop

Precedence  High

Low

Example:

A A A A A A
B B B B B B
C C C C C C
D D D D D D
R R R R R R
T T T T T T

A A A A A A
B B B B B B
C C C C C C
D D D D D D
R R R R R R
T T T T T T

A A A A A A B B B B B B
C C C C C C D D D D D D
R R R R R R T T T T T T

[Action Area: Display Area]

[Action Area: Switch] or [Action Area: Lamp]
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Sub-action

Type
(None, Sub-Display, 
Screen Call, 
Acknowledge Display, 
Ladder Monitor)

None:
Choose [None] when using bit order alarming only.

Sub-Display:
Choose this option when you want to relate a supplemental display to a 
one-bit alarm message.
Set an alarm sub-display to be linked.
For more information, refer to page 10-15.

Screen Call:
Choose this option when you want to call up a screen (for detailed 
information, for example) related to a one-bit alarm message that is 
displayed.
Select [Registration Item] → [Screen Block] and edit the screen to be 
linked.
For more information, refer to page 10-13.

Acknowledge Display:
This option is valid when [Switch] or [Lamp] is chosen for [Action Area] on 
the [Main] tab window.
Select this option when using the acknowledge function.
(However, note that, if the acknowledge function is used for bit order 
alarming, acknowledged information will be cleared when the screen 
display is changed.  Please heed this information and use the function 
effectively.)
For more information on the acknowledge function, refer to 
“Acknowledge Display Function” on page 10-89.

Ladder Monitor:
This option is displayed when the ladder monitor is used.
For more information, refer to the V8 Series Ladder Monitor 
Specifications.

Screen Block When [Screen Call] is chosen for [Sub-action], this option becomes active.  
Specify the top screen block number corresponding to the alarm message.
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Style

*1 When [Switch] or [Lamp] is chosen for [Action Area] on the [Main] tab window, [Enlarge] is fixed 
to “1”.

Detail

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”

Property

Transparent

Enlarge *1

Point

 Windows Font For more information, refer to the Operation Manual.

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”
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 Relay Info. Output 
Memory

Choose whether or not data of the message displayed or selected for bit 
order alarming should be output to the PLC.
If you want to output data, check the box, and specify the desired top 
memory address.

When outputting:  Relay Info. Output Memory (top memory address “n”)
Memory addresses are allocated as shown below.

n: Total number of ON alarms
The number of bits currently set to ON is written.

n + 1: Selected alarm number
[Sub-action: Sub-Display]

The order of precedence of the alarm message among those being 
displayed (starting from #1 having precedence) is output.

[Sub-action: None]
The order of precedence (starting from “1”) of the top message among 
those displayed is output.

n + 2: ON alarm number
[Sub-action: Sub-Display]

The ordinal number of the message selected with the cursor among 
those displayed by bit order alarming (regarding the start message 
number as “0”) is written.

[Sub-action: None]
The ordinal number (regarding the start message number as “0”) of the 
top message among those displayed is output.

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

Relay Info. Output Memory Contents

n Total number of ON alarms

n + 1 Selected alarm number

n + 2 ON alarm number 

A A A A A A
B B B B B B
GGGGGG
OOOOOO
X X X X X X

In order of precedence:

First:
Second:
Third:
Fourth:
Fifth:

n + 1 = 4

B B B B B B
GGGGGG
J J J J J J
NNNNNN
OOOOOO

a a a a a a
b b b b b b
c c c c c c
A A A A A A
B B B B B B
CCCCCC
DDDDDD
E E E E E E
F F F F F F
GGGGGG
HHHHHH
I I I I I I
J J J J J J
K K K K K K
L L L L L L
MMMMMM
NNNNNN
OOOOOO
P P P P P P

First:
6th:
9th:

13th:
14th:

n + 2 = 13

Target alarms

Zeroth:
First:

Second:
Third:

Fourth:
Fifth:
6th:
7th:
8th:
9th:

10th:
11th:
12th:
13th:
14th:

Start message
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Registering messages
There are two ways of registering messages.

• [Bit Order Alarming] dialog → [Main] tab window → [Open]

• [Registration Item] → [Message] → [Group No.] designation

In the [Message Edit] window, line numbers denote absolute addresses as default.
If designating a line number for bit order alarming, select [Display] → [Display Absolute Address as 
Line Number] and remove the check from this menu item before commencing editing.

For more information on the editing procedure in the [Message Edit] window, refer to the Operation 
Manual.
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Display Area
Style

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Color Specify the color in the display area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified the [Bit Order Alarming] dialog.
For more information on the ID, refer to the Operation Manual.
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Checking the display area size
You can check on the screen that alarm messages can be displayed on the display areas as you 
intended.

When you have registered messages, select [View] → [Display Environment] → [Display] tab, check 
the box for [  Display Message].

The registered messages are displayed on the screen.

For more information on size adjustment, etc., refer to the Operation Manual.
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[Roll Up], [Roll Down] Switch Parts

These switch parts are used for scrolling up and down the messages when all the messages cannot be 
held in the display area.
This section describes the settings essential for bit order alarming.

Main

Detail

Function Choose either [Roll Up] or [Roll Down].

ID Set the same ID as specified the [Bit Order Alarming] dialog.
For more information on the ID, refer to the Operation Manual.
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Switch / Lamp (for Display Area)

Messages can be displayed on switches or lamps instead of display areas.
This section describes the switch and lamp settings that are indispensable.

Main

Detail

Sub-Display

For more information on the motion that is made by selecting [Sub-action] tab window → [Sub-action: 
Sub-Display], refer to “10.2  Alarm Sub Display.”

Function Choose [Mode].

Display Order (0 - 23):
Specify the order of displaying the message when multiple [Mode] switches 
or lamps are placed.

* One switch or lamp part shows one message line.

ID Set the same ID as specified the [Bit Order Alarming] dialog.
For more information on the ID, refer to the Operation Manual.
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Calling Screens from Messages (Screen Call)

Overview

• Register associated content of an alarm message to be displayed in advance.
When an alarm message is selected, the screen containing associated content is displayed.  This 
function is called the “screen call” function.
You can create, register, and call up more detailed content on the screen.

• Screens to be called up are ordinary screen displays equipped with parts and items.  Therefore, 
you can create a supplementary display using as many functions as desired.

0000
0000
0000
0000
0000
0000

Messages are displayed when corresponding 
bits in the PLC memory are ON.

Bring up a screen related to the 
message (example: Line B data).

Among the displayed messages, 
press the desired message.

Line A data

Line B data

Line D data

Line G data

Line B data

No. 1 Servo
No. 2 Servo
No. 3 Servo
No. 1 Motor
No. 2 Motor
No. 3 Motor

No. 1    000
No. 2    000
No. 3    000
No. 4    000

A B C

Control Panel Emergency Stop
Line E Target
Tank C Error !

Control Panel Emergency Stop Tank C Error ! Line E Target

The EMERGENCY 
STOP button on the 
control panel is 
pressed.
Check and reset the 
button.
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Notes on Setting Bit Order Alarming

*1 Switch function of display area part
When you have shown an alarm message in the display area through the screen call function, 
the display area part is automatically furnished with the switch function.
When you directly press the location where the message is displayed, the screen call function is 
activated and the screen changes.

Screen Block
Overview
When [Type: Screen Call] is chosen on the [Sub-action] tab window of the [Bit Order Alarming] dialog, 
screen blocks must be specified.  

• A group of supplementary screen displays should be prepared for bit order alarming.  These 
screen displays are re-organized into the order of alarm message registration, which are called 
“screen blocks.” Thus, screen blocks for supplementary displays are assigned to alarm messages 
in order.

• Screens used for [Screen Block] can be equipped with the same functions that are available with 
ordinary screens.
However, when using message mode (using [Page Block] or [Direct Block]), graphic mode, or the 
data block area mode on the screen, you must set the top number of the corresponding message, 
graphic, or data block for each alarm message. 

Editing procedure
For more information, refer to the Operation Manual.

Action Area (Main) This option is valid when [Display Area] *1 or [Switch] is chosen.

Type (Sub-action) Choose [Screen Call].

Screen Block (Sub-action) This setting is required when [Screen Call] is chosen for [Type].  
Specify the top block number (corresponding to the top message for 
bit order alarming) from which “screen blocks” should be started.

0000
0000
0000
0000
0000
0000

Line A data

Line B data

Line D data

Line G data

Line B data

No. 1 Servo
No. 2 Servo
No. 3 Servo
No. 1 Motor
No. 2 Motor
No. 3 Motor
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10.2 Alarm Sub Display
Overview

• It is possible to link messages that are displayed by setting bits (= bit order alarming) with a 
detailed explanation using the alarm sub-display function.

• Alarm sub-displays must be used together with bit order alarming.
Text or graphics can be called up from one-bit alarm message for bit order alarming.  For example, 
this function is useful for displaying a detailed explanation or illustrations corresponding to an 
alarm message.

• A maximum of four sub-displays can be set up for one bit of data.
Therefore, supplemental explanations, additional messages or easy-to-see graphics can be 
displayed at one time.

Configuration

The alarm sub-display components are shown below.

A B C
Message displayed 
by bit order alarming

Detailed information 
for an alarm message 
(pictorial) = alarm sub-
display

Tank A Error !
Tank B Error !
Tank C Error !

A B C

Message displayed by bit 
order alarming

Detailed information 
for an alarm message 
(pictorial)

Tank A Error !
Tank B Error !
Tank C Error !

Detailed information 
for an alarm message 
(textual)

An error is detected at 
tank C.
Stop the machine and 
check around the tank.

[Alarm Sub Display] 
icon = [Alarm Sub 
Display] dialog

[Roll Up], [Roll Down] 
switch parts

Display area
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Setting Dialog

Alarm Sub Display
Main

*1 For more information on the editing procedure of page blocks, direct blocks or graphic libraries, 
refer to the Operation Manual.

Link ID The [Alarm Sub Display] dialog can only work when it is linked with the 
[Bit Order Alarming] dialog.
Set the same ID as specified in the [Bit Order Alarming] dialog.  With 
this setting, the alarm sub-display is linked with bit order alarming.

Block
(Page Block, Direct 
Block, Graphic Library) *1

Choose a form of sub-display from the following options:

Page Block:
Use [Page Block] to display messages.

Direct Block:
Use [Direct Block] to display messages.

Graphic Library:
Use [Graphic Library] to display graphics.

Block No. This option becomes active when [Page Block] or [Direct Block] is 
chosen for [Block].
Specify the top block number of page or direct blocks to be used.  This 
top block number corresponds to the top message number for bit order 
alarming.  The later blocks correspond to the alarm messages 
consecutively.

When you click [Open], the block edit window is opened.

Graphic Library This option becomes active when [Graphic Library] is chosen for 
[Block].
Set the group number and the graphic number of the top graphic.
This top graphic number corresponds to the top message number for bit 
order alarming.  The later graphics correspond to the alarm messages 
consecutively.

When you click [Open], the graphic library edit window is opened.
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Style

Detail

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”

Property

Transparent

Enlarge

Point

 Windows Font For more information, refer to the Operation Manual.

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Display Area
Style

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Color Specify the color in the display area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified the [Alarm Sub Display] dialog.
For more information on the ID, refer to the Operation Manual.



10.2 Alarm Sub Display

10-19

10

[Roll Up], [Roll Down] Switch Parts

These switch parts are used for scrolling up and down the messages when all the messages cannot be 
held in the display area.
This section describes the settings essential for alarm sub-display.

Main

Detail

Function Choose either [Roll Up] or [Roll Down].

ID Set the same ID as specified the [Alarm Sub Display] dialog.
For more information on the ID, refer to the Operation Manual.
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Notes on Setting Bit Order Alarming

Note the following points when setting the [Bit Order Alarming] dialog.

*1 Switch function of display area part
When an alarm message is shown in the display area, it is necessary to choose a 1-bit alarm 
message with the cursor to call up an alarm sub-display.  With the V8 series, the switch function 
is automatically furnished to the display area part.  Thus, if you directly press the place where the 
message is displayed, the cursor will move to that location.  (You can also make a selection 
using the roll-up/roll-down switches.)

Action Area (Main) This option is valid when [Display Area]*1 or [Switch] is chosen.

Type (Sub-action) Choose [Sub-Display]. 
The message displayed by bit order alarming is equipped with alarm sub-
display as a sub-action.

Tank A Error !
Tank B Error !
Tank C Error !

An error is detected at 
tank C.
Stop the machine and 
check around the tank.

(Bit order alarming) (Alarm sub-display)
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10.3 Alarm Tracking (Historical)
Overview

• Messages triggered by bit ON/OFF operation as well as time information are stored in the buffering 
area and are displayed as historical data on the screen.

• The occurrence time and reset time are displayed in one line.

• It is also possible to make calculations to determine time lag, frequency of occurrence, total time, 
etc.

PLC
F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

D200-00

D200-01

D200-02

D200-03

D200-04

D200-05

D200-06

DWUP -+ DELRET RESET

Menu

                                           16:15:43     16:21:12
                                           16:15:51     16:21:54
                                           16:15:52     16:21:55
                                           17:05:02     18:08:01
                                           17:06:31     18:08:01
                                           19:21:30     21:09:44
                                           19:22:45     21:10:22

16:15:43
16:15:51
16:15:52
16:21:12
16:21:54
16:21:55
17:05:02
17:06:31
18:08:01
18:08:01
19:21:30
19:22:45
21:09:44
21:10:22

#2 Roller error
#1 Sensor error
#1 Roller error
#2 Sensor error
#3 Sensor error
#5 Roller error
#4 Sensor error

#2 Roller error
#1 Sensor error
#1 Roller error
#2 Roller error reset
#1 Sensor error reset
#1 Roller error reset
#2 Sensor error
#3 Sensor error
#2 Sensor error reset
#3 Sensor error reset
#5 Roller error
#4 Sensor error
#5 Roller error reset
#4 Sensor error reset

Alarm Tracking

Buffering area

Data changes in the PLC memory are 
monitored and stored.

 02/11/15   16:15:43 02/11/15   16:21:12 
 99/11/15   16:15:51
 99/11/15   16:15:52

If an error is not reset, an asterisk (∗) is 
displayed instead of the time.

Occurrence time Reset time

#2 Roller error
#1 Sensor error
#2 Sensor error

 
 000:00:08
 000:00:01

The alarm occurrence time lag is displayed.

Time lag display

#2 Roller error
#1 Sensor error
#2 Sensor error
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• It is possible to display errors with distinction between the “primary cause” and “others.”
When monitoring bit ON/OFF operation, you will notice that the setting of a bit (primary cause) 
causes secondary and tertiary bits to be set as well.  When this occurs, it is possible to distinguish 
the bit that was set first and those that were set afterwards.  Thus, you can identify the source bit 
that causes the error.

Example: When a belt conveyor error occurs:

By marking the primary cause with an asterisk (∗) when the error messages are displayed, you 
can distinguish the primary cause error from the other errors.

ON

OFF

OFF

OFF

It is possible to distinguish between error No. 1 and other errors.

Normal operation bit (* will be OFF when an error occurs)

Bit for error No. 2

Bit for error No. 3

Bit for error No. 1 (primary cause)

ON

OFF

OFF

OFF

S
A1 A2 A3

2. #1 Sensor error 3. #2 Sensor error

(Moving direction)

1. #2 Roller error (primary cause) = conveyor stop Errors 2 and 3 are triggered by error 1.  In this case, error 1 
is called “primary cause.”

To show the above in a circuit diagram ...

S: Normal operation bit (* will be OFF when an error occurs)

A1: Bit for #2 roller error (primary cause)

A2: Bit for #1 sensor error

A3: Bit for #2 sensor error

 02/11/15   16:15:43
 02/11/15   16:15:51
 02/11/15   16:15:52Primary cause mark

#2 Roller error
#1 Sensor error
#2 Sensor error
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• It is possible to choose whether or not to save the message in the buffer depending on the 
importance of the message.
This is useful when messages by other alarming methods are displayed together.  (Refer to page 
10-49.)

• Messages can be deleted by pressing the [DEL] key.
The deleted message is retained in the buffer as historical data.  (Refer to page 10-32.)

• Information about the alarm information (operation result) in auto operation time or operation rate 
is stored in MONITOUCH internal memory using a macro command.  (Refer to page 10-47.)

• Acknowledge function
The time errors are acknowledged can be displayed through the acknowledge switch.  (Refer to 
page 10-41.)

• Parameter display
In the event of an alarm, the data associated with its occurrence can be displayed together with the 
alarm message.  Logging the history of such alarm-relevant data will make it easier to locate and 
investigate the causes of alarms.  (Refer to page 10-37.)

DWUP -+ DELRET RESETDisplay
Change

              02/11/15   16:15:43  02/11/15   16:21:12
              02/11/15   16:15:51  02/11/15   16:21:54
              02/11/15   16:15:52  02/11/15   16:21:55

Occurrence time Reset time

When the [DEL] key is pressed, the 
selected message is deleted.

#2 Roller error
#1 Sensor error
#2 Sensor error

08:30:45 
10:45:18  10:51:32 

#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

08:30:45 
10:45:18  10:51:32 

#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

11:32:01 
11:32:01  

Occurren

All messages change to the colors for 
acknowledgment, showing the alarm 
acknowledged times.

Reset Acknowle Occurren Reset Acknowle

Selective Acknowle Selective Acknowle

Press the [Acknowledge All] switch.

Alarm display example when [Record Parameters] is not checked

Temperature rise of Tank-A 08/ 9/24    8:12:40
Lack of materials 08/ 9/24  15:15:43
Worker change 08/ 9/24  17:00:00
Abnormality of conveyor A-Line 08/ 9/24  19:59:15
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Configuration

The alarm tracking components are shown below.

Alarm display example when [Record Parameters] is checked

Temperature rise of Tank-A  65 degree 11/ 9/26  16:01:04
Lack of materials  80 g 11/ 9/26  16:01:04
Worker change Worker: YAMADA -> SATO 11/ 9/26  16:01:04
Abnormality of conveyor A-Line 11/ 9/26  16:01:04

[Alarm Tracking] icon 
= [Alarm Tracking] dialog

Switch parts

Display area
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Setting Dialog

Alarm Tracking
Main

Buffering Area No. Specify the desired buffering area number to be used for alarm tracking.  
(Refer to page 10-33.)
The buffering area setting determines the alarm controlling bit, error bit, 
etc.

Refer to Buffering Status:
When you click here, the [Buffering Area Setting] dialog for the 
specified buffer number is displayed.  It is also possible to make 
settings for a buffering area directly.  For more information, refer to 
page 10-33.

Start Message
GNo. (0 to 127)

Specify the group number of the top message among the messages 
registered on the [Message Edit] window which you want to display for 
alarm tracking.

Open:
When you click here, the [Message Edit] window for the specified 
group number is displayed.  It is also possible to edit the message for 
alarm tracking directly.  For more information, refer to page 10-29.

History Display *1

(Time of Occurrence, 
Occurrence/Cancellation 
Time, Time Lag Display, 
Total Frequency of 
Occurrence Display, 
Total Time of Occurrence 
Display, Time of 
Occurrence Display)

Time information attached to an error message varies depending on the 
mode selected.
For [Time Lag Display], [Total Time of Occurrence Display] and [Time of 
Occurrence Display], the time is displayed in units of hours.

* These options [Occurrence/Confirmation Time] and [Occurrence/
Cancellation/Confirmation Time] are added when [  Add Time 
Order Alarming] and [  Acknowledge function] or [  Alarm 
Acknowledge function] is checked in the [Others] tab window in the 
[Buffering Area Setting] dialog.

 Date Display This option is valid for [Time of Occurrence] or [Occurrence/Cancellation 
Time].
When it is checked, the date is indicated with the time.

 Year 4-digit Display This option is valid when [  Date Display] is checked and the Christian 
Era calendar is selected.
Check the box when showing the year using four digits.
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*1 History display types

 Zero Suppress for 
Year

This option is valid when [  Date Display] is checked and the year 
display is selected.
Check the box when showing the year with zero suppression.

 Zero Suppress for 
Month-Day

This option is valid when [  Date Display] is checked.
Check the box when showing the month and date with zero suppression.

 Time Display This option is valid for [Time of Occurrence], [Occurrence/Cancellation 
Time], [Occurrence/Confirmation Time] or [Occurrence/Cancellation/
Confirmation Time].
When it is checked, the time is indicated.
For [Time Lag Display], [Total Time of Occurrence Display] or [Time of 
Occurrence Display], [Time Display] automatically becomes valid.  
Choose either [100:30] (hour : minute) or [100:30:20] (hour : minute : 
second).

Display Order
(Ascending Order, 
Descending Order)

The meaning of “display order” varies depending on what is selected for 
[History Display]. 

Ascending Order:
When [Time of Occurrence], [Occurrence/Cancellation Time], [Time 
Lag Display], [Occurrence/Confirmation Time] or [Occurrence/
Cancellation/Confirmation Time] is selected, older errors are displayed 
at the top and recently occurring errors are displayed at the bottom.
When [Total Frequency of Occurrence Display] or [Total Time of 
Occurrence Display] is selected, smaller totals are displayed at the top 
and larger totals are displayed at the bottom.

Descending Order:
When [Time of Occurrence], [Occurrence/Cancellation Time], [Time 
Lag Display], [Occurrence/Confirmation Time] or [Occurrence/
Cancellation/Confirmation Time] is selected, recently occurring errors 
are displayed at the top and older errors are displayed at the bottom.
When [Total Frequency of Occurrence Display] or [Total Time of 
Occurrence Display] is selected, larger totals are displayed at the top 
and smaller totals are displayed at the bottom.

 Acknowledge 
function

Check this box when using the acknowledge function.
For the acknowledge function, refer to page 10-41.

 02/11/15   16:15:43 02/11/15   16:21:12 
 99/11/15   16:15:51
 99/11/15   16:15:52

If an error is not reset, an asterisk (∗) is 
displayed instead of the time.

Occurrence time

[Occurrence/Cancellation Time]
Reset time

#2 Roller error
#1 Sensor error
#2 Sensor error

Supplementary information:
If data becomes lost while an error is occurring due to power shut-off or removal of the card from 
the secondary store target, “- - - - - - - - - - - - -” will be displayed for the cancellation time.

 
 000:00:08
 000:00:01

The alarm occurrence time lag is displayed.

[Time Lag Display]
Time lag display

#2 Roller error
#1 Sensor error
#2 Sensor error
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Style

* [Enlarge X] and [Enlarge Y] are fixed to “1”.

 1
 3
 5

[Total Frequency of Occurrence Display]
Total frequency of occurrence display

Errors that occur less frequently are displayed at the top and errors that occur 
more frequently are displayed at the bottom.
Errors with the same frequency are displayed in order of occurrence with the 
most recent one at the top.

#2 Sensor error
#1 Sensor error
#2 Roller error

 000:00:41
 000:00:42
  000:00:50

[Total Time of Occurrence Display]
Total time of occurrence display

The total length of time when each error is occurring is displayed.
Errors that occur for a short time are displayed at the top and errors that occur 
for a long time are displayed at the bottom.
Errors of the same total time are displayed in order of occurrence with the 
most recent one at the top.

#2 Sensor error
#1 Sensor error
#2 Roller error

  000:01:50
  000:00:42

[Time of Occurrence Display]
Time of occurrence display

The length of time when each error is occurring is displayed.
Errors are displayed in order of occurrence with the most recent one at the top.

#2 Roller error
#1 Sensor error
#2 Sensor error

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”Property

Transparent

 Windows Font For more information, refer to the Operation Manual.

 The data is 
displayed by 8 
points.

When this box is checked, the date and time are displayed in point size 8.
This setting is usable only when [Gothic font] or [Stroke font] is selected in 
the [Font Setting] dialog, and also [   Windows Font] is checked.
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Detail

 Only Primary 
Cause Display

Check this option when displaying the primary cause error (refer to page 
10-22) only.

 Primary Cause 
Mark Display

When this is checked, the primary cause error is marked at the left with an 
asterisk (∗).

 Screen Display When this box is checked, a screen number can be specified.  The 
specified screen number is linked to a message consecutively from the top 
message of [Message GNo.] set on the [Buffering Area Setting] dialog. 
When an error occurs and you touch the displayed error message, the 
screen changes to the linked screen number.
This function is useful for giving a detailed explanation of the error 
contents.

 Display switching 
button (date/time 
format)

Check this box when changing the time and date with the display switching 
button.
You need to set [Date Display] and [Time Display] in the [Main] tab window.

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

DWUP -+ RET

                              16:15:43  16:21:12
                             16:15:51  16:21:54
                             16:15:52  16:21:55

Set [Screen No. 5].

Press “#2 Sensor error” 
that is the second message 
from the top message.

Screen No. 6 that is the 
second screen from 
screen No. 5 is displayed.

#2 Sensor error
#1 Sensor error
#2 Roller error

#1 Sensor error



10.3 Alarm Tracking (Historical)

10-29

10

Registering messages
There are two ways of registering messages.

• [Alarm Tracking] dialog → [Main] tab window → [Open]

• [Registration Item] → [Message] → [Group No.] designation

• [Buffering Area Setting] → [Discrete memory/CSF format] tab window

For more information on the editing procedure in the [Message Edit] window, refer to the Operation 
Manual.

Double-click on a 
cell under 
“Message”.
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Display Area
Style

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Color Specify the color in the display area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified in the [Alarm Tracking] dialog.
For more information on the ID, refer to the Operation Manual.
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Checking the display area size
You can check on the screen that alarm messages can be displayed on the display areas as you 
intended.

When you have registered messages, select [View] → [Display Environment] → [Display] tab, check 
the box for [  Display Message].

The registered messages are displayed on the screen.

For more information on size adjustment, etc., refer to the Operation Manual.
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Switch Parts for Alarm Tracking
Applicable switch parts list

Notes on setting
Specify the same ID for switch parts as the one specified in the [Alarm Tracking] dialog. 
The ID specified in the [Alarm Tracking] dialog can be known from the [Alarm Tracking] icon or on the 
[Detail] tab window of the [Alarm Tracking] dialog.

To check the ID of each switch part, select [View] → [Display Environment] and check the box for [  
Display ID Number].  

For more information on the ID, refer to the Operation Manual.

Function Contents

Standard Roll Up Scrolls up by one data element.  If all data elements cannot be held 
in the area, one data element at a time scrolls into view.

Roll Down Scrolls down by one data element.  If all data elements cannot be 
held in the area, one data element at a time scrolls into view.

+Block Scrolls up by one page.

-Block Scrolls down by one page.

Reset When the switch is pressed once, it is activated.  Pressing it again 
within 2 seconds clears the buffering area.
Sampling restarts immediately after clearing.
If not pressed again within 2 seconds, the switch is turned off and 
resetting is nullified.

Sample Graph Return Returns to the most recent alarm tracking display when it is pressed 
while flashing.
Flashing of the [Graph Return] switch is canceled as well as its 
selection.

Display Change-
over

This switch is valid when [Date Only] or [Time Only] is selected for 
[Calendar Condition].
Pressing this switch changes between the date display and the time 
display.

Change Display 
Order

Changes over data display order: in ascending order or descending 
order.

Acknowledge 
(selective 
acknowledge)

Acknowledges the selected and unacknowledged messages only.
This switch becomes active when the acknowledge function is 
selected.

Acknowledge 
(acknowledge all)

Acknowledges all unacknowledged messages.
This switch becomes active when the acknowledge function is 
selected.

Entry DELETE Deletes the alarm message selected by the cursor.
Only valid when [Time of Occurrence] or [Occurrence/Cancellation 
Time] is selected for [History Display].

or
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Buffering Area Setting

When you click [Refer to Buffering Status] on the [Main] tab window of the [Alarm Tracking] dialog, the 
setting items for the buffering area number are displayed.

Sampling Method Select [Alarm Tracking].

Sampling Cycle
(0 - 65535 sec)

Specify the data read cycle.
When “0” is specified, monitoring is executed at every cycle.

Memory Continuous:
The sampling data memory is allocated consecutively in the read area or 
from the specified top address.

Individually:
The memory address for sampling data can be specified.

Select [Continuous] and check this box when specifying a top memory 
address for consecutive allocation.  From the message specified for [Start 
Message GNo./No.] on the [Discrete memory/CSV format], as many words 
as specified for [Word Count] are allocated for alarm messages.

Example: [Continuous], [Memory: D100], [Word Count: 1]
[Start Message GNo.: 3 and No.: 0]

Word Count
(1 - 1024)

Specify the number of error bits to be monitored in units of 16 bits (in units 
of words).

= D100-00
= D100-01
= D100-02
= D100-03
= D100-04
= D100-05
= D100-06
= D100-07
= D100-08
= D100-09
= D100-10
= D100-11
= D100-12
= D100-13
= D100-14
= D100-15

AAAAAA
BBBBBB
CCCCCC
DDDDDD
EEEEEE
FFFFFF
GGGGGG
HHHHHH
IIIIII
JJJJJJ
KKKKKK
LLLLLL
MMMMMM
NNNNNN
OOOOOO
PPPPPP
QQQQQQ

Message No. 3

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8
No. 9
No. 10
No. 11
No. 12
No. 13
No. 14
No. 15

As many messages as word 
count are assigned.
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*1 For the procedure of calculating the size of alarm tracking data, refer to “Appendix 1  Buffering 
Area” (page A1-15).

Store Target For more information, refer to “Storage Target (Setting Dialog)” (page A1-
13) in “Appendix 1  Buffering Area.”

No. of Samples
Specify the number of bit ON/OFF operations to be retained as historical 
data.
An occurrence is regarded as one bit operation and a reset is also 
regarded as one bit operation; therefore, to keep one error bit change as 
historical data, “2” should be set at minimum.
* Note that if the value set for [No. of Samples] is less than the display 

area size, messages may not be displayed correctly.

Discrete memory/CSV 
format

For more information, refer to “Discrete Memory/CSV Format (Tab 
Window)” (page A1-19) in “Appendix 1  Buffering Area.”

Others For more information, refer to “Others” (page A1-27) in “Appendix 1  
Buffering Area.”

Start Bit This is valid only when [Alarm Tracking] is selected for [Sampling Method].
You can control start and stop of monitoring the bits for sampling.

When this box is not checked, alarm tracking is always active.
When this box is checked, alarm tracking is not performed even if the 
alarm bit is set to ON or reset to OFF unless the bit specified for [Start Bit] 
(bit 03, 07, 11, 15 of sampling control memory) is set to ON.

* For more information on the sampling control memory, refer to 
“Appendix 1  Buffering Area” (page A1-9).

Reset Bit Display the bit information for each buffer in the sampling control memory.
* For more information on the sampling control memory, refer to 

“Appendix 1  Buffering Area” (page A1-9).
Trigger Bit

Normal Operation Bit

              05/07/15   16:15:43  05/07/15   16:21:12
              05/07/15   16:15:51  05/07/15   16:21:54
              05/07/15   16:15:52  05/07/15   16:21:55
              05/07/15   17:05:02  05/07/15   18:08:01
              05/07/15   17:06:31  05/07/15   18:08:01
              05/07/15   19:21:30  05/07/15   21:09:44
              05/07/15   19:22:45  05/07/15   21:10:22

#2 Roller error
#1 Sensor error
#1 Roller error
#2 Sensor error
#3 Sensor error
#5 Roller error
#4 Sensor error

Example:  When the display area can hold 7 lines:

7 lines × 2 (occurrence and reset) = 14

When [No. of Samples] ≤ 14, alarm tracking cannot be displayed correctly.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

U S R T U S R T U S R T U S R T

Buffer No. 3
Buffer No. 7
Buffer No. 11

n
n+1
n+2

Buffer No. 2
Buffer No. 6

Buffer No. 10

Buffer No. 1
Buffer No. 5
Buffer No. 9

Buffer No. 0
Buffer No. 4
Buffer No. 8

Sampling control memory

LSBMSB
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Alarm Tracking Sequence

Example:  With the settings shown below:
[Read area: D00000]  [Write area: D00050]

[Buffer No.: 0]
[Sampling Method: Alarm Function]
[Word Count: 3]

When [  Start Bit] is checked:

1. With [  Start Bit] checked, alarm tracking is started when this bit is set to ON.
Set [Start Bit] (= D00003-03) of the sampling control memory to ON.

When the buffer number is “0”, the sampling bit is bit 3 of read area “n + 3”.
Read area n + 3 = D00000 + 3 = D00003
Therefore, it will be “D00003-03”.

2. Set the error bit.
With buffer No. 0 and [  Memory Designation], error bits are assigned to read area “n + 4” and 
later consecutively.

n
n + 1
n + 2
n + 3
n + 4
n + 5
n + 6
n + 7

D00000
D00001
D00002
D00003
D00004
D00005
D00006
D00007

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

U S R T U S R T U S R T U S R T

MSB LSB

Read area

Read area

Sampling control memory * = D00003

Memory for alarm 
tracking

* For more information on the sampling control 
memory, refer to “Appendix 1  Buffering Area” on 
page A1-9.

Buffer No. 0Buffer No. 1Buffer No. 2Buffer No. 3

D00003-03
ON

D00004-00

Sampling bit

Top error bit

Monitoring start

n
n + 1
n + 2
n + 3
n + 4
n + 5
n + 6
n + 7

D00000
D00001
D00002
D00003
D00004
D00005
D00006
D00007

Read area

Read area

Sampling control memory

Memory for alarm tracking = D00004-00 to D00006-15

D00003-03

ON

D00004-00

Sampling bit

Top error bit

An error occurs.
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To enable detection of the primary cause, normal operation time or operation rate, set the normal 
operation bit (D00003-2) at the start of operation, and reset the normal operation bit (D00003-2) 
when an error bit comes ON.
If it is not required to detect the time, the normal operation bit need not be set and reset.
(However, in this case, alarm tracking is always working so communications may be delayed.)

3. An alarm message is displayed on the screen.

D00003-03

ON

D00004-00

Sampling bit

Top error bit

An error occurs.

OFF

D00003-02

Normal operation bit

DWUP -+ DELRET RESETDisplay
Change

              02/11/15   16:15:43#2 Roller error
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Parameter Display Function

Overview

In the event of an alarm, the data (parameters) associated with its occurrence can be displayed 
together with the alarm message.  Logging the history of such alarm-relevant data will help you locate 
and investigate the causes of alarms.

    Example: An alarm on September 24 
Temperature control memory D2 PV value 65°C
PLC memory D100 Staff: Sato
PLC memory R0 Material 80 g

Touch!!

YAMADA SATO

MJ1

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

65.0

A B

Thermal error!

Material shortage!

The corresponding alarm bit is set (ON).

Staff change

Temperature rise of Tank-A  65 degree 08/ 9/24    8:12:40

Worker change Worker: YAMADA → SATO 08/ 9/24  17:00:00

Lack of materials  80 g 08/ 9/24  15:15:43

Abnormality of conveyor A-Line 08/ 9/24  19:59:15
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Setting Items

This section explains the settings required for showing parameters together with alarm messages.  For 
more information on other setting items, refer to page 10-25.

Buffering area setting
• Others

• Discrete memory/CSV format

Record Parameters Check this box.

Word Count The necessary number of words is automatically calculated from 
the [Parameter] settings in the [Discrete memory/CSV format] tab 
window.

Parameter
(Yes, None)

Select either option for each message.  Double-clicking the cell under 
[Parameter] calls up the [Parameter Table] dialog.
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• Parameter table

The items which can be set vary with the selection under [Display Type].

No. Parameter Nos. 0 to 7
A maximum of eight parameters can be registered.

Memory Specify the memory address assigned to the parameter.

Display Type Numerical Data: This option is for the display of data at the memory 
address.

Text: This option is for the display of text set at the 
memory address.

Message No.: This option is for the display of a message according 
to a designated message number (absolute address) 
that is already registered.

Bit: When the bit is set (ON), the message specified 
under [Message No.] is displayed.  When the bit is 
reset (OFF), the next message (corresponding to the 
number of [Message No.] plus one) is displayed.

Data Length Specify the length of the data stored at the address set under [Memory].
1-Word, 2-Word

Input Format Select the code to be used at the time of data reading.
DEC, BCD, FLOAT

Display Format Select the format of the data to be displayed.
DEC (w/o sign), DEC (w/ -sign), DEC (w/ +/- sign), HEX, OCT, BIN 
(binary), FLOAT

Digits Specify the number of digits.
1 to 32

Decimal Point Specify the number of decimal places.  When no decimal point is required, 
set “0”.
0 to 31

Zero Suppress Select whether to execute zero suppress.
(Example: 5-digit numeral display  123;  without zero suppress: 00123)

Message G No. 
and Message No.

Specify the message G number and message number you wish to display.
Message GNo. 0 to 127, Message No. 0 to 255

Char. Place Select either flush right or flush left for text display.
Flush Right, Flush Left

Selected line

Shows the selected message. Adds a new parameter.

Moves the selection one line above the currently selected line.

Deletes the selected parameter.

Moves the selection one line below the 
currently selected line.
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Message edit
Parameter numbers can be added to the individual alarm messages.

* To review parameter numbers (0 to 7), go to [Buffering Area Setting] → [Discrete memory/CSV 
format] → [Parameter] → [Parameter Table] → [No.].

Limitations

• When the parameter settings have been made with Windows fonts, parameter symbols (%PxS) 
are shown as they are in the alarm messages to be displayed.

• For parameter Nos. 0 to 7 specified in the [Parameter Table] dialog, the maximum allowable 
number of words is 128 (automatically calculated*).  Be sure to use 128 or fewer words in total.

* To see the number of words used, check “Record Parameters” in “Buffering area setting” on page 10-38.

• In the event of a failure to read parameter memory, “****” is displayed in place of the parameter in 
the message.

• If [Message No.] is selected for [Display Type] in the [Parameter Table] dialog and if the 
corresponding message includes parameter symbols, the symbols “%PxS” appear as they are 
when the message is displayed.

• If [Total Frequency of Occurrence Display] or [Total Time of Occurrence Display] is selected for 
alarm history display, the parameter symbols in alarm messages are displayed as “****”.

• If changes are made to the data in the [Parameter Table] dialog, such as the number of 
parameters, the order of parameters, or the assigned memory addresses, after the execution of 
data sampling and then if screen data transfer is performed in this condition, the data previously 
sampled may not be displayed correctly on the screen.  Whenever any changes as mentioned 
above have been made, formatting is required before sampling start.

• When [Occurrence/Cancellation Time] is selected for alarm history display, the parameters will not 
be displayed for alarm bit reset (OFF) conditions.

Letter Counts Specify the number of characters.
1 to 127

Text Process Set the recognition of MSB and LSB in one word.
LSB → MSB, MSB → LSB

%PxS
Denotes a parameter No. 0 to 7 registered in the [Parameter Table] dialog.
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Acknowledge Function

Overview

In the event of an alarm, the data associated with its occurrence, such as when the alarm was caused 
and reset, can be displayed together with the alarm message.  Through the use of the acknowledge 
switch, the time at which the alarm was acknowledged can also be displayed.  Additionally, a 
distinction between acknowledged and unacknowledged messages is drawn on the display of alarm 
messages.

• The [Acknowledge All] switch enables you to acknowledge all alarm messages and show their 
acknowledged times.

• The [Selective Acknowledge] switch enables you to acknowledge the selected alarm message and 
show its acknowledged time.

08:30:45 
10:45:18  10:51:32 

#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

08:30:45 
10:45:18  10:51:32 

#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

11:32:01 
11:32:01  

Occurrence 
time

All messages turn to the colors for 
acknowledgment, showing the alarm 
acknowledged times.

Reset 
time

Acknowledged 
time

Occurrence 
time

Reset 
time

Acknowledged 
time

Selective 
Acknowledge

Acknowledge 
All

Selective 
Acknowledge

Acknowledge 
All

Press the [Acknowledge All] switch.

10:51:32 
#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

08:30:45 
10:45:18  10:51:32 

#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

11:32:01 
11:32:01  

08:30:45 
10:45:18  

Occurrence 
time

The selected message turns to the 
color for acknowledgement, showing 
the acknowledged time.

Reset 
time

Acknowledged 
time

Occurrence 
time

Reset 
time

Acknowledged 
time

Select a message with the scroll 
switch and press the [Selective 
Acknowledge] switch.

Selective 
Acknowledge

Acknowledge 
All

Selective 
Acknowledge

Acknowledge 
All
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Setting Items

This section explains the settings required for the acknowledge function.  For more information on 
other setting items, refer to page 10-25.

Alarm tracking
• Main

 Acknowledge 
function

Check this box.

History Display *1 Select an option for time information you wish to display with alarm 
messages.

When [  Acknowledge function] is checked, the options [Occurrence/
Confirmation Time] and [Occurrence/Cancellation/Confirmation Time] 
become additionally selectable.

*1 [History Display] options

09/ 2/ 2    08:30:45 
09/ 2/ 2    10:45:18  
09/ 2/ 8    12:11:03
09/ 2/ 9    00:17:58

09/ 2/ 2    11:34:00
09/ 2/ 2    11:34:00 

#2 Roller error
#1 Sensor error
#2 Sensor error
#1 Roller error

[Occurrence/Confirmation Time]

Acknowledged timeOccurrence time

When alarm messages are unacknowledged, 
asterisks ∗ are displayed in their time fields.

09/ 2/ 2   08:30:45 
09/ 2/ 2   10:45:18  
09/ 2/ 8   12:11:03
09/ 2/ 9   00:17:58

09/ 2/ 2   10:51:32 

09/ 2/ 9   00:22:15

09/ 2/ 2   11:34:00
09/ 2/ 2   11:34:00 

#2 Roller error
#1 Sensor error
#2 Sensor error
#1 Roller error

When there are alarms which are not reset yet, 
asterisks ∗ are displayed in their time fields.

Occurrence time

[Occurrence/Cancellation/Confirmation Time]

Acknowledged timeReset time

When alarm messages are unacknowledged, 
asterisks ∗ are displayed in their time fields.
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• Style

Color Setting*1

(Unacknowledged 
Occurring/
Unacknowledged After 
Reset, Acknowledge 
Occurring/
Acknowledge After 
Reset)

Four colors can be set to display alarm messages, depending on their 
status.

Unacknowledged Occurring *2:
Select a color used to display an occurring alarm, for which the 
acknowledge switch is not pressed yet.

Unacknowledged After Reset:
Select a color used to display a reset alarm, for which the 
acknowledge switch is not pressed yet.

Acknowledge Occurring:
Select a color used to display an occurring alarm, for which the 
acknowledge switch is already pressed.

Acknowledge After Reset:
Select a color used to display a reset alarm, for which the 
acknowledge switch is already pressed.

*1 This is settable when [  Acknowledge function] is checked in the [Main] tab window.
*2 This is not settable if [  Windows Font] is checked.

The color selected in the [Message Edit] window takes effect instead.
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Buffering area setting
• Others

Acknowledge switch
Place an acknowledge switch and set the dialog below.

• Main

 Alarm Acknowledge 
function

Check this box.
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• Detail

Function Contents

Sample Acknowledge Alarm acknowledged times can be displayed in the alarm tracking 
area.

Selective Acknowledge:
This switch acknowledges the unacknowledged alarm message 
currently selected.

Acknowledge All:
This switch acknowledges all unacknowledged alarm messages.

ID
(0 to 255)

Set the same number as the ID number of the alarm tracking item.
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Example

When the acknowledge function is used, the message and time display can have the following four 
conditions:

As an example, the following colors are selected for the message and time display.
A: An alarm is occurring but the acknowledge switch is not pressed yet:  black
B: An alarm is reset but the acknowledge switch is not pressed yet:  green
C: An alarm is occurring and the acknowledge switch is pressed:  red
D: An alarm is reset and the acknowledge switch is pressed:  blue

If an alarm occurs and the [Acknowledge All] switch is not pressed, the alarm message is displayed in 
black.  When the alarm is reset afterwards, the message turns green.

When the [Acknowledge All] switch is pressed, the color of the occurring alarm message changes from 
black to red.
The message of the reset error in green turns blue.

Limitations

• A displayable alarm acknowledged time ranges from the time of alarm occurrence until the time 
65,535 seconds (approximately 18 hours) at the maximum elapse.  If the acknowledge switch is 
pressed after a lapse of 65,535 seconds or longer, the time to be displayed then is the time of 
occurrence plus 65,535 seconds.

• If there is an occurring alarm, for which the acknowledge switch is not pressed yet, and if 
[Occurrence/Cancellation/Confirmation Time] has already been selected for [History Display], the 
alarm reset and acknowledged times will be displayed as “-----” at the time of rebooting the V8 unit 
or change to the Main Menu screen.  Even if the acknowledge switch is pressed in this state, the 
acknowledged time is not displayed.

1

0

1

0

08:30:45 
10:45:18  10:51:32 

#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

Alarm occurring but the 
acknowledge switch not 
pressed for it
Alarm reset but the 
acknowledge switch not 
pressed for it

(black)
#2 Roller error

Acknowledge 
All

#1 Sensor error 
occurrence and 
reset

(green)

1

0

1

0

08:30:45 
10:45:18  10:51:32 

#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

11:32:01 
11:32:01  

Alarm occurring and the 
acknowledge switch 
pressed for it
Alarm reset and the 
acknowledge switch 
pressed for it

(red)

(blue)

              ↑ 
[Acknowledge All] switch pressed

← [Acknowledge All] 
switch

Acknowledge 
All
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Other Functions

Using System Memory ($s)
System memory ($s) list

* A macro command “SET_BUFNo” must be executed to output the information above (except for 
$s456 and $s458) into system memory.

(1) Auto operation time ($s436, 437)
= normal operation bit set time & sampling bit set time

(2) Auto operation stop time ($s438, 439)
= normal operation bit reset time & sampling bit set time

(3) Total time of operation
= (1) + (2)

(4) Rate of operation ($s443)
= (1)/(3) × 100
* (A decimal point value to the first position is entered for $s443.)

Example: $s443 = The rate of operation for 585 is [58.5].
(5) Program stop time ($s440, 441)

= Sampling bit reset time

* It is recommended that you use the [Time Display] item to display the time (1) to (5) on the screen.
(Refer to the explanation below.)

Address ($s) Contents

436 Auto operation time (L)

437 Auto operation time (H)

438 Auto operation stop time (L)

439 Auto operation stop time (H)

440 Program stop time (L)

441 Program stop time (H)

442 Number of stops (8)

443 Rate of operation (XX.X) (4)

456 Buffer No. 0 to 11 Normal operation bit (6)

457

458 Buffer No. 0 to 11 Sampling bit (7)

(1)

(2)

(5)

(S)

OFF

(U)
OFF

U2

OFF T1 T2 T3 T4
t1 t2

U1 U3

(1) = T1 + T2 + T3 + T4
(2) = t1 + t2
(3) = (1) + (2)
(4) = (1) / (3) × 100
(5) = U1 + U2 + U3

Error bit

Sampling monitoring Sampling monitoring

Sampling bit

Normal operation bit
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(6)    Buffer No. 0 to 11 Normal operation bit ($s456)
The normal operation bit status of buffer numbers 0 to 11 is written.

(7)    Buffer Nos. 0 to 11 Sampling bit ($s458)
The sampling bit status of buffer numbers 0 to 11 is written.

(8)    Number of stops ($s442)
The number of stops (normal operation bit OFF) during sampling is written.

Display method using the [Time Display] item
When using the [Time Display] item, the time information stored in the system memory ($s) can easily 
be displayed for alarm tracking.  Make settings as shown below.

* Example of [Time Display] item
When the SET_BUFNo macro command is executed, set $s438 (auto operation stop time) = 5320.

Setting for [Time Display] item
[Display Mode]:  Display Seconds in Timer Format
[Memory]:  $s438 (to 439) = auto operation stop time
[Time Display]:  100:30:20

When the time is displayed with the above settings, “$s438 = 001:28:40” is shown.
You can see that the auto operation time is 1 hour 28 minutes 40 seconds.

Display Mode
(Main)

Choose [Display Seconds in Timer Format].

Memory
(Main)

Specify the address where seconds data is stored.
Two words are allocated from the top memory address consecutively.
The data range that can be stored is from 0 to 3599999 seconds (= 
999:59:59).

 Time Display
(Main)

This is checked (cannot be unchecked).
Select [100:30] (hour : minute) or [100:30:20].

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 S S S S S S S S S S S S

$s456

MSB LSB

No. 11
No. 10

No. 9
No. 8

No. 7
No. 6

No. 1
No. 2

No. 3
No. 4

No. 5

Buffer No. 0

Normal 
operation bit

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 U U U U U U U U U U U U

$s458

MSB LSB

No. 11
No. 10

No. 9
No. 8

No. 7
No. 6

No. 1
No. 2

No. 3
No. 4

No. 5

Buffer No. 0

Sampling bit
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Sorting Out by Importance of Alarm Messages
Overview
It is possible to sort out messages according to the importance of each message.

Setting procedure
Select [Registration Item] → [Message Edit] window.  Then select [Display] → [Alarm] to change the 
display.

Clicking on the icon at the extreme left 
determines whether each message should be 
retained in memory or not.  (Refer to the figure 
on the right.)

For more information on the editing and setting 
procedure, refer to the Operation Manual.

              05/07/15   16:15:43  05/07/15   16:21:12
              05/07/15   16:15:51  05/07/15   16:21:54
              05/07/15   16:15:52  05/07/15   16:21:55
              05/07/15   17:05:02  05/07/15   18:08:01
              05/07/15   17:06:31  05/07/15   18:08:01
              05/07/15   19:21:30  05/07/15   21:09:44
              05/07/15   19:22:45  05/07/15   21:10:22

              05/07/15   16:15:43  05/07/15   16:21:12
              05/07/15   16:15:51  05/07/15   16:21:54
              05/07/15   17:05:02  05/07/15   18:08:01

When “Do not retain in memory” is selected for the message “Line * 
maintenance,” an activation of this bit is not stored as historical data.
Consequently, it is not displayed.

= Retain in memory
= Retain in memory
= Retain in memory
= Retain in memory
= Retain in memory
= Retain in memory
= Retain in memory
= Retain in memory

Line 1 stop
Line 2 stop
Line 3 stop
Line 4 stop
Line 1 maintenance
Line 2 maintenance
Line 3 maintenance
Line 4 maintenance

Message No. 3

Line 1 stop
Line 3 stop
Line 1 maintenance
Line 4 stop
Line 3 maintenance
Line 4 maintenance
Line 2 maintenance

Line 1 stop
Line 3 stop
Line 4 stop

When all the messages are set to “retain in memory,” every message is stored as 
historical data when the corresponding bit comes ON.

= Retain in memory
= Retain in memory
= Retain in memory
= Retain in memory
= Do not retain in memory
= Do not retain in memory
= Do not retain in memory
= Do not retain in memory

Line 1 stop
Line 2 stop
Line 3 stop
Line 4 stop
Line 1 maintenance
Line 2 maintenance
Line 3 maintenance
Line 4 maintenance

Message No. 3

Icon displayed → Retain in memory
Icon not displayed → Do not retain in memory
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10.4 Alarm Logging (Historical)
Overview

• Messages triggered by bit ON/OFF operation as well as time information are stored in the buffering 
area and are displayed as historical data on the screen.

• One message line is displayed each at an occurrence and a reset.
Occurrences and resets can be displayed in different colors.

• From the messages stored as historical data, only occurrences or resets can be displayed.

• Parameter display
In the event of an alarm, the data (parameters) associated with its occurrence can be displayed 
together with the alarm message.  Logging the history of such alarm-relevant data will make it 
easier to locate and investigate the causes of alarms.  (Refer to page 10-63.)

PLC
F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

D200-00

D200-02

D200-03

D200-01

DWUP -+ DISPLAY
CHANGERET

<ON>   07-20   16:15:43
<ON>   07-20   16:15:51
<ON>   07-20   16:15:52
<OFF> 07-20   16:21:12
<ON>   07-20   16:21:54
<OFF> 07-20   16:21:55
<OFF> 07-20   17:05:02

07-20   16:15:43
07-20   16:15:51
07-20   16:15:52
07-20   16:21:12
07-20   16:21:54
07-20   16:21:55
07-20   17:05:02

Alarm Logging

Buffering area

Data changes in the PLC memory 
are stored.

Tank A temperature rise
Tank C temperature drop
Tank D temperature drop
Tank A temperature rise
Line B error detection
Tank C temperature drop
Tank D temperature drop

Tank A temperature rise occurred

Tank C temperature drop occurred

Tank D temperature drop occurred

Tank A temperature rise reset

Line B error detection occurred

Tank C temperature drop reset

Tank D temperature drop reset

<ON>   07-20   16:15:43
<ON>   07-20   16:15:51
<ON>   07-20   16:15:52
<OFF> 07-20   16:21:12
<ON>   07-20   16:21:54
<OFF> 07-20   16:21:55
<OFF> 07-20   17:05:02

Tank A temperature rise
Tank C temperature drop
Tank D temperature drop
Tank A temperature rise
Line B error detection
Tank C temperature drop
Tank D temperature drop

<ON>   07-20   16:15:43
<ON>   07-20   16:15:51
<ON>   07-20   16:15:52
<ON>   07-20   16:21:54

<OFF> 07-20   16:21:12
<OFF> 07-20   16:21:55
<OFF> 07-20   17:05:02

Occurrences only

Tank A temperature rise
Tank C temperature drop
Tank D temperature drop
Line B error detection

Tank A temperature rise
Tank C temperature drop
Tank D temperature drop

Resets only

<ON>    09-26 15:51:16 Temperature rise of Tank-A  65 degree
<ON>    09-26 15:51:21 Lack of materials  80 g
<OFF>  09-26 15:51:26 Lack of materials  80 g
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Configuration

The alarm logging components are shown below.

Setting Dialog

Alarm Logging
Main

[Alarm Logging] icon 
= [Alarm Logging] dialog

Switch parts

Display area

Buffering Area No. Specify the desired buffering area number to be used for alarm logging.

Open:
When you click here, the [Buffering Area Setting] dialog for the specified 
buffer number is displayed.  It is also possible to make settings for a 
buffering area directly.  For more information, refer to page 10-61.
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Start Message 
(GNo., No.)

This setting is disabled when [  Use the settings in Buffering Area for the 
message settings] is checked.
When it is unchecked, this setting is possible.
Specify the group number and message (line) number of the top message 
among the messages registered on the [Message Edit] window which you 
want to display for alarm logging.

Open:
When you click here, the [Message Edit] window for the specified group 
number is displayed.  It is also possible to edit the message for alarming 
logging directly.  For more information, refer to page 10-56.

Display in Area
(None, TYPE0, 
TYPE1)

Choose from [None], [TYPE0] or [TYPE1] for the display format of bit ON/
OFF operation in the display area.

None:

TYPE0:
<ON> and <OFF> are indicated in one-byte characters.

TYPE1:
Text to be displayed for bit ON operation and bit OFF operation can be 
specified as desired.
Register the text to be used instead of “<ON>” and “<OFF>” on the 
[Message Edit] window.  The registered text is displayed according to bit 
ON/OFF operation.

When [TYPE1] is chosen, the [Start Message GNo. & No.] option 
becomes active.  Specify the group and line numbers of the start 
message.  The start message line is used for bit ON operation, and the 
next message line is used for bit OFF operation.

Open:
When you click here, the [Message Edit] window for the specified group 
number is displayed.  It is also possible to edit the message for TYPE1 
directly.  For more information, refer to page 10-56.

07-20   11:32:10 Tank A temperature rise
07-20   11:33:15 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop
07-20   11:50:13 Tank C temperature drop

07-20   11:32:10 Tank A temperature rise
07-20   11:33:15 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop
07-20   11:50:13 Tank C temperature drop

<ON>
<OFF>
<ON>
<OFF>

Display in Area

07-20   11:32:10 Tank A temperature rise
07-20   11:33:15 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop
07-20   11:50:13 Tank C temperature drop

Occur
Reset
Occur
Reset

Register the text on the [Message Edit] window.

↓ Start message
= ON
= OFF

Occur
Reset

Message No. 3

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5

Example:
[Start Message]

GNo.: 3
No. 2
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Status Display
(None, TYPE0, 
TYPE1) *1

Choose from [None], [TYPE0] or [TYPE1] for status display that indicates 
the type of messages shown: bit ON operation, bit OFF operation or bit 
ON/OFF operation. 

None:

TYPE0:
<ON/OFF> is indicated in one-byte characters. 

TYPE1:
Text to be displayed for bit ON operation (<ON> with [TYPE0]) and bit 
OFF operation (<OFF> with [TYPE0]) can be specified as desired.
Register the text to be used instead of “<ON>” and “<OFF>” on the 
[Message Edit] window.  The registered text is displayed according to bit 
ON/OFF operation.

When [TYPE1] is chosen, the [Start Message GNo. & No.] option 
becomes active.  Specify the group and line numbers of the start 
message.
The start message line is used for bit ON/OFF operation, the next 
message line is used for bit ON operation, and the next message line is 
used for bit OFF operation.

Open:
When you click here, the [Message Edit] window for the specified group 
number is displayed.  It is also possible to edit the message for TYPE1 
directly.  For more information, refer to page 10-56.

07-20   11:32:10 Tank A temperature rise
07-20   11:33:15 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop
07-20   11:50:13 Tank C temperature drop

<ON>
<OFF>
<ON>
<OFF>

Status display

07-20   11:32:10 Tank A temperature rise
07-20   11:33:15 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop
07-20   11:50:13 Tank C temperature drop

<ON>
<OFF>
<ON>
<OFF>

<ON/OFF>

Status display: Register the text on the [Message Edit] window.

07-20   11:32:10 Tank A temperature rise
07-20   11:33:15 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop
07-20   11:50:13 Tank C temperature drop

Occur
Reset
Occur
Reset

Occur/Reset

↓ Start message
= ON/OFF
= ON
= OFF

Occur
Reset

Occur/Reset
Occur
Reset

Message No. 3

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8

Example:
[Start Message]

GNo.: 3
No. 6
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*1 Status display
Status display uses a character display part.
Unless a character display part ([Display Function: Sampling Status Display]) that links the 
[Alarm Logging] dialog is placed, no status display is available.
For more information, refer to page 10-60.

Default Setting
(ON-OFF/ON/OFF))

Select the display to be shown first (by default).

ON-OFF:
Indicates historical data of both bit ON/OFF operations.

ON:
Indicates historical data of bit ON operation only.

OFF:
Indicates historical data of bit OFF operation only.

 Time Display When indicating the sampling time, check this box.
It is indicated in the format of “month-day, hour : minute : second.”
The number of characters is fixed to 15 (one-byte).

* Year display is not available even when [  Time Display] is checked.

Display Order
(Chronological Order, 
Newest Order)

Choose the message display order for alarm logging.

Chronological Order:
Messages are displayed in order of occurrence with the oldest one at the 
top.

Newest Order:
Messages are displayed in order with the most recent one at the top.

Use the settings in 
Buffering Area for 
the message 
settings

This option determines whether you make the message setting for alarm 
logging on the [Alarm Logging] dialog or in the buffering area setting.

Checked:
Specify the message to be used for [Start Message] on the [Discrete 
memory/CSV format] tab window for buffering area setting.

Unchecked:
Specify the message to be used for [Start Message] on the [Main] tab 
window in the [Alarm Logging] window.

07-20   11:32:10 Tank A temperature rise
07-20   11:33:15 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop
07-20   11:50:13 Tank C temperature drop

Occur
Reset
Occur
Reset

Checked:
Fixed to 15 one-byte characters

hour : minute : second

month-day

Tank A temperature rise
Tank A temperature rise
Tank C temperature drop
Tank C temperature drop

Occur
Reset
Occur
Reset

Unchecked:
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Style

* [Enlarge X] and [Enlarge Y] are fixed to “1”.

Detail

Color
ON Character 
Property
OFF Character 
Property

Different colors can be set for bit ON operation (occurrence) and bit OFF 
operation (reset).

Property
For more information, refer to “Appendix 4  Styles and Coordinates.”

Transparent

 Windows Font For more information, refer to the Operation Manual.

 Real Time Print For more information, refer to “Real Time Print” on page 10-68.

 Print Command 
Memory

For more information, refer to page 10-66.

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Registering messages
There are three ways of registering messages.

• [Alarm Logging] dialog → [Main] tab window → [Open]

• [Registration Item] → [Message] → [Group No.] designation

• [Buffering Area Setting] → [Discrete memory/CSF format] tab window

Double-click on 
a cell under 
“Message”.
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In the [Message Edit] window, line numbers denote absolute addresses as default.
If designating a line number for alarm logging, select [Display] → [Display Absolute Address as Line 
Number] and remove the check from this menu item before commencing editing.

For more information on the editing procedure in the [Message Edit] window, refer to the Operation 
Manual.

Display Area
Style

Detail

Color Specify the color in the display area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified the [Alarm Logging] dialog.
For more information on the ID, refer to the Operation Manual.



10.4 Alarm Logging (Historical)

10-58

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Checking the display area size
You can check on the screen that messages for alarm logging can be displayed on the display areas 
as you intended.

When you have registered messages, select [View] → [Display Environment] → [Display] tab, check 
the box for [  Display Message].

The registered messages are displayed on the screen.

For more information on size adjustment, etc., refer to the Operation Manual.
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Switch Parts for Alarm Logging
Applicable switch parts list

Notes on setting
Specify the same ID for switch parts as the one specified in the [Alarm Logging] dialog. 
The ID specified in the [Alarm Logging] dialog can be known from the [Alarm Logging] icon or on the 
[Detail] tab window of the [Alarm Logging] dialog.

To check the ID of each switch part, select [View] → [Display Environment] and check the box for 
[ Display ID Number]. 

For more information on the ID, refer to the Operation Manual.

Function Contents

Roll Up Scrolls up by one data element.  If all data elements cannot be held in the 
area, one data element at a time scrolls into view.

Roll Down Scrolls down by one data element.  If all data elements cannot be held in the 
area, one data element at a time scrolls into view.

+ Block Scrolls up by one page.

− Block Scrolls down by one page.

Graph Return Returns to the most recent alarm logging when it is pressed while flashing.
Flashing of the [Graph Return] switch is canceled as well as its selection.

Display Change-
over

Changes over the display for bit ON, OFF, or ON/OFF operation.

Print Outputs all data elements stored in the specified buffer to the printer.

Reset When the switch is pressed once, it is activated.  Pressing it again within 2 
seconds clears the buffering area.
Sampling restarts immediately after clearing.
If not pressed again within 2 seconds, the switch is turned off and resetting is 
nullified.

Change Display 
Order

Changes over data display order each time the switch is pressed, between 
chronological order and reverse chronological order.

OR
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Data Display Parts for Alarm Logging
Applicable data display parts list

*1 Sampling Count Display (Num. Display)

*2 Sampling Time Display (Num. Display)

*3 Sampling Status Display (Char. Display)

Notes on setting
Refer to “Notes on setting” for switch parts already described.

Type Function Contents

Num. Display Sampling Count 
Display *1

The total number of historical data elements or the ordinal 
number of the selected data element can be indicated.

Sampling Time 
Display *2

This part indicates the last sampling time or that of the 
selected data point. 
Depending on the setting for [Digits] as well as the check 
box for [  Put msec information on logging time] in the 
[Others] tab window for buffering area setting, the sampling 
time is indicated in the following format:

- [  Put msec information on logging time] unchecked:
Less than 8 digits No display
From 8 digits up to 13 digits “hh : mm : ss”
From 14 digits up to 18 digits “MM - DD   hh : mm : ss”
19 digits or greater “YYYY - MM - DD   hh : mm : ss”

- [  Put msec information on logging time] checked:
Less than 8 digits No display
From 8 digits up to 11 digits “hh : mm : ss”
From 12 digits up to 17 digits “hh : mm : ss.xxx” (xxx: msec)
From 18 digits up to 22 digits “MM - DD   hh : mm : ss.xxx”

(xxx: msec)
23 digits or greater “YYYY - MM - DD   hh : mm : 

ssss.xxx” (xxx: msec)

Char. Display Sampling Status 
Display *3

The alarm logging status (bit ON, OFF, or ON/OFF 
operation) currently being displayed can be indicated.
Secure the required number of bytes by setting [Number of 
Bytes] correctly.

07-20   11:32:10 Tank A temperature rise
07-20   11:33:15 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop
07-20   11:50:13 Tank C temperature drop

Occur
Reset
Occur
Reset

Occur/Reset 4 07-20   11:50:13

07-20   11:32:10 Tank A temperature rise
07-20   11:33:15 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop
07-20   11:50:13 Tank C temperature drop

Occur
Reset
Occur
Reset

Occur/Reset 4 07-20   11:50:13

07-20   11:32:10 Tank A temperature rise
07-20   11:33:15 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop
07-20   11:50:13 Tank C temperature drop

Occur
Reset
Occur
Reset

Occur/Reset 4 07-20   11:50:13
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Buffering Area Setting

When you click [Refer to Buffering Status] on the [Main] tab window of the [Alarm Logging] dialog, the 
setting items for the buffering area number are displayed.

Sampling Method Select [Alarm Logging] or [Alarm Tracking] *1.

Sampling Cycle
(0 - 65535 sec)

Specify the data read cycle.
When “0” is specified, monitoring is executed at every cycle.

Memory Continuous:
The sampling data memory is allocated consecutively in the read area or 
from the specified top address.

Individually:
The memory address for sampling data can be specified.

Select [Continuous] and check this box when specifying a top memory 
address for consecutive allocation.  From the message specified for [Start 
Message GNo./No.] on the [Discrete memory/CSV format], as many words 
as specified for [Word Count] are allocated for alarm messages.

Example: [Continuous], [Memory: D100], [Word Count: 1]
[Start Message GNo.: 0 and No.: 10]

= D100-00
= D100-01
= D100-02
= D100-03
= D100-04
= D100-05
= D100-06
= D100-07
= D100-08
= D100-09
= D100-10
= D100-11
= D100-12
= D100-13
= D100-14
= D100-15

AAAAAA
BBBBBB
CCCCCC
DDDDDD
EEEEEE
FFFFFF
GGGGGG
HHHHHH
IIIIII
JJJJJJ
KKKKKK
LLLLLL
MMMMMM
NNNNNN
OOOOOO
PPPPPP
QQQQQQ

Message No. 0

No. 10
No. 11
No. 12
No. 13
No. 14
No. 15
No. 16
No. 17
No. 18
No. 19
No. 20
No. 21
No. 22
No. 23
No. 24
No. 25

As many messages as word 
count are assigned.
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*1 Alarm logging is also possible when [Sampling Method: Alarm Tracking] is selected.
However, note that there are some limitations described below.
• [Real Time Print] (see page 10-68) is not possible with alarm logging.
• The setting for [Memorize] of the registered message (valid for alarm tracking) is also valid for 

alarm logging.
• When [Add Time Order Alarming] is checked, in the [Others] tab window for the buffer number 

(Sampling Method: Alarm Tracking), memory bits are allocated for the messages according to 
the setting for [No. of Relays] for time order alarming.
With alarm logging, the first message line specified for [No. of Relays] for time order alarming 
is displayed.

*2 For the procedure of calculating the size of alarm logging data, refer to “Appendix 1  Buffering 
Area” (page A1-15).

Word Count
(1 - 1024)

Specify the number of error bits to be monitored in units of 16 bits (in units 
of words).

Store Target *2 For more information, refer to “Storage Target (Setting Dialog)” (page A1-
13) in “Appendix 1  Buffering Area.”

No. of Samples
Specify the number of bit ON/OFF operations to be retained as historical 
data.
Bit ON operation is regarded as one and bit OFF operation is also 
regarded as one; therefore, to keep one error bit change as historical 
data, “2” should be set at minimum.

Discrete memory/CSV 
format

For more information, refer to “Discrete Memory/CSV Format (Tab 
Window)” (page A1-19) in “Appendix 1  Buffering Area.”

Others For more information, refer to “Others” (page A1-27) in “Appendix 1  
Buffering Area.”

 Start Bit You can control sampling start, stop, and restart.

When this box is checked, the bit obtained from the sampling control 
memory area is automatically displayed.

Sampling control memory [U] (bits 03, 07, 11, 15)
ON: Sampling start
OFF: Sampling stop

* For more information on the sampling control memory, refer to 
“Appendix 1  Buffering Area” (page A1-9).

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

U S R T U S R T U S R T U S R T

Buffer No. 3
Buffer No. 7
Buffer No. 11

n
n+1
n+2

Buffer No. 2
Buffer No. 6

Buffer No. 10

Buffer No. 1
Buffer No. 5
Buffer No. 9

Buffer No. 0
Buffer No. 4
Buffer No. 8

Sampling control memory

LSBMSB
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Parameter Display Function

Setting Items

This section explains the settings required for showing parameters together with alarm messages.  For 
more information on other setting items, refer to page 10-51.

Buffering area setting
• Others

• Discrete memory/CSV format

 Record Parameters Check this box.

Word Count The necessary number of words is automatically calculated from 
the [Parameter] settings in the [Discrete memory/CSV format] tab 
window. 

Parameter
(Yes, None)

Select either option for each message.  Double-clicking the cell under 
[Parameter] calls up the [Parameter Table] dialog.
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• Parameter table

The items which can be set vary with the selection under [Display Type].

No. Parameter Nos. 0 to 7
A maximum of eight parameters can be registered.

Memory Specify the memory address assigned to the parameter.

Display Type Numerical Data: This option is for the display of data at the memory 
address.

Text: This option is for the display of text set at the 
memory address.

Message No.: This option is for the display of a message according 
to a designated message number (absolute address) 
that is already registered.

Bit: When the bit is set (ON), the message specified 
under [Message No.] is displayed.  When the bit is 
reset (OFF), the next message (corresponding to the 
number of [Message No.] plus one) is displayed.

Data Length Specify the length of the data stored at the address set under [Memory].
1-Word/2-Word

Input Format Select the code to be used at the time of data reading.
DEC/BCD/FLOAT

Display Format Select the format of the data to be displayed.
DEC (w/o sign), DEC (w/ -sign), DEC (w/ +/- sign), HEX, OCT, BIN 
(binary), FLOAT

Digits Specify the number of digits.
1 to 32

Decimal Point Specify the number of decimal places.  When no decimal point is required, 
set “0”.
0 to 31

Zero Suppress Select whether to execute zero suppress.
Example: 5-digit numeral display  123;  without zero suppress: 00123) 

Message G No. 
and Message No.

Specify the message G number and message number you wish to display.
Message GNo. 0 to 127, Message No. 0 to 255

Char. Place Select either flush right or flush left for text display.
Flush Right/Flush Left

Selected line

Shows the selected message. Adds a new parameter.

Moves the selection one line above the currently selected line.

Deletes the selected parameter.

Moves the selection one line below 
the currently selected line.
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Message edit
Parameter numbers can be added to the individual alarm messages.

* To review parameter numbers (0 to 7), go to [Buffering Area Setting] → [Discrete memory/CSV 
format] → [Parameter] → [Parameter Table] → [No.].

Limitations

• When the parameter settings have been made with Windows fonts, parameter symbols (%PxS) 
are shown as they are in the alarm messages to be displayed.

• For parameter Nos. 0 to 7 specified in the [Parameter Table] dialog, the maximum allowable 
number of words is 128 (automatically calculated*).  Be sure to use 128 or fewer words in total.

* To see the number of words used, check “Record Parameters” in “Buffering area setting” on page 10-38.

• In the event of a failure to read parameter memory, “****” is displayed in place of the parameter in 
the message.

• If [Message No.] is selected for [Display Type] in the [Parameter Table] dialog and if the 
corresponding message includes parameter symbols, the symbols “%PxS” appear as they are 
when the message is displayed.

• If changes are made to the data in the [Parameter Table] dialog, such as the number of 
parameters, the order of parameters, or the assigned memory addresses, after the execution of 
data sampling and then if screen data transfer is performed in this condition, the data previously 
sampled may not be displayed correctly on the screen.  Whenever any changes as mentioned 
above have been made, formatting is required before sampling start.

• Real-time printing of alarm logging data will show parameters as “****”.
• In the case of alarm logging, the parameters will be displayed to indicate alarm bit set (ON) and 

reset (OFF) conditions.

Letter Counts Specify the number of characters.
1 to 127

Text Process Set the recognition of MSB and LSB in one word.
LSB → MSB, MSB → LSB

%PxS
Denotes a parameter No. 0 to 7 registered in the [Parameter Table] dialog.
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Other Functions

Sample Print
Overview
Alarm logging data can be printed.  All the data in the buffer is printed.

* For more information on printing, such as printer compatibility or print setting procedures, refer to 
“16  Print.”

Methods
There are two methods for printing sampling data.

• Switch
When the [Function: Print] switch is pressed, a sample print is carried out.

• Print command memory
The setting shown below is required on the [Alarm Logging] dialog.

 Print Command 
Memory
([Detail])

When this box is checked, one word is allocated for the command 
memory.
Only bit 15 is used.

* Be sure to reset all the bits to “0” except bit 15.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

<ON>   07-20   16:15:43
<ON>   07-20   16:15:51
<ON>   07-20   16:15:52
<OFF> 07-20   16:21:12
<ON>   07-20   16:21:54
<OFF> 07-20   16:21:55
<OFF> 07-20   17:05:02

07-20   16:15:43
07-20   16:15:51
07-20   16:15:52
07-20   16:21:12
07-20   16:21:54
07-20   16:21:55
07-20   17:05:02

buffering area

Print

Tank A temperature rise
Tank C temperature drop
Tank D temperature drop
Tank A temperature rise
Line B error detection
Tank C temperature drop
Tank D temperature drop

Tank A temperature rise occurred
Tank C temperature drop occurred
Tank D temperature drop occurred
Tank A temperature rise reset
Line B error detection occurred
Tank C temperature drop reset
Tank D temperature drop reset

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Print command 
memory “n”

Printout command (0 → 1)
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Printed items
Alarm logs can be printed in the same image as currently shown on the screen.

• Setting position
[System Setting] → [Unit Setting] → [General Settings]
 → [  Print Alarm Logging Data in the Displayed Format]

Checked: Print in the same format as shown on the screen
Unchecked: Print every <ON/OFF> operation

<ON/OFF> shown

Only <ON> shown

07-20   11:32:10 Tank A temperature rise
07-20   11:33:15 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop
07-20   11:50:13 Tank C temperature drop

<ON>
<OFF>
<ON>
<OFF>

<ON/OFF> Print

07-20   11:32:10 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop

<ON>
<ON>

<ON>
07-20   11:32:10 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop

<ON>
<ON>

Print

07-20   11:32:10 Tank A temperature rise
07-20   11:33:15 Tank A temperature rise
07-20   11:40:25 Tank C temperature drop
07-20   11:50:13 Tank C temperature drop

<ON>
<OFF>
<ON>
<OFF>
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Real Time Print
Overview
Each time a bit status changes, the change is printed.
Alarm logs are continuously printed out.

Setting procedure
The setting shown below is required on the [Alarm Logging] dialog.

Limitations
It is possible to use a maximum of 4 alarm loggings with [  Real Time Print].

* Be sure to set different buffer numbers.

When setting four or more alarm loggings with [  Real Time Print], or setting the same buffer number 
on the [Alarm Logging] dialog, the error message “Data has some error.” is displayed.  Please keep 
this limitation in mind.

[Real Time Print] is possible when alarm logging data is being displayed with [Sampling Method: Alarm 
Tracking] selected.  (If you make the setting, it will be ignored.)

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

1)

2)

1)

2)

07-20  11:32:10 Empty pallets short
07-20  11:33:15 Saddle raise stopped
07-20  11:40:25 Control panel emergency stop
07-20  11:50:13 Control panel emergency stop
07-20  11:50:13 Operation box emergency stop
07-20  11:50:13 Pusher error

<OFF>
<OFF>
<ON>
<OFF>
<ON>
<ON>

Alarm Logging

1 bit = ON

Alarm Logging

1 bit = OFF
2 bits = ON

Printing the ON message 
of a bit

Printing the OFF message 
of a bit
Printing the ON messages 
of two bits

 Real Time Print
(Detail)

Check the box.

Default Setting
(Main)

Specify the bit of which activation triggers a real time print.
When [ON-OFF] is selected, an alarm log is printed each time a bit 
changes from ON to OFF or from OFF to ON.
When [ON] is selected, an alarm log is printed at the ON edge of each bit.
When [OFF] is selected, an alarm log is printed at the OFF edge of each 
bit.

* Contents of a real time print are not the same as the display 
format on the screen.

 Time Display
(Main)

If checked, alarm logs are printed with time data.
Time data is not printed if this option is not checked.
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10.5 Time Order Alarming (Real Time)
Overview

This is the function for displaying or erasing messages on the screen by setting or resetting bits.

Difference from Bit Order Alarming
Message display
With bit order alarming, the messages are displayed in order of precedence when multiple bits are set.
With time order alarming, the messages are displayed in order of occurrence (from the oldest or the 
newest) (see page 10-72) when multiple bits are set.

Time display
With time order alarming, not only messages but ON time can also be displayed.

A A A A A A
B B B B B B
F F F F F F
D D D D D D
C C C C C C
E E E E E E

A A A A A A
B B B B B B
C C C C C C
D D D D D D
E E E E E E
F F F F F F

UP DOWN

Menu

Menu

UP DOWN

Example: If the following bits are set in order:
D100 Bit 0 = ON

Bit 1 = ON
Bit 5 = ON
Bit 3 = ON
Bit 2 = ON
Bit 4 = ON

High precedence

Zeroth =
First =

Second =
Third =

Fourth =
Fifth =
6th =
7th =
8th =
9th =

10th =
11th =
12th =
13th =
14th =

AAAAAA
BBBBBB
CCCCCC
DDDDDD
EEEEEE
FFFFFF
GGGGGG
HHHHHH
IIIIII
JJJJJJ
KKKKKK
LLLLLL
MMMMMM
NNNNNN
OOOOOO
PPPPPP

Message

D100 0th bit =
1st bit =

2nd bit =
3rd bit =
4th bit =
5th bit =
6th bit =
7th bit =
8th bit =
9th bit =

10th bit =
11th bit =
12th bit =
13th bit =
14th bit =

Bit Order Alarming

Time Order Alarming

A A A A A A
B B B B B B
F F F F F F
D D D D D D
C C C C C C
E E E E E E

06-04   11:33:15
06-04   11:33:22
06-04   11:33:36
06-04   11:33:45
06-04   11:33:49
06-04   11:33:55

Fixed to 15 one-byte 

hour : minute : second

month-day
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Parameter display
In the event of an alarm, the data (parameters) associated with its occurrence can be displayed 
together with the alarm message.  Logging the history of such alarm-relevant data will help you locate 
and investigate the causes of alarms.  (Refer to page 10-86.)

Setting item
This is the function that displays the current error status in real time; for the convenience of setting, the 
[Buffering Area Setting] dialog must be set.

Configuration

The time order alarming components are shown below.

05-18 13:45:34  Temperature rise of Tank-A  65 degree
05-18 13:45:34  Lack of materials  80 g

[Time Order Alarming] icon = 
[Time Order Alarming] dialog

Switch parts

Display area
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Setting Dialog

Time Order Alarming
Main

Buffering Area No. Specify the desired buffering area number to be used for time order 
alarming.

* With time order alarming, only the current bit ON information is 
displayed.  Therefore, different from the type of alarming that 
retains historical data in the buffering area, the information is not 
retained in the buffering area.

Open:
When you click here, the [Buffering Area Setting] dialog for the specified 
buffer number is displayed.  It is also possible to make settings for a 
buffering area directly.  For more information, refer to page 10-82.

Start Message 
(GNo., No.)

This setting is disabled when [  Use the settings in Buffering Area for the 
message settings] is checked.
When it is unchecked, this setting is possible.
Specify the group number and message (line) number of the top message 
among the messages registered on the [Message Edit] window which you 
want to display for time order alarming.

Open:
When you click here, the [Message Edit] window for the specified group 
number is displayed.  It is also possible to edit the message for time order 
alarming directly.  For more information, refer to page 10-77.

No. of Lines per Relay
(1 to 24)

This setting is disabled when [  Use the settings in Buffering Area for the 
message settings] is checked.
When it is unchecked, this setting is possible.

This option is active when [Display Area] is chosen for [Action Area].
Specify the number of lines to be linked with one alarm (= one bit) on the 
display area part.
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*1 Action Area
When selecting each option, the screen image changes as shown below.

Action Area *1

(Display Area, Switch, 
Lamp)

Choose from [Display Area], [Switch] or [Lamp] for specifying the place 
where the message should be displayed on the screen when the 
corresponding bit is set or reset.

Display Area:
Shows messages on display area parts placed on the screen.

Switch:
Shows messages on switch parts placed on the screen.
Place the [Function: Mode] switch part.  Each switch part has an auxiliary 
item [Display Order] and using this item you can specify which alarm 
message should be displayed on which switch.  When you set the same 
number for [Display Order] of all the switch parts, the messages are 
displayed in the order in which the switch parts were placed.

Lamp:
Shows messages on lamp parts placed on the screen.
Place the [Function: Mode] lamp part.  As with switch parts, each lamp 
part has an auxiliary item [Display Order].

 Time Display When this box is checked, the occurring time can be displayed with the 
message.  (Refer to page 10-69.)

Display Order Chronological Order:
Messages are displayed in order of occurrence with the oldest one at the 
top.

Newest Order:
Messages are displayed in order with the most recent one at the top.

Use the settings in 
Buffering Area for 
the message 
settings

This option determines whether you make the message setting for time 
order alarming on the [Time Order Alarming] dialog or in the buffering area 
setting.

Checked:
Specify the message to be used for [Start Message] on the [Discrete 
memory/CSV format] tab window for buffering area setting.

Unchecked:
Specify the message to be used for [Start Message] on the [Main] tab 
window in the [Time Order Alarming] window.

A A A A A A
B B B B B B
C C C C C C
D D D D D D
R R R R R R
T T T T T T

A A A A A A
B B B B B B
C C C C C C
D D D D D D
R R R R R R
T T T T T T

A A A A A A B B B B B B
C C C C C C D D D D D D
R R R R R R T T T T T T

[Action Area: Display Area]

[Action Area: Switch] or [Action Area: Lamp]
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Sub-action

Type
(None, Sub-Display, 
Screen Call, 
Acknowledge Display)

None:
Choose [None] when using time order alarming only.

Sub-Display:
Choose this option when you want to relate a supplemental display to a 
one-bit alarm message.
Set an alarm sub-display to be linked.
For more information, refer to page 10-15.

Screen Call:
Choose this option when you want to call up a screen (for detailed 
information, for example) related to a one-bit alarm message that is 
displayed.
Select [Registration Item] → [Screen Block] and edit the screen to be 
linked.
For more information, refer to page 10-13.

Acknowledge Display:
This option is valid when [Switch] or [Lamp] is chosen for [Action Area] on 
the [Main] tab window.
Select this option when using the acknowledge function.
For more information, refer to “Acknowledge Display Function” on page 
10-89.

Screen Block When [Screen Call] is chosen for [Sub-action], this option becomes active.  
Specify the top screen block number corresponding to the alarm message.

Acknowledgement 
Display Bit Memory

This is used for acknowledge display.
Setting this bit (ON) when errors have occurred brings up their messages 
in colors showing their respective conditions.
For more information, refer to “Acknowledge Display Function” on page 10-
89.

Time to Retrieve (sec) This is used for acknowledge display.
For more information, refer to “Acknowledge Display Function” on page 10-
89.
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Style

*1 When [Switch] or [Lamp] is chosen for [Action Area] on the [Main] tab window, [Enlarge] is fixed 
to “1”.

Detail

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”

Property

Transparent

Enlarge *1

Point

 Windows Font For more information, refer to the Operation Manual.
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 Relay Info. Output 
Memory

Choose whether data of the message displayed or selected for time order 
alarming should be output to the PLC.
If you want to output data, check the box, and specify the desired top 
memory address.

When outputting:  Relay Info. Output Memory (top memory address “n”)
Memory addresses are allocated as shown below.

n: Total number of ON alarms
The number of bits currently set to ON is written.

n + 1: Selected alarm number

[Display Order: Chronological Order]
[Sub-action: Sub-Display]

The ordinal number of the alarm message among those being displayed 
(starting from #1 that occurred first) is output.

[Sub-action: None]
The order of occurrence (starting from “1” that is the oldest) of the top 
message among those displayed is output.

[Display Order: Newest Order]
[Sub-action: Sub-Display]

The ordinal number of the alarm message among those being displayed 
(starting from #1 that occurred most recently) is output.

[Sub-action: None]
The order of reverse occurrence (starting from “1” that is the newest) of 
the top message among those displayed is output.

Relay Info. Output Memory Contents

n Total number of ON alarms

n + 1 Selected alarm number

n + 2 ON alarm number 

GGGGGG
B B B B B B
O O O O O
X X X X X X
A A A A A A

In order of occurrence:

First =
Second =
Third =
Fourth =
Fifth =

n + 1 = 3

A A A A A A
X X X X X X
O O O O O
B B B B B B
GGGGGG

In order of reverse occurrence:

First =
Second =
Third =
Fourth =
Fifth =

n + 1 = 4
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n + 2: ON alarm number
[Sub-action: Sub-Display]

The ordinal number of the message selected with the cursor among 
those displayed by bit order alarming (regarding the start message 
number as “0”) is written.

[Sub-action: None]
The ordinal number (regarding the start message number as “0”) of the 
top message among those displayed is output.

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

B B B B B B
GGGGGG
J J J J J J
NNNNNN
OOOOOO

a a a a a a
b b b b b b
c c c c c c
A A A A A A
B B B B B B
CCCCCC
DDDDDD
E E E E E E
F F F F F F
GGGGGG
HHHHHH
I I I I I I
J J J J J J
K K K K K K
L L L L L L
MMMMMM
NNNNNN
OOOOOO
P P P P P P

First =
6th =
9th =

13th =
14th =

n + 2 = 13

Target alarms

Zeroth =
First =

Second =
Third =

Fourth =
Fifth =
6th =
7th =
8th =
9th =

10th =
11th =
12th =
13th =
14th =

Start message
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Registering messages
There are three ways of registering messages.

• [Time Order Alarming] dialog → [Main] tab window → [Open]

• [Registration Item] → [Message] → [Group No.] designation

• [Buffering Area Setting] → [Discrete memory/CSF format] tab window

Double-click on a 
cell under 
“Message”.
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In the [Message Edit] window, line numbers denote absolute addresses as default.
If designating a line number for time order alarming, select [Display] → [Display Absolute Address as 
Line Number] and remove the check from this menu item before commencing editing.

For more information on the editing procedure in the [Message Edit] window, refer to the Operation 
Manual.
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Display Area
Style

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Color Specify the color in the display area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified the [Time Order Alarming] dialog.
For more information on the ID, refer to the Operation Manual.
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Checking the display area size
You can check on the screen that alarm messages can be displayed on the display areas as you 
intended.

When you have registered messages, select [View] → [Display Environment] → [Display] tab, check 
the box for [  Display Message].

The registered messages are displayed on the screen.

For more information on size adjustment, etc., refer to the Operation Manual.
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Switch Parts for Time Order Alarming

Set the switch function.  The following switch functions are available with time order alarming.

Notes on setting
Specify the same ID for switch parts as the one specified in the [Time Order Alarming] dialog. 
The ID specified in the [Time Order Alarming] dialog can be known from the [Time Order Alarming] 
icon or on the [Detail] tab window of the [Time Order Alarming] dialog.

To check the ID of each switch part, select [View] → [Display Environment] and check the box for [  
Display ID Number].  

For more information on the ID, refer to the Operation Manual.

Lamp Parts for Time Order Alarming (for Display Areas)

Notes on setting
Refer to “Notes on setting” for switch parts already described.

Function Contents

Roll Up Scrolls up by one data element.  If all data elements cannot be held in the area, 
one data element at a time scrolls into view.

Roll Down Scrolls down by one data element.  If all data elements cannot be held in the area, 
one data element at a time scrolls into view.

Mode This switch becomes available when [Switch] is chosen for [Action Area] in the 
[Time Order Alarming] dialog.  The display area part is changed to the area for 
message display.

Change 
Display Order

Changes over data display order each time the switch is pressed, between 
chronological order and reverse chronological order.

Function Contents

Mode This switch becomes available when [Lamp] is chosen for [Action Area] in the 
[Time Order Alarming] dialog.  The display area part is changed to the area for 
message display.

or
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Buffering Area Setting

When you click [Refer to Buffering Status] on the [Main] tab window of the [Time Order Alarming] 
dialog, the setting items for the buffering area number are displayed.

Sampling Method Select [Time Order Alarming] or [Alarm Tracking] *.

* If the same memory bits for buffering area setting as [Alarm Tracking] 
is to be monitored, the same buffer numbers can be used for time 
order alarming.
Be sure to check [  Add Time Order Alarming] the [Others] tab 
window.

Sampling Cycle
(0 - 65535 sec)

Specify the data read cycle.
When “0” is specified, monitoring is executed at every cycle.

Memory Continuous:
The sampling data memory is allocated consecutively in the read area or 
from the specified top address.

Individually:
The memory address for sampling data can be specified.

Select [Continuous] and check this box when specifying a top memory 
address for consecutive allocation.  From the message specified for [Start 
Message GNo./No.]on the [Discrete memory/CSV format], as many words 
as specified for [Word Count] are allocated for alarm messages.

Example: [Continuous], [Memory: D100], [Word Count: 1]
[Start Message GNo.: 0 and No.: 10]

= D100-00
= D100-01
= D100-02
= D100-03
= D100-04
= D100-05
= D100-06
= D100-07
= D100-08
= D100-09
= D100-10
= D100-11
= D100-12

AAAAAA
BBBBBB
CCCCCC
DDDDDD
EEEEEE
FFFFFF
GGGGGG
HHHHHH
IIIIII
JJJJJJ
KKKKKK
LLLLLL
MMMMMM

Message No. 0

No. 10
No. 11
No. 12
No. 13
No. 14
No. 15
No. 16
No. 17
No. 18
No. 19
No. 20
No. 21
No. 22

As many messages as word 
count are assigned.
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10
Sub-Display

For more information on the motion that is made by selecting [Sub-action: Sub-Display], refer to “10.2  
Alarm Sub Display.”

Calling Screens from Messages (Screen Call)

For more information on the motion that is made by selecting [Sub-action: Screen Call], refer to 
“Calling Screens from Messages (Screen Call)” on page 10-13

Word Count
(1 - 128)

Specify the number of error bits to be monitored in units of 16 bits (in units 
of words).

Store Target *2 For more information, refer to “Storage Target (Setting Dialog)” (page A1-
13) in “Appendix 1  Buffering Area.”

Discrete memory/CSV 
format

For more information, refer to “Discrete Memory/CSV Format (Tab 
Window)” (page A1-19) in “Appendix 1  Buffering Area.”

Others For more information, refer to “Others” (page A1-27) in “Appendix 1  
Buffering Area.”

[  Acknowledge function]
Check this box when using the acknowledge function.
For more information, refer to page 10-89.

 Start Bit You can specify the timing in monitoring the bit as you like.
Monitoring can be started or stopped using the sampling control memory.

When this box is checked, the bit obtained from the sampling control 
memory area is automatically displayed.

Sampling control memory [U] (bits 03, 07, 11, 15)
ON: Sampling start
OFF: Sampling stop

* For more information on the sampling control memory, refer to 
“Appendix 1  Buffering Area” (page A1-9).

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

U S R T U S R T U S R T U S R T

Buffer No. 3
Buffer No. 7
Buffer No. 11

n
n+1
n+2

Buffer No. 2
Buffer No. 6

Buffer No. 10

Buffer No. 1
Buffer No. 5
Buffer No. 9

Buffer No. 0
Buffer No. 4
Buffer No. 8

Sampling control memory

LSBMSB
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Difference from Bit Order Alarming

Error Bit Setting

When assigning registered messages to bits in the PLC memory, the top memory address as well as 
the number of bits used must be set as follows:

Bit order alarming
Specify the desired memory address directly for [Memory] in the [Bit Order Alarming] dialog.
As many memory bits as execution relays are assigned automatically from the specified memory.

Example:
[Memory]: D100-00 (bit designation possible)
[Start Message GNo. and No.]: 0&0
[Executing Relays]: 40
[No. of Relays per Line]: 1
With the above setting, messages are assigned to D100, D101, and D102.

Time order alarming
The memory address is specified by [Buffer No.] and [  Memory Designation] in the [Buffering Area 
Setting] dialog.

• When [  Memory Designation] is not checked:
The memory address following the sampling control memory is used for the start memory.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

D100 bit No.

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

39 38 37 36 35 34 33 32

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16

Message No.

D101 bit No.

MSB LSB

Message No.

D102 bit No.

MSB LSB

Message No.

n
n + 1
n + 2
n + 3
n + 4
n + 5
n + 6
n + 7
n + 8

n
n + 1
n + 2
n + 3
n + 4
n + 5
n + 6
n + 7
n + 8

n
n + 1
n + 2
n + 3
n + 4
n + 5
n + 6
n + 7
n + 8

Read area

Sampling control 
memory

Sampling data

Read area

Sampling control 
memory

Sampling data

Read area

Sampling control 
memory

Sampling data

n: Read area
Buffer up to No. 3 Buffer up to No. 7 Buffer up to No. 11
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10

• When [  Memory Designation] is checked:
The specified memory is used for the start memory.  (Only word designation is possible.)
Memory bits are automatically assigned in units of words from the start memory.

Example:
[Buffering Area Setting] dialog

When [  Memory Designation] is checked: D100 (word designation)
[Word Count]: 3

[Time Order Alarming] dialog 
[Buffer No.]: 0
[Start Message GNo. and No.]: 0 & 0
[No. of Relays per Line]: 1

When the above settings are made, bits in D100, D101, and D102 are assigned, and 48 bits 
(word count × 16) are used for execution.

Setting of Processing Cycle

• Bit order alarming
Choose from [Refresh], [High Speed], or [Low Speed] for [Process Cycle] in the [Detail] tab window 
of the [Bit Order Alarming] dialog.

• Time order alarming
Specify the desired cycle time for [Sampling Time] in the [Buffering Area Setting] dialog.  When “0” 
is specified, it is read at every cycle.  When the desired interval is set, read operation is performed 
at the specified intervals.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

D100 bit No.

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

47 46 45 44 43 42 41 40 39 38 37 36 35 34 33 32

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16

Message No.

D101 bit No.

MSB LSB

Message No.

D102 bit No.

MSB LSB

Message No.
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Parameter Display Function

Setting Items

This section explains the settings required for showing parameters together with alarm messages.  For 
more information on other setting items, refer to page 10-71.

Buffering area setting
• Others

• Discrete memory/CSV format

 Record Parameters Check this box.

Word Count The necessary number of words is automatically calculated from 
the [Parameter] settings in the [Discrete memory/CSV format] tab 
window.

Parameter
(Yes, None)

Select either option for each message.  Double-clicking the cell under 
[Parameter] calls up the [Parameter Table] dialog.



10.5 Time Order Alarming (Real Time)

10-87

10

• Parameter table

The items which can be set vary with the selection under [Display Type].

No. Parameter Nos. 0 to 7
A maximum of eight parameters can be registered.

Memory Specify the memory address assigned to the parameter.

Display Type Numerical Data: This option is for the display of data at the memory 
address.

Text: This option is for the display of text set at the 
memory address.

Message No.: This option is for the display of a message according 
to a designated message number (absolute address) 
that is already registered.

Bit: When the bit is set (ON), the message specified 
under [Message No.] is displayed.  When the bit is 
reset (OFF), the next message (corresponding to the 
number of [Message No.] plus one) is displayed.

Data Length Specify the length of the data stored at the address set under [Memory].
1-Word/2-Word

Input Format Select the code to be used at the time of data reading.
DEC/BCD/FLOAT

Display Format Select the format of the data to be displayed.
DEC (w/o sign), DEC (w/ -sign), DEC (w/ +/- sign), HEX, OCT, BIN 
(binary), FLOAT

Digits Specify the number of digits.
1 to 32

Decimal Point Specify the number of decimal places.  When no decimal point is required, 
set “0”.
0 to 31

Zero Suppress Select whether to execute zero suppress.
(Example: 5-digit numeral display  123;  without zero suppress: 00123)

Message G No. 
and Message No.

Specify the message G number and message number you wish to display.
Message GNo. 0 to 127, Message No. 0 to 255

Selected line

Shows the selected message. Adds a new parameter.

Moves the selection one line above the currently selected line.

Deletes the selected parameter.

Moves the selection one line 
below the currently selected line.
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Message edit
Parameter numbers can be added to the individual alarm messages.

* To review parameter numbers (0 to 7), go to [Buffering Area Setting] → [Discrete memory/CSV 
format] → [Parameter] → [Parameter Table] → [No.].

Limitations

• When the parameter settings have been made with Windows fonts, parameter symbols (%PxS) 
are shown as they are in the alarm messages to be displayed.

• For parameter Nos. 0 to 7 specified in the [Parameter Table] dialog, the maximum allowable 
number of words is 128 (automatically calculated*).  Be sure to use 128 or fewer words in total.

* To see the number of words used, check “Record Parameters” in “Buffering area setting” on page 10-38.

• In the event of a failure to read parameter memory, “****” is displayed in place of the parameter in 
the message.

• If [Message No.] is selected for [Display Type] in the [Parameter Table] dialog and if the 
corresponding message includes parameter symbols, the symbols “%PxS” appear as they are 
when the message is displayed.

• If changes are made to the data in the [Parameter Table] dialog, such as the number of 
parameters, the order of parameters, or the assigned memory addresses, after the execution of 
data sampling and then if screen data transfer is performed in this condition, the data previously 
sampled may not be displayed correctly on the screen.  Whenever any changes as mentioned 
above have been made, formatting is required before sampling starts.

Char. Place Select either flush right or flush left for text display.
Flush Right/Flush Left

Letter Counts Specify the number of characters.
1 to 127

Text Process Set the recognition of MSB and LSB in one word.
LSB → MSB, MSB → LSB

%PxS
Denotes a parameter No. 0 to 7 registered in the [Parameter Table] dialog.
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Acknowledge Display Function

Overview

Using an acknowledge bit for time order alarming or bit order alarming, it is possible to indicate 
whether an alarm message has been acknowledged or not in different colors when an error has 
occurred.

* However, note that, in the case of bit order alarming, acknowledged information will be cleared 
when the screen display is changed.  Please keep this limitation in mind.

If an error occurs while there is no operator attending, the error may be reset automatically before an 
operator acknowledges it.

Using the acknowledge function, you can be informed whether or not any error has occurred or has 
been reset.

Error monitor Error monitor Error monitor
Conveyor error

An error occurs without 
operators in attendance.

The error is reset before 
it is known to operators.

No one knows that 
an error occurred.

No error!

Error monitor Error monitor Error monitor
Conveyor error

An error occurred without 
operators in attendance and 
was reset automatically (the 
alarm remains displayed).

Afterward an operator checks the 
error information using the 
acknowledge bit.  → The message 
of an error already reset is 
displayed in a different color and 
disappears after a predetermined 
time elapses.

The acknowledge function 
provides information on error 
occurrence as well as on 
machine resetting.

There was an 
error, but it is 

now reset.
Conveyor error
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Operation Overview

When the acknowledge function is used, switch or lamp parts are used as message display areas.  
One switch or lamp part can hold one message line.
Message display can have the following four conditions:

A: No error
B: Error occurrence
C: Error occurring when the acknowledge bit is set (ON)
D: Error reset when the acknowledge bit is set (ON)

Four-notch switches, or different lamp colors (OFF, ON, P3, and P4 colors), are used to denote these 
conditions.
In the example below, lamp parts equipped with four colors each are placed on an acknowledge 
screen.

OFF color (no error): white
ON color (error occurrence): red
P3 color (error occurring when the acknowledge bit is set (ON)): yellow
P4 color (error reset when the acknowledge bit is set (ON)): blue

If an error occurs, the corresponding message is displayed in red.  If any of them is reset, it remains in 
red.

When the acknowledge bit is set (OFF → ON), the messages of the errors still occurring turn yellow. 
The message of the reset error turns blue. 

After a predetermined time has elapsed, the blue error message disappears and only the messages of 
the errors still occurring remain yellow.

1

0

1

0

1

0

1

0

← Reset

← Occurring

← Occurring

ACK

Power supply error

A-line communication error

B-line communication error

Acknowledge bit

(red)

(red)

(red)

1

0

1

0

1

0

1

0

← Reset

← Occurring

← Occurring

ACK Acknowledge bit

(blue)

(yellow)

(yellow)

Power supply error

A-line communication error

B-line communication error

1

0

1

0

1

0

1

0

A-line communication error

B-line communication error

← Occurring

← Occurring

ACK Acknowledge bit

(yellow)

(yellow)
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Notes on Setting Time Order Alarming

*1 About [Time to Retrieve]
[Time to Retrieve] is the time when a message remains displayed if an error is reset before or 
after the acknowledge bit is set (ON).
If multiple error bits are reset at different times after the acknowledge bit has been set, each error 
message will be cleared at the conclusion of the time set for [Time to Retrieve] from the bit reset 
time.

Action Area
(Main)

Select [Switch] or [Lamp].
* Choosing [Area] is not valid.

Type
(Sub-action)

Select [Acknowledge Display].

Acknowledgement 
Display Bit Memory
(Sub-action)

When this bit is set (ON) at the occurrence of an error, the corresponding 
alarm message is displayed in a color that shows its condition.

* The acknowledge bit is recognized at the edge of OFF to ON.  Reset 
the bit (OFF) when acknowledge operation has been completed.

Time to Retrieve *1
(Sub-action)

When the acknowledge bit is set (ON), the message of an error already 
reset is displayed in the “reset” color until the time for [Time to Retrieve] 
elapses.  Then the message disappears.

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

(1)

(2)

(3)

Error 0 OFF

ACK

Error 0

Error 1

Error 2

ACK

Error 1

Error 2

Error 2

ACK

Acknowledge bit ON

[Time to Retrieve]

Error 1 OFF

[Time to Retrieve]

[Time to Retrieve] count finishes for errors 0 and 1 at different times.

Error 0 time-up

Error 1 time-up
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Notes on Buffering Area Setting

Be sure to check [Acknowledge function] in the [Others] tab window.

Notes on Setting Switch or Lamp Part (for Display)

Be sure to select 4-notch switch or lamp parts ([Function: Mode]).
In the case of 4-notch switch or lamp parts, color settings denote as shown below. 

* Blinking is available when basic 16-color is selected.

Display on Acknowledge Screen after Screen Change

If you change the currently displayed acknowledge screen in time order alarming to a different screen 
and then go back to the previous screen, the error information on the acknowledge screen remains the 
same as that before the screen change.  If any errors are reset after screen change, they will be 
displayed again at the time of return to the acknowledge screen.

OFF color No error

ON color Error occurrence

P3 color Error occurring when the acknowledge bit is set (ON)

P4 color Error reset when the acknowledge bit is set (ON)

Error 0

Error 1

Error 2

Error 0

Error 1

Error 2

ACK MENU ACK MENU

If errors 0 to 2 are reset after 
they occurred:

The messages of the errors 
remain displayed when the 
acknowledge screen is brought 
up again once you have 
changed to another screen.

MENU

Monitor Change

Setting Save

Line A Line B
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1111 Graphic Display
MONITOUCH can display or change a variety of pre-registered graphics on the screen based on bit 
activation and the graphic number.

Overview

The graphic display function can be used in a variety of ways depending on the purpose.

Graphic display
What is the command 

method for the display?

Based on bit activation (ON/OFF). 
How do you configure the display?

Change over with an 
internal switch.

Graphic mode
[Designate: Internal]

Refer to page 11-4.

Lamp parts

Refer to 
“4  Lamp”.

Fix Move

Specify the graphic number.
What is the display mode?

Graphic mode
[Designate: External]

(with parameters)

Refer to page 11-4.

Graphic mode
[Designate: External]

Refer to page 11-4.

Display as 
parts.

Graphic relay
[Type: 2-Graphic]

Refer to page 11-10.

Display only when the 
bit is activated.

Display a picture when 
the bit is activated and 

deactivated.

Graphic relay
[Type: 1-Graphic]

Refer to page 11-10.
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11.1 Graphic Mode
Overview

• It is possible to bring up registered graphics or texts by specifying a graphic number.
[Designate: External]

• When graphics or texts are displayed by specifying the graphic number, it is possible to animate or 
transform them. 

If you want to animate or transform graphics or texts, set up parameters for these items in the 
graphic library. 
When parameters are set, the required memory addresses are allocated for animation and 
transformation.
For more information on the procedure for setting parameters, refer to the Operation Manual.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

D200 5

“5” in D200

Graphic No. 5 is displayed.

Graphic No. 5

D201 0
0

100

D200

D202
D201

0D200

D202

The graphic moves by 100 
dots in the Y direction.

Graphic No. 0 is displayed 
when D200 = 0.

Specify “100” in D202 
(Y coordinate).

Memory for 
X coordinate
Memory for 
Y coordinate

100 dots
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11• It is possible to give commands for showing graphics or texts using internal switches.
[Designate: Internal]

Configuration

The graphic mode components are shown below.

* The graphic mode display is possible without placing a display area part.
For more information, refer to page 11-7.

Press the [+ Block] switch.

Graphic No. 6 is displayed.

Graphic No. 4 is displayed.

Press the [− Block] switch.

Graphic No. 5

Graphic No. 5 Graphic No. 6

Graphic No. 4

Graphic mode = 
[Graphic] dialog

+ Block,
Block Call,
−Block
switches

Display area
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Setting Dialog

Graphic
Main

Designate
(Internal, External)

Choose the commanding method of displaying graphics (diagrams, texts, 
etc.) registered in the graphic library.

Internal:
The graphic display is changed using internal switches placed on the 
screen (= [+ Block], [− Block] switches, etc.).  The graphics cannot be 
moved or transformed.

External:
The graphic number is specified from the external unit (PLC) and is 
displayed on screen. 
The graphics can be moved or transformed.

Initial Graphic
(G No., No.)

This setting is valid when [Designate: Internal] is selected.
Specify the graphic (group number and graphic number) to be displayed 
first when the screen is opened.
The initial graphic number must be located between the minimum and 
maximum graphic numbers.

Max. Graphic
(G No., No.)

This setting is valid when [Designate: Internal] is selected.
Specify the graphic (group number and graphic number) of the greatest 
number among those to be displayed on the screen.

Min. Graphic
(G No., No.)

This setting is valid when [Designate: Internal] is selected.
Specify the graphic (group number and graphic number) of the smallest 
number among those to be displayed on the screen.

Memory *1 This setting is valid when [Designate: External] is selected.
Specify a memory address used for specifying a graphic number.
The graphic number to be specified varies depending on the [  Graphic 
G No. Designation] setting described below.

No. of Parameter 
Words *2

This setting is valid when [Designate: External] is selected.
Parameters are required when moving or transforming the graphics.  
Specify the total number of parameters provided to the graphics you are 
going to use in graphic mode. 
From this total and parameter numbers, the memory allocation is 
determined.
(For more information on the parameter setting, refer to the Operation 
Manual.)
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*1 Memory allocation

*2 Example of using parameters
The following parameters are set for a circle in the graphic library.

[Action: Animation]
[Center X: Incremental + Input  Parameter No. 1]
[Center Y: Incremental + Input  Parameter No. 2]

The following settings are made in the [Graphic] dialog:
[Designate: External]
[Memory: D300]
[No. of Parameter Words: 2 (because parameters No. 1 and No. 2 are set)]

From the above settings, memory is allocated as shown below:

*3 Absolute addresses of the graphic numbers are as shown below:

 Graphic
G No. Designation *3

This setting is valid when [Designate: External] is selected.
When this box is checked ( ), set a group number (0 - 9).
The graphics that can be displayed on the screen are limited to those in 
the specified group number.  A graphic number (0 - 255) in a single group 
must be specified in [Memory].
When this box is not checked ( ), specify the graphic number to be 
displayed using an absolute address.  A graphic number (0 - 2559) in any 
group can be specified in [Memory].

D300 Graphic number specification memory
D301 Center X coordinate change memory 2 words are secured because “2” is 

specified for [No. of Parameter Words].D302 Center Y coordinate change memory

Groups Specified Separately Absolute Address
Group No. Graphic No. Group No. Graphic No.

0 0000 to 0255 (None) 0000 to 0255
1 0000 to 0255 0256 to 0511
2 0000 to 0255 0512 to 0767
3 0000 to 0255 0768 to 1023
4 0000 to 0255 1024 to 1279
5 0000 to 0255 1280 to 1535
6 0000 to 0255 1536 to 1791
7 0000 to 0255 1792 to 2047
8 0000 to 0255 2048 to 2303
9 0000 to 0255 2304 to 2559

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00Memory n

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00n + 1

[  Graphic G No. Designation]: Graphic No. 0 to 255
[  Graphic G No. Designation]: Graphic No. 0 to 2559

For parameter No. 0(When parameters are set)
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Detail

Display Area
Style

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

Color Set the color inside the area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified the [Graphic] dialog.
For more information on the ID, refer to the Operation Manual.
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11Switch Parts for Graphic Mode

When [Internal] is chosen for [Designate] in the [Graphic] dialog, graphics can be changed using a 
switch.  The following switches can be used.

Applicable switch parts list

Notes

Placing Display Area Parts
With [Designate: Internal], graphics are displayed in display area parts.
With [Designate: External], it is possible to display graphics without display area parts.  However, 
there are instances where the previous picture remains even after the picture is changed.

Changing the Display Area Size
The placed display area part must be adjusted to fit the graphic size in graphic mode.
The “OFF” mark (offset mark) in the graphic library fits to the upper left corner of the display area 
part on screen.  Considering this position, determine the size of the display area part.

Function Contents

+ Block Switches to the next graphic. 

− Block Switches to the previous graphic.

Block Call Requires [Block No.] as an auxiliary setting item.
(In the graphic mode, this means a graphic number (absolute address).  Refer 
to page 11-5.)
When this switch is pressed, the graphic of which number you specified is 
called up.

Press the [+ Block] 
switch.

Graphic No. 5 Graphic No. 6

OFF

OFF

Graphic library edit

The offset mark is aligned with the top left 
corner of the display area part.

Screen edit
Display area part
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11.2 Graphic Relay Mode
Overview

The graphics or texts registered in the graphic library can be displayed or erased according to bit 
activation.  There are two types of graphic relay modes.

• [Type: 1-Graphic]
When a bit is set (ON), the corresponding graphic is displayed; when it is reset (OFF), it is erased.

• [Type: 2-Graphic]
Two graphics are assigned to one bit. 
When the bit is reset (OFF), the OFF graphic is displayed; when it is set (ON), the ON graphic is 
displayed.

D200
On the screen

When bit 1 of D200 is activated ...

The picture corresponding to bit 
1 is displayed on the screen.

D200D200

The ON graphic is displayed when bit 1 
is activated.

The OFF graphic is displayed on the screen.

On the screen

Bit 1 of D200 is deactivated. Bit 1 of D200 is activated.



11.2   Graphic Relay Mode

11-9

11• It is possible to animate or transform both [1-Graphic] and [2-Graphic] graphics or text.

If you want to animate or transform graphics or text, set parameters for these items in the graphic 
library. 
When parameters are set, the required memory addresses are allocated for animation and 
transformation.
For more information on the procedure for setting parameters, refer to the Operation Manual.

Configuration

The graphic relay mode components are shown below.

* The graphic relay mode display is possible without placing a display area part.
For more information, refer to page 11-15.

D200 D200
D201 100

Activate bit 1 of D200.
Graphic No. 0 is displayed.

The graphic moves 100 dots in the X direction.

Specify “100” in D202 (X coordinate).

Memory for X 
coordinate

Graphic relay mode = 
[Graphic Relay] dialog

Display area
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Setting Dialog

Graphic Relay
Main

Memory Specify the command memory that is used to display the registered 
graphics or text on the screen.

Start Graphic
(G No., No.) *1

Specify the top graphic (group number and the graphic number).

No. of Relays
(1 to 512) *2

Specify the number of relays (the total number of bits assigned for 
graphics) to be used.

No. of Parameter 
Words *3

Parameters are required when moving or transforming the graphics.  
Specify the total number of parameters provided to the graphics you are 
going to use in graphic relay mode. 
From this total and parameter numbers, the memory allocation is 
determined.
(For more information on the parameter setting, refer to the Operation 
Manual.)

Type
(1-Graphic
2-Graphic) *1 *2

Select how you will display graphics.

1-Graphic:
When the memory bit is set (ON), the corresponding graphic is displayed; 
when it is reset (OFF), the graphic disappears.

2-Graphic:
When the memory bit is set (ON), the ON graphic is displayed; when it is 
reset (OFF), the OFF graphic is displayed.
A graphic is always displayed whether the bit is set or reset.

Mode
(XOR, REP) *4

This option becomes active when [2-Graphic] is chosen for [Type].
In the case of [Type: 1-Graphic], the mode is fixed to [XOR].
Select the display mode when changing the graphics at bit activation or 
deactivation.

XOR
When the bit is reset (OFF), the OFF graphic is displayed.  When it is set 
(ON), the OFF graphic is cleared, and the ON graphic is drawn.  When 
the bit is reset again, the ON graphic is cleared, and the OFF graphic is 
drawn.

REP
When the bit is reset (OFF), the OFF graphic is displayed.  When it is set 
(ON), the ON graphic is drawn over the OFF graphic.  When the bit is 
reset again, the OFF graphic is drawn over the ON graphic.  The graphics 
are not XORed with the base screen and are displayed in their original 
colors.
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11*1 Display example
[Memory: D200], [Start Graphic: GNo. 0, No. 3]
• [Type: 1-Graphic]

D200 bit 3 is activated: Graphic No. 6 is displayed.
D200 bit 8 is activated: Graphic No. 11 is displayed.

• [Type: 2-Graphic]

D200 bit 4: OFF: Graphic No. 12 is displayed.
ON: Graphic No. 11 is displayed.

D200 bit 9: OFF: Graphic No. 22 is displayed.
ON: Graphic No. 21 is displayed.

*2 Display example
[Memory: D200], [Start Graphic: GNo. 0, No. 0], [No. of Relays: 12]
• [Type: 1-Graphic]

• [Type: 2-Graphic]

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

15 14 13 12 11 10 9 8 7 6 5 4 3

MSB LSB

D200 bit No.

Graphic No. 0 graphic No.
(Bit ON)

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

29 27 25 23 21 19 17 15 13 11 9 7 5 3

30 28 26 24 22 20 18 16 14 12 10 8 6 4

Graphic No. 0 graphic No.
(Bit ON)

(Bit OFF)

D200 bit No.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

11 10 9 8 7 6 5 4 3 2 1 0

MSB LSB

Graphic No. 0 graphic No.
(Bit ON)

[No. of Relays: 12]: 12 graphics can be assigned to these bits 
(bit 0 to bit 11).

D200 bit No.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

22 20 18 16 14 12 10 8 6 4 2 0

23 21 19 17 15 13 11 9 7 5 3 1

MSB LSB

Graphic No. 0 graphic No.
(Bit ON)

[No. of Relays: 12]: 12 graphics can be assigned to these bits 
(bit 0 to bit 11).

D200 bit No.

(Bit OFF)
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*3 Display example
[Memory: D200], [Type: 1-Graphic], [Start Graphic: GNo. 1, No. 4]
[No. of Relays: 20], [No. of Parameter Words: 4]
From the above settings, memory is allocated as shown below:

*4 Display example
• Example in XOR mode

In XOR mode, the graphic color is XORed with the colors of the base screen (display area).  
Therefore, the graphic is displayed in the base color that has been XORed, rather than the 
color specified during editing.

For more information on the XORed colors, refer to page 11-17.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

19 18 17 16 15 14 13 12 11 10 9 8 7 6 5 4

MSB LSB

Graphic No. 1 graphic No.
(Bit ON)

16 bits (relays)

[No. of Relays: 20]: 20 graphics are assigned to 16 
bits in D200 and 4 bits in D201.

D200 For graphic relay motion (16 relays)
D201 For graphic relay motion (4 relays)
D202 For parameter No. 1
D203 For parameter No. 2
D204 For parameter No. 3
D205 For parameter No. 4

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

23 22 21 20

Bit No. of D201

Graphic No. 1 graphic No.
(Bit ON)

4 bits (relays)

Total: 20 = [No of Relays]

D200 bit No.

When the bit is reset (OFF),
the OFF graphic is displayed.

When the bit is set (ON),
the OFF graphic is cleared, and 
the ON graphic is drawn.

When the bit is reset (OFF) again, 
the ON graphic is cleared, and the 
OFF graphic is drawn.

When it is displayed on the screen (background: blue):Graphic library edit

Ellipse in solid color 
Foreground color: Yellow

[Foreground color: Yellow] of the ellipse and 
[Blue] of the screen are XORed into white.
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11• Example in REP mode

In REP mode, however, note that the previous graphic remains on the screen when the next 
graphic is drawn.
To clear the previous graphic, place a box in a solid color a little larger than the graphic.

When one graphic is drawn over another, a box in a solid color is drawn and the new graphic is 
displayed over the box.  The previous graphic is cleared from the screen.

* Even with [Mode: REP], the graphic color is XORed if [Animation] is chosen for [Action] in 
the [Parameter Setting] tab window.

When the bit is reset (OFF),
the OFF graphic is displayed.

When the bit is set (ON),
the ON graphic is drawn 
over the OFF graphic.

When the bit is reset (OFF) again, 
the OFF graphic is drawn over the 
ON graphic.

Graphic library edit

(Back)
Box in solid color 
Color: (same as the base screen)

Graphic No. 0 (ON graphic) Graphic No. 1 (OFF graphic)

(Front)
Circle in solid color 
Color: as desired

(Front)
Circle in solid color 
Color: as desired

(Back)
Box in solid color 
Color: (same as the base screen)

Screen As the result, the OFF graphic is 
cleared, and the ON graphic is drawn.When the bit is reset (OFF), the OFF graphic is displayed.

When the bit is set (ON),

The box on the back 
is drawn over the 
OFF graphic.

Then the circle on the front is drawn over it.
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Detail

Display Area
Style

*1 Example with transparent setting

* [  Transparent] is available with display area parts that are not equipped with any graphics 
but with foreground color and background color only (for example, No. 0 in “Parts_ 
Area_E.V7”).

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

Color Set the color inside the area.

 Transparent *1 When this box is checked ( ), transparency is set for the display area 
part.
Check this box ( ) if you want to avoid a situation in which the graphics on 
the background is hidden by the display area part.

Change Part For more information, refer to the Operation Manual.

When [  Transparent] is checked in the 
[Display Area] dialog: [  Transparent]
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11Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Offset position of the display area part
When using a display area part, the offset position in the graphic library fits to the upper left 
corner of the display area part on a screen.

Even if no display area part is placed, the graphic relay mode works normally.  In this case, 
however, the graphic is displayed in alignment with its offset position in the graphic library at the 
upper left corner of the screen.

ID Set the same ID as specified the [Graphic Relay] dialog.
For more information on the ID, refer to the Operation Manual.

Graphic library

Screen No. 0 Screen No. 6

Display area part
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11.3 Graphic Display Details
Graphic Colors

Display Modes

When graphics are displayed on the screen, there are two types of display modes.
• XOR: Graphic colors are XORed with the colors of the base screen.
• REP: Original graphic colors are shown.

This is determined by the settings for the mode or parameters.  Refer to the following table.

Graphic mode

Graphic relay mode

* When the graphic to be displayed is a [Paint] graphic, it cannot be displayed in XORed 
colors.

* When a pattern with [Transparent Color] is used, the graphic can be displayed with [Mode: 
XOR].  For more information, refer to page 11-18.

Graphic library edit

Graphic registration

Graphic mode

Parameter
Action: Replace

Parameter
Action: Animation

Screen edit
Designate: Internal REP XOR

Designate: External REP XOR

Graphic library edit

Graphic registration

Graphic relay mode

Parameter
Action: Replace

Parameter
Action: Animation

Screen edit

Type: 1-Graphic XOR XOR

Type: 2-Graphic Mode: XOR XOR XOR

Mode: REP REP XOR
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11XORed Colors

When graphic colors are XORed with the colors of the base screen, the following colors take effect.  This 
color is called “XORed color.”  XORed colors of basic eight colors are shown below.

XOR operation
Each color has its identification code as given below:

“A color is XORed with another color” means that each number of color codes are XORed.

Example 1:  XOR color between blue and white (64k-color)
Blue 0000  0000  0001  1111  (001F)
White 1111  1111  1111  1111  (FFFF)
        XOR  ↓
Yellow 1111  1111  1110  0000  (FFE0)

Example 2:  XOR color between blue and white (32k-color)
Blue 0000  0000  0001  1111  (001F)
White 0111  1111  1111  1111  (7FFF)
        XOR  ↓
Yellow 0111  1111  1110  0000  (7FE0)

Graphic colors (basic eight colors)

Colors on the 
base screen 
(basic eight 
colors)

Black Blue Red Magenta Green Cyan Yellow White

Black Black Blue Red Magenta Green Cyan Yellow White

Blue Blue Black Magenta Red Cyan Green White Yellow

Red Red Magenta Black Blue Yellow White Green Cyan

Magenta Magenta Red Blue Black White Yellow Cyan Green

Green Green Cyan Yellow White Black Blue Red Magenta

Cyan Cyan Green White Yellow Blue Black Magenta Red

Yellow Yellow White Green Cyan Red Magenta Black Blue

White White Yellow Cyan Green Magenta Red Blue Black

64k-color 32k-color

Color Code HEX Color Code HEX

Black 0000 Black 0000

Blue 001F Blue 001F

Red F800 Red 7C00

Magenta  F81F Magenta  7C1F

Green 07E0 Green 03E0

Cyan 07FF Cyan 03FF

Yellow FFE0 Yellow 7FE0

White FFFF White 7FFF
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Canceling XOR Display (Transparent Pattern)

Normally, because things like [Animate] that took place on the graphic display were all XORed, it was 
impossible to display colors on the screen in the same colors that you initially created them in (when 
the colors were other than black).
Additionally, because the XORed color was affected by the base color, when animation was performed 
on multiple background colors, the color changed whenever the background did.

When a transparent pattern is used for animation, colors can be displayed just as they were originally 
created.

* For this function, be sure to check [With Transparent] for the pattern.

CHECKER

Original pattern

The original color 
is affected by the 
background color.

The original color is 
affected by the 
background color.

CHECKER

Original pattern

Transparent color

Displayed without 
being affected by the 
background color.

Displayed without being affected by the 
background color.
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11Pattern Edit

• You must set the color you do not want to show on the screen in the [Transparent Color Setting] 
dialog on the [Pattern Edit] window.

• Only one “transparent” color can be used for a single pattern. 
• For a pattern like the one below, the perimeter color (red) is set as “transparent color.”  

Consequently, when this pattern is displayed on the screen, the red area becomes transparent, 
and the background color is displayed.

• For more information on the pattern editing procedure, refer to the Operation Manual.

Notes
• Pattern edit

The following limitations apply when a transparent color for a pattern is used.  If this limit is 
exceeded, the transparent color setting automatically becomes inactive and the pattern is 
displayed in the color that is XORed with the background color.

*1 Pattern size = X size × Y size

*2 This is the number including patterns, switches, and lamps with transparent color.
• Graphic mode

You must set [Designate: External] in the [Graphic] dialog.  When you want to change and display 
several types of graphics, it is recommended that you place the display area parts.

• Graphic relay mode
• [Type: 1-Graphic]

When using a pattern with transparent color setting, you can display the pattern in the original 
colors that, otherwise, would be displayed in XORed colors.

• [Type: 2-Graphic], [Mode: XOR]
It is necessary to set [Type: 2-Graphic] when changing between two types of graphics.
In this case, be sure to set [XOR] for [Mode].
If you select [REP] for a pattern with a transparent color setting, there is a possibility that it will 
not be displayed normally.

V815iX/V812xS/
V810xS/V810xT/

V808xS 

V810xC
V808xC

V808xCH

V806

1 pattern size *1 4,088 dots

Maximum per screen *2 512 128 64

Total size per screen *2 768k dots 512k dots 256k dots

Transparent color
( ) With Transparent: Red)

Pattern When the pattern is displayed on the screen:

Red Black Greenish brown Background

80 × 50 = 4,000 < 4,088 dots
[With Transparent] valid for this pattern

80 dots

50 dots
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* When using patterns with transparent color setting for animations in the graphic or graphic 
relay mode, do not overlap the patterns with each other.  Doing so may cause the display to 
become abnormal.  It is recommended that you not overlap patterns with transparent color 
settings with each other than when using animation.  When you animate a pattern with 
transparent color setting overlaying a pattern with transparent color setting created by 
drawing, there will be no problem with the display.
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12 Calendar
Overview

• The “calendar” part is used to show the “year, month, day, hour, minute, second, and day of the 
week” on the screen.

• The calendar display covers from 2006/1/1 to 2105/12/31 on the V8 series.
• On the V8 series, “2007/11/1 9:00:00” is displayed when the power is turned on immediately after 

purchase (before communication with a PLC with calendar function and before using the built-in 
calendar of the V8 series).

• Depending on the calendar data to be used, the setting and correction methods vary.
Refer to the following table.

PLC Calendar *1 V8 series Calendar *2 User Format *3

Part Time display
   or
Calendar

Time display
   or
Calendar

Time display

Setting items Device connection setting *1
[Calendar]
and
SRAM/clock setting *4
Built-in clock not used

SRAM/clock setting *4 Time display format setting

When the power is 
turned on

The PLC calendar *1 is 
automatically read and 
displayed.

The V8 series calendar is 
displayed.

Data in the memory set for 
the time display part is 
read and displayed.

RUN mode V8 series
CPU clock

V8 series
CPU clock

Auto correction The PLC calendar *1 is 
automatically read when the 
date is changed.

− −

Correction Read area bit ON
   or
macro: 
SET_CLND ...... PLC1
PLC_CLND *5 .. PLC2 to 8

Main Menu screen
   or
Macro “SET_SYS_CLND”

Backup at power-off × ×

2007/11/1   9:16:31
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*1 PLC calendar: Calendar that the PLC retains in the CPU

With the V8 series, 8-way communication is possible at the maximum.  The PLC calendar data to 
be read must be determined.
The [Calendar] setting is possible at [System Setting] → [Device Connection Setting] → [Read/
Write Area] tab window.  When [PLC1] is set, the calendar of PLC1 is read; when [PLC3] is set, 
the calendar of PLC3 is read.

However, if the specified PLC is not equipped with a built-in calendar, it is regarded as “no 
calendar”.

*2 V8 series calendar: Calendar in the V8 series

*3 User format: Calendar in the user-defined format created in the PLC

*4 SRAM/Clock setting
This option should be set when using the built-in calendar in the V8 series.
The calendar data will be retained even when the power is turned off.

• Select [System Setting] → [Unit Setting] → [SRAM/Clock].  Check ( ) the box for [  Use Built-in 
Clock].

• Be sure to set a backup battery.
For more information on the battery, refer to the V8 Series Hardware Specifications Manual.

*5 In the case of PLC2 to PLC8, calendar correction is performed by the execution of macro 
commands “PLC_CLND” and “SYS (SET_SYS_CLND)”.  When the bit in the read area is set 
(ON), the calendar data of the PLC specified for [Calendar] will be read as explained in Note 1 
(*1).  For more information, refer to the Macro Reference Manual.
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12.1 Time Display
Setting Dialog

Main

Display Mode
(Display Calendar, 
Display Seconds in 
Timer Format)

Choose the time display format.  This section explains the case where 
[Display Calendar] is selected for [Display Mode].
For information on [Display Seconds in Timer Format], refer to “10  
Alarming” on page 10-48.

 Use System 
Calendar

When this box is checked ( ), data of the PLC calendar, the V8 series 
calendar or calendar memory is used for the calendar display.  It is 
possible to select the display format and change the character size easily.
When this box is not checked ( ), the calendar in the user-defined format 
is used.

Memory This option becomes active when [  Use System Calendar] is not 
checked.
Specify the memory address from which data is read based on the time 
display setting.

Time Display Setting This option becomes active when [  Use System Calendar] is not 
checked.
Set the calendar data format.
For more information, refer to page 12-4.

 Date Display
 Year 4-digit Display
 Zero Suppress for 
Year
 Zero Suppress for 
Month-Day
 Time Display

Set the time format to be displayed on the screen.
When each box is checked ( ), the option is selected.
Zero suppression can be selected.
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Time Display Format Setting

*1 Memory allocation for each data unit
• Word

• Byte

 Specify Format Check this box ( ) when [  Use System Calendar] is not checked on the 
[Main] tab window.

Read Word Count
(1 to 6)

The specified words are read from the top address specified by [Memory] 
in the [Main] tab window.

Data Unit *1
(Word, Byte)

Select [Word] or [Byte] for data unit when reading data from the PLC.

Code Type
(BCD, DEC) Select [BCD] or [DEC] for code type when reading data from the PLC.

0000 to 0005 Specify the contents of data for each memory.

0000

0005

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

− − − − − −

Year (0 to 99)
Month (1 to 12)
Day (1 to 31)
Hour (0 to 23)
Minute (0 to 59)
Second (0 to 59)

0000

0005

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

Year (0 to 99)
Month (1 to 12)
Day (1 to 31)
Hour (0 to 23)
Minute (0 to 59)
Second (0 to 59)



12.1   Time Display

12-5

12

Style

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”

Property

Enlarge

Point

Rotation + Direction

 Spacing

Character Size

 Windows Font

Display Language

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Example with Time Display Format Setting

<Example 1>
[Time Display] dialog

Display Mode: Display Calendar
Memory: D100

[Time Display Format Setting]
Specify Format
Read Word Count: 3
Data Unit: Word
Code Type: BCD
0000: Month
0001: Day
0002: Hour

<Example 2>
[Time Display] dialog

Display Mode: Display Calendar
Memory: D100

[Time Display Format Setting]
Specify Format
Read Word Count: 2
Data Unit: Byte
Code Type: BCD
0000: Month Day
0001: Hour Minute

D100
D101
D102

2
1

10

1-Feb 10:00

D100
D101

0201
1040

1-Feb 10:40
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12.2 Calendar
Setting Dialog

Main

*1 Display example
Two digits indicate the year 2007 as “07”, four digits, as “2007”.

Style

 Year
 Month
 Hour
 Minute
 sec
 Week

Check ( ) the items to be displayed.
The year in Western calendar and the hour (0 to 24) are displayed.

Edit When you select an item above (  Year to  Week) and click [Edit], the 
[Char. Prop.] dialog for the selected item is displayed.

Set Selected Use this button when applying the same character properties to all the 
items.

Year Digits *1 This option becomes active when [Year] is checked ( ).
Select either two digits or four digits to indicate the year.

 Windows Font For more information, refer to the Operation Manual.

Display Language For more information, refer to “Appendix 3  Display Language.”

Change Part For more information, refer to the Operation Manual.

Customize For more information, refer to the Operation Manual.
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Day-Week Message Setting

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

 Sunday
 Monday
 Tuesday
 Wednesday
 Thursday
 Friday
 Saturday

This option becomes active when [Week] is checked ( ) on the [Main] tab 
window.
Check ( ) the days of the week to be displayed.
When the box is checked ( ), text can be set for each day of the week.
A maximum 13 one-byte characters can be used.

Display Language For more information, refer to “Appendix 3  Display Language.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Notes

• Calendar parts consist of areas of “hour, minute, and second,” areas of “year, month, and day,” 
and areas of two-level display.  Additionally, there is an area for punctuation marks like “:” and “−”.

• Calendar data is displayed in the following format on the computer.

YY or YYYY MM DD hh mm ss SUN

Year Month Day Hour Minute Second Day of the week
(Displayed as registered)
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12.3 Calendar Data Correction
Correct calendar data that has become different from the actual time.
The setting method varies depending on the part selected.
Check the table on page 12-1 and correct the data as needed.

Correcting in the Read Area

PLC with Calendar Function

1. Refer to the PLC manual and correct time-data in the calendar memory of the PLC.
2. Set bit 11 (calendar setting) (0 → 1) of read area “n” that is set in the [Device Connection Setting] 

dialog.
The V8 series reads the calendar data from the PLC.

PLC without Calendar Function

1. Write correct time-data in the memory specified for [Calendar] in the [Device Connection Setting] 
dialog.

2. Set bit 11 (calendar setting) (0 → 1) of read area “n” that is set in the [Device Connection Setting] 
dialog.
The set calendar data is read.

<Example>

D0

2002
      4
    10
    12
    30
      0

D100
D101
D102
D103
D104
D105

2002
      4
    10
    12
    30
      0

D100
D101
D102
D103
D104
D105

04/01/02
09:00:00

04/10/02
12:30:00

Calendar memory: D100 to 106
Read area D0 to 2

(1) Set data.
D100 = 2002
D101 = 4
D102 = 10
D103 = 12
D104 = 30
D105 = 0

(2) Read area
Set D0 bit 11.

Calendar readout
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Correcting using Macro

The calendar data in PLC 1 can be corrected by the execution of the macro command “SYS 
(SET_CLND)”.
1. According to the macro format, set data for “year, month, day, hour, minute, and second” correctly 

at the relevant memory address.
2. Execute the SYS (SET_CLND) macro command as the ON macro of a switch, etc.

The calendar data is written in the PLC1.
The set calendar data is read.

<Example>

$u0
$u1
$u2
$u3
$u4
$u5

0
0
0
0
0
0

$u0
$u1
$u2
$u3
$u4
$u5

2007
    10
    15
    20
      0
      0

$u0
$u1
$u2
$u3
$u4
$u5

2007
    10
    15
    20
      0
      0

$u0
$u1
$u2
$u3
$u4
$u5

2007
    10
    15
    20
      0
      0

10/12/07
10:40:00

10/12/07
10:40:00

10/12/07
10:40:00

10/15/07
15:00:30

(1) Set data.
Set 2007/10/15 20:00:00.

$u0000 = 2007 (W)
$u0001 = 10 (W)
$u0002 = 15 (W)
$u0003 = 20 (W)
$u0004 = 0 (W)
$u0005 = 0 (W)

(2) Execute the macro command.
Set the calendar of PLC1, port 1 to 2007/10/15 20:00:00.

[ON Macro Edit]
$u100 = 1 (W)          (Port No.)
SYS (SET_CLND)  $u0000

Rewrite the PLC calendar.

Calendar readout

Calendar
07/10/12
10 : 40 : 00

07/10/15
20 : 00 : 00

Macro commands “PLC_CLND” and 
“SYS(SET_SYS_CLND)” are used to correct the 
calendar data in PLC2 to PLC8.
   
For more information, refer to the Macro 
Reference Manual.
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Correcting on the Main Menu Screen

Calendar data can be set on the SRAM/Clock screen to be displayed from the Main Menu screen.
For more information on the setting procedure, refer to the V8 Hardware Specifications Manual.
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13 Recipe Mode
Overview

Recipe mode is a data management system for more convenient and simple CSV file processing.

• Display
CSV file or data can be displayed in a tabular list form like Excel.

• Edit function
Data in the CSV file can be edited directly using the keypad.

96
M

B

CompactFlash Card

TARGET

>

PRODUCT PRO1

<

< >

. . 
PRO1
PRO2
PRO3
PRO4
PRO5
PRO6
PRO7
PRO8
PRO9

TEMP
55
56
55
54
53
52
50
49
48

SET
12
11
15
16
11
13
10
15
15

PRESS
150
50
100
150
50
100
10
150
50

MOVE
115
110
114
110
109
113
113
115
118

D
1
2
3
5
8
9
1
5
2

CF   PLC

CF   PLC

BITMAP

SRAM

CARD

DSP

FONT

HDCOPY

JPEG

MEMO

RECIPE

SAMPLE

SNAP

WAV

WEBSERV

DAT0000
CF Card

TARGET

TEST
NORMAL

PRODUCT.CSV

Folder Name File Name Record Name

Edit

TARGET

>

PRODUCT PRO9

<

< >

. . 
PRO1
PRO2
PRO3
PRO4
PRO5
PRO6
PRO7
PRO8
PRO9

TEMP
55
56
55
54
53
52
50
49
48

SET
12
11
15
16
11
13
10
15
15

PRESS
150
50
100
150
50
100
10
150
50

MOVE
115
110
114
110
109
113
113
115
118

D
1
2
3
5
8
9
1
5
2

0 . +- CR

1 2 3 CLR

4 5 6 DW

7 8 9 UP

15
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Not only data but also the title or record name can be edited.

• Files or records can be selected by pressing on the sheet so a batch of data can be transferred 
with ease.

Configuration

The recipe mode components are shown below.

TARGET

>

PRODUCT

<

< >

. .
PRO1
PRO2
PRO3
PRO4
PRO5
PRO6
PRO7
PRO8
PRO9

TEMP
55
56
55
54
53
52
50
49
48

SET
12
11
15
16
11
13
10
15
15

PRESS
150
50
100
150
50
100
10
150
50

MOVE
115
110
114
110
109
113
113
115
118

D
1
2
3
5
8
9
1
5
2

<

>S T U
CR

M N O

CLR

G H I DW

A B C UP

PRO6

D E F
J K L
P Q R
V W X

Y Z
>>

<<

BS DEL

TARGET
>

PRODUCT PRO9
<

< >

. . 
PRO1
PRO2
PRO3
PRO4
PRO5
PRO6
PRO7
PRO8
PRO9

TEMP
55
56
55
54
53
52
50
49
48

SET
12
11
15
16
11
13
10
15
15

PRESS
150
50
100
150
50
100
10
150
50

MOVE
115
110
114
110
109
113
113
115
118

D
1
2
3
5
8
9
1
5
2

CF   PLC

CF   PLC

Display area
Switches

Recipe folder name 
display

Recipe file name display

Switches



13   Recipe Mode

13-3

13

Setting Dialog

Recipe
Main

Command Memory This memory address controls the recipe mode.
11 words are used consecutively.  For more information, refer to 
“Command Memory” (page 13-7).

Target Memory This is the memory address from, or to which, CSV file data is 
transferred.*1

CSV file → Target Memory
Target Memory → CSV file

Info Output Memory This is the memory address that stores the recipe mode status.
29 words are used consecutively.  For more information, refer to “Info 
Output Memory.”

Action Area
(Display Area, Switch)

Choose the area where the data on CF card is to be displayed.
For more information, refer to page 13-12.

No. of Lines
(1 to 30)

This setting is valid when [Action Area: Display Area] is selected.
Specify the number of lines of data to be displayed.  When displaying more 
lines than the specified number, use the scroll switches [DW] and [UP].

No. of Columns
(1 to 100)

This setting is valid when [Action Area: Display Area] is selected and 
[ Hide Title/Data Area] is not checked.
Specify the number of columns of data to be displayed in the display area.  
When displaying more columns than the specified number, use the scroll 
switches [RGT] and [LFT].

Characters/Cell
(1 to 100)

This setting is valid when [Action Area: Display Area] is selected and 
[ Hide Title/Data Area] is not checked.
Specify the number of one-byte characters to be displayed in a cell.  When 
displaying more characters than the specified number in a cell, only the 
specified number of characters are displayed.
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*1 The number of transferable words is limited to 4,096.  Words exceeding this limit are not 
transferred.  Check [Info Output Memory] “n + 28” (page 13-10) to know whether the words to be 
transferred is more than 4,096 or not.

Edit

Choose this setting when using the edit function of recipe mode.
When using the edit function, you can edit the CSV file data, the CSV file name or record name.

*1 If you don’t press the [Register] button, the keypad or keyboard is not registered in the overlap 
library.

Display Order
(Ascending Order, 
Descending Order)

This setting selects the sort order to display the names of recipe folders 
and CSV files. 

Text Process
(LSB → MSB, 
MSB → LSB)

Set the recognition of MSB and LSB in one word.

 Edit Function Choose this setting when using the edit function.  The following setting 
items become active.

Key Display Position 
Overlap ID

Specify the overlap ID to be used for showing the keyboard.

Overlap Lib. No. for 
Numeric Input

Specify the overlap library number of the keypad to be used for inputting 
numerical data.
Pressing the [Register] button *1 registers the keypad in the overlap library.

Overlap Lib. No. for 
Character Input

Specify the overlap library number of the keyboard to be used for inputting 
characters.
Pressing the [Register] button *1 registers the keyboard in the overlap 
library.

REC0002 AAA

TEST

REC0000

 

 

GROUP

REC0001

REC0002 AAA

TEST
REC0000

GROUP

REC0001

Recipe folders are displayed first 
when [Ascending Order] is checked, 
and at the bottom when [Descending 
Order] is checked.

Ascending Order Descending Order

[LSB → MSB] [MSB → LSB]

MSB     LSB
1st byte

15                                     0

2nd byte

LSB    MSB
2nd byte

15                                     0

1st byte
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Style

*1 Depending on the character properties, cell size is determined.
Height: [Enlarge: Y] × 20 dots
Width: Depends on [Enlarge: X], [Property:  Italic], [Characters/Cell]

*2 If the size necessary for recipe mode (cell size × number of lines × number of columns) is greater 
than that of the display area, data that can be held in the display area part is displayed.  To bring 
hidden data into view, use the scroll switches [DW] and [UP].

Ruled Line
Color
Line Type

This setting is valid when [Action Area: Display Area] is selected and 
[ Hide Title/Data Area] is not checked.
It is possible to change the color and line type of the ruled lines.

Char. Prop.
Color
Property
Enlarge *1 *2

Point

For more information, refer to “Appendix 4  Styles and Coordinates.”

NORMAL\

TARGET\

TEST\

Automatic calculation from 
[Enlarge: /Y]

Automatic calculation from [Enlarge: X], [Property:  Italic], 
[Characters/Cell]
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Detail

Hide Title/Data 
Area

This setting is valid when [Action Area: Display Area] is selected.
Set data to be displayed in the display area.

• Unchecked
The folder name, file name, record name, title, and recipe data are 
displayed.

• Checked
The folder name, file name, and record name are displayed.

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

Example: Folder name display

NORMAL\

TARGET\

TEST0\

REC0000

REC0001

NORMAL\

TARET\

TEST

REC0000

Example: Folder name display
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Command Memory

The command memory controls recipe data.  11 words are occupied consecutively.

Memory Contents

n
For control

* For more information, refer to “n : For control” page13-8.

n + 1

File number designation
Used to designate a file from the PLC by not using a switch on the screen.
This is valid when the following conditions are satisfied.

• CSV file “RECxxxx.CSV”
• Bit 9 (file lock) or bit 8 (record lock) of “n” is set to “1”.

n + 2

Record number designation
Used to designate a record from the PLC by not using a switch on the screen.
This is valid when the following conditions are satisfied.

• CSV file “RECxxxx.CSV”
• Bit 8 (record lock) of “n” is set to “1”.

n + 3 to n + 6

Folder name designation (8 one-byte characters: 4 words)
Used to designate a folder from the PLC by not using a switch on the screen.
This is valid when the following conditions are satisfied.

• CSV file other than “RECxxxx.CSV”
• Bit 7 (folder lock) of “n” is set to “1”.
• Bit 8 (record lock) of “n” is set to “1”.
• Bit 9 (file lock) of “n” is set to “1”.

n + 7 to n + 10

Folder name designation (8 one-byte characters: 4 words)
Used to designate a file name from the PLC by not using a switch on the screen.
This is valid when the following conditions are satisfied.

• CSV file other than “RECxxxx.CSV”
• Bit 9 (file lock) or bit 8 (record lock) of “n” is set to “1”.
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• n : For control

(1) Record name edit [0]: Record name edit enabled
[1]: Record name edit disabled

(2) File name edit [0]: File name edit enabled
[1]: File name edit disabled

(3) Title name edit [0]: Title name edit enabled
[1]: Title name edit disabled

(4) Recipe data edit [0]: Recipe data edit enabled
[1]: Recipe data edit disabled

(5) Data transfer [0]: Transfer between card and PLC enabled
[1]: Transfer between card and PLC disabled

(6) Folder lock [0]: Folder selection switch enabled
[1]: Folder selection switch disabled

• Folder selecting procedure to be taken when the switch is disabled
1. Store the folder name in [Command Memory] “n + 3” to “n + 6”.
2. Set this bit to “1”.
3. The corresponding folder is selected.
* Even when the bit is “1” (ON), files or records in the folder can be 

selected as desired.

(7) Record lock [0]: Record selection switch enabled
[1]: Record selection switch disabled

• Record selecting procedure to be taken when the switch is disabled
1. Store the folder name in [Command Memory] “n + 3” to “n + 6”.
2. Store the file name in [Command Memory] “n + 7” to “n + 10”.
3. Store the record number in [Command Memory] “n + 2”.
4. Set this bit to “1”.
5. The corresponding record is selected.
* If the folder name specified in [Command Memory] “n + 3” to 

“n + 6” does not exist, no record is selected, but only folders and 
files in the “Recipe” folder are displayed when this bit is set (ON).

To be continued

(1) Record name edit

(2) File name edit

(3) Title name edit

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0

(4) Recipe data edit

(5) Data transfer

(6) Folder lock

(7) Record lock

(8) File lock

(9) Quick transfer

(10) Transfer 

(11) Transfer from card → PLC
(12) Transfer from PLC → card

(13) Not used(13) Not used
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* If the file name specified in [Command Memory] “n + 7” to 
“n + 10” does not exist, no record is selected, but only folders 
and files in the folder specified in “n + 3” to “n + 6” are displayed.

* When this bit is set (ON), all selection switches do not work.

(8) File lock [0]: File selection switch enabled
[1]: File selection switch disabled

• File selecting procedure to be taken when the switch is disabled
1. Store the folder name in [Command Memory] “n + 3” to “n + 6”.
2. Store the file name in [Command Memory] “n + 7” to “n + 10”.
3. Set this bit to “1”.
4. When this bit is set (ON), the corresponding file is selected.
* If the folder name specified in [Command Memory] “n+3” to 

“n + 6” does not exist, the file “RECxxxx.CSV” specified in “n + 1” 
is selected.  If the file “RECxxxx.CSV” does not exist, nothing is 
selected, and only folders and files in the “Recipe” folder are 
displayed.

* When this bit is set (ON), records can be selected from the 
selected file.  However, the file selection and folder selection 
switches are disabled.

(9) Quick transfer When bit 14 or bit 15 is set to “1” with this bit ON, data is transferred on 
completion of record selection in MONITOUCH.

(10) Transfer mode [0]: By record basis
When records exist, a record is transferred.

[1]: By file basis
The entire data of a file is transferred.  Even if a record is 
selected, the entire data of the file including the record is 
transferred.

(11) Transfer from 
card → PLC

At the leading edge of this bit [0 → 1], data is transferred from the card 
to the target memory.
When a record is selected and bit 13 is reset (OFF), one record is 
transferred to the target memory.
When no record is selected, or when a record is selected and bit 13 is 
set (ON), the entire data of the file is transferred to the target memory.
On completion of data transfer, bit 14 of [Info Output Memory] “n + 5” is 
set (ON).  Reset this bit to “0” after the completion of data transfer.

(12) Transfer from 
PLC → card

At the leading edge of this bit [0 → 1], data is transferred from the target 
memory to the card.
When a record is selected and bit 13 is reset (OFF), one record is 
transferred from the target memory to the card.
When no record is selected, or a record is selected and bit 13 is set 
(ON), the entire data of the file is transferred from the target memory to 
the card.
On completion of data transfer, bit 15 of [Info Output Memory] “n + 5” is 
set (ON).  Reset this bit to “0” after the completion of data transfer.

(13) Not used This bit must be “0”.
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Info Output Memory

This is the memory address that outputs the recipe mode status.  29 words are occupied 
consecutively.

• n : Card status

Memory Contents

n
Card status

* For more information, refer to page 13-10.

n + 1

Error number
When bit 0 of “n” is set to “1”, the error number is stored.  The following error 
numbers indicate the following content:

n + 2
File number
Valid when CSV file is “RECxxxx.CSV”.
The selected or transferred file number is stored.

n + 3
Record number
The selected or transferred record number is stored.

n + 4 to n + 7
Folder name (8 one-byte characters: 4 words)
Valid when CSV file is other than “RECxxxx.CSV”.
The folder name that contains the selected file or record is stored.

n + 8 to n + 11
File name (8 one-byte characters: 4 words)
Valid when CSV file is other than “RECxxxx.CSV”.
The selected or transferred file name is stored.

n + 12 to n + 27
Record name (32 one-byte characters: 16 words)
Valid when CSV file is other than “RECxxxx.CSV”.
The selected or transferred record name is stored.

n + 28

Transfer mode
The status of data transfer between the card ←→ the target memory is 
stored.

* For more information, refer to page 13-11.

(1) CF card error [0]: Normal
[1]: Error

(2) Not used This bit must be “0”.

Error No. Contents

4 CF card not installed or access stopped

12 CF card writing error

16 CF card reading error

(1) CF card error

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

(2) Not used



13   Recipe Mode

13-11

13

• n + 28 : Transfer mode

(1) Error [0]: Normal
[1]: An error has occurred during transfer.
When an error occurs, bit 10 or 11 (transferring) remains “1”.  Bit 14 
and 15 (transfer completed) remains “0”.

(2) Max. transfer [0]: 4096 words or less to be transferred
[1]: 4097 words or more to be transferred
The number of transferable words is limited to 4,096.  When this bit 
is set (ON), 4096 words from the top are transferred and the rest 
(after the 4097th word) are not transferred.

(3) Transfer from card → 
PLC

[1]: Transferring

(4) Transfer from PLC → 
card

[1]: Transferring

(5) Completion of transfer 
from card → PLC

[1]: Transfer completed
Reset the bit to “0” after confirmation of completion.

(6) Completion of transfer 
from PLC → card

[1]: Transfer completed
Reset the bit to “0” after confirmation of completion.

(7) Not used This bit must be “0”.

(1) Error

(2) Max. transfer

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0

(3) Transfer from card → PLC

(4) Transfer from PLC → card

(5) Completion of transfer from card → PLC

(6) Completion of transfer from PLC → card

(7) Not used
(7) Not used
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Display Area

A display area for the recipe mode shows folders in the CF card, CSV file names, or recipe data and 
record names in the CSV files.  Use display area parts to display such data.

* [ Reverse Definition of Lines/Columns] in the [Attribute Setting] dialog is not valid for display 
areas in recipe mode.  (This is valid for macro operation only.)

Style

Detail

Color Specify the color for the display area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified in the [Recipe] dialog.
For more information on the ID, refer to the Operation Manual.



13   Recipe Mode

13-13

13

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”
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Switch

Eleven switches in total are available with the recipe mode.  Four are dedicated to recipe mode and 
seven are commonly used for other functions.

Function Setting Item Contents

Recipe Folder Select Folder name,
Memory 
designation

(Character 
properties depend 
on the settings in 
the [Recipe] dialog.  
Enlargement factor 
is fixed to “1”.)

Data specified for [Folder Name] or data in the 
memory specified for [Memory Designation] is 
automatically displayed on the switch.
When the switch is pressed, the folder indicated 
on the switch is selected and its contents are 
displayed on the screen.

* If the folder indicated on the switch does not 
exist, the contents of the root folder 
(\RECIPE) are displayed.

TARGET
>

<

< >

. . 
PRODUCT1
PRODUCT2
PRODUCT3
PRODUCT4
PRODUCT5
PRODUCT6

TEST

NORMAL

Pressing the [TARGET] switch 
brings up the contents of the 
TARGET folder.
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Recipe File Select File name,
Memory 
designation

(Character 
properties depend 
on the setting in the 
[Recipe] dialog.  
Enlargement factor 
is fixed to “1”.)

Data specified for [File Name] or data in the 
memory specified for [Memory Designation] is 
automatically displayed on the switch.
When the switch is pressed, the file indicated on 
the switch is selected and its contents are 
displayed on the screen.

* If the file indicated on the switch does not 
exist in the folder (or if a different folder is 
selected), the switch does not work.  (An error 
buzzer sounds.)

Edit

−

The [Edit] switch is used for editing CSV file data, 
CSV file names, and record names or titles (only 
when titles or record names are used).
Press on the data or name to be edited.  The 
selected cell is displayed in reverse video.  When 
the [Edit] switch is pressed, the switch is turned 
on and a keypad for editing (overlap display) 
appears.  When a value is keyed in and the [CR] 
key is pressed, it is input and the keypad 
disappears.

To quit editing, press the [Edit] switch to turn it off.

Function Setting Item Contents

>
<

< >

. . 
#1
#2
#3
#4
#5
#6

#1
  100
  110
  100
  120
  100
  130

#2
    33
    32
    31
    30
    29
    28

#3
5550
5540
5400
5510
5520
5560

PRODUCT1

PRODUCT2

PRODUCT3

TARGET

TEST

NORMAL

TARGET

PRODUCT1

Pressing the switch 
selects the file and 
brings up the contents 
of the file.

Folder
File

>

PRODUCT PRO9

<

>

EMP SET
12
11
15
16
11
13
10
15
15

PRESS
150
50
100
150
50
100
10
150
50

MOVE
115
110
114
110
109
113
113
115
118

D
1
2
3
5
8
9
1
5
2

Edit
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Recipe Recipe 
Display

Display order
(0 to 23)

(Character 
properties depend 
on the settings in 
the [Recipe] dialog.  
Enlargement factor 
is fixed to “1”.)

This is valid when [Action Area: Switch] is 
selected.
CF card folders, CSV file names, and record 
names are displayed on switches instead of 
display areas.  When the [Recipe Display] switch 
is pressed, the folder, file, or record indicated on 
the switch is selected.

Depending on [Display Order] set for each switch, 
the positions where each folder, file, and record is 
displayed are determined.
A maximum of 24 switches can be placed for one 
recipe mode.

Change 
Display Order

−

Pressing this switch sorts the list of recipe folders 
and CSV files in ascending or descending order 
alternately.

Memory Card Transfer 
Card -> PLC

−

This switch is active when a record or a file has 
been chosen.
This switch transfers the selected record or file 
data from the CF card to the target memory.

Transfer 
PLC -> Card

−

This switch is active when a record or a file has 
been chosen.
This switch transfers the selected record or file 
data from the target memory to the CF card.

Function Setting Item Contents

TARGET

TEST

NORMAL

. .   

PRODUCT1

PRODUCT2

PRODUCT3

PRODUCT4

PRODUCT5

. . 

#1

#2

#3

#4

#5

0.
1.
2.
3.
4.
5.

1. 1.

0.
0.

Each time a switch is pressed, the names 
indicated on the switches change accordingly.

Folder Record

File

REC0002 AAA

TEST

REC0000

 

 

GROUP

REC0001

REC0002 AAA

TEST
REC0000

GROUP

REC0001

Recipe folders are displayed first in ascending order, 
and at the bottom of the list in descending order.

Ascending Order Descending Order
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Char. Display

* Record name display
[Recipe Record Name Display] is not available with the character display function.
To show the currently selected record name, place the data assigned to [Info Output Memory] 
(“n + 12” to “n + 27”).

Entry LFT
−

This switch is available while CSV file data is 
displayed in the display area.
Data scrolls to the left.

RGT
−

This switch is available while CSV file data is 
displayed in the display area.
Data scrolls to the right.

UP
−

This switch scrolls up the display of folders, files, 
records, or CSV file data.

DW
−

This switch scrolls down the display of folders, 
files, records, or CSV file data.

JPEG File Delete

−

This switch deletes the selected recipe file.
(Valid with [Action Area: Display Area] only)

* When data in the selected file is displayed, no 
switch operation is acceptable (an error 
buzzer sounds).

Function Contents

Recipe Folder Name Display The currently selected folder name is displayed.

Recipe File Name Display The currently selected file name is displayed.

Function Setting Item Contents
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Attribute

When handling a CSV file, be sure to set [Attribute].

*1 When using a macro command in the recipe mode, ensure that the CSV file name is correctly 
specified.  Note that the available file names, storage targets, or designation methods vary 
depending on the macro command.  For more information, refer to the Macro Reference Manual.

*2 A maximum of 256 (No. 0 to 255) attributes can be set.

Starting

Function and Setting CSV File Name Attribute

Recipe mode RECxxxx.CSV
xxxxxxxx.CSV

Recipe

Macro *1 LD_RECIPE RECxxxx.CSV

(Number designation)

LD_RECIPE2

LD_RECIPESEL

LD_RECIPESEL2

SV_RECIPE

SV_RECIPE2

SV_RECIPESEL

SV_RECIPESEL2

RD_RECIPE_FILE xxxxxxxx.CSV

(Name designation)

RD_RECIPE_LINE

RD_RECIPE_COLUMN

WR_RECIPE_FILE

WR_RECIPE_LINE

WR_RECIPE_COLUMN

Step 1 Select [System Setting] → [Attribute Setting].  The attribute window opens.

0000 to 9999

One-byte numerals 
or uppercase 
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Ending

Click the icon on the top left corner of the window and click [Close] or click the [×] button at the top right 
corner.

Step 2 • When creating a new attribute:
Right-click on the “Recipe” folder, and select [New Attribute].

• When selecting an existing attribute:
Double-click on the desired attribute number.

Step 3 The [Attribute Setting] dialog is displayed.

Step 4 Make the setting on the [Attribute Setting] dialog.  Refer to page 13-20.

or
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Setting
Attribute setting

 Use Title *1 Determine how to handle the first line in the CSV file.
• Unchecked

The first line in the CSV file is handled as “data.”

• Checked
The first line in the CSV file is handled as “title.”

6000 15 200

6100 15 201

6200 20 202

6300 20 203

..\ #1 #2 #3

#1  6000    15   200

#2  6100    15   201

#3  6200    20   202

#4  6300    20   203

CSV file Display on MONITOUCH

Title 1 Title 2 Title 3

6000 15 200

6100 15 201

6200 20 202

6300 20 203

..\ Title 1 Title 2 Title 3

#1 6000 15   200

#2  6100    15   201

#3  6200    20   202

#4  6300    20   203

CSV file Display on MONITOUCH
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 Use Record Name *1 Determine how to handle the first column in the CSV file.
• Unchecked

The first column in the CSV file is handled as “data.”

• Checked
The first column in the CSV file is handled as “record names.”

Transfer Mode
(Data, Record Name + 
Data)

The options become available when [  Use Record Name] is checked.
• Data

Only data is transferred.
• Record Name + Data

Record names and data are transferred.

Text Process
(LSB → MSB / 
MSB → LSB)

Set the recognition of MSB and LSB in one word.

[LSB → MSB]

[MSB → LSB]

No. of Bytes for Record
(0 to 32)

This option is active when [Transfer Mode: Record Name + Data] is 
selected.
Set the number of bytes used for a record name.

 Reverse Definition of 
Lines/Columns

This is not valid for the display in recipe mode.  Keep this box 
unchecked.  For more information, refer to the Macro Reference Manual.

No. of Columns
(1 to 4096)

This is valid when [  Reverse Definition of Lines/Columns] is selected.
Set the number of columns in the CSV file.  The record name column 
should not be included.

No. of Lines. *2
(1 to 4096)

This is valid when [  Reverse Definition of Lines/Columns] is selected.
Set the number of lines in the CSV file.

No. of Total Words *2
(1 to 4096)

This is automatically calculated from the data type of data.

Type Set the data type of data in the CSV file.
Type:  DEC, DEC-, HEX, OCT, BIN, CHAR, BCD, FLOAT
Decimal Point:  0 to 32
Word Count:  1-Word, 2-Word
Characters:  2 to 255

6000 15 200

6100 15 201

6200 20 202

6300 20 203

..\ #1 #2 #3

#1  6000    15   200

#2  6100    15   201

#3  6200    20   202

#4  6300    20   203

CSV file Display on MONITOUCH 

ITEM1 6000 15 200

ITEM2 6100 15 201

ITEM3 6200 20 202

ITEM4 6300 20 203

..\ #1 #2 #3

ITEM1  6000    15   200

ITEM2  6100    15   201

ITEM3  6200    20   202

ITEM4  6300    20   203

CSV file Display on MONITOUCH 

MSB     LSB
2nd byte     1st byte

15                                     

LSB    MSB
1st byte     2nd byte

15                                     
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*1 When using both titles and record names:

*2 The maximum possible number of columns or lines is 4096.  However, if [No. of Total Words] 
reaches 4096 words, columns or lines cannot be added even when the number of columns or 
lines is not greater than 4096.

When RECxxxx.CSV is 
Used
(xxxx : 0000 to 9999)

This option is valid when CSV file name is between REC0000.CSV and 
REC9999.CSV (number designation).  Set the CSV file number 
corresponding to the attribute setting.  The CSV file is stored in a folder 
under CF\ (access folder) \Recipe.

* This is not valid when the CSV file names are managed using any 
given names.

TEST1.CSV
TEST2.CSV
TEST3.CSV

MEMO

RECIPE

TEST

NORMAL

PRODUCT1.CSV
PRODUCT2.CSV
PRODUCT3.CSV
PRODUCT4.CSV
PRODUCT5.CSV
PRODUCT6.CSV

TARGET

REC0000.CSV
REC0001.CSV
REC0002.CSV

Under “Recipe” folder

- Title 1 Title 2 Title 3

ITEM1 6000 15 200

ITEM2 6100 15 201

ITEM3 6200 20 202

ITEM4 6300 20 203

..\ Title 1 Title 2 Title 3

ITEM1  6000    15   200

ITEM2  6100    15   201

ITEM3  6200    20   202

ITEM4  6300    20   203

CSV file Display on MONITOUCH
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Creating group folders

When using randomly given CSV file names*1, create a group folder*1 and store the CSV files.  Use 
the same attribute setting for all the CSV files in the same group folder.

*1 Group folder names and CSV file names with 8 or less numerals or uppercase alphabetic 
characters

Step 1 Right-click on the attribute number.  A drop-down menu is displayed.

Step 2 Select [New Group].  The “G000000” folder is selected.

Group folder
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Step 3 Set the folder name.  Right-click on the “G000000” folder.  A drop-down menu is 
displayed.

Step 4 Select [Change Name].  The name is highlighted and the cursor appears.  Input the 
desired name.

Step 5 Repeat steps 1 to 4 and create as many folders as you need.
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Default setting

One of the attribute icons is marked in red.  This is called the “default setting.”
The default setting is used in the following cases:

• There is no attribute setting corresponding to the file “RECxxxx.csv”.

• A group folder without an attribute setting is added to the CF card on Explorer.

TEST1.CSV
TEST2.CSV
TEST3.CSV

JPEG

MEMO

RECIPE

SAMPLE

TEST

NORMAL

PRODUCT1.CSV
PRODUCT2.CSV
PRODUCT3.CSV
PRODUCT4.CSV
PRODUCT5.CSV
PRODUCT6.CSV

TARGET

REC0000.CSV
REC0001.CSV
REC0002.CSV

Since there is no 
corresponding attribute 
setting, default setting 
(No. 1) is used.

REC0000.csv

REC0001.csv
REC0003.csv

Red mark
= Default setting

Attribute CF card

FINAL1.CSV
FINAL2.CSV
FINAL3.CSV
FINAL4.CSV
FINAL5.CSV

TOTAL

TEST1.CSV
TEST2.CSV
TEST3.CSV

JPEG

MEMO

RECIPE

TEST

NORMAL

PRODUCT1.CSV
PRODUCT2.CSV
PRODUCT3.CSV
PRODUCT4.CSV
PRODUCT5.CSV
PRODUCT6.CSV

TARGET

REC0000.CSV
REC0001.CSV
REC0002.CSV

Attribute No. 1 
(default) is applied.

Attribute No. 0 
is applied.

Attribute CF card
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CSV File

File Name and Store Target

Depending on the CSV file name, the store target as well as file designation method varies.  Create 
files according to their purpose.

* Group folder must be defined in the [Attribute Setting] dialog.  A group folder defined in the 
[Attribute Setting] dialog is automatically created when a CF card is inserted into MONITOUCH.

File Name Store Target

RECxxxx.CSV Access folder\Recipe\

Refer to the chart below.

xxxxxxxx.CSV Access folder\Recipe\ (group folder) \

Refer to the chart below.

0000 to 9999

Max: 8 one-byte numerals or 
uppercase alphabetic characters

Max: 8 one-byte numerals or 
uppercase alphabetic characters

TEST1.CSV
TEST2.CSV
TEST3.CSV

BITMAP

CARD

DSP

FONT

HDCOPY

JPEG

MEMO

RECIPE

SAMPLE

DAT0000

TEST

NORMAL

PRODUCT1.CSV
PRODUCT2.CSV
PRODUCT3.CSV
PRODUCT4.CSV
PRODUCT5.CSV
PRODUCT6.CSV

TARGET

REC0000.CSV
REC0001.CSV
REC0002.CSV

Access folder

Group folder

CF card
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Total Number of CSV Files

The number of group folders and CSV files in recipe mode is limited.
• The total number of group folders and CSV files in the “Recipe” folder:  1024 maximum
• The number of CSV files in a group folder:  1024 maximum

Folders or files exceeding 1024 are not 
recognized in recipe mode.

* When access to CSV files is made 
using a macro command, this 
limitation is not imposed.

However, note that access time is 
proportional to the number of files.

Data in CSV File
The number of transferable words

A maximum of 4096 words can be read and written at one time in recipe mode or using a macro 
command.  If you attempt to transfer data that exceeds this capacity, only the first 4096 words will be 
transferred and no more.

Lines and columns

Depending on the attribute setting, the available numbers of columns and lines vary.

*1 Excel can handle 256 columns maximum.
*2 Maximum word count per column:  4096 words
*3 Maximum word count per line:  4096 words
*4 File size:  1 M byte or less

Number of bytes for record

32 bytes maximum per record
* Make the setting in the [Attribute Setting] dialog.

Number of bytes for title

32 bytes maximum per title

Note

In the CSV file, ‘,’ (comma) and ‘ “ ’ (double quotation mark) are not recognized as data.
Note that the file may not be read correctly.

 Reverse Definition of 
Lines/Columns

 Reverse Definition of 
Lines/Columns *4

No. of Lines 1 to 32767 1 to 4096 *3

No. of Columns *1 1 to 4096 *2 1 to 4096

TEST1.CSV
TEST2.CSV
TEST3.CSV

HDCOPY

JPEG

MEMO

RECIPE

TEST

NORMAL

PRODUCT1.CSV
PRODUCT2.CSV
PRODUCT3.CSV
PRODUCT4.CSV
PRODUCT5.CSV
PRODUCT6.CSV

TARGET

REC0001.CSV
REC0002.CSV
REC0003.CSV

: 1024 maximum

: 1024 maximum

: 1024 maximum
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MONITOUCH Operation

Selection

When an action area is pressed, a folder or file can be selected.  It is also possible to select a folder, 
file, or record by designating its name or number from the command memory.

Folder selection

• Display area
If you double-touch a group folder name, the CSV file names in the folder are displayed.
* Every group folder name is followed by a “\”.

• Switch
If you touch a group folder name, the CSV file names in the folder are displayed.
* Every group folder name is followed by a “\”.

TARGET

>
<

< >

. . 
PRODUCT1
PRODUCT2
PRODUCT3
PRODUCT4
PRODUCT5
PRODUCT6

CF   PLC

CF   PLC

>
<

< >

NORMAL
TARGET
TEST
REC0000
REC0001
REC0002

CF   PLC

CF   PLC

Edit Edit

TARGET

>
<

CF   PLC

CF   PLC

>
<

CF   PLC

CF   PLC

NORMAL

TARGET

TEST

REC0000

REC0001

. . 

PRODUCT1

PRODUCT2

PRODUCT3

PRODUCT4

PRODUCT5

Edit Edit
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File selection

• Display area
If you double-touch on a file name, the file is selected and its data is displayed.

• Switch
If you touch on a file name, the file is selected and its records are displayed.

Record selection

• Display area
If you touch on a record, the record is selected.

TARGET

>

PRODUCT1

<

< > CF   PLC

CF   PLC

TARGET

>
<

< > CF   PLC

CF   PLC

. . 
PRODUCT1
PRODUCT2
PRODUCT3
PRODUCT4
PRODUCT5
PRODUCT6

. . 
PRO1
PRO2
PRO3
PRO4
PRO5
PRO6
PRO7
PRO8
PRO9

TEMP
55
56
55
54
53
52
50
49
48

SET
12
11
15
16
11
13
10
15
15

PRES
150
50
100
150
50
100
10
150
50

Edit Edit

TARGET PRODUCT1

CF   PLC

CF   PLC

TARGET

CF   PLC

CF   PLC

>
<

. . 

PRODUCT1

PRODUCT2

PRODUCT3

PRODUCT4

PRODUCT5
>

<

. . 

PRO1

PRO2

PRO3

PRO4

PRO5

Edit Edit

TARGET

>

PRODUCT1

<

< > CF   PLC

CF   PLC

TARGET PRODUCT PRO4

>
<

< > CF   PLC

CF   PLC

TEMP
55
56
55
54
53
52
50
49
48

SET
12
11
15
16
11
13
10
15
15

PRES
150
50
100
150
50
100
10
150
50

. . 
PRO1
PRO2
PRO3
PRO4
PRO5
PRO6
PRO7
PRO8
PRO9

TEMP
55
56
55
54
53
52
50
49
48

SET
12
11
15
16
11
13
10
15
15

PRES
150
50
100
150
50
100
10
150
50

. . 
PRO1
PRO2
PRO3
PRO4
PRO5
PRO6
PRO7
PRO8
PRO9

Edit Edit
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• Switch
If you touch on a record, the record is selected.

Return

• Display area
If you double-touch on the top left cell (..\) in the display area, you are taken one level higher in the 
hierarchy.

• Switch
If you touch on the top switch (..\), you are taken one level higher in the hierarchy.

TARGET PRODUCT1

CF   PLC

CF   PLC

TARGET PRODUCT PRO4

CF   PLC

CF   PLC

>
<

. . 

PRO1

PRO2

PRO3

PRO4

PRO5

>
<

. . 

PRO1

PRO2

PRO3

PRO4

PRO5

Edit Edit

TARGET

>

PRODUCT

<

< > CF   PLC

CF   PLC

TARGET PRODUCTPRO4

>
<

< > CF   PLC

CF   PLC

. . 
PRODUCT1
PRODUCT2
PRODUCT3
PRODUCT4
PRODUCT5
PRODUCT6

. . 
PRO1
PRO2
PRO3
PRO4
PRO5
PRO6
PRO7
PRO8
PRO9

TEMP
55
56
55
54
53
52
50
49
48

SET
12
11
15
16
11
13
10
15
15

PRES
150
50
100
150
50
100
10
150
50

Edit Edit

TARGET PRODUCT1

CF   PLC

CF   PLC

TARGET PRODUCT PRO4

CF   PLC

CF   PLC

>
<

. . 

PRO1

PRO2

PRO3

PRO4

PRO5

>
<

. . 

PRODUCT1

PRODUCT2

PRODUCT3

PRODUCT4

PRODUCT5

Edit Edit
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Transfer

Data can be transferred using a switch on the screen.  It is also possible to designate a file or record 
using the command memory and transfer data.

Record transfer

If you press the transfer switch [Card > PLC] or [PLC > Card] with a record selected, the selected 
record (one line) is transferred.

File transfer

If you press the transfer switch [Card > PLC] or [PLC > CARD] with a file selected (before a record is 
selected), the entire data of the selected file is transferred.

TARGET PRODUCT1

CF   PLC

CF   PLC

PRO4

>
<

. . 

PRO1

PRO2

PRO3

PRO4

PRO5

TARGET PRODUCT1 PRO4

>
<

< > CF   PLC

CF   PLC

TEMP
55
56
55
54
53
52
50
49
48

SET
12
11
15
16
11
13
10
15
15

PRES
150
50
100
150
50
100
10
150
50

. . 
PRO1
PRO2
PRO3
PRO4
PRO5
PRO6
PRO7
PRO8
PRO9

Data of record No. 4 in the CSV file is transferred to the target memory.

Edit Edit

TARGET PRODUCT PRO4

>
<

< > CF   PLC

CF   PLC

TEMP
55
56
55
54
53
52
50
49
48

SET
12
11
15
16
11
13
10
15
15

PRES
150
50
100
150
50
100
10
150
50

. . 
PRO1
PRO2
PRO3
PRO4
PRO5
PRO6
PRO7
PRO8
PRO9

TARGET PRODUCT1

CF   PLC

CF   PLC

PRO4

>
<

. . 

PRO1

PRO2

PRO3

PRO4

PRO5

When a CSV file is selected and no record is selected, the entire data of the file is 
transferred to the target memory (the maximum transferable size is 4096 words).

Edit Edit
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Edit
Data edit

• Display area
If you touch on CSV data with the [Edit] switch activated, a keypad for editing is displayed.  If you 
enter a value using the [CR] key, it is directly written into the CF card.  However, if you press on a 
cell that is only partially displayed, no keypad is displayed.

• Switch
Data editing is not possible because CSV data is not displayed on switches.

Name edit (file, record, title)

If you touch a file name, record name or title name (if set) with the [Edit] switch activated, a keypad for 
editing is displayed.  These names can be edited directly in the same way as data edit.  Note that only 
characters can be input.

TARGET PRODUCT

>
<

< > CF   PLC

CF   PLC

TEMP
55
56
55
54
53
52
50
49
48

SET
12
11
15
16
11
13
10
15
15

PRES
150
50
100
150
50
100
10
150
50

. . 
PRO1
PRO2
PRO3
PRO4
PRO5
PRO6
PRO7
PRO8
PRO9

TARGET PRODUCT

>
<

< > CF   PLC

CF   PLC

TEMP
55
56
55
54
53
52
50
49
48

SET
12
11
15
16
11
13
10
15
15

PRES
150
50
100
150
50
100
10
150
50

. . 
PRO1
PRO2
PRO3
PRO4
PRO5
PRO6
PRO7
PRO8
PRO9

<

>0 . +- CR

1 2 3 CLR

4 5 6 DW

7 8 9 UP

15

Edit enabled Edit disabled

Edit

TARGET

>
<

< > CF   PLC

CF   PLC

. . 
PRODUCT1
PRODUCT2
PRODUCT3
PRODUCT4
PRODUCT5
PRODUCT6

>

<

>S T U
CR

M N O

CLR

G H I DW

A B C UP

PRODUCT1

D E F
J K L
P Q R
V W X

Y Z
>>

<<

BS DEL
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14 Multimedia
14.1 Animation

Applicable Models

Overview

• When the predetermined bit is set ON, the picture is displayed; when the bit is set OFF, the picture 
is cleared.
You can easily set motion by switching pictures in a position or by moving a picture.

• Graphics can be created with dots in the [Frame Edit] area.
Bitmap data can be imported and used for animation.

• You can make an animation image opaque to the background color and display the picture exactly 
as you registered it (when transparent color is set).
In this case, even if animation pictures overlap each other, the image will not be corrupted or 
changed in colors.

Applicable Models Color

 V815iX, V812(i)S, V810(i)S, V810(i)T, V808(i)S 64k colors, 32k colors

Bit is ON Bit is OFF

1 frame

This picture does not react with the background color.

No problem even when images overlap each other.
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• It is not necessary to create a complicated program on the PLC for animation.  Because animation 
can be created easily using the settings on V8 series, you can create interesting screens such as 
screen saver or logo display with minimal effort.

• Using the scale function, you can create screens in synchronization with the PLC, which reflect the 
field condition in real time.

Animation can be performed by synchronizing 
with the value in the PLC, such as data from 
an encoder.

Use the scale function for 
these motions.

Use the scale function for these motions.
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Configuration

If you make an animation as shown below, the screen data is configured and explained.

Registration of animation
• Animation No. 0

(= register a panel to be used for 1.)
Frame: No. 0 to No. 1
Seconds to Replay: 1 second
(Changing and displaying frame No. 0 
and frame No. 1 in 1 second)

• Animation No. 1
(= register a panel to be used for 2.)
Frame: No. 2 to No. 3
Seconds to Replay: 1 second
(Changing and displaying frame No. 2 
and frame No. 3 in 1 second)

Setting animation on the screen
Make settings, such as the PLC memory address to be used for displaying the registered 
animation, or the sequences in which the registered animation should move.

1. Walking sideways

Animation No. 0

2. Walking forwards

Animation No. 1

Register frame No. 0 and frame No. 1 in 
relation with the setting of animation No. 0.

Frame No. 0 Frame No. 1

The picture of walking 
sideways

Register frame No. 2 and frame No. 3 in 
relation with the setting of animation No. 1.

Frame No. 2 Frame No. 3

The picture of walking 
forwards
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Setting Dialog

Main

*1 Contents of command memory

1) Animation display / no display (bit 0)
When this bit is set to “1” (ON), the image of the corresponding animation number is 
displayed.
When you reset it to “0” (OFF), the image is cleared.

Command Memory *1 This is the memory address to be used for displaying the registered 
animation.

Info Output Memory *2 This is the memory address to be used for checking the status of 
animation.

 Use Table Unchecked ( ):
An animation number or display position is designated from the specified 
memory.

Checked ( ):
Animation numbers and display positions are designated in the animation 
table.

Depending on this check box, the tab windows in the dialog changes.

 Continuous Replay Determine whether the defined animation should be replayed only once or 
continuously.

Unchecked ( ):
It is replayed only once.

Checked ( ):
It is continuously replayed.

• Animation table not used • Animation table used

1) Animation display / no displaySystem reserved (setting “0”)

2) Pause / resume 

3) Motion pause / resume

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB
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2) Pause/ resume (bit 1)
When this bit is set to ON, animation currently being played pauses.  When this bit is reset 
to OFF, pause is reset and play is resumed.

* This bit becomes active only when bit 0 (animation display / no display) is set to 
ON.

3) Motion pause / resume (bit 2)
When this bit is set to ON, the animation currently moving pauses.  When this bit is reset to 
OFF, motion is resumed.
* This bit becomes active only when bit 0 (animation display / no display) is set to 

ON.

• When you select the motion by on the animation table ([  Use Table]), motion is resumed 
from the position where it was paused.

• When the coordinate position is specified in memory with [   Use Table] and 
[Coordinates:  Memory Designation], motion is resumed from the position specified in 
the command memory.

*2 Contents of info output memory

• In the case of memory designation, the end bit is output when the animation playback time 
(seconds) has elapsed.

• In the case of using an animation table, the end bit is output when all the animations on the 
animation table have been replayed.

• If the animation is finished halfway through replay, the end bit is not output.
• In the case of scale designation, no output is made to the information output memory.

Playing

Frames are switched in accordance 
with the animation setting.

Set bit 1 to ON.

Pause

The animation pauses with the frame 
displayed when bit 1 is set to ON.

Reset bit 2 to OFF.
Set bit 2 to ON.
= Motion pause

Moving
Reset bit 2 to OFF.
= Motion resume

Reset bit 2 to OFF.
Set bit 2 to ON.
= Motion pause

Moving

Motion is resumed from the coordinates that are 
specified in memory when bit 2 was reset to OFF.

Reset bit 2 to OFF.

= Motion resume

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

1: End of animation *

* When animation is started, it is reset to “0”.
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Action

This tab window is displayed when [Use Table] is not checked ( ) in the [Main] tab window.

*1 When this box is not checked ( ), clicking [Open] brings up the 
reference dialog shown on the right.  The animation setting can 
be checked in this dialog.

*2 When this box is not checked ( ), clicking [Specify with Mouse] changes the mouse pointer into 
a cross cursor.  Specify the position where the image should be displayed.

Animation No.
 Memory 
Designation *1

Unchecked ( ):
Specify the animation number to be used for [No.].

Checked ( ):
Set the memory address to be used for specifying an animation number.

Coordinates
 Memory 
Designation *2

Unchecked ( ):
Specify [X] and [Y] coordinates (in units of dots) where animation should 
be displayed.

Checked ( ):
Set memory addresses to be used for specifying X and Y coordinates, 
respectively.

 Do Not Erase End 
Frame *3

Unchecked ( ):
On completion of replay, the image disappears even if the command bit 
remains ON.

Checked ( ):
The image of the end frame is shown even after completion of replay 
while the command bit remains ON.  When the command bit is reset 
(OFF), the end frame disappears.
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*3 Display example
• Unchecked ( ):

• Checked ( ):

Animation can be shown or cleared in accordance with the status of the command 
memory, which facilitates display control from an external device.

Animation is replayed when 
the command bit is set (ON).

On completion of its play, it 
disappears even if the 
command bit remains ON.

Animation is replayed when 
the command bit is set (ON).

The end frame is shown even 
after completion of replay while 
the command bit remains ON.

When the command bit is 
reset (OFF), the end frame 
disappears.
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Table

This tab window is displayed when [Use Table] is checked ( ) in the [Main] tab window.

 Table No.
(0 to 15)

You can set up to 16 tables for each animation.
Check the box ( ) for the table number to be used, select the table and click 
the [Edit] button.  The [Table No.] dialog is displayed.

* The setting items in the [Table] dialog are explained below.

Animation No. Specify the animation number to be displayed.

 Move Unchecked ( ):
Animation is displayed in the position specified for [Animation Replay 
Coordinates].

Checked ( ):
Animation will move.
The following setting items for movement become active.

Movement 
Pattern *1

None: Animation moves on a straight line path.
Circle (Clockwise): Animation moves on a clockwise circular 

path.
Circle (Counterclockwise): Animation moves on a counterclockwise 

circular path.

Movement 
Points *1
(2 to 32)

This option is active when [None] is chosen for [Movement Pattern].
Specify the desired number of movement points.

No. of 
Divisions *1
(2 to 31)

This option is active when [Circle] is chosen for [Movement Pattern].
Specify the number of divisions of the circumference.

 New *2 This setting is valid when you use the mouse to specify the coordinates.
If the coordinates have not been set yet, this box is checked.
If the coordinates have already been set, this box is not checked.

Full 
Circle *2

This option is active when [Circle (Clockwise/Counterclockwise)] is 
chosen for [Movement Pattern].
Check this box ( ) when you need the path of a perfect circle.

Specify with 
Mouse *2

Depending on the setting for [  New], the function varies.

[  New]:
A mouse cursor is displayed and you can create a path as desired.

[  New]:
An existing path on the screen can be selected.  You can change the 
position by dragging with the mouse.
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*1 Display example

*2 Display example

• When you select [Movement Pattern: None] with [  New], click the desired points on the 
screen in the same way as you draw a straight line.  The coordinates are defined in order.  
Double-click to determine the points.  The dialog is displayed again.  The number of times you 
clicked is automatically set for [Movement Points].  Specifying with mouse is automatically 
finished when you have set 32 points.

 Use WAV Unchecked ( ):
WAV files are not used.

Checked ( ):
You can play animation while playing a sound file (extension “*.WAV”).  The 
following setting items for sound become active.

Seconds to Replay
Seconds to Move

Depending on the setting for [  Move], the function varies.

[  Move]: (Seconds to Replay)
Set the length of time that animation keeps replaying in the specified 
position.

[  Move]: (Seconds to Move)
Set the length of time that the selected animation number moves.

Animation Replay 
Coordinates

If you check [  Move] above ( ), twice as many [Item] and [Coordinates] 
cells as you specified for [Movement Pattern] become active.  When setting 
[Coordinates], you can enter a numerical value directly through the keyboard 
or use the mouse to specify the moving positions.

 Start Frame 
Display *3

It is possible to animate the graphics like a baton pass using the table.
This setting is available for tables other than table No. 0.

 Do Not Erase 
End Frame Same as explained for [Not Delete End Frame] (page 14-6)

 Continuous 
Replay

Check this box ( ) if you want to play the sound all the time 
when the animation is replayed.

WAV File No. Specify the file number of the sound file to be linked.
For information on the sound files available, refer to “14.4  
Sound” (page 14-73).

1

2
3

4 5

6

1
2

3

4

5

6

7
8

91011
12

13

14

15

16

17
18

19 20

Example: In case of a straight line
Movement Points: 6

Example: In case of a circle
No. of Divisions: 20

Start point
Click

2nd point 4th point

3rd point End point

Click

Click

Click

Double-click
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• When [Movement Pattern: Circle (Clockwise/Counterclockwise)] with [  New] and [  Full 
Circle], specify the start and end points.

• When [Movement Pattern: Circle (Clockwise/Counterclockwise)] with [  New] and [  Full 
Circle], specify the start and end points.

• The path you created can be edited by selecting [  New] and [Specify with Mouse].  To show 
the path on the editing screen, check the box ( ) for [  Display Path of Animation] in the 
[Display Environment] dialog.
A straight line, continuous straight line, circle, or arc created by drawing is displayed in the 
editing window.

: Start point : End point

: Start point

: End point

Clockwise

Counterclockwise

Right-click to move back to the [Animation] dialog.

Path for animation
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*3 Display example

: Animation No. 0
: Animation table No. 1, with start frame display
: Animation table No. 2, with start frame display
: Animation table No. 3, with start frame display

When the command bit is set 
(ON), start frames of all 
animation tables are displayed.

When animations are played 
continuously, the same 
action is repeated.

When the replaying of all the animation 
tables have been completed, the 
graphics disappear (when end frame 
erasure is selected).

Table No. 0

No. 3

No. 1

• The start frame disappears when the animation of the table with the checked box ( ) has 
been started.

No. 2
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Scale

This tab window is displayed when [Use Table] is checked ( ) in the [Main] tab window.

*1 With or without scale designation
• When scale values are not used:

• When scale values are used:

 Scale Designation *1 When this box is checked ( ), scale values are used.  The following 
setting items for scale values become active.

Memory *2 Set the memory address used for showing scales.

Animation table No. When the animation table number is checked ( ) on the [Table] tab 
window, scale setting becomes available.

• No. 0 - 7: Animation table No. 7 to 7 are displayed.
• No. 8 - 15: Animation table No. 8 to 15 are displayed.

Set data for [Min. Scale] and [Max. Scale] for each table.

Max. Scale, Min. Scale *2 Specify the maximum and minimum scale values for each animation 
table.

Auto Setting *3 Use this setting when assign scale values to the tables at equal spacing.

50

50

50150

: Graphics to be moved
Coordinates (50, 50) must 
be specified from the PLC.

To move the graphics “+100” 
horizontally, “X150” must be 
specified from the PLC.

100

Define the graphic start position 
as (0, 0) on the screen.

When “100” is specified from the 
PLC, the graphics moves “100” from 
the start position.
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*2 Display example

• When [  Move] is checked in the [Table] tab window:
Animation table No.: 0
Animation No.: 2
[Move] checked: (The graphics moves as shown below.)
Scale: 0 to 100

The moving speed can be expressed by changing the scale value.

• When [  Move] is not checked in the [Table] tab window:
The timing to switch the animation number can be specified using a scale value.

The graphics is animated as shown below.

Table Animation Scale

No. No. Min. Max.

0 5 0 32

1 6 33 65

2 7 66 100

: Animation No. 2

(Moving range)

Scale: 0

The graphics are controlled by 
the scale value within the moving 
range set on the animation table.

Scale: 50

Scale: 100

0   32

33   65

66   100

Table No. 0 No. 1  No. 2 Scale

Table No. 0

Table No. 1

Table No. 2

Depending on the 
scale value, the 
corresponding 
animation is shown.

When showing scale 
values in a bar graph, it 
is possible to use 
animation in 
synchronization with 
the graph.

(Animation No. 5)

(No. 6)
(No. 7)
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*3 Setting example
When assigning scale values equally in the range from 0 to 3000 using the animation table No. 0 
to No. 3:

Detail

Process Cycle Set a cycle for the V series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

Min. Scale: 0
Max. Scale: Set “3000”.

Scale values are 
assigned equally.
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Registering Animation

Define and register animations in the animation area.

Opening the Registration Window

Click [Registration Item] → [Animation], the [Animation] window opens.  Animation can be registered 
on this window.

Depending on the setting on the [Animation VIEW] dialog, tree structure changes.
Make the setting on the [Animation VIEW] dialog and on the [Frame Edit] window in the animation 
area.
Depending on the folder on which you right-click: [Animation], [Animation No. xxxx] or [Frame No. 
xxxx], the menu items that become active vary.

[Animation] folder

[Animation No. xxxx] folder

[Frame No. xxxx] folder

Animation VIEW
Refer to page 14-16.

Animation VIEW
Refer to page 14-16.

Frame Edit
Refer to page 14-17.
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Animation VIEW

*1 A “frame” means each panel to be used for animation.

Graphics can be drawn in dots.  For more information on registration, refer to the next section.

 Use When this box is checked ( ), an animation number is set.  To clear the 
setting, uncheck this box.

Animation No.
(0 to 1023)

The animation number you are currently editing is displayed.
You can change the animation number by clicking the up/down arrow 
buttons.  You can also enter the number directly without using the buttons.

Start Frame No. to 
End Frame No. (0 to 
1022) *2

Set the scope (number) of the frames *1 to be used for animation.

Seconds to Replay
(×100 msec) *2

Set the switching cycle (speed) in which you switch and display the frames 
that you specified for [Start Frame No.] and [End Frame No.].

TEST When the frames have been registered, you can check the actual motion of 
animation.

PLAY If you click this button, the set frame is displayed within the 
time set for [Seconds to reply].

PAUSE Click this button to cause replay to pause.

STOP Click this button to finish display during a replay or pause.

 Repeat 
Playback

When you press the [PLAY] button, normally animation is 
played only once.
When this box is checked ( ), the set frame is played 
consecutively.

Frame No. 0 Frame No. 1 Frame No. 2 Frame No. 3
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*2 Display example
[Start Frame No.] [5]
[End Frame No.] [9]
[Seconds to Replay] [30] (× 100 msec)

Animation is switched as shown below.

Frame Edit

• For more information on frame editing and registration, refer to the Operation Manual.
• You can register a maximum of 1023 frames (0 - 1022).
• The frame has limitations in size, etc.  For more information, refer to page 14-21.

Frame No.5 Frame No.6 Frame No.7 Frame No.8 Frame No.9

30 ×  100 msec = Switches frames within 3 seconds

In the case of continuous replay, animation 
repeats after 3 seconds has elapsed.
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Notes

Animation Setting Position

An animation can be set only on the base screen.
Note that you cannot register it on overlap display parts.

Transparent Setting

You can hide a part of a picture (frame) in the animation you registered.

Transparent color setting for frame
1. Paint out non-display area of each frame using a color different from the color of the display area 

on the [Frame Edit] window.

2. Select [Transparent Color Setting] from the [Transform] menu.
Check [  With Transparent] and select the same color that you used to paint the non-display area 
out in step 1.

This makes the color in the non-display are transparent.  When you display the frame on the 
screen, the background can be seen though the non-display area.

The background can be 
seen through the frame.

The background can be 
seen through the frame.

Example:
Paint in red the part that you don’t 
want to show.

Red
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Transparent color setting for screen
In addition to a transparent color that can be set for each frame of animation, a color will be a 
transparent color for each screen due to the system structure.

To avoid this, set a color that is not used on the screen as a transparent color.
Follow the steps below.

1. Open the screen in which the animation is displayed.
2. Select [Screen Setting] from the [Screen Setting] menu.

The [Screen Setting] dialog is displayed.
3. Click [Others].

Select the desired transparent color for the animation setting.

If you use this color in a frame, the area in this color will not be shown and instead, the background will 
be displayed.

[Transparent Color] for 
the screen

[Transparent Color] 
of the frame

On the V8 screen

The area painted in the transparent color 
of the screen also becomes transparent.

Select a color that is 
not used in the frame.
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Structure of Layers

Animation is placed on the base screen; however, it actually exists in an area different from the base 
screen.
The figure below illustrates the screen structure.

As shown in the figure above, when you bring up an overlap display during animation, be sure to check 
the box for [Superimpose] for the overlap display part.
With [Superimpose] unchecked, animation is shown over the overlap display.
However, only one overlap display part with [Superimpose] checked can be shown on each screen.

CancelOK

Will start operation?

(1) Base screen or video
(2) Overlap display or video

(3) Animation (4) Overlap (Superimpose)

(5) Confirmation pop-up 
window
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Limitations

• Frame size limit
When the capacity per frame is 1 Mbytes or less, maximum resolution of the currently creating 
screen size (V812S, V810S, V808S; 800 × 600 dots, V810T; 640 × 480 dots) is available.

• Maximum number of motions
You can set up to 256 animation dialogs for each screen.
However, the maximum number of animations you can display simultaneously is 64.
Even if you set the bit ON, the 65th and subsequent animations will not be displayed.

• To display animation at a high speed:
When displaying animation at a high speed, the frame size and the number of frames per screen 
are limited.

Note that animation cannot be displayed at a high speed if either limitation has been exceeded.

Per frame Size: Width (W) × Height (H) = 9,600 dots or less

Example: 120W × 80H = 9600 dots

* The same limitation applies to the frames regardless of the number of 
colors: 64K colors, 32K colors, 128 colors, 16 colors and 8 colors.

Per screen The number of frames (Max): 32
(When you display the same frame simultaneously on the same screen, the 
number of frames is counted as one.)

120 dots

80 dots
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Setting Example

An animation shown below is explained.

Registration of the animation number and setting on the [Animation] dialog for the screen are 
explained below:
Registering animation

• Animation No. 0
(= register panels to move sideways)
Frame: No. 0 to No. 1
Seconds to Replay: 1 second
(Changing frame No. 0 and No. 1 and 
display in 1 second)

• Animation No. 1
(= register panels to move lengthways)
Frame: No. 2 to No. 3
Seconds to Replay: 1 second
(Changing and displaying frame No. 2 
and frame No. 3 in 1 second)

Animation setting

(0 , 50) (400 , 50)

(400 , 480)

Display when D100 bit 0 is set to ON

Moving 
lengthways in 
8 seconds

(V8 series models: VGA)

When it reaches here, the picture is no longer displayed.

Moving sideways in 10 seconds

Register frame No. 0 and frame No. 1 in 
accordance with the setting of animation No. 0.

Frame No. 0 Frame No. 1

The picture of 
walking sideways

Register frame No. 2 and frame No. 3 in 
accordance with the setting of animation No. 1.

Frame No. 2 Frame No. 3

The picture of walking 
forwards

[Main] Tab Window [Table] Tab Window

[Command Memory: D100] Table No. 0 Table No. 1

[  Use Table] [  Animation No.: 0] [  Animation No.: 1]

[  Continuous Replay]
[  Move]

[Movement Pattern: None]
[  Move]

[Movement Pattern: None]

[Movement Points: 2] [Movement Points: 2]

[Seconds to Move: 100] (× 100msec) [Seconds to Move: 80] (× 100 msec)

[Coordinates]
    [X0: 0]
    [Y0: 50]
    [X1: 400]
    [Y1: 50]

[Coordinates]
    [X0: 400]
    [Y0: 50]
    [X1: 400]
    [Y1: 480]
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14.2 Video/RGB Display
Applicable Models

Video display

* For information on the video display compatible with V6 models, refer to “2  Overlap”page 2-47.

RGB (input) display

Video & RGB (input) simultaneous display

Overview

Video Display

• NTSC/NTSC Square Pixel/PAL signals are displayed on the screen of the V8i.
You can show a video screen by simply placing and setting a video/RGB display item.

Applicable Models Applicable Option Units Video Channels

V815iX, V812iS, 
V810iS, V810iT, V808iS

GU-00 (V8i/V715X) 4CH

GU-10 (V8i only) 2CH

Applicable Models Applicable Option Units RGB Channels

V815iX, V812iS, 
V810iS, V810iT, V808iS

GU-01 (V8i/V715X) 1CH

GU-10 (V8i only) 1CH

GU-11 (V8i only) 2CH

Applicable Models Applicable Option Units Video/RGB Channels

V815iX, V812iS, 
V810iS, V810iT, V808iS

GU-10 (V8i only) 2CH/1CH

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

An image from the connected video input is displayed 
on the MONITOUCH screen.
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RGB (Input) Display

• The RGB input signal from the computer is displayed on the V8i screen.
You can show an RGB screen by simply placing and setting a video/RGB display item.

• By using the option unit “GU-10”, the video signal and the RGB signal can be read at the same 
time.
The video display and RGB input display can be shown on one screen.

However, the order of precedence determined for simultaneous display.

Precedence

High

Low

CH1 (Video)

CH2 (Video)

CH3 (Video)

CH4 (Video)

CH5 (RGB)

CH6 (RGB)

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

An image from the connected computer is displayed 
on the MONITOUCH screen.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Images from the connected video input as well as a computer 
are displayed on the MONITOUCH screen at the same time.
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Superimpose

When you display an ordinary operation screen (such as switches or text) that you created on an 
overlap display, over a video/RGB display, you can make the operation screen transparent so as not to 
obscure the video/RGB display.  (Superimpose)

4-channel Display

• You can display up to four channels on one screen.  (Select from: 1, 2, 4 channels)
• Two or four channels take a little longer to display than one channel.

However, you can adjust the process speed by specifying a priority in display.  (Specify Display 
Priority)

* When you switch the channels while only one channel is displayed, use [Video Display] of 
an overlap display part.
For more information, refer to “2  Overlap” (page 2-47).

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Video Monitoringngn Display Adjustment

ContrastBrightness Color

Overlap
(With superimpose)

Video/RGB display

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Example 1:  4-channel display Example 2:  2-channel display
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Snapshot Function

You can capture an image of a video/RGB screen and save it on a CF card.  Double-click on the 
video/RGB screen or execute the macro command “SNAP”.  There are three snapshot functions.

• Single Snap
One video/RGB image that is currently displayed is captured when a snapshot is taken.

* When a macro command (background SNAP) is used, a snapshot can be taken while the 
video screen is not displayed.  For more information, refer to the Macro Reference Manual.

• Continuous Single Snap (New)
The video/RGB image that is currently displayed is captured continuously at regular intervals.

• Strobe Snap
A number of frames (16 frames in total) are captured as continuous shooting.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEMVideo

Execute 
“SNAP” !

Take a snapshot of the image currently displayed.
(The image is saved on a CF card when it is inserted.)

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEMVideo

Take a snapshot of the image currently displayed at 
regular intervals.
(The images are saved on a CF card when it is inserted.)

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEMVideo

Take strobe snapshots of the image displayed currently.
(The images are saved on a CF card when it is inserted.)

Execute “STROBE SNAP” !

16 frames in total (each frame 160 × 120 dot size)
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JPEG Display

You can display a snapshot image, which was saved onto a CF card as a JPEG file, on the screen 
again.
If you execute “SNAP” when using a CF card, the video/RGB snapshot image is automatically saved 
as a JPEG file into a certain folder on the CF card.  It can be called and displayed by using [JPEG 
Display] item on the screen.
For more information, refer to “14.3  JPEG Display” (page 14-65).

Operation by Double-clicking

You can set the action to be performed by double-clicking on the video image displayed.

96
M

B

CompactFlash Card

96
M

B

CompactFlash Card
F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEMSnap imageVideo

The snapshot image (JPEG file) stored in the CF card 
is displayed by using “JPEG Display Function”.

Screen changed

CF 
card

Save

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEMVideo

Example:  Enlarged display

Double-click on the screen The display is enlarged.
(By double-clicking once again, the size is reset.)
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Specifications

Display size
The image taken into video/RGB display may or may not be the same in size as the actual image.

If the display size is smaller than the input signal size, the start position of the image clip size can be 
adjusted on the V8i to change the displayable area size.  For more information, refer to “Display Size” 
(page 14-39).

Configuration

• The video display item components are shown below.

Item
Specifications

Video RGB Input

Type Composite video signal Analog RGB

Input signal
NTSC

NTSC Square Pixel
PAL

Analog straight polarity 0.5 V - 1.0 
Vp-p

(75Ω at the end)

Operation mode
NTSC   ITU-R BT. 601
NTSC   Square Pixel
PAL    ITU-R BT. 601

-

Sampling frequency 13.5 MHz -

Display size (Refer to “Display size” below.)

Display color
GU-00 / GU-10 

/ GU-11
V815/V810/V812 16,777,216 colors 256 gray scales
V808 262,144 colors 64 gray scales

GU-01 - 65,536 colors 64 gray scales

External connection BNC co-axial connector D-SUB15 pin (mini)

Input Signal Input Signal Size Display Size
(= image clip size)

Video

NTSC   ITU-R BT. 601 720 × 485 640 × 480

NTSC   Square Pixel 640 × 485 640 × 480

PAL    ITU-R BT. 601 720 × 578 720 × 578

RGB input VESA

640 × 480 640 × 480

800 × 600 800 × 600

1024 × 768 1024 × 768

Video/RGB display icon
= [Video/RGB Display] dialog

Display area

PAUSE switch

RESTART switch
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Setting Dialog

Video/RGB Display
Main

No. of Channels
                      *1 *4
(1CH, 2CH, 4CH)

Specify the number of channels, among those which are connected to the 
V8i or a computer, to be displayed on the display area part linked to the 
[Video/RGB Display] item.
Display size per channel should be set for [Display Size].

Channel Select *2
(Area 1, Area 2, Area 
3, Area 4)

Specify the channel to be displayed in each video/RGB display area.
The areas to be set vary depending on the number set for [No. of 
Channels] mentioned above.

The available number of channels varies depending on the option unit 
used.

Display Size *3 *4 
(Free, 160*120, 
320*240, 640*480, 
640*240)

Select the dot size for one channel.
The size is determined with respect to the top left corner of the display area 
part that is placed on the screen.
When [Free] is selected, the display size can be determined as required.

4 3 2 1 556125

CH1CH2RGB-IN RGB-IN1RGB-IN2 CH1CH2CH3CH4 RGB-IN

1 CH1 (Video)

2 CH2 (Video)

3 CH3 (Video)

4 CH4 (Video)

5 CH5 (RGB)

6 CH6 (RGB)

GU-10 GU-11 GU-00 GU-01
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*1 Display example
• No. of Channels: 1

• No. of Channels: 2

• No. of Channels: 4

Fit to display area This is active only when [Free] is selected for [Display Size].

Unchecked:
The video/RGB screen is displayed only within any display size you set.
Checked:
The video/RGB screen is displayed with automatic scaling to fit in size “Y” 
of the set display size.

For more information, refer to “Display Size (Image Clip Size) and Display 
Area” (page 14-40).

Video Setting For more information, refer to page 14-43.

320 × 240160 × 120

640 × 240

640 × 480

320 × 240160 × 120 640 × 240

320 × 240160 × 120
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*2 Display example

*3 Display example
• No. of Channels: 1, Display Size: 320 × 240

• No. of Channels: 2, Display Size: 320 × 240

* To change the display size during video/RGB display, use [Enlarge] display function 
(fixed to 640 × 480 dots) or use a video overlap display part.
For more information on video overlap display, refer to “2  Overlap” on page 2-47.

*4 The number of channels and the display size can be combined as shown below.

* When the display size is 640 × 240:
When the display size is 640 × 240, displays in the upper and lower half areas can be switched 
using internal memory $s957.
For more information, refer to page 14-45.

Display Size No. of Channels
160 × 120

1CH, 2CH, 4CH
320 × 240

640 × 240  * 1CH, 2CH

640 × 480 1CH

• [No. of Channels: 1] • [No. of Channels: 2]

or• [No. of Channels: 4]

Area 1 Area 1 Area 2

Area 1 Area 2

Area 3 Area 4

Area 1

Area 2

Area 1

320

240

Area 1 Area 2

320

240

320
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Action

Double Click Action Select the action to be performed by double-clicking on a video/RGB 
image.

Display Location when 
Enlarged *5
(Centering, Upper 
Right, Lower Left)

This option becomes active when you use video display function on an 
SVGA model (V812iS, V810iS, V808iS).
If you have enlarged the display (by double-clicking or using macro 
“ZOOM”), a part of the base screen is shown because the video display 
size is 640 × 480 dots on the SVGA model.
In this case, specify the video display position.

 Specify Display 
Priority *6

This option becomes active when you specify [2] or more for [No. of 
Channels] on the [Main] tab window.
Normally video of each channel is displayed at a uniform speed; however, 
when multiple channels are used, the speed will be slower than when only 
one channel is used.
With this priority setting, you can make one channel display faster than the 
other channels.
Display priority is available with one channel per screen.

 Display Operation 
Screen When 
Clicking
(Superimpose)

When you use this function, you cannot use [Double Click Action] 
mentioned above.  When this box is checked ( ), the specified overlap 
display appears over the video/RGB display when you press on the video 
image.
(For information on “Superimpose,” refer to page 14-52.)

If you press the [Register] button, you can use a default overlap screen 
equipped with functions for picture adjustment (brightness, contrast, and 
color) including the snapshot function.  For more information, refer to 
page 14-54.

None No action

Specify Display 
Priority *1

This option becomes active when you specify [2] or more for 
[No. of Channels] on the [Main] tab window.
When double-clicking on a channel being displayed, that 
channel is displayed on a priority basis (= more frames and 
faster display speed than the other channels.)

Enlarge/Resize 
*2

You can enlarge the image (640 × 480 dots) by double-clicking 
and reset it to the original size by double-clicking again.

Single Snap “SNAP” is executed by double-clicking.  When an image is 
being imported, the video/RGB image is displayed as a 
still-frame image.  It is reset when the import is completed.

Continuous 
Single Snap *3

“SNAP” is executed continuously by double-clicking.  When an 
image is being imported, the video/RGB image is displayed as 
a still-frame image.  It is reset when the import is completed.

Strobe Snap *4 “STROBE SNAP” is executed by double-clicking.  (The strobe 
snapshot video/RGB images remain displayed as still-frame 
images.)
By double-clicking again, it is reset to the original video/RGB 
display.
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*1 When [Specify Display Priority] is selected:

*2 Display example

*3 Continuous Single Snap
The target video image is imported by taking snapshots continuously at regular intervals for the 
serial shoot duration.

*4 Strobe Snap
The target video image is imported by taking a number of frames similar to continuous shooting.  
The copied frame images are displayed on the full screen on MONITOUCH.  16 snapshots (160 
× 120 dots each) are processed as one image (640 × 480 dots).

When taking strobe snapshots, other operations or macro commands are not possible.
Wait until strobe snapshots have been completed.

CH1 CH2 CH1 CH2

Double-click Display of the double-clicked channel has 
priority (= the number of frames increases).
Display speed of CH1 decreases (= the 
number of frames decreases).

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEMVideo

Double-click on the image you want to enlarge. The double-clicked image is enlarged.
(By double-clicking again, it is reset to the original size.)

1 2 3 4

5 6 7 8

9 10 11 12

13 14 15 16

Strobe snapshot order
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*5 Display example

*6 Display example
• Unchecked ( ):

• Checked ( ):

[Centering]

Video enlarged display

[Upper Right]

Video enlarged display

[Lower Left]

Video enlarged display

CH1 CH2

Normally, both are displayed with the 
same number of frames

Base screen
CH1

CH3 CH4

CH1

CH2

CH2: With display 
priority setting

[No. of Channels: 4]
[  Specify Display Priority: CH2]

[No. of Channels: 1]
[  Specify Display Priority: CH1]
[No. of Channels: 1]
[ Specify Display Priority]

CH1

CH2
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Snap
This tab window becomes active only when a CF card is inserted in the V8i.

*1 Setting example

When screen data contains both snap settings of [Auto] and [Specify], specify a number in the 
range from 255 to 32767 to prevent the files of [Specify] from being overwritten with those of 
[Auto].
When [Auto] is selected, the number of the last snapshot is stored in system memory $s932.  
(Refer to page 14-47.)

*2 It is possible to save an image that is superimposed on a video/RGB display.
For more information, refer to page 14-45.

Snap File Name
(Auto, Specify) *1 *2

[AUTO]: (0 to 254)
If you select this option, snap files are saved automatically under 
consecutive numbers starting from “VD00000.jpg”.
When [Maximum Number of Snap Files in Auto] (refer to page 14-39) has 
been reached, the existing files are overwritten from “VD00000.jpg”.

[Specify]: (0 to 32767)
Be sure to specify a file number.
The snap files are saved under “VDxxxxx.jpg” starting from the specified 
number.  If the specified file already exists, it is overwritten.

Strobe Speed *2
(1 - 255) (× 100 msec)

This is valid when you execute “Strobe Snap.”
Set the speed for shooting snapshots.

Serial Shoot Duration
(1 - 180) (× sec)

This is valid when you execute “Continuous Single Snap.”
Set the duration for taking snapshots continuously.

Snap Interval
(1 - 25) (× sec)

This is valid when you execute “Continuous Single Snap.”
Specify an interval between shootings when taking snapshots 
continuously.

• [Snap File Name: AUTO]
[Maximum Number of Snap Files in Auto: 10]

• [Snap File Name: Specify]
[File No.: 30]

Saved under 
consecutive 
file numbers

VD00000.jpg
VD00001.jpg
VD00002.jpg

VD00008.jpg
VD00009.jpg

VD00030.jpg

When reaching the 
limit number, the 
files are overwritten 
from the first file.

The specified file is 
overwritten.
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* Snap and CF card
When a CF card is inserted in the V8i, snapshot images are stored on the CF card.
When you insert a CF card into the V8i, the following folders are created for screen data.

Snapshot images are saved in the “SNAP” folder under the file name “VDxxxxx.jpg” (0 to 32767).
Each image of [Single Snap] or [Strobe Snap] is saved as one JPEG file.

* JPEG file colors of snapshots
The number of colors available with snapshots will vary depending on the display image size at 
the time of shooting.  Refer to the chart shown below.

Option Unit Image Size at the Time of Shooting Colors Available with 
JPEG Files

GU-10/GU-11/GU-00
(Video/RGB input)

Same as the image clip size 16M colors

Enlarged or reduced from the image clip size 64k colors

“Strobe Snap” 64k colors

RGB input - 64k colors

BITMAP

SRAM

CARD
DSP
FONT
HDCOPY
JPEG
MEMO
RECIPE
SAMPLE
SNAP

WAV
WEBSERV

DAT0000
CF Card

TEST
DEMO

(Access folder) *

* You can give a desired name 
for the access folder for each 
screen data file.

(Access folder) *
(Access folder) *

VD00000.jpg

VD00005.jpg
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Detail

Display Area

Display area parts are not displayed on the V8i.  Place a display area part to determine the video/RGB 
display position on the editor.

Style

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”
The display area size is automatically calculated in the editor from [Display Size] and [No. of Channels] 
that are set in the [Video/RGB Display] dialog.  The display area is automatically resized and placed.

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

Color Set the color inside the area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified in the [Video/RGB Display] dialog.
For more information on the ID, refer to the Operation Manual.
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Switch Parts for Video/RGB Display 

The following switches can be used for video/RGB display.
This section describes essential setting items for switches that are used together with video/RGB 
display.

Main

Detail

Function Select [Pause] or [Restart], and set the target channel.

Pause:
The video display pauses into a still-frame image.

Restart:
The still-frame image of video display is canceled.

* This setting is invalid for RGB display.

ID Set the same ID as specified in the [Video/RGB Display] dialog.
For more information on the ID, refer to the Operation Manual.
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Display Size

The video/RGB image is displayed in the display area part placed on the screen.  However, depending 
on the input signal size of the video image, the size displayable on the V8i, and the display area size 
placed on the screen, the image may appear differently on the screen.
In this section, the display size is explained in respective cases.

Display Size List

Example 1:  NTSC ITU-R BT. 601

The image of display size is clipped from the image of input signal size.  Consequently, the imported 
image will be smaller than the actual video image.  The start position (= clip start position) can be 
changed.

Input 
Signal Input Signal Size Display Size

(= image clip size)
Clip Start Position

(default)

Video

NTSC  ITU-R BT. 601 720 × 485 640 × 480 (40, 0)

NTSC  Square Pixel 640 × 485 640 × 480 (0, 0)

PAL  ITU-R BT. 601 720 × 578 720 × 578 (0, 0)

RGB input VESA

640 × 480

60Hz

640 × 480 (0, 0)
72Hz

75Hz

85Hz

800 × 600

56Hz

800 × 600 (0, 0)

60Hz

72Hz

75Hz

85Hz

1024 × 768 60Hz 1024 × 768 (0, 0)

485

720

640

480

NTSC

Display size (image clip size)

Input signal sizeClip start position 
= (40, 0)
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Example 2:  PAL ITU-R BT. 601

The image of input signal size is scaled down to the display size.

Display Size (Image Clip Size) and Display Area

With the [Video/RGB Display] item, if you specify [Display Size], the display area part automatically 
changes to the specified size where the clipped video/RGB image will be displayed.

However, if you select [Free] for [Display Size], the display area part size will not change automatically 
but will be scalable as desired.
At the same time, the check box [  Fit to display area] becomes active.  This box determines whether 
you want to scale the video/RGB image to fit into the display area or to display the image at the same 
magnification as much as the display area can hold.

578

720

640

480

PAL

Display size (image clip size)

Input signal size

If you change the size from 
“160 × 120” to “320 × 240”:

The display area is automatically enlarged.

The display area size can be 
set to “320 × 150”.
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Example 1:  1CH display

Example 2:  2CH display

640

480

640

240

Display size
(image clip size)

To show the image in the display 
area shown above:

[Display Size]: Free
[  Fit to display area] unchecked

[Display Size]: Free
[  Fit to display area] checked

The image at the same 
magnification is 
displayed as much as the 
display area can hold. According to the vertical size of the display image, the 

image is reduced.
(The excess area will be filled with transparent display.)

Transparent 
display

640

480

640

210

Display size
(image clip size)

To show the image in the display 
area shown above:

[Display Size]: Free
[  Fit to display area] unchecked

[Display Size]: Free
[  Fit to display area] checked

The image at the same magnification 
is displayed as much as the display 
area for each channel can hold.

According to the vertical size of the 
display image, the image is reduced.  
(The excess area will be filled with 
transparent display.)

Transparent display



14.2 Video/RGB Display

14-42

Clip Start Position

If the image is displayed at the default clip start position, it may extend off the edge of the display area 
or may not be centered.

If you want to show a certain portion of the entire display size (image clip size) of video/RGB image, 
change the clip start position and adjust the display area part.

* The clip start position can be changed using the macro command “CLIP_POS”.
For more information, refer to “Macro” (page 14-47).

400

320

Clip start position = (40, 0) *

[Display Size]: Free
[  Fit to display area] unchecked

Adjust the display area to 
the size of the image you 
want to clip.

The image of the display area size is 
captured and displayed with respect to the 
clip start position at the upper left corner.

400

320

Clip start position = (120, 70) * Use a macro command to change the clip start position.

[Display Size]: Free
[  Fit to display area] unchecked

Adjust the display area to 
the size of the image you 
want to clip.

The image of the display area size is 
captured and displayed with respect to the 
clip start position at the upper left corner.
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Video/RGB Settings

When using a video/RGB display item, be sure to make these settings.
Select from the [Main] tab window of the [Video/RGB Display] dialog or select [System Setting] → [Unit 
Setting] → [Video/RGB].

Video Input
(NTSC, NTSC Square Pixel, 
PAL)

Select the video input signal to be used.

Maximum Number of Snap 
Files in Auto
(0 - 255)

Snapshot images are saved on a CF card when [Auto] is selected 
(page 14-35).  Specify the maximum number of files to be saved 
automatically.

When the Snap File 
Limitation is Exceeded
(Stop, Overwrite)

Set the processing rule when [Maximum Number of Snap Files in 
Auto] mentioned above has been exceeded.

[STOP]:
When the limitation has been exceeded, snap shooting stops.

[Overwrite]:
When the limitation has been exceeded, the images are saved 
while overwriting files from the first file.

Snap File Compression 
Rate
(Low, Middle, High)

Set the file compression rate for snap files.
High: The file size is small but image quality is lowered.
Middle: The file size and image quality are at an intermediate level 

(twice the “High” level).
Low: The image quality is good but file size is bigger (twice the 

“Middle” level).
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System Memory ($s)

The status of video display is output in the system memory ($s) of the internal memory.
For more information, refer to “Appendix 6  Internal Memory.”

Address ($s) Contents

910 Video  CH1  Brightness

911 Video  CH1  Contrast

912 Video  CH1  Color intensity

913, 914 (System reserved)

915 Video  CH2  Brightness

916 Video  CH2  Contrast

917 Video  CH2  Color intensity

918, 919 (System reserved)

920 Video  CH3  Brightness

921 Video  CH3  Contrast

922 Video  CH3  Color intensity

923, 924 (System reserved)

925 Video  CH4  Brightness

926 Video  CH4  Contrast

927 Video  CH4  Color intensity

928, 929 (System reserved)

930   *1 Video status

931   *2 Composition of video and superimpose screen

932   *3 AUTO  File number

933   *4 Focus  CH number (Display Priority)

934   *5 CH number of the display area touched

935   *6 Video  Brightness of the selected video area

936   *7 Video  Contrast of the selected video area

937   *8 Video  Color intensity of the selected video area

957   *9 Video  Display change (640 × 240 dots only)

961   *15 Video Standard size setting (for V815iX only)

962   *10 The number of “Continuous Single Snap” times

966   *11 Video Clip start position of the current channel 
(X coordinate at the top left corner)

967   *11 Video Clip start position of the current channel 
(Y coordinate at the top left corner)

968   *12 Video Image clip size of the current channel (width)

969   *12 Video Image clip size of the current channel (height)

970   *13 RGB IN The maximum number of snap files

971   *14 RGB IN Processing when the snap file limitation is exceeded
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*1 $s930 (Video status)

* Bit 0 (Snap shooting)
When saving on a CF card, VGA (640 × 480 dots) size takes about 4 or 5 seconds.

*2 $s931
It is possible to save a screen superimposed on a video/RGB display.
Operate internal memory $s931 using macro commands.

* Notes
• Strobe snapshots are displayed in 640 × 480 dots from the top left corner regardless of the 

display area setting.  Only the area that overlaps this position is superimposed.
• On the JPEG file saved, the superimposed image cannot be transparent.

*3 $s932
This is active when you select [AUTO] in the [Snap] tab window.
The file number that was shot last is stored.
For more information on [AUTO] in the [Snap] tab window, refer to page 14-35.

*4 $s933
The channel number (1 to 4) having priority is stored.
If no channel is given priority, “−1” is stored.

*5 $s934
The channel number (1 to 4) that you touched in the display area is stored.
As default, “1” is stored.

*6 $s935
The brightness of the channel that you touched in the display area is stored.

*7 $s936
The contrast of the channel that you touched in the display area is stored.

*8 $s937
The color intensity of the channel that you touched in the display area is stored.

*9 $s957
This is valid when you use a display size of 640 × 240.
The display in the upper and lower half areas can be switched.

Value JPEG
0 Video image only

1 Video image + superimpose

1: Snap shooting
1: Video board error occurred 1: Snap files full

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

System reserved (setting “0”)

CH1
0: Upper half display
1: Lower half display

CH2
0: Upper half display
1: Lower half display

CH3
0: Upper half display
1: Lower half display

Not used

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

CH4
0: Upper half display
1: Lower half display
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*10 $s962
The number of “Continuous Single Snap” times is stored.
(This is cleared to zero once at the start of continuous snapshots.)

*11 $s966, $s967
The clip start position of the current channel (X, Y) is stored.

*12 $s968, $s969
The image clip size of the current channel (width, height) is stored.

*13 $s970
The maximum number of snapshots using the macro command “SET_RGB” is set.
(Value: 0 - 255)

*14 $s971
The action to be taken when the maximum number specified at $s970 has been exceeded is set.
(0: Stop, 1: Overwrite)

*15 $s961 (for V815iX only)
This is used to set the standard video size.  The size setting is executed only with an initial 
macro.
The video item display size is set to 640 x 480.

00: 640 × 480
01: 800 × 600
10: 1024 × 768

Not used

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB
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Macro

By using macro commands, you can make action or color adjustment on the video/RGB display.

Video Display Default Setting
When no macro command is used, the video screen is displayed under default conditions.

Video/RGB Macro Commands

The macro commands available with video/RGB display items are those of “VIDEO2” type.

The macro command “VIDEO” is available only with video overlap parts.
For more information, refer to “2  Overlap” (page 2-47).

Command selection:

Item Type Default Value

Brightness 0 (dark) to 31 (bright) 16

Contrast 0 (weak) to 31 (strong) 16

Color intensity 0 (light) to 31 (deep) 16

Name Auxiliary Setting Item

Content

SNAP Channel:  [Auto], [CH (1 - 6)]
File No.:  [AUTO], [No. designation (0 to 32767)]

“Single Snap” is executed.
When you use a CF card, you can specify the method for storing the 
snapshot image.

STROBE Channel:  [Auto], [CH (1 - 6)]
File No.:  [AUTO], [No.  designation (0 to 32767)]

“Strobe Snap” is executed.
When you use a CF card, you can specify the method for storing snapshot 
images.
This command is ignored when no video/RGB image is displayed on the 
screen.
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* For more information, refer to the Macro Reference Manual.

RE_SIZE Reset the size of the video/RGB screen that was enlarged by 
double-clicking on the video display, using the ZOOM macro command, or 
double-clicking on a strobe snapshot.  Even if you do not run this 
command, you can reset the size by double-clicking on the video/RGB 
display.

ZOOM Channel:  [Auto], [CH (1 - 6)]
Display position:  [Centering], [Upper Right], [Lower Left]

The video/RGB screen (640 × 480 dots) is enlarged.  If this command is 
executed continuously, the previous action is automatically cleared.

BRIGHT Channel:  [Auto], [CH (1 - 4)]
Brightness:  0 - 31

Brightness of the video image can be adjusted.  (Not available with RGB)

CONTRAST Channel:  [Auto], [CH (1 - 4)]
Contrast:  0 - 31 

Contrast of the video image can be adjusted.  (Not available with RGB)

COLOR Channel:  [Auto], [CH (1 - 4)]
Intensity:  0 - 31

Color intensity of the video image can be adjusted.  (Not available with 
RGB)

VIDEOINF Channel:  [Auto], [CH (1 - 6)]
Video/RGB display condition:  [SAVE], [DEFAULT]

It is possible to save the current video/RGB display conditions or to reset to 
the default settings.
If you select [SAVE], the display conditions saved by the [SAVE] command 
is kept even if a power failure occurs.  When you display the video/RGB 
image again, the conditions same as the previous one will remain valid.
When [DEFAULT] is selected, the display conditions are reset to default.

PAUSE Channel:  [Auto], [CH (1 - 6)]

The video/RGB display of the specified channel pauses.
You cannot change the size during a pause.

RESTART Channel:  [Auto], [CH (1 - 6)]

The video/RGB display that was paused with the PAUSE command is 
restarted.

DELETE File No.:  0 - 32767

A JPEG file (File name: VDxxxxx.jpg) saved on a CF card by the snapshot 
function is deleted.

SNAP_SEQ Channel:  [Auto], [CH (1 - 6)]
start/stop:  0: stop, 1: start

“Continuous Single Snap” is started or stopped.

CLIP_POS Channel:  [Auto], [CH (1 - 6)]
Clip start position: X coordinate, Y coordinate

The clip start position is changed.

CLIP_SIZE Channel:  [Auto], [CH (1 - 6)]
Image clip size change: Width, height

The image clip size is changed.

Name Auxiliary Setting Item

Content



14.2 Video/RGB Display

14-49

14

Memory designation
Available Devices

Video2 MEMORY F1

AUTO
When setting a macro, you can select [AUTO] for channel number (CH) and file number.

• When channel number is set to [AUTO]:
“SNAP” “STROBE” “ZOOM” “BRIGHT” “CONTRAST” “COLOR”
“VIDEOINF” “PAUSE” “RESTART” “SNAP_SEQ” “CLIP_POS” “CLIP_SIZE”
*1 During “ZOOM”, the relevant channel number is automatically set.
*2 When the channel on a higher display priority is shown, the relevant channel number is 

automatically set.
*3 When neither *1 or *2 is applicable, it depends on the number of channels.

If videos of multiple channels are displayed, this command is not executed.

Internal 
Memory PLC Memory Constant Memory Card Indirect 

Designation

F1

n Command No.

n + 1 CH No./File No.

n + 2 Setting value

Command Name Command No. CH No./File No. Setting Value
SNAP 0 1 to 6 (CH) − 1 (AUTO) 0 to 32767 (file No.)/ −1 (AUTO)

STROBE 1 1 to 6 (CH) − 1 (AUTO) 0 to 32767 (file No.)/ −1 (AUTO)

RE_SIZE 2 

ZOOM 3 1 to 6 (CH)  −1 (AUTO) 0 to 2 (Centering, Upper Right, Lower Left: for SVGA only)

BRIGHT 4 1 to 4 (CH) 0 to 31

CONTRAST 5 1 to 4 (CH) 0 to 31

COLOR 6 1 to 4 (CH) 0 to 31

VIDEO_INF 7 1 to 6 (CH) 0: SAVE, 1: DEFAULT

PAUSE 8 1 to 6 (CH) −1 (AUTO)

RESTART 9 1 to 6 (CH) −1 (AUTO)

DELETE 10 0 to 32767 (file No.)

SNAP (background) 11 1 to 6 (CH) 0 to 32767 (file No.)/ −1 (AUTO)

(n + 3)
0: 160 * 120,  1: 320 * 240
2: 640 * 480,  3: 640 * 240

SNAP_SEQ 12 1 to 6 (CH) −1 (AUTO) 0: stop, 1: start

CLIP_POS 13 1 to 6 (CH) −1 (AUTO) 0 to (up to the maximum screen resolution)

CLIP_SIZE 14 1 to 6 (CH) −1 (AUTO) 1 to (up to the maximum screen resolution)
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• When file number is set to [AUTO]:
“SNAP” “STROBE”
When no file exists, the command creates files starting from No. 0; when some files exist, the 
command creates files starting from the current maximum number (not exceeding the number set 
for [Maximum Number of Snap Files in Auto]).
When reaching the maximum number, the command is not executed any more if you set [Stop] for 
[When the Snap File Limitation is Exceeded].  If you set [Auto], the command creates files starting 
back to No. 0.

* For more information on [Maximum Number of Snap Files in Auto] and [When the Snap File 
Limitation is Exceeded], refer to page 14-39.

RGB Macro Commands

The macro commands available only with RGB display among video/RGB display items are [SYS 
(SET_RGB)] and [SYS (RGB_CHG)].

SYS (SET_RGB)
Available Devices

SYS (SET_RGB)   F1

* For more information, refer to the Macro Reference Manual.

Internal 
Memory PLC Memory Constant Memory Card Indirect 

Designation

F1

F1 value F1 + 1 value Operation

0 - Clears the RGB screen.

1 - Displays the RGB screen.

2 File number
(0 - 32767, -1 [AUTO])

Displays the RGB screen and takes a 
snapshot.

3 File number
(0 - 32767)

Deletes the JPEG file of a snapshot.

4 - 7 System reserved -

8 CH No.
(5 - 6)

Specifies the channel number to be 
displayed or not to be displayed, or the 
channel number used for touch switch 
emulation.
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SYS (RGB_CHG)
Available Devices

SYS (RGB_CHG)   F1

* For more information, refer to the Macro Reference Manual.

Internal 
Memory PLC Memory Constant Memory Card Indirect 

Designation

F1

F1 value F1 + 1 value Operation

0 Setting 1 Sets the clip start position with the value 
of [Setting 1].

1 Setting 2 Sets the clip start position with the value 
of [Setting 2].
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Superimpose

If a video/RGB image is displayed on the full screen, you cannot operate the switches, etc., on the 
screen.
To operate the switches while displaying a video/RGB image, you can call an overlap display with 
“superimpose” on the video/RGB display.

* If you call an overlap display without “superimpose” on a video/RGB display, the video 
image becomes a still-frame image.

• “Superimpose” is available for any overlap display part (normal, call, or multi).
• If you use [Blend] in the [Superimpose Setting] dialog, you can adjust the transparent level of the 

overlap display.

* Note that you can set the transparent color and blend value on each screen.
When you use an overlap display (multi or call) registered in the overlap library, you 
need to set the blend value, etc., on the screen to be displayed.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Video Monitoringngn Display Adjustment

ContrastBrightness Color

Overlap
(With “superimpose”)

Video/RGB display
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Setting Dialog

* It is possible to set the above setting only once for each screen.
You cannot change the setting for each overlap display.

Notes

• Only one overlap display with “superimpose” is available per screen.
If you display multiple overlap displays with superimpose simultaneously, only the superimpose 
setting of the overlap display that appears first becomes active.

• You cannot set a video/RGB display item on an overlap display with “superimpose”.  To place a 
video display item on an overlap display, set it without “superimpose” (uncheck [Superimpose]).

Transparent Color With “superimpose”, one color always becomes transparent when an 
overlap display is shown over a video/RGB display due to the system 
structure.
You need to specify that color.
To avoid showing the video image as transparent, set one color that you do 
not use on the overlap display.

Blend
(0 to 255)

Set the blend ratio of the overlap display to the video/RGB display.
When the blend value is closer to “0”, the overlap display is shown faintly.  
The overlap display becomes more visible as you increase blend value 
closer to “255”.
“255” is the same status as without “superimpose.”

Normal overlap display:
Make the setting on the [Overlap] dialog.

Call- or multi-overlap display:
Make the setting on the [Screen Setting] dialog.

If you use the color (e.g. black) 
that is set for [Transparent 
Color] on the overlap display 
(e.g. switch OFF color), the 
background (e.g. video/RGB 
display) is displayed as is.

Overlap
(Superimpose)

Video

Color Adjustment
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Settings for the Menu Window

You can use the default overlap screen and make the setting easily.  This screen has functions for the 
picture adjustment (brightness, contrast, and color intensity) as well as snap shooting.
The menu window varies depending on whether it is for video screen or RGB screen.

Registration

To create a video menu, an overlap display part is automatically created and registered in the overlap 
library, which is to be called as a call-overlap display.

Video:
Complete the registration on the [Action] tab window of the [Video/RGB Display] dialog.

A video menu is registered under the specified overlap library number.

RGB input:
Complete the registration on the [Action] tab window of the [Video/RGB Display] dialog.

A video menu is registered under the specified overlap library number.

Specify the overlap library number to 
be registered and click [OK].

Specify the overlap library number to 
be registered and click [OK].
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Confirming the Registered Video Menu
Video:
The video menu registered in the overlap library shown below is created.

RGB input:
The RGB menu registered in the overlap library shown below is created.

You can change the design, size, or color intensity for an overlap display as needed.

The editing procedure is the same as the one used for overlap displays, switches, or draw items.  For 
more information, refer to the Operation Manual.

Calling Methods

There are two methods to call the registered video menu.

Clicking on video/RGB display
You can display the video menu by simply clicking on the display area when the video/RGB is 
displayed.
For more information, refer to page 14-32.

Calling with a switch or external command
The calling method is the same as the one used for a call-overlap display.
For more information, refer to “2  Overlap.”

Superimpose Setting

The registered video menu is equipped with superimpose.
To change the blend value or transparent color, review the [Superimpose Setting] dialog in the [Screen 
Setting] dialog on the [Screen Edit] window.
For more information, refer to page 14-52.
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Notes

Placement

• You can place a maximum of four video/RGB display items on one screen.
However, you cannot display multiple video images of the same channel on one screen.  If you do 
so, the video/RGB image displayed last becomes active.

• You can also set video/RGB display items on the base screen or overlap display parts.
However, if you place a display area part at the top left of an overlap display part, the “system 
button” (“2  Overlap”) for the overlap display becomes invalid.
You cannot place any video/RGB display item on an overlap display with “superimpose.”

• When you display animation and video/RGB simultaneously, the animation is displayed on top of 
the video/RGB.

• When you display a video/RGB image and animation simultaneously or when you display a 
video/RGB image and an overlap part greater than 640 × 480 dots with superimpose, the image 
may not be captured correctly.

Display Speed

• The display speed decreases as the number of channels increases.  Because the number of 
frames decreases, a three-channel display is slower than two channels; a four-channel display is 
slower than a three-channel display.

• If an overlap display is displayed on a video/RGB display on the base screen, the video/RGB 
becomes a still-frame image defeating its capability to as a video/RGB display.

* However, if you display an overlap display with superimpose on the video/RGB image, 
the video/RGB display will not be stopped and will maintain the same display speed.

MENU

Run MonitorTest

Error HelpSetting

Stopped
If an overlap display 
is shown overlapping 
a video/RGB display, 
the video/RGB image 
becomes a still-frame 
image.
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• If one channel video/RGB display is set on the base screen and a video/RGB display item is 
placed on an overlap display, the video/RGB image is displayed at a high speed until the overlap 
display appears.

When the overlap display appears and it does not overlay the video/RGB display on the base 
screen, the number of frames decreases and the display speed becomes slow because of the 
two-channel display.

If an overlap display appears over a video/RGB display on the base screen, the video/RGB 
image becomes a still-frame image.  The video/RGB image on the overlap display is displayed 
automatically at a high speed because of the one-channel video/RGB display.

Display Priority

You can specify a priority in display when placing multiple video/RGB displays on the screen.  (Specify 
Display Priority)
Specify the channel number you want to give priority using [Specify Display Priority] for the video/RGB 
display item.
If multiple video/RGB display items are set on one screen, the priority that is assigned to the 
video/RGB display registered last or displayed last becomes valid.

High speed display at 
this point

At this point, both video channels are 
displayed at a low speed

Overlap display ON

CH1

CH2

Base screen

[No. of Channels: 1]
[  Specify Display Priority: CH1]

[No. of Channels: 1]
[  Specify Display Priority: CH2]

The video/RGB display registered 
(placed) last is given priority.
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Before Using RGB (Input) Display

When displaying the RGB screen on the V8i series, positional adjustment is required.  This section 
explains the required adjustment.

Adjusting the Display Position of the Screen

If two types of output frequencies are used, make settings for both [Setting 1] and [Setting 2].  If one 
type is used, make a setting for either of [Setting 1] or [Setting 2].  The procedure for adjusting the 
display position of the BIOS screen for [Setting 1] and the one of the Windows screen for [Setting 2] is 
explained below.

1. Using an RGB display of BIOS screen
Display the BIOS screen on the computer.  Press the [Adjustment] switch for [Setting 1] to switch 
to an RGB display of the BIOS screen.

2. Adjusting the display position of the BIOS screen
With the BIOS screen displayed, adjust the display position using the [F1] to [F4] switches.
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3. Adjustment completed
When the position has been adjusted, press the [SYSTEM] switch.  The RGB Adjustment screen 
is displayed again.  The [Used] lamp for [Setting 1] comes on.

4. Using an RGB display of Windows screen
Display the Windows screen on the computer.  Press the [Adjustment] switch for [Setting 2] to 
switch to an RGB display of the Windows screen.

5. With the Windows screen displayed, adjust the display position using the [F1] to [F4] switches.  For 
the procedure for adjusting the display position, refer to step 2.

6. When the position has been adjusted, press the [SYSTEM] switch.  The RGB Adjustment screen 
is displayed again.  The [Used] lamp for [Setting 2] comes on.

7. Press the [Save] switch to save the setting.  When the setting has been saved, the Main Menu 
screen is automatically displayed.  Settings are stored into the flash ROM, so they are retained 
when the power is turned off and on.
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RGB Display Method Using the [Video/RGB Display] Item

From the V8i, an RGB input image can be displayed on the [Video/RGB Display] item.
The setting procedure is the same as displaying a video image.
For more information, refer to “Setting Dialog” (page 14-29).

Other RGB Display Method (V7 Series Compatible)

You can show an RGB input screen without using any [Video/RGB Display] item.

Switching using read area (n + 1)

Bit 12 (switching to an RGB input screen)
[1] (ON level): RGB input screen displayed
[0] (OFF level): RUN screen displayed

Switching using the macro command
The RGB input screen can be switched using the macro command “SYS (SET_RGB)”.
For more information, refer to the Macro Reference Manual.

Notes on RGB Input

If there is no RGB input (cable not connected), the screen on the V8i turns black.

Switching RGB input parameters
As RGB input parameters, [Setting 1] and [Setting 2] can be used.
If the frequencies for [Setting 1] and [Setting 2] are not the same, the V8i automatically makes a 
distinction and switches over RGB input parameters for [Setting 1] and [Setting 2].  If the 
frequencies for [Setting 1] and [Setting 2] are the same, RGB input parameters for [Setting 1] are 
used.  If the frequencies are the same while RGB input parameters are not the same, [Setting 1] and 
[Setting 2] are switched over using the macro command.
The RGB input parameters can be switched using the macro command “SYS (SET_RGB)”.

For more information, refer to the Macro Reference Manual.

Data output of RGB input
The current RGB input screen status is stored in write area (n + 1).

Bit 12 (RGB input screen status)
[1] (ON): RGB input screen displayed
[0] (OFF): RUN screen displayed

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0

Switching to an RGB input screen

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0

RGB input screen status
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Touch Switch Emulation

• Using this function, the Windows screen displayed on the V8i can be operated using touch 
switches without using the mouse.  This is possible regardless of the display size.

• Connect a computer to the modular jack (MJ1 or MJ2) on the V8i unit.
• The emulation function is provided to CH5 as default (RGB-IN1 with GU-11).  Switching to CH6 is 

possible with the macro command “SYS (SET_RGB)”.
When performing emulation via one serial port, use CH5.  When both CH5 and CH6 are used at 
the same time, the emulation function is fixed to CH5.  No macro command is available for 
switching to CH6.

• With the GU-11 in use, emulation is concurrently executable on two computers via modular jacks 
(MJ1 and MJ2).

Touch panel driver

Limitations
• DOS application software that runs on the MS-DOS prompt window cannot be operated using 

touch switches.
• The PS/2 mouse can co-reside; however, some pointing devices mainly provided to notebook 

computers may not.
• When touch switch emulation and remote desktop window display are used concurrently, the USB 

mouse is not usable for remote desktop window display,  

Manufacturer Type Version Applicable OS

GUNZE TPDD 2.00 Non-support version
Product version Windows XP, 2000, Me

GUNZE U-TP 2.00 Product version Windows 98, 95, NT4.0, 2000

MJ1MJ2

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

RGB-IN1RGB-IN2

V-CP

V-CP

(CH6) (CH5)

GU-11

(Server computer)

(optional)

(Checking the production status)

(Checking the 
production status)(Server computer)
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Setting
• In the V-SFT software, go to [Device Connection Setting] → [Others] → [Touch Switch]

(When input signals from a PC/AT compatible computer are displayed on the V8i, transmit the 
touch switch coordinate output back to the computer via the MJ port selected here.)

• Install Gunze’s touch panel driver on the PC/AT compatible computer before connecting it to the 
V8i.  For the installation procedure, refer to the installation manual provided to Gunze’s touch 
panel driver.

Setting example
The procedure for adding touch switch emulation in an analog RGB input environment is explained.  
This example assumes that the following settings have been made.

• On the RGB Adjustment screen, you have adjusted the position of the BIOS screen at [Setting 
1] and that of the Windows screen at [Setting 2].  (For the adjustment procedure, refer to page 
14-58“Adjusting the Display Position of the Screen”.)

• The V-CP cable is connected between COM2 of the computer and MJ1 (editor port) of the V8i 
(for screen data transfer).

1. Switch to an RGB input screen (the Windows screen is displayed).
2. Start the V-SFT software, and open the file currently transferred to the V8i.
3. Go to [System Setting] → [Device Connection Setting] → [Others] → [Touch Switch] tab window.  

Check [  Use Touch Switch], and in the tab window, select [MJ2] for [Connect to:].
4. Save the file and transfer it back to the V8i.
5. The RUN mode is selected on the V8i.  Switch to an RGB input screen (the Windows screen is 

displayed).

Use Touch Switch Check this box.

2 Port Check this box for emulation via both IN1 and IN2 while the 
GU-11 is used.

Connect to: MJ1, MJ2
Select the port to connect the computer.

 Use Default Comm. 
Parameter Setting Check this box.

GU-11 V-SFT

RGB-IN1 Touch switch (CH5)

RGB-IN2 Touch switch (CH6)
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6. To perform touch switch emulation, connect COM1 (communication port) of the computer and MJ2 
(touch switch) of the V8i using the V-CP cable (refer to item 5 in “Notes” described later).

7. (a) When using the touch panel driver “U-TP”:
Insert the floppy disk of Gunze’s touch panel driver “U-TP”, double-click “setup.exe”, and 
install the touch panel driver according to the prompts.  [Welcome!] → [License Agreement] → 
[Select folder] → [Select Designation Directory] → [Install system tray icons.] → [Number of 
device (Set to “1”)] → [Define device #1 (Keep defaults: “Whole Desktop” and “Device 2”)] → 
[Please select the controller type (Select “Gunze AHL, Serial” for device 1)] → [Serial Setting 
(Check “Auto Detect”)] → [Ready to install] → (Installation starts.)

(b) When using the touch panel driver “TPDD”:
Decompress “TOUCH PANEL DRIVER TPDD” downloaded from the Gunze download site in a 
drive, and double-click “setup.exe” among the decompressed files.  [Welcome] → [Select 
Language (Select “JAPANESE”)] → [Select Controller (Select “4/8 Wire-Type Touch Panel”)] 
→ [Select Clone File (Keep it unchecked)] → [Licence Agreement] → [Select Folder] → 
[Installing TPDD (when completed, click [Finish])]

8. Restart Windows.
9. (a) When using the touch panel driver “U-TP”:

1) When Windows boots up, calibration software is automatically started.  Make the settings 
for calibration.  (Refer to item 3 in “Notes” described later.)  The touch panel driver has 
been installed.

2) If you need to change the settings for the touch panel driver “U-TP”, select [Start] → 
[Program] → [Gunze] → [U-tp] → [Calibrate].  When the settings have been changed, 
restart the computer to validate the new settings.

(b) When using the touch panel driver “TPDD”:
1) When Windows boots up, click the [Start] button, and select [Programs] → [Gunze TPDD] 

→ [Adjust Setting] to open [Touch Panel Device Properties].
2) Click the [Device] tab in the [Touch Panel Device Properties] dialog, and click the [Add] 

button.
3) The [New Pointer Device] window is displayed.  Select “Gunze AHL, Serial”, select 

“COM1” for [Select COM port], and click [Next].
4) The [New Pointer Device] window is displayed.  Select “Whole Desktop” and click [OK].
5) When the [Touch Panel Device Properties] window is displayed again, click the [Apply] 

button and then [Calibrate] button.
6) The calibration program is started.  Make the settings for calibration.  (Refer to item 3 in 

“Notes” described later.)
The settings have been completed.

V8i

MJ1

MJ2

COM1

COM2

V-CPEditor port

Touch switch

PC/AT compatible computer
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Notes
1. It is not possible to switch from the Windows screen to the Main Menu screen on the V8i.
2. When setting the touch panel driver, select “Auto Detect” for [Serial Setting].  When “Auto Detect” 

is selected, the COM port, address, and IRG of the computer connected to the V8i are 
automatically detected and set.  Consequently, it is necessary to connect the V8i and the computer 
via the V-CP cable and place the V8i in the RUN mode before starting Windows.  The 
communication parameter settings are fixed: baud rate at 9600 bps, no parity, 8 data bits, and 1 
stop bit.

3. Correct the touch position and the mouse cursor display position using the calibration software.  
Precisely touch the “×” mark displayed on the screen in order:  1st point (top left of the screen) → 
2nd point (bottom left of the screen) → 3rd point (top right of the screen) → 4th point (bottom right 
of the screen.  Be sure to touch these four points.  When the calibration setting has not been 
completed successfully, the touch test operation is not possible.  Make the calibration settings 
again.

4. When the display size has been changed on the Main Menu screen, select the RUN mode, start 
the calibration software, and correct the touch position and the mouse cursor display position.

5. Once the touch panel driver has been installed, the serial port cannot be available with another 
application software unless the driver is uninstalled or the port is disengaged by changing the 
setting for [Adjustment Setting].

6. If your computer has only one COM port (communication port), use another computer when 
transferring screen data to the V8i.

7. For the [Adjustment Setting] dialog of U-TP or TPDD, refer to the Gunze help menu.  (Normally 
keep the default settings.)

8. When the Windows boots up, select the RUN mode on the V8i.  If you start Windows on the Main 
Menu screen (in the STOP mode), the COM port is not recognized.
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14.3 JPEG Display
Overview

JPEG File Display

• Save a required JPEG file on a CF card and insert the CF card into the V8 series.  The V8 series 
reads the JPEG file and displays the file according to the setting on the screen.

* File size: 1,024 × 768 or smaller
Note that a large size JPEG file takes a little longer to display the image.

• You can call a JPEG file by specifying its file name or file number or by designating its file number 
from the PLC.
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Displaying Video Snapshot

• You can display a video image, which is stored on a CF card, as a JPEG file using the snapshot 
function.

• Two methods of specifying a file number and designating a file number from the PLC are available.

Configuration

The JPEG display item components are shown below.
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image on the card.

JPEG display icon = 
[JPEG Display] dialog

Display area

−Block
+ Block,
File Call,
File Delete,
JPEG Search, etc.
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Setting Dialog

JPEG Display
Main

*1 The following JPEG files can be displayed:
• When specifying a file number:

[JPEG] selected: JPxxxxx.JPG (xxxxx: 0 to 32767)
[Video Snap] selected: VDxxxxx.JPG (xxxxx: 0 to 32767)

• When specifying a file name:
[JPEG] selected: xxxxxxxx.JPG (xxxxxxxx: 64 one-byte alphanumeric characters)
[Video Snap] selected: Not possible

For the storage target of JPEG data and the procedure for storing data on the V8, refer to page 
14-72.

JPEG
Video Snap *1

JPEG:
Select this option when displaying an existing JPEG file.

Video Snap:
Select this option when displaying a video snapshot image.

 Memory 
Designation *2

Check this box ( ) to designate a JPEG file number from memory.  This is 
useful to make JPEG display variable.
The JPEG file name must be in the format of “JP(VD)xxxxx.JPG”. “xxxxx”  
is recognized as a number.

File Designation
(File No., File Name)

These options are active when the [Memory Designation] box is not 
checked ( ).

File No.:
A file of “JP(VD)xxxxx.JPG” (xxxxx: 0 to 32767) can be selected.  Specify 
a file number.

File Name:
File targeted is “xxxxxxxx.JPG” (xxxxxxxx: within 64 one-byte uppercase 
alphanumerics).  Specify a file name.

Info Output Memory This setting is not valid when [File Designation] and [File Name] are 
selected.
Output the file number currently being displayed to the specified memory 
address.

 Fit Image Size to 
Display Area *3

The JPEG file is automatically enlarged or reduced to fit the display area 
size.
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*2 Display example

*3 Display example

• Unchecked
With respect to the top left corner of the display area, the 
image is displayed in its original size.
If the JPEG data is greater than the display area in size, the 
part that cannot be held in the area is not displayed.

• Checked
With respect to the top left corner of the display area, the 
image is enlarged or reduced.
The image is enlarged or reduced at the same factor for 
width and length relative to the display area size.

Display resolution for enlarged or reduced JPEG displays can be set in three levels.
Set a value shown below for system memory $s1008 using a macro command.

* This is valid when the JPEG file size is smaller than 1024 × 768.

Value Resolution Speed
0 Rough Fast

1 Medium Medium

2 Fine Slow

96
M

B

CompactFlash Card

96
M

B

CompactFlash Card

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

D100 = 2

JPEG JPEG
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Detail

Display Area

Style

Detail

Process Cycle Set a cycle for the V series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

Color Set the color inside the area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified in the [JPEG Display] dialog.
For more information on the ID, refer to the Operation Manual.
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Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Notes
The display area needs to be large enough to hold the image of the JPEG file.
When the display area is smaller than the image size, the image is not shown entirely.
When the display area is larger than the image of the JPEG file, part of the display area is shown so it 
is recommended that users match the display area color with the background color of the image.

* If you check [Fit Image Size to Display Area] ( ) on the [Main] tab window of the [JPEG 
Display] dialog, the image is automatically enlarged or reduced to fit the display area size.  
For more information, refer to page 14-67.

Use a color that matches the background color.

Size is the same:

Size is smaller than the image displayed:

Size is larger than the image displayed:
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Switch Parts for JPEG Display

The following switches can be used for JPEG display.

*1 Display example
• When the [+100] switch is pressed while file No. 800 is displayed, a search is conducted for file 

No. 900 or later and the file is displayed.  When a search has been conducted to No. 32767, it 
is continued moving back to No. 0.

• When the [−100] switch is pressed while file No. 800 is displayed, a search is conducted for file 
No. 700 or less and the file is displayed.  When a search has been conducted to No. 0, it is 
continued moving back to No. 32767.

Function Attached Setting Contents Target File

+ Block − Calls the JPEG file of the number one greater 
than the file currently displayed.

JPxxxxx.JPG
VDxxxxx.JPG

− Block − Calls the JPEG file of the number one smaller 
than the file currently displayed.

JPxxxxx.JPG
VDxxxxx.JPG

File Call (JP/ VD file) No. Calls the JPEG file of the specified number. JPxxxxx.JPG
VDxxxxx.JPG

Delete File − Deletes the JPEG file currently displayed. VDxxxxx.JPG

JPEG Search *1 Increment/Decrement
Searches the next JPEG file number on the 
basis of predetermined increment or decrement 
from the currently displayed file number.

JPxxxxx.JPG
VDxxxxx.JPG

+100 -100 +100-100

Function: JPEG Search
Increment/Decrement: −100

(1) No. 800 = JP00800.jpg is displayed. (3) A search is conducted, and No. 900 
= JP00800.jpg is displayed.

Function: JPEG Search
Increment/Decrement: 100(2) Press the [+ 100] switch.

-100 -100 +100+100

(1) No. 800 = JP00800.jpg is displayed. (3) A search is conducted, and No. 700 
= JP00700.jpg is displayed.

(2) Press the [−100] switch.
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Notes

Location of Storing Files

The JPEG display function calls and displays the files in the following location:

*1 When using JPEG display, store the files in the above location in advance.

CF Card Manager

When the JPEG display setting has been completed, transfer the screen data file to the V8 series.  It is 
necessary to save the necessary data (JPEG files) on a CF card using the CF Card Manager and 
insert the card into the V8 series.

When the JPEG files have been saved on the CF card, insert the CF card into the V8 series.

* For the procedure for saving JPEG files on a CF card using CF Card Manager, refer to “18  
CF Card.”

Display Method File Name Location in Editor

JPEG Display *1

JPxxxxx.JPG
(xxxxx: 0 to 32767)
xxxxxxxx.JPG
(xxxxxxxx: 64 one-byte 
alphanumeric characters)

\V-SFTV5\JPEG folder where V-SFTV5 is 
installed

Video Snap VDxxxxx.JPG
(xxxxx: 0 to 32767)

(The video snapshot taken using 
video/RGB display function is automatically 
stored in \SNAP folder on the CF card.)
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CompactFlash Card
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JPEG file
(within \V-SFT V5\JPEG)
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[Transfer] of V-SFTV5

CF card

[CF card manager] of V-SFT V5 Insert into V8

Completed
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14.4 Sound
Applicable Models

* The sound replay function is not available with V8i option units “GU-10” and “GU-11”.
Please note the availability of each function.

Overview

• A WAV file is replayed when the corresponding bit is set or reset.
* An external speaker is required to replay a WAV file.

• You can replay sounds linking the following functions:

*1 Local replay (replay per screen)
• Sound item
• Animation

*2 Global replay (replay by setting the sampling bit)
• Alarm logging
• Time order alarming
• Alarm function

Applicable Models Applicable Option Units

V8i series
GU-00 (V8i/V715X)

GU-01 (V8i/V715X)

F 1
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F 3

F 4

F 5

F 6

F 7

SYSTEM
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Configuration

The sound item components are shown below.

Setting Dialog
Main

Memory Specify the bit memory address that you use to replay/stop the WAV file 
you set in the [Sequence] tab window (Refer to page 14-75.).

Replay [0 → 1]
Stop [1 → 0] (Stop even while the file is replaying.)

 Continuous Replay Check this box ( ) when you want to continuously replay the WAV file you 
set in the [Replay Sequence] tab window (Refer to page 14-75.).

Replay Priority When you set multiple sound items on a screen, set a priority for replay for 
each item.  When multiple bits are set to ON simultaneously, the WAV file 
having a higher priority is replayed.
However, the sound item stops replaying when a WAV file linked to 
sampling starts replaying because sound of sampling has a higher priority.

Sound icon = 
[Sound] dialog



14.4 Sound

14-75

14

Sequence

If any box from  No. 0 to  No. 15 is checked ( ), the [Sequence Setting] dialog for the checked 
number becomes available.

Detail

 No. 0
    :
 No. 15

Check ( ) as many boxes as the number of files to be replayed.
A maximum of 16 WAV files can be replayed consecutively.

File No. Specify the WAV file number to be replayed.
The WAV file name that can be specified for [File No.] is shown below.  No 
files in any other name format can be replayed.
WA xxxx.WAV  (xxxx: 0000 to 1023: WAV file number)

File Name Specify the WAV file name to be replayed.
The WAV file name that can be specified for [File Name] is shown below.  
No files in any other name format can be replayed.
xxxxxxxx.WAV  (xxxxxxxx: 64 one-byte alphanumeric characters 
maximum)
Specifying a file name as the above is required for WAV file saving to a CF 
card.

Memory Select this option to change WAV files to be replayed.
Specify the memory address where the WAV file number is stored.
The WAV file name that can be read in memory is shown below.  No files in 
any other name format can be replayed.
WA xxxx.WAV (xxxx: 0000 to 1023: WAV file number)
Be sure to set the [Sound Setting] dialog when you selected [Memory].
For more information on the [Sound Setting] dialog, refer to page 14-76.

Process Cycle Set a cycle for the V series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Sound Setting

Setting Example

Set the sound item as shown below:

 Import All Files 
from WAV Folder

Check this box ( ) when you want to transfer all WAV files in the \V-SFT 
V5\WAV folder when transferring screen data.

* Be sure to check this box ( ) when you select [Memory] on the 
[Sequence] tab window (page 14-75).

WAV File File Contents
WA0000.WAV Error

WA0001.WAV occurred.

WA0002.WAV

WA0003.WAV  ×  ×

WA0004.WAV

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

M 0-15

...
...

..

D100 3

M 0-15

...
...

..

D100 2

PLC memory

PLC memory

ON 
information

ON 
information

Error × × 
occurred.

Error  
occurred.
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Replaying a WAV File Linking to Animation

When using an animation table, you can replay a WAV file which is linked to the animation function.  
However, animation stops replaying when a WAV file linked to sampling starts replaying because 
sampling has a higher priority.
In this section, the setting for replaying a WAV file linking to animation is explained.
For more information on the animation function, refer to “14.1  Animation” on page 14-1.

Animation Setting
[Main] tab window

[Table] tab window and [Table] setting dialog

[Table] tab window

[Table] setting dialog

No. 0 to 15 Check the box ( ) for the number you want to replay sound.

 Use WAV Check this box ( ).

 Continuous Replay Check this box ( ) when you want to consecutively replay the sound file.

WAV File No. Specify the WAV file number to be used.
The file name that can be replayed is “WA xxxx.WAV” (xxxx: 0000 to 1023: 
WAV file number).

 Use Table Check this box ( ).
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Replaying a WAV File Linking to Sampling

If [Alarm] is selected for [Type], you can replay a WAV file according to bit activation (ON/OFF).
In this section, the setting for replaying a WAV file linking to sampling is explained.
For more information on sampling, refer to “Appendix 1  Buffering Area.”

Buffering Area Setting

 Use WAV Check this box ( ).

 Continuous Replay Check this box ( ) when you want to continuously replay the sound file.
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Message Edit

*1 Sound Priority
With the above setting, if the bits having the same priority are activated, the sound file of the bit 
activated last is replayed.

Also with the above setting, if the bits having different priorities are activated, the sound file of the 
bit having a higher priority is replayed.

Select [Edit] → [Alarm Function].  
The [Alarm Function Setting] dialog is displayed.

Setting Start No.
Set No. of Lines Select the message with which you want to replay sound.

Sound Check this box ( ).

WAV File No. Specify a WAV file number.
The file name that can be replayed is “WA xxxx.WAV” (xxxx: 0000 to 1023: 
WAV file number).

Sound Priority No. *1 Set a priority for the WAV file.
When multiple sound replay bits are activated simultaneously, the WAV file 
that has a higher priority is replayed.

D0-00

D0-01

WA0001.WAV WA0002.WAV

D0-14

D0-15

WA0005.WAV

WA0006.WAV

D0-01

WA0002.WAV
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Notes

WAV File Format

The WAV file in the following format can be replayed on the V8i:

Location of Storing Files
File location during screen creation
Save the WAV files in the \V-SFT V5\WAV folder, which was created when the V-SFTV5 was installed.
The WAV files are transferred at the time of screen data transfer.

File location on the V8i
WAV files are usually transferred to MONITOUCH as a part of screen data.
However, you may save WAV files to the CF card so as to reduce the volume of the screen data.

When using a CF card, WAV files are not transferred using the screen data transfer function.  Use CF 
Card Manager.  (Refer to “18  CF Card.”)

V8i series

Sound synthesis PCM

Sampling rate 8 kHz, 16 kHz

Quantization bit 8 bits, 16 bits

Sound source Monaural, stereo

 Store WAV File in 
CF Card When this box is checked ( ), WAV files are saved on a CF card.
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Outputting Sound Information

Sound information is output to internal memory ($s).

• Address $s1000
The length of time (seconds) that elapsed before the WAV file has finished replaying is stored.

• Address $s1001
The adjusted volume value of channel L is stored.

• Address $s1002
The adjusted volume value of channel R is stored.
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Please use this page for notes.
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15 Others
15.1 Data Block Area

Overview

When there are too many display parts to be displayed on the screen at one time, data blocks can be 
used.  Place the data block area on the screen.  Register the entry targets in the “data block.” Many 
entry targets can be displayed by switching the block number.
A maximum of four data block areas can be set on one screen.
If you set four data block areas on the base screen, you cannot set any more data blocks on the 
overlap IDs 0 to 2.

Configuration

The data block area components are shown below.

Entry Screen

Max. value

Min. value

Entered value

0

9999

0

7 8 9 UP

4 5 6 DW

1 2 3 CLR

0 . +/- ENT

Number 1

Number 2

Number 3

Number 4

Text 1

0.0

0.00

AAAA

0

0

Data Block No.

UP DW

Data Block No. 2

V4T

V4C

V4B

V4W

V4S

9955

8844

7733

6622

5511

Data Block No. 1

Data 1

Data 2

Data 3

Data 4

1111

2222

3333

4444

Data Block No. 0

Number 1

Number 2

Number 3

Number 4

Text 1

0.0

0.00

AAAA

0

0

Data block area

Data block change switches

Data block = 
[Data Block Area] 
dialog

−Block,
+ Block,
Block Call switchesDisplay area
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Setting Dialog

Data Block Area
Main

Detail

Designate
(Internal, External)

Specify the command methods for changing over the data block to be 
displayed.

Internal:
Data blocks are changed over by the switch for [Function: + Block, − Block, 
Block Call].
The ID set for the block change switch and the [Data Block Area] dialog 
must be the same to make the switch valid.

External:
Specify a block number for [Block No. Read Memory].

Depending on this setting, the setting items vary.

Initial Displayed Block, 
Min. Block, Max. Block

These options become active when [Internal] is chosen for [Designate].
Initial Displayed Block:The block number to be displayed first when the 
screen is opened
Min. Block: The minimum number of the block numbers to be displayed
Max. Block: The maximum number of the block numbers to be displayed

Block No. Read 
Memory

This option becomes active when [External] is chosen for [Designate].
Specify a memory address for [Block No. Read Memory].

 Info Output 
Memory

When this box ( ) is checked, the setting becomes valid.
The block number currently displayed is written in this memory address.

 Item Select 
Memory

Check this box ( ) when using the item select function.
For more information on item selection, refer to “7  Entry Mode.”



15.1 Data Block Area

15-3

15
Display Area
Style

Detail

Word Count This option becomes active when [Item Select Memory] is checked ( ).
Be sure to set this option.
For more information on item selection, refer to “7  Entry Mode.”

Order INC Up to four data block areas can be placed on one screen.
When multiple data block areas are placed, this option determines the 
order of precedence given to each data block area.

Process Cycle Set a cycle for the V8 series to read the PLC data while it is communicating 
with the PLC.
For more information, refer to “Appendix 5  Process Cycle.”

 GD-80 Compatible Use this item when screen data of the GD-80 series is converted into the 
V8 series format.
For more information, refer to the File Conversion Manual provided 
separately.

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

Color Set the color inside the area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified in the [Data Block Area] dialog.
For more information on the ID, refer to the Operation Manual.
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Coordinate designation

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Switch Parts for Data Block Area

When [Internal] is chosen for [Designate] in the [Data Block Area] dialog, data block change switches 
are necessary.
This section describes key setting items for switches that are used together with data block areas.
Main

Detail

+ Block Brings up the next data block area in the range between the maximum and 
minimum data block numbers.

− Block Brings up the previous data block area in the range between the maximum 
and minimum data block numbers.

Block Call Brings up the data block area of the specified number.

ID Set the same ID as specified in the [Data Block Area] dialog.
For more information on the ID, refer to the Operation Manual.
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Data Block Edit

Entry targets must be placed on data blocks.
They cannot be placed on the base screen or overlap IDs 0 to 2.

For more information on the data block editing procedure, refer to the Operation Manual.
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15.2 Memory Card Mode
Applicable Media

The SRAM and CF card types compatible with the V8 series are described below.
• Built-in SRAM

A 512-kB SRAM is built in the V8 series.
When using the built-in SRAM, a battery must be installed.

• SRAM memory card (Model: REC-MCARD SRAM)
The required capacity must be specified.  (256 kB, 512 kB, 1 MB, 2 MB, and 4 MB types are 
available.)
A card recorder (type: CREC) is required.

• CF card
Use CF cards which are commercially available.  (For the media of which operations we have 
verified, visit our Website (http://www.monitouch.com).)

Storage Target Setting

Data storage target is determined according to the setting.  Refer to the following table.

To store data in the CREC:
Select [System Setting] → [Device Connection Setting] → [Others] → [Card Recorder] and select 
[MJ1] or [MJ2].  The data is stored on the SRAM memory card inserted in the CREC.

To store data on the built-in SRAM:
Select [System Setting] → [Unit Setting] → [SRAM/Clock].
The [SRAM/Clock Setting] dialog is displayed.  Make the setting for [Memory Card Emulation Area] to 
store data on the built-in RAM.

* For more information on [Memory Card Emulation Area], refer to “Appendix 2 SRAM/Clock 
Setting”.

To store data on a CF card:
When [Card Recorder: No connection] is set ([System Setting] → [Device Connection Setting] → 
[Others]) and no [Memory Card Emulation Area] is set ([System Setting] → [Unit Setting] → 
[SRAM/Clock Setting]), inserting a CF card makes the system recognize the CF card as storage 
target.

System Setting
Storage TargetModular Jack SRAM/Clock

Card Recorder Memory Card Emulation Area

- CREC
(SRAM memory card)

× Built-in SRAM

× × CF card
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Overview

SRAM or CF cards can be used as external storage media.  Data can be written to or read out from the 
PLC at any time required.
The memory card emulation area of SRAM or a CF card is divided into a maximum of 16 files.  Each 
file is divided into a maximum of 4095 records.  Data is stored in each record.

Data can be called or stored in units of “record”.  Since a large capacity of data can be stored, it is not 
necessary to secure a memory area in the PLC for storage purpose.

* When a CF card is used, the recipe function can be used without using the memory card mode.
For more information, refer to “13  Recipe Mode.”

Memory Card Editor

Using Hakko Electronics’ memory card editor (model M-CARD SFT), data stored in the SRAM or CF 
card can be read on a computer, or data in the computer can be written to the SRAM or CF card.

For information on the usage of the memory card editor, refer to the memory card editor M-CARD SFT 
Instruction Manual.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

160

491

3209

200

8821

3000

120

7700

D100

D101

D102

D103

D104

160

491

3209

200

8821

D450

D451

D452

3000

120

7700

Memory card

One file can be divided into a
maximum of 4095 records.

Maximum 16 divisions 
available

One record can contain up to
4096 words.

Memory card 
mode

V8 series

File 0
File 1
File 2
File 3
File 4
File 5

File 14
File 15

Record 0
Record 1
Record 2
Record 3

Record 4093
Record 4094

Record 0
Record 1
Record 2
Record 3
Record 4

Data 0
Data 1
Data 2
Data 3
Data 4

Data 0
Data 1
Data 2

Or built-in SRAM
or CF card

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

160

491

3209

200

8821

3000

120

7700

D100

D101

D102

D103

D104

160

491

3209

200

8821

D450

D451

D452

3000

120

7700

Memory card/
Built-in SRAM/CF Card

Memory card editor

Computer

Memory manager function

Memory card 
mode

V8 series

File 0
File 1
File 2
File 3
File 4
File 5

File 14
File 15

Record 0
Record 1
Record 2

Record 0
Record 1
Record 2
Record 3
Record 4

Data 0
Data 1
Data 2
Data 3
Data 4

Data 0
Data 1
Data 2
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Memory Card Area Map

Excluding header information, the memory card as well as the memory card emulation area is 
allocated as shown below:

Configuration

The memory card mode components are shown below.

0

1023
1024

Type: Data file

Card information

File information

File 0

File 2

File 3

File 4

File 15

File 1

Size of file 0

Size of file 1

Size of file 2

Size of file 3

Size of file 4

Size of file 15

Record name 
(Max. 16 words)

Data (Max. 4096 words)

Address 
4111 (max.)Record name 

(Max. 16 words)

Data (Max. 4096 words)

Record name 
(Max. 16 words)

Data (Max. 4096 words)

Address 0

Record No. 0

Record No. 1

Record No. n
(Max. 4094)

En
tir

e 
fil

e 
si

ze

Memory card icon = 
[Memory Card] dialog

Display area

File Select,
Record Select,
Card Transfer,
Format, etc.
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Setting Dialog

Memory Card
Main

*1 If you attempt to place the entry keys in two positions, the following error message is displayed.

Memory *2 When transferring data between the V8 series and the PLC, specify the top 
memory address that controls operation.  Three words are occupied 
consecutively.
The allocation of memory is shown below.

Key Display Position
(Overlap ID
0 - 2, Base)

When placing the entry keys to enable editing of card numbers, card 
names, file names, or record names, choose the position from overlap IDs 
0 to 2 or the base screen.
Only one position (base, overlap ID 0 to 2) can be chosen for the entry 
keys (entry mode).  *1

Memory Card Setting For more information, refer to page 15-19.

Memory Function
A n Mode operation designation

  PLC → VB n + 1 File number designation

C n + 2 Record number designation
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*2 Memory details
A. n (Mode operation designation)

B. n + 1 (File number designation)
This bit is used to specify a file number from the PLC when bit 9 (file lock) or bit 8 (record lock) 
of “n” is set to “1”.  File numbers can be specified from the PLC, not on the screen.
* When [Not Used] or [Buffering File] is chosen for [Type] of the file number specified from the 

PLC, the file cannot be selected.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0

MSB LSB

Record name edit 
prohibited

File name edit prohibited

Card number/name edit prohibited

Format prohibited

Data transfer prohibited

Record lock

File lock

File selection

Quick selection

Transfer from V → PLC

Transfer from PLC → V

Bit No. Contents Description

0 Record name edit prohibited Record name edit is prohibited.

1 File name edit prohibited File name edit is prohibited.

2 Card number/name edit 
prohibited Card number and name edit is prohibited.

3 Format prohibited Memory card formatting is prohibited.

4 Data transfer prohibited Data transfer between the memory card and the PLC is 
prohibited.

5 - 7 Not used This bit must be reset to “0”.

8 Record lock The use of [Record Select] switch is prohibited.

9 File lock The use of [File Select] switch is prohibited.

10 File selection
In the display area part:
[0]: Only the files for [Type: Data File] are displayed.
[1]: All files are displayed.

11 Not used This bit must be reset to “0”.

12 Quick selection When bit 14 or bit 15 is set to “1” while this bit is set, data is 
transferred upon selection of a record in the V8 series.

13 Not used This bit must be reset to “0”.

14 Transfer from V series → 
PLC

[0 Data is transferred from the V8 series (memory card) to PLC at 
the edge of [0 → 1].  When transferring has been completed, bit 
14 of “CFM_TRFIN” (I/F memory n + 5) is set to “1”.
Reset this bit to “0” after the completion of data transfer.
For more information on the I/F memory, refer to page 15-20.

15 Transfer from PLC → V 
series

[0 Data is transferred from PLC to the V8 series (memory card) at 
the edge of [0 → 1].  When transferring has been completed, bit 
15 of “CFM_TRFIN” (I/F memory n + 5) is set to “1”.
Reset this bit to “0” after the completion of data transfer.
For more information on the I/F memory, refer to page 15-20.
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C. n + 2 (Record number designation)
This bit is used to specify a record number from the PLC when bit 8 (record lock) of “n” is set to 
“1”.  When specifying a record number from the PLC, not on the screen, designate the record 
number in this area.  Different from selection by the [Record Select] switch, the record number 
specified from this memory address is displayed from the top of the display area.

Style

Detail

Color

For more information, refer to “Appendix 4  Styles and Coordinates.”
Property

Enlarge

Point

ID Set the ID.
For more information on the ID, refer to the Operation Manual.
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Display Area
Style

Detail

Coordinates

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

Notes
• Selection of files and records

Press the desired file or record in the display area to choose it.  Since the display area part is 
automatically equipped with a switch function, pressing a file or record name selects the file or 
record.
The Y size of each switch is determined based on [Enlarge Y] specified for the characters in the 
display area.

Color Set the color inside the area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified in the [Memory Card] dialog.
For more information on the ID, refer to the Operation Manual.

Record Select

Card No. 0 File No. Record

Card Name Hakko File Name Record

0. Product Qty
1. Target Qty
2. SR-003
3. TU-008

File Select File Select
0. TUA
1. TUB
2. TUC
3. TUD
4. TUE
5. TUF
6. TUG

Record Select

Card No. 0 File No. 3 Record

Card Name Hakko File Name TU-008 Record
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Switch Parts for Memory Card Mode

With the memory manager function in memory card mode, switches for selecting a file or record on the 
memory card or transferring data from the PLC to the memory card can be used.
This section describes key setting items for switches that are used together with the memory card 
mode.

Main

File Select When file names in the memory card are displayed, this switch starts 
flashing.  Pressing on a file name selects the file.

Record Select This switch is active when a file is chosen.
Pressing this switch brings up record names in the display area.  The 
switch starts flashing.
Pressing on a record name selects the record.  The switch keeps flashing.

Card Number Edit
Card Name Edit
(Auxiliary setting item:
Overlap Library No.)

When the switch is pressed, editing card numbers or names can be 
started.  When the entry keys (entry mode) are placed on the base screen, 
the use of the keys is automatically enabled.  When the switch is placed on 
an overlap display, it works as an overlap call switch.  At the same time, the 
use of the entry keys is enabled.

* For auxiliary setting item [Overlap Library No.], register the entry keys 
(entry mode) in the overlap library.

File Name Edit
(Auxiliary setting item: 
Overlap Library No.)

When this switch is pressed, it is activated.  At the same time, the [File 
Select] switch starts flashing, indicating that a file can be selected.  When a 
file is selected while the [File Name Edit] switch is activated, the file name 
can be edited using the entry keys.  This is an alternate switch: pressing 
once activates the switch and pressing again deactivates the switch.  (The 
switch is not active during file name or record name editing.)

* For auxiliary setting item [Overlap Library No.], register the entry keys 
(entry mode) in the overlap library.

Record Name Edit
(Auxiliary setting item: 
Overlap Library No.)

When this switch is pressed, it is activated.  When a record is selected in 
this condition, the record name can be edited using the entry keys.  This is 
an alternate switch: pressing once activates the switch and pressing again 
deactivates the switch.  (The switch is not active during file name or record 
name editing.)

* For auxiliary setting item [Overlap Library No.], register the entry keys 
(entry mode) in the overlap library.

Card Format Pressing this switch formats a memory card as specified in the [Memory 
Card] dialog.

* This switch is also required for data logging (with storage media other 
than a CF card).
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Detail

Examples of switch operations
• [File Select] and [Record Select] switches

Transfer Card →  PLC This switch is active only when a record on the memory card is selected.
The selected record is transferred from the memory card to the PLC.  The 
data is stored in the memory address specified for [Memory] in the 
[Memory Card] dialog.

Transfer PLC → Card This switch is active only when a record on the memory card is selected.
Data is transferred from the PLC to the selected record.  The data is 
transferred from the memory address specified for [Memory] in the 
[Memory Card] dialog.  The amount of data to be transferred is determined 
by [Word Count].

Roll Up Pressing this switch scrolls up file or record names one by one in the 
display area.

Roll Down Pressing this switch scrolls down file or record names one by one in the 
display area.

+ Block Pressing this switch scrolls up pages of file or record names in the display 
area.

- Block Pressing this switch scrolls down pages of file or record names in the 
display area.

Reset When “11” or “12” is stored in the I/F memory address “n + 1” (specified in 
the [Memory Card] dialog), pressing this switch clears the data in “n + 1”.  
(The error bit of “n” remains set.)
For more information on the I/F memory, refer to page 15-20.

ID Set the same ID as specified in the [Memory Card] dialog.
For more information on the ID, refer to the Operation Manual.

File Select

Record Select

0. Product Qty
1. Target Qty
2. SR-003
3. TU-008

Flashing

File Select
0. TUA
1. TUB
2. TUC
3. TUD
4. TUE
5. TUF
6. TUG

Record Select

Flashing

File names are displayed in the display 
area while the [File Select] switch is 
flashing.

Record names are displayed in the 
display area while the [Record Select] 
switch is flashing.
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• [File Name Edit] switch

• [Record Name Edit] switch

File Select

0. Product
1. Target
2. SR-003

Flashing

File Name Edit

File Select

File Name Edit

0. Product Qty
1. Target Qty
2. SR-003

File Name     Product Qty

B C DA
F G HE
J K LI
N O PM

When the [File Name Select] switch is 
pressed, the [File Select] switch starts 
flashing.

The file name can be edited when 
a file is selected.

When the [Record Name Edit] switch remains activated.

B C DA

F G HE

0. TUA
1. TUB
2. TUC

Record Name          TUA

CR

File Select

0. Product
1. Target
2. SR-003

Flashing

File Name Edit

File Select

File Name Edit

Press the [Record Name Edit] switch.
(The switch is activated.)

The record name can be edited 
when a record is selected.
(When the [Record Name Edit] 
switch remains activated.)
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Data Display Parts for Memory Card Mode
Applicable numerical data display parts

• Main

Function Content

Memory Card No. Display Displays the card number currently being used.

Memory Card File No. Display Displays the file number currently being used or selected.

Memory Card Record No. Display Displays the record number currently being used or 
selected.

Digits When [Function: Memory Card No. Display] is selected:
Because the available card numbers are 0 to 255, specify in the range of 
“1” to “3”.

When [Function: Memory Card File No. Display] is selected:
Because the available file numbers are 0 to 15, specify in the range of “1” 
to “2”.

When [Function: Memory Card Record No. Display] is selected:
Because the available record numbers are 0 to 4094, specify in the range 
of “1” to “4”.
* If the number of digits less than the above is specified, figures 

will not be shown correctly.
Function Set the numerical data display function.

Choose from [Memory Card No. Display], [Memory Card File No. 
Display], or [Memory Card Record No. Display].

Card No. 12 File No. 3 Record No. 6

Card Name ECM File Name Target value Record Name SDY-K
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• Detail

Applicable character display parts

• Main

ID Set the same ID as specified in the [Memory Card] dialog.
For more information on the ID, refer to the Operation Manual.

Function Content

Memory Card Card Name Display Displays the card name currently being used.

Memory Card File Name Display Displays the file name currently being used or selected.

Memory Card Record Name Display Displays the record name currently being used or selected.

No. of Bytes For card, file and record names, it is possible to specify within the range of 
0 to 32.
Specify the number appropriate for card, file or record names.

* For [Memory Card Record Name Display], [No. of Bytes for 
Record] is specified for each file in the [Memory Card] dialog; 
therefore, select the greatest number of bytes for the files.

Function Set the character display function.
Choose from [Memory Card Name Display], [Memory Card File Name 
Display], or [Memory Card Record Name Display].

Card No. 12 File No. 3 Record No. 6

Card Name ECM File Name Target value Record Name SDY-K
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• Detail

ID Set the same ID as specified in the [Memory Card] dialog.
For more information on the ID, refer to the Operation Manual.
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Memory Card Setting

When memory cards are used, make the setting in the [Memory Card] dialog for file divisions or 
definition.  According to the setting in this dialog, the memory card (or memory card emulation area) is 
initialized.

[0] to [15] tab 
window

Each memory card can be divided into 16 (0 to 15).  Click the desired 
number tab and make the setting in the dialog.

I/F Memory The I/F memory is used commonly for division No. 0 to 15.  Make the setting 
in the [0] tab window.  The I/F memory is the memory address where the 
memory card status is written.  Six words are occupied consecutively.
Specify the top memory address.  The contents in memory are shown below.

For more information on the I/F memory, refer to page 15-20.

Type
(Not Used, Data File, 
Buffering File)

Not Used
Files are not used.

Data File
Select this option when using the memory manager function.

Buffering File
Select this open when using the data logging function.

* The following options become active when [Data File] is chosen for 
[Type].

No. of Record
(1 to 4095) Specify the number of records into which each file is divided.

Data Count
(1 to 4096) Specify the number of words to be stored in a record.

No. of Bytes for 
Record
(0 to 32)

Specify the maximum number of characters that can be used for a record 
name.
When displaying or editing record names, consider the available number of 
bytes set here.

Memory When transferring data from the memory card to the PLC, specify the top 
memory address for storing data in the PLC memory.

Memory Memory Name
n CFM_STAT

n + 1 CFM_ERRNo

n + 2 CFM_CARDNo

n + 3 CFM_FILENo

n + 4 CFM_RECDNo

n + 5 CFM_TRFIN
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I/F Memory

Regardless of the memory card mode setting, the newest data is written into “n” (CFM_STAT) and “n + 
1” (CFM_ERRNo). 
Other memory addresses become valid only when memory card mode is set on the screen currently 
displayed.

A. n (CFM_STAT)

B. n + 1 (CFM_ERRNo)
The error contents are stored in “n + 1” (CFM_ERRNo) if bit 0 of “n” (CFM_STAT) is set to “1” 
(an error has occurred).  Respective error numbers indicate the following contents:

Use Device 
Memory Map

The option becomes active when using device memory maps.  For more 
information on device memory maps, refer to the Connection Manual.

Transfer Mode
When transferring data between the memory card and the PLC, the 
minimum transferable unit is a “record.” Choose either [Data Only] or [Data + 
Record Name] when transferring data stored in each record.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Sample data operation Battery voltage Error

Bit No. Contents Description

0 Error
When an error related to the memory card has occurred, 
this bit is set to “1” (ON).  The error contents are stored in 
“n + 1” (CFM_ERRNo).

1 to 6 Not used This bit must be reset to “0”.

7 Battery voltage
When the battery voltage of the memory card has dropped, 
this bit is set to “1” (ON).  Replace the battery as soon as 
possible.

8 to 14 Not used This bit must be reset to “0”.

15 Sample data 
operation

This bit is valid when [  Use a Calculation Operation] is 
checked in the [Buffering Area Setting] dialog for the data 
logging function.  If data in the buffering area is being 
calculated when reading memory card data, this bit is set 
to “1” (ON).

Error No. Contents

1 There is an error in the memory card I/F board.

2 The memory card recorder is not connected.

3 An error has occurred during communication between the V8 series and the 
recorder.

4 No memory card is inserted.

5 Memory card format is different from the setting data.
(Or the memory card is not formatted.)

6 Memory card capacity is smaller than the setting data.

7 The memory card is not compatible.

10 Attempted to write to a memory card of flash ROM.

11 The memory card is write-protected.

12 There is an error in writing data to the memory card.
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C. n + 2 (CFM_CARDNo)
The current memory card number is stored.

D. n + 3 (CFM_FILENo)
The selected or transferred file number is stored.

E. n + 4 (CFM_RECDNo)
The selected or transferred record number is stored.

F. n + 5 (CFM_TRFIN)
Formatting or data transferring condition between the V8 series (= SRAM area or CF card) and 
the PLC is stored.  The contents are shown below:

Bit No. Contents Description

0 Error

When an error has occurred during formatting or 
transferring, this bit is set to “1”.
Bits for (2) “formatting” and (3) “transferring” 
remain “1”.  Bits for (4) “format completed” or (5) 
“transferring completed” remain “0.”

1 to 8 Not used This bit must be reset to “0”.

9 Formatting While formatting, this bit is set to “1”.

10 Transferring from V series → PLC While transferring, this bit is set to “1”.

11 Transferring from PLC → V series While transferring, this bit is set to “1”.

12 Not used This bit must be reset to “0”.

13 Format completed When formatting has been completed, this bit is set 
to “1”.

14 Transferring from V series → PLC 
completed

When transferring has been completed, this bit is 
set to “1”.  The file or record number transferred 
can be checked with “n + 3” (CFM_FILENo) and 
“n + 4” (CFM_RECDNo).  After checking that 
transferring has been completed, reset this bit.

15 Transferring from PLC → V series 
completed

When transferring has been completed, this bit is 
set to “1”.  The file or record number transferred 
can be checked with “n + 3” (CFM_FILENo) and 
“n + 4” (CFM_RECDNo).  After checking that 
transferring has been completed, reset this bit.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0

MSB LSB

Error (1)Formatting (2)

Transferring from V → PLC

Transferring from PLC → V

Format completed (4)

Transferring from V → PLC completed

Transferring from PLC → V completed
(5)

(3)
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Setting Example

When the [Memory Card] dialog is set as below, the area in the memory card is divided and the PLC 
memory is allocated as illustrated below:

<File No. 0> <File No. 1>
[Type: Data File] [Type: Data File]
[No. of Records: 3] [No. of Records: 2]
[Data Count: 5] [Data Count: 2]
[No. of Bytes for Record: 8] [No. of Bytes for Record: 4]
[Memory: D130] [Memory: D505] 
[  Use Temperature Control [  Use Temperature Control 
Network/PLC2Way] Network/PLC2Way]
[Transfer Mode: Data Only] [Transfer Mode: Data + Record Name]

PLC

D130
D131
D132
D133
D134

D505
D506
D507
D508

File 0
File 1
File 2
File 3
File 4
File 5

Record 0 name

Record 0 name

Data 0

Data 1

Record 1 name

Record 1 name

Data 0

Data 1

File 14
File 15

Record 0
Data 0
Data 1
Data 2
Data 3
Data 4

Record 1
Data 0
Data 1
Data 2
Data 3
Data 4

Record 2
Data 0
Data 1
Data 2
Data 3
Data 4

File 1

File 0

PLC memory

Memory for record 
names

Memory for data

Memory card
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Setting and Importing Procedures on the V8 Series

To start the memory manager function, perform the following procedures on the V8 series:

If the memory manager function does not work, check the status of [I/F Memory] set in the [Memory 
Card Setting] dialog for the screen data file (refer to page 15-20), and take appropriate action.

Transfer screen data to the V8 series

Connect the V8 series to the PLC

Format the memory card mode

Memory manager function ... Available

Open the screen where you set memory card mode and press the switch 
(Function: Card Format).

Immediately after formatting, the memory manager function becomes 
available.
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Editing Numbers and Names

When using the memory manager function, card numbers and file names can be edited on the screen.  
To enable the edit, entry mode must be set.
Place the entry keys on the base screen or a multi-overlap display part.

* The entry keys can be placed in one location for one memory card mode.

Placing Entry Keys on Multi-Overlap Display
When the [Card Number Edit] or [File Name Edit] switch is pressed, an overlap screen with entry 
keys registered in the overlap library is automatically called.  This overlap screen can be closed 
automatically when editing has been completed.
In this case, an overlap screen including an entry mode must be set on the [Overlap Library Edit] 
window.

Notes on overlap library editing

Entry mode Select [Memory Card] for [Type].

Entry display Place the parts as below:

Card No.             120
Card No. Edit

Overlap No. 0=Multi-overlap

Card No. 120

CR

On the overlap library

On the screen

For card number editing Numerical data display part
Set the same number of digits as the one for the 
memory card number display part.

For name editing Character display part
Set the same number of bytes as the one for the 
memory card name, memory card file name, or 
memory card record name display part.

ID Set the same ID as specified in the [Entry] dialog.
For more information on the ID, refer to the Operation 
Manual.
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Notes on screen editing

Placing Entry Keys on Base Screen

The entry keys become available when the [Card Number Edit] or [File Name Edit] switch is pressed.
Entry mode and memory card mode are set on the same screen. 
Note the setting items described below.

Memory card mode Choose an area where 
[Multi-overlap] is set on the screen 
from [Overlap ID 0], [Overlap ID 
1], or [Overlap ID 2].
The entry keys can be placed only 
in one position for one memory 
card mode.
(It is not possible to use the entry 
keys on both the base screen and 
an overlap display area in the 
memory card mode.)

Switch parts for 
memory card mode

Set the same ID as the memory card mode.
When the entry keys are placed on a multi-overlap display, the [Card 
Number Edit], [Card Name Edit], [File Name Edit] or [Record Name Edit] 
switch works as a “multi-overlap call” switch.
Each switch has [Overlap Library No.] as an auxiliary setting item.

When [Register] is clicked, the overlap display with entry mode is 
automatically registered under the specified overlap library number.

Entry mode Set an entry mode.  The setting procedure is the same as that for setting 
on an overlap display.

Entry display For numerical data or character display parts placed on the screen, select 
[Function: Entry Display Part].
The setting procedure is the same as that for setting on an overlap display.

Memory card mode Select [Base].

Switch parts for 
memory card mode

Set the same ID as the memory card mode.
The [Card Number Edit], [Card Name Edit], [File Name Edit] or [Record 
Name Edit] switch works as a switch that enables the use of entry mode.
Each switch has [Overlap Library No.] as an auxiliary setting item; 
however, this is not valid.
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15.3 Memo Pad
Overview

• Message board function
The message board function is available for leaving daily messages in a workshop, etc. 
This is particularly useful for exchanging messages among operators working in shifts.

• Pen input
Message entry is made simple by writing on the screen directly with a special pen.

• Eight memo pad areas available
Memo pad areas are common to every screen.  Up to 8 memo pad areas can be registered.

• Saved in the SRAM area
When a memo pad area is secured in the built-in or separate SRAM area, the data is retained 
even after the power is turned off.

• Also, it is possible to use the CF card to save memo pad data without using the SRAM area.
* Memo pad function is not available with the V8 series of matrix switch type.

Configuration

• The memo pad components are shown below.

1-dot 2-dot Line Delete
Area

Delete
All

Blue Red Pink Green Pale
Blue Yellow White Navy Sky

Blue Brown

Message Board

Memo pad icon = 
[Memo Pad] dialog

Display Area Pen Color,
+ Block,
−Block,
Delete All, etc.
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Setting Dialog

Memo Pad

* Only one memo pad function can be used on one screen.

Display Area
Style

Detail

Coordinate designation

For more information on the coordinate designating method, refer to “Appendix 4  Styles and 
Coordinates.”

ID Set the ID.
For more information on the ID, refer to the Operation Manual.

Color Set the color inside the area.

Change Part For more information, refer to the Operation Manual.

ID Set the same ID as specified in the [Memo Pad] dialog.
For more information on the ID, refer to the Operation Manual.
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Switch Parts for Memo Pad

The following switch functions are available with the memo pad function.

Main

* As many colors as set for [Color] ([System Setting] → [Edit Model Selection]) can be used. 

Detail

Pen Color * Selects the pen color.

Pen Size 
(1 Dot, 2 Dots) Selects the pen size.

Line Selects the pen movement.  This is an alternate switch.
ON: Straight line
OFF: Free-hand line

Delete Area Deletes the selected memo pad area.
This is an alternate switch.

ON: Delete the rectangular area selected on the display area.
OFF: Deletion is not possible.

Delete All Deletes data from the current memo pad area.

+ Block Brings up the next memo pad area (up to 8).

− Block Brings up the previous memo pad area (up to 8).

Block Call Brings up the memo pad area of the specified number.

ID Set the same ID as specified in the [Memo Pad] dialog.
For more information on the ID, refer to the Operation Manual.
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Memo Pad Data Storage Area

Memo pad data can be saved in the built-in RAM, SRAM area, or CF card.
Data saved in the RAM is cleared when MONITOUCH is turned off or when the Main Menu screen is 
displayed.
To retain data even when the power is turned off, save it in the SRAM area or on a CF card.

Memo Pad Storage Area Size

* This is the maximum capacity available provided that the entire SRAM area is used for the memo 
pad function.
For the procedure of dividing the SRAM area, etc., refer to “Appendix 2  SRAM/Clock Setting.”

Saving in RAM

No setting is required.

Saving in SRAM

To save data in the SRAM area, it is necessary to make the setting in the [SRAM/Clock Setting] dialog.

[SRAM/Clock Setting] dialog
• Store Area for Memo Pad

Set the storage area size for the memo pad function in the SRAM area.
Refer to the list shown above, and set an appropriate size.
For more information on other setting items, refer to “Appendix 2  SRAM/Clock Setting.”

Storage Target Capacity (words)

RAM 32,000

SRAM* 262,000

CF card 32,000
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Saving on a CF Card

No setting is required.  Insert the CF card into MONITOUCH.
However, when the memo pad area is set in the [SRAM/Clock Setting] dialog, data is stored in the 
SRAM area even if a CF card is inserted.

Timing in Saving Data

The memo pad data is saved in the memo pad area at the following timing.
• When switching pages using the [Function: + Block, − Block] switch
• When changing the screen
• When the Main Menu screen is displayed (only for SRAM)

If data cannot be saved due to insufficient memory, the memo pad display area flashes with beeps.  
Reduce the memo pad data.
The remaining space of the memo pad data storage area is stored in the system memory addresses 
$s108 and 109.

* Notes on SRAM usage
• If the power is shut down before data is saved, the data is deleted.
• If the power is shut down while data is being saved, the entire data may be lost.

The data save status is stored in the system memory address $s720.

System Memory

Memo pad data is stored in system memory $s.

Address ($s)  Contents Memory Type

106 Memo pad number (0 to 7)

← V
Data is 
written from 
the V8 series.

107

108
109 Remaining space of memo pad data storage area (unit: bytes)

720 Result of SRAM area save
0: Normally saved
1: Error in data.  The previous data is cleared.

727 0: Save possible
1: Save impossible due to insufficient memory

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Page 0

Page 1

Page 2

Page 3

Page 4

Page 5

0: Data not registered Page 6

1: Data registered Page 7
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Usage Example

Suppose that the following screen is created. 

1. When the screen is first opened, the following settings are chosen as default.
Pen size: 1 dot
Pen color: White
Pen state: Free
To change the setting, press the corresponding switch and set the desired option.

2. Write a desired message within the memo pad area.

Use the dedicated pen when writing messages.

3. When deleting the message, press the [Delete All] switch.
4. When deleting a part of the message, press the [Delete Area] switch (ON display), and enclose the 

desired data.  The enclosed data is deleted.
On completion, press the [Delete Area] switch (OFF display).

5. When drawing a straight line, press the [Line] switch (ON display).
Moving the pen on the memo pad area draws a straight line.
To cancel the function that draws straight lines, press the [Line] switch again (OFF display).

6. Pressing the [+] switch brings up a new memo pad area (up to 8 areas).
Pressing the [−] switch brings up the previous memo pad area.

1 dot 2 dots Line Delete 
Area

Delete 
All

Blue Red Violet Green Light 
blue

Yellow
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Please use this page for notes.
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16 Print
16.1 Printing Data

Overview

When the V8 series is in RUN mode, the displayed screen or the internal buffer information can be 
printed.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

copy

A

B

C

D

E

F

PictBridge

PictBridge

PictBridge

1)  Hard copy “page 16-27”

2)  Sample print

3)  Data sheet print “page 16-28”

Alarm logging “page 10-66”
Data sampling “page 9-48”

<OFF> 08-20 13:25:40  Empty pallets short
<OFF> 08-20 14:05:13  Saddle raised and stopped
<ON> 08-24 16:59:54  Control panel emergency stop
<OFF> 08-24 17:01:05  Control panel emergency stop
<ON> 08-24 17:01:05  Operation box emergency stop
<ON> 08-24 17:01:05  Pusher error

Copy
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Compatible Printers

The following printers can be connected to the V8 series:

Compatible printers
For the applicable printer model names, visit our Website (http://www.monitouch.com).

Printable Items

The table below shows the items printable by the individual printers.

*1 When “PR201 color” or “ESC-P color” is selected, the 32k-, 64k- or 128-color screen is printed in 
16 colors.
The model V815 does not support screen hard copy.

*2 Color or monochrome hard copy can be designated with the system memory ($s1007).

Editor Setting Applicable Models V8 Connection 
Port

PR201 Monochrome PC-PR201 series models with which printing 
from MS-DOS is possible

MJ2/MJ1 or 
USB-A

PR201 color *1

ESC-P Monochrome ESC/P24-J84, ESC/P-J84, ESC/P Super 
models with which printing from MS-DOS is 
possible

ESC-P color *1

CBM292 / 293 Citizen Systems
Line Thermal Printer

MR - 400 Sato barcode printer MR-400 Series

EPSON STYLUS PHOTO *2 EPSON Color Inkjet Printer
STYLUS PHOTO

EPSON STYLUS C86 Series *2 EPSON Color Inkjet Printer
STYLUS C86

EPSON STYLUS C65 Series *2 EPSON Color Inkjet Printer
STYLUS C65

PictBridge *3 PictBridge compatible printer USB-B

Printable Item PR201
ESC-P CBM292/293 MR-400

STYLUS 
PHOTO

STYLUS C86
STYLUS C65

PictBridge

Screen hard copy  *1  *2

Sample print

Sample print
(Real-time print)

Data sheet print  *3

Data sheet print (expanded)

Print by the macro command 
“OUT_PR”

 *4

Print by the macro commands 
“MR_REG” and “MR_OUT”.

$s1007 Hard copy

0 Color (32k colors)

1 Monochrome
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*3 Print on A4 wide/15 inch wide sheets is not supported.
Data is printed in portrait orientation regardless of the paper setting.

*4 Macro command: OUT_PR
Only characters are printed.  Control codes are not printed.

A

Paper feed direction

A
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Printers PR201 and ESC-P

 The V8 is connectable with MS-DOS-compatible printers.
• MS-DOS-compatible printer models in the PR201 series
• MS-DOS-compatible printer models ESC/P24-J84, ESC/P-J84, and ESC/P Super
* For information on connectable models, visit our website (http://www.monitouch.com).

Connection

Connection with USB-A port
• Connect the USB-A port of the V8 unit to the parallel port of the printer with a USB-parallel 

conversion cable (commercially available).

Serial connection (MJ1 or MJ2)
• Connect the MJ port of the V8 unit to the parallel port of the printer via a converter.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM USB-A

V8
Printer

USB - parallel conversion cable
UC-PGT (ELECOM)

MJF 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8

Printer

V-CP

Parallel ← → serial converter

D-sub 25-pin ← → 9-pin converter

Parallel port
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Device Connection Setting

Click [System Setting] → [Device Connection Setting] → [Printer].  Make necessary settings in the tab 
window.

Printer

Connect to: Select the port where the printer cable is connected.

USB-A: 
Select this option when connecting to a parallel interface printer with a 
USB-parallel conversion cable (commercially available).

MJ1, MJ2:
Select this option when connecting to a printer equipped with serial 
interface.
Select either [MJ1] or [MJ2] of the V8 series.

Type Select the control code of the target printer from the following options:
• PR201 Monochrome
• PR201 Color
• ESC-P Monochrome
• ESC-P Color

 Always Output 
Status Bit  *1

When the V8 series receives a print command, [0 → 1] is output at the start 
of data transmission and [1 → 0] is output at the end of transmission.  
However, if the print data is minimal, the signal may not be output.  Check 
this box ( ) when the output of the bit is required regardless of the data 
size.

Orientation  *2  *3

(Horizontal, Vertical)
Hard copy setting
Choose the orientation of the screen image printed on paper.
When [Vertical] is selected, the image printed is turned 90 degrees on the 
paper.

Reversed
(Reversed, Normal)

Hard copy setting
Reversed: White and black are reversed for printing.
Normal: A print is made as shown on MONITOUCH

Refer to Data Sheet 
Setting

Proceed to the setting for data sheet printing.  For more information, refer 
to page 16-28.

 Use Extension 
Data Sheet

This setting item is inactive because expanded data sheet is not 
supported.
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*1 Data is output in the memory areas shown below.
• Bit 10 of write area “n + 1”

• Bit 0 of internal memory $s16

*2 For the edit models of SVGA (800 × 600 dots) or higher, this setting is not valid.
*3 Hard copy print example

Serial Port

This option is valid when [MJ] is selected for [Connect to:] in the [Printer] tab window.

Baud Rate Specify the baud rate.
4800, 9600, 19200, 38400, 57600, 76800, 115K BPS

Parity Set the parity.
None, Odd, Even

Data Length Set the data length.
7-Bit, 8-Bit

Stop Bit Set the stop bit.
1-Bit, 2-Bit

  0: End (standby)
  1:  Print data transferring

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0

MSB LSB

Write area n + 1

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

$s16

   0: End (standby)
   1: Print data transferring

A A

VerticalHorizontal
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Printer CBM292/293

The V8 is connectable with CBM printers (Citizen).
* For information on connectable models, visit our website (http://www.monitouch.com).

Connection
Serial connection (MJ1 or MJ2)

• Connect the MJ port of the V8 unit with the serial port of the printer.

Device Connection Setting

Click [System Setting] → [Device Connection Setting] → [Printer].  Make necessary settings in the tab 
window.

Printer

Connect to: MJ1, MJ2

Type CBM292/293

 Always Output 
Status Bit  *1

When the V8 series receives a print command, [0 → 1] is output at the start 
of data transmission and [1 → 0] is output at the end of transmission.  
However, if the print data is minimal, the signal may not be output.  Check 
this box ( ) when the output of the bit is required regardless of the data 
size.

Orientation
(Horizontal, Vertical)

These setting items are inactive because of incompatibility with hard copy 
output.

Reversed
(Reversed, Normal)

Refer to Data Sheet 
Setting

Proceed to the setting for data sheet printing.  For more information, refer 
to page 16-28.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM MJ

V8
Printer

MJ-D25

Serial cable

Serial port

CBM attached cable
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*1 Data is output in the memory areas shown below.
• Bit 10 of write area “n + 1”

• Bit 0 of internal memory $s16

Serial port
This port setting is valid when [MJ] is selected for [Connect to:] in the [Printer] tab window.

 Use Extension 
Data Sheet

This setting item is inactive because expanded data sheet is not 
supported.

Baud Rate Specify the baud rate.
4800, 9600, 19200, 38400, 57600, 76800, 115K bps

Parity Set the parity.
None, Odd, Even

Data Length Set the data length.
7-Bit, 8-Bit

Stop Bit Set the stop bit.
1-Bit, 2-Bit

   0: End (standby)
   1: Print data transferring

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0

MSB LSB

Write area n + 1

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

$s16

0: End (standby)
1: Print data transferring
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Printers EPSON STYLUS PHOTO, STYLUS C86, and 
STYLUS C65

The V8 is connectable with printer models STYLUS PHOTO, STYLUS C86, and STYLUS C65 
(EPSON) dedicated to Microsoft Windows.

* For information on connectable models, visit our website (http://www.monitouch.com).

Connection
Connection with USB-A port

• Connect the USB-A port of the V8 unit to the USB port of the printer with a USB cable 
(commercially available).

• Connect the USB-A port of the V8 unit to the parallel port of the printer with a USB-parallel 
conversion cable (commercially available).

Serial connection (MJ1 or MJ2)
• Connect the MJ port of the V8 unit to the parallel port of the printer via a converter.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM USB-A USB-B

V8
Printer

USB cable

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM USB-A

V8
Printer

USB - parallel conversion cable
UC-PGT (ELECOM)

MJF 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8

Printer

V-CP

Parallel   serial converter

D-sub 25-pin ← → 9-pin converter

Parallel port



16.1   Printing Data

16-10

Device Connection Setting

Click [System Setting] → [Device Connection Setting] → [Printer].  Make necessary settings in the tab 
window.

Printer

*1 Data is output in the memory areas shown below.
• Bit 10 of write area “n + 1”

Connect to: Select the port where the printer cable is connected.

USB-A: 
Select this option when connecting to a printer with a USB cable 
(commercially available).

MJ1, MJ2:
Select this option when connecting to a printer equipped with serial 
interface.
Select either [MJ1] or [MJ2] of the V8 series.

Type EPSON STYLUS PHOTO, EPSON STYLUS C86, EPSON STYLUS C65

 Always Output 
Status Bit  *1

When the V8 series receives a print command, [0 → 1] is output at the start 
of data transmission and [1 → 0] is output at the end of transmission.  
However, if the print data is minimal, the signal may not be output.  Check 
this box ( ) when the output of the bit is required regardless of the data 
size.

Orientation *2
(Horizontal, Vertical)

Hard copy setting
Choose the orientation of the screen image printed on paper.

Reversed
(Reversed, Normal)

Hard copy setting
Reversed: White and black are reversed for printing.
Normal: A print is made as shown on MONITOUCH

Refer to Data Sheet 
Setting

Proceed to the setting for data sheet printing.  Refer to page 16-28.

 Use Extension 
Data Sheet

This setting item is inactive because expanded data sheet is not 
supported.

   0: End (standby)
   1: Print data transferring

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0

MSB LSB

Write area n + 1
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• Bit 0 of internal memory $s16

*2 Hard copy example

Serial port
This port setting is valid when [MJ] is selected for [Connect to:] in the [Printer] tab window.

Baud Rate Specify the baud rate.
4800, 9600, 19200, 38400, 57600, 76800, 115K bps

Parity Set the parity.
None, Odd, Even

Data Length Set the data length.
7-Bit, 8-Bit

Stop Bit Set the stop bit.
1-Bit, 2-Bit

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

$s16

   0: End (standby)
   1: Print data transferring

A A

VerticalHorizontal
STYLUS PHOTO
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Printer PictBridge

It is possible to connect a printer compatible with the PictBridge standard.
* For the connectable models, visit our website (http://www.monitouch.com).

Printer Connection
Connection with USB-B port
Connect the USB-B port of the V8 unit to the USB-A port of the printer with a USB cable (commercially 
available).

* When transferring screen data via the USB-B port, change the cable connection.

Printer Setting

Click [System Setting] → [Device Connection Setting] → [Printer].  Make necessary settings in the tab 
window.

Connect to: USB-B (Selecting [Type: PictBridge] automatically selects this option.)

Type PictBridge

 Always Output Status 
Bit  *1

When the V8 series receives a print command, [0 → 1] is output at the 
start of data transmission and [1 → 0] is output at the end of 
transmission.  However, if the print data is minimal, the signal may not 
be output.  Check this box ( ) when the output of the bit is required 
regardless of the data size.

Orientation
(Horizontal, Vertical)

Hard copy setting
Choose the orientation of the screen image printed on paper.

Reversed
(Reversed, Normal)

Hard copy setting
Reversed: White and black are reversed for printing.
Normal: A print is made as shown on MONITOUCH

Refer to Data Sheet 
Setting

Proceed to the setting for data sheet printing.  For more information, 
refer to page 16-28.

PictBridge

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM USB-AUSB-B

V8 Printer

USB cable



16.1   Printing Data

16-13

16

*1 Data is output in the memory areas shown below.
• Bit 10 of write area “n + 1”

• Bit 0 of internal memory $s16

*2 With this option checked, the existing data sheet screen is converted to the expanded one.  
Restoration to the original is not possible.  Data display parts then will be converted to the 
following:
[Display Type: other than CHAR]  →  Numerical data display, [Display Type: CHAR]  → Character 
display
If the contents of a data sheet is not held within the size of paper as a result of expansion, correct 
the data.

Unchecking the box calls up the dialog below.
Clicking [Yes] deletes all parts registered on the data sheet screen.

 Use Extension Data 
Sheet*2

Check this box when using the expanded data sheet printing.

 Use PictBridge only on 
USB-B port

Check this option when using the USB-B port for connection with the 
PictBridge printer during the RUN mode of MONITOUCH.  Switch the 
MONITOUCH display to the Main Menu screen at the time of 
transferring screen data via the USB-B port.

   0: End (standby)
   1: Print data transferring

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0

MSB LSB

Write area n + 1

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

$s16

   0: End (standby)
   1: Print data transferring
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Print Size

The print size varies depending on the item to be printed out or the paper setting.

Screen hard copy
• The paper size is fixed to “A4”.
• The print start position and print size cannot be changed.  The actual margins, however, may differ 

from the one shown below depending on the printer used.

• When [Vertical] (portrait) is selected (unit: mm):
The portrait output is available when the printer supports A4 paper and 2-up printing.  If not 
supported, printing is performed in the landscape orientation.

• When [Horizontal] (landscape) is selected (unit: mm):
The landscape output is available when the printer supports A4 paper and 1-up printing.  If not 
supported, printing is performed in the orientation set on the printer.

Sample print
• Printing is fixed to “A4 vertical (portrait)”.  If a line cannot be held within the paper width, the 

remaining section will be printed while wrapping around and going down to the next line.
• The print start position and print size cannot be changed.  The actual margins, however, may differ 

from the one shown below depending on the printer used.

20

28

20

28

18

27

18

27

A A

(SVGA size)(VGA size)

The lower half will 
not be printed,

28

45

28

45

A
22

38

22

38

A

(SVGA size)(VGA size)

A

15

13
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Data sheet print
• Printing orientation is fixed to “portrait”.
• Select [Screen Setting] → [Data Sheet Setting] and select a paper size at [Paper Size].  If a 

selected paper size is different from the paper size set in the printer, printing cannot be performed 
correctly. (Data that is not held in the area is not printed.)

• The print start position and print size cannot be changed.  The actual margins, however, may differ 
from the one shown below depending on the printer used.

Data sheet print (expanded)
• The print size is A4 only.  Use a printer that handles A4 paper.  If A4 paper is fed in landscape 

orientation or a selected paper size is different from the paper size set in the printer, printing 
cannot be performed correctly.  (Data that is not held in the area is not printed.)

• The print start position and print size cannot be changed.  Margins to be left will slightly vary 
among different printer models.

• For parts placed on an expanded data sheet screen, the setting in [Display Setting] takes effect.  
When a part should always be printed, select [Show] in [Display Setting]

Status Output

The status of the connection between the V8 series and the PictBridge printer is output to the internal 
memory address $s1066.

*1 The error may be output as “-1” (printer error related to hardware) depending on the printer used.

Notes

• Monochrome print is performed with the V806M.  Otherwise, color print is performed.
• Error handling varies depending on the printer model.  For more information, refer to the 

instruction manual for the printer.

Value Status Cause and Remedy

0 The PictBridge printer is not 
connected, or it is in the normal state.

-

1 Printing is in process at the PictBridge 
printer.

-

-1 Printer error (related to hardware) The cable is not connected.  Check the USB cable 
connection.

Check if the printer is out of order.

-2 Printer error (related to paper) The printer runs out of paper.  Add paper.

Paper is not correct.  Set correct paper.

-3 Printer error (related to ink) *1 The ink is not set.  Install an ink cartridge.

The ink level is low.  Install a new ink cartridge.

A

15

13
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Sato’s Barcode Printer MR-400

The V8 is connectable with the barcode printer (Sato) for barcode printing.
* For information on connectable models, visit our website (http://www.monitouch.com).
* Read the instruction manual and command reference book for Sato’s barcode printer MR-

400 series before using this function.

Connection
Serial connection (MJ1 or MJ2)

• Connect the MJ port of the V8 unit with the serial port of the printer.

Printer Setting

Click [System Setting] → [Device Connection Setting] → [Printer].  Make necessary settings in the tab 
window.

Connect to: MJ1, MJ2

Type MR-400

 Always Output 
Status Bit  *1

When the V8 series receives a print command, [0 → 1] is output at the start 
of data transmission and [1 → 0] is output at the end of transmission.  
However, if the print data is minimal, the signal may not be output.  Check 
this box ( ) when the output of the bit is required regardless of the data 
size.

Orientation
(Horizontal, Vertical)

These setting items are inactive because of incompatibility with hard copy 
output.

Reversed
(Reversed, Normal)

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM MJ

MONITOUCH

V8
Printer

Serial cable
Serial port
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*1 Data is output in the memory areas shown below.
• Bit 10 of write area “n + 1”

• Bit 0 of internal memory $s16

Serial port
This port setting is valid when [MJ] is selected for [Connect to:] in the [Printer] tab window.

Memory Card

To use this function, a memory card is required for the MR-400.
For the memory card type and mounting procedure, refer to the instruction manual for the MR-400 
series.

Refer to Data Sheet 
Setting

These setting items are inactive because expanded data sheet is not 
supported.

 Use Extension 
Data Sheet

Baud Rate Specify the baud rate.
4800, 9600, 19200, 38400, 57600, 76800, 115K bps

Parity Set the parity.
None, Odd, Even

Data Length Set the data length.
7-Bit, 8-Bit

Stop Bit Set the stop bit.
1-Bit, 2-Bit

   0: End (standby)
   1: Print data transferring

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0

MSB LSB

Write area n + 1

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

$s16

   0: End (standby)
   1: Print data transferring
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Card Slot Number Setting and Memory Card Formatting

To enable the use of memory cards, set the memory card slot number and format the memory card on 
MR-400.

* “Memory card formatting” denotes the same as floppy disk initialization.

1) Turn off the power to MR-400, and insert a memory card into the card slot on the backside of 
MR-400.

2) Hold down the LINE key on the front of the MR-400, and turn the power on.
“USER MODE” is displayed on the front panel.

3) Press the LINE key and FEED key at the same time.
“ADVANCED MODE” is displayed.

4) Press the LINE key and FEED key at the same time again.
“CARD MODE” is displayed.

5) Press the FEED key until “CARD DRIVE NO/   1   2” is displayed.
Set the memory card slot number.
Press the LINE key to select, and press the FEED key to determine.)
This drive number is the memory card slot number.

6) Press the FEED key to determine the options.  Select “YES” for “CARD FORMAT/   YES   NO” 
and format the memory card.
If no error is given, formatting is successfully done.

7) To quit “CARD MODE,” turn the printer off.

• When the screen data is transferred after editing the MR-400 format table (registration setting), 
formatting is required.
In addition to the above formatting procedure, it is possible to format the memory card by 
outputting the control command of MR-400 from the V8 series.  For more information, refer to 
“Example 1: When the following commands are set in No. 22:” (page 16-24).

Format Table Types

There are two types of format tables.
When the MR-400 commands are registered in this table, desired format or data can be printed.

MR-400 format table (registration setting)
Set the print format.

* The “format” used in the format table includes settings for digits, position, typeface, 
barcode, etc. for MR-400.

Write these settings on the memory card using the MR_REG macro command.
Once they are written on the memory card, it is not necessary to repeat this step until the registration 
setting is changed.

1 2 3 4 5
1 2 3 4 5 6

0123456789012

ABCDEFGHI

Field No.1
Field No.2

Field No.3

Field No.1
Field No.2
Field No.3
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MR-400 format table (call setting)
Use the format (registration setting), and change the print data.  Set the storage target, type, etc. of the 
changed data.

Print the data using the MR_OUT macro command.

Format Table (Registration Setting)

For format table setting, go to [System Setting] → [Unit Setting] → [MR400 Format Table] → 
[Registration Setting].  Format table settings (registration settings) range from No. 1 to No. 128.

OK The format table setting is ended.

Cancel Format table editing is canceled.

Copy The currently open format table is copied into the specified table.

Jump The specified format table is opened.

Return The previous format table number is opened.

Next The following format table is opened.

6 6 6 6 6

4953103125773

MONITOUCH
5 5 5 5 5
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Setting example
To print in the following format:

• Description of escape sequence

• Description of the format table

1 2 3 4 5
1 2 3 4 5 6

Field No.1
Field No.2

Field No.3

<A>

<CC> 2

<YS>, 1 0

</N>, 1, 1 0

<V> 1 0 <H> 5 0

<B> 2 0 2 0 8 0 1 2 3 4 5 6 7 8 9 0

</N>, 2, 5

<V>1 0 0 <H> 5 0 <L> 0 2 0 2 <P> 2 

<X22>, 1 2 3 4 5

</N>, 3, 6

<V> 1 5 0 <H> 3 0 0 <L> 0 1 0 1 <P> 2

<X2 2>, 1 2 3 4 5 6�

<Z>

<Data send start>

<Card slot> Slot number

<Format register>, Format register number
Match this number to the 
registration setting number.

<Field register>, field number, print digits

<Vertical print position> dots <horizontal print position> dots

<Barcode> Bar code type, bar width enlargement, bar top/bottom size (dots), data

<X22 characters>, data

 <Data send end>

Data 
registered for 
field No. 1

Data 
registered for 
field No. 2

Data 
registered for 
field No. 3

Match these 
numbers.
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Notes on inputting

The escape character (ESC) at the top of the escape sequence is expressed as “< >” on MR-400 
and as “1B(H)” in hexadecimal notation.
In the format table, “\” denotes hexadecimal data.
Consequently, “1B(H)” is shown as “\1B”.

To describe “\” as a character, enter “\\”.

MR-400 Format Table (Call Setting)

For format table setting (call setting), go to [System Setting] → [Unit Setting] → [MR400 Format Table] 
→ [Call Setting].  Format table settings (call settings) range from No. 1 to 128.

*1 Field No. 1 to 99 are used.
Settings of No. 100 to 512 are not valid.

Memory Card Slot
(No. 1, No. 2)

Select the card slot drive number set on MR-400.

 Memory Check the box ( ) when each field data is stored in the memory.

OK The format table setting is ended.

Cancel Format table editing is canceled.

Copy The currently open format table is copied into the specified table.

Jump The specified format table is opened.

Return The previous format table number is opened.

Next The following format table is opened.

<X22>, 12345 Escape sequence

1BX22, 12345 Escape sequence
(HEX display)

\1BX22, 12345 Format table

Format table 
number

Field number *1
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Setting example (1)
<To print “ABCDE” in field No. 1>

Setting example (2)
<To print data stored in memory in field No. 2>

Check the box ( ) for [  Memory] of field No. 2.
Press the [Detail] button to bring up the [Detail] dialog.

• Select [Text] for [Type].

*1 To print “ABCDEF” in one-byte characters, specify as shown below in the Shift JIS code.

Memory Specify the top memory address where print data is stored.

No. of Bytes *1 The specified number of bytes is output from the address specified for 
[Memory].

Text Process LSB → MSB / MSB → LSB
Set the recognition of MSB and LSB in one word.

 Add Start and End 
Codes

Make the setting when using barcode type “CODE 39.”
(Refer to page 16-25.)

D100 4241 [H]

D101 4443 [H]

D102 4645  [H]
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• Select [Numerical Data] for [Type].

*1 When [Numerical Data] is selected, binary data is converted into characters (JIS code).
Example: 
When “0100 (BIN)” is set in D100, characters 0100 (= “100”) is printed.

Memory *1 Data contained in the specified memory address is printed in numerals.

Digits Specify the number of digits for the display type.

Decimal Point Specify the number of decimal places.

Display Type Choose from DEC-, HEX, OCT, DEC or BIN.
When [DEC-] is selected, data is shown in decimal notation with ± signs.

 Zero Suppress Choose whether or not to use the zero suppress function.
When [Zero Suppress] is checked ( ), the suppressed zero is filled with 
spaces.

Data Length Choose data length for the memory to be used.

Text Choose one-byte or two-byte characters.

 Add Start and End 
Codes

Make the setting when using barcode type “CODE 39.”
(Refer to page 16-25.)
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Macro

The macro command “MR_REG” is available to write the setting data from format tables (registration 
setting or call setting) to the MR-400.  The macro command “MR_OUT” is available to print out the 
data.

MR_REG
Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

• Example 1: When the following commands are set in No. 22:

When the MR_REG 22 macro command is executed, the memory card is formatted.

• Example 2: When the following commands are set in No. 1:

Execute the MR_REG 1 macro command as the ON macro of a switch.
First: The format is registered on the memory card for MR-400.
Second: The registered data is printed and the format can be checked.

Internal Memory PLC1 - PLC8 Memory Memory Card Constant

F1

Value

F0 Format table registration setting No. 1 - 128
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MR_OUT
Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

• Example 1: When the MR_OUT 50 macro command is executed:
Data of the MR-400 format table (call setting No. 50) is printed.

Barcode Type “CODE 39”

CODE 39 has “∗” at the beginning and the end of each barcode.
When the format table is created, set “∗” in the following two positions.

• Setting in [MR-400 Format Table (Registration Setting)]
Set the number of digits including “∗” for format registration.
For example shown below, set “12” (10 characters + 2).

Internal Memory PLC1 - PLC8 Memory Memory Card Constant

F1

Value

F0 Format table call setting No. 1 - 128
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• Setting in [MR-400 Format Table (Call Setting)]
• Select [Text] for [Type].

• Select [Numerical Data] for [Type].

No. of Bytes Specify the number of bytes including “∗”.

 Add Start/End 
Code

Checked ( ): “∗” is not included in data in [Memory].
Unchecked ( ): “∗” is included in data in [Memory].

 Add Start/End 
Code

Checked ( ): “∗” is not included in data in [Memory].
Unchecked ( ): “∗” is included in data in [Memory].
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16.2 Hard Copy
Print

There are two manners below to print out the screen currently displayed.

Command from Read Area

Bit 10 of [Read Area] “n + 1” is the screen hard copy bit.
Hard copy is produced at [0 → 1] edge.

Printing procedure
1) Bring up the screen to be printed.
2) Set bit 10 of [Read Area] “n + 1” from “0” → “1”.
3) Printing starts.

Command from the Switch

Hard copy is produced by pressing the switch.  The switch placed on the screen is also printed out.

Screen data setting
1) Place a switch provided with [Function: Hard Copy] on the screen which is intended to be 

printed out.
2) Transfer the screen data to the V8 unit.

Printing procedure
1) Bring up the screen to be printed.
2) Press the hard copy switch.
3) Printing starts.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC

D001
D002

D000

PictBridge

Set bit 10 (for screen hard copy) of 
read area “n + 1” from “0” → “1”.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

copy PictBridge

copy
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16.3 Data Sheet Print
Overview

This section explains printing the data currently displayed on numerical data displays or character 
displays that are registered on a data sheet.
This print function also enables real-time printing of memory data that is not shown on the V8 series.

Expanded functions
The data sheet expanded functions are available with the PictBridge printer.
With the expanded functions of data sheet, additional parts can be used, such as lamps and graphs, 
and the sizes of those parts can be changed.  Moreover, the expanded functions allow for parts 
placement regardless of the grids, thereby diversifying layouts on data sheet screens.  Those data 
sheets can be printed out in color.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PictBridge

A

B

C

D

E

FPLC
Print

The V8 series can print out data 
sheets showing the current PLC 
data. 
Setting the bit for “data sheets” prints 
the data sheets.

V8

The printed data sheets show the PLC data 
when printing is initiated.

Printer

Setting the bit for “output data sheets”...

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PictBridge

Print

A        350    42.9%
B        209    25.5%
C        156    19.1%
D        100    12.2%

815

A B C D<

<Current Production Statistics>

Total

Numerical 
data displays

Statistic pie graph

Data sheet screen No. 3

PictBridge printer

Set (ON) bit 9 (for data sheet 
output) in read area “n + 1”.

One sheet of data sheet screen No. 3 is printed out.

D100 = 3
D101 = 1
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Data sheet screen
The print screen is formatted in [Data Sheet] in the V8 series screen data file.
Items usable on data sheets vary, depending on whether the expanded functions are used.

* For more information on the data sheet editing procedure, refer to the Operation Manual.

Item Without Expanded Functions With Expanded Functions
(With PictBridge only)

Graphics Line
Box
Text

Line/continuous line
Box/circle
Text/multi-text
Dot
Paint
Scale
Pattern

Parts Numerical data display
Character display

Lamp
Numerical data display
Character display
Message display
Bar graph
Pie graph
Panel meter
Statistic bar graph
Statistic pie graph
Time display/calendar

A        350    42.9%
B        209    25.5%
C        156    19.1%
D        100    12.2%

815

Line or box

Data display
(Numerical data)

Data display
(Characters)

Text

• With the expanded functions• Without the expanded functions

Statistic pie graph

Line A
Line B

Line C

Line D

Line E

Line F
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Setting Dialog

Data Sheet Setting
[Use Extension Data Sheet] unchecked

*1 This setting is valid only for Japanese printers.
*2 All characters and lines on the data sheet screen are handled as text.  Consequently, the printed 

data sheet looks slightly different from the one on the editor screen.
• Character graphic not used

Top Page Setting 
Memory

Use this memory when printing data sheets by the command (refer to page 
16-32) given in the read area.  2 words are used.

Paper Size
(A4 Portrait, A4 
Landscape, 15-Inch 
Landscape, User 
Designation)

Select a paper size.  According to the size selected, the numbers of 
characters and lines are set.
Printed images are always in portrait orientation.

Characters
(16 to 152) Specify the number of characters per line on a data sheet page.

No. of Lines
(2 to 152) Specify the number of lines per data sheet page.

 Use Character 
Graphic Print *1 *2

When this box is checked ( ), ruled lines are printed clearly.
The number of lines also varies.
The numbers of characters and lines are automatically set as shown 
below.

n Print start number (→ V)

n + 1 Number of pages to be printed (→ V)

Paper Size Characters
No. of Lines

Character graphic
Not used

Character graphic
Used

A4 portrait 80 66 108

A4 landscape 114 40 64

15-inch 
landscape 136 64 64

   Example: Data sheet edited on the editor screen Printed

No. 0 Data

No. 1 Data

No. 2 Data

No. 3 Data

No. 0 Data

No. 1 Data

No. 2 Data

No. 3 Data
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• Character graphic used

[Use Extension Data Sheet] checked (with PictBridge)

Top Page Setting 
Memory

Use this memory when printing data sheets by the command (refer to page 
16-32) given in the read area.  Two words are used.

Paper Size
(A4 Portrait, A4 
Landscape)

Select the orientation of the data sheet screen.  (Paper Size: A4 fixed)

   Example: Data sheet edited on the editor screen Printed

No. 0 Data

No. 1 Data

No. 2 Data

No. 3 Data

No. 0 Data
No. 1 Data
No. 2 Data
No. 3 Data

No. 0 Data
No. 1 Data

No. 2 Data

No. 3 Data

No. 0 Data
No. 1 Data
No. 2 Data
No. 3 Data

n Print start number (→ V)

n+1 Number of pages to be printed (→ V)

Paper size 
(printable area: height x width) 

Orientation

A4 Portrait (912 x 640 dots) Vertical

A4 Landscape (640 x 912 dots) Horizontal

A4 portrait  A4 landscape

A A

Example: Print on 4 paper fed in portrait orientation 

Data sheet 
screen

Data sheet screen 
turned 90 degrees

Paper feed 
direction

Paper 
feed 
direction



16.3   Data Sheet Print

16-32

Print

There are two methods for printing data sheets.

Command from Read Area

Bit 9 of [Read Area] “n+1” is the data sheet output bit.
[0  Data sheet is printed at [0 → 1] edge.

Printing procedure
1) Specify the data sheet number to be the top page for [Top Page Setting Memory] “n”.
2) Specify the number of output pages for [Top Page Setting Memory] “n+1.”

* When [Top Page Setting Memory] “n+1” is “0”, the printer will not print any data sheet.
3) Set bit 9 of [Read Area] “n + 1” from “0” → “1”.
4) Data sheet is printed.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PictBridge

PLC
A Line

B Line

C Line

D Line

E Line

Data sheet No. 3

D010
D011

D009
3
1

D001
D002

D000

Usage example
Read area = D0000
Top page setting memory = D0010

1)  2)

3)

D010: Top page setting memory = 3
D011: Output pages = 1

Bit 9 of read area “n + 1”
 = data sheet output [0 → 1] 
leading edge

4)
One page of data sheet No. 3 
is printed.



16.3   Data Sheet Print

16-33

16

Command with Macro

Use the STA_LIST macro command to print data sheets.

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

* No printing is executed when “0” is set as the number of pages to be printed.  When the 
range specified for print includes an unregistered number, the page corresponding to the 
number will not be printed.

Printing procedure
1) Set the data sheet number to be the top page for the memory “F1 + 0”.
2) Set the output pages for the memory “F1+1”.
3) Execute the STA_LIST macro command.
4) Data sheet is printed.

Internal Memory PLC1 - PLC8 Memory Memory Card Constant

F1

Value

F0 STA_LIST

F1 Print start data sheet number

F1 + 1 Number of pages to be printed: 1 to 1,024*

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PictBridge

A line

B line

C line

D line

E line

Data sheet No. 3

Print example:
To print data sheet No. 3 with F1 = $u100:

1) $u100 = 3 (W) Print start data sheet number
2) $u101 = 1 (W) Number of pages to be printed
3) STA_LIST $u100 Macro execution

4) One page of data sheet No. 3 is printed.
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Notes

When no data sheet screen has been registered, data sheets cannot be printed even if you specify 
them by number.

Print example: 
Read area = D0000
Top page setting memory = D0010

PLC
A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

Data sheet No.14
A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

Data sheet No.12
A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

Data sheet No.11
A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

Data sheet No.10

Data sheet No. 10
No. 11

No. 12
No. 13

No. 14

Data sheet No.14

Data sheet No.10

No.12
No.11

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

If data sheet pages are registered as 
shown on the left:

D0010 (Top page setting memory) = 10
D0011 (Output pages) = 5

Bit 9 (data sheet output) of D0001 [0 → 1] leading edge 

Data sheet No. 10 to 12 and 14 can be printed.
The page that is not stored, No. 13, is ignored, and 
four pages are output.
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17 Barcode
Overview

The V8 series reads barcode data, converts the necessary data into ASCII code and writes them in the 
PLC memory.
With this feature, all information from the barcode is transferred immediately to the PLC. 
Additionally, the V8 series can show the read barcode data on the screen.

• There is no “handshake communication” between them. 
(The barcode reader is not synchronized with the V8 series.)

• A barcode reader is connectable to either modular jack MJ1 or MJ2 or the USB-A port of the V8 
series.
For information on the validated models, refer to the V8 Series Connection Manual.

• It is possible to connect a 2D barcode reader for data read/write operations.

• Note on serial connection
Depending on the barcode reader type, the applicable connecting cable differs.  Please prepare an 
appropriate conversion cable on your own.
(Refer to “Connecting Barcode Reader” on page 17-10.)

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

4902580302447

PI !

PLC

The V8 series reads 
barcode data and 
transfers it to the PLC.Barcode reader

Code No.
4902580302474
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Setting Dialog

Setting Procedure

With the V8 series, barcode connection is recognized as one among 8-way communication.
The setting procedure is the same as that for 8-way communication.  Set the items as shown below.

Step 1 Select [System Setting] → [Device Connection Setting].

Step 2 The [Device Connection Setting] dialog is displayed.
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Step 3 Among [PLC2] to [PLC8], click a position that shows “No connection”.
In this example, select [PLC2].

Step 4 Check the box for [  Use PLC2].
The [PLC2 Connection Device Selection] dialog is displayed.

Step 5 Select [Barcode] for [Device connected].

Step 6 Select an option for [Connect to:]

* When a port already occupied is selected, the following message will be displayed.  
Check that there is no overlapping selection, and correct the setting.
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Step 7 Click [OK], and barcode reader connection is set to the selected MJ port.
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Barcode Setting

Type Select the type of barcode reader from the following options.
• JAN (UPC, EAN)
• ITF (Interleaved 2 of 5)
• CODABAR (NW-7)
• CODE39
• ANY (2D code)
• CODE128

Baud Rate *1 Choose a baud rate.
4800, 9600, 19200BPS

Data Length *1

(7-Bit, 8-Bit) Set the bit length.

Stop Bit *1
(1-Bit, 2-Bit) Set the stop bit.

Parity *1 Set the parity.
None, Odd, Even

Terminator *1
(STX, ETX, CR/LF, CR) Set the terminator.

Parity Set the parity.
None, Odd, Even

Check Digit Set the check digit.
None, Do Not Delete, Delete

I/F Memory Specify the top memory address where barcode data, etc. is stored.
For more information, refer to page 17-6.

 Read Bytes Setting Check this box ( ) when setting the upper limit of the bytes to be read.
Specify an even number for [No. of Bytes].
For more information, refer to page 17-7.

 Use Control 
Memory

Refer to page 17-8.
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*1 Settings necessary for serial connection

I/F Memory

The allocation of I/F memory is shown below:
Type: JAN, ITF, CODABAR, CODE39, CODE128

Type: ANY

 Use Start/End Code This is valid when [Type: CODE39] is selected.
Set the processing of start/end codes “∗” when reading barcodes.

Checked ( )
Data with start/end codes is saved in [I/F Memory].

Unchecked ( )
Data without start/end codes is saved in [I/F Memory].

 Storage Order Set the order in which data is stored in the I/F memory.

Checked (  )
LSB → MSB, MSB → LSB

Unchecked ( ) I/F memory: Internal memory
MSB → LSB

Unchecked ( ) I/F memory: PLC memory
As specified for [Text Process] in the [Communication Setting] tab 
window for the target PLC

Precedence Set a priority among PLC2 to PLC8.

Memory Contents

n Flag / the number of data read

Reset (“0”) all bits not used.

n + 1
•
•

n + m

Data read (ASCII)
“0” (null code) attached to the end of the data

Memory Contents

n Flag

Reset (“0”) all bits not used.

n + 1 (3) Number of data read (0 to 2,048 bytes)

n + 2
•
•

n + m

Data read (ASCII)
“0” (null code) attached to the end of the data

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

0 0 0 0

(3) The number of data read 
(0 to 256 bytes)

(2) Reading complete

(1) Communication error

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

0 0 0 0 0 0 0 0 0 0 0 0 0 0

  (2) Reading complete

   (1) Communication error
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Flag details

Read Bytes Setting

The number bytes to be read depends on the setting for [Type] and [Read Bytes Setting].

• Example
I/F Memory:  D100
Read Bytes Setting:  Checked
No. of Bytes:  10 bytes

- When data “4902580302474” exceeding 10 bytes is read:
10 bytes of data is stored and the remainder is deleted.

(1) Communication 
error
(bit 14)

If an error has occurred during communication between the barcode reader and 
the V8 series, bit 14 is set (“1”).
Check that the settings in the [Communication Setting] tab window ([System 
Setting] → [Device Connection Setting] → [Barcode]) match the settings for the 
barcode reader.  Also check that cable connection is correct.

(2) Reading complete
(bit 12)

When data from barcode reader is received and written to the I/F memory, bit 12 
(reading complete) shows “1”.  Check that the bit is set, and can receive the next 
data.
To read the next barcode data, reset the bit to “0” when the data has been read.

(3) The number of data 
read

The number of bytes read by the barcode reader is written.

Type Read Bytes Setting Check Box Memory Occupied

JAN
ITF

CORDERBAR
CODE39
CODE128

Unchecked Variable for codes to be read
254 bytes maximum

Checked Fixed to the set number of words
(2 to 254 bytes)

ANY
Unchecked Variable for codes to be read

2046 bytes maximum

Checked Fixed to the set number of words
(2 to 2046 bytes)

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

D101

4902580302

I/F Memory Value
D100 Flag / the number 

of bytes read
D101 3934HEX
D102 3230HEX
D103 3835HEX 10 bytes

D104 3330HEX
D105 3230HEX
D106 Not used
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- When data “12345” less than 10 bytes is read:
“0” is stored in memory addresses when there is no corresponding data.

Control Memory

The read permission bit in the control memory is available to control reading by the barcode reader.

• Bit 0: Read permission bit
When this bit is set (ON), data storage in the I/F memory takes place.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

D101

12345

I/F Memory Value
D100 Flag / the number 

of bytes read
D101 3231HEX
D102 3433HEX
D103 0035HEX 10 bytes

D104 0000HEX
D105 0000HEX
D106 Not used

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Read permission bit
0: Not permitted
1: Permitted

Not used
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Barcode Setting Example

Follow these steps to display barcode data received from the PLC on the screen of the V8 series:

Setting Procedure

Set the [Barcode Setting] and [Char. Display] dialogs.
1) Refer to the barcode reader’s manual, and set the items in the [Barcode Setting] dialog 

correctly.  (Refer to page 17-5.)
In this example, specify “D0110” for [I/F Memory].

2) To show the contents of the barcode data that was read, use a character display part. 
For more information, refer to “5  Data Display.”

Notes on Setting

1) In this example, specify “D111” for [Memory] for the character display part because barcode 
data is stored from “n + 1” (“n + 2” for 2D code).

2) Specify the number of bytes of barcode data for [Read Bytes Setting].

* This example shows a case of data storage with [Text Process: LSB → MSB].

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

4902580302474

PI !

PLC

4902580302474
Code No.

Read 
“4902580302474”.

The barcode number is shown here.

“4902580302474” is 
written from D0111.

Barcode reader

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

4902580302474

PI !
D0110

D0111

D0112

D0113

D0114

D0115

D0116

D0117

H3934

H3230

H3835

H3330

H3230

H3734

H0034

Code No.4902580302474

Barcode reader

Read 
“4902580302474”.

This is “13” as 13 
bytes are used.

Flag / the number of bytes read

Character display memory D0111

Data read

I/F memory of barcode setting
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Connecting Barcode Reader

This section explains the connection between the V8 series modular jack (MJ1/2) and the barcode 
reader.

Modular Jack Pin Arrangement and Signal Name

The pin numbers and signal names are shown in the following diagram.

*1 The maximum allowable current value for external power supply (+5V) will vary according to 
whether the system is full-featured (with communication unit + option unit) or not.  For more 
information, refer to the V8 Series Hardware Specifications.

Hakko Electronics’ Cable (V6-BCD)

Length: 3 m
With modular plug

Notes on Connection

For barcode readers with CTS/RTS control, it may be necessary to install a jumper between the CTS 
and RTS to maintain proper operation.

MJ 1 / 2 Pin No. Signal Name Contents

1 +RD/+SD RS-485 data (+)

2 −RD/−SD RS-485 data (−)

3 +5V External +5 V *1
Max. 150 mA4 +5V

5 SG
SG

6

7 RD RS-232C receive data

8 SD RS-232C send data

12345678

MONITOUCH side

12
34

56
78

Brown: + 5V
Red: 0V
Orange: RD
Yellow: SD
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18 CF Card
18.1 Overview

This chapter describes the functions available with CF cards in the V8 series.

Connection

Card Interface

The CF card interface is provided as a standard feature.
* The CF card cover is provided.  When the CF card cover is opened, access to the CF card is 

automatically disabled (when completed during access); when the CF card cover is closed access 
to the CF card is enabled.  For more information, refer to the Hardware Specifications.

USB CF Card Reader/Writer

A USB CF card reader/writer “USB-CFREC” can be connected to the USB-A port (master port) 
provided on the V8 unit as standard.

96
M

B

CompactFlash Card

PLCF 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Insert the CF card.

Reading/writing data 
is supported.

V8

Trend Sampling

USB-A

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

64MBInsert the CF card.

Reading/writing data is supported.

V8

Trend Sampling

USB-CFREC
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2 Drives Supported

The card interface and the USB-A port (master port) can be recognized at the same time.
The card interface is used as a storage target while data can be copied to a CF card connected at the 
USB-A port for data backup purpose.

For more information, refer to page 18-48.

Before Using CF Cards

CF Cards (Operations Verified)
For a list of cards (CompactFlashTM compliant CF cards) operations that have been verified, visit our 
website (http://www.monitouch.com).

When Connecting to Your Computer:

A computer installed with the V-SFT and a CF card reader/writer is needed to save data from the 
computer to a CF card or view the data exported from the V8 to a CF card on the computer.

64MB

64
M

B

CompactFlash Card

PLCF 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

USB-CFREC

Data copying is supported.

V8

Trend Sampling

64MB

Import data from the CF card 
into a PC using the CF card 
reader/writer.

CF card

CF card reader/writer
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Applicable Format (File System)

The V8 series can recognize CF cards of “FAT” and “FAT32” file system types.

Notes

When using a CF card, please note the following:
• Before inserting a CF card into MONITOUCH, be sure to read the V8 Series Hardware 

Specifications and keep the right side out.
If a CF card is inserted with the wrong side out, the CF card or the socket at the MONITOUCH may 
be damaged.

• Do not insert or remove any CF card during access.  Doing so may corrupt data on the CF card.
CF cards can be inserted or removed when the Main Menu screen is displayed.
However, if you press the [Card Menu] switch on the Main Menu screen to bring up the Card Menu 
screen, you cannot insert or remove your CF card.
Before inserting/removing a CF card in the RUN state, ensure that the [CF Card Removal] switch 
is pressed (ON).  Failure to do so could cause data corruption or damage to the CF card.

• Do not turn off MONITOUCH during access to the CF card.
• Save a backup copy of the CF card data at regular intervals.
• If there should be a disk error and you cannot read/write data, you can scan the disk in Windows to 

restore the disk data.
If you still cannot restore the disk data, you need to re-format the CF card.  If you format the CF 
card, data on the card is completely lost.  (For more information on scanning the disk or operating 
Windows, refer to the Windows help information.)

• There is a limitation in the number of write operations to a CF card (about 300,000 times).
If you write to a CF card in a short cycle, it can reduce the card’s lifetime.  When using a CF card to 
save sampling data, be aware of the sampling time.  Be sure to always avoid writing to a CF card 
with the CYCLE macro command.

• Note that the amount of the data to be written should not exceed the memory capacity of the CF 
card.
Especially when you use functions to write data from the V8 series to a CF card, such as saving 
sampling data as CSV files, saving screen data, screen images, or transferring recipe data, you 
need to be careful about the capacity limit of the CF card.
For more information on checking the free CF card space, refer to page 18-56.

• If the screen data for which the CF card function is used is on the V8 series, be sure to insert the 
CF card before operating the screen.

• With a high-capacity CF card (of 2 GB or more) connected, the V8 unit may take a considerable 
time to identify the card.  Do not insert and remove the CF card in a short time.
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Function

You can use the following functions with a CF card.

Saving multiple screen data (Refer to page 18-15.)
You can exchange screen data when needed by saving multiple screen data on a CF card.

Auto uploading of screen data (Refer to page 18-19.)
When a CF card is inserted and the power is turned on, screen data is automatically uploaded.
You can exchange screen data easily.

Saving sampling data (data logging) (Refer to “Appendix 1  Buffering Area.”)
You can save the history data such as errors and numeric values.
If you convert the stored sampling data to a CSV file using the macro command, you can edit the data 
easily using application software such as Excel.
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F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

A

B

C

96
M

B

CompactFlash Card

CF card

Screen data B

Multiple screen data can be saved.
You can select the necessary screen 
data and transfer it to the V8 series. V8 series

96
M

B

CompactFlash Card

96
M

B

CompactFlash Card

96
M

B

CompactFlash Card

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

A BLoading from CF Card.

Insert a CF card and turn 
the DIP switch ON.

MONITOUCH 
power OFF

MONITOUCH 
power ON

When the power is turned 
on, screen data is 
automatically transferred.

96
M

B

CompactFlash Card

PLCF 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Sampling data is written.

V8 series

You can edit it on your PC.

Read data from 
the CF card.

Trend Sampling
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Titles to the sampling data may be given in the CSV file.  (Refer to page 18-45.)

Transferring recipe data (Refer to “13  Recipe Mode” or the Macro Reference 
Manual.)
Using a macro command or recipe function, you can read and write CSV format files, which you 
created on a computer, etc.

Transferring recipe data by the memory manager function (Refer to page 18-42.)
You can also transfer recipe data by the V6 compatible memory manager function.
This is recommended if you are familiar with existing methods or if you use the Memory Card Editor.

Storing JPEG file (Refer to page 18-43.)
You can display a JPEG file on the V8 series screen.
Be sure to store the JPEG data to be displayed on a CF card.

No titles
Buffer number

With titles

96
M

B

CompactFlash Card

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PLC
5516
4450
5465
8845
6548
7894
5478

545
889

65
548

55

No. 5

Manage the data in CSV format.

Data can be 
transferred from the 
CF card to the PLC 
and can be written 
from the PLC to the 
CF card.

V8 series

Read and write 
data on a CF 
card.

Data

Production data A

Production data A-1

Production data A-2

Production data A-3

Production data A-4

Production data A-5

Production data A-6

Setting value 1

Setting value 2

Setting value 3

Setting value 4

Setting value 5
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F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

96
M

B

CompactFlash Card

You can display the JPEG file 
stored on the CF card on the 
screen. V8 series

JPEG file CF card
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Saving a video image (Refer to “14.2  Video/RGB Display”.)
In the V8i that supports the video display function, an image captured from video can be saved as a 
still image using the snap function.
The saved image data is stored on a CF card as a JPEG file.

Saving a hard copy image (Refer to the Macro Reference Manual.)
You can store a screen image such as a JPEG file using the macro command on a CF card.
When it is difficult to connect to the printer at a production site, you can save the screen images on a 
CF card and print them later from your computer.

Backing up memo pad data (Refer to page 18-47.)
When using the memo pad function, you can save memo pad data even when the V8 series is turned 
off.
You can also convert the saved memo pad data to a Bitmap file using the screen editor.

Multi-language display selection (Refer to “Appendix 3  Display Language.”)
If you register text that were edited in a required language as screen data, you can easily switch 
between languages on the V8, such as between Japanese and Chinese (Simplified) or between 
Japanese, Korean, and Chinese.
You need to store the required fonts on a CF card.  When using the macro command to order 
switching, the target language is read from a CF card and displayed.

F 1

F 2
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96
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CompactFlash Card

Save the displayed image on the card.
(JPEG file)

V8 series

Save the video image 
on the CF card.CF card

Execute 
“SNAP” !

Video
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CompactFlash Card

PLC

F 1
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F 4

F 5

F 6

F 7

SYSTEM

V8 series

You can manage and print it on your PC.

Import into the CF card as 
JPEG data.

Save an image for printing 
using the macro command.

Trend Sampling

Trend Sampling

Trend Sampling
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Reduction in screen data size
Part of the screen data, such as screens, patterns, or messages, can be stored on the CF card.  In this 
way, the screen data size can be reduced.

• Storing a pattern (Bitmap) file (Refer to page 18-22.)
• Storing messages (text) (Refer to page 18-24.)
• Storing screen BIN data (Refer to page 18-28.)
• Storing Gothic fonts (Refer to page 18-31.)
• Storing a sound (WAV) file (Refer to page 18-33.)

Sound (WAV) files used for the sound play function of the V8i can be stored on the CF card.

• Storing 3D Parts (Refer to page 18-36.)
Bitmap files of 3D parts (switches, lamps, or data displays) can be stored on the CF card.

• Storing Windows fonts (Refer to page 18-39.)
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Using the macro command, only the language fonts are 
changed.  The rest of the screen data is kept as is.

Store required fonts on the 
CF card in advance.

Japanese Chinese (simplified)

Japanese Korean Chinese
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CompactFlash Card

WAV file No. 0

When the sound play bit is set (ON), the sound 
file is called from the CF card and played.

WAV file No. 1

WAV file No. 2

Speaker

CF card

Sound files imported from the computer

The safety plug 
is disconnected.

Alarm tracking

Safety plug error
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Web server (Refer to “19.5  Web Server.”)
You can monitor the contents of data and images displayed on the V8i, from a Web browser on your 
computer connected to the V8 series by a LAN.  Store the files to be accessed from a Web browser on 
a CF card in advance.

Operation log (Refer to “Operation Logs” in the V8 Series Reference Additional 
Functions”.)
Screen operation history records (operation logs) can be output to the CF card.
In the event of an error, these logs stored will permit users to examine what was conducted at that 
time; thus helping analysis of the causes of the error.

Backing up SRAM data (Refer to “Chapter 5 MONITOUCH Operations” in the 
Hardware Specifications)
If you use built-in SRAM or a SRAM cassette, you can save a backup copy of SRAM data on a CF 
card in case the data may be lost when replacing the SRAM battery.

2 drives supported (Refer to page 18-48.)
The card interface and the USB-A port (master port) can be recognized at the same time.
The card interface is used as a storage target while data can be copied to a CF card connected at the 
USB-A port for data backup purpose.

LAN

96
M

B

CompactFlash Card

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

64MB

64
M

B

CompactFlash Card

PLCF 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

USB-CFREC

Data copying is supported.

V8

Trend Sampling
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18.2 Folder Configuration
Access Folder

• When writing screen data from your computer to a CF card or writing data from the V8 series to a 
CF card, folders are automatically created under the access folder on a CF card.

• The name of the access folder that is created on a CF card is the folder name you specified in the 
screen data file.  (Select [System Setting] → [CF Card Setting].  For more information, refer to 
page 18-10.)

• If you create access folders under different folder names according to the screen data, multiple 
screen data can be saved in respective folders as long as the CF card space allows. 

For the procedure of storing multiple screen data, refer to page 18-15.

BITMAP
CARD
DSP
FONT

DAT0000

BITMAP
CARD
DSP

TEST

BITMAP
CARD
DSP
FONT
HDCOPY
JPEG
MEMO
RECIPE
SAMPLE

PRODUCT

(= Access folder name = Screen data A)

(= Access folder name = Screen data B)

(= Access folder name = Screen data C)
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CF Card Setting

Select [System Setting] → [CF Card Setting].  The [CF Card Setting] dialog is displayed.  Before using 
CF cards, check the setting in this dialog.

CF Card Connection Target Select the CF card to be accessed in the RUN mode.
(This setting is not valid when transferring screen data from the 
CF card because the V8 is in the STOP mode (Main Menu screen 
displayed).)

Access Folder Name
(Max: 32 one-byte 
alphanumeric characters *, 
Default:  DAT0000)

Folder names on the CF card can be created for each screen 
data.
If the same folder name already exists, data will be overwritten.  
Double-check the folder name.

 Range of Patterns to be 
Saved to CF Card

Pattern data can be saved on a CF card.
For more information, refer to page 18-22.

 Range of Messages to be 
Saved to CF Card

Message data can be saved on a CF card.
For more information, refer to page 18-22.

 Range of Screen to be 
Saved to CF Card

Screen data can be saved on a CF card.
For more information, refer to page 18-28.

 Store Manual Font Setting 
to CF Card

When Gothic fonts are used, font data can be saved on a CF 
card.
For more information, refer to page 18-31.

 Store WAV Files to CF Card This is possible with the V8i only.
Sound files can be saved on a CF card.
For more information, refer to page 18-33.

 Store 3D Parts in CF Card Bitmap files of 3D parts can be saved on a CF card.  For more 
information, refer to page 18-36.

 Store Windows Font in CF 
Card

Windows font data can be saved on a CF card.  For more 
information, refer to page 18-39.
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* These are recognized as uppercase characters.
If you input lowercase characters on the editor screen, they are converted into uppercase 
characters when you click [OK], and are recognized as uppercase characters on MONITOUCH.

Contents of CF Card

If you insert an empty CF card (FAT or FAT32 format type) into MONITOUCH and put it in the RUN 
(communication) mode, or if you switch the Main Menu screen to the Card Transfer screen in the 
STOP mode, the following folders are automatically created in the CF card.
(Example: When inserting a CF card into the V8 that contains the screen data file of the access folder 
[DAT0000])

 Store the PLC ladder 
program into CF card

This option is associated with the use of the ladder monitor.  For 
more information, refer to the V8 Series Ladder Monitor 
Specifications.

 Format Buffering Area 
Automatically

This is valid when storing sampling data (alarm, trend) on a CF 
card.
For more information, refer to “Appendix 1  Buffering Area.”

Use Password When 
Transferring Screen to CF 
Card from Display
(Password: Max. 6 
one-byte alphanumeric 
characters)

A password can be used when transferring data from 
MONITOUCH → CF card on the Main Menu screen.
This setting item is valid if no password is set.

BITMAP

SRAM

CARD

DSP

FONT

HDCOPY

JPEG

LADDER
MEMO

RECIPE
OPELOG

SAMPLE

SCRN

SNAP

WAV

WEBSERV

DAT0000

MSG

CF card
(Access folder)
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Folder Configuration

The following table shows each folder name, files in the folder, and the contents:

*1 Only when using on a Web server.
*2 Only for the files created on the V8 series.
*3 Refer to the Macro Reference Manual.
*4 Refer to the V8 Series Ladder Monitor Specifications.
*5 Refer to the V8 Series Reference Additional Functions.

Folder Name
(Fixed) Contents File Name Data Direction Refer to:

BITMAP Pattern (Bitmap) data BMPxxxx.BIN V8 ← CF page 18-22

CARD Recipe data using the V6 compatible 
memory manager function

MCMHEAD.BIN
MCMxxxx.BIN

V8 ← CF
V8 → CF

page 18-42

DSP Screen data DSP0000.BIN V8 ← CF
V8 → CF

page 18-15

FONT Gothic fonts or multi-language fonts xxxxxx.FTD V8 ← CF page A3-1

HDCOPY Screen images
(JPEG or BIN selectable for 128-color 
display)

HDxxxx.JPG
HDxxxx.BIN

V8 → CF
  (V8 ← CF) *1

*3

JPEG JPEG files (not supported by some models) xxxxx.JPG
JPxxxxx.JPG

V8 ← CF page 18-43

LADDER Ladder data for the ladder monitor *4 V8 ← CF *4

MEMO Memo pad data MEMxxxx.BIN V8 → CF
(V8 ← CF) *2

page 18-47

MSG Message file MSGxxyyy.BIN
MSGxxyyy.TXT

V8 ← CF page 18-24

OPELOG Operation log file OPELOG_hhmmss.BIN V8 ← CF
V8 → CF

*5

RECIPE Recipe data RECxxxx.CSV
xxxxxxxx.CSV

V8 ← CF
V8 → CF

*3

SAMPLE Historical data by data logging and of alarms SMPxxxx.BIN
SMPxxxx.CSV

V8 → CF
(V8 ← CF) *2

page A1-1

Title file SMHxxxx.CSV V8 ← CF page 18-45

SCRN Header file SCHEADER.BIN V8 ← CF -

Screen file
Component parts (macro block, sampling 
message)

SCxxxx.BIN
MCRxxxx.BIN
MSGxxxx.BIN

page 18-28

3D parts file 3Dxxxx.BIN page 18-36

Windows font file
(Graphic/message)

WFSxxxx.BIN
WFMxxxx.BIN

page 18-39

SNAP Video snapshot images VDxxxxx.JPG V8 → CF
(V8 ← CF)*1 *2

page 14-23

SRAM Backup data of SRAM data SRM0000.BIN V8 ← CF
V8 → CF

page A2-1

WAV WAV files for sound output WAxxxx.WAV V8 ← CF page 18-33

WEBSERV Files accessible from a Web browser *.SHT, *.HTML, *.TXT, etc V8 ← CF page 19-13

CF card

DAT0000  (Access folder: any given name)
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Folder Name
(Fixed)

Contents File Name Data 
Direction

Refer to:

DSP When setting the DIP switch on the V8 series and 
inserting a CF card, it automatically reads the screen 
data in this folder.

DSPDEF.BIN V8 ← CF page 18-19

CF card

DSPDEF (Folder for auto uploading screen data: fixed folder name)

(Other folders are the same as the “access folder.”)
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18.3 Function Descriptions
List of Functions

For information on applicable functions and their detailed explanations, refer to the chart below.

Function Refer to:

Saving Multiple Screen Data page 18-15

Auto Uploading of Screen Data page 18-19

Reduction in screen 
data size

Storing pattern (bitmap) data page 18-22

Storing message data page 18-24

Storing screen BIN data page 18-28

Storing Gothic fonts page 18-31

Storing sound (WAV) files page 18-33

Storing 3D parts page 18-36

Storing Windows fonts page 18-39

Transferring Recipe Data page 13-1 or
Macro Reference Manual

Transferring Recipe Data by Memory Manager Function page 18-42

Storing JPEG Data page 18-43

Multi-language Display Selection page A3-1

Web server page 19-13

Operation logs V8 Series Reference 
Additional Functions

Ladder monitor function V8 Series Ladder Monitor 
Specifications

Saving sampling data page A1-1

Saving Video Image page 14-23

Saving Screen Image Macro Reference Manual

Memo Pad Data Backup page 18-47

SRAM Data Backup page A2-1

2-drive Connection page 18-48
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Saving Screen Data

You can exchange screen data when needed by saving multiple screen data on a CF card.
* This section describes how to read/write data between your computer  ↔  a CF card.  For 

the procedure of reading and writing between a CF card  ↔  V8 series, refer to “Chapter 6 
MONITOUCH Operations” in the Hardware Specifications.

Writing from Computer → CF Card

Step 1 Start V-SFT.

Step 2 Select [File] → [CF Card Manager].
The following dialog is displayed:

Step 3 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager *1 
will start.
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Step 4 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.

[  Write Data Being Edited]
When this box is checked, the screen data currently being edited is written at the 
same time.
This setting is not valid when the screen data is not opened.

[Path of File to Be Converted]
Click [Open] and select the file you write to the CF card.  The file extension is 
“*.V8”.

[BIN File Comment]
Enter texts when annotating on the screen data file (DSP0000.BIN: BIN file) written 
to the CF card.

[  Use Default Loading]
Check this box when you perform “Auto Uploading of Screen Data” (Refer to page 
18-19.

[  Do Not Overwrite Port No. Table/FROM Backup Area]
This is valid when “station number table” *2 or “FROM Backup area” *3 is used.
Check this box when you do not want to change existing values in the station 
number table or those in the FROM area during screen data transfer from a CF 
card.

Step 5 When completing the setting, click [OK].
The screen data file is saved as “DSP0000.BIN” (BIN file) in the [DSP] folder of the 
access folder on the CF card.
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*1 What is the CF Card Manager?
The CF Card Manager is an application that allows you to write the data used in the V8 series to 
a CF card or to convert the data into each file format after importing the data from the CF card.
For more information, refer to page 18-49.

*2 What is “station number table”?
Station numbers of target devices can be set as desired when using the following PLC models or 
temperature control network models.
• PLC: Mitsubishi QnH (Q) series (Ethernet) (1:n connection only)
• PLC: Mitsubishi QnA series (Ethernet) (1:n connection only)
• PLC: OMRON SYSMAC CS1/CJ1 (Ethernet Auto) (1:n connection only)
• PLC: OMRON SYSMAC CS1/CJ1 DNA (Ethernet) (1:n connection only)
• Temperature controller: Fuji Electric F-MPC04P (loader)
• Temperature controller: Fuji Electric F-MPC04S (UM03)

*3 What is “FROM backup area”?
The FROM backup area is an area in MONITOUCH where the backup copy of data in the PLC 
memory or internal memory can be stored.
To retain the data, use the macro commands “FROM_RD” and “FROM_WR”.
For more information on macros, refer to the Macro Reference Manual provided separately.

“DSP” Folder

The “DSP” folder contains the following file:

Step 6 When writing multiple screen data to a CF card, folders are configured as follows:

DSP0000.BIN Screen data file
(Screen data, system program, fonts, I/F driver, expansion programs)

BITMAP
CARD
DSP

FONT
HDCOPY

DAT0000

. . . . .

BITMAP
CARD
DSP

FONT
HDCOPY

FILE01

. . . . 

DSP0000.BIN

DSP0000.BIN

(Access folder)
CF card

Screen data file

(Access folder)
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Reading from CF Card → Computer

Step 1 Start V-SFT.

Step 2 Select [File] → [CF Card Manager].
The dialog for specifying the CF card drive is displayed.

Step 3 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager 
will start.

Step 4 Check that “DSP0000.BIN” (BIN file) exists in the “DSP” folder in the access folder, and 
select the file.

Step 5 Select [File] → [Put BIN File Back].  Alternatively, right-click → [Put BIN File Back].

Step 6 The following dialog is displayed:
Specify the location and the file name and click [Save].

or
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Auto Uploading of Screen Data

By simply inserting a CF card into the V8 series, the screen data file in the CF card is automatically 
transferred to the V8 series.  You can update screen data easily without interrupting the operator.

Writing from Computer → CF Card

Step 1 Start V-SFT.

Step 2 Select [File] → [CF Card Manager].
The following dialog is displayed:

Step 3 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager * 
will start.



18.3 Function Descriptions

18-20

* What is the CF Card Manager?
The CF Card Manager is an application that allows you to write the data used in the V8 series to a 
CF card or to convert the data into each file format after importing the data from the CF card.
For more information, refer to page 18-52.

Step 4 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.

In the [File to be converted] field, click [Refer] and select the file (extension “*.V8”) to be 
uploaded automatically.

Step 5 Be sure to check [  Use Default Loading].

When [  Use Default Loading] is checked, the following options become active.

• [  Upload System Program Automatically]
Check this box when uploading system program files together with screen data.

• [  Run after System Program Transfer]
This is valid when the above option is checked.  Always check this box.

Step 6 When completing the setting, click [OK].
The screen data file is saved as “DSP0000.BIN” (BIN file) in the “DSP” folder under the 
“DSPDEF” folder on the CF card.

BITMAP

CARD

DSP

FONT

DSPDEF

DSPDEF.BIN

CF card

(Data file for auto uploading)

(Fixed folder name = Exclusive for auto uploading)
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“DSPDEF” Folder

The “DSPDEF” folder contains the following file:

Operation on the V8 Series

After storing data on the CF card, import the data into the V8 series following the steps below.

Notes on write operation
• When using the screen data “DSPDEF” for auto uploading, you can store only one kind of data per 

CF card.
• If you remove the CF card after auto uploading and turn the power on again, the message “Insert 

CF Card in V8.” is displayed and MONITOUCH does not start correctly.
Insert the CF card or set DIPSW1 (DIPSW4 on the V806) to OFF.  Then turn the power off and 
back on.

• Once auto uploading has been performed, all screen data that was written to the V8 (including I/F 
drivers, fonts, etc.), is changed into screen data for auto uploading.
Note that even if you remove the CF card and set DIPSW1 to OFF again, it is not possible to 
restore the same state as before uploading.

DSPDEF.BIN Screen data file for auto uploading
(Screen data, system program, fonts, I/F driver, expansion programs)

Step 1 Turn off the V8.

Step 2 Set DIPSW1 (DIPSW4 on the V806) on MONITOUCH to ON.

Step 3 Insert the CF card into the V8 series.

Step 4 Turn on the V8 series.
The message “Loading from CF Card.” is displayed on MONITOUCH for awhile.  Then 
the screen data stored on the CF card is written.
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Storing Pattern (Bitmap) File

When using many patterns for the screen data file, the screen data might require a large amount of 
memory.  If you use a CF card and save the pattern data to the CF card, you can refer to patterns from 
the CF card and display them.  Thus, the screen data size can be reduced.

Importing to CF Card

Step 1 Make the following setting on the screen data file beforehand.
Select [System Setting] → [CF Card Setting].
The [CF Card] dialog is displayed.

Step 2 Check the box for [  Range of Patterns to be Saved to CF Card] and set the range of 
patterns to be stored.

When the setting has been made, click [OK] and save the screen data file.

Step 3 Select [File] → [CF Card Manager].
The dialog for specifying the CF card drive is displayed.
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“BITMAP” Folder

The “BITMAP” folder contains the following file:

Operation on the V8 Series

Insert the CF card, where the pattern data is stored according to the procedure mentioned above, into 
the V8 series.  When displaying the screen, the stored pattern data appears.

Step 4 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager 
will start.

Step 5 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.

Step 6 If the data is being edited, check the box for [  Write Data Being Edited].
If not, uncheck the box for [  Write Data Being Edited].  Click the [Open] button for 
[Path of File to Be Converted] and select the “*.V8” file that is to be written to the CF 
card.

Step 7 When completing the setting, click [OK].
“BMPxxxx.BIN” file is saved in the “BITMAP” folder under the access folder.

BMPxxxx.BIN Pattern file xxxx = pattern No. 0 to 1023

BITMAP

SRAM

CARD

DSP

FONT

HDCOPY

JPEG

MSG

RECIPE

SAMPLE

SNAP

DAT0000

BMP0000.BIN
BMP0001.BIN

MEMO

(Access folder)

CF card
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Storing Message Data

When using many messages for the screen data file, the screen data might require a large amount of 
memory.  If you save the message data to the CF card, you can refer to messages from the CF card 
and display them on screen.  In this way, the screen data size can be reduced.
Message files can be stored in either BIN or TXT file format.
Saving messages in TXT file format reduces the size of the screen data.  Using the format also 
enables changes to messages in a simple way, even without the editor.

Importing to the CF Card
In TXT file format

Step 1 Set up the following setting on the screen data file beforehand.
Select [System Setting] → [CF Card Setting].
The [CF Card] dialog is displayed.

Step 2 Check the box for [  Range of Messages to be Saved to CF Card] and set the range of 
messages to be stored.

When the setting has been made, click [OK] and save the screen data file.

Step 3 Create files in TXT file format.*1

File name: MSGxxyyy.TXT  

xx = Language No.: 0 - 7
yyy = Message group No.: 0 - 127*2
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*1 A TXT file can be created in different manners.  One is the creation of a TXT file from scratch 
under the designated file name.  The other is utilizing the MSGxxyyy.BIN file that is created when 
the screen data is written to the CF card.  The file in TXT format is obtained by conversion from 
the MSGxxyyy.BIN file.
For how to convert a file from BIN format to TXT format, refer to “Converting File (BIN File) on CF 
Card” (page 18-52).

*2 A TXT file must be compliant with the message group number specified in the [CF Card] dialog 
(select [System Setting] → [CF Card Setting]).
Any TXT file provided with a wrong message group number will not be recognized.

Step 4 “MSGxxxx.TXT” files are saved in the “MSG” folder under the access folder.

BITMAP
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CARD

DSP

FONT

HDCOPY

JPEG

MSG
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SNAP
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In BIN file format

Step 1 Set up the following settings on the screen data file beforehand.
Click [System Setting] → [CF Card Setting].
The [CF Card] dialog is displayed.

Step 2 Check the box for [  Range of Messages to be Saved to CF Card] and set the range of 
messages to be stored.

When the setting has been made, click [OK] and save the screen data file.

Step 3 Click [File] → [CF Card Manager].
The dialog for specifying the CF card drive is displayed.

Step 4 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager 
will start.

Step 5 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.
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“MSG” Folder

The “MSG” folder contains the following files:

*1 This file is not a file to be automatically created.  Save it to the CF card by manual operation.

Operation on the V8 Series
Insert the CF card that contains the message data as described above into the V8 series.  When 
displaying the screen, the stored message data appears.

When both BIN files “MSGxxyyy.BIN” and TXT files “MSGxxyyy.TXT” coexist in the “MSG” folder on 
the CF card, reference to TXT files is assigned higher priority.

Step 6 If the data is being edited, check the box for [  Write Data Being Edited].
If not, uncheck the box for [  Write Data Being Edited].  Click the [Open] button for 
[Path of File to Be Converted] and select the “*.V8” file that is to be written to the CF 
card.

Step 7 When completing the setting, click [OK].
“MSGxxxx.BIN” files are saved in the “MSG” folder under the access folder.

MSGxxyyy.TXT*1 Message xx = Language No. 0 to 15
yyy = Message group No. 0 - 127MSGxxyyy.BIN
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Storing Screen BIN Data

For large-volume screen data storing many screens, you may save the screen BIN data to the CF 
card.
A maximum of 4,000 screens can be registered in the range No. 0 to No. 9999.

Importing to the CF Card

Step 1 Set up the following settings on the screen data file beforehand.
Click [System Setting] → [CF Card Setting].
The [CF Card] dialog is displayed.

Step 2 Check the box for [  Range of Screen to be Saved to CF Card].
Specify the start screen number and the end screen number to be saved to a CF card.

When the setting has been made, click [OK] and save the screen data file.

Step 3 Click [File] → [CF Card Manager].
The dialog for specifying the CF card drive is displayed.

Step 4 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager 
will start.
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“SCRN” Folder

The “SCRN” folder contains the following files:

Step 5 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.

Step 6 If the screen data is being edited, check the box for [  Write Data Being Edited].
If the screen data is not being edited, uncheck the box for [  Write Data Being Edited].  
Click the [Open] button for [Path of File to Be Converted] and select the “*.V8” file that is 
to be written to the CF card.

Step 7 When completing the setting, click [OK].
The files shown are saved in the “SCRN” folder under the access folder on the CF card.

SCHEADER.BIN Header file

SCxxxx.BIN Screen file xxxx = Screen No. 0 to 9999

MCRxxxx.BIN Macro block file in a component part xxxx = Macro block No. 0 to 1023

MSGxxxx.BIN Sampling message file in a 
component part xxxx = Buffer No. 0 - 11
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DSP

FONT

HDCOPY
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Operation on the V8 Series

Insert the CF card with screen files saved as described above into the V8 unit.  At the time of opening 
a screen on MONITOUCH, the CF card will automatically be referred to for bringing up the screen.

* If screen BIN data is not stored correctly on the CF card or if the CF card is not inserted into the 
MONITOUCH, the MONITOUCH recognizes that there is no screen BIN data present.
If you press the [Function: Screen] switch, an error beep sounds and the switch operation is not 
accepted.  If a screen number is specified in the read area from the PLC, the screen will not be 
displayed.  (If this occurs immediately at power-on, the error message “Screen No. Error” will be 
displayed.)

* The screen BIN data stored on a CF card may take longer to appear on the MONITOUCH than the 
one stored in the MONITOUCH memory dose.

Notes

• The screen BIN data size that can be stored on a CF card is 512 KB maximum per file.
The size of each screen BIN data can be viewed by selecting [Tool] → [List of Memory Use].
However, the sizes of the screen BIN data saved on a CF card according to the [CF Card] dialog 
(select [System Setting] → [CF Card Setting]) are not displayed in this list.
Check the data size before setting the [CF Card] dialog.

• For the restoration of the screen BIN file in the “SCRN” folder to the original data file “.V8”, the file 
“DSP0000.BIN” in the “DSP” folder is required.
However, if data information of “DSP0000.BIN” in the “DSP” folder does not match that of 
“SCHEADER.BIN” in the “SCRN” folder, combining the files from these folders does not take 
place, and thus the screen data is created while the screen BIN data in the “SCRN” folder is 
missing.
For more information on this restoring procedure, refer to “Reading from CF Card → Computer” 
page 18-18.

BITMAP

SRAM

CARD

DSP

FONT

HDCOPY

SAMPLE

SNAP

DAT0000

SC0001.BIN
SC0002.BIN

SCRN

SCHEADER.BIN

DSP0000.BIN xxxxxxx.V8

The “DSP0000.BIN” file in the “DSP” folder 
and the files in the “SCRN” folder are 
combined into the original data file.
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Storing Gothic Fonts

When Gothic fonts * are used, the screen data size will become larger.  Within the Gothic fonts, the 
“manual font” type data occupying space can be stored on a CF card.  Using this function, the screen 
data size can be reduced.

* Gothic fonts
These are font types that can be displayed on the V8 series as beautifully as Windows TrueType 
fonts (Arial, Times, etc.).  Since they must be displayed beautifully, they require a greater 
capacity than the English/Western Europe fonts.
For more information, refer to the Operation Manual.

Importing to the CF Card

Assuming that Gothic fonts are used and that the manual font setting has been made, use the 
following procedure to import data to the CF card.

* The font size that can be stored on a CF card is 6 MB maximum 
(V810C/V808C/V806/V808CH: 2 MB maximum). 

Step 1 Make the following setting on the screen data file beforehand.
Select [System Setting] → [CF Card Setting].
The [CF Card] dialog is displayed.

Step 2 Check the box for [  Store Manual Font Setting to CF Card].

When the setting has been made, click [OK] and save the screen data file.
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“FONT” Folder

The “FONT” folder contains the following file:

Operation on the V8 Series

Insert the CF card that contains the manual fonts data of the V8 series.  When the screen with manual 
fonts is displayed, MONITOUCH automatically refers to the fonts on the CF card.

Step 3 Select [File] → [CF Card Manager].
The dialog for specifying the CF card drive is displayed.

Step 4 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager 
will start.

Step 5 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.

Step 6 If the data is being edited, check the box for [  Write Data Being Edited].
If not, uncheck the box for [  Write Data Being Edited].  Click the [Open] button for 
[Path of File to Be Converted] and select the “*.V8” file that is to be written to the CF 
card.

Step 7 When completing the setting, click [OK].
Font files are saved in the “FONT” folder under the access folder.

xxxxxx.FTD Gothic fonts or multi-language font
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Storing Sound (WAV) Files

In the V8i, you can output sound by importing a sound (WAV) file into the screen data.
When importing a WAV file into the screen data, the screen data capacity increases by the amount of 
the WAV file.  If you import the WAV file into a CF card, you can reduce the amount of screen data 
capacity required.

WAV File Name

The following is the name format of WAV files that can be read by the V8i:
WAxxxx.WAV (xxxx: 0 to 1023)
xxxxxxxx.WAV

Importing to CF Card

Step 1 *1 Store the WAV file to be used in \V-SFT V5\WAV beforehand.

Step 2 Make the following setting on the screen data file beforehand.
Select [System Setting] → [CF Card Setting].
The [CF Card] dialog is displayed.
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WAV

WEBSERV
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. . . . .
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WA0000.WAV
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Step 3 Check the box for [  Store WAV File in CF Card].

When the setting has been made, click [OK] and save the screen data file.

Step 4 Select [File] → [CF Card Manager].
The dialog for specifying the CF card drive is displayed.

Step 5 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager 
will start.

Step 6 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.

Step 7 If the data is being edited, check the box for [  Write Data Being Edited].
If not, uncheck the box for [  Write Data Being Edited].  Click the [Open] button for 
[Path of File to Be Converted] and select the “*.V8” file that is to be written to the CF 
card.
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*1 In addition to the procedure described above, it is possible to copy the WAV file into the “WAV” 
folder on the CF card in Explorer.

Operation on the V8 Series
Insert the CF card that contains sound files as described above into the V8 series.  When playing 
these WAV files in the RUN mode, sound is output.

Step 8 When completing the setting, click [OK].
Sound files re saved in the “WAV” folder under the access folder.
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Storing 3D Parts

Bitmap files of 3D parts can be saved to a CF card.

Importing to the CF Card

Step 1 Set up the following settings on the screen data file beforehand.
Click [System Setting] → [CF Card Setting].
The [CF Card] dialog is displayed.

Step 2 Check the box for [  Store 3D Parts in CF Card].

When the setting has been made, click [OK] and save the screen data file.

Step 3 Click [File] → [CF Card Manager].
The dialog for specifying the CF card drive is displayed.

Step 4 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager 
will start.



18.3 Function Descriptions

18-37

18

Step 5 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.

Step 6 If the data is being edited, check the box for [  Write Data Being Edited].
If not, uncheck the box for [  Write Data Being Edited].  Click the [Open] button for 
[Path of File to Be Converted] and select the “*.V8” file that is to be written to the CF 
card.

Step 7 When completing the setting, click [OK].
The 3D parts files are saved to the “SCRN” folder under the access folder on the CF 
card.
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“SCRN” Folder

The “SCRN” folder contains the following files:

Operation on the V8 Series

Insert the CF card with 3D parts that are saved as described above into MONITOUCH.
At the time of opening a screen on MONITOUCH, the CF card will automatically be referred to for 
showing the 3D parts.

* If 3D parts are not stored correctly on the CF card or if the CF card is not inserted into the 
MONITOUCH, the 3D parts will not be displayed on the MONITOUCH.

* The 3D parts stored on a CF card may take longer to appear on the MONITOUCH than those 
stored in the MONITOUCH memory do.

SCHEADER.BIN Header file

3Dxxxx.BIN Bitmap file for 3D part xxxx = Bitmap No. 1 to 1023
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Storing Windows Fonts

The data of Windows fonts can be saved to the CF card.

Importing to the CF Card

Step 1 Set up the following settings on the screen data file beforehand.
Click [System Setting] → [CF Card Setting].
The [CF Card] dialog is displayed.

Step 2 Check the box for [  Store Windows Font in CF Card].

When the setting has been made, click [OK] and save the screen data file.

Step 3 Click [File] → [CF Card Manager].
The dialog for specifying the CF card drive is displayed.

Step 4 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager 
will start.
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Step 5 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.

Step 6 If the data is being edited, check the box for [   Write Data Being Edited].
If not, uncheck the box for [  Write Data Being Edited].  Click the [Open] button for 
[Path of File to Be Converted] and select the “*.V8” file that is to be written to the CF 
card.

Step 7 When completing the setting, click [OK].
The Windows font files are saved to the “SCRN” folder under the access folder on the 
CF card.
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“SCRN” Folder

The “SCRN” folder contains the following files:

Operation on the V8 Series

Insert the CF card with Windows fonts that are saved as described above into the MONITOUCH.
At the time of opening a screen or switching messages on MONITOUCH, the CF card will 
automatically be referred to for showing data in Windows fonts.

* If Windows fonts are not stored correctly on the CF card or if the CF card is not inserted into the 
MONITOUCH, the characters in Windows fonts will not be displayed on the MONITOUCH.

* The Windows fonts stored on a CF card may take longer to appear on the MONITOUCH than 
those stored in the MONITOUCH memory do.

SCHEADER.BIN Header file

WFSxxxx.BIN Windows font (graphics) file xxxx = Data No. 0 to 4095

WFMxxxx.BIN Windows font (message) file xxxx = Data No. 0 to 4095
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Transferring Recipe Data by Memory Manager 
Function

This is a recipe function using the V6 compatible memory manager function.

Memory Manager Function

For more information on the memory card setting or memory card mode, refer to “15.2  Memory Card 
Mode.”

Operation on the V8 Series

You can transfer data when you have formatted a CF card by pressing the [Function: Card Format] 
switch.

Storage target on CF card
The memory manager data on the CF card is stored in the following folder:

Storage target: \CARD
File name: MCMHEAD.BIN (BIN file format)

MCMxxxx.bin (xxxx: Memory card setting No. 0 - 15)

Comparing Data between Computer ←→ V8 and Editing Data

This section describes the procedure for checking a data file, which MONITOUCH has read or written, 
on a computer, as well as the procedure required before converting data edited on a computer into the 
format which MONITOUCH can import.

For how to convert from “MCMHEAD.BIN” → “MCMHEAD.MCD”, or from “MCMHEAD.MCD” to 
“Mcmhead.bin” → “MCMHEAD.BIN”, or “MCMxxxx.BIN”, refer to page 18-52.
For more information on Memory Card Editor, refer to the M-CARD SFT Instruction Manual.

Convert a BIN file to a MCD file using the CF Card ManageV-SFT

Convert the “MCMHEAD.BIN” file to a “*.MCD” file.

The “MCMHEAD.BIN” file and the “MCMxxxx.BIN” file are combined and 
converted to the “MCMHEAD.MCD” file

Open a MCD file.

Open the “MCMHEAD.MCD” file.
You can check the data file.

Edit an MCD file → save.

You can convert the MCD file to the CSV file or read the CSV file.
You can also overwrite the data using the Memory Card Editor.

Write an MCD file using the CF Card Manager → convert the MCD file into BIN format.

Divide the “MCMHEAD.MCD” file into the “MCMHEAD.BIN” file and the 
“MCMxxxx.BIN” file and convert them.

Set the CF card into MONITOUCH.

Read the data file.

M-CARD SFT

M-CARD SFT

V-SFT

V8 series
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Storing JPEG Data

You can display JPEG data on the V8 series screen.
Be sure to store the JPEG data to be displayed on a CF card.

JPEG File Name

The following is the name of a JPEG file that can be read on the V8:
Number designation:  JPxxxxx.JPG (xxxxx: 0 to 32767)
Fine name designation:  xxxxxxxx.JPG (xxxxxxxx: 64 one-byte alphanumeric uppercase 

characters)

Importing to CF Card

Step 1 *1 Store the JPEG file to be used in \V-SFT V5\JPEG beforehand.

Step 2 Select [File] → [CF Card Manager].
The dialog for specifying the CF card drive is displayed.

Step 3 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager 
will start.

Step 4 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.

Step 5 If the data is being edited, check the box for [  Write Data Being Edited].
If not, uncheck the box for [  Write Data Being Edited].  Click the [Open] button for 
[Path of File to Be Converted] and select the “*.V8” file that is to be written to the CF 
card.

DATA
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JP00000.JPG
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*1 In addition to the procedure described above, it is possible to copy the JPEG file into the “JPEG” 
folder on Explorer if it has a distinguishable file name.

Operation on the V8 Series

Insert the CF card, where the JPEG file is stored according to the procedure mentioned above, into the 
V8 series.  The JPEG file on the CF card is displayed in the RUN state.

Step 6 When completing the setting, click [OK].
“JPxxxxx.JPG” file is saved in the “JPEG” folder under the access folder.
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Storing Sampling Data (with Titles Added)

When sampling data in the V8 series is saved in a CSV-format file to a CF card, the sampling data in 
the CSV file shows only the buffering area number in the header line.  The titles of the sampling data 
items do not appear.
However, when you create a CSV file for titles and store it on the CF card beforehand, sampling data 
converted to CSV format shows titles in the header line.

Target Item

• Trend sampling
• Data sampling
• Alarm tracking
• Alarm logging

CSV File Name

A CSV file for titles is named as:
 SMHxxxx.CSV (xxxx= 0000 - 0011: Burring area number)

No titles

With titles

Example: Output of sampling data in buffering area 2 to a CSV file

Buffering 
area number

The titles appear 
in place of the 
buffering area 
number.
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Importing to the CF Card

Operation on the V8 Series

Insert the CF card with the CSV file saved as described above into the V8 unit.
When sampling data is output from MONITOUCH in CSV format to the CF card, the titles automatically 
appear in the header line of the sampling data.
Example: File “CSV0002.CSV”

Step 1 Create a CSV file for titles.
Example: File “SMH0002.CSV”

* There is no limitation to the number of rows and columns for titles.
A CSV file for titles must be within 239 KB in size.

Step 2 A file “SMHxxxx.JPG” is saved in the “SAMPLE” folder under the access folder.
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* Enter the buffering area number, to which 
additional titles are to be set.  If the buffering 
area number specified in the file name does 
not exist, the file has no effect.
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Memo Pad Data Backup

When using the memo pad function, you can save memo pad data even when the V8 series is turned 
off.

Operation on the V8 Series

When inserting the CF card and using the memo pad in the RUN state, the memo pad data is 
automatically stored on the CF card.

* When selecting [SRAM/Clock Setting] from the [System Setting] menu and checking 
[ Store Area for Memo Pad], the memo pad data is stored in SRAM or a SRAM cassette 
even when inserting the CF card into the V8 series.

When to save:
The following explains when memo pad data should be written to the CF card:

• When switching the memo pad display using the [Function: + Block], [Function: − Block], or 
[Function: Block Call] switch

• When switching a screen
• When switching from RUN → STOP (Main Menu screen)

Storage Target on CF Card

The memo pad data is stored in the following folder on the CF card:
Storage target:  \MEMO
File name:  MEMxxxx.BIN (xxxx = 0 to 7: Memo pad page number)

* You can convert the saved memo pad data (MEMxxxx.BIN) to a Bitmap file using the CF Card 
Manager.
For more information on the conversion, refer to page 18-52.
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2-drive Connection

The card interface and the USB-A port (master port) can be recognized at the same time.
The card interface is used as a storage target while data can be copied to a CF card connected at the 
USB-A port for data backup purpose.

Data Backup

Data on the CF card at the card interface can be copied into the CF card connected at the USB-A port.
It is also possible to copy data on the CF card connected at the USB-A port into the CF card at the card 
interface.

Data backup procedure
Use the macro command “COPY_FILE”.
For more information, refer to the Macro Reference Manual.

Selecting the Drive

It is possible to switch the CF card drive to be accessed using a macro command.

Drive selection procedure
Use the macro command “SET_DRIVE”.
For more information, refer to the Macro Reference Manual.

Limitations
This drive selection procedure applies only to CF card access that is made using a recipe macro 
command.
The drive used as a storage target, such as for sampling, will not be changed.
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18.4 CF Card Manager
The CF Card Manager is an application that allows you to write the data used in the V8 series to a CF 
card or to convert the data into each file format after importing the data from the CF card.

Start and Quit

Start

Quit

Click the icon on the top left corner of the [CF Card Manger] window and select [Close].
Or click the [x] button on the top right corner of the window.

Step 1 Start V-SFT.

Step 2 Select [File] → [CF Card Manager].
The following dialog is displayed:

Step 3 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager will 
start.
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Writing to a CF Card

When you perform each CF card function, you need to store the data on the CF card in advance.  The 
CF card manager is required to write data to a CF card.  Follow the steps below.

Step 1 Select [Write to CF Card] from the [File] menu.
The [Write to CF Card] dialog is displayed.

[  Write Data Being Edited]
When this box is checked, the screen data currently being edited is written at the 
same time.
This setting is not valid when the screen data is not opened.

[Path of File to Be Converted]
This is valid when the above option is not checked.
Click [Open] and select the file you write to the CF card.  (Applicable file 
extensions: “*.V8”, “*.MCD”, “*.RAM”)

[BIN File Comment]
Enter texts when annotating on the screen data file (DSP0000.BIN: BIN file) written 
to the CF card.

[  Use Default Loading]
Check this box when you perform “Auto Uploading of Screen Data” (Refer to page 
18-19).

[  Do Not Overwrite Port No. Table/FROM Backup Area]
This is valid when “station number table” *2 or “FROM Backup area” *2 is used.
Check this box when you do not want to change the existing values in the station 
number table or those in the FROM area during screen data transfer from a CF 
card.

Step 2 When completing the setting, click [OK].  The screen data file is saved as 
“DSP0000.BIN” (BIN file) in the “DSP” folder under the access folder on the CF card.
At the same time, the specific extension is written to each folder on the CF card 
according to the screen data file setting.
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*1 What is “station number table”?
Station numbers of target devices can be set as desired when using the following PLC models or 
temperature control network models.
• PLC: Mitsubishi QnH (Q) series (Ethernet) (1:n connection only)
• PLC: Mitsubishi QnA series (Ethernet) (1:n connection only)
• PLC: OMRON SYSMAC CS1/CJ1 (Ethernet Auto) (1:n connection only)
• PLC: OMRON SYSMAC CS1/CJ1 DNA (Ethernet) (1:n connection only)
• Temperature controller: Fuji Electric F-MPC04P (loader)
• Temperature controller: Fuji Electric F-MPC04S (UM03)

*2 What is “FROM backup area”?
The FROM backup area is an area in MONITOUCH where the backup copy of the data in the 
PLC memory or internal memory can be stored.
To retain data, use the macro commands “FROM_RD” and “FROM_WR”.
For more information on macros, refer to the Macro Reference Manual.



18.4 CF Card Manager

18-52

Converting File (BIN File) on CF Card

Import the BIN file that is written to the CF card from the V8 series and convert it to the recognizable 
file format.
The following are convertible BIN files.

Follow the steps below.

File Storage Target Folder Extension After Conversion
BMPxxxx.BIN BITMAP .BMP

MCMHEAD.BIN CARD .MCD
DSP0000.BIN DSP .V8
HDxxxx.BIN HDCOPY .BMP

MEMxxxx.BIN MEMO .BMP
MSGxxyyy.BIN MSG .TXT

Step 1 Select the file to be converted.

Step 2 Select File[] → [Put BIN File Back].  Alternatively, right-click → [Put BIN File Back].

Step 3 The following dialog is displayed:
Specify the folder to save in and the file name and click [Save].

Step 4 The converted file is created in the specified folder.

or
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Property of a BIN File

You can check the information about each BIN file before conversion.
• BMPxxxx.BIN and MEMxxxx.BIN

The Bitmap image is displayed.

• DSP0000.BIN
You can check the file type or version in the [Detail] tab window.

• Other BIN files
In the [General] tab window, the comment that you entered in the [File comment of BIN file] field is 
displayed.  ([File] → [Write to CF card])
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Other Function

CF Card Copy

Step 1 Select [File] → [CF Card Manager].

Step 2 Specify the CF card drive and click [OK].

Step 3 The following dialog is displayed.  Click [OK].

Step 4 The following dialog is displayed.
Remove the CF card from your computer and insert the target CF card.  Click [OK].

Step 5 The following dialog is displayed.  Click [OK].

Step 6 When copy is completed, the following dialog is displayed:
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CF Card Backup

You can back up the data on a CF card.
You can select the copy target folder.

* When copying data from a CF card to the hard disk, you can copy and paste it using Explorer.

Step 1 Select [File] → [Back-up of CF Card].

Step 2 When the [Copy Target Folder] dialog is displayed, click [Refer] and specify the copy 
target folder.

Example: When saving in the “V3_V7” folder in the D drive:

Step 3 Click [OK].  The following dialog is displayed.

Step 4 Click [OK].
The data on the CF card is copied to the copy target.
When copy is completed, the following dialog is displayed:

Step 5 Make sure that the data is copied correctly to Explorer.
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18.5 To Check CF Card Status ($s):
Information about the status and the free space of the CF card inserted into the V8 series is stored in 
the system memory ($s).  The content is shown below:

List

Description

• $s497, $s1030, $s1035
The result of access to the CF card is output.

  Address Contents Memory Type

$s497 The error status of the CF card

  ← V

$s498
The free space of the CF card (KB)

$s499

$s500 CF card removal switch status

$s780 Bitmap file status

$s781 JPEG file status

$s782 WAV file status

$s783 Font file status

$s784 HTML file status

$s1030 Drive C (card interface)
The error status of the CF card

$s1031 Drive C (card interface)
The free space of the CF card (kB)$s1032

$s1033 Drive C
CF card removal switch status

$s1035 Drive D (USB-A)
The error status of the CF card

$s1036 Drive D (USB-A)
The free space of the CF card (kB)$s1037

$s1038 Drive D (USB-A)
CF card removal switch status

$s1050 Background processing flag

$s1051 Background processing completion flag

$s1052 Background processing error flag

   Output No. Contents

 4 The card is not installed.

 5 Format error

 6 The card size is too small.

 7 The card type is different.

12 Card write error

15 Disk error (failed to open)

16 Card read error
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• $s498 to 499, $s1031 to 1032, $s1036 to 1037
The free space of the CF card (kB) is output.

• $s500, $s1033, $s1038
The status of the [Function: CF Card Removal] switch is output.

0: Switch OFF = CF card removal prohibited
1: Switch ON = CF card removal permitted

• $s780: Bitmap file (pattern data)
$s781: JPEG file
$s782: WAV file
$s783: Font file
$s784: HTML file

The status of each file is output.

• $s1050
The status of the action currently being processed is output.

• $s1051
When the processing has been completed (= when $s1050 turns OFF), this turns ON.

When the operation has been verified, the user must clear it to zero.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

0: File format matched
1: File format not matched

0: File present
1: No file present

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Sampling data backup/CSV output
0: Not processed
1: Being processed

Hard copy macro
0: Not processed
1: Being processed

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Sampling data backup/CSV output
0: Not completed
1: Completed

Hard copy macro
0: Not completed
1: Completed
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• $s1052
If an error occurs at the time when the processing has been completed (= when $s1050 turns 
OFF), this turns ON.

When the operation has been verified, the user must clear it to zero.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Sampling data backup/CSV output
0: Normal
1: Error

Hard copy macro
0: Normal
1: Error
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19 Ethernet
19.1 Before Starting

Overview

The following Ethernet functions are available with the V8 series:
To use the Ethernet functions, it is necessary to set the IP address of the V8 series.  Make the settings 
as required for the function you are going to use.

*1 For more information, refer to the V8 Series Connection Manual.
*2 Unavailable with the 128-color mode 
*3 For more information, refer to the V8 Series Reference Additional Functions.
*4 For more information, refer to the DLL Function Specifications.

Function

MONITOUCH + Option

PLC Communication Macro
EREAD
EWRITE
SEND
MES *3

HKEtn20.dll 
*4

Screen 
Data 

Transfer

Web Server
E-Mail
FTP 

Server*3
2 Ports

Network 
Camera*3

Remote 
Desktop*3

TCP/IP UDP/IP

V815iX
V812iS
V810iS
V810iT
V810iC
V808iS
V808iC

V808iCH
V806iT
V806iC

Built-in 
LAN

 *2

V806iM

V812S
V810S
V810T
V810C
V808S
V808C
V806T
V806C
V806M

CU-03-3

CU-03-2

Network Table*1 Not required Required Not 
required

Not 
required

Not 
required

Not 
required
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MONITOUCH IP Address Setting

To use the Ethernet functions, it is necessary to set the IP addresses.  The IP address can be set 
within screen data or on MONITOUCH.

* If the IP address is set within screen data as well as on MONITOUCH, the one set within screen 
data becomes valid.

Method 1: Setting within Screen Data

Set the IP addresses within the screen data.

1. Select [System Setting] → [Ethernet Communication] → [Local Port IP Address].  The [IP Address 
Setting] dialog is displayed.

2. Check [  Set IP] and make the settings.

*1 For more information on the setting items, refer to page 19-4.

Select IP Address from 
Network Table

This is valid when the IP address of the V8 has been registered in the 
network table.  An IP address can be selected from network table No. 
0 to 99.

IP address *1 Set the IP address of the V8.

Default Gateway *1 Set the default gateway.

Subnet Mask *1 Set the subnet mask.
When this box is not checked, the subnet mask is automatically 
recognized based on the extreme left byte of the IP address.
Example: When IP address is “172.16.200.185”, “255.255.0.0” is set.

When IP address is “192.168.1.185”, “255.255.255.0” is 
set.

Port No. *1 Set a port number (1024 - 65535).
(except for “8001”)

Send Timeout Specify the timeout time to be used when sending the 
EREAD/EWRITE macro command.

Retrials 0 - 255
Specify the maximum number of retrials to be attempted in the case a 
timeout occurs.

Memory Protect
Internal Memory
Memory Card Memory

Check this box when disabling data writing from a computer or 
another port.

[IP Address Setting (extended)]
Proceed to this setting for the use of 
both the built-in LAN port and the 
Ethernet unit.
For more information, refer to “Two 
Ethernet Ports” on page 19-31.
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3. Click [OK].
4. Transfer screen data to MONITOUCH.

Method 2: Setting at the Main Menu Screen on MONITOUCH

Set the IP addresses at the Main Menu screen on MONITOUCH.
When IP address setting is made within screen data, the setting within screen data becomes valid.

1. Press the [SYSTEM] button on MONITOUCH.  The MODE menu is displayed.
2. With the MODE menu displayed, press the [F1] button.  The Main Menu screen is displayed on 

MONITOUCH.
3. Press the [Main Menu] switch at the upper left corner of the screen.  The menu is displayed.
4. Press the [Ethernet] switch.  The Ethernet screen is displayed.

5. Press the [EDIT] switch and make the settings.

6. Press the [Setting Finished] switch to end the setting.  Check the IP address under [Ethernet] on 
the Main Menu screen.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM
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Terminology

IP Address

This is an address that is used for recognizing each node on the Ethernet and should be unique.
The IP address is 32-bit data which consists of the network address and the host address and can be 
classified into A to C depending on the network size.

<Notation>
A string of 32-bit data is divided into four, and each segment delimited with a period is in decimal 
notation.
Example: The IP address in class C shown below is represented as “192.128.1.50”.

11000000  10000000  00000001  00110010
<Unusable IP addresses>

• “0” is specified for one byte at the extreme left.  Example: 0.x.x.x
• “127” is specified for one byte at the extreme left (loop back address).  Example: 127.x.x.x
• “224” or more is specified for one byte at the extreme left (for multi-cast or experiment).  Example: 

224.x.x.x
• The host address consists of only “0” or “255” (broadcast address).  Example: 128.0.255.255, 

192.168.1.0

Port Number

Multiple applications are running on each node, and communications are carried out for each 
application between the nodes.  Consequently, it is necessary to have a means to identify the 
application that data should be transferred to.  The port number works as this identifier.  Each port 
number is 16-bit data (from 0 to 65535).

V8 port numbers
The following port numbers are used on the V8 unit.  When changing any port number, select a 
number which is not already used, from the range 1024 to 65535.

Port No. Setting Range Function

Location for Setting

20 Fixed FTP server

21

25 Fixed E-mailing

80 Fixed Web server

502 Fixed Modbus slave (TCP/IP)

1024 to 1025 1024 to 65534 Ladder transfer (Ethernet)

[System Setting] → [Device Connection Setting] → [Ladder 
Transfer Port]

8001 Fixed Screen data transfer*1

8020 Fixed Simulator (Ethernet)

0

1 0

1 1 0

Class A

Class B

Class C

Network address (7)

Host address (8)

Host address (24)

Network address (14) Host address (16)

Network address (14)
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PLC port number
A PLC port number is selectable from the range 256 to 65535.  It is recommended to set a greater 
number.  For more information, refer to the target PLC manual.
The above-mentioned PLC number must be specified also in the V8 screen data: [System Setting] → 
[Device Connection Setting] → [Target Settings] → [PLC Table].  

Default Gateway

A gateway and a router are used for communication between different networks.
The IP address of the gateway (router) should be set to communicate with the node(s) on other 
network.

Subnet Mask

A subnet mask is used for dividing one network address into multiple networks (subnet).
The subnet is assigned by specifying a part of the host address in the IP address as a subnet address.

<Unusable subnet masks>
• All bits are set to “0”.  0.0.0.0
• All bits are set to “1”.  255.255.255.255

8050 1024 to 65535 Remote desktop window display

[System Setting] → [Remote Desktop Table setting] →
[Local Port No. ]

10000 1024 to 65535 Ethernet macro (EREAD/EWRITE/SEND/MES)
Ethernet DLL function (HKEtn20.DLL/VCFAcs.DLL)

[System Setting] → [Ethernet Communication] → [Local Port IP 
Address]
[System Setting] → [Ethernet Communication] → [Network 
Table]

10001 1024 to 65535 8-way communication
[System Setting] → [Device Connection Setting] → 
[Communication Setting] → [Target Port No.] 

50000 to 50002 1024 to 65533 Network camera

[Network Camera Display] dialog

64000 1024 to 65535 Multi-link 2 (Ethernet)/1:n multi-link 2 (Ethernet)

[System Setting] → [Device Connection Setting] → [Multi-link2 
(Ethernet)]  

*1 For screen data transfer on Internet, specify the router port number in the [Transfer] dialog in 
the V-SFT.

Port No. Setting Range Function

Location for Setting

255. 255. 255. 0

1 0

11111111 11111111 11111111 00000000

Class B

Subnet mask

Host address (16)

Network address Subnet address

Network address (14)

Host address
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19.2 Screen Data Transfer
Overview

You can download/upload screen data through the Ethernet.
For the procedures for transferring screen data, refer to the Operation Manual.

LAN

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

MONITOUCH

V-SFT

MONITOUCH
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19.3 Communication with PLC and Other V8 Series
Overview

Communication with the Ethernet unit *1 of the PLC can be performed at a high speed of 100 Mbps *2 
or 10 Mbps.
It is also possible to carry out communication and share data with other V8 series on the same LAN.
In addition, you can also transfer data to the V8 series from your computer if you create programs 
using VB, etc. *3

*1 For PLC models compatible with Ethernet communication, refer to the V8 Series Connection 
Manual.

*2 100 Mbps ready models: V8i (with built-in LAN port), CU-03-3
*3 For more information on program creation, refer to the V Series DLL Function Specifications.

• Register the target PLC in the PLC table, and the target PC/V series in the network table.

LAN

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM
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19.4 E-Mail
Overview

E-mail is sent according to the status of the ON/OFF bit.  If a problem occurs, you will be notified of the 
fault even at a remote location.

• Applicable models
V8i (built-in LAN port)

• Environment requirements
Mail server is on the LAN.

• Item allowing you to send e-mail
Alarm logging
Time order alarming
Alarm tracking

LAN

E-mail

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Mail server

Alarm logging
Time order alarming
Alarm tracking
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Setting

This section describes the settings required for sending e-mail.

IP Address

For information on the IP address, refer to page 19-9.
The gateway setting is also required for sending e-mail.  If no gateway is set, “warning: 208” is 
displayed on the Main Menu screen when you attempt to transfer screen data.

E-Mail

[System Setting] → [Ethernet Communication] → [E-Mail]

SMTP IP Address Set the network IP address of the mail server.

Certify Type No authorization No authentication is performed.

POP before SMTP*1 Authentication is performed with the POP3 server.  
The settings below must be made.

• POP3 IP address
• Account name (within 63 one-byte characters)
• Password (within 63 one-byte characters)

SMTP Authorization*2

LOGIN
PLAIN
CRAM-MD5
DIGEST-MD5

Authentication is performed with the SMTP 
server.  The settings below must be made.

• Account name (within 63 one-byte characters)
• Password (within 63 one-byte characters)

Sender’s Mail Address Set the sender’s mail address.
It is recommended that you prepare a special account only for the V8i on 
the mail server and set its address.

Sender’s Name Set the sender’s name.  A name consisting of both one- and two-byte 
characters is not valid.
It is displayed in the “Sender” field in an incoming mail.

Subject Set the subject.
It is displayed in the “Subject” field in an incoming mail.
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*1 POP before SMTP
POP before SMTP utilizes authentication with POP3 that is performed at the time of receiving 
e-mail.  SMTP permits the sending of e-mail from the authenticated IP address for a limited time.
Since authentication is disabled after a specific time has elapsed, authentication with POP3 will 
be required again.

In the case of authentication with POP3, a password is sent in clear text.  POP before SMTP 
using APOP is also available.  With APOP, a password is sent in encrypted form.
The V8 series, however, supports POP3 only.
 

*2 SMTP Authentication
Authentication is performed with the SMTP server.  SMTP Authentication is classified into 
several authentication methods.  The V8 series supports LOGIN, PLAIN, CRAM-MD5, and 
DIGEST-MD5.
Since the SMTP server automatically performs authentication according to the available method, 
users are not requested to make configurations.
<Automatic authentication steps>
1. Compliant with DIGEST-MD5?
2. Compliant with CRAM-MD5?
3. Compliant with PLAIN?
4. Compliant with LOGIN?
5. Authentication failure

<About the authentication methods>
- PLAIN

This method sends user names/passwords in clear text (not in encrypted form).
- LOGIN

LOGIN is similar to PLAIN.  But it often sends information, as performed with POP3, in divided 
forms, such as “USER xxxxx” or “PASS xxxxxx”.  Because the standard specifications of 
LOGIN are not established, there are e-mail servers that use LOGIN in their own way.

- CRAM-MD5
With CRAM-MD5, the server sends an arbitrary character string (a challenge string) to the 
client.  The client then performs a specific computing process called MD5 (Message Digest 
V5) by using the challenge string and the password, and returns the result to the server.
The server that receives the result also performs the same process.  When both results match 
each other, the server judges that the client knows the correct password and authorizes it.

- DIGEST-MD5
DIGEST-MD5, an expanded version of CRAM-MD5, has an enhanced resistance to dictionary 
attack and brute force attack.

Receiver’s Mail 
Address

8 maximum
Register recipient’s mail addresses.
Register all mail addresses that you send to from the V8i.

Add Register a new recipient’s address.

Change Change an address that is registered.

Delete Delete an address that is registered.
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Buffering Area Setting

Set a recipient’s mail address in the buffering area.  You can set a recipient’s address for each 
sampling.
This section describes the required settings for sending e-mail.  For more information on other setting 
items, refer to “10.3  Alarm Tracking (Historical)” on page 10-33.

Receiver’s Mail Address
Set receivers’ e-mail addresses.

 Use E-Mail This setting is valid when the following three functions are used:
• Alarm Logging
• Time Order Alarming
• Alarm Tracking

Select the tab number of the buffering area setting to send e-mail and 
check this box.

Send to Select recipient e-mail addresses among the registered e-mail addresses.

(1) List of e-mail addresses registered on the [E-Mail Setting] dialog

(2) Recipient mail addresses

>> This button registers the addresses selected from (1) in (2).

OK This button ends selection of recipient.

Cancel This button cancels selection of recipient.

E-Mail Setting This button enables you to check or make the e-mail setting.

Delete This button deletes the selected e-mail addresses from the recipient’s mail 
address list.

(1)
(2)
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Message Edit

In the [Message Edit] window, register messages corresponding to error bits and select whether or not 
to send e-mail.
Select the [E-Mail] icons of the messages with which you want to send e-mail.

* If the [Message Edit] window looks different from the figure above, select [Display] → [Alarm].  For 
more information on the message editing procedure, refer to the Operation Manual.

System Memory ($s)

The information on sent e-mail messages is output to system memory ($s).

• $s1005
If MONITOUCH receives send requests continually, the number (0-16) of e-mail messages waiting 
to be sent is stored.
The V8i series can keep up to 16 e-mail messages.  Any more than 16 messages are discarded.

• $s1006
Error information on e-mail messages is stored.

Error No. Contents Solution

0 Normal -

1 E-mail address error Check the sender’s e-mail address.

6 Network not connected Check the connection to the network.

50 SMPT transmission error Check the IP address for the SMTP 
server.

E-mail icon

Send e-mail
Do not send e-mail
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19.5 Web Server
Overview

You can monitor the internal memory of the V8i series, the PLC memory connected to the V8i series, 
the temperature control memory, and the memory card memory using a Web browser on a computer 
that is attached to the LAN.

• Applicable models
V8i (built-in LAN port)

LAN

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

CFA CF card is required.
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• If you use a table data display, you can create an SHT file (refer to page 19-17) with the V-SFT.  
You do not need to create a file for monitoring.  (Refer to page 19-18.)

V-SFT screen

Web browser screen

This SHT file is a simple file that shows the table data display only.  To show titles or update 
the monitor automatically, you need to add titles or the monitor auto update function to the 
SHT file.
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• Writing data to the V8i series and monitoring are available from a Web browser.  Use the CGI 
function (MemAcs.cgi), which is built in the V8i series.  (Refer to page 19-22.)
In this case, you will need to create an HTM file in this case.

• You can save a screenshot and a video image onto a CF card in JPEG format.  JPEG data on the 
CF card can be displayed with a Web browser.
You can check the machine line status of a production site from a remote monitoring room with the 
V8i series.  (Refer to page 19-27.)



19.5 Web Server

19-16

Notes

Browser Setting

Be sure to uncheck [  Automatically detect settings] and [  Use a proxy server for your LAN] in the 
LAN settings of your Web browser.

Example:  Windows XP
1) Start Internet Explorer.
2) Select [Tools] → [Internet Options].

The [Internet Options] dialog is displayed.
3) Click the [Connections] tab.

4) Click the [LAN Settings] button in the [Local Area Network (LAN) settings] field.
The [Local Area Network (LAN) Settings] dialog is displayed.

5) Uncheck [  Use a proxy server for your LAN] and [  Automatically detect settings], and 
click [OK].
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Files Available to Use on the Web Server

When you use the Web server function, access the CF card in the V8i series from the Web browser on 
your computer.
The files you can access from the Web browser are as follows:

* The files above should be created with the name using 64 or less one-byte alphanumeric 
characters (0 to 9, A to Z) and an extension of 3 one-byte alphanumeric characters.  If the file 
name or extension does not follow this rule, you cannot access it from the browser.

* SSI (Server Side Include)
This is one of the methods to insert dynamic information, such as the current time, into an HTML 
document.
It is expressed as < !--#exec cgi=“xxx.cgi”-- > or < !--#echo var=“DATE_LOCAL”-- >.  A file that 
contains SSI is called SHT/SHTM file.

Extension MIME Type/Sub Type Description

htm text/html HTML document

sht text/html SHT file (with SSI)

txt text/plain Text file

gif image/gif GIF image

jpg, jpe image/jpeg JPEG image
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Table Data Display Monitor

You can monitor the internal memory of the V8i, PLC memory, etc. with a Web browser.
An SHT file, which is required for monitoring with a Web browser, can be created using a table data 
display on the V-SFT.

Creating SHT Files

Create an SHT file using the V-SFT.

Procedure
1. Place the table data display on the screen of the V-SFT.

2. Click the table data to make the handles appear.
If you need multiple table data displays, create them one by one.

3. Right-click and select [Make Browser File].
4. The [Browser File Name Setting] dialog is displayed.  Enter 

a file name.

* The file name should be 64 one-byte alphanumeric 
characters (0 to 9, A to Z).  You cannot access the file using 
other characters.

5. Two files are created in the “\V-SFT V5\Webserv” folder, which was created when the V-SFT was 
installed.

- (File name).sht: The file to be displayed in a Web browser
- (File name).txt: Table data file for table data display

  

File name is “AAA”
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6. Save the screen data.
* You need to use an SHT file, because the SSI is used for the monitoring function of the table data 

display.  An HTM file is not available.

Saving on a CF Card

Save the SHT file, which is created in the “.\V-SFT V5\Webserv” folder, onto a CF card then monitor it 
with a Web browser from your computer.
Save the file using the CF card manager or by using Explorer.

When using CF Card Manager:
1. Select [File] → [CF Card Manager] on the V-SFT.
2. The [Select the drive for CF card] dialog is displayed.  Select the CF card drive.
3. CF Card Manager is started.
4. Click [File] → [Write to CF Card].  The [Write to CF Card] dialog is displayed.  Select screen data.
5. The access folder is created on the CF card.

At this point, the two files “ .sht” and “ .txt”, that were created in the “.\V-SFT 
V5\Webserv” folder, are stored into the “\access folder\WEBSERV” folder of the CF card.

* Note that all files in the “.\V-SFT V5\Webserv” folder are saved on the CF card in this case.  Delete 
unnecessary files beforehand.

* For more information on CF Card Manager, refer to “18  CF Card.”

CF card setting for screen 
data file
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When using Explorer:
1. Start Explorer on Windows.
2. Specify the CF card drive.
3. Select [CF Card Setting] for the screen data for which you use 

Web server function and check that the folder specified for 
[Access Folder Name] exists on the CF card.

(Access folder name: Refer to “18  CF Card” on page 18-9.)

• When the folder exists:
Copy the two files “ .sht” and “ .txt”, that were created 
in the “.\V-SFT V5\Webserv” folder, into the “\access 
folder\WEBSERV” folder of the CF card.

• When the folder does not exist:
1) Create a new folder with the same name as “access folder” name.
2) Create “WEBSERV” folder in the “access folder” that you created in step 1.

3) Copy the two files “ .sht” and “ .txt”, that were created in the “.\V-SFT V5\Webserv” 
folder, into the “\access folder\WEBSERV” folder of the CF card.

CF card setting for 
screen data file

Copy here.

Copy here.
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Accessing with a Web Browser

Access the V8i series, in which a CF card is inserted, with a Web browser.
1. Start a Web browser on the computer on the Ethernet.
2. In the [Address] field, specify the V8i series IP address and the SHT file as shown below.

3. The table data display is shown on the Web browser.

* The access folder is a root folder with the Web server function.
* In this section, it assumes that the HTM file is stored in the WEVSERV folder.

http://(IP address)/WEBSERV/(file name).sht 

IP address: 172.16.200.109
SHT file name: AAA

http://172.16.200.109/WEBSERV/AAA.sht

AAATEST

DAT0000

BITMAP

CARD

DSP

FONT

HDCOPY

JPEG

MEMO

RECIPE

SAMPLE

SNAP

SRAM

WAV

WEBSERV

VD0000.jpg
VD0001.jpg
       :

CCC.htm
DDD.htm
AAA.sht
     :

CF card

(Access folder)
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Memory Access

You can access (read/ write) to any of the internal memory of the V8i, the PLC memory, and the 
temperature control memory.
In this case, you need to set each parameter in the table (page 19-23) and create an HTM (SHT) file 
for sending to the V8i series.  You can access (read/ write) to the desired memory from this HTM (SHT) 
file by specifying the CGI function (MemAcs.cgi) prepared in the V8i series.

Memory Access Flowchart

The procedure of memory access is shown below:

CGI Function (MemAcs.cgi)

“MemAcs.cgi” is a CGI function prepared for reading from, or writing to, the memory of a device 
connected to the V8i series.
Specify the parameters with the SHT file and start the CGI function.
The CGI function recognizes whether to read or write according to the received parameter values.  For 
reading, it sends a monitor table to the Web browser.  For writing, it sends its writing result to the Web 
browser.

V8i

CGI

Web browser

Computer

Specify the V8i’s IP address 
and the HTM file Send 
access memory parameters

Display the received HTM 
file

Receive
Send the HTM file to the 
Web browser

 Start CGI

Access to the internal or PLC 
memory based on the 
parameters

Display the result of access
Create and output HTM file

Receive
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Memory Access Parameter List

The required parameters to start the CGI function (MemAcs.cgi) are shown below.  Enter the 
parameter names and parameter values correctly.  If a name or value is wrong, MemAcs.cgi cannot 
recognize it and cannot work correctly.

W: Used for memory write
R: Used for memory read

Parameter Name Contents W R

MEM_ACSTYPE Memory access type 0: Memory read
1: Memory write

MEM_MODEL Memory model Same as “Indirect Memory” for macro 
commands.
For more information, refer to the 
Macro Reference Manual.

MEM_TYPE Memory Type

MEM_ADDR Memory address
Top memory address to be accessed
(32-bit address supported)

MEM_EXP Expansion code
Set the required models only.  Set “0” for the others.

MEM_TRMNO PLC station number in case of the multi-drop connection

MEM_WCNT The number of words to 
be accessed

Data length: 1 word: 1 - 128
Data length: 2 words: 1 - 64

MEM_TBL_LINE The number of lines in a table ×

MEM_TBL_COLMN The number of columns in a table ×

MEM_UPDT_TIME Update cycle (unit: second)   * No updates when “0” is set. ×

MEM_WR_DATA Writing data
Set the number of words specified for [MEM-WCNT] with 
delimiter “,” (comma).

×

MEM_WRTYPE Writing data type 0: DEC
1: HEX
2: OCT
3: BIN

×

MEM_DSPTYPE Memory display type 0: DEC
1: DEC (w/ −sign)
2: DEC (w/ +− sign)
3: HEX
4: OCT
5: BIN

×

MEM_KETA Digits for displaying the 
value in memory

1 - 32 ×

MEM_DCPT Decimal point for the 
value in memory

0 - 10 ×

MEM_DLEN Memory data length 0: 1 word
1: 2 words

MEM_INPUT Input format 0: DEC
1: BCD

×
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Memory Access Example
Creating HTM files
By using the radio button menu or the combo box, create an HTM file in which to set the Read/ Write 
parameters and save it to the “.\V-SFT V5\Webserv” folder.
Example:

Memory access is not available if you set it as shown above.  
You need to create a file to set all necessary parameters for 
read (or write) while referring to the parameter list on page 
19-23.

Saving on a CF card:
Save the created HTM file on a CF card.
For how to save, refer to page 19-19.

<HTML>
<BODY>

<FORM METHOD="GET" ACTION="../MemAcs.cgi">

<DT>Way to Access Memory
<DD>                    
<INPUT TYPE="radio" NAME="MEM_ACSTYPE" VALUE=0 CHECKED>read<BR>
<INPUT TYPE="radio" NAME="MEM_ACSTYPE" VALUE=1>write

<DT>Access Memory<DD>
<SELECT SIZE=1 NAME="MEM_MODEL">
<OPTION VALUE=0 SELCTED>Internal Memory
<OPTION VALUE=1>PLC Memory
<OPTION VALUE=2>Memory Card Memory
<OPTION VALUE=3>Temp. Control Memory
</SELECT>

<DT>Memory Address             
<DD>                    
<INPUT TYPE="text" SIZE=6 MAXLENGTH=20 NAME="MEM_ADDR" VALUE=100><BR>  

<INPUT TYPE="submit" NAME="submitname" VALUE="Execute">
<INPUT TYPE="reset" VALUE="Clear">

</FORM>

<BR>

<FONT SIZE=4>|<A HREF="./index.htm">Back</A>|</FONT>

</BODY>
</HTML>

Starting the entry form
Use this as is.

Radio button menu

Combo box

Key board entry

Sending the entered data
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Accessing with a Web browser
Start a Web browser on your computer, and access to the CF card that is inserted in the V8i series.
For how to access, refer to page 19-21.

1. The created HTM file is displayed.
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2. Set access memory parameters in each entry field, then press [Write] button.
The V8i series creates the HTM file as shown below and send it to the Web browser.

- Memory access type is “0: Memory read”:

- Memory access type is “1: Memory write”:

The message varies 
depending on the access 
result.
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JPEG File Display

In the V8i series, you can save a video image to the “CF card\access folder\SNAP” folder, and a 
screen shot to the “CF card\access folder\HDCOPY” folder, both as JPEG files.
On a Web server, you can display the JPEG files with a Web browser.

You can display these files with or without using an HTM file.  If you use an HTM file, create one on 
your own.

Without Using an HTM File:

If you do not use an HTM file, specify “Folder Name/ File Name” directly from the Web browser to 
display a JPEG file.

Enter text in the following format for the address field of the Web browser.

* The access folder is a root folder with the Web server function.

Example:  

http://(IP address)/(folder name)/(file name).jpg
HDCOPY

JPEG
SNAP

IP address: 172.16.200.109
When displaying HD0000.jpg in the “HDCOPY” folder:

http://172.16.200.109/HDCOPY¥HD0000.jpg
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Using an HTM File:

If you use an HTM file, you can display not only a JPEG file, but also a title.  By using the HTM refresh 
command, you can process periodic updates.

Creating HTM files
Example:  
Display a video snap image on the Web browser, then create an HTM file to be displayed while 
updating periodically.

<HTML>
<META HTTP-EQUIV="refresh" CONTENT="5;URL=DDD.htm">

<HEAD><TITLE>JPEG Monitor</TITLE></HEAD>

<BODY>
<CENTER>
<H1>No. 1</H1> 
<P>
<IMAGE SRC="../SNAP/VD0000.jpg">

</P>
</CENTER>
</BODY>
</HTML>

<HTML>
<META HTTP-EQUIV="refresh" CONTENT="5;URL=CCC.htm">

<HEAD><TITLE>JPEG Monitor</TITLE></HEAD>

<BODY>
<CENTER>
<H1>No. 2</H1>
<P>
<IMAGE SRC="../SNAP/VD0001.jpg">

</P>
</CENTER>
</BODY>
</HTML>

JPEG file store target/File nameImage display

Title to be displayed on the top of the screen

File name to be displayed nextUpdate cycleAuto update command

JPEG file store target/File nameImage display

Title to be displayed on the top of the screen

File name to be displayed nextUpdate cycleAuto update command

Page title
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In the HTM file example shown on the previous page, the store target is “../SNAP/VD0000.jpg”.
This is specified with a relative pathname.
Another method, an absolute pathname, can also be used.

Saving on a CF card:
Save the created HTM file on a CF card.
For how to save, refer to page 19-19.

AAATEST

DAT0000

BITMAP

CARD

DSP

FONT

HDCOPY

JPEG

MEMO

RECIPE

SAMPLE

SNAP

SRAM

WAV

WEBSERV

VD0000.jpg
VD0001.jpg
     :

CCC.htm
DDD.htm
AAA.sht
    :

../SNAP/VD0000.jpg

CF card

The access folder is a root folder with the 
Web server function.

This example assumes that an HTM file is stored 
in the Wevserv folder.

(Access folder)

Move to the folder one level higher 

File name
Specify the folder name
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Accessing with a Web browser
Start a Web browser on your computer, and access to the CF card that is inserted in the V8i series.

Enter text in the following format for the address field of the Web browser.

Example:  

VD0000.jpg is displayed first.  VD0001.jpg and VD0000.jpg are repeatedly displayed in order, each for 
five seconds.

http://(IP address)/WEBSERV/(file name).htm

IP address: 172.16.200.109
When displaying CCC.htm in the “WEBSERV” folder:

http://172.16.200.109/WEBSERV/CCC.htm

5 seconds later

5 seconds later
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19.6 Two Ethernet Ports
Overview

• On the V8i series (equipped with a built-in LAN port), both the built-in LAN port and an Ethernet 
unit are usable at the same.  They can serve as two different physical ports.

For instance, while the V8i is communicating with PLCs via the built-in LAN port over Ethernet, 
the V8i can also communicate with the V-Server via the Ethernet unit.

• Networks via the built-in LAN port and the Ethernet unit can be designed separately.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8i

Ethernet

Ethernet

PLC

Ethernet unit

Computer
(V-Server)

Built-in LAN port

PLC

Ethernet

Ethernet
F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8i

Computer
(V-Server)

PLC

Ethernet unit
172.16.200.xxx

Built-in LAN port
192.168.1.xxx

PLC

172.16.200.xxx

192.168.1.xxx
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Usage Example
With only one port
V8i is allowed to perform Ethernet communication with PLCs of different manufacturers (PLC for unit A 
and PLC for unit B) on a LAN (IP address: 192.168.1.xxx) inside the factory.

With two ports
By mounting an Ethernet unit on the present V8i, a new network can be additionally established 
without the need for changing the current Ethernet network.  As a result, a LAN can easily be designed 
in the office so as to enable the computer installed in the office to monitor the factory.
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F 4

F 5
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F 7

SYSTEM

V8i

Ethernet

Built-in LAN port

PLC for unit A PLC for unit B

192.168.1.xxx

Factory

Ethernet

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8i

Ethernet

Built-in LAN port

PLC for unit A PLC for unit B

192.168.1.xxx

Factory 
monitoring
(V-Server)

Ethernet unit

172.16.200.xxx

With an additional 
Ethernet unit mounted, a 
network that achieves 
remote monitoring 
through the host 
computer can simply be 
established.

Factory

Office
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Setting Procedure

IP Address Setting

Two IP addresses must be set for the built-in LAN port and the Ethernet unit.
Click [System Setting] → [Ethernet Communication] → [Local Port IP Address].
The [IP Address Setting] dialog is displayed.

For the built-in LAN port
Set the items in the [IP Address Setting] tab window for the built-in LAN port.

For the Ethernet unit
Set the items in the [IP Address Setting (extended)] tab window for the Ethernet unit port.

The included items are the same between the [IP Address Setting] and [IP Address Setting 
(extended)] tab windows.
For more information, refer to page 19-2.
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Network Table

In a case where MONITOUCHs are connected as illustrated below, they may communicate with one 
another using macro commands EREAD and EWRITE (and SEND to send data to the host computer).  
Communication in this style requires the registration of the IP addresses of the MONITOUCHs (or the 
host computer) used as the access targets, in addition to the registration of the local port address.  
Network table registration must therefore be registered.

Network table registration
When you use the two ports, go to the [Network Table Edit] window and register network tables (click 
[System Setting] → [Ethernet Communication] → [Network Table]).
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Even when different networks exist, register their respective data including IP addresses in network 
table editing.

System Memory Setting

A port to be used for the execution of an Ethernet macro command (“WREAD”, “EWRITE”, “SEND”, or 
“MES”) can be specified at $s512.
For more information on the system memory, refer to page 19-38.
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Ethernet Setting on MONITOUCH
Viewing the Ethernet information
The Main Menu screen on MONITOUCH provides information about the built-in LAN port and the 
Ethernet unit.

When [Built-in LAN] is displayed in the [Ethernet Information] section on the Main Menu screen, the 
section shows the information on the built-in LAN port.
Pressing the [Built-in LAN] switch switches it to [Extended LAN].  The section then shows the 
information on the LAN port for the Ethernet unit.
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SYSTEM



19.6 Two Ethernet Ports

19-37

19

Changing the IP address
* The IP address set in screen data [IP Address Setting] takes priority over the IP address set 

on MONITOUCH.
When you change the IP address on MONITOUCH, press [Main Menu] → [Ethernet].

When you set the address for the built-in LAN port, show [Built-in LAN].
Pressing the [Built-in LAN] switch switches it to [Extended LAN].
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System Memory ($s)

The following describes the system memory associated with two Ethernet ports.

* If an Ethernet unit is mounted on the V8 series without the built-in LAN port, $s518 is used for 
Ethernet status storage.

Description of Addresses
$s512
This address is used to specify a port for sending/receiving Ethernet macros 
(EREAD/EWRITE/SEND/MES) when two Ethernet ports are used.

0: Built-in LAN port
Other than 0: Ethernet unit

The addresses $s514 and $s515 are pertinent to the port selected at $s512.
For more information on $s514 and $s515, refer to the V8 Series Connection Manual.

$s519
This address is enabled only when two ports are used.
The Ethernet status of the Ethernet unit will be stored in memory at $s519.
$s519 is used in the same manner that $s518 is used for the built-in LAN port.
For more information on the address $s518, refer to the V8 Series Connection Manual.

Address Description

$s512 Selection from two Ethernet ports (0: built-in LAN port, other than 0: Ethernet unit)

513 (Blank)

514 Macro: Wait request (0: no, 1: yes)

515 Result of macro execution when the above request is made

516 (Blank)

517 (Blank)

518 Ethernet status (for built-in LAN port)

519 Ethernet status (for Ethernet unit)*
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20 Slider Switch
Overview

• The slider switch is useful to change the setting values on the screen.
• A maximum of 1024 parts* (192 parts* for the V806 series) can be placed on one screen.

* Including switches and scroll bars

Position to be pressed and data write timing
• The slider switch works only when the slide switch is pressed (it does not work when a position on 

the rail is pressed).
• When you remove your finger from the slide switch, a value is written and the slide switch is moved 

at the same time.

Display for slide switch movement
• While you are moving your finger to move the slide switch, only a line indicating the switch position 

to be moved is displayed.  The slide switch does not move together with your finger.

MJ1

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

0

0

0

30.5

48.2

25.0

Port 
No. 0

Port 
No. 1

Port 
No. 2

Port 
No. 0

Port 
No. 1

Port 
No. 2

<SV Setting Screen> <SV Setting Screen>

Move the slide switch while holding it down.  When 
you remove your finger, the data is changed.

Port No. 1 Port No. 2 Port No. 3

Movement

Slide switch
RailLine
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Setting Dialog

Main

Style

Memory Specify a memory address to be changed by the slider switch.

Data Length
(1-Word, 2-Word)

Select the data length of the memory address.

Input Type
(BCD, DEC)

Select a code type to be used when importing data into the V series.

Direction
(↑, ↓, →, ←)

Select a sliding direction.

Define detent steps 
by the size of the 
item.

When this check box is checked, the number of divisions for the rail is 
automatically defined according to the size and scale value of the rail.

No. of Divisions
(2 to 1024)

Specify the number of divisions of the rail.
If the size of the rail is smaller than the number of divisions, the rail is 
divided into the number defined in the case where [ Define detent steps by 
the size of the item.] is checked.

Scale Specify the setting range available for the slider switch.  It is also possible to 
make it variable by specifying the memory address.

Edit Parts
(Rail + Slide, Rail, 
Slide)

Select the part whose 
design is to be changed.

Rail
Slide
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* Parts change can be executed by selecting an option on the [Modify Part] window.
Select a slider switch and select [Edit] → [Change Part] → [Modify Part].  The dialog shown below 
is displayed.  Select [Edit a rail] or [Edit a slider].

Detail

Coordinates

For information on the coordinate designating method, refer to “Appendix 4  Styles and Coordinates” 
on page A4-12 .

Color Change the color of the part which is selected for [Edit Parts].
(This is valid only when [Rail] or [Slide] is selected.)

Change Part* Press this button to apply changes to the part selected for [Edit Parts].
For more information, refer to “3.6 Parts” in the Operation Manual.

Process Cycle Set a cycle for the V8 series to read the PLC data during communication.
For more information, refer to “Appendix 5  Process Cycle”.

ID Specify the ID.
For more information on the ID, refer to the Operation Manual.
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Display Setting

For information on setting the [Display Setting] tab window, refer to the V8 Series Reference Additional 
Functions.
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A1Appendix 1 Buffering Area
Overview

• The “buffering area” is the area where sampling data is saved.
Make the setting by selecting [System Setting] → [Buffering Area Setting].

• The buffering area can be partitioned into 12 sections (buffers).
Buffers in the buffering area can store several kinds of data that is sampled by different methods.

• The buffering areas can be located in the DRAM/SRAM area within the V8 series as the primary 
storage target or on a CF card/memory card (SRAM) as the secondary storage target.

When two storage targets (primary and secondary) are set, sampling will continue with the 
primary storage target even if you remove the CF card (secondary storage target) for data 
backup purpose (with [Full Processing: Overwrite]).

12 partitions possible

For trend sampling

For alarm logging

Buffering area

Buffer No. 0

Buffer No. 1

Buffer No. 2

Buffer No. 3

Buffer No. 4

Buffer No. 5

Buffer No. 6

Buffer No. 7

Buffer No. 8

Buffer No. 9

Buffer No. 10

Buffer No. 11

07-20   11:32:10     A tank temperature rise
07-20   11:33:15     A tank temperature rise
07-20   11:40:25     C tank temperature drop
07-20   11:50:13     C tank temperature drop

<ON>
<OFF>
<ON>
<OFF>

No.  0
No.  1
No.  2
No.  3
No.  4

No. 11

96
M

B

CompactFlash Card

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

No.  0
No.  1
No.  2
No.  3
No.  4

No. 11

Secondary storage 
target: CF card

Primary storage 
target: 
SRAM

Buffering area

SRAM (built-in)
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Primary: DRAM + Secondary: None

• Historical data is temporarily stored in the DRAM area within MONITOUCH.
When MONITOUCH is turned off, or when the mode is switched from RUN → STOP, data in the 
DRAM will be erased.

Primary: SRAM + Secondary: CF Card

• Historical data is stored in the SRAM area built in MONITOUCH.
Even when MONITOUCH is turned off, data in the SRAM is retained (as long as the battery 
voltage lasts).
Data in the SRAM is saved to the CF card, that is the secondary storage target, at regular intervals 
as specified.  (For more information, refer to page A1-16.)
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A1Setting Dialog (from [0] to [11] Tab Windows)

Type Determine whether you use the sampling function or not and, if desired, 
specify the function to be used.
Depending on the selection here, the setting items in the tab window will 
change.

None The sampling function is not used.

Trend Select this option when you use trend or data sampling.

Alarm Select this option when you use alarm tracking or alarm 
logging.
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Sampling Method The following six options are available.  Data is sampled in the selected 
method, and can be displayed in the corresponding sampling mode.

Bit Synchronization:
Data is sampled at the edge of 0 → 1 of bits (specified as “T: trigger”) in 
the sampling control memory.
Applicable sampling mode: Data sampling, trend sampling

When a sampling control memory address is separately specified, 
reading occurs at intervals set with [Sampling Cycle].
When a separate setting is not made for sampling control memory 
address, reading occurs in every cycle.  Thus set the [Sampling Cycle] to 
0 sec.
For more information on the sampling control memory, refer to page 
A1-9.

Constant Sampling:
Data is sampled at the specified intervals (= [Sampling Cycle]).
Applicable sampling mode: Data sampling, trend sampling

Device Memory Map (PLC n):
Data for device memory map PLC1 - 8 is sampled at regular intervals or 
in synchronization.
Applicable sampling mode: Data sampling, trend sampling
(Refer to the V8 Series Connection Manual.)

Alarm Logging:
Data is sampled at the ON/OFF edge of each bit.
Applicable sampling mode: Alarm logging

Time Order Alarming:
A message is displayed at the ON edge of each bit.  When the bit is 
reset (OFF), the message disappears.  This function uses the buffering 
area temporarily to show the messages in order of occurrence that 
begins with either the oldest or newest.
Applicable sampling mode: Time order alarming

Alarm Tracking:
Data is sampled at the ON/OFF edge of each bit.
Applicable sampling mode: Alarm tracking, alarm logging, time order 
alarming

Type Sampling Method Corresponding Sampling Mode

Trend

Bit Synchronization
Data sampling
Trend samplingConstant Sampling

Device Memory Map (PLC n)

Alarm

Alarm Logging Alarm logging

Time Order Alarming Time order alarming

Alarm Tracking
Alarm tracking
Alarm logging

Time order alarming
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Buffer No. 3
Buffer No. 7
Buffer No. 11

LSBMSB

= Read area

n+3
n+4
n+5

Buffer No. 2
Buffer No. 6

Buffer No. 10

Buffer No. 1
Buffer No. 5
Buffer No. 9

Buffer No. 0
Buffer No. 4
Buffer No. 8

Sampling control memory (default)
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A1Sampling Cycle
(0 - 65535 sec)

Specify the desired interval for sampling.
For [Sampling Cycle: 0 sec], sampling occurs in every cycle.  With a length 
of time specified, sampling occurs at the specified time intervals.
When “0” is specified for [Sampling Cycle], sampling is made every cycle.  
Set the desired interval in seconds to perform regular sampling.

* When “0” is specified for [Sampling Cycle], sampling starts at the 
beginning cycle, and sampling data is read on completion of sampling.
When a value other than “0” is specified for [Sampling Cycle], 
sampling is made while reading sampling data in cycles.

* Sampling at extremely short intervals (“0”, “1”, etc. is specified for 
[Sampling Cycle]) increases the number of PLC data reading times.  
Depending on screen data, the processing speed of the V8 series may 
be slowed down.  In this case, it is recommended that [  Memory 
Designation] be unchecked.  (Refer to page A1-8.)

* This setting is not valid when [Device Memory Map] is selected for 
[Sampling Method].

 High Speed When this box is unchecked, “sec” is used as the unit for [Sampling 
Cycle].
When this box is checked, “× 100msec” is used as the unit.
A high-speed read cycle for sampling data in 100-msec units can be set.

Table No. This setting is valid when [Sampling Method: Device Memory Map] is 
selected.
Specify the number of the device memory map where data to be read is 
registered.

Memory Continuous, 
Individually

Continuous:
The sampling data memory is allocated consecutively in 
the read area or from the specified top address.

Individually:
The memory address for sampling data can be specified.
(For the procedure of specifying an individual memory 
address, refer to “Discrete Memory/CSV Format (Tab 
Window)” (page A1-19) described later.)

* When [Individually] is selected, reading from the PLC 
occurs more frequently than when [Continuous] is 
selected.  As a result, the processing speed may be 
slowed down.  To increase processing speed, select 
[Continuous].

(Memory 
designation)

Unchecked:
The sampling data memory is allocated consecutively in 
the read area.
(In this case, [Data Length] is fixed to [1-Word].)

Checked:
Specify the desired top memory address.

Data Length (1-Word, 2-Word)
This option becomes active when the box above is 
checked.
Set data length of the data memory.

Word Count Specify the number of words to be sampled. 
As many addresses as the specified number of words must 
be allocated.

[Type: Trend]: 128 words maximum
[Type: Alarm]: 1024 words maximum *

* 16-bit sampling is performed with one word.
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Store Target For more information, refer to “Storage Target (Setting Dialog)” (page 
A1-13) described later.

Discrete memory/CSV 
format

For more information, refer to “Discrete Memory/CSV Format (Tab 
Window)” (page A1-19) described later.

Others For more information, refer to “Others” (page A1-27) described later.

 Specify Sampling 
Control Memory

Unchecked:
Memory addresses are allocated for each buffer consecutively from read 
area “n + 3”.

Checked:
An address can be specified as the sample control memory address 
exclusively for the buffer of the specified number.

* For more information on the sampling control memory, refer to page 
A1-9.

Info Output Memory 
(for separate settings)

This option becomes active when [  Specify Sampling Control Memory] 
is checked.  An info. output memory address can be specified individually.
Specify the info. output memory address to be used exclusively for the 
specified buffer.

* For more information on the info. output memory, refer to page A1-11.

Buffering Area 
common settings

This option becomes active when [  Specify Sampling Control Memory] 
is unchecked.
The top addresses for [Sampling Control memory] and [Info. Output 
Memory] common to buffer Nos. 0 to 11 are indicated.

* For more information on the sampling control memory, refer to page 
A1-9.
For more information on the info. output memory, refer to page A1-11.
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A1 Start Bit When an option other than [Alarm Tracking] is selected for [Sampling 
Method]:
You can control the sampling start, stop, and restart.

When this box is checked, the bit obtained from the sampling control 
memory area is automatically displayed.

Sampling control memory [U] (bits 03, 07, 11, 15)
ON: Sampling start
OFF: Sampling stop

* For more information on the sampling control memory, refer to page 
A1-9.

 When [Alarm Tracking] is selected for [Sampling Method]:
You can control the start and stop of monitoring bits for sampling.

Without checking this box, alarm tracking is always active because the 
alarm monitor is always working.
When this box is checked, alarm tracking is not performed even if the 
alarm bit is set (ON) or reset (OFF) unless the bit specified for [Start Bit] 
(bit 03, 07, 11, 15 of sampling control memory) is set (ON).

* For more information on the sampling control memory, refer to page 
A1-9.

Reset Bit Display the bit information for each buffer in the sampling control memory.
* For more information on the sampling control memory, refer to page 

A1-9.
Trigger Bit

Normal Operation Bit
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Buffer No. 1
Buffer No. 5
Buffer No. 9

Buffer No. 0
Buffer No. 4
Buffer No. 8

Sampling control memory
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Memory Allocation
Trend data / alarm data memory
Depending on the [Memory] setting in the [Buffering Area Setting] dialog, data memory allocation will 
vary.

• [Continuous] & box unchecked:
Memory addresses are allocated following the sampling control memory (refer to page A1-9) (read 
area “n + 3” and later).

• [Continuous] & box checked:
The top memory address for sampling data can be specified.

• When [Individually] is selected:
Individual memory addresses can be specified for sampling data.
Specify these addresses on the [Discrete memory/CSV format] tab window.
(For more information, refer to page A1-19.)

n: Read area

Buffer used - No. 3 Buffer used - No. 7 Buffer used - No. 11
n n n
n + 1 Read area n + 1 Read area n + 1 Read area
n + 2 n + 2 n + 2
n + 3 Sample control memory n + 3 Sampling control memory n + 3
n + 4 n + 4 n + 4 Sample control memory
n + 5 n + 5 n + 5
n + 6 n + 6 n + 6
n + 7 Sampling data n + 7 Sampling data n + 7 Sampling data
n + 8 n + 8 n + 8

n: Read area

Buffer used - No. 3 Buffer used - No. 7 Buffer used - No. 11
n n n
n + 1 Read area n + 1 Read area n + 1 Read area
n + 2 n + 2 n + 2
n + 3 Sampling control memory n + 3 Sampling control memory n + 3

n + 4 n + 4 Sampling control memory
n + 5

Desired 
address

Desired 
address

Sampling data Sampling data Sampling data
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A1Sampling control memory
A memory area called “sampling control memory” is used to control the sampling function for each 
buffer with buffering area settings.
Memory allocation and control items are described below:

• When [  Specify Sampling Control Memory] is not checked:
Sampling control memory is automatically allocated for a maximum of 3 words following the read 
area “n + 3” (specified by selecting [System Setting] → [Device Connection Setting]) when [  
Specify Sampling Control Memory] is checked in the [Buffering Area Setting] dialog.

* The number of words allocated for the sample control memory depends on the number of 
buffers to be used.  (Refer to the illustration below.)
When [Type : None] is set, memory addresses from “n + 3” are not used.

* Be sure to reset the bits not in use to “0” in the sample control memory.

Example:
The top memory address of the sampling control memory 
will be D3 (= read area n + 3) in the following case:

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
 U S R T U S R T U S R T U S R T

Sample control memory
= Read area

n + 3
n + 4
n + 5

Buffer No. 3
Buffer No. 7
Buffer No. 11

Buffer No. 2
Buffer No. 6
Buffer No. 10

Buffer No. 1
Buffer No. 5
Buffer No. 9

Buffer No. 0
Buffer No. 4
Buffer No. 8

T: Trigger This is valid only when [Bit Synchronization] is selected for [Sampling Method].  
Data is sampled from the specified buffer at the edge of [0→ 1].

R: Reset When this bit is set (1), data in the specified buffer is cleared and no sampling 
occurs.  When this bit is reset (0), sampling is started.
(This is not valid when [Time Order Alarming] is selected for [Sampling 
Method].)

S: Normal 
operation bit

This is valid only when [Alarm Function] is selected for [Sampling Method].
This bit controls alarm tracking.  When an error bit is reset, this bit is set.  
When an error bit is set, this bit is reset.  The first error bit that is set while this 
bit is reset is recognized as the “primary cause” error, and can be 
distinguished from the other errors.
(For more information on the alarm function, refer to “10.3  Alarm Tracking 
(Historical).”)
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• When [  Specify Sampling Control Memory] is checked:
When [  Specify Sampling Control Memory] is checked in the [Buffering Area Setting] dialog, a 
desired memory address can be specified as a sampling control memory address for each buffer.  
(The contents of bits are the same as above.)

In this case, however, since data in [Sampling Control Memory] is read at the start of sampling, the 
communication time will be longer than in cases where the box is not checked.
With this box unchecked, data in [Sampling Control Memory] is read at regular intervals, and is not 
read at the start of sampling.

* Be sure to reset the bits not in use to “0” in the sampling control memory.

U:Start Bit When [Sampling Method: Alarm Tracking] is not selected: 
When [  Start Bit] is checked, sampling is started with the bit ON and is 
stopped with the bit OFF.

When [Sampling Method: Alarm Tracking] is selected:
With [  Start Bit] checked, from the start to the end of sampling, no error 
message will be displayed when the alarm bit turns ON unless this bit is ON.
With [  Start Bit] unchecked, alarm tracking is possible regardless of this bit 
activation.
* [  Start Bit] is checked as default.

Example:
The top memory address of the sampling control memory 
will be D100 in the following case:

MSB LSB
Sampling control memory 15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

 n 0 0 0 0 0 0 0 0 0 0 0 0 U S R T

Not used Buffer No. n



Appendix 1    Buffering Area

A1-11

A1Info. output memory
This is the area where the status of each buffer in the buffering area is indicated.

• When [  Specify Sampling Control Memory] is not checked:
When [  Specify Sampling Control Memory] is not checked in the [Buffering Area Setting] dialog, 
a maximum of three words from the address specified for [Info Output Memory] in the [Buffering 
Area Setting] dialog is used as the info. output memory area.

* The number of words allocated for the info. output memory depends on the number of 
buffers to be used.
(Refer to the illustration below.)

T: Input trigger is output.
D: Specified buffer contains data.
F0: Specified buffer is 90% full.
F1: Specified buffer is full.

Example:
The top memory address of the info. output memory will be 
$u16340 in the following case:

MSB LSB
15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Info. output memory F1 F0 D T F1 F0 D T F1 F0 D T F1 F0 D T

n
n + 1
n + 2

Buffer No. 3
Buffer No. 7
Buffer No. 11

Buffer No. 2
Buffer No. 6
Buffer No. 10

Buffer No. 1
Buffer No. 5
Buffer No. 9

Buffer No. 0
Buffer No. 4
Buffer No. 8
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• When [  Specify Sampling Control Memory] is checked:
When [  Specify Sampling Control Memory] is checked in the [Buffering Area Setting] dialog, a 
desired memory address can be specified as an info. output memory address for each buffer.  
(The contents of bits are the same as above.)

* The number of words allocated for the info. output memory depends on the number of 
buffers to be used.
(Refer to the illustration below.)

T: Input trigger is output.
D: Specified buffer contains data.
F0: Specified buffer is 90% full.
F1: Specified buffer is full.

Example:
The info. output memory address will be D200 and is 
exclusively used for the specified buffer.

MSB LSB

Info. output memory 15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

n 0 0 0 0 0 0 0 0 0 0 0 0 F1 F0 D T

Not used Buffer No. n
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A1Storage Target (Setting Dialog)

Primary 
storage target

Type DRAM:
Sampled data is stored in the DRAM area of the V8 
series.
It is cleared when the V8 series is in the STOP mode (the 
power is turned off, the Main Menu screen is displayed).

SRAM:
Sampled data is stored in the SRAM area built in the V8 
series.
Data is retained even when the V8 series is in the STOP 
mode (the power is turned off, the Main Menu screen is 
displayed).

Full Processing
(Stop, Overwrite)

This option determines what happens when the specified 
number of sampling times (No. of Samples) has been 
exceeded.

Stop:
Sampling stops when the number specified for [No. of 
Samples] has been exceeded.
If the medium of the secondary storage target is removed, 
sampling stops and the graph display is cleared.

Overwrite:
Sampling continues while discarding old sampling data 
when the number specified for [No. of Samples] has been 
exceeded.
Even if the medium of the secondary storage target is 
removed, sampling will continue.

No. of Samples
(1 - 65535)
*1 *2

Specify the number of times for storing sampling data in the 
buffering area.



Appendix 1    Buffering Area

A1-14

*1 For more information on the number of sampling times, refer to “No. of Samples.”
*2 Specify a number greater than that of lines that can be held in the sampling mode display area 

for [No. of Samples].  Otherwise, the linked switches (Roll Up, Reset, etc.) will become invalid.
*3 For a list of usable CF cards, visit our Website (http://www.monitouch.com).

No. of Samples

• [No. of Samples] can be set respectively for [Primary storage target] and [Secondary storage 
target].
Note that, however, the following inequation must be satisfied:

[No. of Samples] for [Primary storage target] ≤ [No. of Samples] for [Secondary storage target]

• If a medium is selected for [Secondary storage target] and is ready to be accessed, the count of 
sampling times up to the number specified for [No. of Samples] for [Secondary storage target] can 
be indicated in a sampling count display part.

• If a medium is selected for [Secondary storage target] and is not ready to be accessed (for 
example, the CF card is removed, the CF card cover is open, etc.), the maximum possible count 
will be the number specified for [No. of Samples] for [Primary storage target].

Secondary 
storage target

Output media None:
The secondary storage target is not used.

CF Card *3:
Sampled data is stored on a CF card.  Data is retained 
when the V8 series is in the STOP mode (the power is 
turned off, the Main Menu screen is displayed).  For more 
information, refer to page A1-16.

Memory Card:
Sampled data is stored in the SRAM memory card (with 
card recorder “CREC” used).  Data is retained when the 
V8 series is in the STOP mode (the power is turned off, 
the Main Menu screen is displayed).

Output File No. When [Memory Card] is selected for [Store Target], file 
numbers are automatically given according to this setting.  
For more information, refer to page A1-33.

No. of Samples
(1 - 86400)
*1 *2

Specify the number of times for storing sampling data in the 
buffering area.

 CSV Output For more information, refer to page A1-16.

 Create Backup 
File For more information, refer to page A1-17.
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A1Size Calculation

The size of each buffer is determined from the formulae shown below as well as the storage target, 
which determines the value to be added.

Formulae by sampling method (1)
   (1) Parameter word count,  (2) Number of sampling times,   (3) Sampling word count

(Unit: words)

*1 With [  Put msec information on logging time] checked
*2 With [  Memorize initial value] checked
*3 With [  Acknowledge function] checked
*4 With [  Add Time Order Alarming] and [  Acknowledge function] checked
*5 With [  Add Time Order Alarming] checked
*6 [  Record Parameters]: checked
*7 [  Add Time Order Alarming] and [  Record Parameters]: checked

* For more information on these setting items, refer to “Others” (page A1-27).

Header for each storage target (2)
(Unit: bytes [words])

Trend Bit 
Synchronization

(2 + (3) + 1*1) × (2) AConstant 
Sampling

Device Memory 
Map

Alarm Alarm Logging {(3 + (1) + 1 *6) × (2)} + (3) *2 B

Time Order 
Alarming {(5 + (1) + 1 *6) + 1 *3} × (3) × 16 C

Alarm Tracking {(5 + (1) + 1 *6) + 1 *3) × (2)}
+ {((6 + (1) + 1 *7) + 1 *4 + 2 *5) × (3) × 16)}
+ (7 + (3) *2)

D

Store Target Type/Output media Header

Primary storage 
target

DRAM None

SRAM 112 [56]

Secondary 
storage target

CF card 256 [128]

Memory Card 2048 [1024]*1

(3)

(2)(1)
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Size calculation for each buffer
The required size can be obtained by adding the result of “Formulae by sampling method (1)” and the 
number of words shown in “Header for each storage target (2).”

Example 1: [Sampling Method: Bit Synchronization], [Primary storage target: DRAM], [Secondary 
storage target: CF Card]

Primary storage target = (1) A + (2) None (units: words)
Secondary storage target = (1) A + (2) 128 (units: words)

Example 2: [Sampling Method: Alarm Tracking], [Primary storage target: SRAM], [Secondary storage 
target: None]

Primary storage target = (1) D + (2) 56 (units: words)
Secondary storage target = None

Timing of Data Storage
Primary storage target: DRAM/SRAM
Sampling data is stored constantly during sampling.

Secondary storage target: CF Card/Memory Card
Data in the primary storage target will be output to the secondary storage target at the times shown 
below:

• When the mode is switched from RUN → STOP
• When the [CF Card Removal] switch is pressed 
• When the CF card cover is opened
• When the medium of the primary storage target becomes full
• When the macro command “SMPL_SAVE”, “SMPL_CSV”, “SMPL_CSV2”, “SMPLCSV_BAK”, 

“SMPLCSV_BAK2” or “SMPL_BAK” is executed
• When the power to MONITOUCH is turned ON with [Primary storage target: SRAM]
• When the [Function: Reset] switch in sampling mode is pressed
• When the “R: Reset” bit in sampling control memory is ON

* When [Secondary storage target: CF Card] is selected, a BIN file is created on the CF card and 
data is stored in this file.

CSV Output

Data in the primary storage target is output to the secondary storage target, and data in the BIN file in 
the secondary storage target is saved in CSV format on the CF card.

Timing of data saving
• When the mode is switched from RUN → STOP *
• When the [Function: CF Card Removal] switch is pressed *
• When the CF card cover is opened *
• When the macro command “SMPL_CSV”, “SMPL_CSV2”, “SMPLCSV_BAK” or 

“SMPLCSV_BAK2” is executed

* With [  CSV Output] checked
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A1Storage target
\ (Access folder) \SAMPLE

• File Name: SMPxxxx.CSV
xxxx = 0000-0011: Buffering area number

* It is also possible to use the macro command “SMPL_CSV” without using [  CSV Output].
For more information on the macro commands, refer to page A1-29.

Create Backup File

Data in the primary storage target is output to the secondary storage target as a FIN file, and data in 
the file is copied on the CF card for backup purpose.

Timing of data saving
• When the power is turned on *
• When the date is changed (24:00) *
• When the medium of the secondary storage target becomes full *
• When the macro command “SMPL_BAK” is executed

*  With [  Create Backup File] checked

Storage target
\(access folder)\SAMPLE\YYYYMM\YYYYMMDD

• File Name: SMPxx_yy.BIN
xx = 00-11: Buffering area number
yy = 00-99: Index number

• Example: When saving data on 11.09.07:
Data is saved in the \SAMPLE\200709\20070911 folder.
When the SMP00_99.BIN files have been created these files will be overwritten.

* It is also possible to use the macro command “SMPL_BAK” without using [  Create Backup File].
For more information on the macro commands, refer to page A1-29.

CF card

(Access folder)

SAMPLE     folder SMPxxxx.CSV

BITMAP      folder

  CARD       folder

YYYY: Year
MM: Month
DD: Day

SMP00_01.BIN

CF card

(Access folder)

SAMPLE     folder SMP0000.BIN

BITMAP      folder

  CARD       folder

200709        folder

SMP00_00.BIN20070911        folder

20070912        folder

SMP00_01.BIN

SMP00_00.BIN

SMP00_02.BIN
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CSV Output & Create Backup File

“SMPxxxx.CSV” is created from “SMPxxxx.BIN” in the “SAMPLE” folder when [  CSV Output] is 
checked.
Consequently, backup files “SMPxxxx.BIN” and “SMPxxxx.CSV” are saved in the backup folder when 
[  Create Backup File] is also checked.
(The same operations that the macro commands, “SMPL_BAK” and “SMPLCSV_BAK”, are executed 
at the same time.)

Timing of data saving
• When the power is turned on
• When the date changes (24:00)
• When the medium of the secondary storage target becomes full
• When the macro command “SMPL_BAK” + “SMPLCSV_BAK” or “SMPL_BAK” + 

“SMPLCSV_BAK2” is executed

Storage target
\(access folder)\SAMPLE\YYYYMM\YYYYMMDD

• File Name: SMPxx_yy.BIN
xx = 00-11: Buffering area number
yy = 00-99: Index number

• It is also possible to use the macro commands “SMPL_BAK” and “SMPLCSV_BAK” without using 
[  CSV Output] and [  Create Backup File].  For more information, refer to page A1-29.
The use of macro is recommended for making backup files when the date changes.

• It is possible to automatically delete old backup files when the backup file size exceeds the 
capacity of a CF card.
(In this case, select [System Setting] → [Unit Setting] → [General Settings] and check the box for 
[  Delete folders from the oldest if CF card is lacking in space for backup].) 

YYYY: Year
MM: Month
DD: Day

SMP00_00.CSV

CF card

(Access folder)

SAMPLE     folder SMP0000.BIN

BITMAP      folder

  CARD       folder
200709        folder

SMP00_00.BIN20070911        folder

20070912        folder

SMP00_00.CSV

SMP00_00.BIN

SMP00_01.BIN

SMP0000.CSV

SMP00_01.BIN

SMP00_01.CSV

SMP00_02.BIN

SMP00_01.CSV

SMP00_02.CSV
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A1Discrete Memory/CSV Format (Tab Window)

In this tab window, you can make the memory setting required when [Individually] is selected for 
[Memory] as well as the data type setting for outputting data in CSV format on the CF card.

[Type: Trend]

Example: When trend sampling is set as shown below:
Buffering area setting
[Buffer No.] 0
[Type] Trend
[Sampling Method] Constant Sampling
[Word Count] 4
[Primary storage target] SRAM
[Secondary storage target] CF Card

Trend sampling
[Data Length] 1

As an example, the setting procedure for sampling 4-word data and store it at “D100”, “D200”, “D300” 
and “D400” is explained.
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Individual memory setting procedure

Step 1 Select [Individually] for [Memory] in the [Buffering Area Setting] dialog.
The option for [Word Count] becomes inactive.
The [Discrete memory/CSV format] tab window is automatically displayed.

Step 2 Click on the cell of No. 0 using the mouse.

Step 3 Select “D100”, “D200”, “D300” and “D400” in the “Memory” column, respectively.
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A1

The settings have been completed.

CSV format setting procedure

Step 4 The selected data attributes (Type, Decimal Point, Data Length) will be valid when 
saving data in CSV format.  Make the settings as required.

Step 1 Open the [Discrete memory/CSV format] tab window, and make the settings for data 
attributes (Type, Decimal Point, Data Length) for respective columns.

Step 2 Click [CSV Format].
The [CSV Output Setting] dialog for [Type: Trend] is displayed.

Step 3 When the settings have been completed, click [OK].
The [Buffering Area Setting] dialog is displayed again.
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CSV file example
An example of CSV file with [Type: Trend] is shown below.

[Type: Alarm] and [Sampling Method: Alarm Tracking]

Example: When alarm tracking is set as shown below:
Buffering area setting
[Buffer No.] 0
[Type] Alarm
[Sampling Method] Alarm Tracking
[Word Count] 1
[Primary storage target] SRAM
[Secondary storage target] CF Card

As an example, the setting procedure for sampling 16-bit data and store it at “M100” to “M107”, 
“D250-10” to “D250-15” is explained.

Buffer number
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A1Individual memory setting procedure

Step 1 Select [Individually] for [Memory] in the [Buffering Area Setting] dialog.
The option for [Word Count] becomes inactive.
The [Discrete memory/CSV format] tab window is automatically displayed.

Step 2 Lines for one word from No. 0 to 15 are displayed.
Set “M100” to “M107” and “D250-10” to “D250-15.”

Step 3 If there are any unnecessary addresses, select the line and click the [Delete] button.
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The settings have been completed.

CSV format setting procedure

Step 4 When editing for changing the message, double-click the cell under the “Message” 
column.
The [Message Edit] window is displayed.

Step 1 Open the [Discrete memory/CSV format] tab window and click [CSV format].

Double-click on a cell under “Message.”
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A1

CSV file example
• [Alarm Tracking]

Step 2 The [CSV Output Setting (Alarm Tracking)] dialog is displayed.

Step 3 When the settings have been completed, click [OK].
The [Buffering Area Setting] dialog is displayed again.

Buffer number
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[Type: Alarm] and [Sampling Method: Alarm Logging]

Individual memory setting procedure
Follow the same steps as described for [Sampling Method: Alarm Tracking].  Refer to “[Type: Alarm] 
and [Sampling Method: Alarm Tracking]” on page A1-22.

CSV format setting procedure

CSV file example
• [Alarm Logging]

Step 1 Open the [Discrete memory/CSV format] tab window and click [CSV format].

Step 2 The [CSV Output Setting (Alarm Logging)] dialog is displayed.
Set the dialog for output of the selected information in CSV format.

Step 3 When the settings have been completed, click [OK].
The [Buffering Area Setting] dialog is displayed again.

Buffer number
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A1Others

Use a Calculation 
Operation

This is valid only when [Bit Synchronization] or [Constant Sampling] is 
selected for [Sampling Method].
When the mean, maximum, minimum or total value of data stored in 
the buffering area should be indicated on the screen, check this option.
(Refer to “9  Trend Graph.”)

Memorize initial value This is valid only when [Type: Alarm] and [Primary storage target: 
SRAM] are selected.
With this box unchecked, the bit ON state is read again when the 
power is turned on with the alarm bit ON or when the mode is switched 
from STOP → RUN.
With this box checked, the bit ON state is not read again when the 
power is turned on with the alarm bit ON or when the mode is switched 
from STOP → RUN because its status is saved.

Add Time Order 
Alarming

This is valid only when [Sampling Method: Alarm Tracking] is selected.
Check this box when you use this buffer for time order alarming at the 
same time.

Acknowledge function This option becomes active when [Sampling Method: Alarm Logging] 
is selected or when [Sampling Method: Alarm Tracking] is selected 
with [  Add Time Order Alarming] checked.
Check this box when using the acknowledge function.
(Refer to “Acknowledge Display Function” on page 10-89.)

Record Parameters This option becomes active when [Type: Alarm] is selected.
Check this box when you wish to display the current value for the 
parameter with the error message.

Word Count:
The number of words, automatically calculated, is displayed for the 
parameter.

 Alarm Acknowledge 
function

Check this box when the alarm acknowledge function is to be used 
while [Sampling Method: Alarm Tracking] is selected.
(Refer to “Parameter Display Function” on page 10-37.)

Put msec information 
on logging time

This option becomes active when [Type: Trend] is selected.
With this box checked, the sampling cycle (time) stored together with 
sampling data is saved in units of “msec”.
With this box unchecked, it is saved in units of “sec”.
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Use WAV This option becomes active when [Type: Alarm] is selected.  Sound is 
replayed at the ON edge of the error bit.
(Refer to “14.4  Sound.”)

Continuous Replay This option becomes active when [  Use WAV] is checked.
Sound is continuously replayed when the error bit is set (ON).
(Refer to “14.4  Sound.”)

Use E-Mail This option becomes active when [Type: Alarm] is selected.
E-mail is sent when the alarm bit is set or reset.

Send to:
Set the e-mail address of the recipient.  (Refer to “19.4  E-Mail.”)

 Read sampling 
memories per cycle

Check this box when [Series: L-CPU-B] is selected in the [Device 
Connection Setting] dialog. 
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A1Macro Commands

The following macro commands can be used:

Command Name Contents

SMPL_BAK  F0 Use this command to create a backup file of sampling data 
(\Sample\SMPxxxx.BIN) at the secondary storage target.

F0: 0 - 11 (Buffer No.)

Storage target: \Sample\ (year/month folder) \ (year/month/day folder)

* Even if [Secondary storage target: None] is selected, this command can 
be executed with a CF card inserted.

SMPL_CSV  F0 Use this command to convert the sampling data (\Sample\SMPxxxx.BIN) at 
the secondary storage target into a CSV file (SMPxxxx.CSV) and store it in 
the same storage target.

F0: 0 - 11 (Buffer No.)

* Even if [Secondary storage target: None] is selected, this command can 
be executed with a CF card inserted.

SMP00_01.BIN

CF card

(Access folder)

SAMPLE     folder

SMP0000.BIN

BITMAP      folder

  CARD       folder

200709        folder

SMP00_00.BIN

20070911        folder

20070912        folder

SMP00_01.BIN

SMP00_00.BIN

SMP00_02.BIN

CF card

(Access folder)

SAMPLE     folder

SMPxxxx.BIN

BITMAP      folder

  CARD       folder

SMPxxxx.CSV ←File created
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SMPL_CSV2  F0 
F1

Use this command to convert the sampling data (\Sample\SMPxxxx.BIN) at 
the secondary storage target into a CSV file and store it in the same storage 
target.

F0: 0 to 11 (Buffer number)
F1: File name (within 64 one-byte uppercase alphanumerics)

* Even if [Secondary storage target: None] is selected, this command can 
be executed with a CF card inserted.

SMPL_SAVE Use this command to save the data in the primary storage target at the 
secondary storage target at the preset timing.

Command Name Contents

CF card

(Access folder)

SAMPLE     folder

SMPxxxx.BIN

BITMAP      folder

  CARD       folder

xxxxxxxx.CSV    ← File created
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A1
SMPLCSV_BAK  
F0

Use this command to convert the sampling data (\Sample\SMPxxxx.BIN) at 
the secondary storage target into a CSV file (SMPxxxx.CSV) and create a 
backup file.

F0: 0 - 11 (Buffer No.)

Storage target: \Sample\ (year/month folder) \ (year/month/day folder)

* Even if [Secondary storage target: None] is selected, this command can 
be executed with a CF card inserted.

Command Name Contents

SMP00_00.CSV

CF card

(Access folder)

SAMPLE     folder

SMP0000.BIN

BITMAP      folder

  CARD       folder

200709        folder

SMP00_00.BIN
20070911        folder

20070912        folder

SMP00_00.CSV

SMP00_00.BIN

SMP00_01.BIN

SMP0000.CSV

SMP00_01.BIN

SMP00_01.CSV

SMP00_02.BIN

SMP00_01.CSV

SMP00_02.CSV
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SMPLCSV_BAK2  
F0  F1

Use this command to convert the sampling data (\Sample\SMPxxxx.BIN) at 
the secondary storage target into a CSV file for backup.

F0: F0: 0 to 11 (Buffer number)
F1: File name (within 64 one-byte uppercase alphanumerics)

Storage target: \Sample\ (year/month folder) \ (year/month/day folder)

* Even if [Secondary storage target: None] is selected, this command can 
be executed with a CF card inserted.

Command Name Contents

CF card

(Access folder)

SAMPLE     folder

SMP0000.BIN

BITMAP      folder

  CARD       folder

200709        folder

SEISAN.CSV

20070911        folder

SMP0000.CSV
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A1Internal Memory ($s)

The system memory ($s) is used for buffering area as shown below.

• For more information, refer to “Appendix 6  Internal Memory.”

Address ($s) Contents

20 - 55 Buffer No. 0 - 11 n+0 The setting number of sampling times

n+1 The current number of sampling times

n+2 The number of sampling times executed

177 Buffer number selected with macro command “SET_BUFNO”

180 - 435 Result of operation with macro command “SET_BUFNO”

436 - 443 Alarm tracking Time stamp

456 Alarm tracking  Normal operation bit

458 Alarm tracking  Sampling bit

1098 Sampling macro Background processing selection

1100 - 1114
1120 - 1134
1140 - 1154
1160 - 1174
1180 - 1194
1200 - 1214
1220 - 1234
1240 - 1254
1260 - 1274
1280 - 1294
1300 - 1314
1320 - 1334

Buffer No. 0 - 11 n+0 Primary storage target The setting number of sampling times

n+1 Primary storage target The current number of sampling times

n+2 Secondary storage target The setting number of sampling times

n+3

n+4 Secondary storage target The current number of sampling times

n+5

n+6 The number of sampling times executed

n+7

n+8 Secondary storage target Being accessed

n+9 Background processing flag

n+10 Sampling macro  Executing flag

n+11 Sampling macro  Execution completion flag

n+12 Sampling macro  Error flag

n+13 Sampling error flag

n+14 Sampling error forced storage flag
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[Secondary storage target: Memory Card] (= CREC)

Configuration

Memory Card Capacity

The memory area of the SRAM memory card is illustrated below.

* 256 kB, 512 kB, 1 MB, 2 MB, and 4 MB type memory cards are available.

Memory Card Life
The service life of the SRAM area depends on the battery life.  The battery life varies depending on its 
capacity.  Consult your local distributor.
To check whether the battery voltage is lowered or not, select [System Setting] → [Memory Card 
Setting] → [I/F Memory] (refer to “15.2  Memory Card Mode” (page 15-19)) and check the value in the 
corresponding memory address.

Card information

File information

File 0

File 1

File 2

:
:
:

File 15

No.  0
No.  1
No.  2
No.  3
No.  4

No. 11

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

No.  0
No.  1
No.  2
No.  3
No.  4

No. 11

Secondary storage target: 
Memory card = REC-MCARD 
(SRAM)

CREC

Buffering area

Primary storage 
target: SRAM

0

Header information (1024 words)

1023
1024

Entire file size
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A1Setting Procedure

Device connection setting
When using a CREC (card recorder), select [System Setting] → [Device Connection Setting] → 
[Others] → [Card Recorder].  Check [  Use Card Recorder] and select a connection port (MJ1 or 
MJ2). 

Buffering area setting and memory card setting
Select [Secondary storage target: Memory Card] in the [Buffering Area Setting] dialog.
Editor refers to the setting for [Output File No.], finds the corresponding tab number in the [Memory 
Card Setting] dialog, and automatically sets [Type: Buffering File].

Memory card
When using an SRAM, you need to format an SRAM memory card according to the setting in [Memory 
Card Setting] dialog.
Therefore, you need to set items in the [Memory Card] dialog in the memory card mode and create the 
[Function: Card Format] switch.

Buffering Area Setting

Device connection setting

Memory Card

Card recorder: MJ1/MJ2 

Icon & [Function: Card Format] switch

(Memory Card Setting)

[Secondary storage target: Memory Card]
[Output File No.: (any)] (Automatic setting)
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Setting and Importing Procedures on the V8 Series

To start data logging, follow the steps shown below on the V8 series:

Format
When the [Function: Card Format] switch on the screen is pressed, the memory card is formatted and 
becomes ready to store data.

* SRAM formatting of memory card mode can only be performed using the [Function: Card 
Format] switch.

* If you have changed the setting in the [Memory Card Setting] or [Buffering Area Setting] 
dialog, you need to format the SRAM again.  In this case, the data will be cleared.

Note
• The data stored on a SRAM memory card is retained unless you reset or format the SRAM 

memory card again.
(Note that data will be lost if the battery of the SRAM becomes totally depleted.)

• With [Full Processing: Stop], if you remove the SRAM memory card from the V8 series, sampling is 
temporarily stopped and the data will not be imported.  If sampling data is displayed on the screen, 
the data disappears from the screen.  When you re-set the memory card, the historical data 
imported in the past is displayed and sampling begins again.
With [Full Processing: Overwrite], sampling will continue.

Importing data
To import the sampling data from an SRAM memory card into your computer, use the data read 
software Memory Card Editor (M-CARD SFT).
For more information on using the Memory Card Editor, refer to the M-CARD SFT Instruction Manual.

Connect the V8 series to the PLC

Start sampling

Open the screen where you placed the [Format] switch (memory 
card mode) and press the [Format] switch.

When formatting has been completed, sampling is enabled and data 
logging begins.

Perform formatting
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Appendix 2 SRAM/Clock Setting
Overview

The V8 series is equipped with a 512-kB built-in SRAM.
The SRAM allows you to use the following backup functions:

Primary storage target of sampling data
This area can be allocated as a backup data area of sampling data (data logging function).

Built-in clock
A clock can be incorporated into the V8 series.

Internal memory backup
When the V8 series is turned off, all data in the internal memory ($u) is cleared (reset to “0”).
You can keep the non-volatile (= data retaining) internal memory ($L/$LD) area in SRAM to retain data 
even when a power failure occurs.

Memory card emulation area
When a card recorder (SRAM memory card) is used, you can use this area as an external memory 
device (memory manager function) for a PLC or for sampling data backup (data logging function).

Saving the memo pad
When you use the memo pad function, data on the memo pad will be lost if the V8 series is turned off.  
To avoid such data loss, secure a memory area where memo pad data is retained even when the 
power is turned off.

* Note that the SRAM/clock setting will not work for data backup with the power off if no 
battery is set in the V8 series.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM PLC

Even when a power 
failure occurs, data 
in SRAM remains.V8 series

Power supply

SRAM

Primary storage target 
of sampling data

Memo pad storage area

Non-volatile memory area

Trend Sampling
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SRAM Capacity and Area Size

SRAM Capacity

The capacity of the built-in SRAM is shown below:

Area Size

The memory allocation as well as the maximum memory capacity of the built-in SRAM is shown below:

* The size for “F” (primary storage area of sampling data) varies depending on the buffering area 
setting.  The size is automatically calculated in the editor and cannot be changed.
G = The operation log storage target varies in size with the number of logging times.

MONITOUCH Model Built-in SRAM Clock Function

V815 iX, V812(i)S, 
V810(i)S, V808(i)S
V810iC, V808iC, 
V808iCH
V806iT, V806iC, 
V806iM

512 kB

V810C, V808C, 
V808CH
V806T, V806C, V806M

128 kB

512 kB 128 kB

Header area (128 words)

Header area (1024 words)

A Memory card emulation area = 260,992 words 64,384 words

Header area (16 words)

B Memo pad storage area = 262,000 words 65,392 words

Header area (32 words)

C Non-volatile word memory area
$L

= 261,984 words 65,376 words

Header area (32 words)

D Non-volatile double-word memory area
$LD

= 261,984 words 65,376 words

Header area (4 words)

E Japanese conversion function
(Fixed to 1024 words)

F Primary storage target of sampling data (For size calculation, refer to 
“Appendix 1 Buffering Area.”)

G Operation log storage target
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Setting Dialog

Select [System Setting] → [Unit Setting] → [SRAM/Clock].
The following [SRAM/Clock Setting] dialog is displayed.

 Use Built-in Clock Check this box ( ) when using the clock built in the V8 series.  For 
more information on the procedure of displaying the clock (time display 
item, calendar) on the V8 series, refer to “12  Calendar.”

SRAM Auto Format Check this box when automatically formatting SRAM.
For more information, refer to page A2-6.

Memory Card Emulation 
Area

This area is used when a card recorder (SRAM memory card) is used.  
An area is secured as an external memory device (memory manager 
function) for a PLC or for sampling data backup (data logging function).
For more information on its use, refer to page A2-4, “15.2  Memory Card 
Mode”, and “Appendix 1  Buffering Area.”

Storage Area for Memo 
Pad

An area that stores the memo pad data is secured.
For more information on the memo pad function, refer to “15.3  Memo 
Pad.”

Non-volatile Memory
(Word) ($L)

An area to be used as a non-volatile word memory area or a 
non-volatile double-word memory area is secured.
When setting a non-volatile memory, select [$L] for [Internal Memory] if 
you are using word memory; select [$LD] if you are using double-word 
memory.  The available range is determined by the memory address 
specified.
For more information, refer to page A2-4.

Non-volatile Memory
(Double-word) ($LD)

Japanese Conversion 
Function

When the Japanese conversion function is used, 1028 words are 
automatically allocated.

Primary Storage of 
Sampling

When [SRAM] is selected for [Primary storage target] in the [Buffering 
Area Setting] dialog, an area in SRAM is automatically allocated.
Each time the setting is changed, the required size is calculated 
automatically to allocate the number of words required.

* However, each time this area size change occurs, SRAM needs 
formatting.  With [  SRAM Auto Format] checked, SRAM can 
easily be used as the primary storage target.
For more information, refer topage A2-6.

[No. of Total Words, No. 
of Words Free]

The number of words used and the number of words free with the 
current setting are indicated.
Set the items within the number of words available.
For the contents of the SRAM area, refer to page A2-2.
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Memory Card Emulation Area

The memory card emulation area excluding header information is partitioned as shown below:

* For the procedure of partitioning the SRAM area, refer to “SRAM Capacity and Area Size” 
(page A2-2).

Data protection when a power failure occurs
When a power failure occurs while writing data to the memory card emulation area, the data 
transferred just before the power failure is saved in a buffering file, but the data file cannot be 
guaranteed.

Storage Area for Memo Pad

For more information on the memo pad storage area, refer to “15.3  Memo Pad.”

Non-volatile Memory
Difference between “$L (Word)” and “$LD (Double-word)”

The difference between “Word” and “Double-word” is whether the specified address (= Word) 
only is guaranteed or two words (= Double-word) from the address are guaranteed when a power 
failure occurs.
The setting ranges are shown below:

Device Name Detail Setting Range

$L Word Area 0 to 261984 (max.)

$LD Double-word area 0 to 261984 (max.)

0

1023
1024

Card information

File information

File 0

File 1

File 2

File 3

File 4

File 15 Size of file 15

Size of file 0

Size of file 1

Size of file 2

Size of file 3

Size of file 4

E
nt

ire
 fi

le
 s

iz
e
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Data protection when a power failure occurs
When a power failure occurs while writing data to $L or $LD, the data value just before writing is 
guaranteed.  (In case of $L, the top one word of data just before writing is guaranteed; in case of 
$LD, the top two words of data just before writing is guaranteed.)
When writing texts or writing multiple words simultaneously using the BMOV macro command, 
the data is not guaranteed.
* Therefore, use $LD to access two word data.  To verify whether writing was successful 

or not, check system memory address $s721 to $s726.

Japanese Conversion Function

When the Japanese conversion function is used in the entry mode, 1028 words are automatically 
allocated.

Primary Storage of Sampling
When [Primary storage target: SRAM] is selected in the [Buffering Area Setting] dialog, the required 
memory size is automatically calculated and an appropriate area is automatically allocated in SRAM.
Each time the buffering area setting is changed this size will change accordingly.
To avoid the need of manual SRAM formatting, check [  SRAM Auto Format].  SRAM will be 
formatted automatically.
For more information, refer to page A2-6.

Service Life

The service life of the SRAM area depends on the battery life.  A battery can last for about five years.
To check whether the battery voltage is lowered or not, check system memory address $s167.

Address ($s) Contents Memory Type

721 Writing result of $L address where data is written last
[0]: Normal     [1]: Error

←V
(Information is written 
from the V8 series to 
the $s memory.)

722 $L address where data is written last if $s721 indicates 
[1: Error] at power-up723

724 Writing result of $LD address where data is written last
[0]: Normal     [1]: Error

725 $LD address where data is written last if $s724 
indicates [1: Error] at power-up726

System reserved (setting “0”)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0

MSB LSB

System reserved (setting “0”)

$s167

0: Battery normal
1: Battery voltage drop
2: Battery not mounted
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SRAM Format

When you have made the settings in the [SRAM/Clock Setting] dialog, be sure to format SRAM on the 
Main Menu screen of the V8 series before using it.
For more information on the formatting procedure, refer to the V8 Series Hardware Specifications.

* If you do not execute the formatting, the message “Data has some error.  Error: 161 (or 
163)” appears and you cannot run MONITOUCH.

SRAM Auto Format

If you change the data storage target or the number of buffers for storage according to the function 
such as for sampling, the size of [Primary Storage of Sampling] set in the [SRAM/Clock Setting] dialog 
may also need changing.
In such a case, every time the size is changed SRAM needs formatting.  This formatting can be 
performed automatically.

When [  SRAM Auto Format] is checked, SRAM will automatically be formatted each time screen 
data has been transferred.  Refer to the chart shown below.

When [  SRAM Auto Format] is checked:

SRAM area Condition Auto Format

Memory Card 
Emulation Area

The size is different from the settings. No

The memory card setting or buffering area 
setting of [Secondary storage target: 
Memory Card] is made or changed.

Yes
(All the data on the memory 
card is cleared.)

Storage Area for 
Memo Pad

The size is increased. No

The size is decreased. Yes

Non-volatile Memory
(Word) ($L)
Non-volatile Memory
(Double-word) ($LD)

The size is increased.

Only the memory area 
increased is formatted while the 
existing memory area is not 
formatted.

The size is decreased.

Only the memory area 
decreased is deleted while the 
existing memory area is not 
formatted.

Japanese 
Conversion Function - No

Primary Storage of 
Sampling

The buffering area setting of [Primary 
storage target: SRAM] is made or 
changed.

Yes
(All the data at the primary 
storage target is cleared.)
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Appendix 3 Display Language
Fonts

• The outline of displaying a font on the screen is described below.
Select a base language (= font) first, and edit and place characters in the selected font on the 
screen.
For available fonts and languages, refer to the next page.

• A maximum of 16 languages can be used on the same screen just by switching the characters 
displayed.
For more information, refer to “Language Selection” on page A3-10.

• To display two or more languages on one screen or to display Windows-type characters on the 
screen, use “Windows fonts.”
For more information on the “Windows fonts,” refer to the Operation Manual.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Base language = Japanese 32 Base language = Chinese

Japanese 32 Chinese (simplified)

Screen data = JIS first & 
second levels

Screen data = GB code

Three languages can be registered within screen data “ABC.V8”.

or

Japanese

English

Chinese
(Simplified)

Korean
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Font Types

Fonts are roughly divided into three kinds: bitmap fonts, Gothic fonts, and stroke fonts.  Select one in 
the [Font Setting] dialog because their mixed use on MONITOUCH is not permitted.

Bitmap font
The font data in the size of 16  16 dots or 32  32 dots (two-byte characters) are  scaled according to the 
X/Y enlargement factors and displayed on the screen.
This font type occupies less memory but is not suitable if a smoother-line typeface is required.

Gothic font and stroke font
The font data is displayed in a specified point size.
Since the font data of each point size is transferred to MONITOUCH, the required memory capacity is 
larger than that of bitmap fonts while the displayed typeface has smoother lines.

In the case of Gothic fonts, depending on the function assigned to the part or item, some limitations, 
such as automatic or manual setting for fonts, may apply.

In the case of stroke fonts, there is no limitation that applies depending on the assigned function; 
however, there are other limitations and points to be noted.  (For more information, refer to the V8 
Series Reference Additional Functions.)

Windows fonts
No font data is stored in the MONITOUCH but the fonts used on Windows, such as 
“Times New Roman” or “Arial”, are used as image data.
For more information, refer to the V8 Series Operation Manual.
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The following lists the fonts and corresponding languages that are settable on the V8 series.

Font Setting Language Characters

Bitmap font Japanese Japanese, English JIS level 1 + level 2 + ANK 
code

Japanese 32 Japanese, English JIS level 1 + ANK code

English/Western 
Europe

English, Icelandic, Irish, Italian, 
Dutch, Swedish, Spanish, 
Danish, German, Norwegian, 
Portuguese, Finnish, Faeroese, 
French

ISO-8859-1: Latin1 (Expanded 
ASCII code)

Chinese (Traditional) Chinese (traditional), English BIG5 code (A141 to C67E) + 
ASCII code

Chinese (Simplified) Chinese (simplified), English GB2312 code (A1A1 to FEFE) 
+ ASCII code

Korean Hangul, English KS code (A1A2 to C8FE) + 
ASCII code

Central Europe Croatian, Czech, Hrvatska 
(Croatian), Hungarian, Polish, 
Romanian, Slovakian, Slovene

CP1250 code

ISO code *1
(ISO-8859-2: Latin2) 

Cyrillic Russian, Ukrainian, Kazakh, 
Bulgarian, Uzbek, Azerbaijani

CP1251 code

ISO code *1
(ISO-8859-5: Latin5) 

Greek Greek CP1253 code

ISO code *1
(ISO-8859-7: Latin7) 

Turkish Turkish CP1254 code

ISO code *1
(ISO-8859-9: Latin9) 

Baltic Estonian, Latvian, Lithuanian CP1257 code

Gothic font Gothic Japanese, English JIS level 1 + level 2 + ANK 
code

Gothic (IBM 
Extended Character)

Japanese, English JIS level 1 + level 2 + IBM 
extended code (FA40 to FC4B) 
+ ANK code

English/Western 
Europe HK Gothic

English, Icelandic, Irish, Italian, 
Dutch, Swedish, Spanish, 
Danish, German, Norwegian, 
Portuguese, Finnish, Faeroese, 
French

ISO-8859-1: Latin9 (Expanded 
ASCII code) 

English/Western 
Europe HK Times
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*1 For ISO code, select [System Setting] → [Font Setting], select the font and check the box for 
[ ISO Code].

Stroke font Japanese stroke Japanese, English JIS X 0201
JIS X 0208
NEC special characters
IBM extensions
NEC selection of IBM 
extensions

English/Western 
Europe stroke

English, Icelandic, Irish, Italian, 
Dutch, Swedish, Spanish, 
Danish, German, Norwegian, 
Portuguese, Finnish, Faeroese, 
French

CP1252 code

Chinese (Traditional) 
stroke

Chinese (traditional), English BIG5 code (A141 to F9FE) + 
ASCII code

Chinese (Simplified) 
stroke

Chinese (simplified), English GB2312 code (A1A1 to F7FE) 
+ ASCII code

Korean stroke Hangul, English KS code (A1A1 to FDFE) + 
ASCII code

Central Europe 
stroke

Croatian, Czech, Hrvatska 
(Croatian), Hungarian, Polish, 
Romanian, Slovakian, Slovene

CP1250 code

Cyrillic stroke Russian, Ukrainian, Kazakh, 
Bulgarian, Uzbek, Azerbaijani

CP1251 code

Greek stroke Greek CP1253 code

Turkish stroke Turkish CP1254 code

Baltic stroke Estonian, Latvian, Lithuanian CP1257 code

Font Setting Language Characters
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Distinguishing Fonts on MONITOUCH

The font name is displayed in the following position on the Main Menu screen.

Font names
Font names are displayed in the [Font Setting] dialog and on the Main Menu screen as listed below:

* When [  ISO Code] is checked in the [Font Setting] dialog, “CP” disappears from the Main Menu 
screen.

Font Setting On the Main Menu Screen

Bitmap font Japanese JAPANESE

Japanese 32 JAPANESE 32

English/Western Europe ENGLISH

Chinese (Traditional) CHINESE(TRAD.)

Chinese (Simplified) CHINESE(SIMP.)

Korean KOREAN

Central Europe Central Euro. CP  *

Cyrillic Cyrillic CP  *

Greek Greek CP  *

Turkish Turkish CP  *

Baltic Baltic CP

Gothic font Gothic HA Gothic

Gothic (IBM Extended Character) HA Gothic(IBM)

English/Western Europe HK Gothic HK Gothic

English/Western Europe HK Times HK Times

Stroke font Japanese stroke JAPANESE STROKE

English/Western Europe stroke ENGLISH STROKE

Chinese (Traditional) stroke CHINESE(TRD) ST

Chinese (Simplified) stroke CHINESE(SIM) ST

Korean stroke KOREAN STROKE

Central Europe stroke Cent.Eur. STROKE

Cyrillic stroke Cyrillic STROKE

Greek stroke Greek STROKE

Turkish stroke Turkish STROKE

Baltic stroke Baltic STROKE

Multi-language screen (with multiple fonts selected) MULTI LANG

F 1

F 2

F 3

F 4

F 5

SYSTEM

Font name
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Font Setting Procedure

The dialog below is provided to set the number of languages and the fonts to be displayed on 
MONITOUCH.
Open the dialog by clicking [System Setting] → [Font Setting]. 

Font

Main Menu*1

(Japanese, English, 
Chinese (Traditional), 
Chinese (Simplified), 
Korean)

Select the interface language to be displayed on the Main Menu 
screen of MONITOUCH.
Languages selectable vary with the [Font] setting.
Language change is allowed also on the Main Menu screen of 
MONITOUCH.

Font Select the desired font from [Bitmap font], [Gothic font] and [Stroke 
font].

Setting Select languages by pressing the [Setting] button.
For the operating procedure, refer to the next page.

Interface Language 
(1 to 16)

Set the number of interface languages.
Example: [2]: Language 1 to Language 2

[5]: Language 1 to Language 5

Initial Interface Language 
(1 to 16)

Select the language to be displayed at power-on.

Import Use these buttons when editing text in a language other than 
Language 1 in a Unicode text format.
For more information, refer to page A3-21.

Export
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*1 The following lists the available combinations of the [Main Menu] and [Font] options.
(Setting is possible to display the fonts checked in the [Transfer Font Setting] dialog on the Main 
Menu screen.)

 With [ ] When this box is checked, brackets “[ ]” are included in output files.
When this box is not checked, data is expressed in comma-separated 
values.

* When you open a file on Excel while this box is not checked, some 
character strings like the following will not be imported correctly.

 Output the character 
string in the switch/lamp 
in one line

This option determines how multiple lines of character strings placed 
on a switch or a lamp are output.
Checked: Lines of strings are output in one cell with the line feed code 
“\n”.
Unchecked: Strings are output line by line in separate cells.

Main Menu Font

Japanese, English Japanese

Japanese 32

Gothic

Gothic (IBM Extended Character)

Chinese (Traditional), English Chinese (Traditional)

Chinese (Simplified), English Chinese (Simplified)

Korean, English Korean

English English/Western Europe

English/Western Europe HK Gothic

English/Western Europe HK Times

Central Europe

Cyrillic

Greek

Turkish

Baltic

String in 
V-SFT

Output file
   (Standard format)

0123 123

+BK #NAME?

Leading zeros dropped
Not recognized as a 
character string

Switch Check Output Result

Checked [Error \n Screen]

Unchecked [Error]
[Screen]
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Transfer font setting

*1 The FROM capacity and the available space for font storage vary with edit models.  Do not allow 
the size of font data to exceed the available size.

Transfer Font Setting Select the font(s) to be transferred to MONITOUCH.  Selectable fonts vary, 
depending on the selection for [Font].
Selecting fonts as necessary beforehand enables language switching 
without the use of a CF card.

* The more fonts selected for transfer, the less the capacity for 
screen data becomes available.  If the total capacity is not 
sufficient, do not select fonts that are not necessary.

Font Memory (Used) This field shows the total memory size used for the fonts for transfer 
currently selected.

Font Memory 
(Available)

This field shows the memory space still available for fonts.*1   

Screen Memory 
(Used)

This field shows the data size used for the screen in process of creation.

Screen Memory 
(Available)

This field shows the memory space still available for screen data.*1   

Calculate Memory This button calculates the volume of data from the current settings.

Edit Model

Max. Font Storage Capacity Max. Screen Data 
Storage Capacity
(Including Fonts)

FROM

FROM CF Card

V815iX
V812(i)S
V810(i)S, V810(i)T
V808(i)S

8 MB 6 MB 13.25 MB

V810iC, V808iC
V808iCH

8 MB 2 MB 13.25 MB

V810C, V808C
V808CH

2 MB 2 MB 5.25 MB

V806(i)T, V806(i)C, V806(i)M 2 MB 2 MB 5.25 MB

Gothic fonts

Stroke fonts

Bitmap fonts
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Manual font setting
Two types exist in Gothic/Times fonts: one is automatic setting type and the other is manual setting 
type, for which you need to set the size manually.  For items using fonts of the manual setting type, 
mainly character and message displays, you need to specify the font sizes in their dialogs, [Char. 
Display] and [Message Display].
For more information, refer to “Appendix 1” in the Operation Manual.

• Multi-language selection
Note that the setting for [  1-Byte] of each point size of Language 1 (e.g. Gothic) affects the 
setting of Language 2 (e.g. English/Western Europe HK Gothic).
If you change the setting for either language, the setting for the other will also be changed.

All settings made for Language 1 also apply to Language 2.
Any changes to the settings for Language 1 affect that for Language 2.

Language 1 Language 2
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• Font of the automatic setting type
When multi-language selection is used, the font of the automatic setting type selected for 
Language 1 will automatically be transferred to MONITOUCH together with the screen data.  
However, recognition as the automatic setting type is not made for Language 2 and later.
For Language 2 and later, regard their fonts as those of the manual setting type and set the 
[Manual Font Setting] tab window as necessary.

Language Selection

It is possible to change the language selection without changing the screen.

Language Selection Types

There are five language selection types available.

Language Selection Types and Fonts

Depending on the transfer font settings and presence or absence of CF card, available language 
selection types and fonts vary.

A. Multi-language selection (CF card not used, selection in RUN mode)
B. Multi-language selection (CF card used, selection in RUN mode)

CF Card Selection in 
RUN Mode

Windows 
Fonts

Transfer Font Type See:

Not used Yes Not used
Multi-language A. Multi-language selection (page A3-14)

One language D. Displayed character 
selection

(page A3-17)

Used Yes Not used One language B. Multi-language selection (page A3-15)

Not used Yes Used One language C. Multi-language selection (page A3-16)

Not used No - One language E. Multi-language screen (page A3-17)

Font Language Selection Example

Bitmap fonts Japanese
Japanese 32
English/Western Europe
Chinese (Traditional)
Chinese (Simplified)
Korean
Central Europe
Cyrillic
Greek
Turkish
Baltic

Japanese (Japanese 32)
↓ ↑

Taiwanese (Chinese (Traditional))
↓ ↑

Hangul (Korean)
↓ ↑

Czech (Central Europe)
↓ ↑

Turkish (Turkish)

Gothic fonts Gothic
English/Western Europe HK Gothic
English/Western Europe HK Times

 Japanese (Gothic)
↓ ↑

 German (English/Western Europe HK 
Gothic)

Stroke fonts Japanese stroke
English/Western Europe stroke
Chinese (Traditional) stroke
Chinese (Simplified) stroke
Korean stroke
Central Europe stroke
Cyrillic stroke
Greek stroke
Turkish stroke
Baltic stroke

Japanese (Japanese stroke)
↓ ↑

Chinese (Chinese (Simplified) stroke)
↓ ↑

Spanish (English/Western Europe stroke)
↓ ↑

German (English/Western Europe stroke)
↓ ↑

Turkish (Turkish stroke)

Switching to a different 
font is not possible.



Appendix 3    Display Language

A3-11

A3

C. Multi-language selection (CF card not used, selection in RUN mode, Windows 
fonts used)

* Some limitations are imposed associated with the use of Windows fonts.
For more information, refer to the Operation Manual.

Font Language Selection Example

Bitmap fonts Japanese

Japanese (MS Gothic)
↓ ↑

Chinese (SimSun)
↓ ↑

Spanish (SimSun)

                 
Taiwanese (MingLiU)

↓ ↑
Japanese (MS PGothic)

↓ ↑
Hangul (Batang)

 German (Arial Unicode MS)
↓ ↑

Turkish (Arial Unicode MS)
↓ ↑

Czech (Arial Unicode MS)

Japanese 32

English/Western Europe

Chinese (Traditional)

Chinese (Simplified)

Korean

Central Europe

Cyrillic

Greek

Turkish

Baltic

Gothic fonts Gothic

English/Western Europe HK Gothic

English/Western Europe HK Times

Stroke fonts Japanese stroke

English/Western Europe stroke

Chinese (Traditional) stroke

Chinese (Simplified) stroke

Korean stroke

Central Europe stroke

Cyrillic stroke

Greek stroke

Turkish stroke

Baltic stroke

Only one language 
is selectable for 
data transfer to 
MONITOUCH.
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D. Displayed character selection (CF card not used, selection in RUN mode, 
Windows fonts not used)

Font Language Target Characters

Bitmap fonts Japanese Japanese ← → English

Japanese 32 Japanese ← → English

English/Western Europe Western European language ← → 
English

Chinese (Traditional) Chinese (Traditional) ← → English

Chinese (Simplified) Chinese (Simplified) ← → English

Korean Korean ← → English

Central Europe Central European language ← → 
English

Cyrillic Cyrillic language ← → English

Greek Greek ← → English

Turkish Turkish ← → English

Baltic Baltic language ← → English

Gothic fonts Gothic Japanese ← → English

English/Western Europe HK Gothic Western European language ← → 
English

English/Western Europe HK Times Western European language ← → 
English

Stroke fonts Japanese stroke Japanese ← → English

English/Western Europe stroke Western European language ← → 
English

Chinese (Traditional) stroke Chinese (Traditional) ← → English

Chinese (Simplified) stroke Chinese (Simplified) ← → English

Korean stroke Korean ← → English

Central Europe stroke Central European language ← → 
English

Cyrillic stroke Cyrillic language ← → English

Greek stroke Greek ← → English

Turkish stroke Turkish ← → English

Baltic stroke Baltic language ← → English

Only one language 
is selectable for 
data transfer to 
MONITOUCH.
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E. Multi-language screen (no selection in RUN mode = screen data exchange)

Font Language Selection Example

Bitmap fonts Japanese
Japanese 32
English/Western Europe
Chinese (Traditional)
Chinese (Simplified)
Korean
Central Europe
Cyrillic
Greek
Turkish
Baltic

Japanese (Japanese 32)
↓ ↑

Chinese (Chinese (Simplified))
↓ ↑

Spanish (English/Western Europe)

Taiwanese (Chinese (Traditional))
↓ ↑

Japanese (Japanese 32)
↓ ↑

Hangul (Korean)

Gothic fonts Gothic
English/Western Europe HK Gothic
English/Western Europe HK Times

Japanese (Gothic)
↓ ↑

German (English/Western Europe HK 
Gothic)

Stroke fonts Japanese stroke
English/Western Europe stroke
Chinese (Traditional) stroke
Chinese (Simplified) stroke
Korean stroke
Central Europe stroke
Cyrillic stroke
Greek stroke
Turkish stroke
Baltic stroke

German (English/Western Europe stroke)
↓ ↑

Turkish (Turkish stroke)
↓ ↑

Czech (Central Europe stroke)

Switching to a different 
font is not possible.
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A. Multi-language Selection (CF Card Not Used, Selection in RUN 
Mode)

• The language can be changed in RUN mode using the same screen data file.
• Without using the CF card, you can change characters (Japanese ←→ Chinese (simplified) ←→ 

Korean ←→ Chinese (traditional)) without changing the screen data.
Store required fonts in MONITOUCH in advance.

• To change the language in RUN mode, use the CHG_LANG macro command.
(For more information on macro commands, refer to page A3-27.)

• Up to eight languages can be changed.
• For more information on the setting procedure, etc., refer to page A3-18.
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disc

Chinese (Simplified)

Japanese Korean Chinese (Traditional)

Japanese

Using the macro command, only the language font is changed without 
changing the screen data.

Set the [Font Setting] dialog, 
check necessary fonts in the 
[Transfer Font Setting] tab 
window, and transfer the data 
to MONITOUCH.

Which language do you prefer?

Japanese Korean

Switch “Korean”
ON macro
SYS (CHG_LANG) 

Screen No. 0

Screen No. 1

Switch “Japanese”
ON macro
SYS (CHG_LANG) 
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B. Multi-language Selection (CF Card Used, Selection in  RUN Mode)

• By using the CF card, you can change characters (Japanese ←→ Chinese (simplified) ←→ 
Korean ←→ Chinese (traditional)) without changing the screen data.

* The CF card must be inserted at all times.

• Font data saving to the CF card reduces the memory space occupied by the screen data.
• To change the language in RUN mode, use the CHG_LANG macro command.

(For more information on macro commands, refer to page A3-27.)
• Up to 16 languages can be changed.
• For more information on the setting procedure, etc., refer to page A3-30.
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Chinese (Simplified)

Japanese Korean Chinese (Traditional)

Japanese

Using the macro command, only the language font is 
changed without changing the screen data.

Store required fonts on the 
CF card in advance.



Appendix 3    Display Language

A3-16

C. Multi-language Selection (CF Card Not Used, Selection in RUN 
Mode, Windows Fonts Used)

• You can change the language in RUN mode, using the same screen data file.
• Without using the CF card, you can change characters (Japanese ←→ Chinese (simplified) ←→ 

Korean ←→ Chinese (traditional)).
Since Windows fonts are used it is sufficient to store only one font in MONITOUCH.

• To change the language in RUN mode, use the CHG_LANG macro command.
(For more information on macro commands, refer to page A3-27.)

• Up to 16 languages can be changed.
• For more information on the Windows fonts, refer to the Operation Manual.
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Using the macro command, only the language font is 
changed without changing the screen data.
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D. Displayed Character Selection (CF Card Not Used,  Selection in 
RUN Mode, Windows Fonts Not Used)

• You can change the characters displayed in RUN mode using the same screen data file.
• Even if you use a single font, you can change characters, such as German ←→ Italian, and 

display them.

• If you execute the CHG_LANG macro command and change the screen in RUN mode, the 
characters displayed will be changed.  (For more information on macro commands, refer to page 
A3-27.)

• Characters in up to 16 languages can be changed.
• For more information on the setting procedure, etc., refer to page A3-36.

E. Multi-language Screen (No Selection in RUN mode, Screen Data 
Reloading Required)

• You can register multiple languages using the same screen data file.
However, you cannot change the language in RUN mode.  Language selection is available by 
reloading the screen data setting in the target language for each situation.

• You do not need to manage multiple screen data for each language when storing the screen data.

• For more information on the setting procedure, etc., refer to page A3-39.

Buongiorno Guten Morgen
German Italian

The screen of Language 2 
(English/Western Europe)

The screen of Language 1 
(English/Western Europe)

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

RESET

disc One kind of screen data only
Language 1: Japanese
Language 2: Chinese (Simplified)

Change the settings for [Initial Interface 
Language] and [Transfer Font Setting] 
when transferring data.

[Initial Interface Language: 2]
[Transfer Font Setting: Chinese (Simplified)]

[Initial Interface Language: 1] 
[Transfer Font Setting: Japanese]

Chinese (Simplified)Japanese
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A. Multi-language Selection (CF Card Not Used, 
Selection in RUN Mode)

This section explains the setting procedure for changing the language in a different font in RUN mode 
(assuming that the Language 1 setting has been completed).

Setting Procedure

1. Font setting (page A3-18)
2. Multi-language editing (page A3-20)
3. CHG_LANG macro command setting (page A3-27)
4. Layout check (page A3-28)
5. Screen data transfer (page A3-35)

1. Font Setting

Set the number of languages to be used and the languages to be added.

Step 1 Click [System Setting] → [Font Setting].
The [Font Setting] dialog is displayed.

Step 2 Set the [Interface Language] according to the number of languages to be used.
Example: “3” for switching among languages 1 to 3

Step 3 Select the desired font type for [Font].  Under the [Font], select languages to be 
displayed.
Example: Language 1: English

Language 2: Chinese (Simplified)
Language 3: Korean

Step 4 Select a language number for [Initial Interface Language] so that the corresponding 
language is displayed at power-on.
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Step 5 Select the desired interface language for [Main Menu].  The language is to be displayed 
on the system screen (= Main Menu screen) on MONITOUCH.

Step 6 Open the [Transfer Font Setting] tab window.  Select the fonts to transfer to 
MONITOUCH.  This window setting enables you to switch languages without using a CF 
card.

* The more fonts selected for transfer, the less the capacity for screen data 
becomes available.  If the total capacity is not sufficient, do not select fonts 
that are not necessary.
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2. Multi-language Editing

This section explains the multi-language editing procedure on the condition that the computer used is 
capable of foreign language editing on Microsoft Windows.

* For the setting and notes for editing foreign languages on a Japanese Windows computer, 
refer to the Operation Manual.

When editing on the multi-language window:
Bring up the text in Language 1 used for screen data on the [Multi-language Edit] window, and enter 
the desired text in another language.
Follow the steps below.

Step 1 Open the screen data and click [Registration Item] → [Multi-language].  The 
[Multi-language [0] Edit] window is displayed.

Step 2 Enter the text in Language 2 and later directly on the [Multi-language [0] Edit] 
window.

* Text editing of Language 1 cannot be performed on the [Multi-language Edit] 
window.

Edit

Edit
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Notes
• It is not possible to know in which item each text is used.
• You can edit text using another application software (e.g.: Word, Excel, etc.) and paste it on the 

[Multi-language Edit] window.  Paste text by right-clicking on the screen with the cursor displayed.

When editing in Unicode text format:
In this section, the text of the screen data in Language 1 is output in Unicode text format (extension: 
.txt).  Following the process, the text in another language is edited in Unicode text format.  Finally the 
edited data is imported to the screen data.
Since Unicode text is editable on Excel, translation and editing are allowed while two languages are 
shown side by side on Excel.
Follow the steps below.

Word

Step 1 Select [System Setting] → [Font Setting].
The [Font Setting] dialog is displayed.
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Step 2 Click the [Export] button.
The [Save As] dialog is displayed.  “*.txt” is selected for [Save as type].

In this example, the option [  With [ ]]is checked before the [Export] button is pressed.

Step 3 Click the [Save] button.
The file is saved in Unicode text format.
Example

Language 1 “Test.txt”
Language 2 “Test_2.txt”

Step 4 Start Excel.
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Step 5 Select the Unicode text file you have exported, and drag and drop the file on Excel.

Step 6 Unicode text is displayed on Excel.

Step 7 Edit the text as desired.  (In the example below, Chinese (simplified) is input).

Test_2.txt
Drag and drop
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* The Unicode text file in Language 1 cannot be imported.  However, save the file as it is 
because it is necessary for other files in Languages 2 to 16 to be imported.

* Unicode text file import must be performed for each language.

Step 8 To save the file, select [File] → [Save As].
The [Save As] dialog is displayed.

Step 9 Select “Unicode Text (*.txt)” for [Save as type] and save the file under the same filename.

Step 10 In the [Font Setting] dialog in the V-SFT, click the [Import] button.  Select the Unicode text 
file saved in step 9.  Importing the file is complete.

* Save Unicode text files in Languages 1 to 16 to the same place, under the original 
names.
File importing will be impossible if any Unicode text file is renamed or the file in 
Language 1 is deleted.    
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When directly editing text on items on the screen:
Text in Language 2 and later can be edited on the screen in the same way as Language 1.
Follow the steps below.

Step 1 Specify the interface language number for [Language] on the toolbar.
When a value other than “1” is set, the interface language changes.

Step 2 Edit text in the desired language on each item.

In addition, you can check on the [Entry] dialog for each item that a number other than 
“1” is specified for [Display Language].  The interface language number can be 
changed from the drop-down menu of [Display Language].

Language 1

Language 2
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(Supplementary 
information)

It is also possible to select [View] → [Display Environment].  The setting for [Display 
Language] can be changed in the [Display Environment] dialog. 
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3. CHG_LANG Macro Command Setting
Overview
You can set the interface language that is displayed at first by selecting [System Setting] → [Font 
Setting] and selecting the desired language for [Initial Interface Language] in the [Font Setting] dialog.  
To change the language in RUN mode, you can perform “CHG_LANG” in the SYS macro command.

* The interface language is switched over when the screen is changed after the macro 
command has been executed.  For switching the interface language on the same screen, 
use the macro command “RESET_SCRN”.

Macro command (CHG_LANG F1)
Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Editing procedure
For more information on macro editing, refer to the Macro Reference Manual.

Which language do you prefer?

Japanese Korean

Example:
Set the interface language using the ON macro of the screen change switch.
If you press the “Japanese” switch, the screen changes to the next screen, which will be displayed 
in Japanese.  If you press the “Korean” switch, the screen changes to the next screen, which will 
be displayed in Korean.

Switch “Japanese”
Function  Screen No.1
Use ON Macro
ON Macro Edit
$u00100 = 0 (W) 
SYS (CHG_LANG) $u00100

Switch “Korean”
Function  Screen No.1
Use ON Macro
ON Macro Edit
$u00100 = 1 (W) 
SYS (CHG_LANG) $u00100

Screen No. 0

Screen No. 1

With either switch, the interface 
language can be switched over 
when you open screen No. 1.

Internal Memory PLC1 - PLC8 
Memory

Memory Card Constant

F1

Value Remarks

F1 0: Language 1
1: Language 2

15: Language 16

Although the setting range for [Interface Language] in the [Font 
Setting] dialog and [Display Language] in the [Display 
Environment] dialog is “1” to “16”, the range for “CHG_LANG” 
is “0” to “15”.
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4. Layout Check

When screen data editing has been completed, be sure to check the layout of each language on the 
configuration software.

Checking procedure

Step 1 Specify the interface language number for [Language] on the toolbar.
When a value other than “1” is set, the interface language changes.

(Supplementary 
information)

It is also possible to select [View] → [Display Environment].  The setting for [Display 
Language] can be changed in the [Display Environment] dialog.

Language 1

Language 2
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Notes on layout
• Character properties are used commonly for all languages.

It is possible to change [Enlarge X/Y] or color setting for certain languages.

• Positions of Language 2 and later are determined based on those of Language 1.
For example, if you align texts on the switches at the center for Language 1, texts in Language 2 
are displayed as shown below.

To avoid such a problem in layout, the font size of the second language can be changed.

5. Screen Data Transfer

When all the prerequisites have been completed, transfer the screen data to MONITOUCH.
When the data has been transferred, select RUN mode.
The language selected for [Initial Interface Language] in “1. Font setting” is displayed first.

When you execute the CHG_LANG macro command and display a screen, the corresponding 
language is displayed.

RUN

Stop

Manual

Language 1 (English) Language 2 (German)

If you create a switch in a size that 
fits a short text, the German text 
may not be kept in the switch.

RUN

Stop

Manual

Language 1 (English) Language 2 (German)

Change the font size to German.

F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER
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B. Multi-language Selection (CF Card Used, Selection 
in RUN Mode)

This section describes the procedure for switching over languages in RUN mode using different fonts.
(The procedure is explained assuming that the setting for Language 1 has been completed.)

Setting Procedure

1. Font setting (page A3-30)
2. Multi-language editing (page A3-31)
3. CHG_LANG macro command setting (page A3-31)
4. Layout check (page A3-31)
5. Writing the font file to a CF card (page A3-32)
6. Screen data transfer (page A3-35)

1. Font Setting

Set the number of languages to be used and the languages to be added.

Step 1 Click [System Setting] → [Font Setting].
The [Font Setting] dialog is displayed.

Step 2 Set the [Interface Language] according to the number of languages to be used.
   Example: “3” for switching among languages 1 to 3

Step 3 Select the desired font type for [Font].  Under the [Font], select languages to be 
displayed.
Example: Language 1: English

Language 2: Chinese (Simplified)
Language 3: Korean
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2. Multi-language Editing

The editing procedure is the same as that for “A. Multi-language Selection.”
For more information, refer to page A3-20.

3. CHG_LANG Macro Command Setting

The setting procedure is the same as that for “A. Multi-language Selection.”
For more information, refer to page A3-27.

4. Layout Check

The checking procedure is the same as that for “A. Multi-language Selection.”
For more information, refer to page A3-28.

Step 4 Select a language number for [Initial Interface Language] so that the corresponding 
language is displayed at power-on.

Step 5 Select the desired interface language for [Main Menu].  The language is to be displayed 
on the system screen (= Main Menu screen) on MONITOUCH.

Step 6 Language 1 (English) is automatically to be transferred.  Do not check the boxes for 
other languages.  A CF card is used to store the font data instead of data transfer to 
MONITOUCH.

* The more fonts selected for transfer, the less the capacity for screen data 
becomes available.  If the total capacity is not sufficient, do not select fonts 
that are not necessary.
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5. Writing the Font File to a CF Card

To perform a multi-language selection using CF cards, you need to store the font file for Language 2 
and later on a CF card.  Then insert it into MONITOUCH.

Storing procedure
The procedure for storing font data for Language 2 and later are described below:

Step 1 Open the V8 screen data file that you completed in the multi-language setting, and 
select [System Setting] → [CF Card Setting].  The [CF Card] dialog is displayed.

Step 2 Enter the desired folder name for [Access Folder Name].  (Max: 32 one-byte 
numerals or uppercase alphabetic characters)
This folder name is used for recognizing screen data to which the font on the CF card 
corresponds.

Step 3 Save the screen data file of step 2.

Step 4 Insert the CF card into your computer.

Step 5 Select [File] → [CF Card Manager].
The following dialog is displayed:
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Step 6 Specify the drive where the CF card is inserted and click [OK].  The CF Card 
Manager will start.

* What is the CF Card Manager?
The CF Card Manager is an application software that allows you to write the data 
to be used in the V8 series to a CF card, or to import data from a CF card and 
convert it into another file format.
For more information, refer to “18.4  CF Card Manager” (page 18-49).

Step 7 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.

Step 8 If the data is being edited, check the box for [  Write Data Being Edited].
If not, uncheck the box for [  Write Data Being Edited].  Click the [Open] button for 
[Path of File to Be Converted] and select the “*.V8” file that is to be written to the CF 
card.

Step 9 Click [OK].
The font files are saved to the “FONT” folder under the access folder on the CF card.
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Structure in the CF card
Fonts are stored as shown below:

* The fonts other than the font for Language 1 are stored on the CF card.

When you insert this CF card into MONITOUCH to which you transfer the multi-language screen data, 
multi-language selection becomes possible.

Bitmap
Card
Dsp

Font
Hdcopy

File01

Dsp0000.bin

. . .

Bitmap

Sram

Card
Dsp
Font

Hdcopy
Jpeg
Memo
Recipe
Sample
Snap

Wav
Webserv

Dat0000

Fnt_chn.ftd
Fnt_kor.ftd

(= Access folder)

CF card

(= Access folder)

Language 2, etc

Store Target:
Access folder\Font

File Name:

Font File Name

Japanese Fnt_jpn.ftd

Japanese 32 Fnt_jpn2.ftd

English/Western Europe Fnt_eng.ftd

Chinese (Traditional) Fnt_twn.ftd

Chinese (Simplified) Fnt_chn.ftd

Korean Fnt_kor.ftd

Central Europe Fnt105.ftd

Cyrillic Fnt106.ftd

Greek Fnt107.ftd

Turkish Fnt109.ftd

Baltic Fnt110.ftd

Gothic Fnt006.ftd, Fnt0062.ftd

Gothic (IBM Extended Character) Fnt012.ftd, Fnt0122.ftd

English/Western Europe HK Gothic Fnt008.ftd, Fnt0082.ftd

English/Western Europe HK Times Fnt009.ftd, Fnt0092.ftd

Japanese stroke FNT020.FTD

English/Western Europe stroke FNT021.FTD

Chinese (Traditional) stroke FNT022.FTD

Chinese (Simplified) stroke FNT023.FTD

Korean stroke FNT024.FTD

Central Europe stroke FNT025.FTD

Cyrillic stroke FNT026.FTD

Greek stroke FNT027.FTD

Turkish stroke FNT028.FTD

Baltic stroke FNT029.FTD
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6. Screen Data Transfer

When all the prerequisites have been completed, transfer the screen data to MONITOUCH.
When the data has been transferred, insert the CF card (step 4) into MONITOUCH and select RUN 
mode.
The language selected for [Initial Interface Language] in “1. Font setting” is displayed first.

When you execute the CHG_LANG macro command and display a screen, the corresponding 
language is displayed.

C. Multi-language Selection (CF Card Not used, 
Selection in Run Mode, Windows Fonts Used)   

Using the Windows fonts, it is possible to display multiple languages while switching them in RUN 
mode.
For the editing procedures as well as notes on the Windows fonts, refer to the Operation Manual.

F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER
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D. Display Character Selection (CF Card Not Used, 
Selection in RUN Mode, Windows Fonts Not Used)

This section describes the procedure for switching over characters of different languages in RUN 
mode using the same font.

* The procedure is explained assuming that the setting for Language 1 has been completed.

Setting Procedure

1. Font setting (page A3-36)
2. Displayed character editing (page A3-36)
3. CHG_LANG macro command setting (page A3-27)
4. Layout check (page A3-28)
5. Screen data transfer (page A3-35)

1. Font Setting

The setting procedure is almost same as the “Multi-Language Selection” (refer to page A3-18) 
described before.
However, note that in the [Font Setting] dialog, the same language must be specified for Languages 1 
to 16.

Only one font type you set is downloaded to MONITOUCH.
(The downloaded font is indicated on the Main Menu screen.)

2. Displayed Character Editing

Edit characters in Language 2 (or later) that correspond to the original characters in Language 1.
The editing procedure is the same as that for multi-language selection.

F 1

F 2

F 3

F 4

SYSTEM

Font setting of screen data
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When editing on the multi-language window:
Bring up the text in Language 1 used for the screen data on the [Multi-language Edit] window, and 
enter the desired text in another language.
Follow the steps below.

Notes
• It is not possible to know in which item each text is used.
• You can edit text using another application software (e.g. Word, Excel, etc.) and paste it on the 

[Multi-language Edit] window.  Paste text by right-clicking on the screen with the cursor displayed.

When importing from Unicode text file:
For more information, refer to page A3-21.

Step 1 Open the screen data and click [Registration Item] → [Multi-language].  The 
[Multi-language [0] Edit] window is displayed.

Step 2 Enter the text in Language 2 and later directly on the [Multi-language [0] Edit] 
window.

* Text editing of Language 1 cannot be performed on the [Multi-language Edit] 
window.

Select the same font of [Language 2] as that of [Language 1].

Edit
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When directly editing text on items on the screen:
For more information, refer to page A3-25.

3. CHG_LANG Macro Command Setting

The setting procedure is the same as that for multi-language selection.
For more information, refer to page A3-27.

4. Layout Check

The checking procedure is the same as that for multi-language selection.
For more information, refer to page A3-28.

5. Screen Data Transfer

The setting procedure is the same as that for multi-language selection.
For more information, refer to page A3-35.
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E. Multi-language Screen (Screen Data Reloading)

This section describes the setting procedure for managing multiple languages in different fonts in the 
same screen data file and transferring the font for one language to MONITOUCH when it is required.

* The procedure is explained assuming that the setting for Language 1 has been completed.

Setting Procedure

1. Font setting
2. Displayed character editing
3. Layout check
4. Screen data transfer

1. Font Setting

The setting procedure is the same as that for multi-language selection.
For more information, refer to page A3-18.

2. Displayed Character Editing

Edit characters in Language 2 (or later) that correspond to the original characters in Language 1.
The editing procedure is the same as that for multi-language selection.

When editing on the multi-language window:
For more information, refer to page A3-25.

When importing from Unicode text file:
For more information, refer to page A3-24.

When directly editing text on items on the screen:
For more information, refer to page A3-25.

3. Layout Check

The checking procedure is the same as that for multi-language selection.
For more information, refer to page A3-28.
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4. Screen Data Transfer

Since language selection is not allowed in the RUN mode, it is necessary to load the font data each 
time language selection is made.  Follow the steps below.

Example:
Language 1: English
Language 2: Chinese (Simplified)
Language 3: Korean

Step 1 When transferring Chinese screens to MONITOUCH:
Open the multi-language screen data.

Step 2 Click [System Setting] → [Font Setting].  Set “2” for [Initial Interface Language].

Step 3 Open the [Transfer Font Setting] tab window.  Check [Chinese (Simplified)] and click 
[OK].
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Step 4 Transfer the screen data.
The Chinese font is transferred to MONITOUCH and the MONITOUCH screen is 
displayed in Chinese.

Step 5 Transfer screen data.
The Chinese font is transferred to MONITOUCH and the MONITOUCH screen is 
displayed in Chinese.

Step 6 Open the [Transfer Font Setting] tab window.  Check [Korean] and click [OK].

Step 7 Transfer screen data.
The Korean font is transferred to MONITOUCH and the MONITOUCH screen is 
displayed in Korean.
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Please use this page for notes.
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Appendix 4 Styles and Coordinates
Character properties of items and parts as well as part designing options are almost the same for 
every setting dialog.
This section explains these setting items that are commonly used for items and parts.

Style

Applicable Items

The following items apply to the explanation in this section:

Part Menu Item Menu Name Refer to:

Overlap Normal Overlap Style
page A4-9

Switch
Switch, Lamp

Style

Lamp Text page A4-4

Data Display

Data Display (numerical, character, 
message)

Style page A4-7

Table Data Display (all) Style page A4-9

Table Data Display (respective data) Style page A4-7

Message Message Style page A4-2

Graph
Graph (bar, pie, closed area, panel meter) Style

page A4-9

Statistic Graph (bar, pie) Style

Trend Graph

Trend Graph Style

Trend Sampling Style

Data Sampling Area Style

Alarm

Alarm Tracking Style

page A4-2

Bit Order Alarming Style

Alarm Sub Display Style

Time Order Alarming Style

Alarm Logging Style

− Display Area Style
page A4-9

Calendar
Calendar Style

Time Display Style page A4-7

Recipe Recipe Style
page A4-2

Others Memory Card Style
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Message Display Type

This is applicable to the [Style] tab window for bit order alarming, alarm tracking and memory card 
mode.

Setting dialog

1 Color
(Foreground, 
Background)

Set the color for text.

When [Transparent] is not selected (refer to “Transparent” item), be 
sure to set the background color.

2 Property Select the bold, shadow or italic typeface for text.

1

2

4

5

3

6

Background colorForeground color

ABCD Background color

Foreground color

ItalicBold

Shadow

ABCD Background color

Foreground color

[Shadow]

ABCD
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3 Transparent Select whether or not to make text background transparent.

4 Enlarge
(1 to 8)

Specify enlargement factor for text.

* If you select [System Setting] → [Font Setting] and select [Gothic] 
(or Gothic (IBM Extended Character)), [English/Western Europe 
HK Gothic] or [English/Western Europe HK Times], and check 
the box for [  Windows Font], this setting is disabled.

5 Points
(8 to 72)

If you select [System Setting] → [Font Setting] and select [Gothic] (or 
Gothic (IBM Extended Character)), [English/Western Europe HK 
Gothic] or [English/Western Europe HK Times], and check the box for 
[ Windows Font], this setting is disabled.
Set text size.

6  Windows Font Check the box when using Windows font.
For more information on the Windows fonts, refer to the Operation 
Manual.

ABCD
Background color

Foreground color

[Not Transparent]

ABCD
Foreground color

[Transparent]

Not TransparentTransparent
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Switch and Lamp

For switch and lamp parts, set text style in the [Text] tab window.
For more information on the [Style] tab window for switch and lamp parts, refer to page A4-9.

Setting dialog

1 Text entry area Enter text to be displayed on the switch or lamp part.
(Up to 4 lines can be registered.  Text properties can be set line by 
line.)
The OFF text can be entered in the [OFF] tab window; the ON text 
can be entered in the [ON] tab window.

2 Color
(Foreground, 
Background)

Set the color for text.

When [Transparent] is not selected (refer to “Transparent” item), be 
sure to set the background color.

2

3

5
6
7

4

8

9
10
12

14
15

16

11

13

1

Background colorForeground color

ABCD Background color

Foreground color
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3 Property Select the bold, shadow, 1/4 or italic typeface for text.

 * This is active when [Enlarge X] is set to “1”.

4 Transparent Select whether or not to make text background transparent.

5 Enlarge
(1 to 8)

Specify enlargement factor for text.

* If you select [System Setting] → [Font Setting] and select [Gothic] 
(or Gothic (IBM Extended Character)), [English/Western Europe 
HK Gothic] or [English/Western Europe HK Times], and check 
the box for [  Windows Font], this setting is disabled.

6 Points
(8 to 72)

If you select [System Setting] → [Font Setting] and select [Gothic] (or 
Gothic (IBM Extended Character)), [English/Western Europe HK 
Gothic] or [English/Western Europe HK Times], and check the box for 
[  Windows Font], this setting is disabled.
Set text size.

7 Rotation + Direction Set the combination of text rotation or direction.
Four combinations are displayed in the drop-down menu.

When selecting an option other than the above, click the icon at the 
bottom.  The dialog that allows selection from all options is displayed:

ItalicBold

Shadow

ABCD Background color

Foreground color

[Shadow]

ABCD

1/4

ABCD
Background color

Foreground color
[Not Transparent]

ABCD
Foreground 
color

[Transparent]

Not TransparentTransparent

Click this icon when you want to see other options.



Appendix 4    Style

A4-6

8  Windows Font Check the box when using Windows font.
For more information on the Windows fonts, refer to the Operation 
Manual.

9  Use the Same 
Property for All 
Patterns

When this box is checked, properties in this dialog are applied to all 
patterns (OFF, ON, P3 to P128) of switch and lamp parts (to 
respective lines if multiple lines are included).

10  Size Automatic 
Adjustment

When this box is checked, the switch or lamp part size is 
automatically adjusted to the text you entered.

11  4-Line Display This is valid when [  Windows Font] is checked.
When this box is checked, the text entry area is divided into four 
lines.  In this condition, different properties can be specified for each 
line in Windows font.

For more information on the Windows fonts, refer to the Operation 
Manual.

12 Alignment Set text alignment.

13 Text copy
 Copy only 
characters

Text and its attributes of the current pattern (OFF, ON, P3) are copied 
to the other patterns.

 Copy only characters
With this box checked, text and coordinate information are copied to 
the other patterns.  Text properties will not be copied though.  If the 
destination for copy has no text, text properties will also be copied.

14  Retain the 
coordinates when 
changing character 
string

Newly registered text is placed by centering.
When any registered text is changed while this box is checked, the 
coordinates remain the same.
When a line is added to the existing text while this box is checked, 
the additional line is aligned with the upper line.

15  Pitch Set the pitch between lines.

16 Display Language This setting is effective when you create multi-language screen data.
For more information, refer to “Appendix 3  Display Language.”

Flush RightFlush Left

Center
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Data Display

This is applicable to the [Style] tab window for numerical data display, character display and message 
display.

Setting dialog

1 Color
(Foreground, 
Background)

Set the color for text.

When [Transparent] is not selected (refer to “Transparent” item), be 
sure to set the background color.

2 Property Select the bold*, shadow, 1/4 or italic typeface for text.

  * This is active when [Enlarge X] is set to “1”.

1

2

4

5

6

3

7

8

9

10

1211

Background colorForeground color

ABCD Background color

Foreground color

ItalicBold

Shadow

ABCD Background color

Foreground color

[Shadow]

ABCD

1/4
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3 Transparent *1 Select whether or not to make text background transparent.

4 Enlarge
(1 to 8)

Specify enlargement factor for text.

* If you select [System Setting] → [Font Setting] and select [Gothic] 
(or Gothic (IBM Extended Character)), [English/Western Europe 
HK Gothic] or [English/Western Europe HK Times], and check 
the box for [  Windows Font], this setting is disabled.

5 Points
(8 to 72)

If you select [System Setting] → [Font Setting] and select [Gothic] (or 
Gothic (IBM Extended Character)), [English/Western Europe HK 
Gothic] or [English/Western Europe HK Times], and check the box for 
[ Windows Font], this setting is disabled.
Set text size.

6 Rotation + Direction Set the combination of text rotation or direction.
Four combinations are displayed in the drop-down menu.

When selecting an option other than the above, click the icon at the 
bottom.  The dialog that allows selection from all options is displayed:

7  Spacing *2
(0 to 64)

When this box is checked, you can specify spacing between 
characters.

8 Character Size *3
(1-Byte, 2-Byte)

Choose one-byte or two-byte for displaying numerical data

9  Windows Font Check the box when using Windows font.
For more information on the Windows fonts, refer to the Operation 
Manual.

10 Display Language This setting is effective when you create multi-language screen data.
For more information, refer to “Appendix 3  Display Language.”

ABCD
Background color

Foreground color

[Not Transparent]

ABCD
Foreground 
color

[Transparent]

Not TransparentTransparent

Click this icon when you want to see other options.
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*1 For transparent setting for data display parts, there are some points to be noted.
For more information, refer to “5.5  Notes” (page 5-44) in “5  Data Display.”

*2 [  Spacing] is the setting applicable to numerical data display and character display parts.
*3 [Character Size] is the setting applicable only to numerical data display part.

Graph and Display Area Type

This is applicable to the [Style] tab window for normal overlap display, switch or lamp, graph, display 
area and data sampling area parts.

Setting dialog

11 Change Part For more information, refer to the Operation Manual.

12 Customize For more information, refer to the Operation Manual.

1 Color Set color for each item.

2 Change Part For more information, refer to the Operation Manual.

3 Customize For more information, refer to the Operation Manual.

1

32
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Coordinates

Applicable Items

Part Menu Item Menu Name Refer to:

Overlap Normal Overlap Coordinates
page A4-12

Switch, Lamp Switch, Lamp Coordinates

Data Display
Data Display (numerical, character, message) Coordinates

page A4-11
Table Data Display (all) Coordinates

Graph
Graph (bar, pie, closed area, panel meter) Coordinates

page A4-12

Statistic Graph (bar, pie) Coordinates

Trend Graph

Trend Graph Coordinates

Trend Sampling Coordinates

Data Sampling Area Coordinates

− Display Area Coordinates

Calendar
Calendar Coordinates

page A4-11Time Display Coordinates

Multimedia Video Overlap Coordinates
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Data Display Type

This is applicable to numerical data display, character display and message display.

Start X/Y for each item
Specify the upper left corner of each item for [Start X/Y].

Start X Specify the X coordinate at the upper left corner of the item in dots.

Start Y Specify the Y coordinate at the upper left corner of the item in dots.

Start point
Start point

Start point
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Switch, Lamp and Graph Type

This is applicable to switch, lamp, graph and normal overlap display parts.

Width and height for each item
Width and height are shown below.

Start X Specify the X coordinate at the upper left corner of the item in dots.

Start Y Specify the Y coordinate at the upper left corner of the item in dots.

Width Specify the X size of the item in dots.

Height Specify the Y size of the item in dots.

Width

Height

Width

Height

Width

Height
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Appendix 5 Process Cycle
The screen display speed in communication between the V8 series and the PLC depends on the 
number of parts (mainly the number of memory addresses read from PLC) placed on the screen.

When displaying more parts in screen data, the display speed gets slower and switch response may 
not be slowed.  In such a case, it is possible to speed up the process by differentiating between the 
data to be viewed in real time (high speed) and the others (low speed).  This setting is available with 
[Process Cycle] included in each item dialog.

Setting of Process Cycle

The read timing from the PLC memory can be set.  (The following example is the case with a lamp 
part.)

* The read area is set in the [Device Connection Setting] dialog.  For more information, refer 
to “1  System Setting.”

Exceptions
1. Regardless of process cycle setting, all data is read from the memory at the leading edge (OFF → 

ON) of bit 15 of the read area “n + 1” and when a screen is opened. 
With this operation, all screen data is displayed on the screen.

2. When [Internal] or [Memory Card] is chosen for [Memory], [High Speed] is automatically selected 
for [Process Cycle].

Refresh • One cycle when the screen is opened
• At the leading edge (OFF → ON) of bit 15 (data read refresh) in read 

area * “n + 1”

High Speed • Every cycle

Low Speed • Once in several cycles
• One cycle when the screen is opened
• At the leading edge (OFF → ON) of bit 15 (data read refresh) in read 

area * “n + 1”
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Processing in V8 Series

Processing in the V8 series is performed in the following order:
• The V8 series analyzes screen data to be read from the PLC, and reads them in blocks.
• With data set as high speed, all the blocks are read in one cycle.
• With data set as low speed, one block is read in one cycle.

The next one block is read in the following one cycle.

Read area
Reading

Read area
Reading

Read area
Reading

Read area
Reading

High speed
Block 1
Reading

High speed
Block 1
Reading

High speed
Block 1
Reading

High speed
Block 1
Reading

High speed
Block m
Reading

High speed
Block m
Reading

High speed
Block m
Reading

High speed
Block m
Reading

Low speed
Block 1
Reading

Low speed
Block 2
Reading

Low speed
Block n
Reading

Low speed
Block 1
Reading

1 cycle 1 cycle 1 cycle 1 cycle
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• When activation of bit 15 of read area “n + 1” is detected, all data is read in the next cycle 
regardless of the setting.

• Reading of the memory required for display and operation is performed at the same time using two 
programs.

• Writing of switch activation, etc. is performed in the interval between reading blocks. 

Read area
Reading

Read area
Reading

Read area
Reading

Read area
Reading

High speed
Block 1
Reading

High speed
Block 1
Reading

High speed
Block 1
Reading

High speed
Block 1
Reading

High speed
Block m
Reading

High speed
Block m
Reading

High speed
Block m
Reading

High speed
Block m
Reading

Low speed
Block 1
Reading

Low speed
Block 2
Reading

Low speed
Block 1
Reading

Low speed
Block 1
Reading

1 cycle 1 cycle

1 cycle

1 cycleLow speed
Block n
Reading

Refresh
Block 1
Reading

Refresh
Block t

Reading

Read area
n + 1
Bit 15

0 → 1 detection

Reading all data in this cycle
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One-cycle Processing

The memory set for [Read Area] in the [Device Connection Setting] dialog is read first.  Next, data in 
the memory set for the items on the screen is read and drawn.  When operations of all the setting data 
have been performed, the screen display is completed.  This series of operations is called “one cycle.”
Refer to the illustration below.

Notes
• The write area is not shown in the above illustration because it is processed at a cycle different 

from the read area.
• For one cycle that is executed when the screen is opened, data of all the parts placed on the 

screen is read and the screen OPEN macro is executed; consequently, the processing is not the 
same as shown above.

n = 0

n = n + 1

n < 8

YES

YES

YES

NO

NO

NO

Read area
Reading

High speed
Block 1
Reading

High speed
Block m
Reading

Low speed
Block 1
Reading

1 cycle

Read area
Reading

High speed
Block 1
Reading

High speed
Block m
Reading

Low speed
Block 2
Reading

Read area
Reading

High speed
Block 1
Reading

High speed
Block m
Reading

Low speed
Block n
Reading

1 cycle 1 cycle

Cycle start

[Event Timer]
No. “n” present

[Event Timer]
Timer up

[Event Timer]
No. “n” executed

1. PLC memory (screen setting) transfer
2. Transfer three words of read area to 

system memory ($s460 and later)

Cycle macro execution

Read area “n” processing

Read area “n + 1” processing

Read area “n + 2” processing

High-speed block 1 
processing

High-speed block 2 
processing

High-speed block “m” 
processing

Low-speed block “n” 
processing

Cycle ends

High-speed block 3 
processing
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If Communication Speed is Slow:

To speed up communications, try the following method.

Conventions for Screen Creation

*1 Example of changing [Process Cycle]:
• For data display parts where data is written by the V8 series in entry mode without any 

changes from the PLC or for those that are hardly changed, select [Refresh].
• Select [Low Speed] for data display parts where the display speed on the V8 series need not 

be fast in response to data changes in the PLC.
• For data display parts that must be displayed in real time, select [High Speed].

*2 Example using macro commands:
With [MOV] command:

Line No. 0 D200 = $u200 (W)
Line No. 1 D201 = $u201 (W)
Line No. 2 D202 = $u202 (W)
Line No. 2 D203 = $u203 (W)
Line No. 3 D204 = $u204 (W)

When the above is set, write operation to the PLC is performed five times.  However, when 
[BMOV] command is used:

Line No. 0 D200 = $u200 C : 5 (BMOV)
Only one line is required.  Write operation to the PLC is performed only once.

Method Effect

Consecutively allocate the PLC memory addresses 
that are used for the same screen.

The number of blocks decreases so the cycle 
time can be shorter.

Each part Change the setting for [Process 
Cycle].   *1

Set [Process Cycle] considering the entire 
amount of screen data, data type, or 
functional properties.

Macro Command conventions *2 Use a macro command to reduce the number 
of accesses to the PLC.

Sampling

Uncheck [  Memory Designation] 
in the [Buffering Area Setting] 
dialog, and set the memory of read 
area “n + 3” and later as sampling 
data memory.
For [Individually] is selected for 
[Memory], allocate memory 
addresses consecutively.

The number of blocks decreases so the cycle 
time can be shorter.

Multi-link
Multi-link2

Place all the connected V8 series 
in RUN mode.

This eliminates recovery confirmation 
accesses to the ports where communications 
are not possible.
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Other Notes

• Baud rate setting (serial communications)
Increase the baud rate between the V8 series and the PLC.  With the V8 series, a maximum 115 
kbps (direct connection with Siemens MPI port: maximum 187,500 bps) is supported.  Set the 
maximum baud rate that the PLC supports.

• Ethernet communication
The baud rate available with Ethernet communication is 10 Mbps (depending on the PLC model).
Communications faster than serial communication are available.

On the PLC, set a shorter scan time for the ladder program.
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Appendix 6 Internal Memory
The internal memory is the memory in the V8 series available to the user.
With this internal memory, the V8 series can operate quickly because it is not necessary to transfer to 
or receive data from the PLC.

Memory Type

The internal memory is composed as shown below.

*1 $u, $T, $M, $MC, $s, and $P are volatile memory.
When the Main Menu screen is displayed or the power is shut down (reset), data is erased.

*2 $L and $LD are non-volatile memory.  Data is retained if the power is shut down.
To use $L or $LD, it is necessary to use the SRAM area built in the V8 series and to make the 
SRAM/clock setting.
For the [SRAM/Clock Setting] dialog, refer to “Appendix 2  SRAM/Clock Setting.”

Type Symbol Memory Range Contents

User 
memory

$u
*1

0 to 32767
(32768 words)

This is the read/write memory that can be used freely.
This is an area common to all screens.

$L
$LD

*2

Depends on user setting
(Refer to “Appendix 2  
SRAM/Clock Setting.”)

This is the read/write memory that can be used freely.
This is an area common to all screens.

$T
*1

0 to 1023
(1024 words)

This is the read/write memory that can be used freely.
Each screen can have up to 1024 words.  When the screen is 
switched, all the areas are reset to “0.”  Consequently, these 
memory addresses can be used for macro commands that 
should be executed for each screen.

$M
*1

0 to 2047
(2048 words)

This is the read/write memory that can be used freely.
Each macro command can have up to 2048 words.  When the 
macro command has been executed, or another macro 
command is called, all the areas are reset to “0”.
Consequently, these memory addresses can be used for 
storing temporary values such as for arithmetic operations.

$MC
*1

0 to 2047
(2048 bytes)

This is the read/write memory that can be used freely.
Each macro command can have up to 2048 bytes.  When the 
macro command has been executed, or another macro 
command is called, all the areas are reset to “0”.
Consequently, these memory addresses can be used for 
storing temporary values such as for arithmetic operations.
The difference from $M is that these are addresses in byte 
units; therefore, byte access is possible.

$C
*1

0 to 4095
(4096 words)

These addresses are exclusively used for component parts.
These are valid only when editing component parts.

System 
memory

$s
*1

0 to 2047
(2048 words)

This is the read/write memory used by the system.
This memory is used for data communication to and from 
MONITOUCH, and is mainly necessary for macro commands.
Do not use any area indicated as “Not used” of this memory 
because it is reserved for future use.

$P
*1

0 to 511
(512 words)

This is the read/write memory and is used to control 8-way 
communication or indicate the status of 8-way 
communication.
For more information, refer to the V8 Series Connection 
Manual.
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Notes

1. The internal memory works with “DEC (with sign)” no matter what numeric code is set in the 
[Device Connection Setting] dialog.
(Except items for which the numeric code is specified individually.)

2. Text processing depends on the setting for [Text Process] in the [Communication Setting] tab 
window ([System Setting] → [Device Connection Setting]). 
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Details of System Memory

Contents in system memory $s are shown below.
Denotation of [Memory Type] in the list
• ← V

MONITOUCH writing data
• → V

User definition or setting

Address Contents Memory Type

0 Screen number ← V

1

2 Overlap 0 Registration/display status

← V

3 Overlap 0 Display position X

4 Overlap 0 Display position Y

5 Overlap 0 Overlap library number

6 Overlap 1 Registration/display status

7 Overlap 1 Display position X

8 Overlap 1 Display position Y

9 Overlap 1 Overlap library number

10 Overlap 2 Registration/display status

11 Overlap 2 Display position X

12 Overlap 2 Display position Y

13 Overlap 2 Overlap library number

14

15

16 Printer status
← V

17 Backlight status

18

19

20 Buffer 0 The number of buffers specified

← V

21 Buffer 0 The number of buffers

22 Buffer 0 The number of buffers executed

23 Buffer 1 The number of buffers specified

24 Buffer 1 The number of buffers

25 Buffer 1 The number of buffers executed

26 Buffer 2 The number of buffers specified

27 Buffer 2 The number of buffers

28 Buffer 2 The number of buffers executed

29 Buffer 3 The number of buffers specified

30 Buffer 3 The number of buffers

31 Buffer 3 The number of buffers executed

32 Buffer 4 The number of buffers specified
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33 Buffer 4 The number of buffers

← V

34 Buffer 4 The number of buffers executed

35 Buffer 5 The number of buffers specified

36 Buffer 5 The number of buffers

37 Buffer 5 The number of buffers executed

38 Buffer 6 The number of buffers specified

39 Buffer 6 The number of buffers

40 Buffer 6 The number of buffers executed

41 Buffer 7 The number of buffers specified

42 Buffer 7 The number of buffers

43 Buffer 7 The number of buffers executed

44 Buffer 8 The number of buffers specified

45 Buffer 8 The number of buffers

46 Buffer 8 The number of buffers executed

47 Buffer 9 The number of buffers specified

48 Buffer 9 The number of buffers

49 Buffer 9 The number of buffers executed

50 Buffer 10 The number of buffers specified

51 Buffer 10 The number of buffers

52 Buffer 10 The number of buffers executed

53 Buffer 11 The number of buffers specified

54 Buffer 11 The number of buffers

55 Buffer 11 The number of buffers executed

56

57

                    

62

63

64 Switch function Repeat setting

→ V65 Switch function Repeat prohibited setting

66 Switch ON macro Repeat setting

67

68

69

70

71

72 Result of system call
← V

73 Result of switch function

74

75 Buzzer sound for overlap → V

76 Keypad overlap AUTO OFF Prohibited
→ V

77 Exclusive function of overlap display

Address Contents Memory Type
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78 Entry mode Display type of entry target ← V

79 Entry mode Selection of entry target → V

80 Universal serial Switch output 0 Output codes 0 to 15

← V

81 Universal serial Switch output 1 Output codes 16 to 31

82 Universal serial Switch output 2 Output codes 32 to 47

83 Universal serial Switch output 3 Output codes 48 to 63

84 Universal serial Switch output 4 Output codes 64 to 79

85 Universal serial Switch output 5 Output codes 80 to 95

86 Universal serial Switch output 6 Output codes 96 to 111

87 Universal serial Switch output 7 Output codes 112 to 127

88 Universal serial Switch output 8 Output codes 128 to 143

89 Universal serial Switch output 9 Output codes 144 to 159

90 Universal serial Switch output 10 Output codes 160 to 175

91 Universal serial Switch output 11 Output codes 176 to 191

92 Universal serial Switch output 12 Output codes 192 to 207

93 Universal serial Switch output 13 Output codes 208 to 223

94 Universal serial Switch output 14 Output codes 224 to 239

95 Universal serial Switch output 15 Output codes 240 to 255

96

97

98

99 CVFD macro setting → V

100 PLC calendar condition ← V

101 Calendar writing to PLC Setting → V

102 Result of macro command HIM-FUNC execution ← V

103

104 PLC error handling during macro execution → V

105 ($s104 is other than 0: Writing the result of error handling)

← V

106 Memo pad Displayed page number

107 Memo pad Data Registered/ Unregistered

108 Memo pad Remaining storage area (low-order) Unit: bytes

109 Memo pad Remaining storage area (high-order)

110 Multi-link/ Multi-link 2 communication Local port number

111 Universal serial communication Local port number

112

113

114 When connecting 1 : n PLC 1 down information (port number 32 to 47)

← V

115 When connecting 1 : n PLC 1 down information (port number 48 to 63)

116 When connecting 1 : n PLC 1 down information (port number 64 to 79)

117 When connecting 1 : n PLC 1 down information (port number 80 to 95)

118 When connecting 1 : n PLC 1 down information (port number 96 to 111)

119 When connecting 1 : n PLC 1 down information (port number 112 to 127)

Address Contents Memory Type
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120 When connecting 1 : n PLC 1 down information (port number 128 to 143)

← V

121 When connecting 1 : n PLC 1 down information (port number 144 to 159)

122 When connecting 1 : n PLC 1 down information (port number 160 to 175)

123 When connecting 1 : n PLC 1 down information (port number 176 to 191)

124 When connecting 1 : n PLC 1 down information (port number 192 to 207)

125 When connecting 1 : n PLC 1 down information (port number 208 to 223)

126 When connecting 1 : n PLC 1 down information (port number 224 to 239)

127 When connecting 1 : n PLC 1 down information (port number 240 to 255)

128 When connecting 1 : n PLC 1 down information (port number 0 to 15)

129 When connecting 1 : n PLC 1 down information (port number 16 to 31)

130 MODBUS TCP/IP sub station information → V

131

132 Cycle time ← V

133

134

                    

158

159

160 Calendar Year ← V

161 Calendar Month

← V

162 Calendar Day

163 Calendar Hour

164 Calendar Minute

165 Calendar Second

166 Calendar Day of the week (0: Sunday, 1: Monday, 2: Tuesday, ... 6: Saturday)

167 SRAM information

168 Greenwich time (low-order)

169 Greenwich time (high-order)

170 Video overlap Selected channel number

171 Video overlap Dithering

172 Video overlap Brightness

173 Video overlap Contrast

174 Video overlap Color

175

176

177 Sampling buffer number → V

178 Overflow flag

← V

179 Overflow flag

180 Buffer Word 0 Average (low-order)

181 Buffer Word 0 Average (high-order)

182 Buffer Word 0 Maximum (low-order)

183 Buffer Word 0 Maximum (high-order)

Address Contents Memory Type
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184 Buffer Word 0 Minimum (low-order)

← V

185 Buffer Word 0 Minimum (high-order)

186 Buffer Word 0 Total (low-order)

187 Buffer Word 0 Total (high-order)

188 Buffer Word 1 Average (low-order)

189 Buffer Word 1 Average (high-order)

190 Buffer Word 1 Maximum (low-order)

191 Buffer Word 1 Maximum (high-order)

192 Buffer Word 1 Minimum (low-order)

193 Buffer Word 1 Minimum (high-order)

194 Buffer Word 1 Total (low-order)

195 Buffer Word 1 Total (high-order)

196 Buffer Word 2 Average (low-order)

197 Buffer Word 2 Average (high-order)

198 Buffer Word 2 Maximum (low-order)

199 Buffer Word 2 Maximum (high-order)

200 Buffer Word 2 Minimum (low-order)

201 Buffer Word 2 Minimum (high-order)

202 Buffer Word 2 Total (low-order)

203 Buffer Word 2 Total (high-order)

204 to 211 Buffer Word 3 Average, maximum, minimum, total

212 to 219 Buffer Word 4 Average, maximum, minimum, total

220 to 227 Buffer Word 5 Average, maximum, minimum, total

228 to 235 Buffer Word 6 Average, maximum, minimum, total

236 to 243 Buffer Word 7 Average, maximum, minimum, total

244 to 251 Buffer Word 8 Average, maximum, minimum, total

252 to 259 Buffer Word 9 Average, maximum, minimum, total

260 to 267 Buffer Word 10 Average, maximum, minimum, total

268 to 275 Buffer Word 11 Average, maximum, minimum, total

276 to 283 Buffer Word 12 Average, maximum, minimum, total

284 to 291 Buffer Word 13 Average, maximum, minimum, total

292 to 299 Buffer Word 14 Average, maximum, minimum, total

300 to 307 Buffer Word 15 Average, maximum, minimum, total

308 to 315 Buffer Word 16 Average, maximum, minimum, total

316 to 323 Buffer Word 17 Average, maximum, minimum, total

324 to 331 Buffer Word 18 Average, maximum, minimum, total

332 to 339 Buffer Word 19 Average, maximum, minimum, total

340 to 347 Buffer Word 20 Average, maximum, minimum, total

348 to 355 Buffer Word 21 Average, maximum, minimum, total

356 to 363 Buffer Word 22 Average, maximum, minimum, total

364 to 371 Buffer Word 23 Average, maximum, minimum, total

372 to 379 Buffer Word 24 Average, maximum, minimum, total

Address Contents Memory Type
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380 to 387 Buffer Word 25 Average, maximum, minimum, total

← V

388 to 395 Buffer Word 26 Average, maximum, minimum, total

396 to 403 Buffer Word 27 Average, maximum, minimum, total

404 to 411 Buffer Word 28 Average, maximum, minimum, total

412 to 419 Buffer Word 29 Average, maximum, minimum, total

420 to 427 Buffer Word 30 Average, maximum, minimum, total

428 to 435 Buffer Word 31 Average, maximum, minimum, total

436 Alarm function Auto operation time (low-order)

437 Alarm function Auto operation time (high-order)

438 Alarm function Auto operation stop time (low-order)

439 Alarm function Auto operation stop time (high-order)

440 Alarm function Program stop time (low-order)

441 Alarm function Program stop time (high-order)

442 Alarm function The number of stops

443 Alarm function Rate of operation (XX.X)

444

445

                    

454

455

456 Alarm function  Normal operation bit ← V

457

458 Alarm function  Sampling bit ← V

459

460 Read area n

← V461 Read area n + 1

462 Read area n + 2

463

464 Write area n

← V465 Write area n + 1

466 Write area n + 2

467

468 Memory card number

← V

469 Memory card name

470 Memory card file name No. 0

471 Memory card file name No. 1

472 Memory card file name No. 2

473 Memory card file name No. 3

474 Memory card file name No. 4

475 Memory card file name No. 5

476 Memory card file name No. 6

477 Memory card file name No. 7

Address Contents Memory Type
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478 Memory card file name No. 8

← V

479 Memory card file name No. 9

480 Memory card file name No. 10

481 Memory card file name No. 11

482 Memory card file name No. 12

483 Memory card file name No. 13

484 Memory card file name No. 14

485 Memory card file name No. 15

486

487

488

489

490 V808CH Deadman switch/key switch setting ← V

491 V808CH Answer-back of each switch ← V

492

493

494

495

496 CF card access status (on V-Server or Memory Card Editor) ← V

497 CF card error status

← V
498 CF card remaining capacity (low-order) Unit: kbytes

499 CF card remaining capacity (high-order)

500 CF card removal switch status

501

502

                    

512 Selection from two Ethernet ports → V

513

514 Ethernet Macro Request wait → V

515 Ethernet Macro Request wait execution result ← V

516

517

518 Ethernet Status (for built-in LAN port) ← V

519 Ethernet Status (for Ethernet unit) ← V

520 Network table 0 status

← V

521 Network table 1 status

522 Network table 2 status

                    

617 Network table 97 status

618 Network table 98 status

619 Network table 99 status

620 FL-net Local node number
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621 FL-net Local node Area 1 data top address

← V

622 FL-net Local node Area 1 data top size

623 FL-net Local node Area 2 data top address

624 FL-net Local node Area 2 data top size

625 FL-net Host status

626 FL-net Protocol version

627 FL-net FA links status

628 FL-net Local node status

629 FL-net Status

630 FL-net Node table information

631 FL-net Node table information

632 FL-net Node table information

                    

642 FL-net Node table information

643 FL-net Node table information

645 FL-net Node table information

646 FL-net Refresh cycle time

647 FL-net Node number

648 FL-net Host status

649 FL-net Area 1 data top address

650 FL-net Area 1 data size

651 FL-net Area 2 data top address

652 FL-net Area 2 data size

653 FL-net FA links status

654 FL-net Minimum allowable frame interval

655

656

                    

698

699

700 Language selection, display language number ← V

701

702

                    

708

709

710

711

712

713

714

715

Address Contents Memory Type
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716

717

718

719

720 SRAM Memo padSave information

← V

721 SRAM Internal memory $L save result

722 SRAM Internal $L newest write address (low-order)

723 SRAM Internal $L newest write address (high-order)

724 SRAM Internal memory $D save result

725 SRAM Internal $LD newest write address (low-order)

726 SRAM Internal $LD newest write address (high-order)

727 Memo pad save overflow

728 FROM_RD/FROM_WR macro execution result

729 PLC2 Macro execution result

730 PLC2 Port No. 00 Status

731 PLC2 Port No. 01 Status

732 PLC2 Port No. 02 Status

                    

758 PLC2 Port No. 28 Status

759 PLC2 Port No. 29 Status

760 PLC2 Port No. 30 Status

761 PLC2 Port No. 31 Status

762 PLC2 Constant /Synchronized read Interrupt

→ V763 PLC2 TEMP_RD/TEMP_WR macro forced execution

764 PLC2 Constant /Synchronized write Interrupt

765 PLC2 Error code

← V
766 PLC2 Extended error code 1

767 PLC2 Extended error code 1

768 PLC2 Extended error code 1

769

770

                    

778

779

780 CF card BMP file load information

← V

781 CF card JPEG file load information

782 CF card WAV file load information

783 CF card Font file load information

784 CF card HTML file load information

                    

798

799
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800 Modbus slave communication Reference table number
← V

801 Modbus slave communication Reference memory setting

802 Modbus slave communication Reference memory setting

← V
803 Modbus slave communication Reference memory setting

804 Modbus slave communication Reference memory setting

805 Modbus slave communication Reference memory setting

806

807

808

809

810 to 813 IP address of the local port
← V

814 to 817 IP address of the other port

818 Network table number designation → V

819

820 PLC2 Port No. 32 Status

← V

821 PLC2 Port No. 33 Status

822 PLC2 Port No. 34 Status

                    

885 PLC2 Port No. 97 Status

886 PLC2 Port No. 98 Status

887 PLC2 Port No. 99 Status

888

889

890 Japanese conversion function The number of user-defined words ← V

                    

898

899

900 Touch switch status output

← V901 Touch switch X coordinate output

902 Touch switch Y coordinate output

903

904

                    

908

909

910 Video CH1 Brightness

← V911 Video CH1 Contrast

912 Video CH1 Color intensity

913

914
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915 Video CH2 Brightness

← V916 Video CH2 Contrast

917 Video CH2 Color intensity

918

919

920 Video CH3 Brightness

← V921 Video CH3 Contrast

922 Video CH3 Color intensity

923

924

925 Video CH4 Brightness

← V926 Video CH4 Contrast

927 Video CH4 Color intensity

928

929

930 Video Status ← V

931 Video Composition of superimpose screen → V

932 Auto File No.

← V

933 Focus channel

934 Vodeo Selected video area channel

935 Video Brightness of the selected video area

936 Video Contrast of the selected video area

937 Video Intensity of the selected video area

938

939

                    

954

955

956 Brightness adjustment ← V

957 Video Display change (640 × 240 dots only) → V

958

959 Video Restart macro Operation setting

→ V960 Video Snapshot/JPG display Operation setting

961 Video Standard size setting (for V815iX only)

962 Video The number of “Continuous Single Snap” times ← V

                    

965 File transfer Communication timeout setting → V

966 Video Clip start position of the current channel (X coordinate at the top left 
corner)

← V967 Video Clip start position of the current channel (Y coordinate at the top left 
corner)

968 Video Image clip size of the current channel (width)
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969 Video Image clip size of the current channel (height) ← V

970 RGB IN The maximum number of snap files
→ V

971 RGB IN Processing when the snap file limitation is exceeded

                    

988

989

990 Recipe macro GET_RECIPE_FILEINFO execution result ← V

991

992

                    

998

999

1000 Sound replay Remaining seconds ← V

1001 Sound Channel L Adjusted volume value
← V

1002 Sound Channel R Adjusted volume value

1003

1004

1005 E-mail send Send wait e-mails
← V

1006 E-mail send Error information

1007 EPSON STYLUS PHOTO Hard copy
→ V

1008 JPEG image accuracy

1009 Data sheet Consecutive print (STA_LIST) → V

1010 Data sheet Number of print pages enqueued (STA_LIST) ← V

1011 Data sheet Cancel (STA_LIST) → V/ ← V

                    

1022

1023

1024 Result of external CF access ← V

1025 USB-FDD (drive: A) FDD error status ← V

1026 USB FDD (drive: A) FDD free space (low-order) Unit: KB 

← V1027 USB-FDD (drive: A) FDD free space (high-order)

1028 USB-FDD (drive: A) [CF Card Removal] switch status

1029

1030 Built-in CF (drive: C) CF card error state

← V
1031 Built-in CF (drive: C) CF card free capacity (low-order) Unit: kB

1032 Built-in CF (drive: C) CF card free capacity (high-order)

1033 Built-in CF (drive: C) [CF Card Removal] switch status

1034

1035 USB-A (drive: D) CF card error state

← V
1036 USB-A (drive: D) CF card free capacity (low-order) Unit: kB

1037 USB-A (drive: D) CF card free capacity (high-order)

1038 USB-A (drive: D) [CF Card Removal] switch status

1039

Address Contents Memory Type



Appendix 6    Internal Memory

A6-15

A6

1040

                    

1050 Background CF access Background processing flag

← V1051 Background CF access Background processing completion flag

1052 Background CF access Background processing error flag

1053

1054

1055

1056 Macro execution result Arithmetic operation

← V

1057 Macro execution result Conversion, transfer

1058 Macro execution result Macro motion control

1059 Macro execution result Printer

1060 Macro execution result Video

1061 Macro execution result CF card

1062 Macro execution result Others

1063

1064

1065

1066 PictBridge Status output ← V

1067

                    

1070 FTP information ← V

1071 FTB client Login count ← V

1072 FTP connection Forced disconnection → V

                    

1085 SRAM forced formatting ← V

                    

1098 Sampling macro Background processing selection → V

1099

1100 Buffer No. 0 Primary storage target The setting number of sampling 
times

← V

1101 Buffer No. 0 Primary storage target The current number of sampling 
times

1102 Buffer No. 0 Secondary storage target The setting number of sampling 
times1103

1104 Buffer No. 0 Secondary storage target The current number of sampling 
times1105

1106 Buffer No. 0 The number of sampling times executed

1107

1108 Buffer No. 0 Secondary storage target Access status
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1109 Buffer No. 0 Background processing flag

← V

1110 Buffer No. 0 Sampling macro executing flag

1111 Buffer No. 0 Sampling macro execution completion flag

1112 Buffer No. 0 Sampling macro error flag

1113 Buffer No. 0 Sampling error flag

1114 Buffer No. 0 Sampling error forced storage flag → V

1115

1116

1117

1118

1119

1120 to 1134 Buffer No. 1 (equivalent to buffer No. 0 $s1100 to 1114)

1135

1136

1137

1138

1139

1140 to 1154 Buffer No. 2 (equivalent to buffer No. 0 $s1100 to 1114)

1155

1156

1157

1158

1159

1160 to 1174 Buffer No. 3 (equivalent to buffer No. 0 $s1100 to 1114)

1175

1176

1177

1178

1179

1180 to 1194 Buffer No. 4 (equivalent to buffer No. 0 $s1100 to 1114)

1195

1196

1197

1198

1199

1200 to 1214 Buffer No. 5 (equivalent to buffer No. 0 $s1100 to 1114)

1215

1216

1217

1218

1219

1220 to 1234 Buffer No. 6 (equivalent to buffer No. 0 $s1100 to 1114)

1235

1236
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1237

1238

1239

1240 to 1254 Buffer No. 7 (equivalent to buffer No. 0 $s1100 to 1114)

1255

1256

1257

1258

1259

1260 to 1274 Buffer No. 8 (equivalent to buffer No. 0 $s1100 to 1114)

1275

1276

1277

1278

1279

1280 to 1294 Buffer No. 9 (equivalent to buffer No. 0 $s1100 to 1114)

1295

1296

1297

1298

1299

1300 to 1314 Buffer No. 10 (equivalent to buffer No. 0 $s1100 to 1114)

1315

1316

1317

1318

1319

1320 to 1334 Buffer No. 11 (equivalent to buffer No. 0 $s1100 to 1114)

1335

1336

1337

                    

1359

1360 Security function Current security level ← V

1361 Security function Current login user ID

1362

1363

1364

1365 Operation log viewer Log file number being displayed  ← V

1366 Operation log viewer Log folder number being displayed  

                    

1379

1380 Remote desktop window display Start-up status ← V

1381 Remote desktop window display Connection status
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• Address $s0
Stores the current screen number 0 to 9999.

• Address $s2 to 13
Stores the current overlap display status.

• Address $s16
Stores the current printer status.

1382

                    

1560 Global overlap Registration/display status ← V

1561 Global overlap X coordinate of the display position 

1562 Global overlap Y coordinate of the display position 

1563 Global overlap Overlap library number

                    

2047

Address Contents Memory Type

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Overlap registration*
0: None  1: Present

n + 0 (Display status)

Display status
0: Non-display  1: Display

* For multi-overlap display, this bit is set to “1” only while the display is shown.
The bit, however, remains set (“1”) even during display hidden status when [Read PLC 
Memory when OFF] is checked in the [Detail] tab window for overlap library setting. 

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

X coordinate display Dot:  0 to 1023
Column/ line:  0 to 127

n + 1 (X coordinate)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Y coordinate display Dot:  0 to 767
Column/ line:  0 to 37

n + 2 (Y coordinate)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Multi-overlap number: 0  - 9999
For hiding multi-overlap display: -1
Normal overlap or call-overlap: -1

n + 3 (Multi-overlap number)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Printer status
0: READY 1: BUSY

n + 0 (Printer status)

0: Print standby
1: Printing
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• Address $s17
Stores the current backlight status.
Stores the backlight burnt state.

• Address $s20 to 55 (V7 compatible)
Stores sampling buffer conditions.

• Address $s64
It is possible to add the repeat function to the switch not equipped with repeat function. 
Set a number other than “0” in address $s64 using the switch ON macro.

• Address $s65
It is possible to prohibit the repeat function to the switch equipped with the repeat function. 
Set a number other than “0” in address $s65 using the switch ON macro.

• Address $s66
It is possible to repeat switch ON macro.
Set a number other than “0” in address $s66 using the ON macro.

Example:  Set the switch ON macro as shown below.
$u100 = $u100 + 1
$s66 = 1
RET

While the switch is held down, $u100 is continuously incremented.

* $s64 to 66 are valid for switch ON macros.
* Before executing switch ON macro, the system clears addresses $s64 to 66 to “0”.

For these addresses, set “1” as necessary.
The switch repeat function is prohibited when it is not possible even if the macro 
command is executed.  (For example, the block number has reached the maximum 
value by the [+ Block] switch.)

• Address $s72
Stores the result of the SYS (system call) macro command.

[0]: Normal termination
[Other than 0] (Normally −1): Error (the second screen setting, etc.)

• Address $s73
Stores the result of the switch function when the SWRET command is used for the switch ON 
macro.

[0]: Normal termination
[Other than 0] (Normally −1): Error

Use this address when the next operation should vary depending on the result of the switch 
function.

• Address $s75
This address is used to activate or deactivate the buzzer that indicates the switching of the top of 
multiple overlap displays on the screen.
(For an overlap display with [  Superimpose] checked, the buzzer is inactive regardless of the 
setting at $s75.)

[0]: Buzzer ON
[1]: Buzzer OFF

Buffer No. 0 to 11 n + 0 [No. of Samples] specified in the [Buffering Area Setting] dialog

n + 1 The number of sampling times in buffer (n + 0 ≥ n + 1)

n + 2 The number of sampling times executed

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

n + 0 (Backlight status)

0: OFF 1: ON0: Backlight burnt    1: Backlight normal
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• Address $s76
If a keypad for entry mode is placed on an overlap display, it is possible to erase the overlap 
display with the [ENT] key on the keypad.
To prohibit the above function, use this memory address.

[0]: Overlap AUTO OFF
[Other than 0]: Overlap AUTO OFF prohibited

For more information, refer to “7  Entry Mode.”
• Address $s77

When a value other than “0” is set, the overlap exclusive function is set.
For more information, refer to “2  Overlap.”

• Address $s78
Stores the display type of data in the entry target.

• Address $s79
This setting is valid when the entry mode is switched through the overlap activation (ON/OFF) or 
by multi-overlap number change on one screen.

* Do not set any value other than “0” or “1”.
[0]: The entry target that was selected last in the entry mode becomes selected.
[1]: The entry target currently selected remains selected even after the mode is switched.

• Address $s80 to 95
Used for universal serial communication.
For more information, refer to the V8 Series Connection Manual.

• Address $s99
Used to specify the rounding to be used with the CVFD macro command.

• Address $s100, 101
These are memory addresses related to the calendar.
$s100: The calendar status of the PLC (with built-in calendar) is written.

[0]: Normal
[1]: Error (The calendar information could not be read correctly.)

$s101: When $s100 = 1, calendar writing to the PLC is enabled or prohibited.
[0]: Calendar writing prohibited
[Other than 0]: Calendar writing enabled

No error handling is performed even if an error is detected.

Output Code Entry Target Display Type
−2 No entry mode −
−1 No entry target −
0 Numerical data display Decimal without sign
1 Decimal with sign (−)
2 Decimal with sign (+)
3 Hexadecimal
4 Octal
5 Binary
6 Character display −
7 Message display: other than entry target −
8 Numerical data display Real number (floating decimal point):

Setting Value Meaning Operation

Other than 1 or 2 Rounding When the fraction remainder is 0.5 or greater, it is 
rounded up; when it is less than 0.5, it is rounded 
down.

1 Rounding down The fraction remainder is rounded down.

2 Rounding up The fraction remainder is rounded up unless it is “0”.
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• Address $s102
Stores the result of the HMI-FUNC macro command execution.

[0]: Normal
[Other than 0]: Error

For more information, refer to the Macro Reference Manual.
• Address $s104, 105

Used to specify error handling to be performed when an error occurs during the reading/writing of 
data to the PLC using a macro command via communications. 

Example:
When the indirect PLC memory is set for the writing target memory address within the MOV 
command, the communication error will occur if the value in the indirect PLC memory exceeds 
the range of the PLC memory. 
Use these addresses to avoid such a communication error.

$s104 : [0]
When the write macro command is executed, the next command is started without waiting for 
the result of the macro write command.
If an error occurs during writing, error handling is performed.
The error handling to be performed depends on the setting for [Comm. Error Handling] 
(Stop/Continue) in the [Communication Setting] tab window in the [Device Connection Setting].
$s104: [Other than 0]
When the write macro command is executed, the next command is started after receipt of the 
result of write operation.  If an error occurs during writing, error handling is not performed and 
the result is stored in $s105.  It will take a longer time compared with the case where “0” is set.
$s105: When $s104 ≠ 0, the result of macro write error is stored.
[0]: Normal
[Other than 0]: Error

• Address $s106 to 109
Stores the information of memo pad.

$s106: The page number (0 to 7) of the displayed memo pad is stored.
$s107: The information of whether or not data is registered in each page of memo pad 

(maximum 8 pages) is stored.

$s108, 109: The remaining area for memo pad data is stored.  (Unit: bytes)

• Address $s110
Stores the local port number of the V8 series when selecting [Multi-link] or [Multi-link2] for 
[Connection Mode].

• Address $s111
Stores the local port number for 1 : n connection at the universal serial port.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0: Data not registered
1: Data registered

Page 0
Page 1

Page 2
Page 3

Page 4
Page 5

Page 6
Page 7

$s107
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• Address $s128, 129, 114 to 127 (V7 compatible)
When the connection mode is [1 : n], and time-out is detected in the communication with the PLC 
1, “1” is set at the related bit.  After that, it is not possible to communicate with the PLC on the 
same screen.
When the screen display changes, all bits in these addresses will be cleared to “0” to enable 
communication with the PLC on the screen.

• Address $s132
Stores the cycle time of the current screen.
(Unit: 10 msec)
For more information on one cycle, refer to “Appendix 5  Process Cycle.”

• Address $s160 to 166
Stores the calendar data that is read from the PLC or is currently displayed on MONITOUCH at the 
start of communication.

• Address $s167
Stores the information in the built-in SRAM.

• Address $s168 to 169
Stores the Greenwich Mean Time.

• Address $s170 to 174
Information about the channel number used by the video window (video overlap), brightness, 
contrast, color intensity, etc. is written.
For more information, refer to “2  Overlap.”

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Port No. 15 Port No. 00

$s128

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Port No. 31 Port No. 16

$s129

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Port No. 47 Port No. 32

$s114

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Port No. 255 Port No. 240

$s127

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0
$s167

MSB

0: Battery normal
1: Battery voltage drop
2: Battery not mounted

System reserved 
(setting “0”)

LSB

System reserved (setting “0”)
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• Address $s177
Stores the buffer number for which the SET_BUFNO macro command has been executed.
When the power is turned on, the smallest buffer number among those with [  Use a Calculation 
Operation] checked in the [Buffering Area Setting] dialog.

• Address $s178, 179
When the sample buffer total value overflows after the execution of the SET_BUFNO macro 
command, the bits corresponding to sample word No. 0 to 31 become “1”.
Sample buffer word No. 32 to 128 are not available.

• Address $s180 to 435
Stores the result of the SET_BUFNO macro command execution.

• Address $s436 to 443, 456, 458
Stores the information on the alarm function.  For more information, refer to “10  Alarming.”

• Address $s460 to 462
Stores the information on the read area.  For more information on the read area, refer to “1  
System Setting.”

• Address $s464 to 466
Stores the information on the write area.  For more information on the write area, refer to “1  
System Setting.”

• Address $s468 to 485
The memory card information (card number, card name,  file name) is read from or written to the 
memory (n). 
Use the MOV macro command.

Read: [n = $s468 (to 485)] is executed and memory “n” is monitored.
Write: [$s468 (to 485) = n] is executed and data in memory “n” (to n + 16) is written into the 

memory card.
* Data of $s468 to 485 is always “0”.

Example:
1) $u100 = $s468

The memory card number (1 word) is written into $u100.
2) $u101 = $s469

The memory card name (32 characters) is written into $u101 to $u116.
(If the memory card name is less than 32 characters, 32 characters will be written.)

3) $u117 = $s470
The memory card file name (32 characters) is written into $u117 to $u132.
(If the file name is less than 32 characters, 32 characters will be written.)

• Address $s490 to 491
Stores the information on V808CH.
For more information, refer to the V808CH Hardware Specifications.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Word 15 Word 00

$s178

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Word 31 Word 16

$s179
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• Address $s496
Stores the access status from V-Server or Memory Card Editor to the CF card.

[0]: No access
[1]: Accessing

• Address $s497
The result of access to the CF card is output.

• Address $s498 to 499
Stores the remaining capacity of the CF card in kbytes.

• Address $s500
Stores the status of the [Function: CF Card Removal] switch.

[0]: Switch OFF (CF card removal disabled)
[Other than 0]: Switch ON (CF card removal enabled)

• Address $s512
Selection from two Ethernet ports
When the LAN port built in MONITOUCH and an Ethernet unit (CU-03-3) are used, the port for the 
transmission of Ethernet macro commands (“EREAD”, “EWRITE”, “SEND”, “MES”) is specified at 
this address.

[0]: Built-in LAN port
[Other than 0]: Ethernet unit (CU-03-3) 

For more information on the two Ethernet ports, refer to “Two Ethernet Ports” on page 19-31.

• Address $s514 to 515
These addresses are relevant to the macro commands (“EREAD”, “EWRITE”, “SEND”, “MES”).

- $s514: Request for macro wait
In the case of successive accesses to the same port on one single macro sheet, specify a 
value other than “0” (with wait).  If “0” (no wait) is specified, a macro command issued 
afterward will not be accepted.
[0]: No wait

During the execution of a macro command, the execution of the next macro 
command takes place before the completion of the current one.

[Other than 0]: With wait 
During the execution of a macro command, the next macro command is put on 
hold and is executed after the completion of the previous command.

- $s515: Storage of a macro execution result
When $s514= 0, the issue of a macro command (response not included) is stored.  When the 
value at the address is other than “0”, the response returned to the issue of the command is 
stored.
For more information, refer to the V8 Series Connection Manual.

• Address $s518
Stores the Ethernet status.  For more information, refer to the V8 Series Connection Manual.

[0]: Normal
[Other than 0]: Error number 

4 Card not mounted

6 Too small card size

7 Different card type

9 JPEG/BMP file read error

12 Card write error

15 Disk error (open failure)

16 Card read error
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• Address $s519
Stores the status of the Ethernet unit (CU-03-3) when two Ethernet ports are used.  For more 
information, refer to the V8 Series Connection Manual.

[0]: Normal
[Other than 0]: Error number 

• Address $s520 to 619
Stores the status of Ethernet communication network table Nos. 0 to 99.
For more information, refer to the V8 Series Connection Manual.

• Address $s620 to 654
Stores the information in the FL-Net communications.
For more information, refer to the Specifications for Communication Unit FL-Net (OPCN-2) 
provided separately.

• Address $s700
Stores the display language number (0 to 7) for language selection.
For information on language selection, refer to “Appendix 3  Display Language.”

• Address $s720
Stores the result of memo pad data storage in the built-in SRAM of the V8 series.

[0]: Normal
[1]: Data contains an error and is deleted.

• Address $s721
Stores the result of memo pad data writing in internal memory $L using the built-in SRAM of the V8 
series.

[0]:  Normal
[1]:  Error

• Address $s722 to 723
Stores the $LD address of the last write operation when $s721 = 1 at power-up.

• Address $s724
Stores the result of memo pad data writing in internal memory $LD using the built-in SRAM of the 
V8 series.

[0]:  Normal
[1]:  Error

• Address $s725 to 726
Stores the $LD address of the last write operation when $s724 = 1 at power-up.

• Address $s727
Stores the information of whether or not the capacity of the memo pad data is not too big to be 
saved.

[0]:  Normal
[1]:  Save area insufficient

• Address $s728
Stores the result of the FROM_RD/FROM_WR macro command execution.

[0]:  Normal
[−1]:  NG

• Address $s729 to 764 (V7 compatible)
Stores the information on the PLC2 for 8-way communication.
For more information, refer to the V8 Series Connection Manual.

• Address $s725 to 768 (V7 compatible)
Stores the error information on the PLC2 for 8-way communication.
For more information, refer to the V8 Series Connection Manual.

• Address $s780 to 784
Stores the information on the CF card.
For more information, refer to “18  CF Card.”
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• Address $s800 to 805
Stores the information on the Modbus slave communication.
For more information, refer to the Modbus Slave Communication Specifications provided 
separately.

• Address $s810 to 813
Stores the IP address of the V8 series.
When no IP address is set, “0.0.0.0” is stored.

• $s814 to 818
Stores the IP address of the network table number corresponding to the value set in $s818 *.  If no 
network table exists, “0.0.0.0” is stored.

* Use the MOV (W) macro command when setting the network table number.

• Address $s820 to 887 (V7 compatible)
Stores the information on the PLC2 for 8-way communication.
For more information, refer to the V8 Series Connection Manual.

• Address $s890
Used when the Japanese conversion function in entry mode is used.
Stores the number of user-defined words.
For more information on the Japanese conversion function, refer to “7  Entry Mode.”

• Address $s900
Stores the touch switch information.  For more information, refer to “3  Switch.”

• Address $s901
Stores the X coordinate of the touch switch that is pressed.  For more information, refer to “3  
Switch.”

• Address $s902
Stores the Y coordinate of the touch switch that is pressed.  For more information, refer to “3  
Switch.”

• Address $s910 to 937 (V8i only)
Stores the information on the video display.
For more information, refer to “14.2  Video/RGB Display.”

• Address $s956
Stores the current adjusted brightness value (0 to 127)

• Address $s957 (V8i only)
This is valid when you use video display size of 640 × 240.
For more information, refer to “14.2  Video/RGB Display.”

• Address $s959 (V8i only)
Used to specify the operation of the Video2 RESTART (video restart) macro command.
For more information on the operation, refer to the Macro Reference Manual.

• Address $s960
Used to specify the operation for video snapshot and JPEG display.
For more information on the operation, refer to “14.2  Video/RGB Display” or “14.3  JPEG Display.”

• Address $s961 (for V815iX only)
Used to set the standard video size.
For more information, refer to “14.2  Video/RGB Display.”.

• Address $s962 (V8i only)
Stores the number of “Continuous Single Snap” times of video/RGB display.
For more information, refer to “14.2  Video/RGB Display.”

• Address $s965
Used to set the monitoring timeout time of CF card access from the V-server or a client (CF card 
access DLL, for example) to MONITOUCH in the RUN mode.

Setting value = 0:  60 sec (default)
Setting value = other than 0:  Setting value × 10 sec
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• Address $s966 to 971 (V8i only)
Used to set the reference value for video/RGB display.
For more information, refer to “14.2  Video/RGB Display.”

• Address $s990
Indicates the result of the GET_RECIPE_FILEINFO (recipe) macro command execution.
For more information, refer to the Macro Reference Manual.

• Address $s1000 (V8i only)
Stores the remaining time duration (in seconds) for sound replay.
For more information, refer to “14.4  Sound.”

• Address $s1001 to 1002 (V8i only)
Stores the adjusted volume value.
For more information, refer to “14.4  Sound.”

• Address $s1005 to 1006 (V8i only)
The information on E-mail sending is output.
For more information, refer to “19.4  E-Mail.”

• Address $s1007
Used to select either color or monochrome for hard copy print.
For more information, refer to “16  Print.”

* Available with EPSON STYLUS SHOT only
• Address $s1008

Used to set accuracy of reduced JPEG images.
For more information, refer to “14.3  JPEG Display.”

• Address $s1009
Used to permit or prohibit consecutive printing when the data sheet print macro command 
“STA_LIST” is executed.

[0]: Consecutive printing prohibited
[1]: Consecutive printing permitted

• Address $s1010
This memory address is valid on the condition of $s1009 = 1.
The number of data sheets in printing queue is stored (eight maximum).
If the macro command “STA_LIST” is executed while eight data sheets are already in the queue, a 
macro execution error arises.

• Address $s1011
This memory address is valid on the condition of $s1009 = 1.
Specifying “1” cancels the printing of data sheets in the queue.
The value is automatically reset to “0” after cancellation. 

• Address $s1024
Stores the result of access to a file on the CF card from a client (V-server or CF card access DLL, 
for example) to MONITOUCH in the RUN mode.

0: Normal, -1: Error
• Address $s1025 to 1028

Stores the information on USB-FDD.
For more information, refer to the V8 Series Reference Additional Functions.
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• Address $s1030
The result of access to the CF card at the built-in CF socket (drive: C) is output.

• Address $s1031 to 1032
Stores the free capacity on the CF card at the built-in socket (drive: C) in kB.

• Address $s1033
Stores the status of the [Function: CF Card Removal] switch.

[0]:  Switch OFF (CF card removal disabled)
[Other than 0]:  Switch ON (CF card removal enabled)

• Address $s1035
The result of access to the CF card at the USB-A port (drive: D) is output.

• Address $s1036 to 1037
Stores the free capacity on the CF card at the USB-A port (drive: D) in kB.

• Address $s1038
Stores the status of the [Function: CF Card Removal] switch.

[0]:  Switch OFF (CF card removal disabled)
[Other than 0]:  Switch ON (CF card removal enabled)

• Address $s1050
The status of the action related to CF card is output.

4 Card not mounted

6 Too small card size

7 Different card type

9 JPEG/BMP file read error

12 Card write error

15 Disk error (open failure)

16 Card read error

4 Card not mounted

6 Too small card size

7 Different card type

9 JPEG/BMP file read error

12 Card write error

15 Disk error (open failure)

16 Card read error

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

$s1050

Sampling data 
backup/CSV output
0: Not processed
1: Being processed

Hard copy macro
0: Not processed
1: Being processed

Operation log
0: Not processed
1: Being processed
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• Address $s1051
The status of the completed action related to CF card is output.

• Address $s1052
If an error occurs on completion of processing related to CF card, the result is output.

• Address $s1056 to 1063
• Stores the execution result of the operation macro command.

For more information, refer to the Macro Reference Manual or the V8 Series Reference Additional 
Functions.

• Address $s1066
The status of printing performed on the PictBridge printer is output.

Value Status Cause and Remedy

0 The PictBridge printer is not 
connected, or it is in the normal state.

-

1 Printing is in process at the 
PictBridge printer.

-

-1 Printer error (related to hardware) The cable is not connected.  Check the USB 
cable connection.

Check if the printer is out of order.

-2 Printer error (related to paper) The printer runs out of paper.  Add paper.

Paper is not correct.  Set correct paper.

-3 Printer error (related to ink) * The ink is not set.  Install an ink cartridge.

The ink level is low.  Install a new ink cartridge.

* The error may be output as “-1” (printer error related to hardware) depending on the 
printer used.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

$s1051

Sampling data 
backup/CSV output
0: Not completed
1: Completed

Hard copy macro
0: Not completed
1: Completed

* The user must clear data in the memory address on 
completion of the action.

Operation log
0:  Not completed
1: Completed

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

$s1052

Sampling data 
backup/CSV output
0: Normal
1: Error

Hard copy macro
0: Normal
1: Error

* The user must clear data in the memory address on 
completion of the action.

Operation log
0: Normal
1: Error
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• Address $s1070 to 1072
These addresses are used to make settings for the FTP server or to store the information on the 
server.
For more information, refer to the V8 Series Reference Additional Functions.

• Address $s1085
Stores the information on the SRAM forced formatting.
This is valid when [ Format the SRAM forcefully] is checked in the [General Settings] tab 
window.

[0]: Forced formatting not executed
[1]: Forced formatting executed (Cleared to “0” by mode changes from RUN to STOP)

• Address $s1098
[Other than 0]:
Executes background processing of macro commands “SMPL_BAK”, “SMPL_CSV”, and 
“SMPL_CSV_BAK”.  However, if background processing is being executed to the buffer that has 
been specified, the next processing is started on completion of the current macro processing.

• Address $s1100
The setting number of sampling times at the primary storage target is output.

• Address $s1101
The current number of sampling times at the primary storage target is output.
(The setting number of sampling times ($s1100) ≥ The current number of sampling times ($s1101))

• Address $s1102 to 1103
The setting number of sampling times at the secondary storage target is output.

• Address $s1104 to 1105
The current number of sampling times at the secondary storage target is output.
(The setting number of sampling times ($s1102 and 1103) ≥ The current number of sampling times 
($s1104 and 1105))

• Address $s1106
The number of sampling times executed is output.

• Address $s1108
The media status at the secondary storage target, sampling formatting condition, etc. are 
comprehensively judged and the valid/invalid state of the secondary storage target is output.

[0]: Writing or browsing the secondary storage target is not possible.
[1]: Writing or browsing the secondary storage target is possible.

• Address $s1109
The status of creating backup file or CSV output is output.

[Other than 0]: Backup file being created or CSV file outputted
• Address $s1110

The status of sampling macro commands is output.
[Other than 0]: The macro command “SMPL_BAK”, “SMPL_CSV”, or “SMPL_CSV_BAK” is 

being executed.
• Address $s1111

The status of sampling macro commands is output.
[Other than 0]: The macro command “SMPL_BAK”, “SMPL_CSV”, or “SMPL_CSV_BAK” has 

been executed.
* This is cleared when $s1110 (executing flag) is set (ON).

• Address $s1112
The status of sampling macro commands is output.

[Other than 0]: Execution error of the macro command “SMPL_BAK”, “SMPL_CSV”, or 
“SMPL_CSV_BAK”

* This is cleared when $s1110 (executing flag) is set (ON).
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• Address $s1113
The sampling status is output.

[Other than 0]: A communication error occurs during sampling.
* This is cleared when sampling has been performed normally.  Sampling information of 

device memory maps is not output.
• Address $s1114

The sampling status is output.
[Other than 0]: If a communication error occurs during sampling, sampling will continue by 

resetting the data in the memory address where the error has occurred to “0”.
* Sampling of device memory maps is performed regardless of the setting of this flag, with the 

data in the memory address where an error has occurred at “0”.
• Address $s1120 to 1134, 1140 to 1154, 1160 to 1174, 1180 to 1194, 1200 to 1214, 1220 to 1234, 

1240 to 1254, 1260 to 1274, 1280 to 1294, 1300 to 1314, 1320 to 1334

Same as address $s1100 to 1114
• Address $s1360 to 1364

Stores the information on the security function.
For more information, refer to the V8 Series Reference Additional Functions.

• Address $s1365 to 1366
Stores the information on the operation log viewer.
For more information, refer to the V8 Series Reference Additional Functions.

• Address $s1380 to 1381
Stores the information on the remote desktop window display.
For more information, refer to the V8 Series Reference Additional Functions.

• Address $s1560
Stores the global overlap display status.

• Address $s1561
Stores the X coordinate of the global overlap display position.

Dot: 0 - 1023 
Column: 0 - 127 

• Address $s1562
Stores the Y coordinate of the global overlap display position.

Dot: 0 - 768
Column: 0 - 37 

• Address $s1563
Stores the global overlap library number.

Show: 0 - 9999
Hide: -1 

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Overlap registration*
0: None  1: Yes 

n + 0 (Display status)

Display status
0: Hidden  1: Shown 

* This bit is set to “1” only during display.
The bit, however, remains set (“1”) even during display hidden status when [Read PLC Memory 
when OFF] is checked in the [Detail] tab window for overlap library setting. 
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Please use this page for notes.
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Appendix 7 Error
There are five kinds of error messages displayed on the V8 series:

1) Communication error
2) Data Loading
3) Warning
4) SYSTEM ERROR
5) Touch Switch is Active

Communication Error

When communication is not established between the V8 series and a controller, or any abnormality 
(noise etc.) is detected, the following messages are displayed on the V8 series.

* If the above error messages are displayed on the V8 series without establishing communication 
between V8 and PLC, test the solution of remark “1”.  If the error occurs suddenly in 
communication, test the solution of remark “2”.

Error Messages Contents Solution Remarks

Time-Out

Although a request to send is 
given to a controller, no answer 
is returned within the specified 
time.

1. Check settings in the [Communication 
Setting] tab window of the [Device 
Connection Setting] dialog.

2. Check the cable connection.

1

3. Data may be disrupted because of noise.  
Fix noise. 2

Parity An error occurred in parity 
check.

1. Check the cable connection. 1

2. Data may be disrupted because of noise.  
Fix noise. 2

Framing Although the stop bit must be 
[1], it is detected as [0].

1. Check settings in the [Communication 
Setting] tab window of the [Device 
Connection Setting] dialog.

2. Check the cables and wiring.

1

3. Data may be disrupted because of noise.  
Fix noise. 2

Overrun

After one character is received, 
the next character is received 
before internal processing is 
completed.

1. Check settings in the [Communication 
Setting] tab window of the [Device 
Connection Setting] dialog.

1

2. Data may be disrupted because of noise.  
Fix noise. 2

Check code error
The check code in the 
controller response was not 
correct.

1. Check settings in the [Communication 
Setting] tab window of the [Device 
Connection Setting] dialog.

1

2. Data may be disrupted because of noise.  
Fix noise. 2

F 1

F 2

F 3

F 4

SYSTEM

Communication Error
Time-Out

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM
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Error Messages Contents Solution

Error code received An error code was sent by a controller.
(NAK)

Examine the controller error code and 
solve the problem.

Break The controller’s SD remains at the low 
level.

Examine the connection between the 
controller’s SD and the V8’s RD.

Invalid memory
(Mitsubishi CPU)

You specified an address that exceeds 
the memory range of the PLC that you 
are linked to.

Check the type and range of memory 
that you set.

Invalid CPU model
(Mitsubishi CPU)

The PLC currently being supported 
does not have a corresponding CPU.

Confirm whether or not the CPU that 
you are using can be used with the 
V8 series.

Format The code of the received data is 
invalid.

1. Confirm link unit settings.
(After making settings, cut power 
to the controller.)

2. Review the [Device Connection 
Setting] ([System Setting] → 
[Device Connection Setting]).

3. If errors only occur from time to 
time, a noise-based 
communication error may be 
present.

Compare
(HIDIC S10)

Transmission data and received data 
are different.

NAK A NAK code is received.

Transaction Error
(Allen-Bradley PLC)

Transmitted transaction data and 
received transaction data are not in 
agreement.

Communication Error An unclear communication error is 
detected.

Count error
(Mitsubishi CPU and Q link unit)

The expected data amount is different 
from the count value.

Command error
(Mitsubishi CPU and Q link unit)

The response code differs from the 
expected code.

Invalid cassette
(Mitsubishi ACPU)

This cassette is not included in the 
memory cassettes currently being 
supported. Contact your local distributor.

Password error
(Mitsubishi QCPU) The password is incorrect.
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Error Messages for Network Communication
Ethernet

CC-LINK

OPCN-1

Error Messages Contents Solution

Ethernet Error:XXXX

The Ethernet status is saved at system 
memory address $s518 and a code 
other than “0” (normal) is received.
XXXX : Error No.

For the contents and solution to each error 
number, refer to Appendix 5 of the V8 
Series Connection Manual separately 
provided.

Error Messages Contents Solution

I/F Board Err The I/F unit for CC-LINK has an error. Contact your local distributor.

Station Number Err The port number set by a switch is not 
within the setting range (1 to 64).

Specify the port number within the setting 
range.

Word Writing to Sp. Relay

Word writing to a special relay (M9000 
and later) is attempted.
(Notes: Only bit writing is possible for 
special relays when connecting with 
CC-LINK.)

Do not attempt to perform word writing to 
special relays.

Error Messages Contents Solution

I/F Board Err The I/F unit for OPCN-1 has an error. Contact your local distributor.

Stat. No. out of range The port number set by a switch is not 
within the setting range (1 to 127).

Specify the port number within the setting 
range.

Network Link Error Cannot connect to the master station 
in the network.

Check the condition of the master station 
(PLC).  Check the network connection.

Network I/O Access Err
MONITOUCH has attempted to have 
access to a memory area out of the 
designated input/output words.

Check the memory for the network I/O in 
the screen data file.

Waiting for Reply

1. Less than “Max_int” time 
(communication monitoring time 
for salve station) set on the PLC for 
OPCN-1 communications

2. Timeout on the V8 series
(The timeout time can be set in the 
[Device Connection Setting] dialog 
that is displayed by selecting 
[System Setting] → [Device 
Connection Setting] on the 
V-SFT-5 editor.)

This error is indicated when the above 
1 and 2 are present.

When the “Max_int” time is too long 
(infinite, for example) on the PLC, it is not 
possible to know whether or not the 
response from the PLC is correctly made.
This error message disappears when a 
response from the PLC is received within 
the “Max_int” time.

Word Writing to Sp. Relay 
(Mitsubishi: A Series)

Word writing to a special relay (M9000 
and later) is attempted.
(Notes: Only bit writing is possible for 
special relays when connecting with 
OPCN-1.)

Do not attempt to perform word writing to 
special relays.
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T-LINK

PROFIBUS-DP

Error Messages Contents Solution

T-LINK I/F Board Err The I/F unit for T-LINK has an error. Contact your local distributor.

Network I/O Access Err
MONITOUCH has attempted to have 
access to a memory area out of the 
designated input/output words.

Check the memory for the network I/O in 
the screen data file.

Communication Error 
Received Code No. 22

The PLC loader is being accessed so 
that processing is not performed on 
the V8 series.  (This error occurs 
during program transfer from the PLC 
loader for most cases.)

Wait for the PLC loader to finish 
processing, and press the [RETRY] switch 
on the V8 screen.

Communication Error 
Received Code No. 32

An attempt to access an area that 
does not exist within the PLC is made.
Example: A file area (W) that is not 
defined with the PLC program

Check the PLC memory addresses set in 
the screen data file.

Communication Error 
Received Code No. 36

The number of monitor registration 
points is too small.

Correct the number of monitor registration 
points.  For monitor registration, refer to the 
user manual of the PLC you are using.

Error Messages Contents Solution

Time-Out

“Check” is displayed 2 or 3 seconds 
before this error occurs when 
connecting the V8 series and 
PROFIBUS-DP in the RUN mode.

The setting for [Own Stat. No.] on the V8 
series is discrepant with that for [Address] 
for [V8 series] on the SIMATIC Manager.  
Check and correct the setting.

A screen is displayed instantaneously 
(= communications performed) before 
this error occurs when connecting the 
V8 series and PROFIBUS-DP in the 
RUN mode.

The DB address set on the V8 screen may 
not exist on the PLC (memory over).  
Check the setting.
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DeviceNet

* Depending on the errors detected, turning on the power again may be necessary on the master as 
well as on the V8 series.

Error Messages
LED

Contents Solution
MS NS

Initialization error Red

Reading or writing to RAM is not 
performed normally during 
initialization check.

• Turn the power on again.
If recovery is not possible, a fault is 
suspected.

Start-up information check error:
The baud rate is outside the 
specified range.

• Make the baud rate (using DIP 
switch 7 and 8) the same as set 
for the master on “CU-07” and 
turn on the power again.

If recovery is not possible, a fault is 
suspected.

Start-up information check error:
Excessive size for input

• On the V-SFT-5 editor, select 
[System Setting] → [Device 
Connection Setting].  In the 
[Input/Output Word Counts 
Setting] tab window, enter the 
desired value of up to 128 words 
for [Input Range].  Then turn on 
the power again.

Start-up information check error:
Excessive size for output

• On the V-SFT-5 editor, select 
[System Setting] → [Device 
Connection Setting].  In the 
[Input/Output Word Counts 
Setting] tab window, enter the 
desired value of up to 128 words 
for [Output Range].  Then turn on 
the power again.

BUS OFF Error Green Red

• The communication cable is 
short-circuited at start-up.

• The baud rate does not match 
the setting for the master.

• Check the wiring and turn on the 
power again.

• Make the baud rate (using DIP 
switch 7 and 8) the same as set 
for the master on “CU-07” and 
turn on the power again.

Node Address 
Duplication Error Green Red

The same node address is 
already used for the master or 
some other slave.

• Check the node address and 
correct it to an address which is 
not used yet (using DIP switch 1 
to 6) on “CU-07”.  Then turn on 
the power again.

Network Error Green

The network power is off. • Turn on the network power 
supply.

No other devices exist on the 
network.

• Check the wiring and turn on the 
power again.

• Make the baud rate (using DIP 
switch 7 and 8) the same as set 
for the master on “CU-07” and 
turn on the power again.

Red

I/O time-out:
Communication with the master 
has become disabled.

• Check the conditions of the 
master power supply.

• Check the wiring.

Green No connection exists. • Check the wiring.

Definition Error − − The returned error code is not 
supported by the DeviceNet.

Review the settings below:
• Master setting
• CU-07 setting
• V-SFT-5 setting
• Wiring

: Extinguished : Illuminated : Blinking
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Data Loading

If an error is detected on the screen data in the RUN mode, the following messages are displayed on 
the V8 series.

Error Numbers
Error No.

* Error numbers with “*” do not occur under ordinary circumstances.
If any of these errors are displayed, contact your local distributor.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Screen No. Error Error : XX (XX : XXX)

Error Messages Contents Solution

Screen No. Error There is no setting for the received screen.

At the start of communications, the V8 
series regards the value in the read area “n 
+ 2” as the screen number.
Check that this value is an existing screen 
number on the controller.

Error : XX (XX : XXX) There is an error in the created screen 
data.

According to the item number and the 
sub-item number displayed on the V8 
series, find the edited screen where the 
error occurs.  Check the contents of the 
error (error number) and remove the error.

Error No. Problem Solution

3 Data version does not match the MONITOUCH 
system program version.

Transfer the MONITOUCH system program 
from Editor.
If not corrected, check the Editor version and 
the system program version of the V8 series, 
and contact your local distributor.

10 The communications board does not match the 
I/F driver.

The I/F board does not match the I/F driver.  
Check the I/F driver and transfer data again.

11 The PLC model set in the screen data does not 
match the I/F driver.

Check the PLC model and transfer the I/F driver 
again.

12 The I/F driver version does not match the 
version of screen data.

Check the Editor version and the I/F driver 
version, and contact your local distributor.

13 The I/F driver version does not match the 
version of the MONITOUCH system program.

Check the I/F driver version and the system 
program (SYSTEM PROG.) version of the V8 
series, and contact your local distributor.

15 The display language on MONITOUCH does 
not match the language set in the screen data.

Check the MONITOUCH model and the 
language used for the created data.

Error : XX (XX : XXX)
Sub-item No.
Item No.
Error No.
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17 The network I/O number exceeds the usable 
number range.

Set a number within the usable range.

19 An I/F driver that MONITOUCH does not 
support is transferred.

Transfer the correct I/F driver.

20 The maximum capacity of the buffering area 
has been exceeded.

Data capacity to be saved in DRAM at the 
primary storage target (buffering area setting) 
has exceeded the maximum available capacity.
Reduce the number set for [No. of Samples].

22 The buffer number specified for trend or alarm 
item has not been set.

Set the buffer number in the [Buffering Area 
Setting] dialog from the [System Setting] menu.

23* Memory card file No. error Contact your local distributor.

24 The output file number in the buffering area 
setting is not unique or [Buffering File] is not set 
for the memory card setting.

When [Secondary storage target: Memory Card] 
is selected in the buffering area setting, the 
output file number can be set.  However, the set 
output file number already exists.
As another possibility, [Type: Buffering File] is 
not set in the [Memory Card Setting] dialog 
though [Secondary storage target: Memory 
Card] is selected.
Check the output file number in the [Buffering 
Area Setting] dialog, and set correctly.
If not successful, check the setting in the 
[Memory Card Setting] dialog.

25 The number of sampled words in the buffering 
area setting is exceeded.

Check the value set for [Word Count] in the 
[Buffering Area Setting] dialog.
Bit Synchronization, Constant Sampling, Alarm 
Logging, Device Memory Map:
128 words maximum
Alarm Tracking, Time Order Alarming:
1024 words maximum

26 The trend and alarm items that refer to the 
buffering area are too many.

The items that refer to the buffering area are too 
many on one screen (16 items maximum).
Reduce the number of trend/alarm items placed 
on the screen.

27* There is an error in the buffering area setting. Contact your local distributor.

28 The same function is set for both MJ1 and MJ2 
ports.

Check the setting in the [Device Connection 
Setting] dialog and set correctly.

29 The memory capacity is insufficient. Decrease the value set for [No. of Samples] for 
DRAM at the primary storage target (buffering 
area setting).
Reduce the value set for [Word Count] for an 
alarm item.
Delete the following settings if not necessary.
- Multi-link/Multi-link2
- Ladder monitor
- Connection devices not used
If not corrected, contact your local distributor.

30 The number of registered items is too many. Reduce the number of items.

31 The memory capacity for the registered items is 
insufficient.

Take the following action for the relevant 
screen.

Reduce the value set for [Word Count] for time 
order alarming.
Reduce the value set for [Word Count] for alarm 
tracking.
Reduce the value set for [Executing Relays] for 
bit order alarming.
Reduce the number of items placed on the 
screen.

32 The number of items that uses the memory 
exceeds the available number.

Reduce the number of items.

Error No. Problem Solution
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33 The maximum settable number of switches and 
lamps has been exceeded.

The number of switches and lamps placed on 
the screen has exceeded 1024.  Switches and 
lamps on overlap displays are included in this 
number.
Reduce the number of switches and lamps.

34 The items that occupy the memory area exceed 
the available work memory capacity.

Reduce the amount of data.

35* Variable length data error

Contact your local distributor.

36* ITEM error

37* Component ITEM error

38* Component error

40* Group byte count error

41* Recognition flag error

42* Function ITEM error

43* Function ITEM end error

44* Group ITEM end error

46 An unavailable memory address is set or the 
available memory range is exceeded.

Check the memory setting.

47 IDs of the items in screen library with setting 
limitations are duplicate on a screen.

Check the IDs and keep them unique.

48 The network table number set for Ethernet local 
port IP address is the same as the network table 
number of the PLC.

Check and set the network table number again.

49* Group ITEM error

Contact your local distributor.50* Link ITEM error

51* Editor ITEM error

52 The overlap ID is illegal and must be a value 
from “0” to “2”.

Check the overlap ID and set correctly.

53 In the call-overlap setting, an overlap library 
number with no data registration is specified.

Specify an overlap library number registered on 
the multi-overlap edit window.

54 Overlap displays occupy too much memory 
capacity.

Reset the overlap display data size.

55* Multi-overlap header error

Contact your local distributor.

56* Graphic undefined command error

57* Graphic ITEM error

58* Graphic execution error

59* Switch function error

60 Switch operating area error Reset the switch operating area.

61* Statistic graph % display No. over
Contact your local distributor.

62* Multi data over

63 The selection order number of data blocks (a 
maximum of four) is duplicated.

Check the data block selection order number 
and set correctly.

64* Data display element No. error Contact your local distributor.

65 The scale or graph is not set correctly in the 
settings for trend graph or trend sampling.

Correct the settings for [Scale Max. Value] and 
[Scale Min. Value] or [Graph Max. Value] and 
[Graph Min. Value] in the dialog.

66* Internal circle radius is “0”.
Contact your local distributor.67* The number of X-axis data points is equal to or 

less than zero. 

Error No. Problem Solution
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68 The display area is insufficient for the area 
(lines) that is displayed by one bit (bit order 
alarming).

Check the [No. of Lines per Relay] in the [Bit 
Order Alarming] dialog and enlarge the display 
area if necessary.

69 A pattern or frame larger than the screen size 
has been specified.

Re-set the pattern or frame.

70 The number of columns or lines of data sheet is 
exceeded.

Check the data sheet columns/lines, and set 
correctly.

71 The maximum part size in the closed area graph 
has been exceeded.

The part size in the closed area graph has 
exceeded 64 kB.
Reduce the data size of the parts.

72 The setting for real time printing of alarm 
logging has exceeded the upper limit, or the 
specified buffer number is not unique.

There are four or more alarm logging parts with 
[   Real Time Print].  As another possibility, 
there are two or more alarm logging parts with 
the same [Buffer No.] with [   Real Time Print].

Make the setting for [   Real Time Print] within 
the limit.  If not solved, check the Editor version 
and the system program (SYSTEM PROG.) 
version of the V8 series, and contact your local 
distributor.

73 There are four or more video items on one 
screen.  (including the screen library)

Check the number of video items and reduce 
the number.

74 Animation item is placed other than the base 
screen (screen library, etc.).

Place the animation item on the base screen.

75 The screen data type is not consistent. Transfer the system program of the V8 series 
from Editor.

76 The number of executing relays for bit order 
alarming is exceeded.

Check the value set for [Executing Relays].
Universal serial:  4096 maximum
Other PLCs:  512 maximum

77* Expanded graphic ITEM error
Contact your local distributor.

78* Expanded function ITEM error

79 Component parts occupy too much memory 
capacity.

Reduce the number of component parts.

80* Macro: Undefined command error Contact your local distributor.

81 Macro: The numbers of FOR and NEXT 
commands are not the same.  FOR-NEXT 
commands are nested beyond 8 levels.

Correct the FOR-NEXT commands.

82 Macro: There are two different commands for 
the same label number.

Macro: Re-set the label.

83 Macro: There is no destination label for the 
jump.

Macro: Change or set the destination label.

84* Macro: Illegal memory use Change the macro command.

85* Macro: Undefined system call Contact your local distributor.

90 A screen library that is not registered is used. Check the screen library number.

91 Bitmap data for switch or lamp is not registered. Check the following points:
No bitmap name is designated.
The total count of 3D parts exceeds 1023 
(maximum).
The part size is too large.
There is no bitmap in the PARTS folder.

92* Multi-language initial display string No. error
Contact your local distributor.

94 Multi-language selection string number error

95 MR400 format table setting: String code error There is an illegal code after “\” in the string.

96 MR400 format table setting: String size error The total size of the string is too large.

97 Multi-language font setting error Transfer the first language font or screen data 
again.

Error No. Problem Solution
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99 Registration items occupy too much memory 
capacity.

Reduce the number of registration items.

100 Universal serial: GD-80 compatible entry mode 
is set.

Uncheck [GD-80 Compatible] in entry mode.

101 Universal serial: System memory setting error Check whether or not access to the outside the 
specified memory is attempted, such as for 
macro indirect designation.

102* Connection mode setting error

Contact your local distributor.103* Network I/O size setting error

104* Network table setting error

120 Multi-link2 is not selected for modular jack 1 or 
2.

Check the connection port setting in the 
[Multi-link2] dialog.

121 Multi-link2 port number error.  The local port or 
the total number of ports is out of the range of 1 
to 4.

The value for [Local Port No.] or [Total] in the 
[Multi-link2] dialog is out of the range of 1 to 4.  
Set the value of [Local Port No.] or [Total] within 
the range of 1 to 4.

122 Multi-link program is not registered.
Transfer the multi-link program.

123 Multi-link2 program is not registered.

127 MONITOUCH does not support the remote 
desktop window display.

Check whether MONITOUCH is a model that 
supports the remote desktop window display.  If 
not, remove the setting.

128 No key code for the remote desktop window 
display is registered in MONITOUCH.
Version 5.4.13.0 or earlier (SYSTEM PROG version 
1.560)

Register the license key code for remote 
desktop window display on the Main Menu 
screen.

129 No remote desktop window display program is 
registered in MONITOUCH.

Update the V-SFT version and resend the 
screen data to MONITOUCH.
For data transfer to a CF card, you need to 
rewrite the data to the CF card via the CF card 
manager.

130* Ethernet: Network byte error Contact your local distributor.

131 Ethernet: The local port is not set in the table. Check the port number on the Main Menu 
screen of MONITOUCH, and check that the 
local port is set on the network table edit 
window.

132 Ethernet: The network table is not found or is 
not the right one.

Set [PLC Table] ([Device Connection Setting] → 
[Target Settings]).

133 Ethernet: IP address No. error Check the IP address in the network table edit 
window or in the PLC table.

134 Ethernet: Port No. error Check the port number in the network table edit 
window or in the PLC table.

135 FL-net: FL-net data error Check the setting for [FL-Net] in the 
[Communication Parameters] dialog.

136 IP address setting error: The network table 
number selected for local port IP address is not 
registered.

Check the network table number.

137 The Ethernet port number of the IF driver is not 
unique.

Set an unique port number for the I/F driver.

138 The remote desktop table is not registered. Register the remote desktop table with the 
specified number.

139 The remote desktop table is not set correctly. Check the remote desktop table settings again.  
(Check, for example, whether an unregistered 
remote desktop table number is specified.)

140 The I/F driver version of MONITOUCH does not 
match the version of the MONITOUCH system 
program.

Check that the MONITOUCH system program 
(SYSTEM PROG.) version is compatible with 
the device connected, and if necessary, update 
the system program version.

141* Multi-link 2 connection is set. Contact your local distributor.

Error No. Problem Solution
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142 I/F driver not registered Transfer the I/F driver.
Check the memory of the item.

143 Device memory maps in the buffering area 
setting are not set.

Check the device memory map setting, and set 
correctly.

145 The setting number of a device memory map in 
the buffering area setting is not unique.

Check that each device memory map number is 
unique in the buffering area setting, and set 
correctly.

146* Device memory map memory setting error Contact your local distributor.

150 Ladder monitor program is not registered. Transfer the ladder monitor program (.ldpA).

151 Ladder monitor program: Model setting error Check the PLC model of the device connected, 
and transfer the screen data again.

152 Ladder monitor program: Unsupported 
language

Check the MONITOUCH model and the 
language used in the screen data, and set 
correctly.

155 FROM data unregistered The “default.dtm” file is not transferred though 
[  Use Internal Flash ROM as Back-up Area] 
is checked in the [General Settings] dialog 
([System Setting] →  [Unit Setting]).  
As another possibility, no port number table is 
found though [  Use Port Number Table] is 
checked in the [Device Connection Setting].
When this item is checked, the screen data 
capacity of the Main Menu screen becomes 128 
kB smaller than the case where it is not 
checked.  Check the setting.
If the capacity is not reduced, contact your local 
distributor.

156 “Backup area” and “port number table” cannot 
be used at the same time.

[  Use Internal Flash ROM as Back-up Area] 
is checked in the [General Settings] dialog 
([System Setting]  →  [Unit Setting]), and at the 
same time [   Use Port Number Table] is 
checked in the [Communication Setting] tab 
window of [Device Connection Setting] dialog. 
It is not possible to use both functions at the 
same time.  Uncheck either item, and transfer 
screen data again.

157 Some port numbers in the port number table are 
duplicate.

Be sure to set unique port numbers when the 
port number table is changed using the 
FROM_WR macro command.

158 The model set for ladder monitor program is not 
consistent with the one for ladder data.

Transfer the ladder data (.ldmA) of the correct 
model.

159 PLC ladder data is illegal. Transfer the ladder data (.ldmA) again.

160 The SRAM area size exceeds the available 
range.

Check the SRAM/clock setting.

161 The SRAM area is not formatted. Format the SRAM area on the SRAM/Clock 
screen that can be displayed from the Main 
Menu screen.
Check that the battery voltage is not lowered.

162 Data in the SRAM area does not match the 
MONITOUCH system program version.

Check the MONITOUCH system program 
version, and contact your local distributor.

163 The SRAM/clock setting does not match the 
SRAM area format.

Format the SRAM area on the SRAM/Clock 
screen that can be displayed from the Main 
Menu screen.

164 The simulator program version does not match 
the version of the MONITOUCH system 
program.

Check the MONITOUCH system program 
version and the compatible simulator program 
versions.

165 Device memory map data is registered for a 
model that does not support device memory 
maps.

Delete the device memory map.

Error No. Problem Solution
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166 The function set for the serial port is duplicated.

The sub item number shows;
      0: CN1
      1: MJ1
      2: MJ2
Specify a unique function (Simulator, etc.) for 
each port.

170 The ladder communication program is not found 
in MONITOUCH.

[Use Ladder Tool] is selected in the [Device 
Connection Setting] dialog, but no ladder 
communication program is found in the V8 
series.
When you do not execute ladder transfer, 
uncheck the box for [  Use Ladder Tool].
When performing ladder transfer, transfer the 
ladder communication program to 
MONITOUCH.

171 The PLC model set for screen data does not 
match the model of the ladder communication 
program.

Transfer the ladder communication program for 
the PLC model.

172 The ladder communication program is stored in 
MONITOUCH.

[Use Ladder Tool] is not selected in the [Device 
Connection Setting] dialog; however, the ladder 
communication program is stored in 
MONITOUCH.
Check the box for [Use Ladder Tool].

173 [Use Ladder Tool] is selected in the [Device 
Connection Setting] dialog; however, the 
connection mode other than “1:1” is selected for 
[Connection Mode].

Ladder transfer supports “1:1” connection only.
When you do not execute ladder transfer, 
uncheck the box for [   Use Ladder Tool].
When executing ladder transfer, select “1:1” for 
[Connection Mode] in the [Communication 
Setting] tab window.

174 The I/F driver that does not support ladder 
communication is set.

Check that the I/F driver supports ladder 
communication.

175 (V808CH only)
MONITOUCH does not support the ladder 
communication.

Check the ladder communication setting.

183 The printer model is not right. Transfer the printer driver for the model that is 
set for screen data.

184 Printer driver is not found. Transfer the printer driver.

185 (V806 only)
No option unit is installed.

Check the option unit setting in the [Edit Model 
Selection] dialog ([System Setting] → [Edit 
Model Selection]).
Install the option unit DU-01.

186 (V806 only)
No option unit is installed.

Remove the option unit DU-10 once and install 
it again.

187 Check that the device memory map number 
specified in the buffering area setting is used for 
periodical writing or synchronized writing.

Check the data in the device memory map.

188 In the device memory maps specified for 
periodical writing or synchronized writing, the 
same memory address is specified.

Check the data in the device memory map.

189 The Japanese conversion program is not 
registered in MONITOUCH.

Transfer the Japanese conversion program.

192* I/F driver setting error

Contact your local distributor.
193* The common data sheet setting is not 

registered.

194* The memory card setting is not registered.

195* VIO input/output memory is not registered.

Error No. Problem Solution

Sub item number

Error : 166 (0 : x)
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Item numbers
The item number shows the editing screen or other place where the error is detected.

0 : Header
1 : Network table
2 : Buffering area
3 : Barcode
4 : Memory card
5 : External character 16
6 : External character 32
7 : Message group
8 : Dot pattern
9 : Graphic library
10 : Page block
11 : Direct block
12 : Screen block

196 The data stored on the CF card is not correct. This error may relevant to the operation of 
storing on CF card (data of screen, 3D parts, 
etc.).
Use a CF card, on which data is stored correctly 
via the CF card manager.

197 (V808CH only)
The TB2 is the port dedicated to RS-232C.

Check the port set in the screen data.

198 (V808CH only)
The TB3 is the port dedicated to RS-422 or 
RS-485.

Check the port set in the screen data.

199 Multiple functions are allocated to the USB port. Multiple functions are allocated to the USB-B 
port.  Use the USB port for only one of USB 
simulator, PictBridge printer, and USB ladder 
communication.

201* Total byte count error Contact your local distributor.

202 The touch switch setting is not right. Select the touch switch type appropriate for the 
MONITOUCH model.

203 The memo pad function not available with 
matrix switch type is found.

Delete the item (= memo pad).

204 Manual setting type font data is not transferred. Manual setting type font data is not transferred.  
Characters in automatic setting type font are 
displayed correctly; however, if not in automatic 
setting type font, they are displayed in 12 points 
tentatively.
Check the setting in the [Manual Font Setting] 
dialog, and transfer the screen data again.

206 No sound unit is installed. Install option unit “GU-xx”.

207 No video unit is installed. Install option unit “GU-00” or “GU-10”.

208 There is no gateway setting. To use the e-mail function, be sure to set 
gateway on the network table (Ethernet).

209 PLC ladder data is not registered. Transfer the ladder data (.ldmA).

214 No key code for the remote desktop window 
display is registered in MONITOUCH.
Version 5.4.14.0 or later (SYSTEM PROG version 
1.570)

Register the license key code for remote 
desktop window display on the Main Menu 
screen.

215 The SRAM area is used.  Connect the battery. Although the use of SRAM is set in the 
[SRAM/Clock Setting] dialog, no battery is 
connected.  Connect the optional battery 
(V7-BT) to the back of MONITOUCH.

216 A data sheet includes an item that cannot be 
printed.

Recheck the data sheet screen.  Remove the 
unusable item.

Error No. Problem Solution
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13 : Macro block
14 : Data block
15 : Data sheet page
16 : Multi-overlap
17 : Screen
18 : Function switch
19 : Screen library
20 : Expansion data
21 : Device memory map
22 : Expanded font
23 : Alarm mask data
24 : SRAM
25 : Bitmap area
26 : CF attribute table
27 : Print format
28 : Tag table
29 : Slave communication memory table
30 : WAV file table
31 : JPEG table
32 : Animation table
33 : Comment table
34 : Windows font table
35 : Windows font table (message)
36 : Windows font table (characters)
37 : Extended message, comment table
50 : I/F driver
52 : Remote desktop table
70 : No optional driver provided
90 : Error detection in RUN mode

Sub item numbers
The sub item number shows the number of the editing screen detecting the error.
• Buffering area: -1 = common item, 0 to 11 = buffer No.
• Message: Message group No.
• For graphic library, the library linear number is shown.

Graphic group No. × 256 + No. in the group
• Device memory map: xyy (x = PLC1 to 8, yy = table No.)
• I/F driver: 1 to 8 = PLC1 to 8, 9 = simulator



Appendix 7    Error

A7-15

A7

Warning

A message may be displayed on the Main Menu screen.  This is a warning message.
For the warning details and solutions, refer to “Error Numbers” on page A7-6 and correct screen data.

SYSTEM ERROR

When a system error is detected, the following error screen is displayed on the V8 series.

Error Code:  XX
1: Watchdog timer error
11: Switch table error
30: Request for displaying full error
31: Memory allocation system error
32: General exceptions/MMU address system error
33: RTOS system error
34: Memory error
35: Inaccurate memory error
37: Inaccurate memory write error

The source of the error could be one of the following three problems.
1) Program crash due to noise
2) Hardware problem
3) Bad program

If any of these errors occurs, contact your local distributor.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Warning:202
The setting for [Touch Switch] is not right.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

System Error screen
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Touch Switch Is Active

If the power is turned off while a touch switch is activated, the error screen shown below is displayed.  
Remove your finger from the screen.
If the error screen remains displayed, contact your local distributor.

Errors Displayed on the PC when a Screen is Created

When a rule is violated when creating a screen, the following type of message is displayed.  Correct 
the error as indicated by the message.

Example: When you attempt to set multiple entry modes in one overlap layer or the base screen.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Touch switch is active.
Keep hand off the screen.
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A7

Error Check

Errors in the file can be checked during editing.
Select [Tool] → [Error Check] on Editor.

• When no error is found:
The [Error Check Complete] message is displayed.

• When an error is found:
An error list like the one shown below is displayed.

• Detail window:
When you select an item and double-click  , the detail window is displayed.
Fix the problem as indicated.

Display details by 
double-clicking.
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Please use this page for notes.
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